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1.1. Pandora FMS: What is it, exactly ?
Pandora FMS is a monitoring software, intended for all types of environments. To use the word
'monitoring', in its broad semantic sense, is somehow risky  as there are hundreds of tools available
 each one of them adapted to a singular type of environment: It's not the same to monitor a couple
of printers in a small office than thousands of interfaces and switches with extremely high network
traffic in a data center, consisting of thousands of servers.
Pandora FMS is designed to adapt to every roll and to every organization. Its main aim is to be
flexible enough to manage and control the complete infrastructure, without a further need to invest
any more time or money into any other monitoring tool.
FMS is an acronym for Flexible Monitoring System. Its purpose is to be able to monitor both
complex new generation tools, systems and outdated elements of difficult access and scarce
compatibility, all on only one platform.

Pandora FMS currently avails of agents for every ‘modern’ operating system on the market, that is:
from Windows NT4, to Windows 2008. Not forgetting all the modern Unices (AIX, Solaris, HPUX,
BSD, Linux) in every version and in all of its distributions.
Pandora FMS can, of course, be used successfully not only as a systems monitoring tool, but with all
sorts of network devices, be it by using SNMP (versions 1,2,3) or via TCP protocol probes (snmp,
ftp, dns, http, https, etc), ICMP or UDP.

1.2. About the Documentation
All of this power and flexibility comes with an implicit difficulty at setup stages. In spite of
Pandora’s mostly graphical configuration, we are aware that learning how to use it seems a little too
complicated at first. That is why we have divided the 800 pages of the User’s Guide in several
chapters:
•Chapter I. Understanding Pandora FMS.
•Chapter II. Installation and Configuration.
•Chapter III. Monitoring with Pandora FMS.
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•Chapter IV. Operating and Managing Pandora FMS.
•Chapter V. Complex Environments and Best Performance.
•Chapter VI & VII. References and Technical Appendices.
Besides
the
official
documentation,
you
can
avail
of
our
user’s
forum
at http://openideas.info/smf where you can post queries in English, Spanish and Japanese to other
users. Were you to require official training there is an official training program [1] imparted by the
developers of Pandora.
We have compiled some quick reference guides to assist you to configure Pandora FMS and to
implement simple monitoring tasks with Pandora’s tool. You can also avail of quick reference
manuals for the installation of software agents, like Windows and Linux. Short videos are also at
your disposal, to carry you through some of the most technical parts of the configuration and if
necessary, you could avail of regular, scheduled workshops. More detailed information on all of the
above can be found on our website at http://pandorafms.com

1.3. The Evolution of Pandora as a Project
Pandora was created by Sancho Lerena in 2003. Since then, it has gradually evolved to become the
resilient, innovative and flexible monitoring tool we can offer today.
Originally written in 100% open source code, it passed the growing experimental years and after a
strong demand for the product from large companies and corporations, we felt compelled to launch
the Enterprise version. This version offers some specific characteristics designed for conditions
which require to process large volumes of information and to be able to work with thousands of
environmental devices.
The company financing and coordinating all the back up work in Pandora FMS development is
Artica Soluciones Tecnologicas, a Spanish company, founded in 2005 by Pandora’s alma mater. The
open source version is, nonetheless, fully operative and functional as a production tool, and most
companies, in fact, who do not require professional support, or which are very well staffed, get by
well with the Open Source version.

Pandora FMS can be found, to this day, among Sourceforge’s top rated, with thousands of
downloads and satisfied users all over the world. For more information on Pandoras evolution and
to see a road map of the project, please visit http://pandorafms.com
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1.4. A Quick Glance on the Features of Pandora FMS

•Autodiscovery. In a local setting, the plugins of Pandora’s agents permit hard disk,
partitions, and data bases detections in a data server, among many other features by default.
•Autoexploration. By remote access and by using the web, it can detect active systems,
catalogue them according to its operating system and by applying a profile it is able to
commence monitoring them. It can even detect the topology of the web and come up with a
web map which is based on route distribution.
•Monitoring. The Agents of Pandora FMS are the most powerful in the market. They are
capable of obtaining information  from the execution of a command to the call, at its most
basic level on the Windows API: Events, logs, numerical data, process stages, memory and
CPU consumption. Pandora avails of a default monitors’ library, but one of the greatest
advantages of Pandora is its resourcefulness to add and create new monitors.
•Remote access. The agents themselves can activate services, delete temporal files or
execute processes. Commands can also be executed remotely from the console, like stopping
or starting services. Furthermore, it's also possible to program tasks that require periodical
execution. It's also possible to use Pandora FMS to access Windows machines remotely (via
VNC) or to access web or Unix systems through Telnet or SSH from a web interface.
•Alerts and Notifications. Notification is just as important as failure detection. Pandora
FMS gives you an almost infinite variety of notification ways and formats. Including, but not
limited to escalation, correlation of alerts and prevention and mitigation of cascading events.
•Analysis and Visualization. Monitoring is not just receiving a trap or visualizing a downed
service, it is also to present forecast reports, correlated summary charts of long term
gathered data, to generate user portals, delegate reports to third parties or to define its own
charts and tables. Pandora incorporates all of those in a Web interface.
•Inventory making. Contrary to other solutions where the idea of CMDB is just a
prerogative  to Pandora, it is just an option. The inventory is flexible and dynamic (it can
autodiscover, accepts remote input, etc.) It can notify changes (e.g. uninstalled software) or
simply be used to make listings.
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Right from the start, every technical manual on Software will tell you about configuration, text files,
databases, protocols, etc. We very often learn to configure at low levels remaining ignorant towards
its full potential, that is, to what can be done with it and in which situations. The purpose of this
section is to explain the theory behind monitoring in a concise but systematic way, regardless of the
software that is used for this purpose.

2.1. Types of Monitoring
When we talk about ‘how a certain element is’, be it a server, a data base, a Web element, or a
refrigerator, we can ask ourselves the following questions:
1.How do we obtain the information? Do we have something in place, to that effect? Or do
we have to ask along the way?
2.Are we interested in having to ask constantly or to wait for something to happen?
3.What sort of information does it give me? Is it something I can measure in a graphical way
and watch its progression?
All of these questions answer the three key points that condition the essence of our monitoring
model. The first question responds to weather we are going to use an agentbased monitoring to be
executed inside the device we are controlling; or if, on the contrary, everything is being done
externally, by employing an internet connection. There are monitoring systems that operate one
way or another, and devices that can only be monitored in this or that way. Pandora FMS supports
all models.
The second question concerns to weather the monitoring is synchronous (every X number of
seconds it asks itself, regardless of any information changes taking place or not) or asynchronous (it
only receives information when something relevant has taken place). If I am using synchronous
monitoring with 10 million elements, collecting data at 5 minute intervals, the load will be
considerable, but if I do it every 50 minutes instead, it will be much more manageable, the down
side of it being, that if something takes place in between, it can take 50 minutes before I realize it. If
I use asynchronous monitoring (e.g. with SNMP traps or logs) I can save in many resources, but I
will not be able to draw graphics or do historical graphs, except those directly related to the
incidents occurred. Many tools are based solely in one of the models, sometimes known as
'performance' or 'capacity' tools, and there are other tools based in events managing. They are not
often exchangeable in their functions. Pandora FMS supports both approaches. The third question
refers to what we are looking for in a given moment in time, it can be a text chain (a descriptive
event) a floating point number (to be able to draw graphics) or simply a status (down, up). Being
able to work with different kinds of data allows more flexibility. Pandora FMS supports all types of
data. These three "paradigms" condition its environment greatly, as well as the tool chosen to
monitor it. Acknowledge the type of information needed and the best approach to obtain it. Plan
around the available information elements and on how to monitor them.

2.2. Remote Monitoring
If we speak of remote monitoring, we mean to say that it's Pandora FMS’ server the one that probes,
('polling') in a synchronous way, the devices it intends to monitor. When we speak about this mode,
we aren't referring to the 'local' monitoring, based on agents installed on the devices we wish to
observe.
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Generally speaking, when we monitor remotely, we do it with two different purposes:
•To make sure they are 'alive' (e.g. interface, or active system)
•To obtain a numerical value (e.g. to measure the web traffic or the number of active
connections)
When synchronous, this monitoring is always conducted in the same direction: From the monitoring
server to the monitored element.
We can also be interested in the opposite process: that is in receiving a warning when an incident
occurs. That is asynchronous monitoring, and in case of remote monitoring, we usually refer to it as
SNMP traps.
Synchronous monitoring is usually done by using the SNMP protocol, which is the most widely used
in web equipment, but it can also be done by WMI, a similar protocol owned by Microsoft.
Basically, both protocols work in a similar fashion, which is as follows: A server sends a request for
a particular configuration element of the ‘SNMP agent’ or ‘WMI service’ that it hears in the device.
This particular element is called OID, in SNMP and in WMI, it can be identified by a WQL query;
this can have to do with the free available memory, the router’s number of connections or the traffic
in a given interface.
If the monitoring is mainly based in internet environments. It's important to know SNMP in detail,
as it will be the monitoring tool's most widely used function. The asynchronous monitoring through
SNMP is also vital. Together with a monitoring tool, you'll need an external explorer of SNMP
devices, access to the MIBS collections from the makers of your Web devices (which are like OID’S
libraries) and, of course, a lot of patience to investigate, given that each device usually has its own
collection of OID’s but, among the thousands that each device has, you'll only be interested in some
of those elements.
If your monitoring is based in Windows servers and you're not interested in installing agents on the
machines, WMI remote monitoring would be very powerful and well suited. The WMI interface is
even more potent (and better organized than SNMPs). With WMI, you'll be able to obtain
practically any data, status or event on your Windows servers.
Unix and Windows systems can be also proved with SNMP, but the information returned is scarce.
Besides, you'll need to activate and configure the SNMP agents of the operating system, which can
be much more complex than simply installing a Pandora FMS monitoring agent.
Finally, you can always monitor web elements through the use of TCP or ICMP tests. ICMP is mainly
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used for two purposes:
•To verify if a system responds (ping)
•To find out the latency time of that device (in milliseconds)
Through TCP tests, it is possible to test if a web server responds properly, or if a mail server (SMTP)
sends the mail well. These types of tests are not intended to just get the server to 'open the port' but
also to get it to 'communicate’: that is, that the sending mail command receives an O.K to confirm it
or the answer from the web server is ‘200 OK’ (a valid reply in the HTTP protocol).
By default, there are a series of plugins for TCP testing, but it can easily implement its own tests by
adapting its own scripts or developing new ones. The integration with Pandora FMS does not
require an API, complex structures or proprietary libraries.
Given its importance, Web Transaction Monitoring and remote monitoring receive a separate,
specific chapter.

2.3. Local Monitoring (by Agents)
When it concerns systems and applications, the best way to obtain information is definitely from the
system. This is done by executing commands, or querying the system data sources from the same
engine we want to monitor. This means we have to execute a command or script, or to investigate
the system or the application. To that end, we use Pandora’s monitoring agent, a specific software
to take care of those small monitoring tasks.
The agents can only be installed on Unix and Windows operating systems. An agent can not be
installed in a cisco device, eg. According to the nomenclature used by Pandora FMS, we use ‘agent’
to refer to the entity containing the information and ‘software agent’ as the part of that software
installed in that system to extract information and report on to Pandora FMS’ server. The software
agent executes, constantly, on the system (as service) and reports information periodically.
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The agents allow you to do more, besides obtaining information through commands, things like e.g.
to obtain inventory information. It can also be configured to get them to react in case of a problem
or a failure, interacting automatically with the system, deleting a temporary file or executing a
given command.
To obtain 'precise' and specific information, on that we are interested in, we will often have to refer
to the manuals of the application we want to monitor, because even when we avail of ‘generic’
monitors, what we are looking for may not be so trivial.
Under Windows, there's an almost infinite variety of access to the information: WMI, performance
counters, event logs, system logs, registry, commands, powershell scripts, API (by Windows NT) etc.
In fact, Microsoft’s architecture is one of the easiest, more powerful and better documented, when it
comes to obtaining the information from the system. In Unix / Linux systems the capability of the
software agent to execute any command, allows us to benefit from the full shell power.

2.4. The Monitoring Procedure
Why do you really want to monitor ? Have you given it some thought? I mean, once you have
obtained data from your servers: When they fall, or how much they consume. Have you thought of
what you're going to do? Because may be by asking yourself: What's the most critical one? First,
you'll save a lot of time that would otherwise have been spent 'messing' or investigating issues that
aren't going to be useful in your daytoday work later.

Please dedicate five minutes to answering some questions. In your case, what do you think
describes your monitoring needs better ?
•To avoid losses > Availability.
•To analyze degradations > Performance.
•To evaluate growth > Capacity planning.
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On each of those instances, the focus will be on certain aspects.
Availability, on first instance. You are mostly interested in eventbased monitoring and remote
monitoring will probably be enough for your needs; it's faster to deploy and will give you relatively
quick results. You are after SLA informs.
Performance, on second instance. Its field is graphics and numbers, information it obtains through
agents or remotely, even though you will probably require agents to get indepth information on
their systems. Group reports and combined graphics are your main priority.
Capacity Planning, on third instance. Much more specific, it needs to obtain data, as in the second
instance, but to play with it, with predictive monitors and very specialized projective reports.
Establishing early alerts will be of great help and you're required to have a good knowledge of the
WARNING and CRITICAL status meanings, besides elaborating serial event management policies to
prevent the problem before it happens, which is without a doubt the most complex and interesting
case.
Once you know which model you are to follow, you are left to wonder what to do when the system
tells you the service is down, or worst even, what will happen if the server's capacity reaches the
limit on next Friday? You need to think in action procedures.

2.5. Action Procedures
We call action procedures something that can't be achieved by any tool (so far) which is basically
thinking and planning how to notify the incidents. In order to do that you'll have to consider several
factors:
•Event Urgency. You are to be able to discriminate between something unusual and
something critical.
•Notification Format. Email, SMS or, why not, a mild shock to the operator to stop him
from falling asleep (we are yet to implement it, but it would't be a difficult thing to do ...)
•Scalability: It basically consists of notifying someone first, hoping to get the incident solved
 and if not, then a second person is informed and if the problem persists, a third becomes
involved, usually someone respected by the previous two.
Ideally, before any configuring is done. You should have those concepts in mind. Even better, gather
some patience and a virtual design tool (Visio, OpenDraw ...) and draw its critical elements and
paint with arrows how the information is obtained and who'll be notified or what will be done in
response to that information.
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By focusing first on the most critical, you reach the starting point to what is the most important for
your organization. Once you know what the most critical is, you can discover how to monitor it and
in the meantime you can think of what's responsible for the problems in those systems and how to
notify it.

2.6. Supervision Models
By supervision models, we understand the fact that a monitoring system is designed to report
information to an automated system, but this is, in fact, watched by a human being in a direct or
indirect way. This person often receives the name of operator, which is the person which looks at
the screen or otherwise receives the events, be it by a ‘smartphone device or similar, or by email or
logs registered with another tool. The how to doesn't matter, the important thing is the fact of
having someone minding the system.

On the other hand, there are certain people who we call 'system administrators' in general or
'infrastructure personnel', which are those who, when something happens, receive a call from the
operator saying: "Hey, we have got a problem here." or a direct notification, sent automatically by
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the system, warning them of something, which is in most cases, a SMS or an email.
Here we can already see the great difference:
•The direct supervision model implies a person or several people, constantly watching the
system, so if something critical occurred it would be detected immediately. It can usually
notice small, noncritical changes, and has a much greater flexibility. It is not necessary to
define 'notifications' (alerts under Pandora) for each possible case, but it's enough with
looking at the events (some sort of visor to detect status changes) to have an idea of ‘what is
cooking’ in the system, at any given time. It is possible to define many screens and also to
define alerts to support that supervision. This model is used in large environments, given
that it does not matter how much we define an alert policy. A perfect, autonomous
supervision can never be warranted.
•The indirect supervision model implies there is no one permanently looking at the screen,
so it is necessary to define, before hand, the automatic notifications (alerts) that the system
is going to have; given that the events, graphics and maps aren't going to be seen by anyone.
This system is suitable when we have few devices, or when we have very closely identified,
what's critical and how to confront the problem (solution and notification).
For teamwork that involves operators, administrators and third level personnel and Pandora FMS
tools like: ticketing of events, incident creation, scaling of notifications, internal mail, notice board
and chat among the users of Pandora FMS are very useful.

2.7. And what Now ?
The following chapters are exclusively dedicated to Pandora FMS. Up to this point, we have been
discussing general matters which were probably important for you to know before we're continuing
to explore Pandora FMS. You will probably know many things already and may have used other
monitoring programs, you heard, perhaps, that this or that application is always monitored in a
certain way because it's the best way possible.
Maybe, but from our experience, each client does things a certain way and regardless of how much
we know about monitoring, I doubt we know more on how your infrastructure has been set up than
you do. Monitoring easy tasks presents no problems, the hard job is to adapt the monitoring to your
business without having to adapt your business to the monitoring, not a trivial one. More that 800
pages await, if you are to discover the best way to monitor your organization with Pandora FMS, a
real challenge.
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This chapter provides a general description of Pandora’s components, the way they relate to each
other and how to use the Pandora FMS architecture to meet different challenges regarding the
topology of its infrastructure.
Pandora FMS is extremely modular and decentralized. The most important component is the
database, were everything is stored (presently, it's only supported on MySQL production systems,
but PostgreSQL andOracle Databases are supported as well). Each one of components of Pandora
FMS can be replicated and works in a pure HA environment, be it passive or active or in a clustered
environment (Active/Active along with load balancing). There are also descriptions for methods to
setup a high availability SQL backend.

Diagram of the global architecture of Pandora FMS
Pandora FMS consists of several elements  among them the Servers, which are in charge of
collecting and processing data. The servers also introduce the collected and processed data into the
database. The console is the part in charge of displaying the data present in the database and of
interacting with the final user. The software agents are the applications which run on the monitored
systems (usually servers) and collect the information to send it to the servers of Pandora FMS.

3.1. Pandora FMS Servers
The Pandora FMS Servers are the elements in charge of performing the pertinent checks. They
verify and change them according to their results. They are also in charge of firing the alerts
established to control the status of their databases.
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The Pandora FMS Data Servers can work with high availability and / or load balancing. In a very
large architecture, it's possible to employ several servers simultaneously for being able to handle
large volumes of information, distributed by geographic or functional zones.
Pandora FMS Servers are always working and permanently verifying if any elements experience any
difficulties and if those are defined as alerts. When faced with a problem, this executes the response
defined in the alert, like sending an SMS, an email or activating the execution of a script.
There can be simultaneous servers, one of them being a main server and the rest of the servers
being slaves. Although there is a master and a slave server, they work simultaneously. The
difference between them is that when one is down (e.g. a network server) the master server is in
charge of processing all the downed server’s associated data.
The server receiving the data file from the agent, or processing the information (if this is of the
remote type) is the one which fires the associated alerts to that data which is after processing.
Pandora FMS automatically manages each server's status, its loading levels and other parameters.
The user can monitor the state of each server by the server's status section of the web console.
Under Pandora FMS, there are twelve different servers in total, specialized in and responsible for
the earlier mentioned tasks. The ten servers are integrated into a single application under the
general name of 'Pandora Server' which is a multithreaded application (multiprocessing) that
executes in subprocesses (threads) each one being different to the instances or to the specialized
servers of Pandora FMS.

3.1.1. The Data Server

It processes the information sent by the Software agents. The software agents
send XML data to the server in different ways (FTP, SSH or Tentacle) and the server
periodically verifies whether there are any data files awaiting processing or not. This
process utilizes a disk directory as a bonding medium for the elements to be
processed. It's possible to install different data servers on different systems or on the
same host (which will be different virtual servers). Several servers may work together
in very large environments, making the best of the available hardware (e.g.
multiple CPU environments).
The Data Server (like the rest of servers) is accessing the Pandora FMS database,
which shares the web server and contains the processed data packets. The server
executes as a daemon or service and processes the gathered packets into its file
system. In spite of its simplicity and its modest use of resources, the data server is
one of the elements critical to the system as it processes all of the agents information,
generates system alerts and events according to that data. The data server solely
works by the XML data from the software agents without conducting any remote
verification.
3.1.2. The Web Server
The web server executes remote monitoring tasks through the web: ICMP tests (ping,
latencies) TCP and SNMP requests. If an agent is assigned to a server, it's always assigned to a web
server, not to a data server. The reason for that is that it's very important that the engines executing
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the Web servers have 'network visibility' to be able to carry out the monitoring tasks assigned to
them and making it possible for a server to connect to a defined network. If we e.g. create a module
for a ping verification on '192.168.1.1' and the agent or module is assigned to a server on
'192.168.2.0/24' without network access to '192.168.1.0/24' we're always going to get a 'down'
reply, because it's unable to establish contact with it.

3.1.3. The SNMP Server (also known as the SNMP Trap Console)
This server utilizes the standard daemon of the traps recollection system which is called
'snmptradp'. This daemon receives SNMP traps and Pandora FMS Server processes and stores them
within the database. While processing and analyzing them, it can also fire the designated alerts in
the SNMP console of Pandora FMS.

3.1.4. The WMI Server
WMI is a Microsoft standard to obtain information from the operating system and Microsoft
Windows environmental applications. Pandora FMS has a dedicated server to conduct native
centralized WMI calls. Thanks to that server it's possible to collect data from Windows systems
remotely and without the need for an agent.

3.1.5. The Recognition Server
The recognition server (or 'Recon Server') is used to explore the Web regularly and to detect new
systems in operation. The Recon Server is also able to assign a monitoring template to recently
detected systems and to apply the modules automatically by default, as defined by that template, so
they can immediately be used to monitor the new system. By using the applications of the NMAP,
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xprobe and traceroute systems, it's also capable of identifying systems by their operating system,
based in the opened ports and to establish the network's topology, guided by the systems it already
knows.

3.1.6. The Accessories Server (Plug Ins)
It executes complex user tests conducted in any language, is integrated in the Pandora FMS
interface and centrally managed. This allows the advanced user to define his own complex, self
developed tests and to integrate them into the application so they can be used in an easy, integrated
way under Pandora FMS.

3.1.7. The Prediction Server
It is a small component of artificial intelligence that implements a data prevision statistically which
is based on past data with a scope of up to 30 days in four temporal references. It allows to predict
the value of a data item in 10 to 15 minute intervals, knowing if a particular data presents an
anomaly. At present, it's based on its past historical performance. You basically won't have to
construct a dynamic baseline by a weekly profile. This server also manages the service monitoring
calculations (BPM) from Pandora FMS versions 5 and above.

3.1.8. The Network Test Server (Goliath)
The Network Test Server Goliath, the Export Server, the Inventory Server, the Event
Correlation Server and the Enterprise Network Server are all features which are only
available to the Enterprise Version of Pandora FMS.

The Network Test Server is used to conduct load testings. It conducts synthetic network testing,
which means complete network testing, including: User identification process, parameters for data
transfer, contents verification, menu navigation, etc. It's basically intended for verification tests
(does it work or not ?) and to obtain latencies (in seconds) of the complete network navigation
experience (including the resources linked to the page like images, full texts, etc).

3.1.9. The Export Server
The export server of Pandora FMS permits the transfer of data from the monitored dispositive of a
Pandora FMS installation to another, making it possible to facilitate replication of any data. This is
particularly useful for large deployments with several Pandora FMS installations, if we e.g. want to
have some critical information centralized in only one of them.

3.1.10. The Inventory Server
The inventory server obtains and visualizes inventory information on the systems: Installed software
and patches, hardware memory chips, hard disks, services running in the system, etc. It's able to
obtain this information both locally and remotely by the software agents.

3.1.11. The Event Correlation Server
This special server can be used to correlate events and generate alerts. This is a special server that
does not monitor, and like the others, can be specified in the configuration for its start up or left
alone. Compared to the rest, this server does not avail the threads configuration or high availability.
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3.1.12. The Enterprise Network Server for SNMP and ICMP
There are two additional servers using advanced strategies to process ICMP (ping) and SNMP
(polling) requests in a way that offers a superior performance to the opensource version, in
exchange for some delicate requests (especially SNMP) as they work with previously validated OID’s
by the opened server.
They use low level binary tools to access the TCP/IP system of the server by conducting block
surveillance in a much more efficient way.

3.2. The Pandora FMS Network Console
This is the Pandora FMS User Interface. This administration and operations console allows to
control the status of the agents, access statistical information, generates graphics and tables of data,
as well as managing incidences with its integrated system to different users with different
privileges. It's also capable of producing reports and defining new modules, agents and alerts as
well as creating other users profiles  and all of that is conducted in a centralized way.
The Web console is programmed in PHP and doesn't require the end user to install any additional
software, neither Java nor ActiveX. Graphics are however available in Flash. To be able to see them
in the format you'll need the Flash application on your navigator, which can be accessed from any
modern platform which supports HTML and CSS. We recommend Firefox 2.x or IE 7.x. The user
experience with ancient browsers like IE6 is very poor, because most of the features implemented in
the Pandora FMS 3.0 console are unusable (and therefore hidden) if you're trying to use them.
The network console is able to operate and supervise multiple servers. This means you may add as
many web consoles as you want, either for load distribution or to facilitate access due to logistical
problems (large webs, several groups with different users, geographical and administrative
differences, etc.) It's a prerogative to have access to the data storage center were Pandora FMS
compiles everything. That means: Access to the database and in case of the Enterprise Version,
synchronized access to the agent's repository of configurations via NFS.

3.3. The Pandora FMS Database
Pandora FMS utilizes a MySQL database. Pandora FMS hosts an asynchronous
database with all the received information, performing a temporary cohesion and
normalizing all the data received from several sources. Each agent's data module
generates a data entry for each packet, which means a real production system can
have a scope of ten million units of data or atoms of information.
This data is automatically managed from Pandora FMS which carries on a periodical and automatic
maintenance service of the database, allowing Pandora FMS to do without any sort of manually
assisted database administration system, be it by an operator or an administrator. This is done by
periodically purging any data after a certain time period (90 days in a preset option) as well as a
compaction of the data which is above a predetermined and configurable number of days (the
default value is '30 days').

3.4. The Software Agents of Pandora FMS
When we're referring to an agent in Pandora FMS, we're distinguishing three essential components
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in the recollection of data:
•The agent.
•The software agent (software application, Pandora FMS agent running in a machine).
•The physical agent (hardware).

3.4.1. The Agent
The Pandora FMS agent itself is basically an organizational element, created with Pandora FMS
Web Console and associated to a group of modules (seen as individual monitoring elements). This
agent can also (optionally) have one or more IP addresses associated to it.
The agent can have associated remote modules, which would have been obtained by web servers,
WMIs, plug ins, etc.
•Verification on whether the engine is connected or on line (PING).
•Verifications on whether a given port is opened or closed.
•Verifications on whether a network, hosted on a specific port of the hardware, is responding
correctly.
•Verification on whether a network, hosted in a specific point of the hardware, has the
desired content.
•Hardware verifications by SNMP (knowing the MIB).
•Latency time verification between the hardware and the Pandora FMS servers.
The agent can also have local modules associated to it. Local modules are those defined in the
software agent's configuration which are also required to be defined within the network console's
agent. If the agent is in 'autolearning mode' (the default setting), these local modules are created
automatically in the web console when a packet of data arrives from the agent for the first time.
Therefore, an 'Agent' may contain modules of both remote and local types. The remotetype
modules are executed by the servers obtaining information remotely (prediction included) and the
local modules are obtained by the Data Server.

3.4.2. The Software Agent
A software agent installed on a remote engine is completely different from the one on the server or
within Pandora's network console. The software agent gathers 'local' information from the engine
where it's executing which ones obtain information on the system by commands.
Pandora FMS Agents can be practically developed in any language as long as it meets the conditions
of the data exchange API from the Pandora FMS Data Server (defined by the XML data exchange).
The window agents operate in a free environment for C++ and employ the same interface and
modularity as the UNIX agents, however coming with several characteristics of their own.
Illustration: Recollection of data in Pandora FMS
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These scripts are built from sub modules and each one of them recollects a portion of information.
Each agent collects several portions of information. These are compiled into one packet and stored
in a single file named 'data package'.
The copy process of the data packet from agent to server is synchronously executed on a regular
basis. That is, within regular intervals defined by the agent which can be modified in order not to
clutter the data base with superfluous information, to overload the web, or to become detrimental
to the system's performance.
The interval is set up to 300 seconds, which is the decimal equivalent of 5 minutes. Lesser values to
100 (seconds) are not recommended, as they can affect the hostsystem's performance. They're also
capable of overloading the database and the central processing system.

It's important to remember that Pandora FMS is not a 'real time system', but a general
monitoring system for systems and applications in environments where real time is
not a critical factor. It may be adapted to operate in environments with response times
of 3 to 5 seconds.
Illustration: Logical diagram of an agent and a physical agent.
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Packet transfers are conducted by the Tentacle Protocol, but they can also be transferred
using SSH or FTP.
With either SSH or Tentacle, the process can be made secure, given that passwords don't travel
through the web nor contain unencrypted confidential data, assuring the confidentiality, integrity
and authentication of the connections between agent and server. The codegenerating process and
also the Tentacle protocol are detailed in the documentation on the installation and configuration of
the agents and servers to be able to carry the SCP (SSH) transfer automatically.
The transfer can be conducted by FTP or any other file transfer system. However, we chose the
Tentacle Protocol due to its security, user friendliness and the numerous options this system
provides.
Please check the documentation annexe on how to configure the transfer protocols.
Pandora FMS agents are designed to be executed from the agent they recollect the data from,
although the agents can recollect information stored in accessible engines from the host on which
they are installed on. They're also known as 'satellite agents'.
It is also feasible to configure an engine in a way to be able to bear several agents of Pandora FMS
simultaneously. This predicament is quite rare. It occurs if we have e.g. a software and a satellite
agent. The standard software agent monitors the engine where it's executed while the installed
satellite agents (there can be several) are monitoring remote systems by Telnet, SNMP or other
proprietary protocols.

3.4.3. The XML Data File
The data file has the following syntax:
<host number>.<serial number>.data
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This data file has an XML structure. It takes its name from a combination of the host names where
the agent is located and a serial number, which differs in each packet and the extension data which
indicates a data packet.
Illustration: Logical structure of a software agent's modules.

<host number>.<serial number>.checksum

The data file is the file which holds the '.data' extension: The verification file by the extension of
'.checksum' contains a MD5 hash of the data file. These allow to perform a final verification to
ensure the data haven't been altered in any way before being processed.
The XML data file the agent generates is at the heart of Pandora FMS. It contains a data packet
along with the information gathered by the agent. This data packet has a compact design: Light and
flexible that allows any user to avail of Pandora FMS agents or to generate information to be
processed in Pandora FMS by its own method. The data file is an XML file similar to the following:
<agent data os_name=”SunOS” os_version=”5.8” timestamp=”300” agent_name=”pdges01” version=”1.0”>
<module>
<name>FTP Daemon</name>
<type>generic_proc</type>
<data>0</data>
</module>
<module>
<name>DiskFree</name>
<type>generic_data</type>
<data>5200000</data>
</module>
<module>
<name>UsersConnected</name>
<type>generic_data_inc</type>
<data>119</data>
</module>
<module>
<name>LastLogin</name>
<type>generic_data_string</type>
<data>slerena</data>
</module>
</agent_data>
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3.4.4. The Physical Agent
Pandora FMS has a physical agent mounted on an ASUS and an Arduino automaton. This tandem,
along with the connected sensors presently facilitates the monitoring of the following
environmental features:
•Humidity
•Temperature
•Ambient lighting
•Presence
Because of the electrical nature of the sensors they are easily calibrated. Their values are also able
to be processed by Pandora FMS without any difficulty. The fact that the sensor is a wireless router
opens up an entire world of possibilities to this type of sensors already present in the CPDs of some
companies.

3.5. Typologies, Schemes and Monitoring Models
There are different models to address the monitoring process, both local and remote. We enumerate
the following common examples for different topologies in order to familiarize the reader with the
possible problems and the solutions Pandora has to offer. Each of the solutions is described in
successive chapters.

3.5.1. Accessible Networks
This is the norm in small, simple webs but also in the very centralized and well organized ones. This
one is the easiest model to implement.
•Network access for centralized remote monitoring. It implies that we can access every
engine from Pandora’s server to probe remotely.
•Network access for agent based monitoring. In this network, we're able to reach Pandora’s
server from the agents installed on the monitoring engine.

3.5.2. LimitedAccess Networks
•Remote Network: This is an unreachable network for remote testing by Pandora FMS. We
are using a software agent as a remote gatherer to test other systems on that end. We call
these 'operating modes': A 'satellite agent mode' (when all testing is carried out within the
same agent) and a 'broker agent mode' (if it impersonates several agents but all tests are
actually carried out in the same physical engine).
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Deployment model for remote and inaccessible networks in Broker Mode

•Software agents without access to a Pandora FMS Server. In this case, we're going to use
the proxy characteristics of the software agents, allowing an agent without access to the
server to use an agent with access to connect by it.

Deployment model for remote networks by using the Proxy Agent Mode

•The need to conduct remote server monitoring for different networks: In this situation
we're going to mount several different servers of Pandora FMS. Connected to the same
database, one server is going to execute a battery of predefined tests and a different one by
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another. Both servers operate within the same environment which are getting managed from
the console simultaneously.

3.5.3. Special Organizational Characteristics
•The need to monitor several headquarters by monitoring equipment and different
configurations. In this case, we're using an export to duplicate a part of the monitoring in an
independent environment segregated from Pandora FMS.

Hierarchical export model along with an Export Server

•Duality of Reporting: We can configure additional agents to support two different Pandora
FMS Servers, although only one will be able to manage it.
•Fragmented Management: It's pretty useful if you're required to delegate the
administration of part of the equipment to different personnel with different access levels.
This is more of a management issue rather than an architectural problem. It can be resolved
by the assigned permissions within the management policies.

3.5.4. Large Environments
•A LargeVolume Network, consisting of thousands of network testing processes which
we're to distribute within different 'remote monitoring probes'. Given their large numbers
(over 50,000) we can't centralize them into a single server. To do so, we're going to use
different servers in Broker Mode which distributes the remo by its own method, the testing
load.
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Distribution of remote testing model with agents in broker mode

In case of a primary hardware failure, we're required to setup a HA Server for security reasons.
We're going to learn how to mount two servers: One ‘passive’, waiting in standbymode for the
active one to stop responding so it can start working. There are several ways to set them up in this
way.
•The need to monitor a large volume of systems and manage them in a centralized
way (more than 2500 agents). In order to do so, we're configuring different Pandora FMS
Servers, coordinated by the same system we call 'metaconsole'. They can be linearly scaled in
this way.
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The metaconsole model
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4 PANDORA FMS GLOSSARY OF TERMS
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One of the things which are sometimes difficult to understand in the beginning are the terms we
use. If you came from another monitoring system or if you don't know any previous one, it's quite
difficult. The main purpose of this glossary is to unify and define all the term definitions usually
used in Pandora FMS in a detailed way.

4.1. Agent
An agent in Pandora FMS is an organizing company. It is usually a machine, system or host (a
computer). The agent contains information and belongs to one group. An agent could also be an
organizing unity, different from a computer. It could be a building, a vehicle or anything else that
'contains information'. The agent contains information stored in different modules. The agent could
be linked to other agents by a parental connection (an agent could be the son of another agent).
Therefore, the agent is an organizing unity within Pandora FMS  a concept where information from
other information units called modules is stored.

4.2. Software Agent
Though it's named the same as the previous concept, the software agent refers to the software
which is installed on the computers to automatically collect information. This program is called the
'Pandora FMS Agent' and it's installed on all types of systems: Windows, UNIX, etc. The software
agent is an appliance that generates a data file that is sent to the Pandora FMS through the
network, usually by the Tentacle Protocol.

4.3. Module
One module is an atomic information entity that stores values (numerical or alphanumerical text).
Each module only stores one kind of data, from the same kind. That's to say, the module that stores
the traffic flow in one router, only store this value (numbers that increases as time goes on). The
agents are contained inside the agents, and they are always related to an only agent. An agent could
have N modules. The modules are not connected between them.

4.4. Remote Server
Server that is on net and that isn't the local server.

4.5. Server
The Pandora FMS Server is the element which processes the collected information in different ways.
They are also the ones that execute alerts and send the data to the database. There are many
subtypes of Pandora servers, and each one conducts one operation. The servers type of network, e.g.
conducts remote monitoring tests (at a distance, whereas the data servers process the collected XML
data).
Sometimes, we refer to a 'Server' when speaking about a system, to a computer.
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4.6. Console
The console or web console is the web application which allows to manage Pandora FMS by using
the web.

4.7. Group
A group is an organizing element. The groups have agents, and are used as reference to fix the
things a user could see and the ones it can't. For example, when a report is defined and it's
associated to one group, only the users with access to this group are able to see this report.
The groups can also contain other groups, but this hierarchy couldn't be seen (at least in version 3.1
and previous ones) in any other way nor is it taken into account in the permission system.

4.8. Profile
It's a group of 'permissions' on different operations which are possible under Pandora FMS: To see
an agent, modify an agent, assign alerts, define reports, manage the database, etc.

4.9. ACL
ACL is an English acronym for Access Control List, or 'Listas de Control de Accesos' (LCA in
Spanish), that in Pandora FMS are defined by assigning a profile in a group to one user.

4.10. Monitor
It's a module with an associated state. In previous versions of Pandora FMS, only the boolean
modules had states ('normal', if they are at '1' and 'critical' if they are at '0'). At present, all the
modules allow to define thresholds for three different states. When a module hasn't information
about an associated state, it doesn't know when to change to a 'critical' or 'warning' state, so it's
simply a module.

4.11. Data Files / XML Data
An XML file is a data file, generated by the Pandora FMS software agents. Besides containing the
agent modules information, it contains information about the agent itself (the version, the operating
system, etc.). The XML format is a standard in computing, and it's quite useful to contain data. For
more info about the XML format, please read the detailed explanation of XML.

4.12. Alert
An Alert is a request of an alert template, associated to a specific module. It can have different
associated actions and has two possible states: 'Fired' and 'not fired'. The alert, in Pandora FMS,
does that when something happens  e.g. if a server is down, Pandora FMS interprets this and it
56

Alert

sends an email or an SMS to a person, displaying what happened.

4.13. Alert Template
An Alert Template is one of the alert's three main components. It defines an alert's configuration in
a general way (properly speaking we call alerts to a template request). It allows to specify the firing
condition, which can depend on the module's value or state and other details, such as the maximum
number of times it's going to be fired within a specific interval or recovery options.

4.14. Action
The action is one of the alert's parts. Actions are requests which is, the particularity of one
command. This particularity takes care for the actions to include specific parameters, e.g. on the
command 'eMail' we could define the actions 'Send an email to the administrator' and 'Send an
email to the project distribution list', defining some of the fields the command had, specifying the
administrator's email or its distribution list, following the previous example.

4.15. Command
A Command is another component of the Pandora FMS list. Excluding the Pandora FMS internal
commands which allow to generate events, send emails, etc. A command represents a program or
external utility the server executes.

4.16. Shell or Command Line
The Shell or Command Line is an interface which allows the introduction of commands by using the
keyboard.

4.17. Package
A package contains a program or group of programs packaged in a specific format, ready to be
installed in a specific operating system and version, e.g. an RPM package for OpenSUSE Linux.

4.18. Tarball
It's the same as a package. It contains a program or group of programs packed in the TAR format,
but different from this, it doesn't contain information about on how to install it, and they aren't
specific for a specific operating system, although it's possible.

4.19. SVN / Subversion / Code Repository
SVN / Subversion and Code Repository are version control systems which store one repository along
with the different version of the files which are assigned to one project as long at it exists. The
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group of files within a specific moment of time is called 'Revision', so two people which have the
same project's revision are going to have two identical copies of the same files.

4.20. Database
A Database is a group of data which belongs to the same context and is stored systematically for its
later use. Pandora FMS uses relational databases, within which the place and the way data is stored
has no particular importance. You can have access to them by a structured language of standard
requests (e.g. [http://en.wikipedia.org/wiki/SQL SQL).

4.21. Database Sketch
The Database Sketch describes the database structure in a formal language. In a relational database,
the sketch defines the tables, the fields of each table, and the connections between fields and tables.

4.22. Tentacle
Tentacle is the data transfer protocol the software agents use to send data to the Pandora FMS
Server. Tentacle is multi platform compatible and designed to be an easy to use and secure
protocol.
By
default,
it
uses
port
41121
(assigned
by
[http://en.wikipedia.org/wiki/Internet_Assigned_Numbers_Authority IANA.)

4.23. State
We usually refer to the state of one module. It gives us information about the module at the present
moment. The state of an agent is determined by considering the worst of the state of all its modules
as a group (if it has 5 modules and one is in 'critical', two in 'warning' and two in 'normal'), the
module's state will be 'critical'. Same goes for the state of one group.

4.24. 'Critical' and 'Warning' States
'normal', 'warning' and 'critical' are one module's the three possible states. The 'warning' and 'critical'
states usually show error conditions of different severity. Pandora FMS allows to define different
thresholds for the 'warning' and 'critical' states of each module independently.

4.25. 'Unknown' State
We say that one module is on state unknown if it doesn't receive data from more than twice its
interval. This is, one module that sends data every 5 minutes is selected as unknown after 10
minutes of no receiving any data. Although, the module still keeps its state NORMAL, WARNING or
CRITICAL depending on the last data that it got.

58

Alert Threshold

4.26. Alert Threshold
It's the time interval in which the defined restrictions are applied when configuring the alert
template. For example: An alert template which defines a '10 minutes' threshold and a maximum
alert number of '5', warranties that the alert won't be fired more than 5 times within a 10 minutes
interval. Besides, the alert will remain fired until this time interval ends, except if the recovery is
already configured.

4.27. False Positive / Negative
If a check returns an error but hasn't take place, we consider it a false positive. If it doesn't give back
any error and it has taken place, we say that it's a false negative, e.g. we have a false positive if a
module returns '1' if the server is available and '0' if it isn't, although it returns '1' but the server is
not available.

4.28. FlipFlop Protection
The flipflop protection of one module displays the number of times the state changes its condition.
This feature allows to protect one module from false positives or negatives. For example, if we know
that a module returns false positive, but never more than twice in a row, we can configure the flip
flop protection to '3' in order to avoid the false positives would cause state changes.

4.29. Synchronous Monitoring
We consider a module as synchronous if it returns data in regular intervals, e.g. a temperature
measurement every 5 minutes.

4.30. Asynchronous Monitoring
We consider a module as asynchronous if it returns data, depending on its availability, e.g. it
searches for a string in a log file. If it doesn't find the string, the module doesn't return data.
Another very common example is the one of SNMP traps which are only generated if an error
takes place (e.g. a powersupply failure).
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5 PANDORA FMS INSTALLATION
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5.1. Minimum Hardware Requirements
5.1.1. Console and Server Requirements
•Up to 500 agents or 5.000 modules: 3GB of RAM, a 2.5GHz singlecore CPU and a fast
hard drive, 7200 RPM or equivalent, assuming 80% of modules with history and an average
interval of 5 min.
•Up to 2.000 agents or 10.000 modules: 6GB of RAM, a dual core 2.5GHz CPU and a very
fast hard drive (10000 RPM or more), assuming 80% of modules with history and an
average interval of 5 min. You're also required to tune up your MySQL very well.
•For more than 4.000 agents: 12GB of RAM, a 3GHz quadcore CPU and the fastest hard
drives available on the market (15,000 RPM or more), assuming 80% of modules with
history and an average interval of 5 min. It's recommended to have MySQL installed onto
another server. You're required to tune up your MySQL very well or to have 'Percona XtraDB'
installed.

It's not recommended to use Pandora FMS in virtual environments, since the disk access
requirements are very high. In case you have to do so, it's strongly recommended to
assign independent RAM, CPU and hard disks instead of using a part of the host's
resources and to use SAN disks in these kinds of environments.

It's strongly recommended to use Pandora FMS in virtual environments for testing,
certification or development environments, but never in productive systems !

Disk size: A minimum of 15GB free space. It's recommended to have 25GB.

5.2. Software Requirements
The officially supported OS platform for Pandora FMS is Linux. From Pandora FMS versions 5.1 and
above, Windows Server is also supported. The supported Linux distributions and versions for the
server and console are as follows:

Component

Operating System
• RedHat Enterprise (RHEL) 6.x
• CentOS 6.x
• SLES 11 SP1 or higher.

Pandora FMS 5.1 or higher

• OpenSUSE 11.x or higher.
• Debian 5.x or higher.
• Ubuntu 11 or higher.
• Microsoft Windows Server (2003 or higher)
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We don't offer official support for them, but other platforms where Pandora FMS works are as
follows:

Component

Operating System

Pandora FMS 4.0 or higher

• FreeBSD 9.1
• Solaris 10 / OpenSolaris

The Pandora FMS Agents run on almost any modern operating system. Please take a look at the
Agent Requirements section for more details.

5.2.1. Database Requirements
Prior to installing Pandora FMS, you're required to have a MySQL Database up and running (Oracle
and Postgre SQL supports are still experimental). You're also required to have a MySQL Server
running on a server. It may be the same server you're going to install Pandora FMS on. You may
also utilize a separate server which is accessible from your Pandora FMS Server / Console using a
TCP/IP network. To do so, you're required to have:
•The IP Address of your MySQL Server: ('localhost' if it's installed on the same Pandora
FMS Server Host).
•A privileged User:A user who has the rights to create databases and users (usually the user
named 'root'). This user must be allowed to connect from the IP address of your Pandora
FMS Server host.
•A Password: A password for privileged users.

You're required to get this up and running before installing Pandora FMS. If you don't
know how to install a MySQL Server, please check the On-Line Documentation for the
entire process on how to do that, because this procedure changes considerably on
different operating systems and Linux distributions.

5.2.2. Agent Requirements
The remote agent is able to run on any hardware which is able to run the minimum required
operating systems.
Alongside Linux, Pandora FMS Agents work on the following systems:

Component
Pandora Agent (versions 4.0 or above)

Operating System
• Linux (all distributions)
• HPUX 11.x or higher, with Perl 5.8.
• AIX 4.3.3 or higher, with Perl 5.8.
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• BSD (NetBSD, OpenBSD, FreeBSD), with Perl
5.8.
• MacOSX.
• Solaris 8 or higher, with Perl 5.8.
• Windows NT4 (see special version notes
here).
• Windows XP
• Windows 2000
• Windows 2003
• Windows 2008
• Windows 7
• Windows 8
• Windows 2012
Pandora Android Agent (versions 2.0 or
above)

• Android 2.2 or above

Pandora Embedded Agent (versions 4.0 or
above)

• Embedded devices require compilation.

It's well known that the agent has been implemented successfully into other operating
systems, but there is no official support for them. The agent does not work under
Windows NT4. To be able to monitor outdated Windows systems, you may install the
'Cygwin' environment and the Agent for Linux. If you intend to do so, please expect the
performance to be much lower than it would be under current Windows versions.

Under UNIX platforms, you're additionally required to have installed:
•'Perl 5.8' or higher.
•You may optionally unzip the package and execute it via path by the user on which the
Pandora FMS Agent gets hosted on. This package is only required if you intend to use the
file collection.
•If you intend to use the local inventory plug in to obtain information from the hardware,
you're required to install the tool named 'lshw' which requires to have full access and the
right to execute itself from the system path.

5.2.3. Server Requirements
You can also work on any operating system with Perl 5.8 installed and iThreads enabled.
It should be noted that Pandora FMS requires a MySQL server to store all information. This server
may be installed on any MySQLsupported platform. This could be Windows, Linux, Solaris, etc.
It's required to have Perl 5.8 installed, at least for the server to work appropriately. In addition to
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the operating system's SNMP packets ('netsnmp') to utilize the Pandora FMS SNMP service, it also
requires a MySQLDatabase, NMAP packages and the optional xprobe2 to be able to use the
advanced features of the Recon Server and traceroute's Perl libraries to be able to setup a self
discovering network. It's also necessary to install the WMI client's binary for WMI queries against
Windows systems. The client binary is a part of the SAMBA project (v4) and can be compiled, but
not without some difficulty under any UNIX environments.

5.2.4. Console Requirements
The console requirements are the same as for the server. We recommend its operation being
resident on Linux systems, but like the web interface it's a pure AMP application (Apache, MySQL
and PHP). Theoretically, it could work on any system which is able to run Windows, Unix, etc.

5.2.5. WebAdministration Requirements for the Tool
You're required to have a web browser installed to verify the operations of the console. It's not
required to have the Flash plug in installed in your browser to start, but it's recommended to utilize
some of the interactive Flash graphics.

5.2.6. Package Dependencies
Pandora FMS has a heavy dependency on the GNU/Linux Operating System, but it also needs
additional packages which aren't installed by default in many cases. During the installation process,
there is a detailed list of package dependencies for Debian, Ubuntu and OpenSUSE.

5.3. Issues prior to Installation
5.3.1. MySQL
You will need to have a MySQL Server installed BEFORE configuring Pandora FMS, because in one
of the steps, you're required to access a running MySQL server instance. For doing that, you need to
have it operational. If you are installing the MySQL Server at the same time as Pandora FMS,
remember that you need to set up the MySQL server properly prior to configuring Pandora FMS.
This is easily done in two steps:
1. Please start the MySQL Server daemon:
/etc/init.d/mysql start

2. Configure the root password for the MySQL root user:
mysqladmin password <password>

Where '<password>' is the password you have to setup for the MySQL root user (which is different
from the systems 'root' user). The system is going to ask for this password throughout the entire
Pandora FMS installation process.

5.3.2. Pandora FMS Installation Order
You're required to follow this sequence in order to install Pandora FMS properly:
1.Install console
2.Install server
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The reason for this is the MySQL database configuration is made during the initial configuration
phase of the console installation. To ensure the correct working of the server, it's recommended to
conduct the whole console's installation process first.
The Pandora FMS Server and console are also possible to be hosted on different machines, because
you can configure the server to utilize a remote MySQL database by means of the server's
configuration file.
Regarding the agent: You may install it before or after installing the server and console, because the
agent works independently and it's capable of getting installed on any machine.

5.3.3. Installing the Enterprise Version
From versions 4.0.2 and above, the license number of Pandora FMS activates all features of the
Enterprise Version. If you're installing the Pandora FMS 4.0.2 Enterprise without a valid license
number, it's not going to work. You first have to install the opensource version, get the license
number and install the Enterprise Version.
In summary:
•Please install the opensource console.
•Please access the console, go to the setup section and insert your license code as shown on
the picture below.
•Install the Enterprise Console.
However, if you do it in any other order, the screen which reports the error to you could be used for
inserting the license number.
Please enter the license number in the main configuration option (setup):

From Pandora FMS versions 5 and above, the security for license verification was improved and
requires a different method of license installation. In order to install the license for versions 5 and
above, you're required to install the enterprise console and access the login screen first. Once you've
agreed, a window called License Application v5.X is going to open.

5.3.3.1. Special Requirements for the Enterprise Version
In order to use the ICMP Enterprise Server, you're required to have NMAP 5.51 or a higher version
installed.

5.4. Installing the Appliance CD
Due to the length of this section, we have established a special screen shotequipped section. It's
called Appliance CD Installation.
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5.5. Installing the VMWare Virtual Machine
Alongside the Centos ISO, you can find a virtual machine which contains an already installed
Pandora FMS under 'sourceforge.net'. This image is tested with VMWare ESX, VMWare Workstation,
VirtualBox and HyperV. To run it under HyperV, you're required to export the VMDX and VDH
files from the 'MVDC.exe' executable. They are available after you've installed the Microsoft Virtual
Machine Converter.
To install it, you have to execute the '.ovf' file under 'Virtualbox' and 'VMWare Workstation'. Under
ESX and HyperV, you're required to import the image under 'Import VM' and select the virtual
image there.
The credentials for this machine are the following:
User: root
Password: pandora
Console User: admin
Password: pandora
MySQL user: root
Password: pandora

5.6. Installation under SUSE (OpenSUSE or SLES)
5.6.1. Automatized Installation by the Official Repository
You're required to have access to the internet to perform this kind of installation. This method is
easy and fast. All steps are required to be conducted as a 'root' user or by the use of 'sudo' before
entering any command:
Step 1: Please create a repository by entering the following command:
zypper ar -G http://artica.es/suse PandoraFMS_Official_Repo

Step 2: Update the repository's information:
zypper refresh

Step 3: Install Pandora FMS:
zypper install pandorafms_agent_unix pandorafms_console pandorafms_server mysql-community-server
apache2-mod_php5

This is going to install Pandora FMS and all of it's dependencies by a single command.

5.6.2. Manual RPM Installation
5.6.2.1. Configuring Software Repositories

The installation of software on SLES (SUSE Linux Enterprise Server) is conducted
via RPM packets. These RPM packets can contain official software provided by the
manufacturer Novell. The installation DVD / CD or HTTP / FTP repositories or other
non-official repositories are maintained by the community of developers and users of
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SUSE (OpenSUSE). These repositories can only be accessed by the internet, but the
individual RPM packages may be downloaded, copied to servers and manually
installed by the command line.
SLES utilizes a general management interface (YAST) for package management and software
repositories. This interface is used to manage the entire SLES system: Disk partitioning, installing
software, configuring the NICs, etc. It can be used with graphical interface (X), any console or
remote session via SSH.
For this documentation, we've used the 'Zypper' tool from SUSE, which is capable of solving
dependencies and downloading packages directly from the repositories on the internet. If you don't
have Zypper installed, you should install it, because it's faster and much more convenient. If you
don't, you're required to have to conduct all the entire installation of packages using YaST and the
SUSE Installation CD manually.

5.6.2.2. Previous Dependencies Installation
You're required to install the following package dependencies (which are included under SUSE):
apache2 apache2-mod_php5 php5 php5-gd php5-gettext php5-json php5-mbstring php5-ldap php5-mysql \
php5-pear php5-snmp php5-zip nmap perl-DBD-mysql perl-DBI perl-Date-Calc perl-HTML-Parser \
perl-HTML-Encoding perl-HTML-Tree perl-IO-Socket-inet6 perl-Socket6 perl-Mail-Sendmail perlNetAddr-IP \
perl-TimeDate perl-XML-Simple perl-XML-Twig perl-libwww-perl mysql-client mysql-max mysql \
net-snmp xorg-x11-fonts-core php5-pear-db php5-curl php5-xmlrpc perl-SNMP graphviz graphviz-gd

Unlike SLES, OpenSUSE doesn't have a 'mysql-max' package. You may install the
MySQL standard package without experiencing any problems.

In order to install all dependencies, please just execute:
zypper install ..

Followed by the whole package list, specified in the paragraph above, this is going to display a
screen like the one on the picture below:
Getting repositories data...
Reading packets installed...
perl-DBI already installed.
perl-HTML-Parser already installed.
perl-TimeDate already installed.
perl-XML-Simple already installed.
perl-libwww-perl already installed.
xorg-x11-fonts-core already installed.
Resolving dependencies...
Following NEW packages will be installed:
apache2 apache2-mod_php5 apache2-prefork apache2-utils libapr1 libapr-util1 libdnet1
liblua5_1 libmm14 libmysqlclient15 mysql mysql-client mysql-Max net-snmp nmap
perl-Bit-Vector perl-Carp-Clan perl-Data-ShowTable perl-Date-Calc perl-Date-Manip
perl-DBD-mysql perl-HTML-Encoding perl-HTML-Tree perl-IO-Socket-inet6
perl-Mail-Sendmail perl-NetAddr-IP perl-SNMP php5 php5-ctype php5-dom php5-gd
php5-gettext php5-hash php5-iconv php5-json php5-ldap php5-mbstring php5-mysql
php5-openssl php5-pdo php5-pear php5-snmp php5-sqlite php5-tokenizer php5-xmlreader
php5-xmlwriter php5-zip php5-zlib t1lib
Total Size: 19.1 M. After the operation, additional 55.9 M will be used.
Continue? [Yes / no]:
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By clicking 'yes', Zypper starts downloading and installing the packages.
When finished, you're required to install some extra packages. Under OpenSuse, not all the required
packages for Pandora FMS exist yet. They are going to be provided by an additional RPM to satisfy
the dependencies from the Pandora FMS Sourceforge website. The additional RPMs are the
following:
perl-time-format php-pear-xml_rpc wmic smstools perl-HTML-Tree perl-XML-Twig

Extra packages like 'Perl-HTML-Tree' and 'Perl-XML-Twig' are required to be installed
manually.

If you intend to use the Recon Server, you're required to install these additional packages:
perl-net-traceroute perl-net-traceroute-pureperl xprobe2

These RPM files can be found on the official distribution site of Pandora FMS Software in a specific
dependencies directory for OpenSUSE.
{{Tip|Please make sure to download the appropriate packages for OpenSUSE.
Please put them in a directory, e.g.: '/tmp/extra' and execute the following command:
rpm -i *.rpm

5.6.2.3. Agent Installation
You're required to download an RPM package similar to this one from our web site (the version or
some other details could be slightly different):
pandorafms_agent-3.0.0-1.noarch.rpm

In order to install it, just execute this command:
rpm -i pandorafms_agent-3.0.0-1.noarch.rpm

If these phrases are shown:
Insserv:warning:script 'smsd' missing LSB tags and overrides Insserv:defaultstart undefined,
assuming default start runlevel (s) for script 'smsd'.
Don't worry. It's just a warning message, not an error.

5.6.2.4. Server Installation
Same as on the agent. Just execute:
rpm -i pandorafms_server-3.0.0-1.noarch.rpm

If you have installed the agent before that, you'll get the following (quite unimportant) warning:
useradd: Account "pandora" already exists.
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5.6.2.5. Console Installation
Please execute the RPM installation tool for packages in order to install the package which contains
the Pandora FMS Console:
rpm -i pandorafms_console-3.0.0-1.noarch.rpm

If you have any trouble installing the Pandora FMS console caused by a wrong package name, you'll
probably get an error message such as this:
error: Failed dependencies:
php5-pear-db is needed by pandorafms_console-3.1-1.noarch

You can force the installation by using the 'nodeps' flag.

5.6.3. Uninstalling Pandora FMS
You're able to uninstall any of Pandora FMS components by using the following commands:
rpm -e pandorafms_agent
rpm -e pandorafms_console
rpm -e pandorafms_server

The Pandora FMS database won't get uninstalled if any of the Pandora FMS packages are  just all
files from any other package (including the configuration files) are going to be deleted.

5.7. Installation in Red Hat Enterprise Linux / Fedora / CentOS
The installation process is nearly the same as the one from SUSE. Please keep in mind that RHEL,
CentOS or Fedora RPM packages aren't the same as the ones in SUSE  there are also some
incompatibilities.
First of all, you're required to add some official repositories to your system. Subsequently, you may
choose to add the Pandora FMS official repository to conduct an installation from the online
repositories. Adding this additional repositories is going to help you to install all required
dependencies for Pandora FMS.
Edit /etc/yum.repos.d/CentOSBase.repo and enable EXTRAS, and UPDATES repos. Usually should
be something like this:
[updates]
name=CentOS-$releasever - Updates
mirrorlist=http://mirrorlist.centos.org/?release=$releasever&arch=$basearch&repo=updates
gpgcheck=1
gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-CentOS-6
[extras]
name=CentOS-$releasever - Extras
mirrorlist=http://mirrorlist.centos.org/?release=$releasever&arch=$basearch&repo=extras
gpgcheck=1
gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-CentOS-6

We're also going to add the EPEL repository:
[EPEL]
Name = EPEL
baseurl = http://dl.fedoraproject.org/pub/epel/6/$basearch/
enabled = 1
gpgcheck = 0
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Please refresh your repository information by this command:
yum makecache

5.7.1. Automated Install by using the Pandora FMS Repository
You're going to need YUM and access to internet. First, you're required to create a reference to the
Pandora FMS official repository for CentOS 6. This also applies for the usage under RHEL6.
vi /etc/yum.repos.d/pandorafms.repo

Add this contents:
[artica_pandorafms]
name=CentOS6 - PandoraFMS official repo
baseurl=http://artica.es/centos6
gpgcheck=0
enabled=1

Please refresh your repository information:
yum makecache

You can now install Pandora FMS along with the MySQLServer. This is an 'optional' dependency.
You're required to have a MySQL server if you don't already have one.
yum install pandorafms_console pandorafms_server mysql-server

This is going to download all RPMs and dependencies, install them for you and leave the system
ready for setup.

5.7.2. Manual Installation by RPM Files
Most of the dependencies should be resolved using YUM or any other automatic package. All
dependencies are marked as needed packages in the RPM definition:
yum install php php-gd graphviz php-mysql php-pear-DB

php-mbstring php-ldap php-snmp \

php-ldap php-common php-zip nmap
yum install perl-HTML-Tree perl-DBI perl-DBD-mysql perl-libwww-perl perl-XML-Simple \
perl-XML-SAX perl-NetAddr-IP net-snmp net-tools perl-IO-Socket-INET6 perl-Socket6 \
nmap sudo xprobe2 make perl-CPAN perl-JSON net-snmp-perl perl-Time-HiRes perl-XML-Twig

Some dependencies (like 'wmic' or 'xprobe2') aren't contained in the official RHEL repositories.
We're providing them on our Sourceforge download page as Tools and Dependencies.
Some other dependencies like 'graphviz', 'perlXMLSimple' or 'perlHTMLTree' are in the additional
repositories we've installed before. It's important that you activate/install it prior to executing yum.

If you're using a version prior to RHEL6, some dependencies could have another name,
e.g. 'perl-SNMP'. Under CentOS5, RHEL5, etc. it would be called 'net-snmp-perl'.

In order to install the RPM, just e.g. use the 'rpm i' or the yum command directly:
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rpm -i pandorafms_server-x.x-x.noarch.rpm

or
yum install pandorafms_server-x.x-x.noarch.rpm

If you encounter any problems at the time you're trying to access the Pandora FMS Console
installation web page, please check if SELinux is active: In this case, it's mandatory to deactivate it.
Please follow theFAQ procedures in such a case.

RHEL and CentOS 5.x use PHP 5.1 by default. This version is not compatible with
Pandora FMS. You're required to use PHP version 5.2 or above.

To do so, we recommend to use the following repository for CentOS5/RHEL5, which contains PHP
5.2:
[c5-testing]
name=CentOS-5 Testing
baseurl=http://dev.centos.org/centos/5/testing/$basearch/
enabled=1
gpgcheck=1
gpgkey=http://dev.centos.org/centos/RPM-GPG-KEY-CentOS-testing

5.8. Installation under Debian and Ubuntu
It's recommended to install Pandora FMS on a 10.04 version or above. On Debian Stable ('Squeeze')
versions, it's possible to experience problems due to old versions of some required optional
software, such as: The Debian LWP library does not implement some methods for SSL. This is
necessary for the monitoring of Enterprise WEB modules to get fixed by installing a newer version
of LWP by CPAN (manual method). You also require an NMAP version 5.51 or above to use the
Enterprise ICMP Server. 'Squeeze' comes with version 5.0. You may install a newer version, using
those packages. We're recommending to use the unofficial DEB or to compile a version for
yourselves.

If you install under Debian Squeeze, you're required to add the 'Non-Free' repository for
the package 'snmp-mibs-downloader'.

Due to the nature of Debian packaging (if you choose Debian or Ubuntu), you're
required to have access to the internet or a local package repository to conduct the
installation. A single dependency under Debian could have sub-dependencies. The
installation without access an on-line repository could turn out to be very complex.
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5.8.1. Installation by using the Artica Private Repository
There's also a much faster and easier method: Just add the Artica Private Repository. It contains any
and all the Ubuntu and Debian packages you might require.
In order to do so, please edit the file '/etc/apt/sources.list' and add the following line:
deb http://www.artica.es/debian/squeeze/

Execute as root (sudo)
apt-get update

Installation of Pandora FMS by aptget:
root@debian:~# apt-get install pandorafms-console pandorafms-server pandorafms-agent-unix
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
apache2-mpm-prefork apache2-utils apache2.2-common dbconfig-common graphviz libapache2-modphp5 libcgraph5 libcurl3 libgd2-xpm libgvpr1
libio-socket-inet6-perl libnetaddr-ip-perl libonig2 libqdbm14 libsnmp-perl libsocket6-perl
libssh2-1 libtime-format-perl
libxml-namespacesupport-perl libxml-sax-expat-perl libxml-sax-perl libxml-simple-perl nmap
php-db php-gettext php-pear php5 php5-cli php5-common
php5-curl php5-gd php5-ldap php5-mysql php5-snmp php5-suhosin php5-xmlrpc smistrip snmp snmpmibs-downloader snmpd xprobe
Suggested packages:
apache2-doc apache2-suexec apache2-suexec-custom graphviz-doc libgd-tools php5-dev
The following packages will be REMOVED:
libgd2-noxpm
The following NEW packages will be installed:
apache2-mpm-prefork apache2-utils apache2.2-common dbconfig-common graphviz libapache2-modphp5 libcgraph5 libcurl3 libgd2-xpm libgvpr1
libio-socket-inet6-perl libnetaddr-ip-perl libonig2 libqdbm14 libsnmp-perl libsocket6-perl
libssh2-1 libtime-format-perl
libxml-namespacesupport-perl libxml-sax-expat-perl libxml-sax-perl libxml-simple-perl nmap
pandorafms-agent-unix pandorafms-console
pandorafms-server php-db php-gettext php-pear php5 php5-cli php5-common php5-curl php5-gd
php5-ldap php5-mysql php5-snmp php5-suhosin php5-xmlrpc
smistrip snmp snmp-mibs-downloader snmpd xprobe
0 upgraded, 44 newly installed, 1 to remove and 0 not upgraded.
Need to get 40.9 MB of archives.
After this operation, 90.8 MB of additional disk space will be used.
Do you want to continue [Y/n]? y
WARNING: The following packages cannot be authenticated!
pandorafms-agent-unix pandorafms-console pandorafms-server
Install these packages without verification [y/N]? y

5.8.2. Manual Installation by DEB Packages
Under Debian or Ubuntu, the dependencies are the following:
Server:
snmp snmpd libtime-format-perl libxml-simple-perl libdbi-perl libnetaddr-ip-perl
libhtml-parser-perl wmi-client xprobe2 nmap traceroute
libio-socket-inet6-perl libhtml-tree-perl libsnmp-perl snmp-mibs-downloader
libio-socket-multicast-perl libsnmp-perl libjson-perl

If the 'wmi-client' package is not available in the repositories, you're required to
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download it from the Pandora FMS Sourceforge website.

Console:
php5 libapache2-mod-php5 apache2 mysql-server php5-gd php5-mysql php-pear php5-snmp php-db phpgettext
graphviz mysql-client php5-curl php5-xmlrpc php5-ldap

In order to install the Server package or the console, you first have to implement all of the required
dependencies. This is done by installing all the before mentioned packages by using the
command aptget along with root privileges:
apt-get install snmp snmpd libtime-format-perl libxml-simple-perl libdbi-perl libnetaddr-ip-perl \
libhtml-parser-perl wmi-client xprobe2 nmap libmail-sendmail-perl traceroute libio-socketinet6-perl \
libhtml-tree-perl php5 libapache2-mod-php5 apache2 mysql-server php5-gd php5-mysql php-pear
php5-snmp \
php-db php-gettext graphviz mysql-client php5-curl php5-xmlrpc php5-ldap libsnmp-perl snmpmibs-downloader \
libio-socket-multicast-perl libsnmp-perl libjson-perl

The character '\' is used as a line divider. You may copy and paste it directly out of this
documentation into the console and the line breaks will be considered as such.

This command would install all the dependencies required to install the Pandora FMS Server and its
console into a Debian or Ubuntu system.
The installation with the DEB packages is very easy. First, you're required to download all the
necessary packages. Subsequently, you're required to execute the following commands in the same
directory in which you've put the packages.
In this example they are installed all together, but it could also be just one of them.
dpkg -i pandorafms-console_xxx.deb pandorafms-server_xxxx.deb

Once the command has been executed, you might see that some dependencies are missing. If so,
you can try to solve it automatically by using the following command:
apt-get -f install

This will attempt to download all the necessary missing packages from the automated installation of
Pandora FMS on the system. Once the necessary packages have been installed, you're required to
continue with the installation of all Pandora FMS components.
In order to complete the installation of the Pandora FMS Console, you have to access the console
URL and follow the steps suggested by the installation wizard. If the console is installed on a server
with the IP of e.g. '10.20.34.54', you're required to enter the following URL:
http://10.20.34.54/pandora_console
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5.8.3. Uninstalling Pandora FMS
dpkg -r pandorafms-console-enterprise
dpkg -r pandorafms-console

5.9. Installation in FreeBSD
From version 3.2 and above, Pandora FMS supports the use of FreeBSD as an operating system.

5.9.1. Perl with iThread Installation
To execute the Pandora FMS Server Daemon, Perl is required to be compiled with enabled iThread,
although the FreeBSD perl 5.x (5.8 or later) package named 'perl5.x.x.pkg' comes without iThread,
so it cannot be used.
Therefore, you're required to compile and install the perl 5.x executable by using the FreeBSD ports
collection like described below.
cd /usr/ports/lang/perl5.x
make config
-> Enable ITHREADS.
make
make install

5.9.2. Previous Dependencies Installation
In FreeBSD, the dependencies are the following:
Server:
databases/p5-DBI mail/p5-Mail-Sendmail net-mgmt/p5-NetAddr-IP textproc/p5-XML-Simple
devel/p5-Time-Format www/p5-HTML-Parser net/p5-Net-Traceroute-PurePerl
net/p5-IO-Socket-INET6 database/p5-DBD-mysql textproc/p5-XML-Twig converters/p5-JSON
net-mgmt/net-snmp security/nmap net/xprobe sysutils/coreutils net-mgmt/net-snmp
net-mgmt/wmi-client

In order to install the Pandora FMS Server, you're required to implement all the dependencies
before doing so. It's recommended to do so by using the ports collection. Please don't use packages
here.
You may install all the necessary dependencies in the following way:
e.g.) p5DBI installation.
cd /usr/ports/databases/p5-DBI
make
make install

Console:
www/apache22, lang/php5, net-mgmt/php5-snmp, www/php5-session, devel/php5-gettext,
converters/php5-mbstring, net/php5-ldap, databases/php5-mysql, graphics/php5-gd,
archivers/php5-zip,
archivers/php5-zlib, devel/php5-json, ftp/php5-curl, devel/pear, databases/pear-DB, net/pearXML_RPC,
graphics/graphviz (GTK, GDK_PIXBUF, PERL, PHP should be enabled.)

In order to install the Pandora FMS Console, you will have to implement all of the before mentioned
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dependencies. You may use the ports collection or the packages to do so.

5.9.3. Console Installation
There are no Pandora FMS Console package files for FreeBSD. It's recommended to install the
pandora console by using the installer.
How to install it by the installer is described in the section named 'Manual Installation from Sources
in Linux/Unix' below.
Under FreeBSD with apache 2.2, the Pandora FMS console directory is:
/usr/local/www/apache22/data/pandora_console

5.9.4. Server Installation
There are no Pandora FMS Server package files for FreeBSD. You're required to install the Pandora
Server by using the installer.
How to install it by the installer is described in the section named 'Manual Installation from Sources
in Linux / UNIX' below.
The file locations and startup script structures are different from Linux. We're going to show the
FreeBSDspecific procedures below.
After the installation, you're required to add the following lines to the '/etc/rc.conf' file:
pandora_server_enable="YES"
tentacle_server_enable="YES"

These settings are required to enable Pandora, the Pandora Servers and Tentacle. Otherwise, they
are not going to be launched.
On FreeBSD, most of the Pandora server's files are gong to be installed in the directory named
'/usr/local'.
pandora_server, tentacle_server:
/usr/local/bin/pandora_server
/usr/local/bin/tentacle_server

Startup script:
/usr/local/etc/rc.d/pandora_server
/usr/local/etc/rc.d/tentacle_server

Configuration file:
/usr/local/etc/pandora/pandora_server.conf

util:
/usr/local/share/pandora_server/util/*

Man pages:
/usr/local/man/man1/*

Other:
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The 'data_in' and log directories are the same as the ones under Linux.

5.9.5. Agent Installation
There are no Pandora FMS Agent package files for FreeBSD. It's recommended to install the
Pandora Agent by using the installer.
How to install the agent by the installer is described in the section named 'Manual Installation from
Sources under Linux / UNIX' below.
The file locations and startup script structures are different from the ones under Linux. We're going
to show the FreeBSD specific procedures below.
After the installation, you're required to add the following line to the file '/etc/rc.conf':
pandora_agent_enable="YES"

To enable the Pandora FMS Agent, these settings are required. Otherwise, it's not going to be
launched.
On FreeBSD, the majority of the files of the Pandora FMS Agent are installed in the directory
'/usr/local'.
Agent:
/usr/local/bin/pandora_agent

Startup script:
/usr/local/etc/rc.d/pandora_agent

Configuration file:
/usr/local/etc/pandora/pandora_agent.conf

Plugins:
/usr/local/share/pandora_agent/plugins/*

Man pages:
/usr/local/man/man1/*

Other:
The 'data_out' and log directories are the same as the ones under Linux.

5.10. Installation in NetBSD
From versions 5.0 and above, Pandora FMS supports the use of NetBSD.

5.10.1. Previous Dependencies Installation
In NetBSD the dependencies are as follows:
Server:
mysql55-server databases/p5-DBI mail/p5-Mail-Sendmail net/p5-NetAddr-IP textproc/p5-XML-Simple
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time/p5-Time-Format www/p5-HTML-Parser net/nmap net/p5-IO-Socket-INET6
database/p5-DBD-mysql textproc/p5-XML-Twig sysutils/coreutils converters/p5-JSON net/net-snmp

In order to install the Pandora FMS Server, you are required to implement all of the dependencies
before doing so. It's recommended to be done by using 'pkgsrc'.
You may install all dependencies like this:
e.g.) p5DBI installation.
cd /usr/pkgsrc/databases/p5-DBI
make
make install

Subsequently, you're required to install 'Net::Traceroute::PurePerl' and 'LWP::Simple' using CPAN.
perl -MCPAN -e 'install Net::Traceroute::PurePerl'
perl -MCPAN -e 'install LWP::Simple'

'xprobe' is also required to be installed by compiling the source package.

You may download it from [1]
If you're unable to compile it without some errors showing up, please modify the following files and
try again:
•Add ' include <cstdlib> ' to 'libsexternal/USI++/src/ip.cc'.
•Add ' include <cstdlib> ' to 'libsexternal/USI++/src/misc.cc'.
•Add ' include <cstring> ' to 'libsexternal/USI++/usi++/tcp.h'.
Console:
www/apache22, lang/php54, net/php-snmp, www/ap-php, devel/php-gettext,
converters/php-mbstring, databases/php-ldap, databases/php-mysql, raphics/php-gd,
archivers/php-zip, archivers/php-zlib, textproc/php-json, www/php-curl, lang/pear,
databases/pear-DB, graphics/graphviz,

In order to install the Pandora FMS Console, you're required to implement all of the dependencies
before doing so. You may use 'pkgsrc' for that.
In addition, you're required to install the 'XML_RPC' using the 'pear' command as shown below.
pear install XML_RPC

5.10.2. Console Installation
There are no Pandora FMS Console package files for NetBSD. You're required to install the pandora
console by using the installer.
How to install it by the installer is described in the section named 'Manual Installation from Sources
in Linux/Unix' below.
On NetBSD with apache 2.2, the Pandora FMS Console directory is the one mentioned below.
/usr/pkg/share/httpd/htdocs/pandora_console
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5.10.3. Server Installation
There are no Pandora FMS Server package files for NetBSD. You're required install the pandora
server by using the installer.
How to install it by the installer is described in the section named 'Manual Installation from Sources
in Linux/Unix' below.
The file locations and startup script structures are different from the one under Linux. We're going
to show the NetBSD specific procedures below.
After the installation, you're required to add the following lines to the '/etc/rc.conf':
pandora_server="YES"
tentacle_server="YES"

To enable the Pandora Servers, Pandora and Tentacle, these settings are required. Otherwise, they
are not going to be launched.
On NetBSD, most of the Pandora FMS Server files are installed under '/usr/local'.
pandora_server, tentacle_server:
/usr/local/bin/pandora_server
/usr/local/bin/tentacle_server

Startup script:
/etc/rc.d/pandora_server
/etc/rc.d/tentacle_server

Configuration file:
/usr/local/etc/pandora/pandora_server.conf

util:
/usr/local/share/pandora_server/util/*

Man pages:
/usr/share/man/man1/*

Other: The 'data_in' and log directories are the same as the ones under Linux.

5.10.4. Agent Installation
There are no Pandora FMS Agent package files for NetBSD. You're required to install the Pandora
FMS Agent by using the installer.
How to install an agent by the installer is described in the section named 'Manual Installation from
Sources in Linux/Unix' below. The file locations and startup script structures are different from the
ones under Linux. We're going to show the NetBSD specific procedures below.
After the installation, you're required to add the following line to the '/etc/rc.conf':
pandora_agent="YES"

To enable the Pandora FMS Agent, these settings are required. Otherwise they are not going to be
launched.
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On NetBSD, most files of the Pandora FMS Agent are installed in the directory named '/usr/local'.
Agent:
/usr/local/bin/pandora_agent

Startup script:
/etc/rc.d/pandora_agent

Configuration file:
/usr/local/etc/pandora/pandora_agent.conf

Plugins:
/usr/local/share/pandora_agent/plugins/*

Man pages:
/usr/share/man/man1/*

Other:
The 'data_out' and log directories are the same as the ones under Linux.

5.11. Manual Installation from Sources under Linux / UNIX
This option is especially important in cases where you intend to utilize the development version's
code or directly from the code repositories.

5.11.1. Previous Installation of Necessary Software
As you're going to build Pandora FMS from the sources, you'll require the basic software in order to
compile and install software from the code. Depending on the use of one distribution or another,
you're required to install packages such as 'make', 'gcc' and others. Furthermore, it's recommended
to review the corresponding dependencies section to your distribution.
Under Debian and Ubuntu there is a metapackage which contains all of them:
apt-get install build-essential subversion

Under SUSE, Redhat or Fedora, you're required to install several packages:
zypper install make automake subversion

5.11.2. Download from Sources
The easiest way is to download the sources in the 'tarball' format (.tar.gz, .tgz or .tar.bz2) and
decompress them. For it, you have to go to the Pandora official web site and into the download
section athttp://pandorafms.com.
Other interesting option if you want to keep well informed and to use the latest code, stable or in
development, is using the client from Subversion (svn) code version system. You may visit the
development version at Pandora FMS official web site project http://pandorafms.org/index.php?
sec=community&sec2=development&lang=es for it.
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To download the development version code using the command line from the SVN client:
svn co https://svn.code.sf.net/p/pandora/code/

5.11.3. Agent Installation
The agents don't require compilation or preparation. Once you're acquired the agent package
named 'pandorafms_3.0_unix.tar.gz', please perform the following:
1. Open a shell and acquire root privileges by entering:
su -

2. Copy the package to '/tmp' and execute:
tar xvzf pandorafms_3.0_unix.tar.gz
./pandora_agent_installer --install

3. Start the agent manually by executing:
/etc/init.d/pandora_agent_daemon start

5.11.3.1. Custom Agent Installation
From Pandora FMS versions 3.1 and above, the agent is able to be completely installed in a custom
defined directory, like e.g. '/opt/pandora'. This customdefined directory is going to contain
everything the agent has, e.g. configuration files, log files, plug ins and even man pages.
To use this method, just enter:
./pandora_agent_install --install /opt/pandora

The only file that Pandora FMS is going to create outside it's defined directory is the main agent's
service launcher in '/etc/init.d/pandora_agent_daemon' (or equivalent under other UNIX branches)
and the startup level link e.g. '/etc/rc.d/rc2.d/S90pandora_agent_daemon'.
It's also possible to perform an installation to execute the agent by other means than root. To
execute it by the user 'Pandora', you have to e.g. install it by using the following command:
./pandora_agent_install --install /home/pandora pandora

When specifying a custom user, the agent has to be installed to a custom location where that user
has to have write permissions ('/home/pandora' in the previous example).

5.11.4. Console Installation
Once you've opened the console and arrived at the location of the compressed file named
'pandorafms_console3.0.0.tar.gz' or similar, please follow the below mentioned steps:
1. We acquire root privileges by entering:
su -

2. We're copying it to '/tmp' and execute:
tar xvzf pandorafms_console-3.0.0.tar.gz
cd pandora_console
./pandora_console_install --install
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5.11.5. Server Installation
Once you've opened the console and arrived at the location of the compressed file named
'pandorafms_server3.0.0.tar.gz' or similar, please follow the below mentioned steps:
1. We acquire root privileges:
su -

2. We're copying it to '/tmp' and execute:
tar xvzf pandorafms_server-3.0.0.tar.gz
cd pandora_server
./pandora_server_installer --install

If you're experiencing any dependencyrelated problems, you're required to rectify them before
attempting any installation. We might be able to force the installation and ignore the problems with
the dependencies, but Pandora FMS wouldn't work properly in this case.

5.11.5.1. Uninstallation / Manual Wipe from Server
If we have installed / updated several different versions, using different installation methods (RPM
or tarball), we might reach a point in which we have various versions mixed up that could be using
wrong versions of libraries or the server itself. The following procedure is aimed at detecting which
versions are there and manually erase them:
Binaries should always be located under '/usr/local/bin', containing a link to '/usr/bin'. To test this,
please enter the following commands:
ls -la /usr/local/bin/pandora_server
ls -la /usr/local/bin/tentacle_server
ls -la /usr/bin/tentacle_server
ls -la /usr/bin/tentacle_server

Pandora's libraries depend on their distribution's version. The following command should allow you
to learn where they are and whether there are various ones or not:
find / -name "WMIServer.pm"

This is going to display a complete path where Pandora's library is installed, e.g.:
/usr/local/share/perl/5.10.0/PandoraFMS/WMIServer.pm

It could happen that various paths are displayed:
/usr/local/share/perl/5.10.0/PandoraFMS/WMIServer.pm
/usr/local/share/perl/PandoraFMS/WMIServer.pm

In such a case, we wouldn't know which one is in use, so our best option is to remove the entire
directories and reinstall Pandora FMS:
rm -Rf /usr/local/share/perl/5.10.0/PandoraFMS
rm -Rf /usr/local/share/perl/PandoraFMS/

It's always a good idea to backup the '/etc/pandora/pandora_server.conf' ... just in case.
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5.11.6. Server Code Update: Compilation and Manual Installation of the Server
There is another way other than via the generic installation script. You could 'compile' the Pandora
FMS code by the Perl interpreter of its system. This process simply installs the libraries and the
minimum required executables, but it doesn't touch the starting script system, the maintenance
scripts, the configuration or any other thing other than the application and its libraries. This process
is recommended if someone is forced to update the server code without overwriting its
configuration.
Please decompress your server code under '/tmp' and follow the below mentioned steps:
1.We acquire root privileges:
2. We're copying it to '/tmp' and execute:
tar xvzf pandorafms_server-3.0.0.tar.gz
cd pandora_server
perl Makefile.PL
make
make install

Please observe all errors which get returned by the console. If any dependency is missing or if there
is any other problem, the system is going to notify you. If you observe a message like this:
Warning: prerequisiete Mail::Sendmail 0 not found
Warning: prerequisiete Net::Traceroute::PurePerl 0 not found

If displayed, it means there are some Perl packages that Pandora FMS requires and the system
doesn't have them installed yet. Please check the previous paragraphs on how to install the previous
required dependencies in Pandora FMS. You can however 'ignore' these errors (because they are
warnings, not errors) and force the installation. Of course you'll experience problems in one
moment or another, because there is a missing but required component. If you know the non
installed component and it's not going to be used (e.g. 'traceroute' is only used for the Pandora FMS
Recon Server) you may go on.
After this process is completed, the files are automatically copied into the following directories:
/usr/local/bin/pandora_server
/usr/local/bin/pandora_exec

There are several '.pm' files (Perl libraries) that Pandora FMS requires. These '.pm' libraries are
copied into several files, depending on its distribution and its version, e.g. under Ubuntu 9.04,
they're copied into the following directories:
/usr/local/share/perl/5.10.0/PandoraFMS/

Under SUSE and SLES 11, they are copied into:
/usr/lib/perl5/site_perl/5.10.0/PandoraFMS/

5.12. Installing the Enterprise Version
In order to install the Enterprise version of Pandora FMS (besides installing the 'Open' packages of
the console and server) we're required to install two additional packages to the console and server.
The package called 'console' is going to depend on the distribution you have installed. We're going
to use different packages for each distribution:
For Red Hat Enterprise Linux / CentOS / Fedora:
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rpm -i pandorafms_console_enterprise-X.X.noarch.rpm

For OpenSUSE:
rpm -i pandorafms_console_enterprise-X.X.noarch.rpm

For Debian / Ubuntu:
dpkg -i pandorafms_console_enterprise_xxx.deb

To install the Enterprise Console by using the source code:
Once you've opened the console and arrived at the location of the compressed file named
'pandorafms_consoleX.X.tar.gz' or similar, please follow the below mentioned steps:
1. You're acquiring root privileges by entering:
su -

2. Please copy it to '/tmp' and execute:
tar xvzf pandorafms_console-X.Xtar.gz

Then please copy it to the directory in which your Pandora FMS opensource console is installed. It's
either '/var/www/pandora_console' for Debian or Ubuntu, or '/srv/www/htdocs/pandora_console/'
for SUSE, RH, Fedora, etc. (or any other directory, depending on your distribution).
Debian:
cp -R enterprise /var/www/pandora_console

OpenSUSE:
cp -R enterprise /srv/www/htdocs/pandora_console

3. Just change the permissions in case the files are intended to get used by the web server's user,
e.g.:
Debian:
chown -R www-data /var/www/pandora_console/enterprise

OpenSUSE:
chown -R wwwrun /srv/www/htdocs/pandora_console/enterprise

It's recommended to conduct the License Activation at this point.
First make sure the opensource server version is installed. Then proceed to install the enterprise
version in order to install the Enterprise Server.
Once you've opened the console and arrived at the location of the compressed file named
'pandorafms_serverX.X.tar.gz' or similar, please follow the below mentioned steps:
1. You're acquiring root privileges:
su -

2. You're copying it to '/tmp' and execute:
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tar xvzf pandorafms_server_enterprise-X.X.tar.gz
cd pandora_server/
# ./pandora_server_installer --install

If the Pandora FMS Server Binary isn't contained in the default directory '/usr/bin', you'll have to
indicate the directory as follows:
# PREFIX=/usr/local ./pandora_server_installer --install

After installing, the server is going to restart (/etc/init.d/pandora_server restart). Subsequently, the
Enterprise Servers are going to be shown as enabled.

5.13. Installation of the Pandora FMS Server and Console under Windows
From Pandora FMS versions 5.1 and above, there is a windows installer which allows us to jointly
install Apache, PHP, MySQL, Pandora FMS and some dependencies necessary for the server's and
console's appropriate functioning under Windows.
It comes as a selfinstaller into executable format (.exe). For a basic installation, you're just required
to accept all the options listed below.
Please select the language:
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Please follow the installer steps:

Please accept the license terms:

85

Installation of the Pandora FMS Server and Console under Windows

Please select the components to install:

This installer is mainly prepared for an installation on a computer which doesn't have an already
installed Apache or MySQL. In case you have any other web server, such as IIS: It can be enabled,
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you're however required to disable it in order to work through Apache.
If you have a MySQL Server installed and running on the computer before installing the remaining
components of Pandora FMS, you're required to change the MySQL root password for the user
called 'pandora'. This change is necessary in order for the database to be created which has to be
able to assign permissions to the Pandora FMS Database correctly. Once you've installed Pandora
FMS on your computer, please feel free to replace the password.
After selecting the components to install, you're required to specify the installation path:

The components are going to be installed by following this setup window. The only component
which requires a user validation is Apache. Please accept all the conditions you're getting asked
about:
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As denoted above, other components are installed besides MySQL and Apache. In case they have
been already installed, you may see a message like this:

Please wait until the files are copied and all the setuprelated settings are carried out.
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Until the installation is complete as shown below.
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Once completed, it's going to open the browser on the login screen automatically. In cases you've
installed the Enterprise Version, you're going to be asked for the license code which will be provided
from Artica for implementation. Except for the Enterprise Version, the server is installed as a service
and starts automatically during the installation process. If the installation of the Enterprise Version
has been completed with no valid license code, the server is not going to boot.
In order to quickly start the process, please click on 'Start' and 'Programs'.

Once the service is running properly, a readytouse console with all the servers is going to appear
as shown on the picture below.
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5.14. Windows Agent Installation
The agent comes as a selfinstaller in executable format (.exe). The basic installation conducts all
the required steps. It's only going to be necessary to accept all of the options. To install the Pandora
FMS Agent under Windows, you're just required to download and to execute it. The installer is
going to guide you though all the steps in your chosen language. The following example shows the
installation for Windows Vista. Please keep in mind that Pandora FMS only works with any
currently available Microsoft Windows (2000 or newer) OS platform.
Please select the language:

Please follow the installer steps.

Please accept the license terms here and click on 'next':
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Please select the path where you want the Pandora FMS Agent to be installed. You can change it by
clicking on 'Browse'. After that, just klick on 'Next'.
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Please wait while the files are being copied.

Please configure the agent's data such as IP (or name) of the Pandora FMS Server which is going to
receive the agent's data and the data entry path (if you aren't sure whether you know the correct
value or not, just leave it at the default value that's already in here).
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Please decide whether you want to start the Pandora FMS Agent's service in this moment. Contrary
to common belief you're going to have to do this manually, otherwise Pandora FMS won't start
automatically if Windows reboots.
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When the installation is finished, you may change the agent's parameters in the file named
'pandora_agent.conf' or by the direct link in the Pandora FMS Menu

5.14.1. Windows Agent  Unattended Installation
From versions 3 RC3 and above, Pandora FMS includes the option of installing the Windows Agent
unattended. You're required to execute the agent installer, handing over the /mode
Silent parameter, indicating the installation to be conducted unattendedly. Besides, you can hand
over the /prefix <Ruta> parameter to indicate the complete installation path to the installer.
Please execute the following command where 'XXXXX' could change depending on the installers
version, and <Ruta> is the complete path where we want to install it (in inverted commas if it has
any spaces).
PandoraFMS_windows_agent_v3.0.XXXXX.setup.exe /mode Silent /prefix <Ruta>

In order to install the current version and to install e.g. in c:\agente_pandora\, you're required
to execute the following:
PandoraFMS_windows_agent_v3.0.RC3.setup.exe /mode Silent /prefix c:\agente_pandora

This is going to install Pandora FMS along with the default values in the indicated path and starts
the Pandora FMS service on the machine. It's necessary to execute this installing process by a user
which bears the privileges to install software or services on the machine.
From the agent's versions 5.1 and above, the installer has changed. In order to install the agent in
an unattended way, you're required to execute it in the following way:
PandoraFMS_agent_v5.1.exe /S

In case you intend to install the agent in a different path:
PandoraFMS_agent_v5.1.exe /S /D=C:\Agente_Pandora

5.14.2. Unattended Deinstallation
The uninstaller is an executable called ' uninstall.exe' which remains in the Pandora FMS
installation directory. It also allows the unattended deinstallation for it. You're required to execute
the unistaller by the/mode Silent option to use it.
Let's assume that Pandora FMS is installed in the default path:
c:\archivos de programa\pandora_agent

You're required to execute it in the following way:
“c:\archivos de programa\pandora_agent\uninstall.exe” /mode silent

5.14.3. Manual Installation of Windows Agent
The Windows Agent can be installed manually. To learn in which way the manual installation works
also serves to understand how the Agent works internally and to be able to reset some parameters
of the installation later.
Assuming that all the agents necessary files are obtained including their directory structure, they are
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summarized below.
•PandoraAgent.exe: The Pandora FMS service executable. We'll later see that it accepts any
parameters useful for us.
•pandora_agent.conf: The main configuration file.
•libcurl.dll: The library used by Pandora FMS to upload the files by FTP.
•libeay32.dll: The library used to encrypt connections (SSH and Tentacle) by Pandora FMS.
•zlub1.dll: The Library used to compress data by Pandora FMS.
•libodbc++.dll: The library used for ODBC checking by Pandora FMS.
•pandora_agent.log: The agents main log.
•pandora_debug.log: The agents main log (as debug).
•/util: In the 'util' directory, there are several 'typical' given UNIX tools to Win32 such as
'grep', 'gawk', 'wc', 'head', 'tail', etc.
There is also the Tentacle client named 'tentacle_client.exe. It's the one used to send the packages to
the Pandora FMS Server.
All these files can be obtained from our code repository (subversion) under 'sourceforge.net'.
Another easier solution is to compress a ZIP file from the contents of a currently installed agent.
Just zip the contents of the directory named 'c:\program files\pandora_agent' and decompress it
within the appropriate sub folder on the desired system.

5.14.3.1. Using 'PandoraAgent.exe' from the Command Line
If we're executing 'pandoraagent.exe' including the 'help' parameter, it's going to show something
like this:
Pandora agent for Windows. Version 3.0 (Build 090924)
Usage: pandoraagent.exe [OPTION]
Available options are:
--install: Install the Pandora Agent service.
--uninstall: Uninstall the Pandora Agent service.
--test-ssh: Test the SSH Pandora Agent configuration.
--test-ftp: Test the FTP Pandora Agent configuration.
--process: Run the Pandora Agent as a user process instead of a service.

To install the service (if not already installed), please execute the following command from the
directory where the '.exe' is residing, e.g. 'c:\program files\pandora_agent':
pandoraagent.exe --install

This command is going to install the service on the machine, building on the path where the '.exe' is
located. If we want to remove it, it's the same process, but with a differt option:
pandoraagent.exe --uninstall

Depending on the kind of the selected Windows system, it's possible that you may have to reboot
the system after removing the service. On other systems, the change is inherited without the need
for a reboot.
If you want to try a FTP or SSH connection from the command line, you may use the above
mentioned options.
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5.14.3.2. Pandora FMS Windows Agent as a Process
For debugging reasons, tests and other unusual circumstances, it's possible to execute the agent the
way processes usually do. To get this done, please execute the following command:
pandoraagent.exe --process

There are some restrictions to the execution in process mode. Pandora FMS is meant to be executed
as service and a user system. If you execute it by means of other users without privileges, there are
going to be some functions which aren't going to work properly.

5.14.4. Pandora FMS for Windows NT4
This agent is a porting of the UNIX agent, compiled in Perl by the 'ActiveState DevKit' Perl compiler.
It's a standalone EXE file, equipped with all the tools required to run. It comes with the same
features as the UNIX agent, but it runs on an NT4 box. This means it can execute commands and
change the output in a way to produce usable data for Pandora FMS.
It was created to be used on any Windows machine (NT4, Win95, Windows 20002008 and
Windows 7) and could be useful on Windows embedded systems without WMI core (which renders
the standard Pandora FMS Windows Agent not to run properly).

5.14.4.1. Installing the Agent
Please copy all contents on a directory of your choice, e.g. 'c:\pandora'.
Edit the 'pandora_agent.conf' and set your parameters, including the log file and the temporary
directory. It should be something like 'c:\pandora\temp' and 'c:\pandora\log'. Please make sure the
appropriate directories exist before trying to start the Pandora FMS Agent.

5.14.4.2. Running the Agent
This agent doesn't run as a service. You're required to install by the startup menu or by hand. The
shortlink you're creating has to have a parameter, which is where the main Pandora FMS agent
directory is located. In this scenario, it's 'c:\pandora'. The startup command has to be the following:
c:\pandora\pandora_agent.exe c:\pandora

5.14.4.3. Installation as a Service
The 'srvany.exe' tool is intended to perform this task. It's a Microsoft resource kit tool and capable to
use any '.exe' file as a service. Please read the documentation on how to use 'srvany' tool. It's
contained in this package.

5.15. Embedded Agent
Pandora FMS has a very special agent, called the "embedded" agent. It's a pure C development,
designed to be entirely crossplattform compatible. You're only required to have the GNU C
compiler to compile. You may link and use it in any available system. We have tested it in a few
ARM enviroments. It doesn't require anything special and should be able to run on any system
equipped with a GNU C compiler.
In order to use it, you'll also require to compile and link the Tentacle client protocol to send
information to the Pandora FMS Server.
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To compile both, you're going to require the GNU C extensions and autotools (e.g. 'autoconf',
'automake', 'pkgconfig', etc).
You'll require sources for the embedded agent from our SVN or file release section on
Sourceforge AND the code for Tentacle Client from our SVN or the download section as a separate
file.

5.15.1. Basic Installation
The simplest way to compile this package is the following:
1. 'cd' to the directory containing the package's source code and type './configure' to configure the
package for your system. If you're using 'csh' on an old version of System V, you might need to type
'sh ./configure' instead (to prevent 'csh' from trying to execute 'configure' itself).
Running 'configure' takes a while. While running, it gives back some messages, telling for which
features it's checking for.
2. Type 'make' to compile the package.
3. Optionally, type 'make check' to run any selftests that comes along with the package.
4. Type 'make install' to install the programs, all data files and the documentation.
5. You may remove the program binaries and the object files from the source code directory by
executing 'make clean'. To also remove the files created by the 'configure' command (to compile the
package for a different kind of computer), please execute 'make distclean'. There is also a 'make
maintainerclean' target, but it's mainly intended for the package developers. If you use it, you may
have to get all sorts of other programs in order to regenerate files which came along with the
distribution.

5.15.2. Installation Names
By default, 'make install' is going to install the package's files in '/usr/local/bin', '/usr/local/etc', etc.
You may specify an installation prefix other than '/usr/local' by giving 'configure' the option of '
prefix=PATH'. The command 'make install' is going to install the following files by default:
/usr/local/etc/pandora/pandora_agent.conf
/usr/local/bin/pandora/pandora_agent

You can specify separate installation prefixes for architecturespecific files and architecture
independent files. If you give 'configure' the option 'execprefix=PATH', the package is going to
use 'PATH' as the prefix for installing programs and libraries. The documentation and other data
files are still going to use the regular prefixes.
In addition, if you use an unusual directory layout, you may execute options like 'bindir=PATH' to
specify different values for particular kinds of files. Please execute 'configure help' for a list of the
directories you can set up and which types of files go into them.
If the package supports it, you can cause programs to be installed by an extra prefix or suffix on
their names by giving 'configure' the option of 'programprefix=PREFIX' or 'program
suffix=SUFFIX'.

5.15.3. Features of the Embedded Agent
In this moment, the agents supports the basic features only, which means there are only the
'module_exec' and the 'module_plugin' method to obtain information. All information you're
gathering from the system must be done by using an external command execution.
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6 INITIAL CONFIGURATION AFTER
INSTALLATION
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The order you should follow after Installation is:
1.Create the database through the Pandora FMS web console installation wizard.
2.Modify the server configuration including the access credentials to the BBDD that have
been generated by the previous step.
3.Start server Arrancar servidor.
4.Start the local agent (if required).
5.Go to Pandora FMS for the first time to start using it.

6.1. Console Initial Configuration
Assuming we are going to execute all components (Database, Console, Server and Agent) on the
same machine: If you haven't done it already, please start the MySQL server and create an Admin
password (root).
/etc/init.d/mysql start

Now create the password, for example "pandora123" for your MySQL root user:
mysqladmin password pandora123

Then start the Apache Server on your server:
/etc/init.d/apache2 start

You may get to your server IP address through the web to conduct the Pandora FMS post
installation now. This postinstallation serves to create the Pandora FMS database and to configure
the access credentials (user, password, name of database) in the Pandora Server to the established
user DB.
If your server's IP is e.g. '192.168.5.54', please put the following line into the address bar of your
browser:
http://192.168.5.54/pandora_console/install.php

From now on, you're just required to follow the below mentioned steps in order to create the
Pandora FMS DB.
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Please click on 'Next'.
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This screen is intended to verify that all software dependencies have been properly installed.
Note: If you're required to install some dependencies, it's going to be necessary to restart the web
server in order to use it.
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At this point, it configures the access data to your MySQL server. You're required to enter the root
password which you've created in the previous step (which was 'pandora 1234' in the example).
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You're required to enter the password for database access here.
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Installation complete.

In this point, you're required to delete "install.php" manually. Please go to the Pandora FMS Console
install directory and delete the 'install.php':
•(DEBIAN/UBUNTU) /var/www/pandora_console
•(FEDORA/CENTOS/REDHAT) /var/www/htdocs/pandora_console
•(SUSE) /srv/www/htdocs/pandora_console
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To delete a file under Linux, please use the 'rm' command in the following way:
rm install.php

6.1.1. License Application
The Pandora FMS Enterprise version bears a different license key associated to each installation. To
use the Enterprise Features and the console's remote updates, you're required to enter the license
code in the console configuration section.
After installing the Enterprise version's Pandora FMS Console by any installation method, you're
required to access the Pandora Console (http://IP/pandora_console/). Subsequently, the following
welcome screen to accept the license is going to appear:
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After accepting the license, the Pandora FMS Database schema is going to change, adding required
new tables for the use of the Enterprise Version. In this moment, a new screen to register the license
key, which Artica has sent to you, is going to appear:

For versions prior to Pandora FMS 5, you're required to enter the license key directly. For Pandora
FMS Versions 5 and above, you're required to perform a specific procedure, which is thoroughly
explained in a welcome document which is going to be shipped along with the License to you.

It's very important -not- to start the 'pandora_server' daemon until the Enterprise
Version's Pandora FMS Console has been properly installed, because numerous
different errors might occur if you do so before completing the process.

6.2. Server Initialization and Basic Configuration
Pandora FMS has configured your database and created a MySQL user for gaining access to it. It has
created a random password for the 'pandora' user that should be the one which was used to modify
the defined password in the Pandora FMS Server.
For this last step, you're required to edit the file named '/etc/pandora/pandora_server.conf' from
your Pandora installation and look for the following line:
dbpass pandora

Then replace 'pandora' for the password which was created by the wizard. Once this is done and the
file is saved, you're able to start the Pandora FMS server by entering the following command:
/etc/init.d/pandora_server start
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The server should return start values like the ones below.
Pandora FMS Server 3.0-dev Build PS090915 Copyright (c) 2004-2009 ArticaST
This program is OpenSource, licensed under the terms of GPL License version 2.
You can download latest versions and documentation at http://www.pandorafms.org
[*] Backgrounding Pandora FMS Server process.

The Pandora Server is now running with PID 2085.

The Tentacle Server is configured to start along with the system boot. If you intend to
work with the Pandora FMS Server without rebooting the machine, it's recommended to
restart this service by hand.

6.3. Initial and Basic Configuration of the Agent
You can start your machines local agent (it comes preconfigured to send data to the same machine
where it's running, using tentacle), to start collecting data automatically:
/etc/init.d/pandora_agent_daemon start

You're now able to gain access to your Pandora FMS WEB console by the following URL:
http://x.x.x.x/pandora_console

x.x.x.x

is the IP of the machine on which you've installed the Pandora FMS Console.
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7 UPGRADING FROM PREVIOUS VERSIONS
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7.1. Upgrading to Minor Releases
Upgrading to a minor version means if you e.g. upgrade from '3.1' to '3.1.1', or from a '3.1rc1' to a
'3.1final' or '3.1rc2'.
The upgrading / migrating process from same major level version implies that versions don't come
with any changes regarding their internal database schemata. They're only going to upgrade the
software, but neither the database schemata nor the data.
The updating or migration among the same major versions is very easy. Please just replace your
current setup with new release, e.g. from '3.1RC1' to '3.1RC2'. You're required execute the below
mentioned steps to do so.
1: Backup your database (just as a precaution  it shouldn't be necessary).
2: Backup your configuration files:
/etc/pandora/pandora_server.conf
pandora_console/include/config.php at your apache web root directory.
/etc/pandora/pandora_agent.conf
Any custom files (map images, plugins)

3. Please pick your preferred updating method (via RPM, DEB or tarball / sources):

7.1.1. Installation of additional Network and local Components
Pandora FMS 4.0.3 comes out of the box with some new network and local components. If you
install this version, all these new components are going to be installed by default. If you have e.g.
Pandora FMS 4.0.x installed, you're required to execute some auxiliary scripts to obtain all the new
modules.
The scripts are located under '<pandora_console>/extras'. Their names are mentioned below.
network_components.mysql.sql
network_components.oracle.sql
network_components.postgreSQL.sql

You're required to execute the appropriate script, using your DBMS. For MySQL, the appropriate
command is the following:
mysql -u root -proot pandora < network_components.mysql.sql

These scripts are going to add some new component groups and network components to your
disposal.

If something fails during the script's execution (e.g. a duplicate index because you've
already created a group), you may modify them to properly insert the new modules
within your database. Only scripts consisting of a valid SQL syntax are accepted here.

If you have the Enterprise Version, you're going to find some similar scripts for the local modules,
located at '<pandora_console>/enterprise/'. These scripts consist of the following:
local_components.mysql.sql
local_components.oracle.sql
local_components.postgreSQL.sql
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You may execute the script like the previous ones, e.g.:
mysql -u root -proot pandora < local_components.mysql.sql

You're required to execute the 'network_component' script prior to the execution of
the 'local_component' script in order to create new component groups.

7.1.2. Updating / Upgrading from an RPM
You should know if it's an update or a reinstall first. Please check the package version which is
installed on your system by the following command:
rpm -q -a | grep pandora

If you're done installing Pandora's packages, they're e.g. going to be shown as a list of the package
names and versions:
pandorafms_console-3.0.0-1

This means that you have the 'pandorafms_console' package in version '3.0.01'. If you intend to
install the same version you've already installed, you may 'reinstall' it by entering the following
command:
rpm -i --force <package_name.rpm>

Sometimes updates of versions which bear the same name and number are releases (they are
development improvements, etc.). In this case, it's recommended to reinstall them by forcing the
installation by the 'force' parameter.
If it's the same package but from a higher version, you may update it by the following command:
rpm -U <package_name.rpm>

To force an update of a version which you have already installed, the course of action is very similar
to the reinstallation. Doing so is going to preserve your original files if they've been modified. The
new version is going to have the same versions of the packages you've installed before. You may
force the update by entering this command:
rpm -U --force <package_name.rpm>

Please exercise extreme caution before reinstalling or updating any package and generate security
backups of:
•/etc/pandora/pandora_server.conf: On Pandora FMS Server.
•/etc/pandora/pandora_agent.conf: On Pandora FMS Agents.
If you're using the Enterprise Version, please keep in mind you're also required to upgrade the
Enterprise packages by using the same method explained here.

7.1.3. Using .deb Packages
If you are using a Debian or Ubuntu or another system that uses '.deb' packages, please just install
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the new packages. The Debian package system is going to manage the uninstalling of previous
version and asks you whether to preserve the old version or not.
dpkg -i package_name.deb.

If you experience any dependency problems, please resolve it by the following command:
apt-get install -f

Please install new packages and replace the configuration files by the ones of your backup.
If you're using the Enterprise Version, please keep in mind that you're also have to upgrade the
packages by using the enterprise '.deb' packages.

7.1.3.1. The UNIX Pandora Agent
If you intend to update a UNIX Pandora Agent, the system asks to overwrite the plugin files in the
final part of the installation. Please check whether the plug ins underwent any modifications or not
to avoid accidental overwriting of important files.

7.1.4. From Tarball / Sources
7.1.4.1. The Web Console
For the Web Console, please decompress the tarball file which contains the Pandora FMS Console to
the '/tmp' directory by entering the following command first:
cd /tmp
tar xvzf pandorafms_console_3.1xxxx.tar.gz

The Automated Way
Under SUSE (VMware image or CD Appliance):
cd /tmp
cd pandora_console
./pandora_console_upgrade -p /srv/www/htdocs/pandora_console

The second parameter (in this example '/srv/www/htdocs/pandora_console'), is the path where the
Pandora FMS console is already installed.
Under Ubuntu / Debian
cd /tmp
cd pandora_console
./pandora_console_upgrade -p /var/www/pandora_console

The Manual Way
Please unpack the Pandora FMS Console tarfile to '/tmp/pandora_console'. Please copy the contents
of '/tmp/pandora_console' to the current Pandora FMS directory.
Under SUSE (VMware Image or CD Appliance):
cp -R /tmp/pandora_console /srv/www/htdocs/
chown -R wwwrun:root /srv/www/htdocs/pandora_console

Under Ubuntu and Debian:
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cp -R /tmp/pandora_console /var/www/
chown -R www-data:root /var/www/pandora_console

You may safely delete the temp files from the directory '/tmp/pandora_console' by entering the
following command now:
rm -Rf /tmp/pandora_console

The contents of the attachment directory should be furnished by Apache user permissions (it's
'wwwrun:www' or 'wwwdata:wwwdata').
The Enterprise Version (manual installation only)
In order to upgrade the Enterprise version, the '/enterprise' directory and all its contents are
required to be copied into the Pandora FMS Web Console's root directory.

7.1.4.2. The Server
For the server, please decompress the tarball file which contains the Pandora FMS Server to '/tmp'
first.
cd /tmp
tar xvzf pandorafms_server_3.1xxxx.tar.gz

The Automated Way
To perform the upgrade, please do so by using the Upgrade Script:
cd pandora_server
./pandora_server_upgrade --upgrade

The Manual Way
This procedure is going to install new binaries and libraries. This procedure doesn't update or
upgrade the very important Pandora FMS tools. You're required to copy them one by one.
cd pandora_server
# ./pandora_server_installer --install

If the Pandora FMS server binary isn't contained in the default directory '/usr/bin', you'll have to
indicate the directory as follows:
# PREFIX=/usr/local ./pandora_server_installer --install

Please delete all temporal files by entering the command below (if you don't need them anymore):
rm -Rf /tmp/pandora_server

The Enterprise Version
The process is very similar to the previous server upgrade. Please decompress the tarball and
execute the following as 'root':
perl Makefile.PL
make
make install
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These commands should upgrade your Enterprise Server.

7.1.4.3. The Agent
Please decompress tarball file:
cd /tmp
tar xvzf pandorafms_unix_agent_3.1xxx.tar.gz

Please execute the installation tool which is going to install the agent as a whole and all the tools
and plug ins that it requires. This installer generates an automatic backup of your configuration files
under '/etc/pandora/pandora_agent.conf.yyyymmdd.' Please execute the script and copy the
contents of your backup configuration file under '/etc/pandora/pandora_agent.conf' by entering the
following commands:
cd pandora_agent
./pandora_agent_installer --force-install
cp /etc/pandora/pandora_agent.conf.xxxxxxx /etc/pandora/pandora_agent.conf

Please delete all temporal files by the command below if you don't need them anymore.
rm -Rf /tmp/pandora_agent

Experts only: You may only replace the agent's executable '/usr/bin/pandora_agent' or 'c:\program
files\pandora_agent\pandoraAgent.exe' to update the agent. Before that, please make sure to stop
the process or service to replace the executable. This should come in handy if a quick upgrade is
intended.
Please keep in mind there are no changes to the database schema contained within minor version
releases. It's sufficient to replace or upgrade the files as described above. Major versions, e.g. '3.0' to
'3.1' or '2.1' to '3.0', might have serious changes in the database schemata and are going to require a
database conversion.
Please refer to the the documentation for further details.

7.2. Migrating to another System
Sometimes we might intend to use the new version of Pandora FMS under a different
system/distribution, e.g. migrating from 'SUSE 11' to 'SUSE 12' or from 'Ubuntu' to 'CentOS'.
For achieving this, we're required to install the new Pandora FMS application from scratch or to
download our ISO appliance and install it.
•Once the new Pandora FMS instance is running in our new system, we're going to perform
a backup of the previous system's database:
mysqldump -u root -p pandora > backup_pandora_X.Y.sql

•After we transfer the backup file named 'backup_pandora_X.Y.sql' to the new system.
•Then we're going to stop all the running processes except 'mysql' by entering the following
command:
/etc/init.d/pandora_server stop
/etc/init.d/pandora_agent_daemon stop
/etc/init.d/tentacle_serverd stop
/etc/init.d/apache2 stop o /etc/init.d/httpd stop (parar servidor apache, variará dependiendo
de la distribución que usemos)
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•Within a MySQLShell, we're going to acquire root privileges first. Then we're going to
access the Pandora FMS Database (default name is 'pandora') and conduct the import
operation:
#mysql -u root -p
mysql>use pandora
Database changed
mysql>source /home/artica/backup_pandora_X.Y.sql ( put the full path to the backup file you
created a few steps back )

•If you're migrating to a superior version, you must perform the database migration scripts.
•If you've changed your distribution's OS, please keep in mind that the console's path may
have been modified within the system, and some database fields are also required to be
modified within the Pandora FMS Database. To do so, we're required to conduct the
following queries:
#mysql -u root -p
mysql>use pandora
Database changed
mysql>UPDATE tconfig SET value = '/var/www/html/pandora_console/attachment' WHERE token LIKE
'attachment_store'
mysql>UPDATE tconfig SET value = '/var/www/html/pandora_console/include/fonts/smallfont.ttf'
WHERE token LIKE 'fontpath'

Where '/var/www/html/pandora_console/attachment' is the actual console's path within your
system.
These path variables are also required to be modified within the server's and console's configuration
files.
•Once the database has been imported, we're required to make sure the configuration files
'<CONSOLE_PATH>/pandora_console/include/config.php'
and
'/etc/pandora/pandora_server.conf' hold the same data in the fields named 'dbname',
'dbuser' and 'dbpass'. If they're unequal, we're required to do the following:
1. To replace the new configuration files by the old ones.
2. To update the database credentials according to the values stored in the configuration files.
Assuming the new configuration file hold the following data: 'dbname=pandora',
'dbuser=pandora1' and 'dbpass=pandora2', it's recommended to enter the following commands:
#mysql -u root -p
mysql>grant all privileges on pandora.* to 'pandora1'@'localhost' identified by 'pandora2';
mysql>flush privileges;

Subsequently, we may restart all the daemons and gain access to the Pandora console along with
the previous configuration. If you've changed your IP address, you're required to modify the
'target_ip' token within all the agent's configuration files.
This procedure is also valid for the Enterprise version.

7.3. Updating to a Major Version
This is the same process as with a minor version, but you're required to upgrade your data and
database schemata as described below:
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7.3.1. Upgrading the Database Schemata (Major Versions only)
A major version is defined as upgrading from '3.0' to '3.1' or if migrating from '3.x' to '4.x'. An
update from '4.0' to '4.0.1' is not considered upgrading to a major version which is the reason for
why it doesn't require a Database Upgrade.
Majorversion upgrades or migrations require to perform a database upgrade. This upgrade is
initiated from the command line interface and converts all information. You're not going to lose
anything in the upgrade, but anyway: ALWAYS conduct a fullbackup first (not just the database,
the entire code and configuration as well). Please follow the steps for upgrading as described below.
Please install your packages from your new version of Pandora FMS (including the Enterprise
packages). The required files to conduct the database upgrade are contained in these packages. You
can
find
them
in
the
'{PANDORA_CONSOLE}/extras'
directory
and
under
'{PANDORA_CONSOLE}/enterprise/extras' (Enterprise Version only).
The {PANDORA_CONSOLE} is your Pandora FMS console directory which contains the console
code. Under a SUSE it's '/srv/www/htdocs/pandora_console', under a 'Debian' or 'Ubuntu', it's
'/var/www/pandora_console'.
Please go to the 'extras' directory. There is a file called 'pandoradb_migrate_vX.Y_to_vX.Z.sql'. This
file contains all the SQL code required to convert your X.Y.x database in a X.Z database ready to be
used with a X.Z console and a X.Z server. The required steps to conduct the conversion are the
following:
1: Please perform a complete backup of your current database by entering the following command:
mysqldump -u root -p pandora > backup_pandora_X.Y.sql

2: Please stop your Pandora FMS Server and Web Server:
/etc/init.d/pandora_server stop
/etc/init.d/apache stop

3: Apply the upgrade script to update your database. You're going to find it once you have installed
the new version's packages. The script is going to ask for your Pandora FMS user password for
MySQL (you may find it within your current '/etc/pandora/pandora_server.conf' file). We're
assuming your Pandora FMS Database is called "pandora" and it's running on the same machine
you're executing the following command:
cd /srv/www/htdocs/pandora_console (or equivalent)
cat extras/pandoradb_migrate_vX.Y_to_vX.Z.sql | mysql -u pandora -p -D pandora

After a few seconds or minutes, the database is ready to perform its tasks in conjunction with latest
version of Pandora FMS.
In case of experiencing any problems, the backup to go back to your previous version may be
restored by the command below:
mysql -u root -p
>
>
>
>

drop database pandora;
create database pandora;
use pandora;
source backup_pandora_X.Y.sql
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7.3.2. The Enterprise DB Schema
It's very important to execute the Open Migration Script first. It's located in the 'extras'
directory as mentioned within the previous section.

This process is almost the same as the ones explained above. In the '/enterprise/extras' directory,
you have a file called 'pandoradb_migrate_vX.Y_to_vX.Z.sql'. Please use this file like the
OpenSource Migration Script explained above:
cd /srv/www/htdocs/pandora_console (or equivalent)
cat enterprise/pandoradb_migrate_vX.Y_to_vX.Z.sql | mysql -u pandora -p -D pandora

7.3.3. Updating from Version 5.0 to 5.1
7.3.3.1. Recon Scripts and Tasks
The Recon Task's fields consisted of four static fields until the publication of version 5.0. These
fields have been changed to a dynamic system of fields, defined within the recon script's creation
(similar to the plugin's macros) under Pandora FMS 5.1. They involve some database's structure
and storing changes.
Due these changes, we're required to execute the following script after the upgrade's completion:
/usr/share/pandora_server/util/pandora_migrate_recon_scripts.pl <dbname> <dbhost> <dbuser> <dbpass>

It's going to create the old four fields as dynamic fields within the recon script's table and is going to
convert the already used fields within the recon tasks to the new format, therefore maintaining the
compatibility to previously created recon tasks.

7.3.4. Update from Version 4.x to 5.0
Within version 5.0 of Pandora FMS, some API functions like set create_event have
changed as follows:

7.3.4.1. Compound Alerts
Within version 5.0, the compound alerts have been entirely removed. If they still exist, they're going
to be deleted during the migration process.

7.3.4.2. Plug Ins
The plugin system has changed in Pandora FMS 5.0. The data of these type of modules is now
different. In this case, it's mandatory to conduct an update.
If your current installation contains plug ins and plugin modules, you're required to execute the
following script after the upgrade's completion:
/usr/share/pandora_server/util/pandora_migrate_plugins.pl <dbname> <dbhost> <dbuser> <dbpass>

117

Updating to a Major Version

The PSPZ files to import plug ins of previous versions of 5.0 are compatible to the new system.

7.3.5. Update from Version 3.2.1 to 4.0
Subsequently to updating the console from 'Tarballs', 'DEB' or 'RPM' packages, the access to the web
console could experience the following errors:
Notice: Undefined index: dbtype in /var/www/pandora_console/include/functions_db.php on line 32
Notice: Undefined index: dbtype in /var/www/pandora_console /include/functions_db.php on line
48
Notice: Undefined index: dbtype in /var/www/pandora_console/include/functions_db.php on line
625

To resolve these errors, please add the
'<pandora_console_path>/include/config.php':

following

line

to

the

file

named

$config["dbtype"]="mysql";

If the SSH extension is contained within your setup, please delete it. It's quite old and it's not going
to run in conjunction with Pandora FMS 4.0. It's also going to crash the console.
rm -Rf < your pandora console root directory>/extensions/ssh_console*

Some 3.2 setups cause problems within an autoincrement table. In this case, please enter the below
mentioned command into SQL by using the SQL manager in the console or by using the MySQL
command line client:
ALTER TABLE tsesion AUTO_INCREMENT = 1;

After upgrading the server, there's a new server for highspeed ICMP and SNMP monitoring
available at your disposal. There are special preparations required for using it. Please read the
following lines thoroughly and disable it by adding the following lines to your
'pandora_server.conf':
snmpserver 0
icmpserver 0

7.4. Problems while upgrading from a previous Version (Perl Libraries)
Sometimes an upgrade moves the Pandora FMS Libraries to different locations, e.g. to where the
old library's versions were installed. After completing the upgrade, you might have two different
versions of Pandora FMS Libraries and you're unable to know which version is actually going to be
used. The best solution is to locate the libraries, delete all of them and to reinstall or upgrade here.
To do so, please execute the command below:
find /usr -name "Core.pm"

This command is going to show you a few lines like:
/usr/lib/perl5/site_perl/5.10.0/PandoraFMS/Core.pm
/usr/lib/perl5/vendor_perl/5.10.0/Bootloader/Core.pm

The Pandora FMS libraries are located under '/usr/lib/perl5/site_perl/5.10.0/PandoraFMS/'. Please
delete them entirely and reinstall them by using packages or tarball sources.
rm -Rf /usr/lib/perl5/site_perl/5.10.0/PandoraFMS/
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The Perl versions and exact locations may differ within each Linux distribution, so you're required
to locate them prior to deleting the directory which was mentioned here.

7.5. Problems during the Upgrade from a previous Version (Database)
If you experience any problems, it's probably because you're upgrading a 2.x version which was an
upgrade from a 1.x version or because someone has conducted manual changes to the Database
scheme. If you e.g. get a message like this:
ERROR 1005 (HY000) at line 101: Can't create table './pandora/talert_template_modules.frm' (errno:
150)

This error originates in a problem under MySQL, because some fields don't have the expected type.
The 'id_agente_modulo' field in 2.1 is required to consist of the 'bigint(10)' type. If you e.g. have
migrated from a 1.x version of Pandra FMS, you're going to encounter this problem. Before
upgrading the migration tool to 3.0, please enter this command within the MySQLConsole:
ALTER TABLE tagente_modulo MODIFY id_agente_modulo bigint(10) unsigned NOT NULL auto_increment;

Please retry to execute the upgrade tool again. Please keep in mind that you're required to have
InnoDB support for your MySQL Database Server.
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8 SECURITY UPGRADES / PATCHES
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A security upgrade or security patch is a small patch usually for Console, but you can also have a
security patch for server. In both cases the source package to "patch" the problem can be presented
in several formats:

8.1. From distro packages
A package (RPM or DEB): just install the package:
Ubuntu/Debian
dpkg -i <package_name>

SUSE/RedHat/CentOS/Fedora
rpm -u <package_name>

8.2. From tarball or SVN
A package in tarball/Source format. This implies you know a bit more about the internals of
Pandora FMS, that means, you know "where" are the files you will replace. Using a tarball is just a
way to say, you have the source files and you will replace that for your installed Pandora FMS files.
In Console:
All
files
should
be
put
on
/var/www/pandora_console
(Ubuntu/debian),
/srv/www/htdocs/pandora_console (SUSE), or other directories, depending on distros.
In Server:
It depends on your version and install method, but the files you will need to replace should be
searched before:
•Libraries:
find
/usr
/usr/lib/perl5/PandoraFMS

name

"PluginServer.pm",

usually

should

be

at

•Binaries: find /usr name "pandora_server", usually should be at /usr/bin

8.2.1. Example of a manually conducted Console Update
If you e.g. have a tarball called 'pandorafms_console_3.1_securityfix_may2011.tar.gz' (and
supposing you're on a standard SUSE system) please enter the following commands:
cd /tmp
tar xvzf /home/youruser/download/pandorafms_console_3.1_securityfix_may2011.tar.gz
cd pandora_console
cp -R /srv/www/htdocs/pandora_console
sudo chown -R wwwrun /srv/www/htdocs/pandora_console

8.2.2. Example of a manually conducted Server Update
For example, if you have a tarball called 'pandorafms_server_3.1_securityfix_may2011.tar.gz' (and
supposing you're on a standard SUSE system), please execute the following commands:
cd /tmp
tar xvzf /home/youruser/download/pandorafms_server_3.1_securityfix_may2011.tar.gz
cd pandora_server
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Now, please locate your Pandora library files by using the below mentioned command:
sudo find /usr -name "NetworkServer.pm"
.
.
/usr/lib/perl5/site_perl/5.12.1/PandoraFMS/NetworkServer.pm

As you certainly have noticed, this isn't the default installation directory, because it's the same as if
it were installed from the sources, not from an RPM package. We now know the location of the
Pandora FMS Libraries  they're under '/usr/lib/perl5/site_perl/5.12.1/PandoraFMS/', so please
copy all updated libraries and overwrite the old ones. This step is the same as if you've installed
your system by packages instead of sources but with different directory names:
sudo cp -R lib/PandoraFMS/*.pm /usr/lib/perl5/site_perl/5.12.1/PandoraFMS/

Please keep in mind to copy the binaries and tools by the below mentioned command:
sudo cp -R bin/* /usr/bin

(Please ignore the warning message about skipping the copy for the Pandora FMS directory  it's
normal).
sudo cp -R util/* /usr/share/pandora_server/
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9 CONSOLE UPDATES BY USING THE
UPDATE MANAGER
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9.1. OpenSource Updates
Since Pandora FMS 4.0.2, you may update from weekly semiautomatic updates by using the Open
Source version. This feature is based on an improvement of the Update Manager's system, which
was only available to customers of the Enterprise version before. Now you may
verify online whether there's a new update, download and update your console automatically by a
request.
This feature has the following characteristics:
•The server which executes the Pandora FMS console has to be connected to the Internet.
•The Update Manager is going to contact our server for new updates (on Sourceforge). It
also sends anonymous statistical data about the use of Pandora FMS (number of agents).
•An update from Sourceforge is going to be downloaded from the weekly updates folder.
•The updates are incremental and they're containing the whole console. This process could
take a lot of time (the package size is about 25 MB).
•The Updates are conducted automatically: They're not reviewed by the team. In 99% of
cases, there are no expected problems but we're not guaranteeing anything if a problem
occurs.
•The updates are only intended for the console (neither for agents nor servers).

9.1.1. The Console's Updating Process
It's very easy. Just go to 'Extensions' > 'Update Manager'. The main screen allow you to check for
new available updates to be installed, also you can see the list, containing the previously installed
updates (on the picture below, there are no previous updates yet). Please click on 'install'.
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Please click on the 'Install' button.

To use the Update Manager, the server which hosts the Pandora FMS Console has to be
connected to Internet. Pandora FMS is going to use the 'wget' command to download the
packages by default (it's faster). You may also use the 'curl' method to do so (you may
change it within the Pandora configuration files) but it's slower.
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The moment the packages are downloaded and installed, you're going to return to the main page
which is going to look like the one shown below. It shows the installed updates and a message
which says that there are no more available updates. Congratulations, you've updated your system
to a new version!
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9.2. Enterprise Updates
Unlike Open updates, Enterprise updates have several additional features:
•100% tested by our development team, so you can enjoy updates on the same day an
incident was opened (even a few hours later).
•Specific updates (incremental) which allow you to update the outdated part only and
without being forced to download huge packages.
•Offline updates are allowed now. Downloading packages from the support page for the
Pandora FMS installation which aren't connected to the Internet (due to security reasons).
To use the Enterprise version's Update Manager, you're required to install the Key Generator and
enter your serial number first.
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You may access the Update Manager by clicking on 'Operations > 'Extensions' and 'Open Update
Manager.' If you have the Enterprise version installed, you may use this interface. If not, the open
version is going to be displayed.
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On this page, you're able to verify the current version number of Pandora FMS. You're going to get
notified if there are any new available updates.
To update to a new version, please click on the 'Update' button.
You may also mark the checkbox named 'Overwrite local changes' which is going to overwrite any
existing local modification of the files.

9.2.1. OffLine Updates
You may also download 'offline' updates for Pandora FMS which are packages with an '.OUM'
extension. Please go to the Pandora FMS official support page and download the '.OUM' files as
shown on the picture below.
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Upload it to the console by using this control:

The update is going to be applied automatically.

You may also update by ZIP files in the same way that you've used to update by the
OUM files. These zip files were created by our programmers.

9.3. Additional Configuration of PHP Engine to operate with Update
Manager
To ensure the Open Update Manager is working appropriately, it requires more memory than the
amount assigned by default. To assign more memory to the PHP executions, you're required to edit
the 'php.ini' file and set up the reserved memory to at least 64MB.
The appropriate line to edit is shown below.
memory_limit = 64M

; Maximum amount of memory a script may consume (16MB)

On Debian and Ubuntu systems, the file is usually located in the directory named
'/etc/php5/apache2'.
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10 THE PANDORA FMS INTERFACE
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10.1. Introduction
In this section, we're going to show you the basic menus of the Pandora FMS Interface along with
all icons and features required to start learning how to use Pandora FMS.

10.2. Pandora FMS Start Session Screen
On the image below, you see the Pandora FMS start session screen which is shown by default:

On the bottom of the screen, you can see the version of Pandora FMS you're currently using.
There are text entry boxes in the center to enter the user's name and password with the session start
button (login).
Once the right credentials to start are introduced. The defaults are:
•User: admin
•Password: pandora
In a predefined way, the console will show the Pandora FMS main welcome page. Pandora FMS
start session screens can be customized. This will be explained in the Customized welcome
screen section.

10.3. Pandora FMS Main Page
The Pandora FMS main page shows basic information about the system state and the number of
checks it does.
The Pandora FMS main screen is shown here:
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The static elements which do not change in different screens of the interface are:
•Operation Menu
•Administration Menu
•Defined Links
•Headers
The dynamic elements which do change in different screens are:
•Header information
•User information, pending messages, system notifications, etc. (this will be explained in
the subsection header below).
•Site news
•Last activity of the Web Console
•General basic information
•Checking main view in Pandora FMS

10.3.1. Pandora FMS Customized Page
The Pandora FMS main page can be personalized under 'Operation' > 'Workspace' and 'Edit my
user'.
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Note: Shortcut bar functionality is implemented in Pandora 5.0
Available Options:
•Default: Pandora FMS main page as it is shown by default.
•Dashboard: You can choose a user dashboard.
•Visual Console: You can pick the user's visual console.
•Event List
•Group View
•Tactical View
•Alert Detail
•Other: Users are able to customize their home page. It's going to display the default view by
default.
Example:
Select
'Other'
and
type
'sec=estado&sec2=operation/agentes/estado_agente' to show agent's detailed view.

10.3.2. The Operation Menu
The Operation menu allows you to visualize all checking done by Pandora FMS agents, the visual
maps, network maps, server state, inventory, see and manage the incidents (if you have sufficient
permissions), see the users, see the SNMP console, see the messages and use the extensions.
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From the Operation menu down to any submenu, there could be other elements which are going to
be displayed by selecting the menu:

All of these elements link to other pages containing information and all of them will be explained in
the chapters dealing with Operations in Pandora FMS in great detail.

10.3.3. The Administration Menu
The Administration Menu allows users to see and manage the monitoring that Pandora FMS agents
execute. It also allows to visualize the modules and components of these checks, the alerts that
these modules and agents can throw and how these alerts work, the existing policies, users, SNMP
console, reports, user profiles, the Pandora FMS servers and their assigned tasks, the system audit
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register, the Pandora FMS web console, database maintenance and the console extensions.

There could be other elements present which will be displayed when selecting menus in any
submenu down from the Administration menu.

All of these elements are links to pages with information. All of them will be explained in 'Operation
136

Pandora FMS Main Page

and Management' in the Pandora FMS chapters in great detail.

10.3.4. Links Menu
The links menu just shows a link to default sites. They can be added, modified or deleted from the
Pandora FMS administration menu. These links allow to link Pandora FMS to other WEB
applications from its organization and make sure that Pandora FMS becomes a nuclear management
point.

10.3.5. The Headers
The Pandora FMS headers offer several quick links or a direct access to important features of the
system and a search bar:

From left to right, the header provides the following:
•A link to the system state which shows the Pandora FMS server state.
•The autorefresh button which, apart from updating the screen, could be configured to
autorefresh in a determined time interval. This allows you to define e.g. that it will be
refreshed every X time on any page. By doing this, the session or the information in it won't
get lost. It also displays the updated data.
•If there are pending system advices, an alert icon will be shown. When you click on it, a
modal window will be displayed, containing the current system advices. In the center of this
information window, you may find update manager updates, system security problems or
value notifications (e.g. the default console password) by default.
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•A link to the general contextual help content of Pandora FMS.
•A button for closing the session.
•The user which is currently connected. A direct link to his user page (in brackets).
•If the user has pending messages to read, a card will be shown. If you click on it, a modal
window with the current messages will appear.
•The search bar which allows to search in several elements: Agents, reports, alerts, maps,
combined graphs and / or users in the Pandora FMS database.

By clicking on the link, this goes straight to the server state, informing you about the number of
details about them:

The autorefresh button allows to update the page by klicking on it. It also allows to select an
update frequency:
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Once this has been activated, the remaining time until the next update will be shown next to the
link name:

The auto refresh is only shown on some of the pages. It's disabled on the rest of pages by default for
the reason of avoiding conflicts and losing data e.g. if you fill out a form in this moment. The list of
pages containing the auto refresh are:
•Tactical View
•Group View
•Agent Detail
•Alert Detail
•Monitor Detail
•Service View
•Dashboard
•View Events
•SNMP Console
•Network Map
The search tool allows you to look for entries in maps, reports, graphs, alerts, users and agents. The
information is arranged in slides for each kind of data, the agent slide will be selected in a
predetermined way:
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The direct link to events is the same as the one which the Operation menu shows. This shows events
which occur in the system and allows their management if there are sufficient permissions to do
that. The event management will be explained in the chapter "Management of the application".

10.4. Icons within the Pandora FMS Interface
In Pandora FMS, there are several icons next to text, which possess other icons by themselves. We're
going to explain the most important ones in this section.

10.4.1. Contextual Help Icon
The Contextual Help Icon gives you a general help on the field it comes with or in the application
form or page where it is. It opens a pop up window (you're required to have popup windows
activated in your browser). It provides all information you might require. You're required to click on
the icon to display this kind of help.
It's a roundshaped icon in form of an interrogation mark on green background.

10.4.2. Suggestion / Advice Icon
The suggestion and advice icons provide you with some help on the field it comes with. It's shown
by clicking on the icon.
The icon is a yellow star.

10.4.3. Management Icon
The management icon comes with some files of some tables. It represents a direct link to the
element's configuration. To have access to the linked page, you just have to click on it.
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10.4.4. Full Screen Icon
It's usually shown next to the title of the pages you're on. It represents the possibility of the page to
be shown as full screen. To use this functionality, you may click on the icon.
The icon is a square with four arrows  one in each corner.

10.4.5. Magic Wand Icon (Wizard)
The magic wand icon shows the current functionality to be useful to apply a large amount of items
the easy way by a unique action (with the help of an assistant), e.g. there are wizards in the
reporting section (Enterprise Version) that allows you to create report items for a large number of
modules by one click. In the Visual Console Wizard, it can also be useful to create a lot of items the
easy way.
The Magic Wand Icon is shown below.

10.4.6. Remote Configuration Edit Icon
There is a configuration option for the Pandora FMS software agents which allows to edit its
configuration remotely from the console (in the Enterprise version). This option comes in two
different pages: The first one is the agent list and the management of them. You may access it
through 'Administration' > 'Manage Agents':

If you click the icon, the 'R' column on the right wants to indicate that the software agent could be
configured from the console by remote.
The option is also shown if you try to edit the agent's features, after clicking on the 'edit' button
below its name:
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On the following page, the agent details will be shown. Next to the name box, the agent remote
configuration edit icon will appear:

10.4.7. Update Icon (forced Version)
Pandora FMS remote checking has an update interval  but this could be forced by clicking on a
button. If it's forced, the module will be updated. This interval is going to start counting from zero.

10.4.8. Refresh Icon (after a forcedupdate Action)
Once the forced update icon has been clicked, it's appearance changes to show that it's been
activated.

It returns to his usual appearance once the checking has been updated.

10.4.9. Alternative Texts on Icons and Images when hovering the Mouse over it
Almost all Pandora FMS images have an alternative text which is shown when you're hovering with
the mouse pointer over it. You able to obtain alternative textual information as well as the
information the images are able to offer in this way.
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10.5. Images in Pandora FMS
The images in Pandora FMS can be graphs, generated by the Pandora FMS standard graph engine
or Flash graphs, generated by the Flash engine. These can be defined by the administrator in the
visual system configuration.
The current graphs (statics) provide less information as they aren't interactive. They don't show any
text when hovering over them with the mouse pointer. The flash graphs can't be used in reports.

The Flash graphs give this information:

In case there isn't any data to show in a graph, Pandora FMS displays an error message in the
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image:

10.6. Data missing on Agent's Data Lists
If the agent has no data to show, it displays a warning message instead:

The above is an example of an agent without any alerts.

10.7. States and possible values of Agents, Modules and Groups
If an agent has any data to show, this data could be in several states:
•OK: Green
•Warning / Notice: Yellow
•Critical: Red
•Unknown: Grey, with the information of the last contact in red.
•Not started: They can't be seen. They only appear in blue in any management views.
This would be the data view of one agent which are called 'Modules' under Pandora FMS. It shows
the module name, its state (in a colored box) and its numeric or alphanumeric value.
Data view for one agent
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There is also the detailed agent view. This view quickly summarizes the agent's state 'as a whole'
and the summarized state of the modules. We can see several agents in different states in this view:
The agent's view

In this view, the agent called 'Database Server' has one configured module and one module in
'critical' state. Having an agent with at least one module in 'critical' state is visualized as a red box.
The information of the agents as two '1' separated by ':' shows one defined module and one in
'critical' state (in dark red).
The agent called 'My Agent' has two modules in normal state.
The "vanesaHP630NotebookPC" agent has 20 modules. There are 3 in 'unknown state',
represented as a 3 in light gray as it has all elements in 'unknown state'. It's visualized in blue.
There are 2 modules in 'critical', 14 in 'normal' and 1 in 'warning' state.
Group View
As before, the group view summarizes the status of all agents for each group.
In this group view, we can see the following status:
•OK: All agents are working appropriately (green).
•Warning / Notice: At least one agent of this group is in a 'warning' status (yellow).
•Critical: At least one agent is in a 'critical' status (red).
•Unknown: All agents of this group have an 'unknown' status (grey).
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•Without Modules: When the agents of a group don't have modules or if they are not
initialized (white).
Module View
This view provides a list which contains all modules of all agents. The list all states of all modules
along with the same color coding as described above.
This view provides a lot of filtering options and could come in handy when comparing the module
information of different agents.

10.8. The Widget's Autocomplete Agent
On some pages under Pandora FMS, you're maybe seeing some pages as this:

This widget starts it's searching as you are typing and displays the agents which correspond to the
characters you've typed in. The color coding of the results are:
•First block in green: The agents matching by name.
•Second block in yellow: The agents matching by description.
•Third block in purple: The agents matching by address.

Please keep in mind that the widget starts working after you've typed at least two
characters.
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11 PANDORA FMS CONFIGURATION
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Pandora FMS has three basic components which are required to be properly configured for a correct
operation. The first two are the server and the web console, which should interact between each
other and the database to introduce, to process and to show the stored data. There are also the
software agents which transmit the data to the Pandora FMS server.
In this chapter, we are going to explain the configuration files of the three elements and others
which are important for a correct performance of the application components.

11.1. Server
Pandora FMS server has a configuration file that allows to adjust several application parameters to
obtain an excellent performance. The configuration file pandora_server.conf is located
at /etc/pandora/ by default.

11.1.1. Configuration File Elements
Pandora FMS configuration file is a UNIX standard plain text where the variables that aren't used or
the comments are preceded by a "#" character. The comments must start the line and as for the
entire line, the .conf file must not have any line which shares code and comment.
Now we are going to explain all the configuration parameters.

11.1.1.1. servername
Pandora FMS server name. If it's commented we should use the name of the equipment or "host".
Please do not change the name of the server after executing it the first time because all reference
goes linked to the name (remote agent modules and other information). If you change it, you're
required to reassign the server to all your agents.

11.1.1.2. incomingdir
It's the incoming directory of XML data packages. It's located under '/var/spool/pandora/data_in/'
by default. You can improve the performance by setting up a RAM disk or very fast harddrive here.

11.1.1.3. log_file
The Pandora FMS record file (log). It's located under /var/log/pandora/pandora_server.log by
default. This is the main logfile and it's very important for debugging.

11.1.1.4. snmp_logfile
It's
the
logfile
of
SNMP
the
console
of
Pandora
FMS.
It's
located
under /var/log/pandora/pandora_snmptrap.log by default. This is a log file which contains all
received SNMP traps BEFORE the Pandora FMS server processes them. It's not recommended to edit
or even touch this file.

11.1.1.5. errorlog_file
The
Pandora
FMS
error
registry
file
(log).
It's
located
under /var/log/pandora/pandora_server.error by default. This logfile stores all noncontrolled errors
or noncaptured output from tools executed by the server. It's important to find problems and
debugging as well.

148

Server

11.1.1.6. dbname
The name of database the server will connect to. It's located under 'pandora' by default.

11.1.1.7. dbuser
Username used in the Pandora database connection. It's located under 'pandora' by default.

11.1.1.8. dbengine
The engine which is running the database (oracle, postgres or mysql). It's located under 'Mysql' by
default.

11.1.1.9. dbpass
The password for the connection against the Pandora FMS Database.

11.1.1.10. dbhost
The IP address or equipment name which hosts the Pandora FMS database. In reduced installations,
it's usually the same equipment where the server is located, which is localhost.

11.1.1.11. dbport
It's used to define a different port in your database setup (optional).

11.1.1.12. daemon
It shows if the Pandora server is executed as a demon or not. If the server is launched with the '–D'
option, it's executed as demon.

11.1.1.13. verbosity
The detail level for the server and error messages, the register or log files. 0 is the predetermined
one, 1 is the detailed, 2 is debugging, 310 is noisy. If you experience any problem with Pandora
FMS, put this value to 10 to get the maximum detail. High values (e.g. 10) are not intended to be
used in productive systems because they have a great performance impact.

11.1.1.14. master
Let's say '1' is a master server, '0' is a slave server which is part of a multiple server configuration
(for a HA environment, please go to the "HA Documentation" chapter for more information).

11.1.1.15. snmpconsole
'1' shows the SNMP traps reception console is activated in the configuration. '0' shows that it's not.
The console depends on the snmptrapd UNIX service. Before starting Pandora FMS server, please
make sure that the 'snmptrapd' process IS NOT running on your server.

11.1.1.16. networkserver

'1' shows the Pandora FMS network server is activated in the configuration. 0 that it
is not.
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11.1.1.17. dataserver
'1' shows the Pandora FMS Data Server is activated in the configuration. 0 that it is not. This server
processes the XML files coming from the agents, but also perform much more tasks. You're required
to have this server always running on your systems.

11.1.1.18. reconserver
'1' shows the Pandora FMS Network Recon Server is activated in the configuration. 0 that it is not. If
you don't want to use the recon server, it's recommended to disable it.

11.1.1.19. pluginserver
'1' shows the Pandora FMS complement server is activated in the configuration.0 that it is not.

11.1.1.20. predictionserver
'1' shows the Pandora FMS prediction server is activated in the configuration.0 that it is not .

11.1.1.21. wmiserver
'1' shows the Pandora FMS server of WMI is activated in the configuration.0 that it is not .

11.1.1.22. inventoryserver
(Pandora FMS Enterprise only)
'1' shows the Pandora FMS remote inventory server is activated in the configuration.0 that it is not.
The inventory data transmitted by the agents are processed by the data server. There is no need to
activate the remote inventory server here in this case.

11.1.1.23. exportserver
(Pandora FMS Enterprise only)
'1' shows that the Pandora FMS export server is activated in the configuration.0 that it is not.

11.1.1.24. webserver
(Pandora FMS Enterprise only)
'1' to activate the WEB checking (webserver, also known as Goliath Server). 0 that it is not.

11.1.1.25. eventserver
(Pandora FMS Enterprise only)
Enables ('1') or disables ('0') the event correlation server (default value is '1').

11.1.1.26. icmpserver
(Pandora FMS Enterprise only)
Enables (1) or disables (0) the Enterprise ICMP server (default value is 0). The Enterprise ICMP
server uses NMAP to perform block ICMP requests. The XML output of older versions of NMAP does
not report roundtrip time. If all your ICMP latency modules return a value of '0', please set this
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configuration variable to '0'. If the version is incorrect, please install NMAP 5.51 or higher. If you're
unsure, you may run NMAP and see if the roundtrip time is returned:
nmap -nsP -PE -oX - www.pandorafms.com | grep srtt

11.1.1.27. snmpserver
(Pandora FMS Enterprise only)
Enables ('1') or disables ('0') the Enterprise SNMP server (default value is '0'). The Enterprise SNMP
server uses an external utility called braa to perform the block of SNMP queries. Modules which
can't be processed by braa will be marked as uninitialized and are going to be handled by the
Network server. If you experience additional problems with braa, simply set this configuration
variable to '0'.

11.1.1.28. network_timeout
It's the timeout in seconds for the network server connections on network ICMP modules. Default
value is 2 seconds. If you are performing remote checks on WAN networks, you probably should
increase this value to avoid incorrect results.

11.1.1.29. server_keepalive
Time before classifying the server as 'down' in seconds. The default value is '45'.

11.1.1.30. server_threshold
The number of seconds for the main loop in seconds. Its value is '5' by default. This is a very
important configuration token, because it defines how many times Pandora FMS looks into the
database or on the harddrives for new data to process. '5' through '10' are good values in most cases
 the minimum value is '1'. If you set it to '1', the system CPU load will be very high. You can set it to
'1' in in specific cases, e.g. your server has been down for a while and you're required to process the
pending XML files and network modules as quick as the system can. Set this to '1', wait for all
pending modules / XML processes to be finished and set them to 5  15 again. This value, used in
conjuntion with 'server_threads' and 'max_queue_files', is used to adjust the performance of your
server.

11.1.1.31. icmp_checks
Number of threads for the network server. It shows how many checks can be done at the same time,
but as it increases it requires much more processing capacity. Its default value is 5. Please do not
use more than 20  25 threads or the system could either get unstable or it's going to have poor
performance.

11.1.1.32. icmp_checks
Defines the number of pings to each 'icmp_proc' kind of module. At least one of these ckecks has to
give back '1' to the module for getting classified as correct. Its default value is '1'. If you set '5' here
and the first ping is OK, the other 4 are going to get skipped.

11.1.1.33. tcp_checks
Number of TCP retries in case the first one fails. Its default value is 1.
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11.1.1.34. tcp_timeout
Specific timeout for TCP connections. The default value is '30'.

11.1.1.35. snmp_checks
Number of SNMP reattempts in case the first one fails. The default value is '1'.

11.1.1.36. snmp_timeout
Specific expiration time for SNMP connections. Its default value is '3'.

11.1.1.37. snmp_proc_deadresponse
Gives back 'DOWN' if it's impossible to connect with a boolean SNMP module (proc) or if it gets
'NULL' as a response. If set to '0' it should be ignored.

11.1.1.38. plugin_threads
Number of threads for the complement server. Shows how many checks could be done
simultaneously. Its default value is '3'.

11.1.1.39. plugin_timeout
Timeout for the checks with complements. After this time, the module state will be shown as
'unknown'. Its default value is 5. You're verly likely to need to raise this value. If a plugin has a
higher value, the value used is the given one here, instead of the plugin value.

11.1.1.40. wmi_timeout
WMI timeout checks. After this time, the module state will be shown as 'unknown'. Its default value
is '10'.

11.1.1.41. wmi_threads
Number of threads for the WMI server. It shows how many checks could be done simultaneously. Its
default value is '2'.

11.1.1.42. prediction_threads
Number of threads for the prediction server.

11.1.1.43. recon_threads
Number of threads for the network recon server. Shows how many checks could be done
simultaneously. Its default value is '2'.

11.1.1.44. dataserver_threads
Number of threads for the data server. Shows how many threads of the XML file processor are
pcrocessed simultaneously. Its default value is '2'. Recommended max. is '4'.
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11.1.1.45. inventory_threads
(Pandora FMS Enterprise only)
Number of threads assigned to the remote inventory server. It shows how many simultaneous
threads are assigned to this component.

11.1.1.46. export_threads
(Pandora FMS Enterprise only)
Number of threads assigned to the export server. It shows how many simultaneous threads are
assigned to this component.

11.1.1.47. web_threads
(Pandora FMS Enterprise only)
Number of threads assigned to the WEB test server. It shows how many simultaneous threads are
assigned to his component.

11.1.1.48. web_engine
(Pandora FMS Enterprise only)
Set to "curl" to use Curl instead of LWP for web monitoring. The Curl binary must be installed and
in the PATH.

11.1.1.49. mta_address
Mail Server IP address (Mail Transfer Agent)

11.1.1.50. mta_port
Mail server port ('25' by default)

11.1.1.51. mta_user
Mail server user (if necessary for use with authentication)

11.1.1.52. mta_pass
Password for the mail server (if necessary with authentication)

11.1.1.53. mta_auth
Mail server authentication system (if necessary. The valid values are: 'LOGIN', 'PLAIN', 'CRAMMD5'
and 'DIGESTMD')

11.1.1.54. mta_from
Mail address the mails will be sent from. The default value is pandora@localhost.

11.1.1.55. mail_in_separate
'1' by default. If set to '1', it delivers separate mail for each destination. If set to '0', the mail will be
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shared among all destinations.

11.1.1.56. xprobe2
If it's given, it's used to determine the operating system of the remote systems, assigned to the
agents when a recon network task is launched. The default path is /usr/bin/xprobe2. If not
provided, NMAP will be used instead  it's much more imprecise, though.

11.1.1.57. snmpget
Required for SNMP checks. The default path is/usr/bin/snmpget. It refers to the location of the
SNMP standard client for the system. It's recommended not to touch it unless you know exactly
what you're doing.

11.1.1.58. nmap
Required for the recon server. The default path is/usr/bin/nmap. It's recommended not to touch it
unless you know exactly what you're doing.

11.1.1.59. plugin_exec
Shows the absolute path to the program which executes the plugins in a controlled way in time. The
default path is/usr/bin/timeout. It's recommend not to touch it unless you know exactly what you're
doing. If
your
base
system
doesn't
have
a
timeout,
you
should
use
the
path /usr/bin/pandora_exec instead.

11.1.1.60. autocreate_group
Numeric ID of the default group for the new agents, created with the data server through the
datafile reception. The default value is '2'.

11.1.1.61. autocreate
If you change this value to '1' the agents will be selfcreated if XML files are received for which there
would be no agents. If it's set to '0' they're not going to be created and you're required to create an
agent first (agent names are case sensitive).

11.1.1.62. max_log_size
Maximum size of Pandora FMS register file in bytes. When this size is reached, it's recommended
the file should be moved topandora_server.log.old and let the server generate a new one. The
default value for the size is 65536 Bytes.

11.1.1.63. max_queue_files
Maximum number of unread XML datafiles from the directory which contains them to avoid an
overload to the system. Although the directory is not going to be read, doesn't mean the files are not
 and they continue being processed. The default value is '250'.

11.1.1.64. use_xml_timestamp
Deactivated by default. If activated ('1') it uses the XMLfile timestamp, generated with time and
date of the server in the moment of reception, instead of the timestamp that the XML file internally
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has, which was generated by the server. This is useful to be deactivated globally in case the use of
the dates generated by the agents and date / hour (timestamp) of the server as a reference for all
data. In systems which experience problems with synchronization or systems with wrong date /
hour, it's an option which could solve almost all problems.

11.1.1.65. auto_restart
Deactivated by default. If it's activated (value in seconds), it forces the server to do an internal
restart each X seconds (1 day = '86400'). This option is useful if you observe a degradation or loss
of control of any thread or specific server in use with Pandora FMS.

11.1.1.66. restart
Default value is '0'. If set to '1', the server will restart on critical errors after a given number of
seconds.

11.1.1.67. restart_delay
Default value is '60'. The number of seconds the server will wait before restarting after a critical
error if restart is enabled.

11.1.1.68. self_monitoring
The server has a self monitoring flag which creates a virtual agent in the server which monitors
most of the important parameters of a Pandora FMS Server. To activate it, the
parameter self_monitoring must be set to '1'.

11.1.1.69. update_parent
Although the server has a parameter to define if the agent can update it's parent by sending the
parents name on the XML: If this parameter is not defined or set to '0', the agent information is
ignored. If not, when the server receives an XML with 'parent_name' attribute, is going to look for
an agent with this name  and if it's found, it updates the parent of the agent from the XML.

11.1.1.70. icmp_threads
(Pandora FMS Enterprise only)
Number of threads for the ICMP Enteprise server (default value is '3').

11.1.1.71. snmp_threads
(Pandora FMS Enterprise only)
Number of threads for the Enteprise SNMP server (default value is '3').

11.1.1.72. block_size
(Pandora FMS Enterprise only)
Block size for block producer / consumer servers, which is the number of modules per block
(default value is 15).
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11.1.1.73. braa
(Pandora FMS Enterprise only)
Location of the braa binary required for the Enterprise SNMP server (default path is
'/usr/bin/braa').

11.1.1.74. braa_retries
(Pandora FMS Enterprise only)
Number of retries before braa handles a module over to the Network Server in case of an error.

11.1.1.75. event_window
(Pandora FMS Enterprise only)
Event window: It's the time window (in seconds) in which the event server will look for events. For
example, if set to '3600', the event server is going to check events generated within the last hour.

11.1.1.76. wmi_client
Default WMI client used (default value is 'wmic'). It's not recommended to change this value.

11.1.1.77. activate_gis
Flag to activate GIS (positional information for agents and maps). It's deactivated by default.

11.1.1.78. location_error
Radius of error in meters to consider two GIS locations as the same location.

11.1.1.79. recon_reverse_geolocation_mode
Recon reverse geolocation mode [disabled, sql, file]
•disabled The recon task doesn't try to geolocate the IP discovered.
•sql The recon task tries to query the SQL database to geolocate the IP discovered.
•file The recon task tries to find the geolocation information of the IP discovered in the file
indicated in the 'recon_reverse_geolocation_file' parameter.

11.1.1.80. recon_reverse_geolocation_file
Recon reverse geolocation file. This is the database with the reverse geolocation information using
MaxMind GPL (GeoLiteCity.dat format).

11.1.1.81. recon_location_scatter_radius
Radius (in meters) of the circle in where the agents will be place randomly when found by a recon
task. Center of the circle is guessed by geolocating the IP.

11.1.1.82. google_maps_description
This enable realtime reverse geocoding using Google Maps public API. This requires internet access
and could have performance penalties processing GIS information due the connection needed to
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resolve all GIS input. NOTE: If you don't pay the service to Google, they are going to ban your IP in
a few days.

11.1.1.83. openstreetmaps_description
This enable realtime reverse geocoding using Openstreet Maps public API. This requires internet
access, and could have performance penalties processing GIS information due the connection
needed to resolve all GIS input. You can alter the code to use a local (your own) openstreet maps
server.

11.1.1.84. event_file
This configuration token lets you configure a text file where events, generated by Pandora FMS, will
be written in CSV format.
For example:
event_file /var/log/pandora/pandora_events.txt

The first line of the text file is a header containing a list of field names. The contents of
pandora_events.txt could be:
id_agente,id_grupo,evento,timestamp,estado,utimestamp,event_type,id_agentmodule,id_alert_am,critici
ty,user_comment,tags,source,id_extra,id_usuario,critical_instructions,warning_instructions,unknown_
instructions,ack_utimestamp
Agent_1,Servers,Module Connections opened (136.00) is going to NORMAL,2013-07-01
19:00:57,1,1372698057,going_down_normal,Connections opened,,2,,,Pandora,,,,,,1372698057
Agent_2,Servers,Alert recovered (Critical condition) assigned to (Network Traffic
(Outgoing)),2013-07-01 19:00:59,0,1372698059,alert_recovered,Network Traffic
(Outgoing),Critical condition,4,,,Pandora,,,,,,0

11.1.1.85. snmp_storm_protection
Pandora FMS's SNMP Console will not process more than this number of SNMP traps from a single
source in a defined time interval. If this number is reached, an event is generated.

11.1.1.86. snmp_storm_timeout
Time interval for snmp_storm_protection in seconds.
To e.g. prevent a single source from sending more than 1000 traps per 10 minutes:
snmp_storm_protection 1000
snmp_storm_timeout 600

11.1.1.87. text_going_down_normal
Text for the event that is generated when a module goes to normal status. The macros '_module_
and _data_' are supported.
text_going_down_normal Module '_module_' is going to 'NORMAL'(_data_)

11.1.1.88. text_going_up_critical
Text for the event which is generated when a module goes to 'critical' status.

157

Server

11.1.1.89. text_going_up_warning
Text for the event which is generated when a module goes from 'normal' to 'warning' status.

11.1.1.90. text_going_down_warning
Text for the event which is generated when a module goes from 'critical' to 'warning' status.

11.1.1.91. text_going_unknown
Text for the event which is generated when a module goes to 'unknown' status.

11.1.1.92. event_expiry_time
Events older that the specified time (in seconds) will be autovalidated. Set to '0' to disable this
feature.
To e.g. automatically validate events 10 hours after they were generated, just use the command:
'event_expiry_time 36000'

11.1.1.93. event_expiry_window
This parameter is used to reduce the impact of 'event_expiry_time' so the entire event table does not
have to be searched. Only events more recent than the specified time window (in seconds) will be
automatically validated. This value must be bigger than event_expiry_time.
The default value ('86400') is the equivalent of one day:
event_expiry_window 86400

11.1.1.94. (>= 5.X) snmp_forward_trap
Enables ('1') or disables ('0') the SNMP trap forwarding to the host specified in snmp_forward_ip.

11.1.1.95. (>= 5.X) snmp_forward_ip

IP address of the host to which SNMP traps will be forwarded to.
Bear in mind that setting a local IP address will cause a forwarding loop that is going to
induce a collapse of the Monitoring Server.

11.1.1.96. (>= 5.X) snmp_forward_version
SNMP version to use when forwarding SNMP traps. This token can only have the following values:
•1
•2c
•3

11.1.1.97. (>= 5.X) snmp_forward_secName
Only for SNMP version 3. It defines the security name. More information at snmpcmd's man page.
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11.1.1.98. (>= 5.X) snmp_forward_engineid
Only for SNMP version 3. It defines the authoritative (security) engine ID. More information
at snmpcmd's man page.

11.1.1.99. (>= 5.X) snmp_forward_authProtocol
Only for SNMP version 3. It defines the authentication protocol. This token can only have the
following values:
•MD5
•SHA

More information at snmpcmd's man page.
11.1.1.100. (>= 5.X) snmp_forward_authPassword
Only for SNMP version 3. It defines the authentication pass phrase. For more information, please go
to snmpcmd's man page.

11.1.1.101. (>= 5.X) snmp_forward_privProtocol
Only for SNMP version 3. It defines the privacy protocol. This token can only have the following
values:
•DES
•AES

More information at snmpcmd's man page.
11.1.1.102. (>= 5.X) snmp_forward_privPassword
Only for SNMP version 3. It defines the privacy pass phrase. More information at snmpcmd's man
page.

11.1.1.103. (>= 5.X) snmp_forward_secLevel
Only for SNMP version 3. It defines the security level. This token can only have the following
values:
•noAuthNoPriv
•authNoPriv
•authPriv

More information at snmpcmd's man page.
11.1.1.104. (>= 5.1) claim_back_snmp_modules
If set to 1, SNMP modules run by the Network Server will be claimed back by the SNMP Enterprise
Server when the database maintenance script (pandora_db) is run.

11.1.2. Snmptrapd configuration
The SNMP Console of Pandora FMS uses snmptrapd to grab SNMP traps. Snmptrapd is a standard
159

Server

tool, present on almost all UNIX systems, to grab traps and write a logfile. Pandora FMS configures
snmptrapd to write a custom logfile and reads it every x seconds, executing alerts if defined.
Previously, snmptrapd will accept all incoming notifications, and log them automatically (even if no
explicit configuration is provided). Starting with 5.3 release, access control checks will be applied to
incoming notifications.
If snmptrapd is running without a suitable configuration file (or equivalent access control settings),
then such traps will not be processed.
You're probably required to configure your snmptrapd using the file /etc/snmp/snmptrapd.conf. If it
doesn't exist, please check /var/log/pandora/pandora_snmp.log file for warnings or errors.
A basic snmptrapd.conf could be like:
authCommunity log public
If doesn't work on your linux distribution, please check your version syntax to enable the reception
of traps in your snmptrapd daemon with
man snmptrapd.conf

11.1.3. Tentacle Configuration

By default, Pandora FMS software agents send the data packages to the server
through the Tentacle protocol (Port 41121/TCP assigned by IANA [1]). The agent
could also be reconfigured to it send data in alternative ways: local transfer
(NFS,SMB),SSH or FTP, etc. IF you want them to send the data packages by usinf
the Tentacle protocol, then you're required to configure a Tentacle server where this
data is intended to be received. When a Pandora FMS server is installed, a Tentacle
server is also installed in the same machine by default.
If it would be necessary to adjust some parameters of the Tentacle server configuration, then it
could be done modifying the script that launches the Tentacle Server daemon directly which is in:
/etc/init.d/tentacle_serverd
Furthermore, there is a list of the different options for Tentacle Server configuration:
PANDORA_SERVER_PATH
The path to the entry directory of data. The default path is /var/spool/pandora/data_in
TENTACLE_DAEMON
The Tentacle daemon. The default command is 'tentacle_server'.
TENTACLE_PATH
The path to the Tentacle binary. The default path is '/usr/bin'.
TENTACLE_USER
User from which the Tentacle demon will be launched. The default value is pandora.
TENTACLE_ADDR
Direction to listen to the data packages. If you fix 0.0.0.0. it will be listened to all of them. The
default value is to listen in all directions. This is true when it's IP is 0.0.0.0.
TENTACLE_PORT
The listening port for package reception. By default it's 41121 (official port assigned by IANA).
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TENTACLE_EXT_OPTS
Additional options for executing the Tentacle server. You can setup Tentacle to use authentication
with certs (x509) and/or simmetric password in both sides here.
Simple file transfer with password authentication (not secure):
Extra parameters in the tentacle server setup
x password
Extra parameters in the client side (TENTACLE_EXT_OPTS)
x password
Secure file transfer without client certificate:
Extra parameters in the tentacle server setup
e cert.pem k key.pem
Secure file transfer with client certificate:
Extra parameters in the tentacle server setup
e cert.pem k key.pem f cacert.pem
Extra parameters in the client side (TENTACLE_EXT_OPTS)
e cert.pem k key.pem
Secure file transfer with client certificate and password authentication:
Extra parameters in the Tentacle Server setup
x password e cert.pem k key.pem f cacert.pem
Extra parameters on the client side (TENTACLE_EXT_OPTS)
x password e cert.pem k key.pem

11.2. WEB Console
The Pandora FMS web console has a configuration file which usually is created and configured
when it's installed. If the installation is done through the DEB or RPM packages or from the Pandora
FMS installation CD, then it's configured in an automated way. If it's installed in a manual way, it's
contained in the tarball package. It could also be configured by the web assistant through
http://ip_instalacion_consola/pandora_console/install.php
The configuration file config.php is in the directory '/include/' in the console installation directory.
This
could
be
'/var/www/pandora_console'
(Debian,
Ubuntu)
or
'/srv/www/htdocs/pandora_console/' (SUSE, RH, Fedora...), depending on the distribution.

11.2.1. Configuration File config.php
The configuration options in the file are contained in the header, and these are:
$config["dbname"]
Database name to connect to. The default value is 'pandora'.
$config["dbuser"]
User name for the connection against the Pandora database. The default value is 'pandora'.
$config["dbpass"]
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Password for the connection against Pandora FMS database.
$config["dbhost"]
IP adress or equipment name which hosts the Pandora FMS database. In a reduced installation, it
usually is the same equipment where the server is, which is 'localhost'.
$config["homedir"]
Directory where the Pandora FMS web console is located.
'/var/www/pandora_console' or '/srv/www/htdocs/pandora_console'.

This

is

usually

$config["homeurl"]
Base directory for Pandora FMS. This is usually '/pandora_console'.
$config["public_url"]
The full URL is set with the string value, the value is the URL of inside Pandora FMS Server if you
use a inverse proxy e.g. 'mod_proxy' from Apache.

11.2.1.1. Redirection to '/pandora_console' from /
If you only have one Pandora FMS in your Apache server then it's possible that you could benefit by
automatically readdressing '/pandora_console' when users connect with the URL of their server. To
do this, you could create the following file index.html and put it in the web server root directory
('/var/www' or '/srv/www/htdocs'):
For the case if users connect with the URL / of their server. You can create the following
file index.html and put it in the web servers root directory for it:
<html>
<head>
<meta HTTP-EQUIV="REFRESH" content="0; url=pandora_console/index.php">
</head>
</html>

11.3. Pandora FMS Software Agents
11.3.1. What is an Agent ?
Pandora FMS software agents collect all data from their systems. They are each executed in a local
system, but they also can collect remote information through the monitoring systems installation for
the agent in several different machines.
They are developed to work with a fixed platform, using specific tools from the language which was
used: VBScript / Windows scripting for Microsoft platforms (Windows 2000, Windows XP, Windows
2003 and Windows Vista), ShellScripting for UNIX including GNU/Linux, Solaris, AIX, HPUX and
BSD and also the Nokia IPSO. The Pandora FMS agents could be developed in any language as long
as it would be a system with an easy API and open code. There are modalities of the Pandora FMS
project which has been started for the agents creation in Posix, C, Perl and Java for systems which
require closed agents.
Pandora FMS is 100% open code, e.g. in the way the agents collect and send information is
documented and could analyze and / or modify the code to suit to your needs. An agent could be
created again in any programming language and could also be easily updated to improve aspects of
the program that hadn't been covered completely.
This document describes the agent installation in machines that work with the Windows and UNIX
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operating systems.

11.3.1.1. General Role of Software Agents
The Software Agents general role is based on obtaining information about the operating system on
which they are installed, to collect this information and sending it to the Server.
Pandora FMS software agents use the specific commands of the operative system in order to obtain
the information. The Pandora FMS Data Server keeps and processes the data generated by these
commands and sent to the server in an XML file.
The information returned by these commands is kept in what is called a 'Module'. If the agent has
been added in 'learning mode', the modules which have been sent and which haven't been
previously defined in the logical agent will be created automatically by the server.

11.3.2. Introduction to the Agent Configuration
The agent is controlled by a unique configuration file which has a syntax which is almost identical
in UNIX systems as it's in Windows Systems. This file is named pandora_agent.conf and it's located
in
the
agent
installation
directory
(in
Windows
Systems)
and
under /etc/pandora/pandora_agent.conf in Unix systems.
This configuration file is a plain text file with different options which could all be modified by the
administrator. To modify it or it's performance, just configure where ther data is supposed to get
sent to, which things have to be monitored and how it's going to be done.

Configuration file encoding. It's very important and has to have the same value which is
set in the encoding configuration parameter. If the encoding is set properly, the
reception of data with improper encoding characters is going to be avoided.

Now we're going to deal with all the general parameters for the Software Agent and the monitoring
modules  which are the ones defining how and what is locally monitored with the Software Agent.

11.3.3. General Agent Parameters
The Configuration of the General Agent Parameters is defined in this section. Some of them are
common for all systems and others are intended specifically for Windows or Unix machines. The
general parameters are:

The first time the server receives data from an agent is going to save all of the
information into the database. For the following received data it will only update
(depending on learning mode status enabled/disabled) the following fields from XML
file: version, date, OS version, and the following parameters from the configuration
file: gis_exec, latitude, longitude, altitude parent_agent_name, timezone_offset, add
ress and custom_field.

11.3.3.1. server_ip
It's the IP address or the name of Pandora FMS Server Host where all data will be stored. The server
has to be prepared to collect the data either by SSH (listening on port 22), Tentacle (port 41121),
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FTP (port 21), SMB or NFS.

11.3.3.2. server_path
The server path is the comprehensive file path where the server stores all the data which was sent
by the agent. The default path is '/var/spool/pandora/data_in'.

11.3.3.3. temporal
This is the complete path of the folder where the agent stores the local data before sending them to
the server.
Please consider the data packages are deleted by default once the agent tries to contact with the
Pandora FMS Server. It's not taking into account if the connection was successful or not (although
this function could be changed, as we see later).
This is done to prevent an overload on the harddrive of the host system where the agent runs. The
location of the local file changes, depending on the architecture of the host system. Under UNIX
systems it's usually at '/var/spool/pandora/data_out', and under Windows systems it's 'C:\program
files\pandora_agent\temp'. The Windows installer is going to create this directory depending on
where it decides to install Pandora FMS by default.
And under Windows systems, the Windows installer is going to create this directory by default,
depending on where it decides to install Pandora FMS.

11.3.3.4. description
Sends the description of the agent in XML and Pandora FMS imports this description when it creates
the Agent.

11.3.3.5. group
Sends the name of the group we want the agent to own, and that is only used in the moment the
agent is created. The Pandora FMS Server will automatically use this group to put the agent in the
selected group.

11.3.3.6. temporal_min_size
If the free space (in MB) of the partition in which the temporary directory is located. If it's smaller
than this value, it would continue generating data packages. It avoids the disk becoming full if the
connection with the server is lost during an extended interval under any circumstances.

11.3.3.7. logfile
The path to the Pandora FMS agent events record file. The file could be used to check the system
and to investigate other things.

11.3.3.8. interval
This is the time interval (in seconds) in which the agent is going to collect data from the host
system and send the data packages to the server. The range of recommended values constitutes
from 300 (5 minutes) to 600 (10 minutes). This value could be bigger, but it's important to consider
the impact of a higher value in the database. The execution is not recommended if it's configured to
be below 3060 seconds.
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11.3.3.9. debug
This parameter is used to check the creation of data in the files, forcing the agent to not copy data
from files for the server, so the data content of the files could be checked and also copy the XML
files data manually. No data is destroyed when the process has been completed, so the data of the
files will be at the temporary directory. The activity is registered in the registry file. The registry file
is 'pandora_agent.log' (see logfile above).

11.3.3.10. agent_name
This is an alternative name for the host. This parameter is optional. This has not been declared but
obtained directly from the system. The parameter could be used to overwrite the host name for
another one in case of a conflict.

11.3.3.11. address
This is the IP address of the software agent. It could be an IP address with the format X.X.X.X or a
domain name such as 'localhost' or 'auto'. If it's an IP address or a domain name, it will be added to
the addresses of the agent and established as a main address. If the value is 'auto', it will obtain the
IP address from the host and added to the agent as in the previous case.

11.3.3.12. encoding
Installs the kind of codification of the local system, such as ISO885915 or UTF8. This option is
available for the UNIX and Windows agents from Pandora FMS 2.0.

11.3.3.13. server_port
This parameter allows to identify the remote port of the server that is waiting. By default it's 41121
for Tentacle. In case Tentacle is not used or that the server is configured to use another port, this is
the place where it should be changed.

11.3.3.14. transfer_mode
This parameter specifies the transfer mode we have to install in order send the agent data to the
server. The available modes are SSH (using SCP), Tentacle, FTP o local. The local mode is only for
systems where the agent is executed in the same machine that the server, because it is basically an
copy between directories. The local mode is available only for GNU/Linux agents.

11.3.3.15. server_pwd
Specific for the password of Windows FTP and for the Tentacle transference mode, although the
password at the last one is optional. Server password for authentication with password.

11.3.3.16. server_ssl
Specific for the Tentacle transfer mode. Allows to authorize ('1') or deny ('0) the connections which
encrypt through SSL.

11.3.3.17. server_opts
Specific for the Tentacle transfer mode. Allows to give additional parameters to the Tentacle client
for advanced configurations. They should be between "" (e.g. "vr 5").
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Coming with the 3.2 agent version, tentacle supports the optional use of a HTTP proxy (using
CONNECT) mode to send information to the server. This is implemented using an advanced option
like this:
server_opts y user:pass@proxy.inet:8080
This will force the tentacle client to use 'proxy.inet' on port 8080 using "user" and "pass" for
authentication. If you intend to use a proxy on e.g. 192.168.1.2 on port 9000 without credentials,
the command would have to be:
server_opts y 192.168.1.2:9000

11.3.3.18. delayed_startup
This parameter allows to configure the Pandora FMS agent in order to start working after any
specific amount of time (in minutes) after manual execution. It could be useful for systems with a
lot of load packages. It's deactivated by default, which means the Pandora FMS agent is going to
start working from the moment it will be executed manually. This option is only valid for UNIX
agents.

11.3.3.19. pandora_nice
This parameter allows to specify the priority, the Pandora FMS agent process will have within the
system. It's only available for Unix / Linux agents.

11.3.3.20. autotime
If it's enabled ('1') it's going to send a timestamp of special execution (AUTO) that makes the server
use its local date / hour to establish the data hour, not paying attention to the hour sent by the
agent. This is necessary in agents which have a wrong hour or a different hour from the server for
any reason.

11.3.3.21. cron_mode
With this parameter, it's possible to make the agents using the Linux crontab functions to execute
itself in a predetermined interval instead of using the agents internal system to execute itself on a
certain time. It's deactivated by default and it's not recommended to use it unless it's an absolute
necessity.

11.3.3.22. remote_config
This parameter controls the possibility to configure the agent remotely from the console. '1': The
remote configuration is allowed. '0': The remote configuration is not allowed. It's deactivated by
default.

11.3.3.23. xml_buffer
The default value is '0'. If set to '1', the agent is going to save any XML data files which couldn't be
sent and retries later.
if you are in a secured environment under UNIX and want to enable the XML buffer, you should
consider changing the temporal directory, since anyone has the right to write into '/tmp'.

An example of the general parameters from a UNIX configuration would be:
server_ip

192.168.1.1
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server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

/var/spool/pandora/data_in
/var/spool/pandora/data_out
/var/log/pandora/pandora_agent.log
300
0
box01
41121
tentacle
1

An example of the general parameters from a Windows configuration would be :
server_ip

192.168.1.1

server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

/var/spool/pandora/data_in
c:\archivos de programa\pandora_agent\temp
c:\archivos de programa\pandora_agent\pandora_agent.log
300
0
box01
41121
tentacle
1

11.3.3.24. timezone_offset
The agent can set it's timezone offset with the server now. It's very useful to have agents with a
different timezone synchronized on the same time with a server in another timezone. Agents will
send the shifted timezone to the server.
1.Timezone offset: Difference with the server timezone
timezone_offset 3

11.3.3.25. parent_agent_name
If the server allows it, it's also now possible to update the parent of an agent by sending the name of
the parent agent in XML.
parent_agent_name parent_name

11.3.3.26. agent_threads <threads>
Number of threads the agent is going to launch to execute modules simultaneously. by default there
is a single thread, to execute one module, and later the other, and go on until finish all of them.
This is only available in Unix agents.

11.3.3.27. include <filename>
This is the alternative configuration file path. This file can contain additional modules and
collections alongside the ones found in the main configuration file. This token is optional. In
matters related to perl agents, it allows for filename wildcards.

11.3.3.28. broker_agent <name>
It manages configuration and data collection from an agent like if they would be multiple numbers
of it. A new configuration file is created for each broker agent added in the main configuration file
with the name we have assigned to it. This token will be used only in the broker agent and not in
the new agents created by it. These new agents will start reporting after the next execution. This
token is optional.
167

Pandora FMS Software Agents

11.3.3.29. pandora_user <user>
This parameter is optional and allows to execute the agent with the specified system user. This user
has to have have permissions to execute the agent and all associated resources.
As we can see, most of the parameters from a Windows and a UNIX agent are the same.

11.3.3.30. (>= 5.X) custom_id
Custom ID of the agent for external applications.

11.3.3.31. (>= 5.X) url_address
Custom URL to open it from the agent in the console.

11.3.3.32. (>= 5.X) custom_fieldX_name
Name of an agent custom field which already exists on the system. If doesn't exist, it will be
ignored.
Example:
custom_field1_name Model

11.3.3.33. (>= 5.X) custom_fieldX_value
Value for the custom field X defined in the previous parameter.
Example:
custom_field1_value C1700

11.3.4. Secondary Server
An special kind of general configuration parameter is the definition of a secondary server. This
allows the definition of a server to send data to, in a complementary way to the server defined the
standard way. The secondary server mode works in two different ways:
•on_error: Send data to the secondary server only in cases it could not send them to the
primary one.
•always: Always send data to the secondary server, no matter if it's able to contact the main
server or not.
Configuration example:
secondary_server_ip

192.168.1.123

secondary_server_path
secondary_mode
secondary_transfer_mode
secondary_server_port

/var/spool/pandora/data_in
on_error
tentacle
41121

11.3.5. UDP Server
The Pandora FMS Agent (both, Unix and Windows) allows to configure the agent for listening to
remote commands. This server listens on a user specfied UDP port and allows to receive orders from
a remote system  ideally from Pandora FMS through the execution of alerts on the server.
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There are several options to configure the UDP remote server. The default file is pandora_agent.conf
•udp_server: To activate the UDP server, set it on '1'. This is deactivated by default.
•udp_server_port: Port where it listens.
•udp_server_auth_address: Authorized IP address to send orders. For security reasons,
please restrict the access to this agent from a unique IP.
•process_<name>_start <command>: Command which is going to start a userdefined
process.
•process_<name>_stop <command>: Command which is going to stop the process.
•service_<name> 1: Allows the service <name> to be started or stopped remotely from
the UDP server.
Configuration Example:
udp_server 1
udp_server_port 4321
udp_server_auth_address 192.168.1.23
process_firefox_start firefox
process_firefox_stop killall firefox
service_messenger 1

The server accepts the following commands:
* <START|STOP> SERVICE <name of the service>: Starting or stopping a service.
* <START|STOP> PROCESS <name of the process>: Starting or stopping a process.
* REFRESH AGENT <name of the agent>: Forces one execution of the agent and refreshes data.

In 5.0 version, Unix agent only implements REFRESH AGENT command.
For example:
STOP SERVICE messenger
START PROCESS firefox
REFRESH AGENT 007

There is a script on the server at /util/udp_client.plwhich is used by the Pandora FMS Server as a
command of an alert to start process or services. It has this syntax:
./udp_client.pl <address> <port> <command>

To e.g. restart an agent:
./udp_client.pl 192.168.50.30 41122 "REFRESH AGENT"

For more information, please go to the Alert Configuration section.

11.3.6. Modules definition
Each piece of information which is collected has to be perfectly defined in each module, using the
most precise syntax. You can implement as many values as necessary in order to be collected,
adding, at the end of the general parameters as many modules as the number of values to compile.
Each module is composed of several directives. The list which appears bellow is a descriptive list of
all available modules and signals for UNIX agents (almost all of them could be also apply to the
Windows agent).
The general syntax is the following:
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module_begin
module_name NombreDelMódulo
module_type generic_data
.
.
.
module_description Ejecución del comando
module_interval Número
module_end

There are different kinds of modules, with different suboptions, but all modules have an structure
similar to this. The parameters module_interval and module_description are optional and the rest of
them completely compulsory. First, we're going to see the common elements.

11.3.6.1. Common elements of all modules
Module fields (except module data, description and extended info) are only stored on
module creation and will never be updated if the module is already created. This
behaviour is identical to the agent's enabled learning mode.

module_begin

Defines the beginning of the module (compulsory).
module_name <name>

Name of the module. This is the module ID. Please pick a name without blanks and not too long.
There is no specific limitation (max. 250 characters), but a short name would be easier to work
with. This name CAN NOT be duplicated ' with a similar name in the same agent. This name could be
duplicated with other modules in other agents. Just like in other chapters, Pandora FMS is sensitive
to the difference between capital and small letters (compulsory).
module_type

The data type that the module is going to use. There are several data types for agents:
•Numerical (generic_data). Simple numerical data, in floating points or wholes. If the
values are in the floating point type, they are going to be cut to their whole value.
•Incremental (generic_data_inc). The whole numeric data equals to the difference between
the current value and the previous one. When this difference is negative, the value is fixed to
'0'.
•Alphanumeric (generic_data_string). Collect alphanumeric text strings.
•Monitors (generic_proc). Useful to evaluate the state of a process or service. This type of
data is called 'monitor', because it assigns a '0' to a 'false' state and any value higher than '1'
to a 'true' state.
•Asynchronous Alphanumeric (async_string). Collects alphanumeric text strings which
could enter any moment without a fixed periodicity. The rest of the parameters (generic)
have a synchronous working, which means they expect the data entry every XX time, and if
they don't arrive then it's said they are in an unknown state (unknown). The asynchronous
modules are unable to adopt this state.
•Asynchronous

Monitor (async_proc).

Similar

to

'generic_proc'

but

asynchronous
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(compulsory).
•Asynchronous Numerical (async_data). Similar to 'generic_data' but asynchronous
(compulsory).
module_min <value>

This is the minimum valid value to generated data within this module. If the module has not been
defined in the web console yet, this value would be taken from this directory. This command is not
compulsory. This value does not eliminate the defined value within the agent. If the module does
not exist in the dashboard, then it's going to get created automatically when the learning mode is in
use.
module_max <value>

This is the maximum valid value for generated data in this module. If the module has not been
defined in the web console yet, this value could be taken from this directory. This guideline is not
compulsory and it's not supported by the Windows agent. It doesn't eliminate the defined value
within the agent. If the module does not exist in the dashboard, it will be created automatically
when the learning mode is in use.
module_min_warning <value>

This is the minimum value which will make the module state go to the 'warning' status. This
guideline is not compulsory. If the module doesn't exist in the dashboard, then it's going to get
created automatically when the learning mode is in use.
module_max_warning <value>

This is the maximum value which will make the module go to 'warning' status. This guideline is not
compulsory. It uses a <= (less than) operator.
module_min_critical <value>

This is the minimum value which will make the module state go to 'critical' status. This guideline is
not compulsory. This uses a > operator, not a >= operator.
module_max_critical <value>

This is the maximum value which will make the module state go to 'critical' status. This guideline is
not compulsory. This uses a <= operator.
module_disabled <value>

Indicates if the module is enabled ('0') or disabled ('1'). This guideline is not compulsory. If the
module does not exist in the dashboard, it's going to get created automatically when the learning
mode is in use.
module_min_ff_event <value>

This is the interval between new status changes which are filtered to avoid continuous changes of
module state. This guideline is not compulsory. If the module doesn't exist in the dashboard, it's
going to be created automatically when the learning mode is in use.
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module_description <text>

This guideline will be employed to add a comment to the module. This guideline in not compulsory
and it doesn't overwrite the value defined by the agent. If the module doesn't exist in the
dashboard, it's going to get created automatically when the learning mode is in use.
module_interval <factor>

Since Pandora 1.2 introduced this new type, it's possible for each module to fix its own interval.
This interval is calculated as a multiplier for the agent interval. If the agent has e.g. an interval 300
(5 minutes) and you want a module which is going to get processed every 15 minutes only, you
should add this line: module_interval 3. This module will be processed every 300sec x 3 = 900sec
(15 minutes).
module_timeout <secs>

(Windows only)
In the 3.1 version, Pandora FMS supports specifying the total of seconds in each module
independently. The agent is going to wait for the execution of the module, so if it takes more than
XX seconds, it's going to abort the execution of the module (to avoid becoming 'dead' in the
implementation of a module). In version 3.1, it's supported on Windows only  but in future
versions, it's also going to get implemented into the UNIX agents.
module_postprocess <factor>

Same as in the definition of post processing of a module that is done from the console, a numeric
value of floating comma could be defined here which is going to send this value to Pandora FMS in
order to use it to multiply the received (raw) by the agent. If you e.g. want to multiply the value
that the agent returns by 1024, just put "1024" in here. If you want to divide it by 1024, then just
put 1/1024 here  which is 0,000976563.
module_save <variable name>

From version 3.2, it's possible to save the modules return value in an environment mode variable, so
it could be used in other modules later. It's important to consider the values are updated after the
modules are executed in the same order in which they were defined.
For example:
module_begin
module_name
module_type
module_exec
module_save
module_end

echo_1
generic_data
echo 41121
ECHO_1

module_begin
module_name echo_2
module_type generic_data
module_exec echo $ECHO_1
module_end

module_crontab <minute> <hour> <day> <month> <day of the week>

From version 3.2, it's possible to schedule modules in the order they'll be executed on
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a specific date. To do this, you're required to define the module_crontab', using a
similar
format
to
that
of
the
crontab
file:
(http://es.wikipedia.org/wiki/Cron_(Unix)#Sintaxis)
module_crontab <minute> <hour> <day> <month> <day of the week>
Being:
•Minute 059
•Hour 023
•Day of the month 131
•Month 112
•Day of the week 06 (0 is Sunday)
It's also possible to specify intervals using the character as a divider.
In order to one module will be executed e.g. every Monday between 12 and 15, we could use the
following configuration:
module_begin
module_name crontab_test
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_end

The module will be executed once during the interval. If we want it to be executed while the
interval is on, we could use the module_cron_interval 0 option in the following way:
module_begin
module_name crontab_test2
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_cron_interval 0
module_end

To execute a command every hour, in an hour and 10 minutes:
module_begin
module_name crontab_test3
module_type generic_data
module_exec script.sh
module_crontab 10 * * * *
module_cron_interval 0
module_end

module_condition <operation> <command>

From version 3.2, it's possible to define commands that will be executed if the module returns some
specific values. It's necessary to specify one of the following options:
•> [value]: Executes the command if the module value is higher than the given one.
•< [valor]: Executes the command if the module value is lower than the given one.
•= [valor]: Executes the command if the module value is equal to the given one.
•!= [valor]: Executes the command if the module value is different to the given one.
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•=~ [regular expression]: Executes the command if the module value coincides with the
given regular expression.
•(valor, valor): Executes the command if the module value is ranged between the given
values.
It's possible to specify multiple conditions for the same module. For example:
module_begin
module_name condition_test
module_type generic_data
module_exec echo 2.5
module_condition (1, 3) script_1.sh
module_condition > 5.5 script_2.sh
module_end

Examples:
module_begin
module_name MyProcess
module_type generic_data
module_exec tasklist | grep MyProcess | wc -l
module_condition > 2 taskkill /IM MyProcess* /F
module_end
module_begin
module_name PandoraLogSize
module_type generic_data
module_exec ls -la "c:\Archivos de programa\pandora_agent\pandora_agent.log" | gawk "{ print $5
}"
module_condition > 10000 del "c:\Archivos de programa\pandora_agent\pandora_agent.log"
module_end
module_begin
module_name Service_Spooler
module_type generic_proc
module_service Spooler
module_condition = 0 net start Spooler
module_end

•NOTE: On Windows platforms, it's recommended to use cmd.exe /c to execute the
command to ensure it's executed properly. For example:
module_begin
module_name condition_test
module_type generic_data
module_exec echo 5
module_condition (2, 8) cmd.exe /c script.bat
module_end

module_precondition <operation> <command>

If the precondition is true, the module is going to run. It's necessary to specify one of the following
options:
•> [value]: Executes the command if the module value is higher than the given one.
•< [value]: Executes the command if the module value is lower than the given one.
•= [value]: Executes the command if the module value is equal to the given one.
•!= [value]: Executes the command if the module value is different to the given one.
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•=~ [regular expression]: Executes the command if the module value coincides with the
given regular expression.
•(value, value): Executes the command if the module value is ranged between the given
values.
An example of a module using preconditions is the following:
module_begin
module_name Precondition_test1
module_type generic_data
module_precondition (2, 8) echo 5
module_exec monitoring_variable.bat
module_end

Like postconditions, it's also possible to use several preconditions. The module is only going to be
executed if all preconditions are met:
module_begin
module_name Precondition_test2
module_type generic_data
module_precondition (2, 8) echo 5
module_precondition < 3 echo 5
module_exec monitoring_variable.bat
module_end

•NOTE: On Windows platforms, it's recommended to use cmd.exe /c to execute the
command to ensure it's proper execution. For example:
module_begin
module_name Precondition_test3
module_type generic_data
module_precondition (2, 8) cmd.exe /c script.bat
module_exec monitoring_variable.bat
module_end

(>= 5.x) module_unit <value>

This is a unit of the value retrieved by the module.
Example:
module_unit %
(>= 5.x) module_group <value>

This is the name of the module group. If the group doesn't exist, the module will be created without
getting assigned.
Example:
module_group Networking
(>= 5.x) module_custom_id <value>

This is a custom identifier for the module.
Example:
module_custom_id host101
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(>= 5.x) module_str_warning <value>

This is a regular expression to define the 'warning' status in the string types modules.
Example:
module_str_warning .*NOTICE.*
(>= 5.x) module_str_critical <value>

This is a regular expression to define the 'critical' status in the string type modules.
Example:
module_str_critical .*CRITICAL.*
(>= 5.x) module_warning_instructions <value>

These are the instructions to the operator if the module changes to 'warning' status.
Example:
module_warning_instructions Increase incident priority
(>= 5.x) module_critical_instructions <value>

These are the instructions to the operator if the modules changes to 'critical' status.
Example:
module_critical_instructions Call to sys department
(>= 5.x) module_unknown_instructions <value>

These are the instructions to the operator if the module changes to 'unknown' status.
Example:
module_unknown_instructions Open incident
(>= 5.x) module_tags <value>

These are the tags which will be assigned to the module separated by commas. It will only be
assigned to tags which exist in the system.
Example:
module_tags tag1,tag2,tag3
(>= 5.x) module_warning_inverse <value>

This is a flag (0/1) which will inverse the 'warning' threshold of the defined value when activated.
Furthermore, if you use a negative value for the interval, e.g. the 'warning' status for values under '
50', you need set the 'min_warning' to '50' and set this parameter.
Example:
module_critical_inverse 0
(>= 5.x) module_critical_inverse <value>

This is a flag (0/1) which will inverse the 'critical' threshold of the defined value when activated.
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Furthermore, if you use a negative value for the interval, e.g. the critical state for values under '75',
you're required to set the 'min_critical' to '75' and set this parameter.
Example:
module_critical_inverse 1
(>= 5.x) module_quiet <value>

This is a flag (0/1) which will turn the module into quiet mode when activated. It won't generate
events or alerts anymore.
Example:
module_quiet 1
(>= 5.x) module_ff_interval <value>

This is the flip flop execution threshold of the module (in seconds).
Example:
module_ff_interval 2
(>= 5.x) module_macro<macro> <value>

This is a macro generated by the console in conjunction with the components macro system. Setting
this parameter from the configuration file is futile, because it's intended for modules created with
local components only.
Example:
module_macro_field1_ 8080
module_end

Defines the end of the module (compulsory).

11.3.6.2. Specific guidelines to obtain information
Furthermore, there are the specific guidelines that could be specified for each module in order to
obtain information. Only one kind of them can be used in each module.
module_exec <command>

This is the general way to gather information by executing a command. Both for the UNIX and for
the Windows agent. There is only one guideline to obtain data the generic way, executing only one
command (it's able to use pipes to readdress the execution to another command). This guideline
executes a command and keeps the return value. This method is also available under the agents for
Windows; it's the general purpose method for both agents.

If execution returns a return code different from '0', it will be interpreted as "execution
error" and the information will be discarded.

In some cases where you're sure your command is ok, even if returning code is !=0, you can pipe
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the execution to another "dump" command to clean the return code, e.g.:
top -n 1

Will give you error code 1 (check which echo $?). To "clean" that error code, just use this command:
top -n 1 | grep ""

There are the following, additional guidelines for the agents to obtain data:
module_service <service>

Checks if a specific service is being executed on the machine. Remember to use the «" "» characters
if the name of the service contains blanks.
module_begin
module_name Service_Dhcp
module_type generic_proc
module_service Dhcp
module_description Service DHCP Client
module_end

The service is identified with the short name of the service (service name), such as it appears in the
Windows services manager. There is one other identifier, called "display name", longer and usually
more descriptive, but this is not the one used by Pandora FMS to identify the process. Neither it is
the process related to the server. In this snapshot, we can see the short name (service name) of the
service monitored in the previous example. It is important to stress that there is a difference in the
use of the "capital and the small letters (case sensitivity).
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UNIX
Under Unix, it works like under Windows, but under UNIX, 'service' and 'process' is considered the
same concept. For example, to see if the process named sshd is running, the module definition
would be:
module_begin
module_name Service_sshd
module_type generic_proc
module_service sshd
module_description Process SSHD running
module_end

'service watchdog' and 'service asynchronous detection' aren't possible under UNIX agents.
Asynchronous Way
Pandora FMS usually executes a test battery (each of it defined by a module) every X seconds (300
seg. = 5 min. by default). If a service is down just after an execution of Pandora, it's going to take
additional 300 seconds to recognize the service went down. The difference on asynchronous mode
is that modules immediatly notify Pandora FMS about the fail or shutdown of this service. This is
called asynchronous operation mode. It would be sufficient to add the following command to the
guideline to use it:
module_async yes

Watchdog of services
There is a watchdog mode for the services, so the agent is able to restart them if they stop. In this
case, the restarted service doesn't require any parameter, because Windows already knows how to
do it. In such cases, the configuration is a lot easier:
module_begin
module_name ServiceSched
module_type generic_proc
module_service Schedule
module_description Service Task scheduler
module_async yes
module_watchdog yes
module_end

module_proc <process>

Checks if an specific name of process is working in this machine. If the name of the process has
blanks no use «" " », please consider that the name of the process should have the .exe extension.
The module is going to return the number of processes executed with this name. Same as in the
other cases, it's important to know that the name of the process has to be exactly the same as the
one shown by the Windows Task Manager, including blanks, capital letters / small letters;
e.g. cmd.exe is not the same as CMD.exe (case sensitivity).
This is an example of the monitoring of the process 'cmd.exe':
module_begin
module_name CMDProcess
module_type generic_proc
module_proc cmd.exe
module_description Process Command line
module_end

UNIX
Under UNIX, this module works like 'module_service'. It doesn't support asynchronous and / or
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watchdog mode.
Asynchronous mode
In a similar way to the services, monitoring processes can be critical in some cases. The Windows
agent supports asynchronous checking for the module_proc. module now. In this case, the
agent immediatelyreports it if the process changes its state without waiting for the agent to
execute the verification as it's configured in the agent interval again. In this way, you're able to get
informed about the failure of critical processes almost in the moment they happen. This is an example
of asynchronous monitoring of the processes:
module_begin
module_name Notepad
module_type generic_proc
module_proc notepad.exe
module_description Notepad
module_async yes
module_end

The difference is located in the configuration token 'module_async yes'.
Processes Watchdog
A Watchdog is a system which allows to act immediately if an agent is down, usually picking up the
process which went down. The Pandora FMS Windows Agent could act as a watchdog when a
process is down. This is called watchdog mode for the process.
Executing a process would require some parameters, so here are some additional configuration
options for these kinds of modules. It is important to keep in mind that the watchdog mode only
works if the module type is set to asynchronous. This is an example of configuration of
'module_proc' with 'watchdog' enabled:
module_begin
module_name Notepad
module_type generic_proc
module_proc notepad.exe
module_description Notepad
module_async yes
module_watchdog yes
module_start_command c:\windows\notepad.exe
module_startdelay 3000
module_retrydelay 2000
module_retries 5
module_end

This is the definition of additional parameters for 'module_proc' with watchdog enabled:
•module_retries: Number of consecutive attempts for the module will try to start the
process before deactivating the watchdog. If the limit is reached, the watchdog device for
this module will be deactivated. It's never going to try and start the process, even if it's
recovered by the user (at least until the agent gets rebooted). There is no limit for the
number of retries for the watchdog by default.
•module_startdelay: Number of milliseconds the module is going to wait before starting the
process for the first time. If the process takes lot of time at starting, it would be a good idea
to order the agent to wait by using this parameter until it starts checking for if the process
has been started or not. In this example, it has been set to wait for 3 seconds.
•module_retrydelay: Similar to the previous one but for subsequent falls / reattempts, after
having detected a fall. When Pandora detects a fall, it relaunches the process, waits for the
preset number of milliseconds and checks if the process is already up again.
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It's important to keep in mind that Pandora FMS is executed as a service. If you want to utilize the
watchdog functionality to execute processes which allow interaction with the desktop, you should
check the box 'Interactive access with desktop' under the Pandora FMS service functionalities as
shown in this snapshot:

It's also necessary to understand that Pandora FMS is executed under the count of "SYSTEM" if
started as a service. The executed process is going to run with the user and environment of the one
who started it, so if it wants to e.g. execute a specific process which requires the environment and
rights of a specific user, one should include the previous processes for starting the environment
(environment variables, etc.) and execute this script as a watchdog action in a script (.bat or
similar).
module_cpuproc <process>

(UNIX only)
Returns the CPU usage of a specific process.
module_begin
module_name myserver_cpu
module_type generic_data
module_cpuproc myserver
module_description Process Command line
module_end

module_memproc <process>

(Unix only)
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Returns the memory used by a specific process.
module_begin
module_name myserver_mem
module_type generic_data
module_memproc myserver
module_description Process Command line
module_end

module_freedisk <unit_letter:>|<volume>

This module works under UNIX and Windows. It checks for the free space in the disk unit (don't
forget «":"» after the unit_letter) or the UNIX volume e.g. '/var'.
module_freepercentdisk <unit_letter:>|<volume>

This module returns the free disk percentage under a Windows unit: (don't forget the ":") or on a
Unix system, the volume, like '/var'.
module_begin
module_name freepercentdisk
module_type generic_data
module_freepercentdisk C:
module_end
module_begin
module_name disk_var
module_type generic_data
module_freepercentdisk /var
module_end

module_occupiedpercentdisk <unit_letter:>|<volume>

(Unix only)
This module returns the occupied disk percentage in a UNIX volume e.g. '/var'.
module_begin
module_name disk_var
module_type generic_data
module_occupiedpercentdisk /var
module_end

module_cpuusage <cpu id>

This works under UNIX and Windows. It returns the CPU usage in a CPU number. If there is only
one CPU, please leave it blank or use 'all'. It's also possible to obtain the average use of all CPU in
multiprocessor systems in this way:
module_begin
module_name SystemCPU
module_type generic_data
module_cpuusage all
module_description Average CPU use in systme
module_end

To check the CPU usage in CPU #1:
module_begin
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module_name SystemCPU_1
module_type generic_data
module_cpuusage 1
module_description Average CPU use in system for CPU #1
module_end

module_freememory

Supported under Windows and UNIX. It returns the free memory of the whole system:
module_begin
module_name FreeMemory
module_type generic_data
module_freememory
module_description Non-used memory on system
module_end

module_freepercentmemory

Supported under UNIX and Windows. This module returns the free memory percentage on one
system:
module_begin
module_name freepercentmemory
module_type generic_data
module_freepercentmemory
module_end

module_tcpcheck

(Windows only)
This module tries to connect with an IP and a specified port. It returns '1' if successful and '0' if not.
It's also recommended to specify a timeout:
module_begin
module_name tcpcheck
module_type generic_proc
module_tcpcheck www.artica.es
module_port 80
module_timeout 5
module_end

module_regexp

(Windows only)
This module monitors a record file (log) looking for coincidences using regular expressions, ruling
out the already existing lines when starting the monitoring. The data returned by the module
depend on the module type:
•generic_data_string, async_string: Returns all the lines which fit the regular expression.
•generic_data: Returns the number of lines which fit with the regular expression.
•generic_proc: Returns '1' if there is a coincidence and '0' if not.
•module_noseekeof: With this configuration token active, with a '0' default value in each
module execution and independently from any modification of the target file, the module
will restart its check process without searching for the file's EOF flag. It will always extract
all our search pattern's the matching lines to the XML output.
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module_begin
module_name regexp
module_type generic_data_string
module_regexp C:\WINDOWS\my.log
module_pattern ^\[error\].*
module_noseekeof 1
module_end

To obtain more information about the syntax of regular expressions in general, please visit [2].
module_wmiquery

(Windows only)
The WMI modules allow to locally execute any WMI query without the use of an external tool. It's
configured through two parameters:
•module_wmiquery: Used WQL query. As a result, several lines could be obtained which
will be placed as several data.
•module_wmicolumn: Name of the column which is going to be used as a data source.
For example, we could obtain a list of the installed services:
module_begin
module_name Services
module_type generic_data_string
module_wmiquery Select Name from Win32_Service
module_wmicolumn Name
module_end

Or the current CPU load:
module_begin
module_name CPU_speed
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end

module_perfcounter

(Win32 only)
Obtains
data
from
the
performance
counter
(http://msdn.microsoft.com/en
us/library/aa373083(v=vs.85).aspx Performance Counters (Documentación en ingles Performance
Counters Documentation) through the PDH interface (the library pdh.dll should be installed in the
system. PDH.DLL is a Windows library. If you have not installed it yet, you have to install the
Windows performance analysis tool (which is usually installed by default).
module_begin
module_name perfcounter
module_type generic_data
module_perfcounter \Memory\Pages/sec
module_end

The Windows performance monitor is a powerful tool which has hundreds of parameters that could
be used for monitoring. Each manufacturer also adds his owns monitors, so this is a powerful,
versatile and easy to use tool to monitor the system parameters and also the devices which run on
it.
The syntax of the perfcounter elements depend on the language. In a e.g. German version, Windows
184

Pandora FMS Software Agents

is going to have specific identification strings and in an English version, Windows will have other
ones. This makes it difficult to use on systems with heterogeneous languages.
To explore the different values which could be used, you can use the the Windows tool
"Performance" to see which strings of performance you're able to monitor.
You can see the Windows performance monitor on this snapshot:

On this snapshot you can see how the interface shows things if we want to add a new monitoring
element.
We could visualize several parameters of the Procesador (in Spanish in the original version) which
has different sub elements, of which we have selected % of processor time and in several sub
elements here. We're interested in total _Total in this case.
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Surfing with the SO tool in this way, we could get different elements of the system performance.
For this specific example, the module would be:
module_begin
module_name Processor_Time
module_type generic_data_inc
module_perfcounter \Procesador(_Total)\% de tiempo de procesador
module_end

By default the raw value of the counter is shown, to get the cooked value add the module_cooked
1 parameter:
module_begin
module_name Disk_E/S_Seg
module_type generic_data
module_cooked 1
module_perfcounter \DiscoFísico(_Total)\E/S divididas por seg.
module_end

Most of the returned data that are counters, so you should use 'generic_data_inc' as data type. It's
also able to return values in very high data scales (several millions), so you could reduce these
values using the module post process with values like '0.000001' or similar.
module_inventory

It's implemented as an agent plugin under Linux / Unix
Using predefined WMI consults and queries on the registry. This module obtains information about
the different aspects of a machine ... from software to hardware.
The module can get different parameters to mark the kind of information it gets. Here is the
parameter list and the kind of information that it gives:
•CPU: Gets information about the system CPUs (processor name, watch frequency and
description).
•CDROM: Gets information about the CDROM (name, description and unity letter).
•Video: Gets information about video cards (description, RAM and processor).
•HDs: Gets information about the hard disks (model, size and name in the system).
•NICs: Gets information about the network interface controllers(description, MAC address
and IP address).
•Patches: Gets information about the installed patches (identifier, description and
comments).
•Software: Gets information about MSI packages installed (name and version).
•RAM: Gets information about RAM modules (tag, capacity and name).
•Services: Gets information about the installed services. The short name shown in the first
column is the name of the service that Pandora FMS probably uses to monitor services.
Additional Module Parameters:
•module_interval: This module has an additional line to specify the interval in days, where
one can obtain the information for the module.
This is an example to use this module:
module_begin
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module_name Inventory
module_interval 7
module_type generic_data_string
module_inventory RAM Patches Software Services
module_description Inventory
module_end

module_logevent

(Windows only)
This new module allows to obtain information from the Windows event log file. It returns the
elements which fit to a given pattern, also allowing to filter by source and event type. The module
implemented in version 2.0 has been improved, using the Win32 native API now to have access to
the events from the file, instead of using the WMI subsystem (much slower). This method is quicker
and allows to work in systems with many elements. The new implementation also allows to filter
through much more fields compared to the previous version. The standard format of the module is
the following:
module_begin
module_name MyEvent
module_type async_string
module_logevent
module_source <logName>
module_eventtype <event_type/level>
module_eventcode <event_id>
module_application <source>
module_pattern <text substring to match>
module_description
module_end

To avoid showing which has already been shown, we only consider those events which had
occurred since the last time the agent was executed, as it happens with other modules (e.g.
'regexp').
'module_logevent' accepts the following parameters (all of them case sensitive):
•module_source: Event source (System, Application, Security). This field is compulsory.
•module_eventtype: Event type (failure, information). This is an optional field.
•module_pattern: Pattern to search (substring). It's an optional field.
•module_eventcode: It's a numeric ID of the event, e.g. 5112. It's an optional field.
•module_application: Application source of the event. Be careful not to confuse it with
'module_source' which shows the name, source or log file where the events are looked for.
For showing all events of an error type system we e.g. should define the following module:
module_begin
module_name log_events
module_type generic_data_string
module_description System errors
module_logevent
module_source System
module_eventtype error
module_end

To show all events which contain the word 'PandoraAgent':
module_begin
module_name log_events_pandora
module_type async_string
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module_description PandoraAgent related events
module_logevent
module_source System
module_pattern PandoraAgent
module_end

Another example: Filtering the event showed on the snapshot:

module_begin
module_name MyEvent
module_type async_string
module_source Application
module_eventtype Information
module_eventcode 6000
module_application Winlogon
module_pattern unavailable to handle
module_description
module_end

It's very important to understand that Pandora FMS is not a system to collect logs. This tool is
intended to be used to select critical or important events for monitoring which collects all events
without classifying them from a common source (as the 'system' could be one). Doing so will only
cause problems in a way that e.g. the DB will be collapse and the system will work very badly. It's
extremely important to understand that the event collection which comes with Pandora should
always be used with taking this into account and not to abuse Pandora FMS as a generic event
collector.
module_plugin

It's a parameter to define the data which is obtained at the exit of a plugin agent. It's a special case
of module which builds all its XML on its own. It also doesn't require any other delimiter like
'module_begin', 'module_type', etc. It requires this format:
module_plugin plugin_filename parámetro_1 parámetro_2 parámetro_3

In order to configure additional parameters for the plugin, please use the standard syntax:
module_begin
module_plugin plugin_filename parameter_1 parameter_2 parameter_3
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module_interval 2
module_condition (0, 1) script.sh
module_end

Each plugin has its own syntax. We are going to describe the regular expressions plugin which
comes with the agent by default.
module_plugin grep_log /var/log/syslog Syslog ssh

In this example, the name of the plugin is 'grep_log'. It's going to search for the regular expression
'ssh' in the file '/var/log/syslog' which will be kept in a module called 'Syslog'.
Another example intended to be solely used on Windowsbased systems (and only on versions 3.1
or later):
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\df_percent.vbs"

File collection and plugins
When you use file collections, you need to know where the file collection stores the files. File
collections use a "handle" or short name which is generated when you first create the collection. It
has to have a name similar to "fc_2". Here are some examples of 'module_plugin' usage using file
collections:
UNIX:
module_plugin /etc/pandora/collections/fc_1/always_1.sh

Windows:
module_plugin cscript //B "%ProgramFiles%\pandora_agent\collections\fc_2\df_percent.vbs"

It's very important to know the plugin execution output could return more than one module,
because it returns a full XML structure. This is e.g. the plugin output of the '/util/df.vbs' plugin in
windows:
<module>
<name><![CDATA[C:]]></name>
<description><![CDATA[Drive C: free space in MB]]></description>
<data><![CDATA[2361]]></data>
</module>
<module>
<name><![CDATA[D:]]></name>
<description><![CDATA[Drive D: free space in MB]]></description>
<data><![CDATA[32020]]></data>
</module>
<module>
<name><![CDATA[Z:]]></name>
<description><![CDATA[Drive Z: free space in MB]]></description>
<data><![CDATA[10168]]></data>
</module>

module_ping <host>

(Only for Windows versions 4.0.1 or newer)
This module pings the preset host and returns '1' if it's up and '0' if not. It's a wrapper for ping.exe.
Is supports the following configuration parameters:
•module_ping_count x: Number of 'ECHO_REQUEST' packets to be sent ('1' by default).
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•module_ping_timeout x: Timeout in milliseconds to wait for each reply ('1000' by default).
•module_advanced_options: Advanced options for ping.exe.
Example:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.1.1
module_ping_count 2
module_ping_timeout 500
module_end

module_snmpget

(From version 4.0.1 onwards, Windows only)
This module performs an SNMP get query and returns the requested value. It's a wrapper
for snmpget.exe.
It supports the following configuration parameters:
•module_snmpversion [1,2c,3]: SNMP version (1 by default).
•module_snmp_community <community>: SNMP community (public by default).
•module_snmp_agent <host>: Target SNMP agent.
•module_snmp_oid <oid>: Target OID.
•module_advanced_options: Advanced options for snmpget.exe.
Example:
module_begin
module_name SNMP get
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.1.1
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.148
module_end

11.3.7. Examples
Example of a Windows module, checking if 'EventLog' works. Example:
module_begin
module_name ServicioReg
module_type generic_proc
module_service Eventlog
module_description Eventlog service availability
module_end

An example for a UNIX module would be:
module_begin
module_name cpu_user
module_type generic_data
module_exec vmstat | tail -1 | awk '{ print $14 }'
module_min 0
module_max 100
module_description User CPU
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module_end
Tipos de agentes software

11.3.8. Specific Configuration by Technologies
With Pandora FMS it's possible to monitor any system. This could either be done with an installed
Software agent on the system, which collects data straight from the system to be monitored, or by
using a 'Satellite Agent' which consists of an agent which is executed in a server and monitor some
parameters of systems which have adjacents through SNMP or userdefined commands.
The software agents could be Windows or UNIX agents. The agents could be installed using any of
the agents described in the following lines. To use a satellite agent, it will be sufficient to install a
software agent and define the configured modules to collect data from an external system through,
e.g. the snmpget tool or ping.

11.3.8.1. UNIX / Linux Agents
UNIX has several command line tools that allow that get data through commands would be a very
simple thing. The Unix agents are based in this premise. There are two kinds of UNIX agents:
•ShellScript: With a defined shellscript for each kind of SO based on bash, ksh or csh. In the
classical UNIX Systems (Solaris, AIX, HPUX), all functionalities are not implemented yet 
but under Linux or MAC they are.
•Perl: There is a unique multiplatform agent based on Perl 5.8 that works alike in all Unix
systems. You're required to have a Perl 5.8 system or higher installed for proper functioning.
The shellscript agents have been designed to work in even the oldest UNIX versions: HPUX11.0, AIX
4.1, Solaris 6 ... They work, but are feature limited e.g. not having the Tentacle client and having to
use the FTP or SSH system to upload the monitoring data to its server.
Pandora FMS UNIX Agents Configuration

There is hardly any difference between AIX, Solaris and GNU / Linux. We are going to describe
some of their most important parameters and paths.
After starting the installer, the agents main directory or 'home' directory is
'/usr/share/pandora_agent/' where the Pandora FMS agent is installed. In the system where this
isn't possible for reasons of e.g. a strict system policy, we recommend to create a link to this path
from the real installation path, e.g. '/opt/pandora' > '/usr/share/pandora_agent'.
The other important folders are:
•/var/spool/pandora/data_out: Folder where the collected data from the agents is kept.
•/etc/pandora/pandora_agent.conf: Main agent configuration folder. The definition of where
the data is collected is defined by the used command.
•/usr/local/bin/pandora_agent: The current Pandora FMS agent. This file is a shellscript
which collects the configuration data in the 'pandora_agent.conf' files and sends the data
packages to the Pandora Server. It usually has a link to '/usr/bin/pandora_agent'.
•/usr/local/bin/tentacle_client: The agent which adds the Tentacle client for being able to
send the data files to the server. This is a client written in Perl 5.8. It usually has a link to
'/usr/bin/tentacle_client'.
•/etc/init.d/pandora_agent_daemon: Script for starting and stopping. This daemon calls up
'pandora_agent' and gives two options (start / stop). On the AIX systems, the daemon's
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name is/etc/rc.pandora_agent_daemon.
•/var/log/pandora/pandora_agent.log: Text file where the activity of the Pandora FMS agent
is kept if the agent is executed in depuration mode.
•/etc/pandora/plugins: Directory which
to /usr/share/pandora_agent/plugins.

keeps

the

agent's

plugins.

It's

a

link

Initial Execution of a UNIX Agent

When you start the Pandora FMS agent, this should copy the data file to the Pandora FMS server
through
the
dispatch
system
which
is
specified
in
the
configuration
file
of /etc/pandora/pandora_agent.conf. It's recommended to configure the dispatch system (Tentacle,
SSH, FTP) before that.
To start the agent, you're only required to execute:
/etc/init.d/pandora_agent_daemon start

For IPSO systems the agent will be launched with a priority of '10', so it turns into the process with
the lowest priority in the system CPU. It will be executed when other processes with a higher
priority are in a wait state in the CPU system queue. The IPSO agent has a special parameter
(harmless_mode ) for a special management of the CPU process on systems Checkpoint/NOKIA. This
is a very special case.
In BSD systems the highest priority is '+20' and the lowest '20'.
To stop the agent, just execute:
/etc/init.d/pandora_agent_daemon stop

Advanced Configuration for the UNIX Agent

The real power of Pandora FMS is on the agent capacity to start processing the user defined scripts.
This could be used to collect specific data or to make an operation which returns any desired value,
because it's the aim of the agent plugin structure. For more information, please check the Annex on
creating Agent Plugins.
Examples of Implementation for UNIX Agents

Example #1: Calculate the number of displays on the Apache Web server main page (it could
degrade the running of huge records):
module_begin
module_name WEB_Hits
module_type generic_data_inc
module_exec cat /var/log/apache/access.log | grep "index" | wc -l
module_end

Example #2: Checks if the process of the (named) DNS is working or not:
module_begin
module_name DNS_Daemon
module_type generic_proc
module_exec ps -Af | grep named | grep -v "grep" | wc -l
module_end
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Altering the way UNIX Agents obtain system information

This is valid for UNIX Perl agents only (version 3.2 or higher).
There are some modules which work like "blackboxes". They are performing operations the user
doesn't have to know about what it's really doing. These modules are:
•module_procmem
•module_freedisk
•module_freepercentdisk
•module_cpuproc
•module_proc
•module_procmem
•module_cpuusage
•module_freememory
•module_freepercentmemory
Modules like e.g. 'module_cpuusage' return a percentage of the current system CPU usage, but the
user doesn't need to use a command. On windows and on UNIX systems, Pandora 'already knows'
what to do.
Pandora UNIX Agents have predefined commands to do that. The below mentioned commands are
executed in different ways depending on the OS:
linux => 'vmstat 1 2 | tail -1 | awk \'{ print $13 }\,
solaris => 'vmstat 1 2 | tail -1 | awk \'{ print $21 }\,
hpux => 'vmstat 1 2 | tail -1 | awk \'{ print $16 }\

It could happen that your system is slightly different from the tested system and the command is
not valid. You're able to use your own command with a simple 'module_exec' or redefine internal
pandora commands to do that. You need to edit some lines of Pandora FMS Unix Agent code for
that, but don't worry  it's Perl code and it's very basic editing.
The Pandora agent is usually located in '/usr/bin/pandora_agent'. Please edit with vi or nano (they
are common text editors for the console), and search for "Commands to retrieve" text. You should
see something like this:
# Commands to retrieve total memory information in kB
use constant TOTALMEMORY_CMDS => {
linux => 'cat /proc/meminfo | grep MemTotal: | awk \'{ print $2 }\,
solaris => 'MEM=`prtconf | grep Memory | awk \'{print $3}\'` bash -c \'echo $(( 1024 *
$MEM ))\,
hpux => 'swapinfo -t | grep memory | awk \'{print $2}\
};

This is the piece of code which defines how pandora gets information from the system to get the
total memory. AIX is not defined because we don't have the information on how to get this
information in a AIX system yet.
# Commands to retrieve partition information in kB
use constant PART_CMDS => {
# total, available, mount point
linux => 'df -P | awk \'NR > 1 {print $2, $4, $6}\,
solaris => 'df -k | awk \'NR > 1 {print $2, $4, $6}\,
hpux => 'df -P | awk \'NR > 1 {print $2, $4, $6}\,
aix => 'df -kP | awk \'NR > 1 {print $2, $4, $6}\
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};

These are the commands to get disk the information in KB (total, free and mount point). To change
any of the predefined values to get the information, just edit the command but be careful with it:
1.Check that lines end with ";"
2.Check that commands are between ' ' symbols.
3.Check that any ' symbol you use ends on the \ symbol, e.g.:
df -P | awk 'NR > 1 {print $2, $4, $6}'

Will be
df -P | awk \'NR > 1 {print $2, $4, $6}\'

It's the same used above, so see how it's written in the code.

11.3.8.2. Pandora FMS Windows Agents
Checking of the Windows agent working

The exit of the Pandora FMS Windows agent can be checked in the file C:\archivos de
programa\pandora_agent\pandora_agent.log. It's a plain text file that contains information about
the agent's execution flow.
To check if Tentacle or SSH are working well, you can use the command tentacle_client or the
parameter 'testssh' on the binary. The first command will return an error, because neither the
address nor the file to send is specified, but it checks if the Tentacle client tentacleclient is in the
system the second one will force Pandora FMS to connect using SSH internally and copy a file
called ssh.test. Remember that you're required to configure SSH properly, to generate the required
keys and to import them onto the server if you want to use it.
Checking of Pandora FMS Agent service

The Pandora FMS 3.0 version has been carefully checked and "debugged" in order to avoid all kinds
of memory leaks, handles of processes, files or TCP/IP ports. It's very stable and has been tested on
all Windows platforms where it has to operate. Nevertheless, it could happen that the service
crashes a few times on some systems. We have tried to give some solutions to those users which
require a restarted system or a supplementary control of the agent for it.
There are two ways of having more control over the agent. The first one is to force the restart of the
agent every X days through the Windows internal programmer for tasks through the AT command.
Restart with AT
In English
To schedule a restart on Mondays and Fridays:
at 00:00 /every:Monday,Friday "c:\program files\pandora_agent\scripts\restart_pandora_agent.bat"

In Spanish
For example, to schedule an every day restart:
at 00:00 /every:L,M,Mi,J,V,S,D "c:\archivos de
programa\pandora_agent\scripts\restart_pandora_agent.bat"
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To see a list of the scheduled tasks, just execute the following command in the command line:
at

This will give you the scheduled tasks.
Automatic control of the service in case of crashes
Windows provides an additional way of controlled restart of the service if this crashes for any
reason. This allows to tell the Windows service to restart it automatically in case of a crash. You
have to go to the Windows services dashboard and to the Pandora FMS agent and click on
'Properties' for it. On the 'Recovery' slide, you're required to change the default values into this:

This causes an automatic restart if the service crashes  but only once a day. If it happens to crash
more than once a day, it won't get restarted again. The reason this configuration is avoidance of a
possible system overload due to a forced execution that downs too much of the other services,
which is caused by a problem within the system. Pandora FMS should never be down. In any case,
you can adjust these parameters if a Pandora FMS service crash should be controlled by the system
and to make sure that you'll always have the agent running this way.
Configuration of Pandora FMS Windows Agent

The whole installation is done through the file pandora_agent.conf. This file is a list of pairs of keys
and values which have been described before. Here is an example of this file:
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# General Parameters
# ==================
server_ip mypandoraserver.host.com
server_path /var/spool/pandora/data_in
temporal "c:\windows\temp"
interval 300
agent_name myagent_name
# Module Definition
# =================
# Counting OpenedConnections (please check language string)
module_begin
module_name OpenNetConnections
module_type generic_data
module_exec netstat -na | grep ESTAB | wc -l | tr -d " "
module_description Conexiones abiertas (interval 2)
module_interval 2
module_end
# Is Eventlog service running ?
module_begin
module_name ServicioReg
module_type generic_proc
module_service Eventlog
module_description Servicio Registro de sucesos
module_end
# Is lsass.exe process alive ?
module_begin
module_name Proc_lsass
module_type generic_proc
module_proc lsass.exe
module_description LSASS.exe process.
module_end
# Received packets.
# Please notice that "Paquetes recibidos" string must be replaced by
# the correct string in your Windows system language.
module_begin
module_name ReceivedPackets
module_type generic_data
module_exec netstat -s | grep "Paquetes recibidos " | tr -d " " | cut -f 2 -d "=" | tr -d
"\n"
module_description Conexiones abiertas (interval 2)
module_end
# Free space on disk
module_begin
module_name FreeDiskC
module_type generic_data
module_freepercentdisk C:
module_description Free space on drive C:
module_end
module_begin
module_name FreeMemory
module_type generic_data
module_freepercentmemory
module_description Amount of free memory.
module_end

Extending the agents functionality with VBS code

Starting with the 3.1 version, Windows agents started to have plugins like the Unix agents, but don't
forget they also have the possibility of executing the external scripts, based on VBScript as simple
modules. Take a look at the VBS code which obtains the CPU total use of a system:
strComputer = "."
Set objWMIService = GetObject("winmgmts:" _
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& "{impersonationLevel=impersonate}!\\" _
& strComputer & "\root\cimv2")
Set object1 = objWMIService.Get( _
"Win32_PerfRawData_PerfOS_Processor.Name='_Total'")
N1 = object1.PercentProcessorTime
D1 = object1.TimeStamp_Sys100NS
Wscript.Sleep(1000)
set object2 = objWMIService.Get( _
"Win32_PerfRawData_PerfOS_Processor.Name='_Total'")
N2 = object2.PercentProcessorTime
D2 = object2.TimeStamp_Sys100NS
' CounterType - PERF_100NSEC_TIMER_INV
' Formula - (1- ((N2 - N1) / (D2 - D1))) x 100
PercentProcessorTime = (1 - ((N2 - N1)/(D2-D1)))*100
Wscript.Echo PercentProcessorTime

We keep it in a file called "CPUTotal.vbs" which is located at c:\program files\pandora_agent\util.
Now we're going to create the new module type of 'module_exec' with this content:
cscript.exe /NoLogo c:\program_filespandora_agent\util\CPUTotal.vbs

We already have a new module that returns the CPU total use, obtained through the external script
in VB. There are plenty of things that can be obtained through VBScript. Microsoft has an excellent
online documentation about VBS that you can check in MSDN: [3].
Running the Pandora FMS Agent under a different user than SYSTEM

You can setup the Windows agent to run under a different user. You're required to configure the
startup service with a different user and provide this user with special privileges to do that. That
user is required to get included in the 'Administrators' group.
In the WMI console, all users from the group 'Administrators' have ALL permissions enabled.
This is an example of a user and it's WMI settings for the ROOT environment. Branches will inherit
the root permissions by default:
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You can look up some Microsoft links related to this issue on : [4] [5]

11.3.8.3. Autoupgrading Software Agents
Pandora FMS 3.2 has a new feature called "File collection". File collections are described in a few
chapters below, they are a 'centralized file distribution system' to copy files (binary, scripts and
data) from the console to the agents running the Pandora FMS software agent.
We can provide a way to 'autoupgrade' the software agents using that mechanism and a very
special tool. It works in the following way:
1. Agents receive new binaries e.g. in the file collection's incoming directory:
c:\program files\pandora_agent\collections\fc_1\pandoraAgent.exe

2. The agent utilizes a special module to execute the pandora_update tool. This tool receives a
single parameter, the FileCollection handle (or short name). In this scenario, it's fc_1. It checks for a
file called 'pandoraagent.exe' (or 'pandora_agent' under UNIX), looks at the size and contents of
both files (by using a HASH), the running 'pandora_agent' and the binary provided in the file
collection. If they are different, 'pandora_update' stops the agent, replaces the binary and restarts
the agent again, using the new binary.
3. Furthermore, 'Pandora_update' writes the update event to a small log to be able to recover the
next execution and warns the user about the agent's updating process by means of an 'async_string'
module.
This means that the used modules could be configured to have a high interval to perform the
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update process.
UNIX Standard Installation
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec nohup /etc/pandora/plugins/pandora_update fc_1 2> /dev/null && tail -1 nohup.out 2>
/dev/null
module_description Module to check new version of pandora agent and update itself
module_end

UNIX Custon Installation
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec nohup /var/opt/PandoraFMS/etc/pandora/plugins/pandora_update fc_1
/var/opt/PandoraFMS 2> /dev/null && tail -1 nohup.out 2> /dev/null
module_description Module to check new version of pandora agent and update itself
module_end

NOTE: The second parameter of the 'pandora_update' command is the installation path of Pandora
FMS. This parameter is only required if Pandora FMS is installed in a path different from the default
path.
Windows
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec pandora_update.exe fc_1
module_description Module to check new version of pandora agent and update itself
module_end

NOTE: If it has the agent in a non "standard" path under UNIX, you're required to modify some of
the 'pandora_update' utility values, specifically the following lines:

# Setup your particular paths / process settings here
# [SETUP BEGIN] 12:46, 23 November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23 November
2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010
(UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010
(UTC)12:46, 23 November 2010 (UTC)
# Location of binaries
# UNIX
my $running_binary = "/usr/bin/pandora_agent";
my $updated_binary = "/etc/pandora/collections/$fc_path/pandora_agent";
# UNIX style
my $start_pandora = "/etc/init.d/pandora_agent_daemon start";
my $stop_pandora = "/etc/init.d/pandora_agent_daemon stop";

Please change the paths to the ones which fit with your system manually.

11.3.8.4. Process to Auto Upgrade Agents from versions previous to 3.2
The first thing is to get the executables from the Pandora FMS agent and the 'pandora_update' tool
('pandoraAgent.exe' and 'pandora_update.exe' under Windows and 'pandora_agent' and
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'pandora_update' under UNIX).
Many of the steps that we are giving here means the following things:
1. You have a way to copy files to the systems which you want to update. This is a feature which the
Pandora FMS 3.2 version provides (File Collection) but just now, you want to migrate to the 3.2
version, because this feature is missing there. It's assumed that you have alternative mechanisms.
2. The agent's configuration and remote management is activated and working. This will be useful.
It's recommended to create several directories and configure a new module in your Pandora FMS
agent configuration.
Windows Platforms
We should copy 'pandora_update' to one directory of the system path or to the directory '/util' of
our Pandora (in Windows).
Supposing that we have Pandora FMS installed in:
C:\Archivos de programa\pandora_agent

We have to copy 'pandora_update.exe' in the directory:
C:\Archivos de programa\pandora_agent\util

Then we create two directories:
C:\Archivos de programa\pandora_agent\collections
C:\Archivos de programa\pandora_agent\collections\fc_1

And after this, we should copy the new agent's binary to the last directory which we have created:
C:\Archivos de programa\pandora_agent\collections\fc_1\PandoraAgent.exe

We create one module in the agent as the one that follows:
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec pandora_update.exe fc_1
module_description Module to check new version of pandora agent and update itself
module_end

This special module that uses the 'pandora_update' executable, executes a special tool
('pandora_update') which compares the current executable with the one that already exists in the
directory '/collections/xxxx', where 'xxxx' is a parameter that is passed on to the module. This
location is the one specified with the file collections. After using the 3.2 version, the distribution of
the new *.exe of the agents will be done through filecollections and this identifier will be necessary
to 'locate' in which file collection our executable is located.
UNIX Platforms
Similar to the Windows platforms, we have to copy the executable of the UNIX agent and the
'pandora_update' feature. If it has a nonstandard installation and possesses customized paths, you
should have to pay lot of attention to the previous paragraph where it's described which files should
be modified.
You have to copy pandora_update into your agent's plugins / folder:
/etc/pandora/plugins/pandora_update
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Now create directory 'collection/fc_1' in the base directory of your '/etc/pandora':
/etc/pandora/collections/
/etc/pandora/collections/fc_1

The call to 'pandora_update' will be done on its system paths to the plugins. In this case, the default
path is '/etc/pandora/plugins/pandora_update'.
The module for the UNIX case will be the following:
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec nohup /etc/pandora/plugins/pandora_update fc_1 2> /dev/null && tail -1 nohup.out 2>
/dev/null
module_description Module to check new version of pandora agent and update itself
module_end

NOTE: It's recommended to check if both 'pandora_update' and 'pandora_agent' have suitable
permissions and owners, executing permissions and the same user which owns the 'pandora_agent'
executable.

11.3.9. Pandora FMS Drone Agents
11.3.9.1. What is a Drone Agent ?
The Pandora FMS Drone Agent is a running mode of Pandora FMS Software Agent. This running
mode only works on Windows and Linux machines. It was developed to deal with complicated
environments with restricted access to the machines. The Drone Agent has two main features:
•Proxy mode
•Broker mode
Running in this mode, the Drone Agent can report data and utilize all features of the standard
Pandora FMS Software Agent.
The picture below shows an architecture of Pandora FMS using Drone Agents:
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Proxy Mode

Proxy Mode is very useful for networks which have restrictions in their communications. The agent
running this mode enabled a Tentacle Proxy Server to allow agents to communicate with the
Pandora FMS Server through itself.
The new Tentacle version supports proxy usage (HTTP/Connect mode), so that agents can contact
with the server using an intermediate standard proxy directly. You also can use a new tool called
'Tentacle Proxy Server' is used to centralize all communication between Pandora FMS and the
agents, allowing the file management and remote configuration for policy basedmonitoring. You
can see more about the Tentacle Proxy Server here.
You'll get all functionalities of a proxy but managed by Pandora FMS Software Agent with this
feature. This mode has two requirements 1. The agent cannot be run by the root. 2. If you want
to use the proxy mode with Unix agent then it must be installed with a user without root
privileges (the same user will execute the agent in proxy mode later).
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All parameters to configure the Tentacle Proxy Server are available trough its agent configuration
file:
server_ip
It's the IP address or the name of Pandora FMS server host. Be careful with the enabled Proxy
Mode. This parameter cannot take values like 127.0.0.1, locahost, 0.0.0.0 or related.
proxy_mode
Proxy mode status. If the 'proxy_mode' is set to '1', the proxy feature of the drone agent is activated.
If the proxy_mode is set to '0', the proxy feature is off. This feature is disabled by default.
proxy_max_connection
Number of max. simultaneous connections of the proxy. 10 connections are allowed by default.
proxy_timeout
Timeout for the proxied server. Default value is '1 second'.
11.3.9.1.1.1.

Usage Examples

I only have one connection to the Pandora FMS Server
This situation is not a problem for the Pandora FMS Drone Agent. To configure the proxy mode, just
set 'server_ip' to the Pandora FMS IP and the 'proxy_mode' parameter to '1'. You can configure some
parameters like the number of connections and timeout if needed. You'll have the agent and the
Tentacle Proxy Server up and running on the machine which can connect with Pandora FMS Server
with this configuration.
To configure the other agent, just set the 'server_ip' parameter to the IP address of the Drone Agent
with proxy mode enabled. That's all you have to do. The agents are going to use the drone agent to
connect to the Pandora FMS Server.
I'm required to setup a double proxied connection
You're able to connect a Drone Agent to another. It's very easy.
To perform the double proxy, just configure the Drone Agent which can connect to Pandora FMS
Server to set the 'server_ip' to the Pandora FMS IP address. 'proxy_mode' must be set to '1' and the
other parameters if you need.
To configure the second Drone Agent, just set the 'server_ip' to the one of the first Drone Agent and
enable the proxy mode by setting 'proxy_mode' to '1'.
With this configuration, an agent connected to the second Drone Agent can send data to Pandora
FMS Server through the two proxies.
Broker Mode

The Broker Mode is designed to "recreate" different agents (as an entity) from a single software
agent installed on a server. Broker agents execute different setups, like if it has different
personalities or different agents installed on the same server with different configurations. Each
configuration file is independent and can have it's own plugins, inventory modules, etc. It can be
remotely managed as any other agent of course. This is perfect to monitor servers / Comm devices
nearby and useful when you're unable to reach a router but can install an agent in a nearby host.
You can monitor ten routers from a single agent and have eleven agents in your Pandora FMS
console (10 routers + 1 host) for example.
It's important to know that the broker_agent token will be ignored in the configuration of an agent
which is set like a broker agent.
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The main features of "broker mode" are:
•Send local data with another agent name. Useful to monitoring different instances of a
software applicationn as independent agents.
•Send data from remote devices / checks executed from a single host and have it under
Pandora FMS like they were different independent agents.
Examples

Send data to server with different agent names, using different configurations
Modify your pandora_agent.conf with following lines:
broker_agent router_1
broker_agent router_2
broker_agent router_3

On the next execution or restart you will have three new files: 'router_1.conf', 'router_2.conf' and
'router_3.conf'. They are an exact copy from origial "pandora_agent.conf" file, except the attribute of
'agent_name' which will be selected from the 'broker_agent' call.
You now have four agents with different configuration files. You can now add different modules in
each configuration file, e.g. edit 'router_1.conf' and add:
Sample of remote check
Please add the following line to the remote configuration file 'pandora_agent.conf':
broker_agent server_1

A new file called 'server_1.conf' will be created and we'll edit it for the purpose of adding specific
modules for this broker agent:
module_begin
module_name Check SSH Status
module_type generic_proc
module_tcpcheck 192.168.1.1
module_port 22
module_timeout 5
module_end

This configuration can be interesting when making checks against another remote machine. Even if
it has an agent installed Pandora, is unattainable by the server.
This feature is available since 4.0 version.

11.3.10. Agent / Module Autocreation from XML File / Learning Mode
Pandora FMS supports the creation of agents and/or modules in an automated way if you receive
the information coming from an XML (data server). This happens automatically, unless you
completely disable this behaviour by disabling the server autocreate parameter. The 'creation' only
happens the first time agent data arrives on the server. That means you can create the
information but you cannot update the agent or module information each time you're getting a
new XML  with a few exceptions as you can see below.
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This behaviour could be avoided in specific agents by disabling the learning mode of the agent. By
disabling this feature, the agent will not create new modules when the XML arrives with the new
module. The information won't update the agent configuration parameters.

11.3.10.1. Loaded Data from the XML in the Creation of an Agent
Stored Data for an agent is the following:
In 4.x version:
•Agent name.
•IP address.
•Agent description.
•Agent's parent.
•Timezone offset.
•Group.
•Operating system.
•Agent interval.
•Agent version
In 5.x version
It's the same as in 4.x version, plus the following:
•Custom fields.
•Custom ID.
•URL address.

11.3.10.2. Data modified in the Agent when receiving XML (Learning Mode enabled)
•Agent's IP address
•Agent's parent (if defined in server setup, for v4.x parents it's always updated)
•OS Version.
•Agent's version.
•Timezone.
•Custom fields.
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The GIS data are always updated. It doesn't matter at all if the learning mode is enabled
or not.

By enabling the learning mode, the new modules which get received through the XML file, are
going to be created under Pandora FMS.

11.3.10.3. Data added to the Module on Creation Time
The first time you get data coming from an XML for a module, the read data from the XML and
inserted in the system are the following:
In 4.x version
•Name.
•Type.
•Description.
•Max Min value filter.
•Post process.
•Module interval.
•Min / Max Critical.
•Min / Max Warning.
•Disabled module.
In 5.x version
The same as in 4.x plus the following:
•Units.
•Module group.
•Custom ID.
•Str. Warning / Critical.
•Critical instructions.
•Warning instructions.
•Unknown instructions.
•Tags.
•Critical inversion mode.
•Warning inversion mode.
•Quiet mode.
•Min. FF Threshold.

11.3.10.4. Loaded Data when Module already exists
If the data server processes an XML containing information for a preexistent module, part of its
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information will be overwritten / updated. The description and extended information (see next
epigraph) are updated.
Note: GIS data are always updated unless you have the GIS update disabled for that agent (this is
configured in agent's GIS setup).

11.3.11. Extended Module Information
This epigraph is for advanced and development environments. You're able to send custom XML data
(using your own application or altering the Pandora agent's source code). This XML file has two
'custom' tags named 'rack_number' and 'severity':
<module>
<name><![CDATA[battery_level]]></name>
<description><![CDATA[The actually device battery level]]></description>
<type><![CDATA[generic_data]]></type>
<data><![CDATA[61]]></data>
<rack_number>2</rack_number>
<severity>MAJOR</severity>
</module>

The module is going to be shown like on the picture below.

These fields don't store history values. They're only going to store the last received
value from the XML data.

208

Pandora FMS Software Agents

12 INTRODUCTION TO MONITORING
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12.1. Monitoring with Pandora FMS
All the user interaction with Pandora FMS is done through the WEB console. The Pandora FMS
console is a WEB console which follows the latest standards and WEB technologies, so it requires an
advanced browser and the optional use of Flash. It is recommended to use Firefox 2.x or higher.
You can also use Internet Explorer 8 or higher, although it gives an uncomfortable user experience
due to its peculiar way to manage some WEB controls.
Generally spoken monitoring consists of the execution of processes (through modules) in any
system in order to send its resulting data to a server. The server will process these resulting data
where the frontend (WEB console) is going to display it to the user.
Pandora FMS is a scalable monitoring tool. It would be possible to monitor about 1200 to 1500
agents with a single server, although the number of monitoring processes could grow without
restrictions with the correct architecture (Meta Console).

12.1.1. Monitoring by Software Agent vs. Remote Monitoring
There are two main monitoring procedures with Pandora FMS: The software agent based (local)
and the remote one.
The software agent based monitoring includes a piece of software (module) into the monitored
system, e.g. the measurement of the percentage of CPU usage on a certain system while the remote
monitoring is done through network tests without the use of modules, e.g. checking if a certain host
is active or not.
The main difference between these two types is that whereas the software agent based is executed
from the monitored system, the remote monitoring is executed from the Pandora FMS Server
against the target system.

12.1.2. Agents on Pandora FMS
All monitoring done by Pandora FMS is managed through a generic entity called 'Agent' which is
incorporated into a more generic block called 'Group'. An agent can only belong to one group.
The information is logically arranged by means of a hierarchy which is based on groups, agents,
module groups and modules. There are Agents which are solely based on the information given by a
software agent installed on the system, and Agents with exclusive network information 
information that doesn't come from a software agent where installing software is not necessary
which would execute the network monitoring tasks from the Pandora FMS Network Servers.
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There are also agents which have network information and information obtained through software
agents.
The information is collected in modules which are logically assigned to Pandora FMS agents in the
console. It's important to distinguish the concept of Agents (where the modules which contain the
collected info are located) from Software Agents which are getting executed on remote systems.

12.1.3. Status and Event Monitoring
With Pandora FMS 3.0, a new important functionality was added. The way in which Pandora FMS
has been working until now, was changed. Pandora FMS allows the user to fix standards to define
any data in three possible states:
'NORMAL', 'WARNING' and 'CRITICAL'.
Automatically, all modules of the 'proc' kind are defined as 'NORMAL' if they have a value of '1' or
bigger than '1'. They will be defined as 'CRITICAL' if they have a value lower than '1' ('0' or a
negative value).
But what happens with a value of CPU usage? How could the system know if it's a 'NORMAL',
'CRITICAL' or 'WARNING' value? It doesn't know it by default  it only gets a numeric value and if
nothing has been defined for it, all the values would be 'right' in 'NORMAL' status.
There are two status fields in the agent configuration which haven't been mentioned before. These
are:
•Warning status
•Critical status
Each of those two fields can possess two values: Minimum and Maximum. By configuring them
correctly, you're going to realize that some values will show a module in 'warning' and others in a
'critical' status:
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To understand these options better, it's best to see an example. The CPU module will always be on
'green' in the agent status, so it simply informs about a value between 0% and 100%. If we want the
module of the CPU usage to be shown in yellow ('warning') if it has reached e.g. 70% of its use, and
in red ('critical') if it e.g. reached 90%, it's recommended to configure:
•Warning status:70
•Critical status:90
If you're going to reach the 90% value with these settings, the module will be shown in red
('CRITICAL'), if it's between 70% and 89.99%, it will be yellow ('WARNING') and under 70% in
green ('NORMAL').
If we have a module with a string type, you're able to configure the status using a regular
expression in the Str fields of 'Warning' and 'Critical' status parameters. If we have e.g. a module
that returns OK, ERROR: Connection fail or BUSY: Too much devices it depends on the query result.
To configure the 'WARNING' and 'CRITICAL' module status, we will use the following regular
expressions:
Warning Status: .*BUSY.*
Critical Status: .*ERROR.*

You have to be careful here, because this regular expressions are case sensitive. With this
module configuration, the status will be 'WARNING' if the data contains the string BUSY and it's
going to jump to 'CRITICAL' if the data string contains ERROR.
If, by any chance, both states are configured with the same values, the 'Critical' value will
always have presidence. In this case, the 'Warning' state is unreachable, because the 'Critical' state
is more important.
This is an example of the modules in each of the states:

It's obvious these fields have no sense for modules which only return boolean values ('1' or '0').
These values are shown in the main screen of the monitor view. You're instantly able to tell by
taking a quick look on how many checks are in the 'Normal', 'Warning' or 'Critical' states.

12.1.4. Other Common Monitoring Parameters
12.1.4.1. Historical Data

Pandora FMS optionally allows to keep the history of any data individually. All modules keep a
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history (so they're able to generate graphs and include them in reports of the historical / evolutive
kind) by default. In a very big implantation which requires to monitor a lot of data, it's possible that
you have no need to keep the history for some, thereby allowing for the possibility of occupying a
lot less resources in this way.
This option allows to deactivate the history of the modules where you don't need to keep a history.
Even if you deactivate the history, the alerts will continue to work in exactly the same way e.g. as
the event generation and the view of the current state of this monitor.

12.1.4.2. FF Threshold

The FF Threshold Parameter (FF=FlipFlop) is used to 'filter' the continuous changes of the state in
the creation of events / statuses. In Pandora FMS, you can indicate that, until an element hasn't
adapted the same status at least X times after having changed from an original status, it won't get
considered as changed. Lets see a classical example: One ping to a host where there is loss of
packages. In an evironment like this, it's possible to receive results as these:

1
1
0
1
1
0
1
1
1

However, the host is alive in all cases. What we really want to say to Pandora is: Until the host
doesn't say that it's at least three times down, it doesn't show it as down, so in the previous case it
would never be as down, and it would only be this way in this case:
1
1
0
1
0
0
0

From this point it will be shown as down  but not before that.
So the 'Flip_Flop' protections are pretty useful to avoid disturbing fluctuations. All modules
implement it. Its use is to avoid the change of status (limited by the defined or automatic limits, as
shown in the case of 'proc' modules).
From 5.1 version, the FF threshold has two modes.
•All state changing: same value is used for all state changing, to normal, warning and
critical.
•Each state changing: different value can be set for each state changing, to normal, warning
and critical.
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In async modules, the timeout (FF timeout) can also be set. It's useful if you want to fire an alert
only when the data server received several critical/warning data in a short period of time. When
data arrival interval exceeded the timeout, the counter of FF threshold is reset.

For example, if you want to fire an alert only when agent sends critical data twice in 5 minutes (you
don't want to fire an alert when data arrival interval exceeds 5 minutes.), set the FF threshold to 1
and the FF timeout to 300.

12.1.4.3. Module Macros

Any number of custommade Module Macros may be added to an agent module. These macros can
be used when configuring alerts and actions later.
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The recommended format for Module Macro names is:
_macroname_

For example:
•_technology_
•_modulepriority_
•_contactperson_

13 MONITORING WITH SOFTWARE
AGENTS
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13.1. Agent Configuration
Pandora FMS agents have a local configuration by default, so their maintenance will be managed
from the monitored machine which edits their configuration file.

13.1.1. Remote Configuration
On the enterprise version, there is a remote Agent Configuration feature which allows their
centralized configuration and file management from the server console.
The configuration consists of two files. Their file names are <md5>.conf and <md5>.md5, where
<md5> is the agent's name hash code. Those files are stored in '/var/spool/pandora/data_in/conf'
and '/var/spool/pandora/data_in/md5' folders.
Those files are composed of plain text and could be edited from the console, which regenerates
them if there is any change. Communication is always in the direction from agent to server, which
means the functionality is controlled by the agent.

In order to enable the remote configuration, you're required to edit the 'remote_config' parameter
from the 'pandora_agent.conf' file, setting it to '1'. Once this change is done, the agent's
configuration file will be ignored, because it's detecting a change in the configuration. It's going to
download the new version from the server. This is a good way to force the server to get the agent's
local configuration to delete both configuration files from the server.

13.2. Common Configuration Parameters
In the Pandora FMS Software Agents section you can find a complete explanation on
Agent Configuration. In this section, the common parameters used to configure the
Software Agents are going to be explained.
The most common parameters are:
•server_ip: IP direction of Pandora FMS Server.
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•server_path: Path of the 'incoming' folder for the Pandora FMS server (it's
'/var/spool/pandora/data_in' by default).
•temporal: Software agent's temporal folder (it's '/var/spool/pandora/data_out' by default).
•logfile: Software agent's log file (it's '/var/log/pandora/pandora_agent.log' by default).
•interval: Agent's execution interval (it's '300' by default).
•intensive_interval: Intensive module execution interval (it's '300' by default).
•debug: Debug mode enable ('0'  it's disabled by default).
•agent_name: Agent name (hostname is taken by default).
•server_port: Tentacle server port (it's '41121' by default).
•transfer_mode: Filetransfer mode (it's 'tentacle' by default).
•remote_config: Activation of remote configuration ('0'  it's disabled by default).
An example of the general parameters for a UNIX configuration would be:
server_ip
server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

192.168.1.1
/var/spool/pandora/data_in
/var/spool/pandora/data_out
/var/log/pandora/pandora_agent.log
300
0
box01
41121
tentacle
1

An example of the general parameters for a Windows configuration would be:
server_ip
server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

192.168.1.1
/var/spool/pandora/data_in
c:\program files\pandora_agent\temp
c:\program files\pandora_agent\pandora_agent.log
300
0
box01
41121
tentacle
1

13.3. Custom Fields
Custom fields are an easy way to personalized agent's information. You're able to create custom
fields by klicking on 'Administration' > 'Manage monitoring' > 'Manage custom fields'.
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If you want to create a custom field, you have to click on the 'Create field' button and fill in the
fields as described below:

•Name: Name of the custom field.
•Display on front: With this field checked, the custom field will be displayed in front of the
agent like on the screenshot below:
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13.4. Monitoring with the Software Agent
The data collected by the software agents is kept in small information pieces called 'modules'. Each
module only keeps one kind of data. Each module's value is the value of a supervised variable. Once
the agent starts sending information, the data will start to consolidate in the database where you're
able to access it.
Please check the Software Agents Installation Section to obtain more information about them.
The Pandora FMS Software Agents use the operating system's specific commands to obtain
information. The Pandora FMS Data Server keeps and processes data generated by these commands
which are sent to the server in form of an XML file. The information which gets returned by these
commands is contained in what we call 'Modules'.

In the agent configuration file, the modules are defined by the following structure:
module_begin
module_name cpu_user
module_type generic_data
module_exec vmstat 1 2 | tail -1 | awk '{ print $13 }'
module_description User CPU Usage (%)
module_end

The parameter which indicates how to get the module information is called 'module_exec' . This
parameter specifies the command which the agent should execute in order to get the information
from the system. Example:
module_exec vmstat 1 2 | tail -1 | awk '{ print $13 }'

219

Monitoring with the Software Agent

The agent will execute the command as an operator to collect the information:
$> vmstat 1 2 | tail -1 | awk '{ print $13 }'

Then the agent gets the returned value by the command and attaches it to the XML file as module
data. Of course the agent can execute any program or script which returns the monitoring value.
The field 'module_exec' could be for example:
module_exec myScript.pl --h 127.0.0.1 -v cpu

Again the agent is going to execute the command and collects the returned value in the same way
as an operator would type in the shell:
$> myScript.pl --h 127.0.0.1 -v cpu

When the software agent is executed for the first time, it sends an XML to the Pandora FMS data
server which is received in the server's incoming directory through Tentacle, SSH or FTP. The data
server checks this directory every X time and when it finds a file, it gets processed. On opening this
data file (XML), it identifies the agent by its unique name. This is because each agent is required to
have a completely unique name, where capital and small letters are distinguished by Pandora FMS.
The server creates all agents automatically from which it receives data and which aren't already
logged in on the DB by default. In the same way, if the agent has been added in 'learning mode', the
modules which haven't been previously defined in the agent will be created automatically by the
Server.

Configuration file encoding. It's very important and has to have exactly the same value
as the one set in the encoding configuration parameter. If the encoding is properly set,
you're going to avoid the reception of data, bearing wrong encoding characters.

13.4.1. Kinds of Modules
There are several kinds of modules, but they're mainly classified in two categories: Data which
originated on software agents and data which originated on network modules, executed by a
network server. The modules identified as 'generic' are the ones which originate on software agents
and those identified as 'remote' are network modules.
generic_data
A kind of numerical data. It's pretty useful to keep numerical data (in whole numbers and floating
point) obtained through a Pandora FMS agent module.
generic_data_inc
A kind of increasing numerical data. It keeps data which results in the difference between the last
agent data and the current data. The Pandora FMS server calculates and keeps the rate by second
automatically. All of the modules which end on 'inc' are of the incremental kind. This kind of data is
used to count the 'number of times' of something, e.g. the entries in a log, bytes/sec,
connections/sec, etc.
generic_proc
They are generally called "monitors", too. They belong to the boolean kind of data where a value of
'0' means 'false' or 'bad value', and values higher than '0' mean 'right' or 'right value'. The 'generic
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proc' kind is also called 'monitor', because they can show if something is right or wrong without the
need of interpreting or establishing alerts on it. They are displayed in the agent view as small lights.
Red if it's '0', green if it's higher than'0'. All of modules which end on 'proc' are monitors.
generic_data_string
Kinds of alphanumeric data (text).
async_data
It's a kind of asynchronous numeric data. It's the same as 'generic_data' but for asynchronous data
which are only updated if there is a change. The asynchronous kind of data don't have a defined
periodicity when we can obtain data.
async_string
This is a kind of asynchronous alphanumeric data. It's the same as 'generic_string' but for
asynchronous data which are only updated if there is a change. It's the kind of data that you're
recommended to use if you want to monitor searches in logs or event viewers. We could have new
data by any second or not having one at all in many days.
async_proc
It's a kind of asynchronous boolean data. It's the same as 'generic _proc' but for asynchronous data
which are only updated if there is a change.
The software agent already comes preconfigured to send certain data from the system on which it's
installed. These usually are (depending on the version):
•System CPU
•Available space on the harddrive
•Free memory
•Monitor of the programs and services states
Depending on the software agent, they are also going to look for one operating system or another.
They also might have more modules or different things to check.
All these information is located in the file 'pandora_agent.conf'. This file is in the directory
'/etc/pandora/' under GNU/Linux and, under the default Windows installation, the directory is
'C:\Archivos de Programa\pandora_agent\' or 'C:\Program Files\pandora_agent\' or similar.
We are now going to explain the kind of data for some of the modules:
Percentage of CPU usage under GNU/Linux
# CPU usage percentage (GNU/Linux)
module_begin
module_name cpu_user
module_type generic_data
module_interval 1
module_exec vmstat 1 2 | tail -1 | awk '{ print $13 }'
module_max 100
module_min 0
module_description User CPU Usage (%)
module_end

It's obvious the kind of module is from the 'generic_data' kind which executes a GNU/Linux console
command to obtain the result ('module_exec'). The maximum is set to '100' and the minimum to '0'.
The interval ('module_interval') represents the number of iterations between the execution of each
module. If it's different from '1', the module will only start the execution of the agent the number of
times which is set there. If e.g. the agent execution time is set on '300' and the module interval is '3',
the module is going to be executed every 900 seconds.
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Percentage of the CPU usage under Windows:
# CPU usage percentage (Windows)
module_begin
module_name CPUUse
module_type generic_data
module_cpuusage all
module_description CPU#0 usage
module_end

As you can easily see, the module is completely different from GNU/Linux under Windows. Under
Windows it's an internal agent command where module_cpuusage all represents the CPU usage for
all CPUs. Using 'module_cpuusage' is only going to calculate the CPU usage for CPU #0. The rest of
the fields are optional.
To add one more module, please check the agent configuration and create a valid module block.
Once you have done this, keep the agent configuration file and restart the agent, no matter if it's the
UNIX daemon or the Windows service.

13.4.2. Module Creation Interface
The creation of local modules from the console is done using a form in the shape of a text box. This
is the location to specify the configuration data, which will be placed into the configuration file of
the software agent (besides the common configuration with the remote modules like thresholds,
type and group).
Creation of a module with the remote config enabled on the agent:

In vicinity of this text box there are two buttons: One to create a basic configuration
structure and the other to check that the data is correct. This check is intended for basic
parameters, e.g. checking if it begins with 'module_begin', ends with 'module_end' and if it has a
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valid type and name. It's possible of other parameters to be wrong, but it won't be detected here.
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The field name and the type combo are linked to the parameters 'module_name' and
'module_type' of the data configuration. If you change the module name on the name field, the
configuration data name will be changed automatically and vice versa. If you select a type in the
combo, the data configuration type will be changed and if a correct type was written in the
configuration data, this type will be selected automatically in the combo.
When a module from a local component is changed, it might have macros. If it has macros, the
configuration data will be hidden and a field for each macro is going to appear instead. You can
find a detailed explanation of this feature in the following section:

Templates and components
13.4.3. Conditional Monitoring
The Pandora FMS Software Agent supports the execution of a script as a postcondition, depending
on the module value. Also the software agent has a feature to evaluate a precondition before
module execution. We're going to explain both features and provide examples in this section for
them.

13.4.3.1. PostConditions
The parameter module_condition defines a postcondition in the moment of module execution. It
means this parameters define the command which will be executed depending on the value
returned by the module. The structure in the configuration file is:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition < 20 add_processes.sh
module_end

You can define multiple postconditions for the same module, e.g.:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
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module_exec get_cpu_usage.pl
module_condition (90, 100) remove_processes.sh
module_condition < 20 add_processes.sh
module_end

Some examples:
Execution if the module data is less than '20' :
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition < 20 add_processes.sh
module_end

If the script named 'get_cpu_usage.pl' returns '18', the software agent is going to execute the script
'add_processes.sh', otherwise it won't.
Execution with two preconditions:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition < 10 start_new_server.sh
module_condition < 20 add_processes.sh
module_end

If the module returns '15', the software agent is going to only execute the script named
'add_processes.sh'  but if the value is '6', the script is going to execute both scripts named
'start_new_server.sh' and 'add_processes.sh'.

13.4.3.2. PreConditions
The parameter 'module_precontition' defines a precondition to evaluate before a module
execution. Depending on the result of this precondition, the software agent will execute the module
or not. The structure of the configuration file is:
module_begin
module_name CPU_Usage
module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_end

You can e.g. define multiple preconditions for the same module:
module_begin
module_name CPU_Usage
module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_precondition = 1 important_service_enabled.sh
module_end

Some examples:
Module execution if the precondition is above '10' only:
module_begin
module_name CPU_Usage
module_type generic_data
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module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_end

The software agent executes the script 'number_active_processes.sh', if the returned value is greater
than '10'. If the returned value is lower than '10', the module will never be executed.
Module execution if only two of the preconditions are met::
module_begin
module_name CPU_Usage
module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_precondition = 1 important_service_enabled.sh
module_end

We have two preconditions in this example. To execute the module (both of them in this case), all
preconditions must be met. The module will only be executed if the script
'number_active_processes.sh' returns a value greater than '10' and when the script
'important_service_enabled.sh' returns a value of '1'.

13.4.4. Intensive Monitoring
(Only available in versions 5.0 or above)
Certain values are very important for some modules, while others are not. If when you are e.g.
monitoring a system service, you want to be notified as soon as possible if the service goes down 
but you don't need to be reminded the service is up every ten seconds.
This is where intensive modules are coming in. Intensive modules run with an interval
of intensive_interval in seconds. When intensive conditions are met, they run the rest of the time
with an interval of intervalseconds like the rest of the modules.
If you want e.g. to check whether the SSHD system service is running every 10 seconds, but want to
be notified every 10 minutes if the service is fine, you may configure the agent in the following way:
intensive_interval 10
interval 600
module_begin
module_name SSH Daemon
module_type generic_data
module exec ps aux | grep sshd | grep -v grep | wc -l
module_intensive_condition = 0
module_end

If the service goes down, you will be notified in the next 10 seconds. If the service is up, you will be
notified in the next 10 minutes.
This can save a lot of space in the Pandora FMS Database.

13.4.5. Programmed Monitoring

The software agent supports the definition of programmed modules which are
executed in the defined instants. The syntax is the same as crontab. For a detailed
explanation, seehttp://en.wikipedia.org/wiki/Cron#Predefined_scheduling_definitions
The module structure is the following:
226

Monitoring with the Software Agent

module_begin
module_name crontab
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_end

In this example the module is executed once, every Monday from 1200 to 1500 hours.
If you want a module which is executed during all the interval, we have to set the option
'module_cron_interval' to '0' in this way:
module_begin
module_name crontab
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_cron_interval 0
module_end

If we're required to execute the module every hour past ten minutes we can use this module
definition:
module_begin module_name crontab module_type generic_data
module_crontab 10 * * * * module_cron_interval 0 module_end

module_exec

script.sh

13.4.6. Specific Monitoring for Windows
The software agent for Windows has specific features to make monitoring a lot easier. These
features are explained with some examples:

13.4.6.1. Monitoring Processes and Watchdog Process
Monitoring of Processes

The parameter module_proc verifies if a process with a preset name is running on this machine.
The module definition is:
module_begin
module_name CMDProcess
module_type generic_proc
module_proc cmd.exe
module_description Process Command line
module_end

If the process name has blanks, so please don't use «" "». The process name is the same as shown in
Windows Task Manager (taskmngr) including the .exe extension. It's very important to use the
same upper and lowercase letters.
If you want the software agent to immediately notify you if a process is not working, you're required
to add the parameter module_async yes. In this case, the module definition would be:
module_begin
module_name CMDProcess
module_type generic_proc
module_proc cmd.exe
module_async yes
module_description Process Command line
module_end
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Watchdog Process

The watchdog feature on the Pandora Agent for Windows allows to respond immediately to the
crash of a process and restarts it. It's important to keep in mind that the watchdog only works if the
module is of the asynchronous type.
The definition of a module with watchdog enabled would be as follows:
module_begin
module_name Notepad
module_type generic_data
module_proc notepad.exe
module_description Notepad
module_async yes
module_watchdog yes
module_start_command c:\windows\notepad.exe
module_startdelay 3000
module_retrydelay 2000
module_retries 5
module_end

In the previous example, the watchdog is only going to activate the 'notepad.exe' if the process is
not running. It's going to execute the command c:\windows\notepad.exe each time. Other
preconfigured parameters for the watchdog execution are to try 5 times with a warmup time (delay
before trying) of 3 seconds and a time of 2 seconds between retries.

13.4.6.2. Service Monitoring and Watchdog Service
Service Monitoring

The parameter module_service verifies if a specified service is running on the machine. The
definition of this module is as follows:
module_begin
module_name Service_Dhcp
module_type generic_proc
module_service Dhcp
module_description Service DHCP Client
module_end

Remember to use «" "» if the name of the service has blanks in it's name. To find the service name,
you can look at the Service Name field under the Windows Service Manager. It's important to keep
in mind that all names are case sensitive.
If we want the software agent to notice us immediately when a service is down, we're required to
add the parameter module_async yes. The module definition would be as follows:
module_begin
module_name Service_Dhcp
module_type generic_proc
module_service Dhcp
module_description Service DHCP Client
module_async yes
module_end

Watchdog Service

There is a watchdog mode for services which allow you to detect and restart a downed service
almost in real time. A module definition example using watchdog would be the following:
module_begin
module_name ServiceSched
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module_type generic_proc
module_service Schedule
module_description Service Task scheduler
module_async yes
module_watchdog yes
module_end

The watchdog definition for services which have no need for any extra parameter because they are
incorporated in the service definition.

13.4.6.3. Monitoring Basic Resources
This section describes how to monitor the basic variables of a Windowsbased machine.
Monitoring the CPU

To monitor the CPU, you may use the parameter module_cpuusage which returns the CPU usage
percentage.
Its possible to monitor the CPU based on its ID with a module definition like the following:
module_begin
module_name CPU_1
module_type generic_data
module_cpuusage 1
module_description CPU usage for CPU 1
module_end

You're also able to monitor the average CPU usage from all systems with the following module:
module_begin
module_name CPU Usage
module_type generic_data
module_cpuusage all
module_description CPU Usage for all system
module_end

Memory Monitoring

To monitor the memory, you can use two parameters: module_freememory which returns the
amount of free memory in the system and module_freepercentmemory which returns the
percentage of free memory.
An example for a module using the module_freememory parameter would be:
module_begin
module_name FreeMemory
module_type generic_data
module_freememory
module_description Non-used memory on system
module_end

An example for a module using the module_freepercentmemory parameter would be:
module_begin
module_name FreePercentMemory
module_type generic_data
module_freepercentmemory
module_end
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Monitoring Harddrives

To monitor the harddrive space, you may use two parameters: module_freedisk which returns the
amount of available space and module_freepercentdisk which returns the percentage of available
space. Both parameters require the monitored unit as an input. Please don't forget the «":"»
characters.
A module which e.g. utilizes the module_freedisk parameter is defined in this way:
module_begin
module_name FreeDisk
module_type generic_data
module_freedisk C:
module_end

An module which e.g. utilizes the module_freepercentdisk parameter is defined in this way:
module_begin
module_name FreePercentDisk
module_type generic_data
module_freepercentdisk C:
module_end

13.4.6.4. WMI Queries
The Pandora FMS Software Agent allows you to extract information by using WMI queries and
ODBC connections  very common technologies used to store external or systemrelated
information.
WMI Queries

The software agent allows you to execute any local WMI query you want using
the module_wmiquery parameter. To do the query, you're required to set the
parameter module_wmiquery by the query which is going to be performed and to set the
parameter module_wmicolumn by the column which has the information to monitor.
We're able to get e.g. a list with the installed services:
module_begin
module_name Services
module_type generic_data_string
module_wmiquery Select Name from Win32_Service
module_wmicolumn Name
module_end

We're also able to get the CPU load using WMI:
module_begin
module_name CPU_Load
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end

13.4.7. Remote Checks with Software Agents
A remote check performed by the agent makes it e.g. easy to monitor complex networks with have
special, securityrelated requirements. This section explains how to use this feature of the software
agent:
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13.4.7.1. ICMP Checks
ICMP or ping checks come in handy if the machine is connected to a network. Only one software
agent is easily able to monitor the status of the whole network in this way.
UNIX
By using the UNIX software agent, you're able to utilize the system commands to create a module
which performs the ping check. An example module definition would be:
module_begin
module_name Ping
module_type generic_proc
module_exec ping -c 1 192.168.100.54 >/dev/null 2>&1; if [ $? == 0 ]; then echo 1; else echo 0;
fi
module_end

In this example module, we're going to perform a ping check on the host '192.168.100.54'. If you
want to check a different host, all you have to do is to change the IP.
Windows
The software agent for Windows platforms has the following parameters to configure the ping
checks:
•module_ping_count x: Number of ECHO_REQUEST packages to send (Default value is '1').
•module_ping_timeout x: Timeout in miliseconds (Default value is '1000').
•module_advanced_options: Advanced options for 'ping.exe'.
A module configuration example could be:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end

In this example, we're going to perform the same check as in the previous one, but now we're going
to use the Software Agent for Windows platforms.

13.4.7.2. TCP Checks
TCP checks are useful to verify if a port of a host happens to be open or not. It could be interesting
in case you want to know e.g. if an application is connected to the network or not.
UNIX
We're able to perform the TCP checks by the following module by utilizing the software agent for
UNIX platforms:
module_begin
module_name PortOpen
module_type generic_proc
module_exec nmap 192.168.100.54 -p 80 | grep open > /dev/null 2>&1; echo $?; if [ $? == 0 ];
then echo 1; else echo 0; fi
module_timeout 5
module_end

With this module, we're going to check if port 80 of the host '192.168.100.54' is open or not.
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Windows
If we want to use the software agent for Windows, we have some parameters to configure for the
TCP check. The parameters are:
•module_tcpcheck: Host to be checked
•module_port: Port to be checked
•module_timeout: Timeout for the check
An module definition example is this:
module_begin
module_name TcpCheck
module_type generic_proc
module_tcpcheck 192.168.100.54
module_port 80
module_timeout 5
module_end

This module is the equivalent for the Windows software agent to perform the check on port 80 of
the host '192.168.100.54'.

13.4.7.3. SNMP Checks
SNMP checks are commonly used to monitor network devices to check e.g. the interface status,
inbound/outbound bytes, etc.
UNIX
If you are using the software agent for UNIX platforms, you may create the module using the
command 'snmpget' like this:
module_begin
module_name SNMP get
module_type generic_data
module_exec snmpget 192.168.100.54 -v 1 -c public .1.3.6.1.2.1.2.2.1.1.148 | awk '{print $4}'
module_end

This module returns the value for OID .1.3.6.1.2.1.2.2.1.1.148 on the host '192.168.100.54'.
Windows
For the Windows software agent, we have the following configuration parameters for the module:
•module_snmpversion [1,2c,3]: SNMP version (Default value is '1').
•module_snmp_community <community>: SNMP community (Default value is 'public').
•module_snmp_agent <host>: The host to monitor.
•module_snmp_oid <oid>: OID.
•module_advanced_options: Advanced options for 'snmpget.exe'.
A module example could be:
module_begin
module_name SNMP get
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
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module_snmp_oid .1.3.6.1.2.1.2.2.1.1.148
module_end

Using the UNIX software agents, this module is the Windows platform equivalent to do the last
performed check.

13.4.8. Proxy Mode
To use the agent's proxy mode on Linux or UNIX systems, the agen't must -not- be
executed by a root user ! You're required to perform a custom installation of the
Pandora FMS agent to do so. You may look up all the details about custom installations
in the section Custom Agent Installation.

Pandora FMS Software Agents have a Proxy Mode which allows them to act as proxies, redirecting
the communication of several agents to the Pandora FMS Server. The software agent with an
enabled proxy mode is able to perform monitoring tasks, too.

The Proxy Mode is very useful if you're dealing with a network in which only one machine can
communicate with the Pandora FMS Server. In this situation, all software agents installed on
machines without access to the Pandora FMS Server are going to send the XML files to the agent
currently working as a proxy  which is going to redirect all files to Pandora FMS Server.
In addition to XML file redirection, the proxy mode supports Remote Configuration and File
Collection features.
To enable the Proxy Mode in a software agent, you're required to configure the following
parameters:
•server_ip: IP of the Pandora FMS Server. If the proxy mode is enabled, the IP is not
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allowed to take the following values: '127.0.0.1', 'localhost' or '0.0.0.0'.
•proxy_mode: If it's set to '1', the proxy mode is enabled. The default value is '0' (disabled).
•proxy_max_connection: Maximum number of connections for the proxy. The default value
is '10'.
•proxy_timeout: Proxy timemout. The default value is '1' (in seconds).
An configuration example would be:
server_ip 192.168.100.230
proxy_mode 1
proxy_max_connection 20
proxy_timeout 3

To redirect a software agent's connection, you're only required to set the IP address of the proxy
mode enabled software agent to the IP address of the Pandora FMS Server on agents with limited
access, e.g.:
Our proxy mode enabled agent has the IP of '192.168.100.24'.
In the software agent which can't directly connect to the Pandora FMS Server, we configure the
parameter server_ip in the following way:
server_ip 192.168.100.24

This configuration allows the accesslimited software agent to use the other software agent with
enabled proxy mode to communicate with the Pandora FMS Server.

13.4.9. Broker Mode
The software agent has a Broker Mode which allows one agent to monitor and manage the
configuration as if there were several software agents installed:
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The software agent with enabled Broker Mode has an auxiliary configuration file (defined for each
broker) which is similar to software agent's main configuration file. In this way the software agent's
behaviour is the same as if several software agents were installed in the same machine, it means,
each broker works in the same way a software agent does. This feature is very useful to remotely
manage several devices by installing only one software agent. It's also possible to monitor several
devices with different configuration files but only one software agent in this way.
The main features of the Broker Mode are:
•To send local data as another agent. Very useful to monitor different software instances as
different agents.
•To send the collected data from the remote checks to other machines as if a software agent
had been installed onto them.
To create a broker, you're only required to add a line with the parameter broker_agent
<broker_name>
broker_agent dev_1
broker_agent dev_2

Once the brokers are created, the configuration files 'dev_1.conf' and 'dev_2.conf' are going to be
created with the same content as in the original software agent, but with a different agent name. By
adding or deleting modules from configuration files 'dev_1.conf' and 'dev_2.conf', we can customize
the checks performed by the brokers.
Inside Pandora FMS web console the brokers appear and will be managed as the other agents,
which means that if we have a software agent installed with two brokers, we're going to see three
different agents with their modules, configurations, etc. in the web console.

13.4.9.1. Examples of Use
Monitor a local Database as a different Agent

We want to monitor the basic parameters of a machine (CPU, memory and harddrive) and an
installed database which that we want to monitor separately.
To perform this monitoring, we are going to use the following structure:
•Installed Software Agent: monitoring CPU, memory and disk.
•Broker for the Database: monitoring internal status of the database.
We're going to install the software agent on the machine to monitor the CPU, memory and
harddrive. We're also adding the following line in the software agent configuration:
broker_agent DBApp

We're going to create a broker agent called 'DBApp' by adding this line. Because of it's creation, a
configuration file named 'dbapp.conf' will appear. We're adding the modules to perform the checks
for the database in this configuration file:
module_begin
module_name Num Users
module_type generic_data
module_exec get_db_users.pl
module_end
module_begin
module_name Num slows queries
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module_type generic_data
module_exec get_db_slows_queries.pl
module_end

By doing this, you're going to see two agents in the Pandora web console: One bearing the name of
the machine with the modules 'CPU', 'Memory' and harddrive and another one called 'DBApp' with
the modules 'Num Users' and 'Num slows queries'.
Remotely Monitor Devices using Brokers

For this example, we've installed a software agent on a Windows machine, monitoring CPU,
memory and harddrive. We're also required to monitor a router with the IP '192.168.100.54'
without being allowed to install an agent on it. To solve the problem, we can use brokers.
We're going to create a broker using the following parameter:
broker_agent routerFloor5

By adding this line, we're going to create a broker agent by the name of 'routerFloor5'. The software
agent was installed on a Windows machine, so we're able to monitor the router by using the ping
and SNMP modules available for Windows software agents. To do that, we're modifying the file
'routerFloor5.conf' by adding the following lines:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name Eth 1 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.1
module_end
module_begin
module_name Eth 2 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.2
module_end

In this example, the web console of Pandora FMS shows two agents: One is the Windows machine
with the modules 'CPU', 'Memory' and 'harddrive' and the other one is 'routerFloor5' bearing the
modules named 'Ping', 'Eth 1 up' and 'Eth 2 up'.
Remote Monitoring of a Network with limited Communication Options

In some cases, it's required to monitor devices remotely where the Pandora FMS Remote Server
can't access them directly.
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In this example, we have to monitor some devices from one of the company sites from the
headquarters remotely. The Pandora FMS Server is connected to the other company sites in the
headquarters using a VPN. Due to some restrictions, the Pandora Remote Server can't access the
machines directly. To monitor the company sites, we're going to use the Broker Mode which allows
a software agent to send XML files to the Pandora Server as if there would be several different
devices.
We add as many brokers as there are devices to be monitored. In the configuration file of the
software agent, an example configuration could be:
broker_agent device_1
broker_agent device_2
broker_agent device_3
broker_agent device_4
...

Once the brokers are created, we're able to customize the monitoring for each devices by modifying
the configuration file of each broker. The configuration e.g. for the Windows machine called
'device_1' is:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name CPU_Load
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end
module_begin
module_name Mem_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Memory
module_wmicolumn FreeMemory
module_end
module_begin
module_name Disk_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Disk
module_wmicolumn FreeSpace
module_end

237

Monitoring with the Software Agent

We're able to use the remote configuration feature by a configuration like this. We're also able to
send monitoring information to the Pandora FMS Server, despite the restrictions in the
communication between the different company sites.
Shared Monitoring Load by Brokers

The broker mode is very useful to share and distribute the monitoring load within several network
points.

In this example, our architecture has several networks named from A to Z with a 1000 devices each.
The capacity of the Pandora FMS Remote Server is about 2000 agents, because we've decided to use
broker mode enabled software agents to share and distribute the load. These broker mode enabled
software agents are going to remotely monitor all devices from the network and send the data in
XML format to the Pandora FMS Central Server.
For each network, we have a broker mode enabled agent. On it, we're going to create as many
brokers as the number of devices to be monitored. An example configuration for the software agent
'Broker_Agent_Net_A' could be the following:
broker_agent device_1
broker_agent device_2
broker_agent device_3
broker_agent device_4
...

In addition for each broker, we're going to add the modules to monitor the devices. Example: The
broker 'device_1' (which is a router) could have this configuration:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
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module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name Eth 1 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.1
module_end
module_begin
module_name Eth 2 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.2
module_end

Another example configuration for the broker 'device_2' which monitors a Windows machine with
the following modules:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name CPU_Load
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end
module_begin
module_name Mem_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Memory
module_wmicolumn FreeMemory
module_end
module_begin
module_name Disk_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Disk
module_wmicolumn FreeSpace
module_end

Using broker mode enabled software agents, we're easily able to share the load to collect the data
from thousands of devices.

13.4.10. Inventory using Software Agents
Pandora FMS Software Agents support inventory features for both hardware and software. The
inventory system allows you to get a history of CPU, cards, memory, patches, software, etc, used in
the company servers. Furthermore, it's possible to generate alerts if a change occurs in the
inventory, e.g. if a disk was replaced or an application was deleted.

For further information on the subject, please have a look at the section Local
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Inventory by Software Agents.
13.4.11. How to ask an Agent for OnDemand Information
Before the publication of version 3.2, there wasn't any way for asking the remote software agent for
information. You were compelled had to wait for the agent to reach its interval limit to send its
information. The Windows Agent 3.0 has a not very well known feature called "UDP Server" which
allows to receive communication data from outside to ask for information and to force the agent to
refresh its cycle which forces it to send the information to the Server.
In 3.2 version, we now have implemented the same feature called 'REFRESH AGENT' which is
available under the UNIX agent as well. We also have included a 'default' alert template and
commands, designed for easy handling. You now can setup your agents (for Windows and UNIX) to
receive orders from the console to report the data immediately, without having to wait for it's
interval any more.
This feature is pretty simple. First, you're required to setup your agent (Windows or Linux) to
accept outside connections on a specific UDP port, from a specific IP address (or 0.0.0.0 for
anyone). Under Windows, you can also define other possible things the agent can execute as a
result of a remote command. Under UNIX, the only supported operation (at this time) is "REFRESH
AGENT". Klicking on it is going to result on an immediate agent execution which skips its interval.
This is an example of the UDP server settings under the 3.2 Unix software agent:
udp_server 1
udp_server_port 41122
udp_server_auth_address 0.0.0.0

You may enable the server by setting the value of '1' and disable it with '0' under the 'udp_server'
option. Please set '0.0.0.0' as source IP address to enable any IP.
This is an example of the UDP server settings under the 3.x Windows software agent:
udp_server 1
udp_server_port 41122
udp_server_auth_address 192.168.1.23

As you can see, it's exactly the same. In this case, we're going to use the IP address '192.168.1.23' as
the only authorized one to refresh this agent.
The Pandora FMS Server has a small script which sends the order to the agent. In our default
command, its fully operational and ready to be used. This script is written in Perl which acts as a
small client to communicate with the simple UDP server, embedded in the agent and sends
commands passed to the command line.
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To limit the possible values on a field, is possible to define a list of value/tag. If this list is defined,
the field will be a selection combination.
The format will be the following:
value1,tag1;value2,tag2;value3,tag3

We also provide a default alert template to assign "manual" alerts to an agent which means an alert
will never be fired automatically. You're required to use the 'manual alerts' to force a manual alert
execution by using the circleshaped button on the agent's main view.
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We have created a default alert action called "Restart Agent", which is going to call up the remote
agent's command. This action attaches the REFRESH AGENT command to the command, and
utilizes the main IP address of the agent to reach, using the default port for the UDP server
(41122):

Please follow these steps to enable the Software Agent's remote refresh option:
1. In the configuration file, set up the options for the software agent (UNIX or Windows). Please be
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mindful on the authorized IP address (is the Pandora FMS server behind a NAT ?), or just put
'0.0.0.0' in the field to allow any IP address to force a refresh of the agent.
2. Restart the software agent.
3. You need to setup the IP address on your agent item in the Pandora FMS console. The alert
action will utilize the IP address to connect to the running software agent on the remote system.
4. Set an alert to any of the modules of that agent (no matter which), using this screenshot as a
example guide:

5. You're now ready to force a refresh for that agent using the main view, clicking on the green
circleshaped button on the left of the alert you've just defined:

If you want to instantly get the agent's information without having to wait for the agent interval,
just click in the button and wait a few seconds. The agent will be contacted and forced to execute,
the XML file are going to be transferred to your Pandora FMS server and processed, depending on
your system load. It will be processed in approx. 15 seconds and displayed on the console.

13.4.12. Using Software Agent Plugins
Agent plugins are executed by the software agent and are able to report several information
(modules) at once. Each plugin works in a different way and you should test how it works before
using it. Default installation of Pandora FMS comes with a bunch of plugins. Of course, UNIX and
Windows agents come with different plugins and some of them work very similar.

13.4.12.1. On Windows Systems
Under the 3.2 version, the windows agents come with the following plugins:
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•df.vbs: Reports the available harddrive space in bytes. It reports different modules for each
harddisk that is found on the system. If you want to report the data of specific units only,
just use the parameters after the 'module_plugin' call.
•df_percent.vbs: Very similar to previous the one, but it's going to report the available space
in percent. It's going to generate modules with names like 'DiskFree_C'.
•logevent_log4x.vbs: Reads eventlog entries and generates 'log4x' data.
•ps.vbs: It requires process names and check if these processes are running. If you e.g.
execute it with "iexplorer.exe mucommand.exe other.exe" it's going to check for three
processes, returns different modules for each of them and reports if the proccesses are down
or not.
Under Windows, all default plugins are coded in VBScript. You're going to need to use the correct
interpreter for the VBScript Console (sometimes referred to as 'Windows Scripting Host') to run it.
These are some examples for the usage of the previous plugins:
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\logevent_log4x.vbs" Aplicacion
System 300
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\df.vbs"
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\ps.vbs" iexplore.exe myapp.exe

13.4.12.2. On Unix Systems
Under version 3.2, the generic UNIX agent comes with following plugins:
•files_indir: This plugin receives a target directory, e.g. '/tmp' and returns two modules: One
called 'FS_/tmp/' (boolean) which returns a value of '1' if it contains the same number of
files as in the previous execution. The other module called 'NumFiles_FS_/tmp/' returns the
number of files in that particular directory.
•grep_log: It's a generic log parser and it takes tree arguments: <file_to_process>,
<module_name> and <reg_exp>. It will generate information inside an 'async_string'
module type called <module_name>, using all data which match the <reg_exp> regular
expression. For more information on this plugin, please look at the example below.
•pandora_df: It's very similar to the Windows plugin. It's going to report available space on
all mounted partitions on the system. It also takes information from the NFS mounts. The
information for all filesystems is returned, but one or more filesystems may be specified as
plugin parameters by default.
These plugins are very similar to the Windows plugins. We're not required to use the full path to the
plugins, because the 'module_plugin' directive looks for the plugin directory under the agent's home
directory. We use the following syntax to execute them:
module_plugin grep_log /var/log/syslog Syslog .
module_plugin pandora_df tmpfs /dev/sda1

And some special plugins working under UNIX:
•nagios_plugin_wrapper: This is not really a plugin, it's just a wrapper, used to execute a
Nagios plugin and to process the output to generate a Pandora module. It grabs the standard
output, puts the results into the module description and gets the errorlevel to process a
'module_proc' (boolean) module by its results. Just call up the nagios plugin as a parameter
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to 'nagios_plugin_wrapper' with all its needed parameters and it's going to generate a
Pandora FMS module.
•inventory: This is used in the inventory system. It will create an inventory XML with
information about the system. It could be modified to gather different information, but by
default, it only works under Linux and gets packages and services in the default runlevel and
some other options. Please check out the inventory documentation for more information.
•pandora_update: This is used to utilize the autoupdate feature on the software agents.
Please check out the agent configuration section for more information.

13.4.12.3. Examples using Plugins
The plugins for software agents are able to return one type of data or a group of them. An example
of a plugin which only returns one data type could be the plugin 'ps.vbs' for Windows. We're going
to execute the plugin by the following line:
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\ps.vbs" IEXPLORE.EXE

The result will be a module which returns a value of '0' if the process is down and '1' if the process is
running, e.g.:
<module>
<name><![CDATA[IEXPLORE.EXE]]></name>
<description><![CDATA[Process IEXPLORE.EXE status]]></description>
<data><![CDATA[1]]></data>
</module>

An example of a plugin which returns several data could be the plugin 'df.vbs' for Windows. The
line to execute the plugin could e.g. be:
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\df.vbs"

The plugin returns a module per found harrdrive. The result would be something like this:
<module>
<name><![CDATA[C:]]></name>
<description><![CDATA[Drive C: free space in MB]]></description>
<data><![CDATA[8050]]></data>
</module>
<module>
<name><![CDATA[D:]]></name>
<description><![CDATA[Drive D: free space in MB]]></description>
<data><![CDATA[900]]></data>
</module>

13.4.13. Local Plugins Editor
Since version 5 of Pandora FMS, it's possible to manage the software agent's plugins from the
console without the requirement of editing the configuration file directly.
If an agent has an enabled remote configuration, it's going to have the plugins editor tab in the
'Manage' view, as you can see in the screenshot below:
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The editor shows the plugins list and allows to delete, to add and to disable it. Disabling it under
the plugins policy can be useful, because the plugins are still disabled if the policy is going to be
applied again.

The managed plugins from this editor can be edited from the agent configuration file, too:

13.4.14. How to Create your own Agent Plugins
The plugins can be developed in any programming language, but they have to respect the following
two restrictions:
•Whatever you want to do: It has to be completely automated (no interactive processing
from the user) and must be done from the command line (shell). You're allowed to use any
kind of scripting or compiled language, but you have to provide a standalone executable
with all it's dependencies (libraries, dll, etc.) in this case.
•Plugin has to report the information to the standard output (just using 'echo', 'printf' or the
equivalent in your language) and to use the XML syntax for the Pandora FMS agent
information. This is an example of 'generic_data' (numerical information) in XML:
<module>
<name><![CDATA[Sample_Module]]></name>
<type><![CDATA[generic_data]]></type>
<data><![CDATA[47]]></data>
<description><![CDATA[47]]></description>
</module>
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The <![CDATA[xxx]]> is used to 'encapsulate' data and to protect the XML files from nonvalid
characters like ',', '&' or '%'.

Please take a look at our Pandora FMS plugin library at http://pandorafms.org before
trying to create your own plugin. If you want to create your own, please upload it to
the Pandora FMS public library to allow others use your plugin when it's done.
13.4.15. Using Nagios Plugins from the Agent
Nagios has a lot of amazing plugins you're free to use in conjunction with Pandora FMS. One way is
to use remote plugins with the Plugin Server, using the Nagios compatibility, but they only receive
it's status. They're not going to use the descriptive output that some Nagios plugins have.

Using the wrapper to utilize Nagios plugins in the software agent will solve this
problem. The wrapper comes with 3.2 Unix agent by default. An equivalent plugin
for Pandora FMS Windows agents can be downloaded from our website
at http://pandorafms.org resource library at [1]).
What does the plugin wrapper for nagios plugins do ?
It executes the nagios plugin, utilizes it's native parameters and converts the output into useful
values for Pandora FMS. It has two kinds of information:
•Status information: 'NORMAL' ('1'), 'CRITICAL' ('0'), 'WARNING' ('2'), 'UNKNOWN' ('3') and
'OTHER' ('4'). It's going to use a 'proc' module by default, so the values 'NORMAL' and
'CRITICAL' are working by default. If you want to have information on 'WARNING' and
'OTHER' values, you're required to setup the module thresholds manually.
•Descriptive information: Usually string information. It's going to be put on the description
field on the module. This is usually something like "OK: successfully logged in" or similar.

13.4.15.1. Example
You have a pop3 plugin (in '/tmp/check_pop3_login') with execution permissions, which checks if
the pop3 account is working. By connecting to a remote host, send a user and password and see if
everything is ok. This is a command line example:
/tmp/check_pop3_login

mail.artica.es sanler@artica.es mypass

It's going to return something like this:
OK: successfully logged in.

If it's not ok, will return something like this:
Critical: unable to log in.

Using the wrapper is simple. Before the call up, you're just required to put in the wrapper and the
module name you want:
/etc/pandora/plugins/nagios_plugin_wrapper sancho_test /tmp/check_pop3_login
sanler@artica.es mypass

mail.artica.es

It's going to generate a full XML for the agent plugin:
<module>
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<name>sancho_test</name>
<type>generic_proc</type>
<data>0</data>
<description><![CDATA[Critical: unable to log on]]></description>
</module>

Or:
<module>
<name>sancho_test</name>
<type>generic_proc</type>
<data>1</data>
<description><![CDATA[OK: successfully logged in.]]></description>
</module>

The full entry in the 'pandora_agent.conf' will be something like this:
module_plugin nagios_plugin_wrapper POP3_artica.es /tmp/check_pop3_login mail.artica.es
sanler@artica.es mypass

In the module, this will be seen like this on a 'fail' event:

13.4.16. Monitoring with KeepAlive
There is a special module. It has a unique kind called 'keep_alive' and is very useful to receive any
information if there is no contact to the agent. It comes in handy if an agent has stopped to send its
information and notifies us.
If there is a module (local or remote) which gets information from the agent, the date of the last
'contact' is updated in a way there is always data. The agent is going to have its date of last contact
updated. This can come in handy if the agent 'doesn't answer'. Any agent is considered 'dead' if it
hasn't managed to get its data updated in the double of time of its interval, to be precise. If it has
e.g. a 5 minutes interval and more than 10 minutes have been past since his last update, the agent
is considered 'dead'.
In this moment, the KeepAlive module would appear. It would get fired and appears as a 'Critical'
state on the monitor.
The configuration of this kind of modules is very easy. You're just required to create a new module
kind called 'dataserver' e.g. in the following way:
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Once created (if the agent has data in its interval) it will always be in 'NORMAL' (green) status.

If the agent stops sending data (in this example it has interval of 1 minute), it will pop up
automatically and on 'CRITICAL' status (red):

Important: If we have a remote module, e.g. one ping apart from the data reported by the agent,
the KeepAlive module will never pop up. We're continually updating the agent by the ping.
Furthermore, the KeepAlive module works the same as any other. It could be associated to an alert
and used for lots of other elements (reports, maps, etc.).
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13.4.17. Monitoring Command Snapshots
From the 4.0.3 version and above, this way to monitor allows administrators to use a special way to
capture the output from commands which differs from the parsing of a single value or string. This
module stores the information as text, but with the purpose of getting the exact output of the
command, not as single data. It's going to show the same output format and contents like the one
returned by the command.
An image always works better than words, so:

This is the 'netstat an' command output, captured by Pandora FMS after clicking on the special icon
for the command snapshot. It's only available if we have a multiline text and a nonsplit output.
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These are the different "snapshots" across a certain time. Pandora is only going to show information
if the agent's information is different (data type continues to be of the 'generic_data_string' type
here). It's not recommended, but if you want to store each single data string, you may use
'async_string'. The behaviour of showing information only when changes occur is perfect for
reporting data on problems and to compare other events to the information contained in the
command snapshot pertaining that period.
To capture the command outputs in a snapshot, you're required to write a small plugin which sends
all data with a 'module_plugin' syntax (including the XML tags) and executes the plugin as a
standard plugin. This is an example which generates output for the 'netstat' command:
#!/bin/bash
echo "<module>"
echo "<name>netstat</name>"
echo "<type>generic_data_string</type>"
echo "<data><![CDATA["
netstat -an | grep LIST
echo "]]></data>"
echo "</module>"

Please save this script contents in a file on the agent (or remotely distribute it along with file
collections), execute it and use the syntax below:
module_plugin <full path for file>

The agent is going to generate a command snapshot for almost any command. Just replace 'netstat'
with your command. Some useful suggestions for UNIX systems are e.g.:
* top -b -n 1
*
*
*
*

ps aux
vmstat 1 5
who
last -10

On Windows systems:
* tasklist
* netstat -an
* net start
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Remember that you're always required to do this within a script which is generating the
XML file. If you do that by calling up a 'module_exec', each line reported by the
command will be interpreted as a line with different 'data blocks' - and you cannot see it
as a command snapshot anymore.

Remote Monitoring

13.5. Introduction
The Pandora FMS Network Server is an essential piece of Pandora FMS, because it
allows to conduct remote tests from a central point. The Data Server and the Network
Server are conducting the tasks assigned to them through a multiprocess queue
system. A network server can also work with other network servers, balance the load
and act as a support device in case another network server fails, conducting the work
the failing server was supposed to do. If you like to know more about High
Availability (HA) under Pandora FMS, please take a look at the chapter about it.
Our Network Servers only work with assigned network modules. Because there are network tests to
perform, the Network Server should of course have a complete visibility (IP adresses and ports) over
the devices we're going to perform the tests on. It's completely futile to perform tests against a
system with ports which can't be seen or for which we don't have the proper paths for. The
existence of firewalls (or the problems generated though the existence of these kinds of devices) or
preexisting paths in the network have nothing to do with Pandora FMS or with a specific
configuration of it.

13.6. Remote Network Modules
The Pandora FMS Network Modules conduct remote monitoring tasks. The remote execution of
tasks can be summarized in three blocks:
ICMP Tests
These tests consist of whether a machine answers to a 'ping' ('remote_icmp_proc') or the latency of
a system in milliseconds ('remote_icmp'). In both cases, the tests are conducted by the network
server to which the agent which contains these network modules were assigned.
TCP Tests
In this test, we're going to remotely check if a system has opened the TCP port which was specified
in the module definition. Additionally, a text string can be sent (using the string '^M' to replace the
'CR'). By receiving a response sub string, you're able to check if the communication is alright. This
method allows to implement easy protocol checks. We could e.g. check if a server is 'alive' by
sending the following string:
GET / HTTP/1.0^M^M
We suggest to just wait a moment to be able to receive the '200 OK' string here.
SNMP Tests
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It's possible to launch SNMP petitions remotely (called 'SNMP Polling') which are
accessible and have activated SNMP services to obtain data like: 'state of the
interfaces' and 'consumed network bandwidth by interface', etc. If you like to know
more about SNMP, please consult the section for SNMP with Pandora FMS here.

In conclusion it's quite obvious that the network server is the one which conducts the different
network tests assigned to each agent. Each agent is assigned to a Network Server  and it's this
Network Server which executes the task and transfers the results to the DB of Pandora FMS.

13.7. General Configuration of a Module for Network Monitoring
To remotely monitor any kind of equipment or an equipment service (FTP, SSH, etc.), you're
required to create the corresponding agent to monitor the service first.
Please go to the Pandora FMS section for console administration and klick on 'Manage agents':

In the following screen, please klick on 'Create agent':
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Please enter the proper data to define your new agent and klick on 'Create':

Once you have created the agent, please klick on the drop down menu of the modules. Please select
'Create a new network module' in it and klick on the 'Create' button:

Please select a network component module in the following form: Look for the check you need in
the dropdown menu on the right. In this example, we've selected 'Host Alive' which represents a
ping for the machine. It's a simple check for being able to tell if the machine is connected to the
internet or not.
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We're going to leave the advanced options for later. Make sure the modules have obtained the
agent's IP address. You're also able to enter a different IP address here. Once you have finished to
define the module, press the Create button.
In the following screen, all modules for the agent are shown. On the picture below, you can see the
pre set 'Agent_keepAlive' (which was created along with the agent) and the module 'Host Alive'
added:

As you can see, there is a warning attached to the modules. The warning only means that no data
has been received by the module yet, because it's just been added a few moments ago. Once the
modules begin to receive any data, the warning disappears.
To see the data from the newly created module, just klick on the 'view' button on the top right and
look at the bottom where the data is going to appear if it starts to receive anything:
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To perform another kind of network check, we suggest to proceed exactly as described above, but
with a different kind of module.

13.8. ICMP Monitoring
The previous example was one of ICMP monitoring. These are the more basic and simple checks
which give us important and precise information. There are two kinds of ICMP checks:
•icmp_proc, host (ping) check which allows to come to know if an IP address responds or
not.
•icmp_data or latency check. Basically, it informs us about the time which the IP address
requires for answering a basic ICMP consult in milliseconds.

13.9. TCP Monitoring
The TCP check allows to check the state of a port or a TCP service.
There are two specific fields for TCP tests:
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By default, the TCP check is simply a test for whether the destination port is open or not. You're also
able to send a text string and wait to receive something which will be processed directly as data.
It's possible to send a text string (using the «^M» string to replace the CR) and to wait if you're
going to receive an answer substring to check whether the communication is functioning properly
or not. This allows to implement simple protocol checks. If you want to e.g. check whether a server
is alive or not, you may send the following string:
GET / HTTP/1.0^M^M

Then just wait to receive the string:
200 OK

This string is coded in 'TCP send' and 'TCP receive' fields.
TCP send
It's the field to configure the parameters intended to be sent to the TCP port. It accepts the '^M'
string as a replacement for the sending of a CR. To send several strings in a row in a send/response
manner, you're required to separate them by the character:
TCP receive
It's the field to configure the text strings which we expect to receive on the TCP connection. If they
send/receive in several steps, each step should be separated by the '|' (pipe) character.
By means of the Pandora FMS TCP check, you're able to perform more things than just to inspect
whether a port is open or waiting for an answer from a simple request or not. It's possible to send
data, waiting to receive something, to send something afterwards, waiting to send something. Only
if all the processes are conducted in the right way, we're able to validate the results.
To use the Pandora FMS Dialog and Response Checking System, you may separate the different
petitions by the | ('pipe') character.
This is an example of a SMTP conversation:
R: 220 mail.supersmtp.com Blah blah blah
S:
R:
S:
R:
S:
R:
S:
R:
S:
S:
R:
S:
R:

HELO myhostname.com
250 myhostname.com
MAIL FROM:
250 OK
RCPT TO:
250 OK
DATA
354 Start mail input; end with .
.......your mail here........
.
250 OK
QUIT
221 mail.supersmtp.com Service closing blah blah blah

If you e.g. want to check the first protocol points, the necessary fields to emulate this conversation
would be:
TCP Send
HELO myhostname.com^M|MAIL FROM: ^M| RCPT TO: ^M

TCP Receive
250|250|250
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If the three first steps are OK (code 250), then the SMTP is working properly. You're not required to
send a complete mail here (but you could, in any case). This allows to perform protocolbased TCP
checks which could be used for any protocol which utilizes plain text conversations.

13.10. SNMP Monitoring
13.10.1. Introduction to SNMP Monitoring
When we talk about the SNMP monitoring, the most important thing in the beginning is to separate
the testing concepts (polling) and the traps. The SNMP testing implies to order Pandora to conduct
a 'snmpget' command against a SNMP device such as a router or a switch (or even a computer with
an installed SNMP agent). This is a synchronous operation (every X seconds). Receiving an SNMP
trap, on the other hand, is an asynchronous operation (that could or couldn't happen in a million
years). It's commonly used to receive 'alerts' coming from a device, e.g. if a switch knocks down a
port or its fan is too hot.
To use the SNMP monitoring test, you're only required to add a SNMP module under Pandora
which creates a new network module. The majority or the SNMP items which report data in the
incremental way ('generic_data_inc'), e.g. when it asks for a value, it reports the 'global' quantity of
information, if a total of bytes gets collected from the moment the device starts. This would be
necessary to extract the last quantity of bytes known from the one which is working and gets
divided by the seconds from the last known data. This dividing is going to provide the required data
for displaying 'bytes per second' display. This operation is done with Pandora using generic data inc.
Using the SNMP Traps is something completely different. It's possible to receive traps from any
device without the necessity of configuring anything (except the SNMP console). If a trap gets
received, it's going to appear on the SNMP console.
It is possible to define an alert, based on OID (the code that identifies a trap, something similar to
3.4.1.1.4.5.24.2), in a IP agent or in a custom data (data that could be in the trap). It is also possible
to order Pandora that it copies the information in an special text module in the agent. If the agent is
defined, this operation is called SNMP Traps transfer.
Pandora FMS is able to work in conjunction with any device that supports SNMP. It currently works
with SNMP versions 1, 2, 2c and 3.
Pandora FMS works with SNMP using individual OIDs, where each OID is a network module for it.
If we want to monitor e.g. a 24port 'Cisco Catalyst' switch and to learn the operating system and
the entry and exit port, we're required to define a total of 72 modules (24 x 3).
To work with SNMP devices, you're required to know the following:
•What

the SNMP Protocol is and how it works. The published RFC3411 from
the IETF describes it in detail here: https://www.ietf.org/rfc/rfc3411.txt
•The IP and the SNMP community of the remote device.
•To activate the device's SNMP management so we're able to perform SNMP queries from
the network server.
•The specific OID of the remote device which we want to check.
•How to manage the data that's going to get returned by the device. The SNMP devices
usually return data in different formats.
This network server should be the one assigned for the agent if we're going to define the network
modules. You also need to keep in mind that, if we want other network servers to do queries (in
case the assigned server fails), they're going to perform the queries with other IP addresses.
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Pandora FMS could manage almost all of them, except the 'timetick' that gets managed as a numeric
format without converting it to date / hour. Pandora FMS manages counters of the 'data' kind as
'remote_snmp_inc'. They are of special importance, as they are counters which can't be considered
numeric data. The majority of the SNMP statistical data are of the 'counter' kind and it's necessary
to configure them as 'remote_snmp_inc' if we want to monitor them properly.

13.10.2. SNMP Monitoring from Agents
Since version 3.2, it's possible to get SNMP information which is available under the Windows
Agent. Under UNIX or Linux, 'snmpget' is usually available, so it could be retrieved automatically.
Under Windows systems, an external utility is necessary which isn't always easy to obtain or to
install.
We have added the utility 'snmpget.exe' to the Windows agent by default (which is part of the 'net
snmp' project and comes with BSD license). We've also added the basic 'MIBs' and a wrapper /
script to wrap the call into the 'snmpget.exe' utility.
Using this call, we're able to monitor SNMP from an agent, obtaining information from any remote
system to which the agent has access to, so we're able to work as a 'satellite agent' or 'proxy agent'
(just as the manual says).
Under Windows, the syntax for the execution is:
module_exec getsnmp.bat <comunidad_SNMP> <ip de destino> <OID>
Some examples of SNMP modules executed by Windows agents are:
module_begin
module_name SNMP_if3_in
module_type generic_data_inc
module_exec getsnmp.bat public 192.168.55.1 .1.3.6.1.2.1.2.2.1.10.3
module_end
module_begin
module_name SNMP_if3_desc
module_type generic_data_string
module_exec getsnmp.bat public 192.168.55.1 IF-MIB::ifDescr.3
module_end
module_begin
module_name SNMP_Sysup
module_type generic_data
module_exec getsnmp.bat public 192.168.55.1 DISMAN-EVENT-MIB::sysUpTimeInstance
module_end

The same examples, executed under UNIX agents:
module_begin
module_name SNMP_if3_in
module_type generic_data_inc
module_exec snmpget -v 1 -c public 192.168.55.1 .1.3.6.1.2.1.2.2.1.10.3
module_end
module_begin
module_name SNMP_Sysup
module_type generic_data
module_exec snmpget -v 1 -c public 192.168.55.1 DISMAN-EVENT-MIB::sysUpTimeInstance
module_end

It's important to remember that only the 'basic' OIDs are translatables for their numerical
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equivalent. It's advisable to always use numerical OIDs, because we don't know if the tool would
otherwise be able to translate it or not. In any case, the MIBs can always be obtained in the
'/util/mibs' directory under Windows or in '/usr/share/snmp/mibs' under Linux.

13.10.3. Monitoring by Network Modules with SNMP
For being able to monitor any element through SNMP, we should at least know its IP and its SNMP
community. It would also be quite important to know the OID which we want to monitor, although
we could obtain it by means of an SNMP Walk as long as we know where each OID comes from. To
monitor an element through SNMP, you first have to create an agent for it. If you already have one,
simply add a new network module and follow the previous instructions.
Once the module has been created, you should select a SNMP data type in the configuration module
form just like the ones shown on the image:

Any of the three SNMP data types are valid. Simply select the one which coincides with the type of
data that you want to monitor.
Once you have selected a SNMP data type, the form is going to expand, showing additional fields
for SNMP like the following:

Next, you're required to define the fields:
SNMP community
The SNMP community is necessary to monitor the element. It acts as a password.
SNMP version
The SNMP protocol version of the device. It could be 1, 2, 2c or 3.
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SNMP OID
The OID identifier to monitor. They can consist of numeric values. The alphanumeric values are
internally transformed into numeric values by the system (which are the ones used to do the
petition) by means of a dictionary called MIB.
An alphanumeric OID can be similar to this one:
iso.org.dod.internet.private.transition.products.chassis.card.slotCps.cpsSlotSummary.cpsModuleTab
le.cpsModuleEntry.cpsModuleModel.3562.3

The numeric equivalent would be something like this:
1.3.6.1.4.868.2.4.1.2.1.1.1.3.3562.3

Without the MIB, the alphanumeric format is invalid. Installing an MIB on the system is not a trivial
thing, so it's recommended to work with numeric identifiers directly, although it's a little more
cryptic. The above shown is much more portable and it also doesn't create any problems for you,
because it doesn't require MIBs.
Pandora FMS includes some OIDs in its database which could be used directly. If you are going to
create the module, select the 'Cisco MIBs' component to show a list of the available MIBs for Cisco
devices:

Once you have selected the proper component, you're able to pick the available MIB for it:
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By doing this, the fields will be filled out by the necessary information.
There are more MIBs included in Pandora FMS. With an Enterprise Version, there are several
included MIB packages for different devices. Once you have introduced the data, please klick on
the Create button.
To see the data of the module which has been just created, just klick on the upper flap
named View and take a look at the bottom of the page, where the data is going to be shown once it
starts to receive any.

To see the text string kind data of the modules from the system description example, please go to
the upper right flap named Data.
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The data received by the SNMP system description data modules are pointed out in red.

13.10.4. Pandora FMS SNMP MIB Browser
From Pandora FMS 5.0 and above, you possess a complete SNMP MIB browser included in the
Pandora FMS console. This feature is also available in the open source version. It doesn't require
any additional software like java plugins or Flash. It's purely based on JavaScript and HTML code.
On the back end, it uses 'netsnmp', which is a Linux based SNMP system and a dependency for the
Pandora FMS console installation. It's required to be installed.
You can access the SNMP browser from the SNMP menu. At this point, it only supports SNMP v1.
First of all, you need to understand that Pandora FMS performs a full scan of the target device's
SNMP tree, so if the device has a huge OID database (like a modern switch with lots of ports). This
operation can take several minutes. You're also able to choose to explore a single subtree and save
quite some time in this way.
You may use this OID to e.g. only obtain information on the 'Enterprise' subtree for a Cisco device:
.1.3.6.1.4.1.9

The browser is used to navigate, which means that clicking on each tree and sub tree to arrive at
the last piece of information on the branch, which is a sole OID with a single value. You're going to
see an 'eye' icon and if you click on it, you're going to get the value of the OID. The system will try
to locate the description and humanreadable OID translation if the MIB for that branch is available.
If you don't have an MIB available, the only thing you're able to see is the numerical OID
information, value and data type.
The descriptive information is stored in MIB files. If you like to know more on this topic, please
follow this link [1]. If you don't have an MIB for the device you intend to browse, you probably
have to 'dig search' in the values  which is pretty complex and takes a lot of time.
The Pandora FMS SNMP MIB Browser allows you to search for a text string or numerical value in
the OID's values and also the translated OID's (if available). It could be very helpful to be able to
search for known values to identify the matching OID value. If there are several matches, you're
able to browse in them. You're going to get the matches displayed in an easily identifiable yellow
colour.
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13.10.4.1. MIBs Management
You can upload and manage Pandora FMS managed MIBs. You can add new MIBs or delete some.
These MIBs are ONLY going to be used by Pandora FMS, which is also going to utilize the system
MIBs
(the
ones
in
'/usr/share/snmp/mibs').
Pandora
FMS
uses
the
path
'{PANDORA_CONSOLE}/attachment/mibs' to store the MIB files.

To avoid confusion between the 'trap' MIBs and the polling MIBs: This manager is for polling MIBs.
The SNMP Traps Monitoring is discussed in a different section and is only available in Enterprise
Versions.
There are many prepackaged collections of MIBs. One of the best available is on the Getif website.
It's one of the best free SNMP browsers for Windows [2].
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13.10.4.2. SNMP Browser on Module Creation
You may use the SNMP browser from the network module creator / editor section by clicking on the
'SNMP Walk' button. That's going to open a floating window, which is going to display the SNMP
tree of the device (if you've put the IP and SNMP community there). Once you locate the OID you
want (by clicking on the hand icon), that OID information will be copied to the module definition to
be used under Pandora FMS.

13.10.5. Pandora FMS SNMP Wizard
In the agent management view, there is a set of tools specifically created to remotely create
modules: The Agent Wizard.
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Some of these tools utilize SNMP to explore the host data and to put it into a form combo. With a
few steps, it's possible to create dozens of customized modules in this way.

13.10.5.1. SNMP Wizard

You're required to set up the IP target, the community and other desired parameters (SNMP v3 is
supported) to make an SNMPWalk to the host.

Once the data is correctly retrieved, a form for module creation is going to appear:
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It's possible to create modules from the following kinds of SNMP data by the SNMP Wizard:
•Devices
•Processes
•Free Space on Harddrives
•Temperature Sensors
•Other SNMP Data
You may select the kind of module and put the desired elements from the left combo to the right
one. When you've completed this process, please click on the 'Create modules' button.
This wizard is going to create two kinds of modules:
•SNMP Modules for the data with a static OID (sensors, memory data, CPU data, etc.).
•Plugin Modules for the data with dynamic OID or calculated data (processes, disk
space, used memory in percentage, etc).

We're going to use the SNMP remote plug in for all plug-in modules. If this plugin isn't
installed on the system, these features are not going to be available. The plugin has to be
named 'snmp_remote.pl', but the path where it's going to be placed doesn't matter at all.

13.10.5.2. SNMP Interface Wizard
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In the Agent Wizard, there is an SNMP wizard specifically created for browsing interfaces.
This Wizard browses the SNMP branch IFMIB::interfaces, offering the possibility of creating
multiple modules of various interfaces with multiple selections.
Like the SNMP Wizard (after selecting the IP target, community, etc.), the system conducts an
SNMP query on the host and it's going to fill out the module creation form.
You're able to select one or more interfaces from the left combo by using it. After that, the common
elements available to them (e.g. description, speed, inbound / outbound traffic, etc.) are going to
appear on the right. You're able to select one or more elements of this combo and click on 'Create
modules' to create these modules for each selected interface in the combo on the left.

13.10.6. MIB Study about External Tools and Integration in Pandora FMS
To conduct an analysis of the possible OIDs to utilize them in Pandora FMS, it's recommended to
use a MIB browser to analyze the MIB provided by each manufacturer. These MIB browsers are
screen tools that read, process, analyze and display the complete tree of each MIB's OID for the
user. They're allowing to search and understand which OIDs are necessary to monitor our devices.
We suggest to utilize the following MIB Management tools:
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•iReasoning
•Get-If

MIB Browser (Linux, Windows, Java): [3]

Free MIB Browser (Windows): [4]

•TKMib: For UNIX. It's incorporated in most of the GNU/Linux distributions by default.
The snapshots which are shown below have been done while working with the iReasoning tool.
On the first snapshot, you can see a request from a device with an MIB load ( MIB2 default) which
recognizes some of the existing OIDs. These OIDs are represented as strings or numeric values.
Pandora FMS is able to understand both, but it's only able to resolve the alphanumeric OIDs if it has
loaded the right MIB into the operating system. The best option (and also the best portable) is to
utilize numeric OIDs.

On the second snapshot, we can see the result of conducting a recursive 'walk' on a branch we don't
have MIBs for. It results in a serial of numeric OIDs which aren't useful at all, so we don't have the
slightest idea what they are for or which kind of data they might have to offer.

Apart from that, we can also accomplish that by using an MIB exploring tool. We can use OID
references by using the OID index (some manufacturers have MIB and OID references) or links
which store OIDs of interest. Other manufacturers of SNMP batteries tend to document their SNMP
records with natural language and are easy to understand. We're easily able to obtain the OIDs we
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need (the SNMP battery is in the UCDSNMP case, which is used by the majority of UNIX systems).
Lots of other SNMP batteries of other operating systems (like AIX or Windows) are also thoroughly
documented.
Recommended Links to work with SNMP
•Full OID Catalog for CISCO (extremadamente útil): [5]
•HP Printer MIB: [6]
•Nagios Exchange  SNMP [7]
•Algunos OID SNMP frecuentemente usados en routers: [8]

13.11. Common Advanced Features of Network Modules
The following screen shows the advanced features for the network module configuration:

Description
Module description. There is already a default description which we could change.
Custom ID
Customizable identifier which is necessary if you wish the server to send multicast messages with
information about agents. You can also use this field to integrate Pandora FMS data into an external
information system like a CMDB.
Interval
The module's execution interval. As shown in the example, it could be different from the agent's
interval.
Post Process
The module's post processing. It's useful to multiply or divide the returned value, e.g. when we
obtain bytes and we want to show the value in Megabytes.
Min. Value
The module's minimum value. Any value lower than the one defined here will be considered
'invalid' and ruled out.
Max. Value
The module's maximum value. Any value higher than the one defined here will be considered
'invalid' and ruled out.
270

Common Advanced Features of Network Modules

Export Target
It's useful to export the values returned by the module to an Export Server. It's available in the
Pandora FMS Enterprise Version only, and could come in pretty handy if we have configured an
export server in advance of this. If you'd like to know more about Export Servers, you can obtain the
information here.

Critical Instructions
Instructions for when the status changed to 'critical'.
Warning Instructions
Instructions for when the status changed to 'warning'.
Unknown Instructions
Instructions for when the status changed to 'unknown'.
CRON
If a cron is set up properly, the module interval is going to be ignored and runs on the specified date
and time.
Timeout
Time in seconds the agent is going to wait for the execution of the module.
Category
If you need to group or categorize modules, a category can be allocated here.

13.12. Windows Remote Monitoring with WMI
It's purpose is to remotely monitor a Windows system or system service through WMI. All queries
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have to be conducted in WQL, a Microsoftspecific SQL language for internal queries to the
operating system. You're able to conduct any query that is shown in the Microsoft database. There
are tools such as 'WMI Explorer' which allow to completely explore the WMI values tree. It could be
very useful to locate any WMI value of interest. The 'standard' Windows servers could have more
than 1,000 different queries, and with additional software and its own WMI sources, the number of
queries can even be increased further. It's not enough to have a repository of modules which are
specifically created for this  it's important to have the tools to find the information we consider the
most useful.
Working Snapshot from WMI Explorer under Windows

NOTE: To use the WMI monitor service, we first have to activate it in the configuration file of
Pandora (it's '/etc/pandora/pandora_server.conf') in the following way:
# wmiserver : '1' or '0'. Set to '1' to activate the WMI server in this setup.
# DISABLED BY DEFAULT
wmiserver 1

To start monitoring through WMI, we should create the corresponding agent to monitor the service
first. It's recommended to start from there.
Please klick on Manage agents in the administration section of the Pandora FMS console.
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In the following screen, klick on 'Create agent':

Please enter your new agent's data and klick on 'Create':

Once you've created the agent, klick on the upper flap of the modules ('Modules'). Please select
'create a new network module' in it and klick on 'Create':
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The necessary fields to remotely monitor the Windows system through WMI are shown in the
following form. You're required to fill out the necessary fields like in the example below:
Name
The module's name.
Type
The monitored data type.
Target
The remote system's IP to monitor.
Namespace
Space for WMI names. This field is different from 'empty string' by default and depends on the
information source of the application we intend to monitor.
Username
Name of the Administrator or any other user which possesses the privileges to remotely execute
WMI queries.
Password
Password for the Administrator or any given user.
WMI Query
WMI query. It's very similar to a sentence in SQL, e.g.:
SELECT LoadPercentage from Win32_Processor WHERE DeviceID = "CPU0"
SELECT SerialNumber FROM Win32_OperatingSystem
SELECT AvailableBytes from Win32_PerfRawData_PerfOS_Memory
SELECT DiskWriteBytesPersec from Win32_PerfRawData_PerfDisk_PhysicalDisk WHERE name = "_Total"

Key String
Optional field to compare the returned query with a string. In case it exists, the module is going to
return either '1' or '0' instead of the string itself.
Field Number
The number of the returned field, starting from '0' (the WMI queries are able to return more than
one field). Most of the time, the value is '0' or '1'.
Please fill out the required fields as shown below:
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The advanced options are the same as for all network modules. Please go to the network advanced
fields section if you need to obtain more information. Please keep in mind that the module bears the
agent's IP address which could be changed. Once you're finished defining the module, klick on
'Create'.
If you do not know the exact parameters, you're also able to select one of the preinstalled ones
included in the Pandora FMS Database. Please select the WMI module component for it:

After you've done that, please select a WMI check from one of the available ones:

The required information is filled in automatically, except for the user and it's password. Please
remember that only users with administration permissions and their passwords are valid
here. The module is also unable to return any value:

Once you have finished to configure the module, please click on Create. On the following screen, the
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modules for the agent including the added module Windows version is shown:

As you can see, there is a warning on the modules. The warning only means that no data has been
received yet, because it just has been created a few moments ago. Once the modules start to receive
any data, the warning disappears.
If you like to see the just created module data, please click on the upper flap named 'View'. Please
take a look at the bottom of the page where the data will be displayed, once they start to receive
any. and enter it

To examine the module's data type string, just klick on the top right flap named Data:

The Pandora FMS Enterprise version owns more than 400 WMI Remote Monitoring Modules for
Windows. They're available for the following devices and components:
•Active Directory
•BIOS
•System Information
•Windows Information
•Printers
•MSTDC
•IIS
•LDAP
•Microsoft Exchange
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13.12.1.1. WMI Wizard
Under the Agent Wizard feature shown on the picture below, there is a WMI wizard which is
intended to browse in and to create modules with WMI queries on a specified agent:

You're required to login as a user with administrator rights on the target host to conduct the first
WMI queries. This data is going to be used to create the WMI modules.

It's possible to create modules from various kinds of WMI data by the WMI Wizard:
•Services: Creates boolean monitors in 'normal' status if the service it's running and on
'critical' when it's stopped.
•Processes: The processes monitor is only going to receive any data if the process is active,
otherwise it's going to take the 'unknown' status.
•Free space on disk The available space on the harddrive.
•WMI components: You're able to choose from the WMI components registered on the
system (it's under 'Administration' > 'Manage modules' > 'Network components') by this
option.
Just select the kind of module and put the desired elements from the left combo to the right and
click on the 'Create modules' button.
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13.13. Monitoring with Plug Ins
Unlike with the rest of components, Pandora FMS doesn't include any preconfigured complement,
so you're required to create and configure a complement to be able to add it to the module of an
agent first. Pandora FMS includes plug ins in it's installation directories, but they are not configured
in the database by default.
To add a plugin which already exists to Pandora FMS, go to the console administration section, click
on 'Manage Servers' and on 'Manage Plug ins':

Once you are on the screen of the plugin management, please click on Add to add a new plug in:

Fill out the plugin creation form by the following data:
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Name
The name of the plugin, in this case 'NMAP'.
Plugin Type
There are two kinds of plug ins: The standard plug ins and the Nagios type. The standard plugins
are scripts which execute actions and accept parameters. The Nagios plug ins are intended to be
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used under Pandora FMS. The main difference between them is that the Nagios plugins return an
error level to show if a test has been successful or not.
If you want to use a plug in of the Nagios type and to obtain data, not a state (e.g. good or bad),
then you're also allowed to use a plug in of the Nagios type as 'standard'.
For the NMAP plugin example, we're required to select 'Standard'.
Max. Timeout
It's the expiration time of the plugin. If you don't receive a response within the specified time, it's
recommended to select the module as 'unknown', because then its value is not going to get updated.
It's a very important factor when implementing monitoring with plug ins. If the plug in execution
time is bigger than the specified value, we never would obtain data with it. This value is
recommended to always being higher than the time it (usually) takes to return a value of the script
or executable which is used as a plug in. In there is no preconfigured value, it's recommended to use
the same value which can be found underplugin_timeout in the configuration.
For our example, we're going to take the value of '15'.
Description
It's the plug in description. Just write a short description, e.g.: 'Test #9 of open UDP ports.' and if
possible, specify the complete interface parameters to e.g. help someone who is going to check the
plugin definition to know which parameters are going to get accepted afterwards.
Plugin Command
It is the path where the plugin command is located. If the installation has been of a standard type,
it's going to be located in the directory '/usr/share/pandora_server/util/plugin/' by default,
although it also could be any path of the system. In this case, it's recommended to use the path of
'/usr/share/pandora_server/util/plugin/udp_nmap_plugin.sh'.
The Pandora Server is going to execute this script, so it's of course required to have the appropriate
permissions to access and execute it.
Plugin parameters
A string with command parameters which are going to be executed after command execution and a
blank space. This parameter field accepts macros as '_field1_ _field2_ ... _fieldN_'.
Parameter Macros
It's possible to add unlimited macros to be used in the 'plugin parameters' field. These macros are
going to appear as regular text fields in the module configuration.
Each macro has 3 fields:
•Description: A short string describing the macro. It's the label near the field.
•Default value: The default value asigned to the field.
•Help: A text with a explanation of the macro.
An example of a macro configuration:
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An example of this macro in the module editor:

Internal Macros
Like the alerts, it's possible to use internal macros in the plug ins configuration, too.
The available macros are:
•_agent_: Complete agent's name which fired the alert.
•_agentdescription_: Description of the agent to which the module belongs to.
•_agentstatus_: Current status of the agent to which the module belongs to.
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•_address_: Address of the agent to which the module belongs to.
•_module_: The module's name.
•_modulegroup_: The module's group name.
•_moduledescription_: A description of the module.
•_modulestatus_: The status of the module.
•_moduletags_: The module's associated tags.
•_id_agent_: The ID of the agent. It's quite useful to generate a direct URL to redirect to a
Pandora FMS console webpage.
•_policy_: The name of the policy the module belongs to (if that applies).
•_interval_: The execution interval of the module.
•_target_ip_: The target IP address of the module.
•_target_port_: The target port number of the module.
•_plugin_parameters_: The plugin parameters of the module.
•_email_tag_: The emails associated to module tags.
After the configuration, please click on 'Create' and check if the plugin has been correctly created.

The plugin code could be seen in the given address:
#!/bin/bash
# This is called like -p xxx -t xxxx
HOST=$4
PORT=$2
nmap -T5 -p $PORT -sU $HOST | grep open | wc -l

That basically joins the commands and parameters, replacing the macros by their values to execute
a quick UDP (sU) NMAP (T5) and that has (wc_l) the open ports quantity (grep open).
Once that the plugin has been created to use it on an agent, it's recommended to create an agent in
case you haven't done this before. Just click on Manage agents In the Pandora FMS console
administration section:
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On the following screen, please click on Create agent:

Fill out the data for your new agent and click on Create agent:

Once you have created the agent, click on the modules upper flag (Modules). Just select 'create a
new plugin module' and click on Create in it:
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In the following form, fill in the blank fields, select the module type 'Generic module to aquire
numeric data', specify the IP address and the port to which to conduct the analysis against:

Once you have finished this, just click on 'Create'.
On the following screen the modules including the NMAP module for the agent will be shown:

As you can see, there is a warning attached to the modules. The warning only means that no data in
the module has been received yet, because they've just been created a few moments ago. Once they
start to receive any data, the warning is going to disappear.
To see the data of the just created module, please click on the upper flap named 'View'. Look at the
bottom of the page, where the data is going to be shown once they start to receive any.
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To see the data type of the modules, please go to the top right flap named 'Data'.

13.13.1. Example 1  Plugin Module for MySQL
This is another more complex example on how to implement a plugin. It's another plugin that
comes by default with Pandora FMS. In this case, it's the MySQL check plugin.
First, create a plugin module ('Administration' > 'Manage Servers' > 'Manage plug ins') for MySQL
by using the following data:
•Name: MySQL
•Plugin type: Standard
•Max. timeout: 10 seconds
•Description: MySQL check plugin
Checks:
This plugin provides four checks:
Connections: Connections Com_select: Number of select queries from start Com_update: Number of
update queries from start Innodb_rows_read: Innodb files readings
•Plugin command: /usr/share/pandora_server/util/plugin/mysql_plugin.sh
•Plugin parameters: s _field1_ u _field2_ p _field3_ q _field4_
•Macro _field1_:
•Description: IP Address
•Default value: X.X.X.X
•Macro _field1_:
•Description: User
•Default value: User
•Macro _field1_:
•Description: Password
•Default value: Password
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•Macro _field1_:
•Description: Check
•Default value: Connections
•Help: Possible values: Connections/Com_select/Com_update/Innodb_rows_read
When it's ready, the plugin is going to look like this:
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This plug in provides four checks:
•Connections: Connections
•Com_select: Number of select queries from start
•Com_update: Number of update queries from start
•Innodb_rows_read: Innodb file readings
Please create a module in the system agent where Pandora FMS is installed and assign it. Its name
is going to be MySQL Connections, using itself as a complement (MySQL), localhost for IP, 'user' as a
username and 'pass' as a password (which serves as the Pandora database password in this
example).
After it's creation, the module has to look like this:
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Once you have created it, it will be located directly beneath the NMAP module:

The information on the main page (just klick on the 'View' tab) is supposed to look like this:

The detailed information (just klick on the 'Data' tab) should look like this:

13.13.2. Example 2 SMTP Server Remote Plug In
From version 4.0.2 and above, this plug in is included by default. If you are using an older version,
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you can download and install it from the Pandora FMS Module Library here.
This plug in sends an email by using a remote server to do so. You're able to specify the server IP,
port, user name, password and authentication scheme, email destination and destination. It returns
the value of '1' if it works properly and '0' if not. The plug in is also required to be of the
'generic_proc' type.
This is a screen shot of the module definition using this plug in:

13.13.3. Example 3  DNS Server Remote Plug In

From version 4.0.2 and above, this plug in is included by default. If you are using an
older version, you can download and install it from the Pandora FMS Module
Library here.
This plug in checks the IP address of a specified domain (eg artica.es). This is a fixed IP, using an
external DNS as reference. You're able to validate whether the domain is returning the correct IP
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address to avoid unnecessary balancing, DNS attacks, etc. in this way. It returns the value of '1' if it
works properly and '0' if not. The plugin is required to be of the 'generic_proc' type.
This is a screen shot of the module definition using this plug in:

13.13.4. Example 4  UDP Port Remote Plug In

From version 4.0.2 and above, this plug in is included by default. If you are using an
older version, you may download and install it from the Pandora FMS Module
Library here.
This plug in checks for a specified address and a UDP port. It returns the value of '1' if it works
properly and '0' if not. The plugin is required to be of the 'generic_proc' type.
This is a screen shot of the module definition using this plug in:
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13.14. Intensive monitoring
A remote module (whether it is a network module, a plugin module etc.) may return unreliable
data due to different reasons. For example, a ping module may return 0 even when a host is up
because of network congestion.
Depending on how Pandora FMS is configured this may trigger a series of undesired events
(changed statuses, fired alerts, sent emails...).
To deal with this situation Pandora FMS provides custom FF thresholds for each module. The FF
threshold is the number of additional times that a module is executed before changing its status (a
value of 0 means this feature is disabled). Only if the status change condition is held for all of the
retries will the module’s status be changed.
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The interval of these additional executions can be specified with the FF interval.

This is better seen with an example: Let’s suppose we have a WMI module that returns the amount
of free hard disk space in megabytes. We configure this module to become critical when this value is
lower that 100. Then we create an alert that sends an email to the sysadmin when this module
becomes critical so that he can free up some space. But, due to a software bug, every now and then
the value returned is much lower than the actual one. To get around this issue, we set the module’s
FF threshold to 1 and the FF interval to 30 seconds. This means the first time the module receives a
value lower than 100, the module will be executed again 30 seconds later, and only if it is still
lower than 100 will the module’s status be changed to critical. Otherwise the module resumes
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normal execution.
This works well for synchronous modules, but asynchronous modules need an additional
configuration parameter. Since they do not send data at regular intervals, checking for consecutive
values may not be that useful if they are far away in time. In this case, and FF timeout needs to be
specified. This means the number of consecutive values must occur within the configured time
interval.

Starting from version 5.1, individual FF thresholds can be configured for each module status, so
that a module may require two consecutive values to become critical, but just one to become
normal, for example.
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14 REMOTE MONITORING
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14.1. Introduction
The Pandora FMS Network Server is an essential piece of Pandora FMS, because it
allows to conduct remote tests from a central point. The Data Server and the Network
Server are conducting the tasks assigned to them through a multiprocess queue
system. A network server can also work with other network servers, balance the load
and act as a support device in case another network server fails, conducting the work
the failing server was supposed to do. If you like to know more about High
Availability (HA) under Pandora FMS, please take a look at the chapter about it.
Our Network Servers only work with assigned network modules. Because there are network tests to
perform, the Network Server should of course have a complete visibility (IP adresses and ports) over
the devices we're going to perform the tests on. It's completely futile to perform tests against a
system with ports which can't be seen or for which we don't have the proper paths for. The
existence of firewalls (or the problems generated though the existence of these kinds of devices) or
preexisting paths in the network have nothing to do with Pandora FMS or with a specific
configuration of it.

14.2. Remote Network Modules
The Pandora FMS Network Modules conduct remote monitoring tasks. The remote execution of
tasks can be summarized in three blocks:
ICMP Tests
These tests consist of whether a machine answers to a 'ping' ('remote_icmp_proc') or the latency of
a system in milliseconds ('remote_icmp'). In both cases, the tests are conducted by the network
server to which the agent which contains these network modules were assigned.
TCP Tests
In this test, we're going to remotely check if a system has opened the TCP port which was specified
in the module definition. Additionally, a text string can be sent (using the string '^M' to replace the
'CR'). By receiving a response sub string, you're able to check if the communication is alright. This
method allows to implement easy protocol checks. We could e.g. check if a server is 'alive' by
sending the following string:
GET / HTTP/1.0^M^M
We suggest to just wait a moment to be able to receive the '200 OK' string here.
SNMP Tests
It's possible to launch SNMP petitions remotely (called 'SNMP Polling') which are accessible and
have activated SNMP services to obtain data like: 'state of the interfaces' and 'consumed network
bandwidth by interface', etc. If you like to know more about SNMP, please consult the section for
SNMP with Pandora FMS here.
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In conclusion it's quite obvious that the network server is the one which conducts the different
network tests assigned to each agent. Each agent is assigned to a Network Server  and it's this
Network Server which executes the task and transfers the results to the DB of Pandora FMS.

14.3. General Configuration of a Module for Network Monitoring
To remotely monitor any kind of equipment or an equipment service (FTP, SSH, etc.), you're
required to create the corresponding agent to monitor the service first.
Please go to the Pandora FMS section for console administration and klick on 'Manage agents':

In the following screen, please klick on 'Create agent':
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Please enter the proper data to define your new agent and klick on 'Create':

Once you have created the agent, please klick on the drop down menu of the modules. Please select
'Create a new network module' in it and klick on the 'Create' button:

Please select a network component module in the following form: Look for the check you need in
the dropdown menu on the right. In this example, we've selected 'Host Alive' which represents a
ping for the machine. It's a simple check for being able to tell if the machine is connected to the
internet or not.
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We're going to leave the advanced options for later. Make sure the modules have obtained the
agent's IP address. You're also able to enter a different IP address here. Once you have finished to
define the module, press the Create button.
In the following screen, all modules for the agent are shown. On the picture below, you can see the
pre set 'Agent_keepAlive' (which was created along with the agent) and the module 'Host Alive'
added:

As you can see, there is a warning attached to the modules. The warning only means that no data
has been received by the module yet, because it's just been added a few moments ago. Once the
modules begin to receive any data, the warning disappears.
To see the data from the newly created module, just klick on the 'view' button on the top right and
look at the bottom where the data is going to appear if it starts to receive anything:
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To perform another kind of network check, we suggest to proceed exactly as described above, but
with a different kind of module.

14.4. ICMP Monitoring
The previous example was one of ICMP monitoring. These are the more basic and simple checks
which give us important and precise information. There are two kinds of ICMP checks:
•icmp_proc, host (ping) check which allows to come to know if an IP address responds or
not.
•icmp_data or latency check. Basically, it informs us about the time which the IP address
requires for answering a basic ICMP consult in milliseconds.

14.5. TCP Monitoring
The TCP check allows to check the state of a port or a TCP service.
There are two specific fields for TCP tests:
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By default, the TCP check is simply a test for whether the destination port is open or not. You're also
able to send a text string and wait to receive something which will be processed directly as data.
It's possible to send a text string (using the «^M» string to replace the CR) and to wait if you're
going to receive an answer substring to check whether the communication is functioning properly
or not. This allows to implement simple protocol checks. If you want to e.g. check whether a server
is alive or not, you may send the following string:
GET / HTTP/1.0^M^M

Then just wait to receive the string:
200 OK

This string is coded in 'TCP send' and 'TCP receive' fields.
TCP send
It's the field to configure the parameters intended to be sent to the TCP port. It accepts the '^M'
string as a replacement for the sending of a CR. To send several strings in a row in a send/response
manner, you're required to separate them by the character:
TCP receive
It's the field to configure the text strings which we expect to receive on the TCP connection. If they
send/receive in several steps, each step should be separated by the '|' (pipe) character.
By means of the Pandora FMS TCP check, you're able to perform more things than just to inspect
whether a port is open or waiting for an answer from a simple request or not. It's possible to send
data, waiting to receive something, to send something afterwards, waiting to send something. Only
if all the processes are conducted in the right way, we're able to validate the results.
To use the Pandora FMS Dialog and Response Checking System, you may separate the different
petitions by the | ('pipe') character.
This is an example of a SMTP conversation:
R: 220 mail.supersmtp.com Blah blah blah
S:
R:
S:
R:
S:
R:
S:
R:
S:
S:
R:
S:
R:

HELO myhostname.com
250 myhostname.com
MAIL FROM:
250 OK
RCPT TO:
250 OK
DATA
354 Start mail input; end with .
.......your mail here........
.
250 OK
QUIT
221 mail.supersmtp.com Service closing blah blah blah

If you e.g. want to check the first protocol points, the necessary fields to emulate this conversation
would be:
TCP Send
HELO myhostname.com^M|MAIL FROM: ^M| RCPT TO: ^M

TCP Receive
250|250|250
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If the three first steps are OK (code 250), then the SMTP is working properly. You're not required to
send a complete mail here (but you could, in any case). This allows to perform protocolbased TCP
checks which could be used for any protocol which utilizes plain text conversations.

14.6. SNMP Monitoring
14.6.1. Introduction to SNMP Monitoring
When we talk about the SNMP monitoring, the most important thing in the beginning is to separate
the testing concepts (polling) and the traps. The SNMP testing implies to order Pandora to conduct
a 'snmpget' command against a SNMP device such as a router or a switch (or even a computer with
an installed SNMP agent). This is a synchronous operation (every X seconds). Receiving an SNMP
trap, on the other hand, is an asynchronous operation (that could or couldn't happen in a million
years). It's commonly used to receive 'alerts' coming from a device, e.g. if a switch knocks down a
port or its fan is too hot.
To use the SNMP monitoring test, you're only required to add a SNMP module under Pandora
which creates a new network module. The majority or the SNMP items which report data in the
incremental way ('generic_data_inc'), e.g. when it asks for a value, it reports the 'global' quantity of
information, if a total of bytes gets collected from the moment the device starts. This would be
necessary to extract the last quantity of bytes known from the one which is working and gets
divided by the seconds from the last known data. This dividing is going to provide the required data
for displaying 'bytes per second' display. This operation is done with Pandora using generic data inc.
Using the SNMP Traps is something completely different. It's possible to receive traps from any
device without the necessity of configuring anything (except the SNMP console). If a trap gets
received, it's going to appear on the SNMP console.
It is possible to define an alert, based on OID (the code that identifies a trap, something similar to
3.4.1.1.4.5.24.2), in a IP agent or in a custom data (data that could be in the trap). It is also possible
to order Pandora that it copies the information in an special text module in the agent. If the agent is
defined, this operation is called SNMP Traps transfer.
Pandora FMS is able to work in conjunction with any device that supports SNMP. It currently works
with SNMP versions 1, 2, 2c and 3.
Pandora FMS works with SNMP using individual OIDs, where each OID is a network module for it.
If we want to monitor e.g. a 24port 'Cisco Catalyst' switch and to learn the operating system and
the entry and exit port, we're required to define a total of 72 modules (24 x 3).
To work with SNMP devices, you're required to know the following:
•What

the SNMP Protocol is and how it works. The published RFC3411 from
the IETF describes it in detail here: https://www.ietf.org/rfc/rfc3411.txt
•The IP and the SNMP community of the remote device.
•To activate the device's SNMP management so we're able to perform SNMP queries from
the network server.
•The specific OID of the remote device which we want to check.
•How to manage the data that's going to get returned by the device. The SNMP devices
usually return data in different formats.
This network server should be the one assigned for the agent if we're going to define the network
modules. You also need to keep in mind that, if we want other network servers to do queries (in
case the assigned server fails), they're going to perform the queries with other IP addresses.
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Pandora FMS could manage almost all of them, except the 'timetick' that gets managed as a numeric
format without converting it to date / hour. Pandora FMS manages counters of the 'data' kind as
'remote_snmp_inc'. They are of special importance, as they are counters which can't be considered
numeric data. The majority of the SNMP statistical data are of the 'counter' kind and it's necessary
to configure them as 'remote_snmp_inc' if we want to monitor them properly.

14.6.2. SNMP Monitoring from Agents
Since version 3.2, it's possible to get SNMP information which is available under the Windows
Agent. Under UNIX or Linux, 'snmpget' is usually available, so it could be retrieved automatically.
Under Windows systems, an external utility is necessary which isn't always easy to obtain or to
install.
We have added the utility 'snmpget.exe' to the Windows agent by default (which is part of the 'net
snmp' project and comes with BSD license). We've also added the basic 'MIBs' and a wrapper /
script to wrap the call into the 'snmpget.exe' utility.
Using this call, we're able to monitor SNMP from an agent, obtaining information from any remote
system to which the agent has access to, so we're able to work as a 'satellite agent' or 'proxy agent'
(just as the manual says).
Under Windows, the syntax for the execution is:
module_exec getsnmp.bat <comunidad_SNMP> <ip de destino> <OID>
Some examples of SNMP modules executed by Windows agents are:
module_begin
module_name SNMP_if3_in
module_type generic_data_inc
module_exec getsnmp.bat public 192.168.55.1 .1.3.6.1.2.1.2.2.1.10.3
module_end
module_begin
module_name SNMP_if3_desc
module_type generic_data_string
module_exec getsnmp.bat public 192.168.55.1 IF-MIB::ifDescr.3
module_end
module_begin
module_name SNMP_Sysup
module_type generic_data
module_exec getsnmp.bat public 192.168.55.1 DISMAN-EVENT-MIB::sysUpTimeInstance
module_end

The same examples, executed under UNIX agents:
module_begin
module_name SNMP_if3_in
module_type generic_data_inc
module_exec snmpget -v 1 -c public 192.168.55.1 .1.3.6.1.2.1.2.2.1.10.3
module_end
module_begin
module_name SNMP_Sysup
module_type generic_data
module_exec snmpget -v 1 -c public 192.168.55.1 DISMAN-EVENT-MIB::sysUpTimeInstance
module_end

It's important to remember that only the 'basic' OIDs are translatables for their numerical
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equivalent. It's advisable to always use numerical OIDs, because we don't know if the tool would
otherwise be able to translate it or not. In any case, the MIBs can always be obtained in the
'/util/mibs' directory under Windows or in '/usr/share/snmp/mibs' under Linux.

14.6.3. Monitoring by Network Modules with SNMP
For being able to monitor any element through SNMP, we should at least know its IP and its SNMP
community. It would also be quite important to know the OID which we want to monitor, although
we could obtain it by means of an SNMP Walk as long as we know where each OID comes from. To
monitor an element through SNMP, you first have to create an agent for it. If you already have one,
simply add a new network module and follow the previous instructions.
Once the module has been created, you should select a SNMP data type in the configuration module
form just like the ones shown on the image:

Any of the three SNMP data types are valid. Simply select the one which coincides with the type of
data that you want to monitor.
Once you have selected a SNMP data type, the form is going to expand, showing additional fields
for SNMP like the following:

Next, you're required to define the fields:
SNMP community
The SNMP community is necessary to monitor the element. It acts as a password.
SNMP version
The SNMP protocol version of the device. It could be 1, 2, 2c or 3.
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SNMP OID
The OID identifier to monitor. They can consist of numeric values. The alphanumeric values are
internally transformed into numeric values by the system (which are the ones used to do the
petition) by means of a dictionary called MIB.
An alphanumeric OID can be similar to this one:
iso.org.dod.internet.private.transition.products.chassis.card.slotCps.cpsSlotSummary.cpsModuleTab
le.cpsModuleEntry.cpsModuleModel.3562.3

The numeric equivalent would be something like this:
1.3.6.1.4.868.2.4.1.2.1.1.1.3.3562.3

Without the MIB, the alphanumeric format is invalid. Installing an MIB on the system is not a trivial
thing, so it's recommended to work with numeric identifiers directly, although it's a little more
cryptic. The above shown is much more portable and it also doesn't create any problems for you,
because it doesn't require MIBs.
Pandora FMS includes some OIDs in its database which could be used directly. If you are going to
create the module, select the 'Cisco MIBs' component to show a list of the available MIBs for Cisco
devices:

Once you have selected the proper component, you're able to pick the available MIB for it:
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By doing this, the fields will be filled out by the necessary information.
There are more MIBs included in Pandora FMS. With an Enterprise Version, there are several
included MIB packages for different devices. Once you have introduced the data, please klick on
the Create button.
To see the data of the module which has been just created, just klick on the upper flap
named View and take a look at the bottom of the page, where the data is going to be shown once it
starts to receive any.

To see the text string kind data of the modules from the system description example, please go to
the upper right flap named Data.
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The data received by the SNMP system description data modules are pointed out in red.

14.6.4. Pandora FMS SNMP MIB Browser
From Pandora FMS 5.0 and above, you possess a complete SNMP MIB browser included in the
Pandora FMS console. This feature is also available in the open source version. It doesn't require
any additional software like java plugins or Flash. It's purely based on JavaScript and HTML code.
On the back end, it uses 'netsnmp', which is a Linux based SNMP system and a dependency for the
Pandora FMS console installation. It's required to be installed.
You can access the SNMP browser from the SNMP menu. At this point, it only supports SNMP v1.
First of all, you need to understand that Pandora FMS performs a full scan of the target device's
SNMP tree, so if the device has a huge OID database (like a modern switch with lots of ports). This
operation can take several minutes. You're also able to choose to explore a single subtree and save
quite some time in this way.
You may use this OID to e.g. only obtain information on the 'Enterprise' subtree for a Cisco device:
.1.3.6.1.4.1.9

The browser is used to navigate, which means that clicking on each tree and sub tree to arrive at
the last piece of information on the branch, which is a sole OID with a single value. You're going to
see an 'eye' icon and if you click on it, you're going to get the value of the OID. The system will try
to locate the description and humanreadable OID translation if the MIB for that branch is available.
If you don't have an MIB available, the only thing you're able to see is the numerical OID
information, value and data type.
The descriptive information is stored in MIB files. If you like to know more on this topic, please
follow this link [1]. If you don't have an MIB for the device you intend to browse, you probably
have to 'dig search' in the values  which is pretty complex and takes a lot of time.
The Pandora FMS SNMP MIB Browser allows you to search for a text string or numerical value in
the OID's values and also the translated OID's (if available). It could be very helpful to be able to
search for known values to identify the matching OID value. If there are several matches, you're
able to browse in them. You're going to get the matches displayed in an easily identifiable yellow
colour.
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14.6.4.1. MIBs Management
You can upload and manage Pandora FMS managed MIBs. You can add new MIBs or delete some.
These MIBs are ONLY going to be used by Pandora FMS, which is also going to utilize the system
MIBs
(the
ones
in
'/usr/share/snmp/mibs').
Pandora
FMS
uses
the
path
'{PANDORA_CONSOLE}/attachment/mibs' to store the MIB files.

To avoid confusion between the 'trap' MIBs and the polling MIBs: This manager is for polling MIBs.
The SNMP Traps Monitoring is discussed in a different section and is only available in Enterprise
Versions.
There are many prepackaged collections of MIBs. One of the best available is on the Getif website.
It's one of the best free SNMP browsers for Windows [2].
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14.6.4.2. SNMP Browser on Module Creation
You may use the SNMP browser from the network module creator / editor section by clicking on the
'SNMP Walk' button. That's going to open a floating window, which is going to display the SNMP
tree of the device (if you've put the IP and SNMP community there). Once you locate the OID you
want (by clicking on the hand icon), that OID information will be copied to the module definition to
be used under Pandora FMS.

14.6.5. Pandora FMS SNMP Wizard
In the agent management view, there is a set of tools specifically created to remotely create
modules: The Agent Wizard.
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Some of these tools utilize SNMP to explore the host data and to put it into a form combo. With a
few steps, it's possible to create dozens of customized modules in this way.

14.6.5.1. SNMP Wizard

You're required to set up the IP target, the community and other desired parameters (SNMP v3 is
supported) to make an SNMPWalk to the host.

Once the data is correctly retrieved, a form for module creation is going to appear:

309

SNMP Monitoring

It's possible to create modules from the following kinds of SNMP data by the SNMP Wizard:
•Devices
•Processes
•Free Space on Harddrives
•Temperature Sensors
•Other SNMP Data
You may select the kind of module and put the desired elements from the left combo to the right
one. When you've completed this process, please click on the 'Create modules' button.
This wizard is going to create two kinds of modules:
•SNMP Modules for the data with a static OID (sensors, memory data, CPU data, etc.).
•Plugin Modules for the data with dynamic OID or calculated data (processes, disk
space, used memory in percentage, etc).

We're going to use the SNMP remote plug in for all plug-in modules. If this plugin isn't
installed on the system, these features are not going to be available. The plugin has to be
named 'snmp_remote.pl', but the path where it's going to be placed doesn't matter at all.

14.6.5.2. SNMP Interface Wizard
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In the Agent Wizard, there is an SNMP wizard specifically created for browsing interfaces.
This Wizard browses the SNMP branch IFMIB::interfaces, offering the possibility of creating
multiple modules of various interfaces with multiple selections.
Like the SNMP Wizard (after selecting the IP target, community, etc.), the system conducts an
SNMP query on the host and it's going to fill out the module creation form.
You're able to select one or more interfaces from the left combo by using it. After that, the common
elements available to them (e.g. description, speed, inbound / outbound traffic, etc.) are going to
appear on the right. You're able to select one or more elements of this combo and click on 'Create
modules' to create these modules for each selected interface in the combo on the left.

14.6.6. MIB Study about External Tools and Integration in Pandora FMS
To conduct an analysis of the possible OIDs to utilize them in Pandora FMS, it's recommended to
use a MIB browser to analyze the MIB provided by each manufacturer. These MIB browsers are
screen tools that read, process, analyze and display the complete tree of each MIB's OID for the
user. They're allowing to search and understand which OIDs are necessary to monitor our devices.
We suggest to utilize the following MIB Management tools:
•iReasoning

MIB Browser (Linux, Windows, Java): [3]
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•Get-If

Free MIB Browser (Windows): [4]

•TKMib: For UNIX. It's incorporated in most of the GNU/Linux distributions by default.
The snapshots which are shown below have been done while working with the iReasoning tool.
On the first snapshot, you can see a request from a device with an MIB load ( MIB2 default) which
recognizes some of the existing OIDs. These OIDs are represented as strings or numeric values.
Pandora FMS is able to understand both, but it's only able to resolve the alphanumeric OIDs if it has
loaded the right MIB into the operating system. The best option (and also the best portable) is to
utilize numeric OIDs.

On the second snapshot, we can see the result of conducting a recursive 'walk' on a branch we don't
have MIBs for. It results in a serial of numeric OIDs which aren't useful at all, so we don't have the
slightest idea what they are for or which kind of data they might have to offer.

Apart from that, we can also accomplish that by using an MIB exploring tool. We can use OID
references by using the OID index (some manufacturers have MIB and OID references) or links
which store OIDs of interest. Other manufacturers of SNMP batteries tend to document their SNMP
records with natural language and are easy to understand. We're easily able to obtain the OIDs we
need (the SNMP battery is in the UCDSNMP case, which is used by the majority of UNIX systems).
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Lots of other SNMP batteries of other operating systems (like AIX or Windows) are also thoroughly
documented.
Recommended Links to work with SNMP
•Full OID Catalog for CISCO (extremadamente útil): [5]
•HP Printer MIB: [6]
•Nagios Exchange  SNMP [7]
•Algunos OID SNMP frecuentemente usados en routers: [8]

14.7. Common Advanced Features of Network Modules
The following screen shows the advanced features for the network module configuration:

Description
Module description. There is already a default description which we could change.
Custom ID
Customizable identifier which is necessary if you wish the server to send multicast messages with
information about agents. You can also use this field to integrate Pandora FMS data into an external
information system like a CMDB.
Interval
The module's execution interval. As shown in the example, it could be different from the agent's
interval.
Post Process
The module's post processing. It's useful to multiply or divide the returned value, e.g. when we
obtain bytes and we want to show the value in Megabytes.
Min. Value
The module's minimum value. Any value lower than the one defined here will be considered
'invalid' and ruled out.
Max. Value
The module's maximum value. Any value higher than the one defined here will be considered
'invalid' and ruled out.
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Export Target

It's useful to export the values returned by the module to an Export Server. It's
available in the Pandora FMS Enterprise Version only, and could come in pretty
handy if we have configured an export server in advance of this. If you'd like to know
more about Export Servers, you can obtain the information here.

Critical Instructions
Instructions for when the status changed to 'critical'.
Warning Instructions
Instructions for when the status changed to 'warning'.
Unknown Instructions
Instructions for when the status changed to 'unknown'.
CRON
If a cron is set up properly, the module interval is going to be ignored and runs on the specified date
and time.
Timeout
Time in seconds the agent is going to wait for the execution of the module.
Category
If you need to group or categorize modules, a category can be allocated here.
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14.8. Windows Remote Monitoring with WMI
It's purpose is to remotely monitor a Windows system or system service through WMI. All queries
have to be conducted in WQL, a Microsoftspecific SQL language for internal queries to the
operating system. You're able to conduct any query that is shown in the Microsoft database. There
are tools such as 'WMI Explorer' which allow to completely explore the WMI values tree. It could be
very useful to locate any WMI value of interest. The 'standard' Windows servers could have more
than 1,000 different queries, and with additional software and its own WMI sources, the number of
queries can even be increased further. It's not enough to have a repository of modules which are
specifically created for this  it's important to have the tools to find the information we consider the
most useful.
Working Snapshot from WMI Explorer under Windows

NOTE: To use the WMI monitor service, we first have to activate it in the configuration file of
Pandora (it's '/etc/pandora/pandora_server.conf') in the following way:
# wmiserver : '1' or '0'. Set to '1' to activate the WMI server in this setup.
# DISABLED BY DEFAULT
wmiserver 1

To start monitoring through WMI, we should create the corresponding agent to monitor the service
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first. It's recommended to start from there.
Please klick on Manage agents in the administration section of the Pandora FMS console.

In the following screen, klick on 'Create agent':

Please enter your new agent's data and klick on 'Create':

Once you've created the agent, klick on the upper flap of the modules ('Modules'). Please select
'create a new network module' in it and klick on 'Create':
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The necessary fields to remotely monitor the Windows system through WMI are shown in the
following form. You're required to fill out the necessary fields like in the example below:
Name
The module's name.
Type
The monitored data type.
Target
The remote system's IP to monitor.
Namespace
Space for WMI names. This field is different from 'empty string' by default and depends on the
information source of the application we intend to monitor.
Username
Name of the Administrator or any other user which possesses the privileges to remotely execute
WMI queries.
Password
Password for the Administrator or any given user.
WMI Query
WMI query. It's very similar to a sentence in SQL, e.g.:
SELECT LoadPercentage from Win32_Processor WHERE DeviceID = "CPU0"
SELECT SerialNumber FROM Win32_OperatingSystem
SELECT AvailableBytes from Win32_PerfRawData_PerfOS_Memory
SELECT DiskWriteBytesPersec from Win32_PerfRawData_PerfDisk_PhysicalDisk WHERE name = "_Total"

Key String
Optional field to compare the returned query with a string. In case it exists, the module is going to
return either '1' or '0' instead of the string itself.
Field Number
The number of the returned field, starting from '0' (the WMI queries are able to return more than
one field). Most of the time, the value is '0' or '1'.
Please fill out the required fields as shown below:
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The advanced options are the same as for all network modules. Please go to the network advanced
fields section if you need to obtain more information. Please keep in mind that the module bears the
agent's IP address which could be changed. Once you're finished defining the module, klick on
'Create'.
If you do not know the exact parameters, you're also able to select one of the preinstalled ones
included in the Pandora FMS Database. Please select the WMI module component for it:

After you've done that, please select a WMI check from one of the available ones:

The required information is filled in automatically, except for the user and it's password. Please
remember that only users with administration permissions and their passwords are valid
here. The module is also unable to return any value:

Once you have finished to configure the module, please click on Create. On the following screen, the
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modules for the agent including the added module Windows version is shown:

As you can see, there is a warning on the modules. The warning only means that no data has been
received yet, because it just has been created a few moments ago. Once the modules start to receive
any data, the warning disappears.
If you like to see the just created module data, please click on the upper flap named 'View'. Please
take a look at the bottom of the page where the data will be displayed, once they start to receive
any. and enter it

To examine the module's data type string, just klick on the top right flap named Data:

The Pandora FMS Enterprise version owns more than 400 WMI Remote Monitoring Modules for
Windows. They're available for the following devices and components:
•Active Directory
•BIOS
•System Information
•Windows Information
•Printers
•MSTDC
•IIS
•LDAP
•Microsoft Exchange
WMI Wizard
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Under the Agent Wizard feature shown on the picture below, there is a WMI wizard which is
intended to browse in and to create modules with WMI queries on a specified agent:

You're required to login as a user with administrator rights on the target host to conduct the first
WMI queries. This data is going to be used to create the WMI modules.

It's possible to create modules from various kinds of WMI data by the WMI Wizard:
•Services: Creates boolean monitors in 'normal' status if the service it's running and on
'critical' when it's stopped.
•Processes: The processes monitor is only going to receive any data if the process is active,
otherwise it's going to take the 'unknown' status.
•Free space on disk The available space on the harddrive.
•WMI components: You're able to choose from the WMI components registered on the
system (it's under 'Administration' > 'Manage modules' > 'Network components') by this
option.
Just select the kind of module and put the desired elements from the left combo to the right and
click on the 'Create modules' button.
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14.9. Monitoring with Plug Ins
Unlike with the rest of components, Pandora FMS doesn't include any preconfigured complement,
so you're required to create and configure a complement to be able to add it to the module of an
agent first. Pandora FMS includes plug ins in it's installation directories, but they are not configured
in the database by default.
To add a plugin which already exists to Pandora FMS, go to the console administration section, click
on 'Manage Servers' and on 'Manage Plug ins':

Once you are on the screen of the plugin management, please click on Add to add a new plug in:

Fill out the plugin creation form by the following data:
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Name
The name of the plugin, in this case 'NMAP'.
Plugin Type
There are two kinds of plug ins: The standard plug ins and the Nagios type. The standard plugins
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are scripts which execute actions and accept parameters. The Nagios plug ins are intended to be
used under Pandora FMS. The main difference between them is that the Nagios plugins return an
error level to show if a test has been successful or not.
If you want to use a plug in of the Nagios type and to obtain data, not a state (e.g. good or bad),
then you're also allowed to use a plug in of the Nagios type as 'standard'.
For the NMAP plugin example, we're required to select 'Standard'.
Max. Timeout
It's the expiration time of the plugin. If you don't receive a response within the specified time, it's
recommended to select the module as 'unknown', because then its value is not going to get updated.
It's a very important factor when implementing monitoring with plug ins. If the plug in execution
time is bigger than the specified value, we never would obtain data with it. This value is
recommended to always being higher than the time it (usually) takes to return a value of the script
or executable which is used as a plug in. In there is no preconfigured value, it's recommended to use
the same value which can be found underplugin_timeout in the configuration.
For our example, we're going to take the value of '15'.
Description
It's the plug in description. Just write a short description, e.g.: 'Test #9 of open UDP ports.' and if
possible, specify the complete interface parameters to e.g. help someone who is going to check the
plugin definition to know which parameters are going to get accepted afterwards.
Plugin Command
It is the path where the plugin command is located. If the installation has been of a standard type,
it's going to be located in the directory '/usr/share/pandora_server/util/plugin/' by default,
although it also could be any path of the system. In this case, it's recommended to use the path of
'/usr/share/pandora_server/util/plugin/udp_nmap_plugin.sh'.
The Pandora Server is going to execute this script, so it's of course required to have the appropriate
permissions to access and execute it.
Plugin parameters
A string with command parameters which are going to be executed after command execution and a
blank space. This parameter field accepts macros as '_field1_ _field2_ ... _fieldN_'.
Parameter Macros
It's possible to add unlimited macros to be used in the 'plugin parameters' field. These macros are
going to appear as regular text fields in the module configuration.
Each macro has 3 fields:
•Description: A short string describing the macro. It's the label near the field.
•Default value: The default value asigned to the field.
•Help: A text with a explanation of the macro.
An example of a macro configuration:
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An example of this macro in the module editor:

Internal Macros
Like the alerts, it's possible to use internal macros in the plug ins configuration, too.
The available macros are:
•_agent_: Complete agent's name which fired the alert.
•_agentdescription_: Description of the agent to which the module belongs to.
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•_agentstatus_: Current status of the agent to which the module belongs to.
•_address_: Address of the agent to which the module belongs to.
•_module_: The module's name.
•_modulegroup_: The module's group name.
•_moduledescription_: A description of the module.
•_modulestatus_: The status of the module.
•_moduletags_: The module's associated tags.
•_id_agent_: The ID of the agent. It's quite useful to generate a direct URL to redirect to a
Pandora FMS console webpage.
•_policy_: The name of the policy the module belongs to (if that applies).
•_interval_: The execution interval of the module.
•_target_ip_: The target IP address of the module.
•_target_port_: The target port number of the module.
•_plugin_parameters_: The plugin parameters of the module.
•_email_tag_: The emails associated to module tags.
After the configuration, please click on 'Create' and check if the plugin has been correctly created.

The plugin code could be seen in the given address:
#!/bin/bash
# This is called like -p xxx -t xxxx
HOST=$4
PORT=$2
nmap -T5 -p $PORT -sU $HOST | grep open | wc -l

That basically joins the commands and parameters, replacing the macros by their values to execute
a quick UDP (sU) NMAP (T5) and that has (wc_l) the open ports quantity (grep open).
Once that the plugin has been created to use it on an agent, it's recommended to create an agent in
case you haven't done this before. Just click on Manage agents In the Pandora FMS console
administration section:
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On the following screen, please click on Create agent:

Fill out the data for your new agent and click on Create agent:

Once you have created the agent, click on the modules upper flag (Modules). Just select 'create a
new plugin module' and click on Create in it:
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In the following form, fill in the blank fields, select the module type 'Generic module to aquire
numeric data', specify the IP address and the port to which to conduct the analysis against:

Once you have finished this, just click on 'Create'.
On the following screen the modules including the NMAP module for the agent will be shown:

As you can see, there is a warning attached to the modules. The warning only means that no data in
the module has been received yet, because they've just been created a few moments ago. Once they
start to receive any data, the warning is going to disappear.
To see the data of the just created module, please click on the upper flap named 'View'. Look at the
bottom of the page, where the data is going to be shown once they start to receive any.
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To see the data type of the modules, please go to the top right flap named 'Data'.

14.9.1. Example 1  Plugin Module for MySQL
This is another more complex example on how to implement a plugin. It's another plugin that
comes by default with Pandora FMS. In this case, it's the MySQL check plugin.
First, create a plugin module ('Administration' > 'Manage Servers' > 'Manage plug ins') for MySQL
by using the following data:
•Name: MySQL
•Plugin type: Standard
•Max. timeout: 10 seconds
•Description: MySQL check plugin
Checks:
This plugin provides four checks:
Connections: Connections Com_select: Number of select queries from start Com_update: Number of
update queries from start Innodb_rows_read: Innodb files readings
•Plugin command: /usr/share/pandora_server/util/plugin/mysql_plugin.sh
•Plugin parameters: s _field1_ u _field2_ p _field3_ q _field4_
•Macro _field1_:
•Description: IP Address
•Default value: X.X.X.X
•Macro _field1_:
•Description: User
•Default value: User
•Macro _field1_:
•Description: Password
•Default value: Password
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•Macro _field1_:
•Description: Check
•Default value: Connections
•Help: Possible values: Connections/Com_select/Com_update/Innodb_rows_read
When it's ready, the plugin is going to look like this:
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This plug in provides four checks:
•Connections: Connections
•Com_select: Number of select queries from start
•Com_update: Number of update queries from start
•Innodb_rows_read: Innodb file readings
Please create a module in the system agent where Pandora FMS is installed and assign it. Its name
is going to be MySQL Connections, using itself as a complement (MySQL), localhost for IP, 'user' as a
username and 'pass' as a password (which serves as the Pandora database password in this
example).
After it's creation, the module has to look like this:

330

Monitoring with Plug Ins

Once you have created it, it will be located directly beneath the NMAP module:

The information on the main page (just klick on the 'View' tab) is supposed to look like this:

The detailed information (just klick on the 'Data' tab) should look like this:

14.9.2. Example 2 SMTP Server Remote Plug In
From version 4.0.2 and above, this plug in is included by default. If you are using an older version,
you can download and install it from the Pandora FMS Module Library here.
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This plug in sends an email by using a remote server to do so. You're able to specify the server IP,
port, user name, password and authentication scheme, email destination and destination. It returns
the value of '1' if it works properly and '0' if not. The plug in is also required to be of the
'generic_proc' type.
This is a screen shot of the module definition using this plug in:

14.9.3. Example 3  DNS Server Remote Plug In

From version 4.0.2 and above, this plug in is included by default. If you are using an
older version, you can download and install it from the Pandora FMS Module
Library here.
This plug in checks the IP address of a specified domain (eg artica.es). This is a fixed IP, using an
external DNS as reference. You're able to validate whether the domain is returning the correct IP
address to avoid unnecessary balancing, DNS attacks, etc. in this way. It returns the value of '1' if it
works properly and '0' if not. The plugin is required to be of the 'generic_proc' type.
This is a screen shot of the module definition using this plug in:
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14.9.4. Example 4  UDP Port Remote Plug In

From version 4.0.2 and above, this plug in is included by default. If you are using an
older version, you may download and install it from the Pandora FMS Module
Library here.
This plug in checks for a specified address and a UDP port. It returns the value of '1' if it works
properly and '0' if not. The plugin is required to be of the 'generic_proc' type.
This is a screen shot of the module definition using this plug in:
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14.10. Intensive monitoring
A remote module (whether it is a network module, a plugin module etc.) may return unreliable
data due to different reasons. For example, a ping module may return 0 even when a host is up
because of network congestion.
Depending on how Pandora FMS is configured this may trigger a series of undesired events
(changed statuses, fired alerts, sent emails...).
To deal with this situation Pandora FMS provides custom FF thresholds for each module. The FF
threshold is the number of additional times that a module is executed before changing its status (a
value of 0 means this feature is disabled). Only if the status change condition is held for all of the
retries will the module’s status be changed.
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The interval of these additional executions can be specified with the FF interval.

This is better seen with an example: Let’s suppose we have a WMI module that returns the amount
of free hard disk space in megabytes. We configure this module to become critical when this value is
lower that 100. Then we create an alert that sends an email to the sysadmin when this module
becomes critical so that he can free up some space. But, due to a software bug, every now and then
the value returned is much lower than the actual one. To get around this issue, we set the module’s
FF threshold to 1 and the FF interval to 30 seconds. This means the first time the module receives a
value lower than 100, the module will be executed again 30 seconds later, and only if it is still
lower than 100 will the module’s status be changed to critical. Otherwise the module resumes
normal execution.
This works well for synchronous modules, but asynchronous modules need an additional
configuration parameter. Since they do not send data at regular intervals, checking for consecutive
values may not be that useful if they are far away in time. In this case, and FF timeout needs to be
specified. This means the number of consecutive values must occur within the configured time
interval.
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Starting from version 5.1, individual FF thresholds can be configured for each module status, so
that a module may require two consecutive values to become critical, but just one to become
normal, for example.
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15 VIRTUAL ENVIRONMENT MONITORING
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15.1. Monitoring Amazon EC2 Environments
This specific monitor utilizes the CloudWatch API to monitor your instances in an
Amazon EC2 environment. You're required to have the CloudWatch service enabled
in your instance. Feel free to download the EC2 module from the Pandora FMS
Module Library.
The main idea of this remote server plug in is to obtain information from your instances by using
the network server plugin. That means you're required to register the plug in on the server and
create different modules to obtain the information from your EC2 Servers.
This is an execution example:
/home/slerena/ec2_plugin.sh -A AKIAILTVJ3S26GTKLD4A -S CgmQ6DxUWES05txfe+juJLoM57acDudHogkLotWk -i
i-9d0b4af1 -n AWS/EC2 -m CPUUtilization

It's going to return a numeric percentage value of the 'CPU Utilization' metric in the instance named
'i9d0b4af1'.
To install it, you're required to:
•Have a running JAVA environment and a JAVA home directory. In the Pandora FMS
Appliance (VMware/Image) it's located under '/usr/'.
•Copy this plug in to a path, change the permissions to '755' and enter the base path on the
'AWS_CLOUDWATCH_HOME' variable which is located among the first lines of the plug in.
The plug in consists of several files:

/ec2_plugin.sh: The plug in itself /bin/*: The components of Amazon CloudWatch
command-line (monitoring) tools are included in this bundle. The scripts contained in
there are distributed under the Apache License.
Please put the whole package in a directory on the server, e.g:
/usr/share/pandora_server/plugin/ec2

and change the 'AWS_CLOUDWATCH_HOME' variable to '/usr/share/pandora_server/plugin/ec2'.
If you have any doubts about whether it's correctly installed or not, feel free to execute this
command to test it:
/usr/share/pandora_server/plugin/ec2/mon-cmd --version

Should return something like this:
Amazon CloudWatch CLI version 1.0.9.5 (API 2010-08-01)

If it returns about the same string, you're ready to use the plug in.
If not, you're probably required to install and configure the Amazon CloudWatch commandline
monitoring tools properly. Please follow these steps to do so:

15.1.1. Installation
1. Please ensure that a JAVA version from version 1.5 or higher is installed on your system (the
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command
to
check
this
is
'java
version').
2.
Unzip
the
installation's
zip
package.
3.
Set
the
following
environment
variables:
3.1 'AWS_CLOUDWATCH_HOME': The directory where the deployment files to check with were
copied
to:
Under UNIX, the command is: 'ls ${AWS_CLOUDWATCH_HOME}/bin' (should list 'monlist
metrics')
Under Windows, the command is: 'dir %AWS_CLOUDWATCH_HOME%\bin' (should list 'monlist
metrics')
3.2
JAVA_HOME

Home
directory
of
the
Java
installation
4. Adds '{AWS_CLOUDWATCH_HOME}/bin' to your path (under Windows it's:
'%AWS_CLOUDWATCH_HOME%\bin')

15.1.2. Configuration
Please provide your AWS user credentials by using the commandline tools. There are two ways to
provide the credentials: You may either use AWS keys or X.509 certificates.

15.1.3. Using AWS Keys
1. Please create a credential file. The installation includes
'{AWS_CLOUDWATCH_HOME}/credentialfilepath.template'.

a

template

file

named

•Edit a copy of this file to add your information to it.
•Under UNIX, limit the permissions to the owner of the credential file by the following
syntax: 'chmod 600 <the file created above>'.
2. There are several ways to provide your credential information:
•Set the following environment variable: 'AWS_CREDENTIAL_FILE=<the file created in 1>'.
•Alternatively, provide the following option with every command: 'awscredentialfile <the
file created in 1>'.
•Explicitly specify credentials on the command line, e.g.: 'I ACCESS_KEY S SECRET_KEY'.

15.1.4. Using X.509 Certificates
1. Please save your certificate and private keys to e.g. 'mycert.pem' and 'mypk.pem' files.
2. There are two ways to provide the certificate information to the command line tool:
•Please set the following environment variables:
EC2_CERT=/path/to/cert/file
EC2_PRIVATE_KEY=/path/to/key/file

•Please specify the files for every command directly on the commandline:
<command> --ec2-cert-file-path=/path/to/cert/file --ec2-private-key-filepath=/path/to/key/file

15.1.5. Setting Custom JVM Properties
By setting the environment variable 'SERVICE_JVM_ARGS', you can pass arbitrary JVM properties to
the command line. For example, the following line sets the proxy server properties under
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Linux/UNIX:
export
Dhttp.proxyPort=8080"

SERVICE_JVM_ARGS="D

http.proxyHost=http://my.proxy.com 

15.1.6. Running
1. Please check whether your setup works properly and execute the following command:
$ mon-cmd --help

You should be able to see the usage page for all monitoring commands by this command:
$ mon-list-metrics --headers

You should see a header line here. If you have any metrics defined, you should see them as well.

15.2. Monitoring VMware Environments
Virtual environments are very important for IT architectures, that is why monitoring these
environments is crucial for the proper performance of your company. With Pandora FMS
Enterprise you're able to install the VMware Monitoring Plug in, which allows you to control
VMware architectures easily.

15.2.1. Monitoring VMware Architecture
By this system, it's possible to monitor architectures like the one below.

Pandora FMS monitors ESXi servers, Data stores and Virtual Machines. Pandora FMS utilizes the
provided VMware web API to collect the data.
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15.2.2. Monitoring by the VMware Monitoring Plug In
VMware monitoring is based on several components:
1.An agent plug in that discovers all the entities of your environment and collects the
information to monitor. For Pandora FMS 5.0 and higher versions, the plug in is also able to
update some agent parameters required by the extensions. Furthermore, it can copy the
events from the VMware vCenter to the Pandora FMS Console.
2.A basic configuration extension in order to execute the VMware plug in from the
Enterprise image file (ISO) without any problems.
3.VMware View and VMware Manager are extensions which allow you to manage virtual
machines easily and provide a view of the whole environment.
By this system, you're able to get an agent for every ESXi, Data store and virtual machine found as
well as an agent which represents the Data Center. This allows you to manage the entities
regardless of the relationship between them within the virtual architecture. Furthermore, each
agent possesses the configured modules and is ready to be monitored according to its VMware
entity type.

15.2.2.1. Internal PlugIn Execution
For versions 5.0 and above, the agent plug in performs all the features: Entity selfdiscovery, data
collection, copying of events and custom field configuration.
For each discovered entity, the plug in sends an XML file to the Pandora FMS Server to be
processed. This entity is going to become a Pandora FMS Agent. The events copied into the console
are going to appear in the event view and managed as events generated by the system.
The plug in has some auxiliary files with information which is related to the monitoring
configuration: Logs, monitored entities, event monitoring pointer, etc.

Since it certainly would negatively affect the monitoring performance, it's very
important not to delete those files.

15.2.3. PlugIn Requirements
These are the requirements to ensure the proper performance of the VMware plug in:
•Installation of Pandora FMS 4.0.3 or higher versions (the extensions only work from
Pandora FMS 4.0.3 Patch 130310 and above)
•The Pandora FMS Agent must be installed on the machine.
•A Linux, UNIX or Windows operating system is required.
•The curl command for versions 5.0 or higher has to be available. The Pandora FMS
Windows Agent incorporates the (curl) command.
•The ping command has to be available.
•The installation of VMware vSphere SDK for Perl is required.
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15.2.4. Configuring vCenter for Monitoring
The plug in uses vCenter performance counters. Performance counter availability depends on the
statistics which collect the levels configured in the vCenter.
These levels could be changed from the 'vCenter Server Settings' menu and the 'Statistics' option.
You're going to see a description of the counters, collected by vCenter for each time option and
level. The minimum level to use the Pandora FMS Monitoring Plug In is 'Level 2.'

Depending on the vCenter configuration, some modules may not report their data to Pandora FMS.
There are three possible reasons for that:
•There's a plug in missing in the vCenter.
•A VMware agent must be installed on the entity.
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•The entity (or the ESXi virtual machine) is simply switched off.
You're required to consult the VMware documentation to solve these problems.
Some solutions, such as the hardware status monitoring, may require an advanced configuration of
both: The vCenter and the host which supports the ESX.

15.2.5. VMware vSphere SDK for Perl Installation
You're able to obtain the VMware software by visiting their Download Center.

15.2.5.1. Installing the Linux SDK
This procedure was tested for SDK versions 4.1 and 5.1.

It's always recommended to utilize the SDK version with its corresponding VMware
software version, e.g.: The 4.1 VMware software is recommended to be used with the
version 4.1 of the SDK.

Please decompress the SDK package by the following command first:
# tar -xzvf VMware-vSphere-Perl-SDK-x.x.x-xxxxxx.i386.tar.gz

Then, compile and install the SDK by the following commands:
# perl Makefile.PL
# make
# make install

If the SDK was installed successfully without the appearance of any errors, you're going to be able
to connect with the vCenter by the following command:
# /usr/lib/vmware-viperl/apps/general/connect.pl --server <vcenter_ip> --username <vcenter_user>
--password <vcenter_pass>

The command response should be something like this:
Connection Successful
Server Time : 2013-02-21T16:24:05.213672Z

15.2.5.2. SDK Setup under Windows
The version of Perl which was shipped with the vSphere SDK doesn't work with VMware's PERL
libraries. Please follow these steps to fix this problem:
•Install the VMware vSphere SDK.
•Install

the Strawberry PERL version 5.12.

•Copy
the
directory
named
'C:\Program
CLI\Perl\lib\VMware' to 'C:\strawberry\perl\lib'.

Files\VMware\VMware

vSphere
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•Uninstall the VMware vSphere SDK.

15.2.5.3. Installing the Plug In by the VMware Settings Extension

This extension is going to be installed by the ISO of the Enterprise Version 5.1 by
default.

By the VMware Settings extension, we're able to set up the VMware plugin execution directly from
the Pandora FMS Console. This extension appears under 'Administration' > 'Setup' and 'VMware'.
Within it, we're able to set the plugin's path, the config's file path and the parameters 'VCenter IP',
the data center's name, 'username', 'password' and the runtime plugin.

The execution of the plug in is added as a new Cron Job which can be executed every 5, 10 or 15
minutes. The execution of the Pandora FMS cron extension, which has to be added in the file
'/etc/crontab', is required to be configured as shown below.
*/1 * * * * root wget -q -O http//localhost/pandora_console/enterprise/extensions/cron/cron.php
>> /var/www/html/pandora_console/pandora_console.log

This extension requires the installation of Pandora FMS 5.1 to be compatible to the
implementation of the Pandora FMS cron job and has to be configured to an interval of
one minute. Without this requirement, the extension is not going to work properly.
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After configuring the plug in, a new task is added within the cron jobs by the following settings:

This particular cron job can only be set from the VMware Settings extension. Any
changes made from a different location or tool within the cron job is going to cause a
malfunction of the plug in.

15.2.6. Setup and Commissioning of the PlugIn Agent
In order to install the plugin agent, please copy the 'vmwareplugin.pl' and 'vmwareplugin.conf'
files to the folder '/etc/pandora/plugins' by the following command:
cp vmware-plugin.pl vmware-plugin.con /etc/pandora/plugins

Then add a new module plugin type to the agent configuration file by the following line:
module_plugin /etc/pandora/plugins/vmware-plugin.pl /etc/pandora/plugins/vmware-plugin.conf

If you also wish to copy events, create another plugin module with a different configuration file
that enables to copy events. The command would be like this:
module_plugin /etc/pandora/plugins/vmware-plugin.pl /etc/pandora/plugins/vmware-plugin-events.conf

Under a Windows system, you're required to specify the interpreter you're intending to use. The
command could e.g. look like this:
module_plugin perl "C:\Program Files\pandora_agent\util\vmware-plugin.pl" "C:\Program
Files\pandora_agent\util\vmware-plugin.conf"

The following sections explain the parameters of the plugin configuration file in detail.

345

Monitoring VMware Environments

Since the VMware plug in uses a very heavy SOAP API, it takes too much time to
execute some tasks. On systems with a large number of entities to monitor, it may be
necessary to share and distribute the load among various Pandora FMS Software Agents.
All relevant information is going to be provided in the sections below.

If you are using Pandora FMS 5.0 or a higher version and you intend to use the plug-in
extensions or any event monitoring, you're required to properly configure the Pandora
API. You're also required to provide an API password and access to the relevant
addresses in the API access list to do so. These fields are defined in the general
configuration of the Pandora FMS Console.

15.2.7. Monitoring the VMware Virtual Architecture
Please go to 'Monitoring' > 'Agent Detail' to do so.

The picture below is going to show the agents created by the plug in along with the other Pandora
FMS agents.

If you click on the name of an agent, you're going to see the Pandora FMS Agent's view along with
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the modules which are getting monitored by the VMware plug in.

The plug in displays a basic monitoring for every VMware element by default. The default settings
for these entities consist of the following:

15.2.7.1. Default Modules for the Data Center
•Ping
•Check 443 port

15.2.7.2. Default Modules for the Data Store
•Capacity
•Free Space
•Disk Overallocation
•Free Space Bytes
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15.2.7.3. Default Modules for ESXi
•CPU Usage
•Memory Usage
•Data received
•Data transmitted
•Disk Read Latency
•Disk Write Latency
•Host Alive

15.2.7.4. Default Modules for Virtual Machines
•CPU Usage
•Memory Usage
•Tools Running Status
•Host Alive
•Disk Free
•Disk Read Latency
•Disk Write Latency
•Data received
•Data transmitted
In the following section, all available modules and information reported by them will be explained
in detail.

15.2.8. VMware Virtual Architecture Agent Modules
Some modules may not be available, depending on the VMware version and environment settings.
In the following tables, the available modules and their features will be described.

The plug in allows you to configure Custom Performance Counters for ESX hosts and
virtual machines. The details on how to create those custom counters is described in the
sections below, where the contents of the configuration file is described in detail.

15.2.8.1. Modules for the Data Center
Module

Description

API
Version

Availability

Ping

ping check ping to the machine which supports
vCenter

All

Always

Check port
443

Check the port 443 on the machine that supports
vCenter

All

Always
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15.2.8.2. Modules for Data Store Agents
Module

Description

API Version Availability

Capacity

Maximum capacity of the Data Store in
bytes

All

Always

Free Space

Percentage of free space on the Data Store

All

Always

≥v4.0

Always

All

Always

Disk over-allocation Disk over-allocation percentage
Free Space Bytes

Amount of free disk space in bytes

15.2.8.3. Modules for Agents of the ESXi Host Type
Shows whether connected or not

Module

Description

API
Version

Availability

Boot Time

Last time the host was booted

All

Always

CPU Info [x]

General CPU information (it creates one
module for each ESXi CPU)

All

If connected.

Memory Size

Total amount of the host's physical memory
in bytes

All

If connected.

Overall CPU
Usage

Addition of the use of all CPUs in MHz

All

If connected.

Overall Memory
Usage

Used physical memory on the host in MB

All

If connected.

Power State

State of the host's power.

≥v2.5

Always.

SSL Thumbprint

Host SSL print

≥v4.0

If configured.

Uptime

Uptime of the host in seconds

≥v4.1

If configured.

VNIC Info [x]

Information about the host's virtual network
interfaces

All

If connected and
configured.

Host Alive

Module KeepAlive type. Value is '1' if the
ESX is connected and '0' if it's not.

All

Always.

Connection State State of the host's connection.

All

Always.

Disk Read

Rate of read Kb/s of the disk

All

Stats Level ≥2

Disk Write

Rate of written Kb/s of the disk

All

Stats Level ≥2

Disk Read
Latency

Latency of the disk reading in milliseconds

All

Stats Level ≥2

Disk Write
Latency

Latency of the disk writing in milliseconds

All

Stats Level ≥2

Data received

Range of host received Kb/s

All

Stats Level ≥2

Data transmitted

Range of host sent Kb/s

All

Stats Level ≥2

Packages
Received

Number of packages received in the interval

All

Stats Level ≥2
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Packages
Transmitted

Number of packages sent in the interval

All

Stats Level ≥2

CPU Usage

Percentage of CPU usage

All

Stats Level ≥2

Memory Usage

Percentage of RAM usage

All

Stats Level ≥2

Net Usage

Sent and received data from all NICs

All

Stats Level ≥2

Disk Rate

Aggregated I/O rate in KB/sec

All

Stats Level ≥2

Max. Disk
Latency

Max. latency of all disks

All

Stats Level ≥2

HA Status

Host HA status

≥v5.0

If configured.

15.2.8.4. Modules for Virtual Machinetype Agents
These modules provide information from a VMware architecture's point of view. If you wish to
monitor other parameters related to virtual machine you're also required to consider other options
such as Monitoring with Software Agents or Remote Monitoring.

Module
Boot Time

Description
Last date where the virtual machine was started.

Connection State Connection state

API
Availability
Version
All

If connected.

All

Always.

≥v4.0

If
configured.

Consumed
Overhead
Memory

Memory consumed by the virtual machine in MB.

CPU Allocation

Information about the resources assigned to the virtual
machine's CPU.

All

If
configured.

Disk Free [x]

Free disk percentage of the virtual machine (there will
be one module for each disk the virtual machine
contains).

All

If
configured.

Guest State

Host's operating system's operating mode.

All

If
configured.

Host Info

Information about the VMware host

All

If
configured.

Host Alive

Module of 'KeepAlive' type. Value is '1' if the virtual
machine is executed and '0' if not.

All

Always.

Host Memory
Usage

Consumed memory by the virtual machine in MB.

All

If connected.

Host Name

Name of the host's operating system.

All

If
configured.

IP Address [x]

System's IP address (It's going to show one for each
available network interface.)

≥v4.1

If
configured.

MAC Address
[x]

System MAC address (It's going to show one for each
available network interface).

All

If
configured.
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Max. CPU
Usage

Maximum limit of the virtual machine's CPU usage.

All

If
configured.

Max Memory
Usage

Maximum limit of the virtual machine's RAM.

All

If connected.

Memory
Allocation

Limit of the resources for the memory

All

If connected.

Memory
Overhead

The the virtual machine's used memory above the
requirements of the host's operating system in Bytes.

All

If
configured.

Overall CPU
Demand

Basic statistics on the CPU performance in MHz.

≥v4.0

If connected.

Overall CPU
Usage

Basic statistics on the CPU usage in MHz.

All

If connected.

Power State

Current state of the virtual machine's power.

All

Always.

Private Memory

The virtual machine's given memory in MB of nonshared memory.

≥v4.0

If connected.

Shared Memory

The virtual machine's given memory in MB of shared
memory.

≥v4.0

If connected.

Tools Running
Status

Current state of executed VMWare tools installed on
the host's operating system.

≥v4.0

If
configured.

Trigger Alarm
State

State of the VMware alarms

All

If
configured.

≥v4.1

If connected.

Uptime Seconds Virtual machine uptime in seconds.
Virtual Image
Path

Virtual machine configuration file path (.vmx).

All

Always.

Disk Read

Rate of the disk read Kbps

All

Stats Level
≥2

Disk Write

Writing speed of the disk in Kb/s.

All

Stats Level
≥2

Disk Read
Latency

Disk reading latency in milliseconds.

All

Stats Level
≥2

Disk Write
Latency

Disk writing latency in milliseconds.

All

Stats Level
≥2

Data Received

Host Kb/s received range.

All

Stats Level
≥2

Data
Transmitted

Host's sent range in Kb/s.

All

Stats Level
≥2

Packages
Received

Number of received packages in the interval.

All

Stats Level
≥2

Packages
Transmitted

Number of transmitted packages in the interval.

All

Stats Level
≥2

CPU Usage

CPU usage percentage.

All

Stats Level
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≥2
Memory Usage

RAM usage percentage.

All

Stats Level
≥2

Net Usage

Sent and received data of all NICs.

All

Stats Level
≥2

Disk Rate

Aggregated I/O rate in KB/sec.

All

Stats Level
≥2

Max. Disk
Latency

Max. latency of all disks.

All

Stats Level
≥2

HeartBeat

Number of virtual machine's heartbeat.

All

Stats Level
≥2

CPU Ready

Percentage of time when machine is ready but not
scheduled on a physical CPU.

All

Stats Level
≥2

Number
Snapshots

Number of snapshots for the virtual machine (This
module affects the monitoring performance. We
strongly recommend executing it with a high value,
e.g. every hour).

All

If
configured.

HA Status

HA status for the virtual machine.

≥v5.0

If
configured.

15.2.9. VMware Event Monitoring
This feature was created to copy event information from the VMware vCenter to Pandora FMS.
These events belong to the Pandora FMS Event Management work flow and are associated to the
agent which represents the vCenter (if any) automatically. The picture below shows an example of
the events generated.
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The copy process respects all the information and severity degree which VMware assigns to them on
event creation. The events with 'critical', 'warning' or 'information' severity levels preserve these
levels in Pandora FMS. The following picture is an example of the detailed information under
Pandora FMS.

Related to the events in Pandora FMS, you could perform all actions available for event
management, e.g. alert creation, filter configuration, incident creation, etc.

15.2.10. VMware Virtual Architecture Management and Visualization
Two extensions are distributed along with the VMWare plug in: The 'VMware Manager' and
'VMware View'. VMware View allows you to easily see all the VMware architecture components. By
the VMware Manager, you're also able to manage virtual machines, stopping, starting, resetting or
canceling the activity from the Pandora FMS Console. These extensions are optional and are solely
going to work in conjunction with Pandora FMS 4.0 or newer versions.
From the plugin versions 4.1 and above, these extensions are encompassed by a single extension,
which in turn is divided into the two above cited, and one last extension called 'VMware Settings'.
This latest extension is supported from version 5.1 of Pandora FMS and above only.

15.2.10.1. Installing VMware Manager, VMware View and VMware Settings Extensions
To install the extensions, please copy the content of the extensions file (that you're going to find
when unzipping the plug in the extension file) in the Pandora FMS Enterprise Console section. The
commands to execute are as follows:
cp -R extensions/* <pandora_console_dir>/enterprise/extensions/

The VMware plugin extensions will be available from this point.

If you intend to use the VMware Manager, you're required to install the VMware SDK
on the machine where the Pandora FMS console is being executed.
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15.2.10.2. Using VMware View Extensions
To start using the VMware architecture view, please click on 'View Agents' > 'VMware View' in the
monitoring menu.

The VMware View extension is going to display a map with all the VMware architecture discovered.

The map bears elements of the VMware architecture (virtual machines, ESX, Data Stores and Data
Centers) with different icons that identify them and the Pandora FMS agents state that represent
354

Monitoring VMware Environments

each element. Besides the relationship that exists between the virtual machines, ESX and the Data
Center are shown. Therefore, you can easily check the state of the VMware architecture at a glance.
This extension comes with some options which might help you to improve the architecture
visualization by allowing you to hide elements, enlarge the character size and zoom in and out:

By using the previous options, you could only see the Data Center and the ESX with a font size of
'14' and a zoom size of 2x.
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15.2.10.3. VMware View Dashboards (5.0 or higher)
For Pandora FMS 5.0 or higher versions, the VMware View extension comes with two additional
map views of the virtual architecture topology. The two additional tabs allow you to switch between
different views of the VMware View Extension.

The first view is a general dashboard where you're able to see the general virtual architecture in
numbers at a glance, e.g. how many virtual machines there are or how many Data Stores or ESXi
hosts might have a problem. There are also graphs which are going to show the virtual machines
which have the highest memory, CPU, disk and network consumption of the entire virtual
architecture. You're also able to easily check for general performance parameters at a glance.

The second view allows you to check for the performance parameters of each ESX host. By this
view, you may choose e.g. an ESX host for which a dashboard with the status of the host and virtual
machines, metrics relating to the usage of CPU, memory, disk and network ESXi host will be
displayed. This also offers a graphical view of the virtual machines with the highest resource (CPU,
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memory, disk and network) consumption.

15.2.10.4. Using the VMware Manager Extension
To use the VMware Manager extension, you're required to go to the operating view of one agent
which corresponds with a virtual machine in the VMware architecture. By this view, you can see an
icon with the VMware symbol which corresponds to the extension.

The VMware Manager Extension allows you to manage virtual machines from the Pandora FMS
Console. The extension shows the current state of the virtual machine with a color code (green=on,
orange=off and grey=stopped). It also shows the availability status in a combo and allows you to
change the state of the virtual machine by selecting it on the 'Change Status' button.
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As shown on the image below, you can stop a running virtual machine by selecting the 'Stop' status
by this extension:

It stops the machine and changes the VMware Manage extension view. As you can see on the image
below, the machine is stopped:

This extension requires the installation of VMware SDK for Perl on the same machine
where Pandora FMS is installed. The extension is not going to work without it.

15.2.11. PlugIn Configuration
The VMware plug in detects all entities and adds the standard checks by default. You're able to
setup the monitoring and to decide which variables you intend to monitor by using the
configuration file.
The configuration file contains all the information necessary for monitoring, consolidated in the
following sections: 'Configuration', 'Rename', 'Reject', 'Datacenter', 'Datastore', 'ESX' and 'VM'.
Subsequently, each section explains its possible configuration.

All errors related to the configuration file are explained in the Error Log Server and in
the Event Viewer of Pandora FMS. You're able to locate any problems in the
configuration file by consulting these sources.
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15.2.11.1. Configuration File
Global Configuration

The general configuration is defined by the token named 'Configuration' and contains the following
parameters:
•Server: The vCenter's IP.
•User: The vCenter's user.
•Pass: The vCenter's password.
•Datacenter: The Data Center you intend to monitor.
•Temporal: The temporary directory.
•Logfile: The log file's location.
•entities_list: The file location, containing the list of the monitored entities.
•transfer_mode: The transfer mode for XMLs. It can be 'tentacle' or 'local'.
•Tentacle: It sends XMLs files to the Pandora FMS Server by using the Tentacle
protocol.
•Local: It copies files found in a local folder. The agent is required to be executed on
the same machine on which the local folder is located.
•tentacle_ip: The Pandora FMS Server IP to which the information is sent.
•tentacle_port: The Pandora FMS server port to which the information is sent (default value
is '41121').
•tentacle_opts: Some additional options for sending with Tentacle (default value is 'none').
•local_folder: The destination directory to copy XMLs with local mode turned on.
•pandora_url:

The
Pandora
FMS
'http://192.168.70.81/pandora_console').

console's

URL

(e.g.

•api_pass: The Pandora FMS API password.
•api_user: The Pandora FMS Console user.
•api_user_pass: The Pandora FMS Console's user password.
•event_mode: The flag which enables the event collecting mode. If it's set to '1', the event
collecting mode is enabled. If it's set to '0', the event collecting mode is disabled.
•event_pointer_file: The temporary file location which stores the pointer to the collection
events.
•Verbosity: The log level (please set it to '0' for errors which prevent the plugin's operation
and to '1' for all errors).
•Threads: The number of plugin threads (default value is '1').
•Interval: The agent's interval which represents the VMware entities.
Example: The configuration file could look like the one shown below.
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Configuration
server 192.168.70.249
user Administrator
pass S1stemas
datacenter artica
temporal /tmp
logfile /tmp/vmware_plugin.log
entities_list /tmp/vmware_entities_list.txt
transfer_mode tentacle
tentacle_ip 192.168.70.81
tentacle_port 41121
tentacle_opts
local_folder /var/spool/pandora/data_in
pandora_url http://192.168.70.81/pandora_console
api_pass 1234
api_user admin
api_user_pass pandora
event_mode 0
event_pointer_file /tmp/vmware_events_pointer.txt

If you intend to use the plug in under Windows, you're going to have to change all file
paths for a compatible routing.

Entity Renaming

The token Rename is used to rename the entities discovered by the plug in. By using this feature,
the agents created under Pandora FMS are going appear with a newly assigned name. The syntax is
shown below:
<current name> TO <new name>

A good configuration example could be like the one below.
#Rename entities
Rename
Debian 11 TO Virtual Machine 1
RedHat 12 TO Web server
ESX Workstation TO Host Work Sales

Entity Dismissal

The plug in allows you to dismiss entities by type or individually. Both options are explained below.
The dismiss function uses the token Reject to dismiss entities. In this section, you can dismiss
entities according to their type, e.g. all virtual machines or all ESX hosts. The accepted values for
this function are the following:
'all_datastore', 'all_datacenter', 'all_esx' and 'all_vm'.
A configuration for this section (which would dismiss all the entities) would be like the one shown
below:
#Dismissed entities
Reject
all_datastore
all_datacenter
all_esx
all_vm

360

Monitoring VMware Environments

To dismiss entities individually, you have to delete the entity's file which created by the plug in. The
plug in creates a file on the location which is indicated by the parameter entities_list (it's
'/tmp/vmware_entities_list.txt' by default). This plug in provides the content of this file in the
moment of first execution or creates a list with all the discovered entities (if it doesn't already exist).
A good example of this file could be like the one below:
Datacenter
artica
Datastore
datastore_1
datastore2
ESX
192.168.70.252
VM
Pandora FMS 4.0.3
Debian2
Debian3
Debian4
Redhat
debian5
Debian6
Debian8
Debian7
Debian11
Debian10
Debian9
NSM
Pandora
vcenter
suse11.2

The configuration file is divided into several tokens: Datacenter, Datastore, ESX and VM where the
different entities are listed. Once the configuration file is created, the plug in is going to read the
entities to monitor. If you intend to dismiss a certain entity, you just have to delete it from the
folder.
If
you
e.g.
don't
want
to
monitor
the
following
entities: Debian2, datastore2, NSM, suse11.2 and 192.168.70.252, the configuration file has to be
like the one below:
Datacenter
artica
Datastore
datastore_1
ESX
VM
Pandora FMS 4.0.3
Debian3
Debian4
Redhat
debian5
Debian6
Debian8
Debian7
Debian11
Debian10
Debian9
Pandora
vcenter

This feature allows you to distribute the monitoring load by limiting the number of monitored
entities in every plugin execution. Some more loading distribution techniques are going to be
explained below:
Monitoring Configuration

The next file sections configure the created modules for every type of entity. These sections use
the Data Center, Data Store, ESX and VM sections. In these sections, you can enable and disable
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modules to monitor. For the following example, we have created a configuration according to the
modules which we'd like to create for the ESX and virtual machines.
...
#ESX Modules
ESX
cpuUsagePercent disabled
diskRead enabled
diskWrite enabled
#VM Modules
VM
diskReadLatency disabled
diskWriteLatency disabled
diskRate enabled
...

Every configuration line is a module. Although in the example above, all the modules are created
with default values. You're able to configure the following values: 'Name', 'description' and 'limits'
for the 'warning' and 'critical' states. An example of this configuration type would be like the one
below:
...
#VM Modules
VM
diskReadLatency disabled
diskWriteLatency disabled
diskRate name = Disk Rate; desc = Lec Rate/Esc disk; limits_warn = 5 10; limits_crit = 0 4
...

The available options for the module configuration are as follows:
•<module> disabled: The module will NOT be created
•<module> enabled: The module "WILL" be created (with values by default)
•<module> name = <name>; desc = <description>; limits_warn <lim_warn>;
limits_crit <lim_crit>: The module will be created along with the given name and
description. The module is going to define thresholds for the 'maximum' and 'minimum' as
well as for 'Critical' and 'Warning' states.
Please keep in mind that it's very important to respect the structure of the file lines, the
configuration file lines, the character next to the name and the module description.
diskRate name = Disk Rate; desc = Lec Rate/Esc Disk; limits_warn = 5 10; limits_crit = 0 4
diskRate name = Disk Rate
= 0
4

; desc = Lec Rate/Esc disk

; limits_warn = 5 10; limits_crit

The modules are referenced by their short names or a simpler equivalent name to write it in the
command line. The short and full names mapping tables are explained in the next section.
Let's analyze the configuration of the example above. We have configured the Disk Rate module
which will be created along with the following values:
* Nombre: Disk Rate
*
*
*
*
*

Descripción: Lec Rate/Esc disk
Min Warning: 5
Max Warning: 10
Min Critical: 0
Max Critical: 4

There are some modules which are dynamically generated, e.g. the modules on disks or network
interfaces. For these metrics, the plugin creates a module for each discovered element. These
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modules bear special names in Pandora FMS, e.g.:
Disk Free [0]
Disk Free [1]
Disk Free [2]
...

Since the name has a dynamic part in these cases, it's allowed to use the macro '%s' which is going
to be replaced by the variable part of the module name. An example of dynamic module
configuration would be as follows:
diskfree name = Disk (% s) free space; desc = Free space for disk; limits_warn = 0 0; limits_crit =
00
In this case, the default module name is:
Free Disk [0]
And is going to be renamed to:
Disk (0) free space
From version 5.0 and above, you're able to set text strings for the limits of the 'Warning' and
'Critical' states of the modules. In such a case, the configuration would look like this:
PowerState operation name = State; desc = VM operating state; limits_warn =. * suspended. *;
limits_crit =. * poweredOff. *
You're also able to configure regular expressions to provide greater flexibility within the setting
limits.
Custom Performance Metrics

In this section, we're going to show how to configure new modules for Performance Counters,
Virtual Machines and ESX. To set a new performance module, you're required to use the following
structure:
custom_performance type = mem; metric = swapinRate; module_type = generic_data; name = Swap In
Rate; desc = Swap In Rate for host; limits_warn = 0 0; limits_crit = 0 0

The parameters to set are the following:
•Type: Type of metrics to monitor. The types of metrics are:
•Cpu: CPU
•Mem: Memory
•Disk: Disk
•Net: Network
•Sys: System
•Metric: The metrics to monitor (explained later view metrics where available).
•Module_type: The Pandora FMS module type (e.g. 'generic_data').
•Name: The module's name.
•Desc: The description of the module.
•Limits_warn: The 'Warning' limits for the state.
•Limits_crit: The 'Critical' statelimits.
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You're able to check the available metrics for each type in the 'Performance' section of each entity.
This view shows performance metrics which can be monitored by the VMware plug in which is
located in the vCenter. The image below e.g. shows the Performance View for an ESX host.

To see a complete list of all the metrics sorted by type, please click on the Advanced button and then
on the Char option button. A window which contains a list of all metric types and their respective
metrics are going to be displayed like the ones on the picture below:
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For each type of metric, a number of counters are going to appear. They represent the variables
you're able to monitor with Pandora FMS. To monitor a variable, you have to use your
internal Name. Furthermore, you have to make sure that the level of statistics which is configured in
the vCenter shows the variable you seek by a comparison of the variable with the Collection Level of
the metric.

365

Monitoring VMware Environments

If you e.g. like to see the CPU usage of an ESX host, you should search for CPUtype variables for an
ESX and select Utilization. In this case, the line you have to add to the configuration file has to look
like the one below:

custom_performance type = cpu; metric = utilization; module_type = generic_data,
name = CPU Utilization, desc = CPU Utilization for ESX; limits_warn = 0 0;
limits_crit = 0 0
15.2.11.2. Monitoring of Several Data Centers by the same Agent
Each configured plugin module in the agent monitors a Data Center. If you like to monitor several
data centers by one Pandora FMS Software Agent, it's important to keep the following things in
mind:
•It's required to add a 'module_plugin' parameter for each data center to monitor, e.g.:

module_plugin / etc / pandora / plugins / vmware-plugin.pl /
etc/pandora/plugins/vmware-plugin-datacenter1.conf
module_plugin / etc /
pandora / plugins / vmware-plugin.pl / etc/pandora/plugins/vmware-plugin366
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datacenter2.conf
•You're also required to change the parameters 'logfile', 'entities_list' and 'event_pointer_file'
in each configuration file. The configuration files have to look similar to the ones shown
below:
vmwareplugindatacenter1.conf

...
logfile / tmp/vmware_plugin_datacenter1.log
entities_list
tmp/vmware_entities_list_datacenter1.txt
event_pointer_file
tmp/vmware_events_pointer_datacenter1.txt ...

/
/

vmwareplugindatacenter2.conf

...
logfile / tmp/vmware_plugin_datacenter2.log
entities_list
tmp/vmware_entities_list_datacenter2.txt
event_pointer_file
tmp/vmware_events_pointer_datacenter2.txt ...

/
/

•If you like to copy events, you're required to add two more plugin modules along with their
configuration files and to activate the 'event_mode' flag. In such a case, the 'module_plugin'
configuration would have to look like this:

module_plugin / etc / pandora / plugins / vmware-plugin.pl /
etc/pandora/plugins/vmware-plugin-datacenter1.conf
module_plugin / etc /
pandora / plugins / vmware-plugin.pl / etc/pandora/plugins/vmware-plugindatacenter1-events.conf
module_plugin / etc / pandora / plugins / vmwareplugin.pl / etc/pandora/plugins/vmware-plugin-datacenter2.conf module_plugin / etc
/ pandora / plugins / vmware-plugin.pl / etc/pandora/plugins/vmware-plugindatacenter2-events.conf
15.2.11.3. Sharing the Monitoring Load between several Pandora FMS Servers
The options of the plugin configuration file easily allow you to distribute the monitoring load
between several Pandora FMS Servers.
Just imagine that you've acquired a similar structure in your virtualization environment to the one
shown below:
DC
|
|- Datastore_1
|- DataStore_2
|
|- ESX_1
|- mv1.1
|- mv1.2
|- mv1.3
|- ESX_2
|- mv2.1
|- mv2.2
|- mv2.3

You have two Pandora FMS servers to monitor all your devices in your environment. It's an easy
way to split the load by monitoring the Data Center, Data Stores and ESX on the first server and all
the virtual machines on the second. The configuration file for the Recon Script has to be like the one
below:
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Server 1:
Reject
all_vm

Server 2:
Reject
all_datacenter
all_datastore
all_esx

Server 1 is going to monitor everything except the virtual machines. Server 2 is only going to
monitor the virtual machines.
Another option would be to split the monitoring by ESX server. In this case, the first Pandora FMS
Server would monitor all the things related to the first ESX and the second would split everything
related to the second ESX. The configuration files would have to look like the one below:
Server 1:
Reject
DataStore_2
ESX_2
mv2.1
mv2.2
mv2.3

Server 1 ignores everything related to the second group of VMware entities. It's going to monitor
the first part of the environment.
Server 2:
Reject
DC
Datastore_1
ESX_1
mv1.1
mv1.2
mv1.3

Server 2 ignores everything related to the first group of VMware entities plus the Data Center
(because these entities are monitored by Server 1).
The feature to reject entities is very flexible and allows you to split the load by assigning a few
entities to each Pandora FMS Server.

15.2.11.4. Example of the Configuration File
File with all Modules disabled

The lines which start by a '#' character are comments.
#Datacenter Modules
Datacenter
ping disabled
check443 disabled
#Datastore Modules
Datastore
capacity disabled
freeSpace disabled
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overallocation disabled
freeSpaceBytes disabled
#ESX Modules
ESX
bootTime disabled
cpuInfo disabled
memorySize disabled
overallCpuUsage disabled
overallMemoryUsage disabled
powerState disabled
sslThumbprint disabled
uptime disabled
vnicInfo disabled
hostAlive disabled
connectionState disabled
diskRead disabled
diskWrite disabled
diskReadLatency disabled
diskWriteLatency disabled
netReceived disabled
netTransmitted disabled
netPkgRx disabled
netPkgTx disabled
cpuUsagePercent disabled
memoryUsagePercent disabled
netUsage disabled
diskRate disabled
maxDiskLatency disabled
#VM Modules
VM
bootTime disabled
connectionState disabled
consumedOverheadMemory disabled
cpuAllocation disabled
diskFree disabled
guestState disabled
host disabled
hostAlive disabled
hostMemoryUsage disabled
hostName disabled
ipAddress disabled
macAddress disabled
maxCpuUsage disabled
maxMemoryUsage disabled
memoryAllocation disabled
memoryOverhead disabled
overallCpuDemand disabled
overallCpuUsage disabled
powerState disabled
privateMemory disabled
sharedMemory disabled
toolsRunningStatus disabled
triggeredAlarmState disabled
virtualImagePath disabled
uptimeSeconds disabled
diskRead disabled
diskWrite disabled
diskReadLatency disabled
diskWriteLatency disabled
netReceived disabled
netTransmitted disabled
netPkgRx disabled
netPkgTx disabled
cpuUsagePercent disabled
memoryUsagePercent disabled
netUsage disabled
diskRate disabled
maxDiskLatency disabled
heartbeat disabled
cpuReady disabled
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15.2.11.5. Correspondence Table of Short Names
Data Center

Full name
Ping

Short name
ping

Check port 443 check443
Data Stores

Full name

Short name

Capacity

capacity

Free Space

freeSpace

Disk Overallocation overallocation
Free Space Bytes

freeSpaceBytes

ESX

Full name

Short name

Boot Time

bootTime

CPU Info

cpuInfo

Memory Size

memorySize

Overall CPU Usage

overallCpuUsage

Overall Memory Usage overallMemoryUsage
Power State

powerState

SSL Thumbprint

sslThumbprint

Uptime

uptime

VNIC Info

vnicInfo

Host Alive

hostAlive

Connection State

connectionState

Disk Read

diskRead

Disk Write

diskWrite

Disk Read Latency

diskReadLatency

Disk Write Latency

diskWriteLatency

Data Received

netReceived

Data Transmitted

netTransmitted

Packages Received

netPkgRx

Packages Transmitted

netPkgTx

CPU Usage

cpuUsagePercent
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Memory Usage

memoryUsagePercent

Net Usage

netUsage

Disk Rate

diskRate

Max. Disk Latency

maxDiskLatency

HA Status

haStatus

Virtual Machines

Full name

Short name

Boot Time

bootTime

Connection State

connectionState

Consumed Overhead Memory consumedOverheadMemory
CPU Allocation

cpuAllocation

Disk Free

diskFree

Guest State

guestState

Host Info

host

Host Alive

hostAlive

Host Memory Usage

hostMemoryUsage

Host Name

hostName

IP Address

ipAddress

MAC Address

macAddress

Max. CPU Usage

maxCpuUsage

Max. Memory Usage

maxMemoryUsage

Memory Allocation

memoryAllocation

Memory Overhead

memoryOverhead

Overall CPU Demand

overallCpuDemand

Overall CPU Usage

overallCpuUsage

Power State

powerState

Private Memory

privateMemory

Shared Memory

sharedMemory

Tools Running Status

toolsRunningStatus

Trigger Alarm State

triggeredAlarmState

Uptime Seconds

uptimeSeconds

Virtual Image Path

virtualImagePath

Disk Read

diskRead

Disk Write

diskWrite
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Disk Read Latency

diskReadLatency

Disk Write Latency

diskWriteLatency

Data Received

netReceived

Data Transmitted

netTransmitted

Packages Received

netPkgRx

Packages Transmitted

netPkgTx

CPU Usage

cpuUsagePercent

Memory Usage

memoryUsagePercent

Net Usage

netUsage

Disk Rate

diskRate

Max. Disk Latency

maxDiskLatency

HeartBeat

heartbeat

CPU Ready

cpuReady

Number of Snapshots

snapshotCounter

HA Status

haStatus

15.2.11.6. Table of Events
This list of events is going to help you to configure Alert Events under Pandora FMS.
For a complete and updated reference of all possible events, you may check theVMware
Documentation.

Event

Criticity

Event type

Group

An account was created on host {host.name}

Informational

System

All

Account {account} was removed on host
{host.name}.

Informational

System

All

An account was updated on host {host.name}.

Informational

System

All

The default password for the root user on the
host {host.name} has not been changed.

Informational

System

All

Alarm '{alarm.name}' on {entity.name}
triggered an action

Informational

System

All

Created alarm '{alarm.name}' on
{entity.name}

Informational

System

All

Alarm '{alarm.name}' on {entity.name} sent
email to {to}

Informational

System

All

Critical

System

All

Alarm '{alarm.name}' on {entity.name}
cannot send email to {to}
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Reconfigured alarm '{alarm.name}' on
{entity.name}

Informational

System

All

Removed alarm '{alarm.name}' on
{entity.name}

Informational

System

All

Alarm '{alarm.name}' on {entity.name} ran
script {script}

Informational

System

All

Alarm '{alarm.name}' on {entity.name} did
not complete script: {reason.msg}

Critical

System

All

Informational

System

All

Critical

System

All

Alarm '{alarm.name}' on {entity.name}
changed from
{from.@enum.ManagedEntity.Status} to
{to.@enum.ManagedEntity.Status}

Informational

System

All

All running virtual machines are licensed

Informational

System

All

User cannot logon since the user is already
logged on

Informational

System

All

Critical

System

All

The operation performed on host {host.name}
in {datacenter.name} was canceled

Informational

System

All

Changed ownership of file name {filename}
from {oldOwner} to {newOwner} on
{host.name} in {datacenter.name}.

Informational

System

All

Critical

System

All

Checked cluster for compliance

Informational

System

All

Created cluster {computeResource.name} in
{datacenter.name}

Informational

System

All

Removed cluster {computeResource.name} in
Informational
datacenter {datacenter.name}

System

All

Insufficient capacity in cluster
{computeResource.name} to satisfy resource
configuration in {datacenter.name}

Critical

System

All

Informational

System

All

Alarm '{alarm.name}': an SNMP trap for
entity {entity.name} was sent
Alarm '{alarm.name}' on entity {entity.name}
did not send SNMP trap: {reason.msg}

Cannot login {userName}@{ipAddress}

Cannot change ownership of file name
{filename} from {owner} to
{attemptedOwner} on {host.name} in
{datacenter.name}.

Reconfigured cluster
{computeResource.name} in datacenter
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{datacenter.name}
Configuration status on cluster
{computeResource.name} changed from
{oldStatus.@enum.ManagedEntity.Status} to Informational
{newStatus.@enum.ManagedEntity.Status} in
{datacenter.name}

System

All

Created new custom field definition {name}

Informational

System

All

Removed field definition {name}

Informational

System

All

Renamed field definition from {name} to
{newName}

Informational

System

All

Changed custom field {name} on
{entity.name} in {datacenter.name} to
{value}

Informational

System

All

Cannot complete customization of VM
{vm.name}. See customization log at
{logLocation} on the guest OS for details.

Informational

System

All

An error occurred while setting up Linux
identity. See log file '{logLocation}' on guest
OS for details.

Critical

System

All

An error occurred while setting up network
properties of the guest OS. See the log file
{logLocation} in the guest OS for details.

Critical

System

All

Started customization of VM {vm.name}.
Customization log located at {logLocation} in
the guest OS.

Informational

System

All

Customization of VM {vm.name} succeeded.
Customization log located at {logLocation} in
the guest OS.

Informational

System

All

The version of Sysprep {sysprepVersion}
provided for customizing VM {vm.name}
does not match the version of guest OS
{systemVersion}. See the log file
{logLocation} in the guest OS for more
information.

Critical

System

All

An error occurred while customizing VM
{vm.name}. For details reference the log file
{logLocation} in the guest OS.

Critical

System

All

dvPort group {net.name} in
{datacenter.name} was added to switch
{dvs.name}.

Informational

System

All

dvPort group {net.name} in

Informational

System

All
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{datacenter.name} was deleted.
Informational

System

All

dvPort group {net.name} in
{datacenter.name} was reconfigured.

Informational

System

All

dvPort group {oldName} in
{datacenter.name} was renamed to
{newName}

Informational

System

All

HA admission control disabled on cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

HA admission control enabled on cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

Re-established contact with a primary host in
this HA cluster

Informational

System

All

Unable to contact a primary HA agent in
cluster {computeResource.name} in
{datacenter.name}

Critical

System

All

All hosts in the HA cluster
{computeResource.name} in
{datacenter.name} were isolated from the
network. Check the network configuration for
proper network redundancy in the
management network.

Critical

System

All

HA disabled on cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

HA enabled on cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

A possible host failure has been detected by
HA on {failedHost.name} in cluster
{computeResource.name} in
{datacenter.name}

Critical

System

All

Host {isolatedHost.name} has been isolated
from cluster {computeResource.name} in
{datacenter.name}

Warning

System

All

Created datacenter {datacenter.name} in
folder {parent.name}

Informational

System

All

Renamed datacenter from {oldName} to
{newName}

Informational

System

All
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Datastore {datastore.name} increased in
capacity from {oldCapacity} bytes to
{newCapacity} bytes in {datacenter.name}

Informational

System

All

Removed unconfigured datastore
{datastore.name}

Informational

System

All

Discovered datastore {datastore.name} on
{host.name} in {datacenter.name}

Informational

System

All

Critical

System

All

<internal>

Informational

System

All

File or directory {sourceFile} copied from
{sourceDatastore.name} to {datastore.name}
as {targetFile}

Informational

System

All

File or directory {targetFile} deleted from
{datastore.name}

Informational

System

All

File or directory {sourceFile} moved from
{sourceDatastore.name} to {datastore.name}
as {targetFile}

Informational

System

All

Reconfigured Storage I/O Control on datastore
Informational
{datastore.name}

System

All

Configured datastore principal
{datastorePrincipal} on host {host.name} in
{datacenter.name}

Informational

System

All

Removed datastore {datastore.name} from
{host.name} in {datacenter.name}

Informational

System

All

Renamed datastore from {oldName} to
{newName} in {datacenter.name}

Informational

System

All

Renamed datastore from {oldName} to
{newName} in {datacenter.name}

Informational

System

All

Disabled DRS on cluster
{computeResource.name} in datacenter
{datacenter.name}

Informational

System

All

Enabled DRS on {computeResource.name}
with automation level {behavior} in
{datacenter.name}

Informational

System

All

DRS put {host.name} into standby mode

Informational

System

All

DRS is putting {host.name} into standby
mode

Informational

System

All

Multiple datastores named {datastore}
detected on host {host.name} in
{datacenter.name}
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DRS cannot move {host.name} out of standby
mode

System

All

DRS moved {host.name} out of standby mode Informational

System

All

DRS is moving {host.name} out of standby
mode

Informational

System

All

Critical

System

All

Informational

System

All

Critical

System

All

Resource configuration specification returns
to synchronization from previous failure on
host '{host.name}' in {datacenter.name}

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is now compliant with
DRS VM-Host affinity rules

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is violating a DRS VMHost affinity rule

Informational

System

All

DRS migrated {vm.name} from
{sourceHost.name} to {host.name} in cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

DRS powered On {vm.name} on {host.name}
in {datacenter.name}

Informational

System

All

Virtual machine {macAddress} on host
{host.name} has a duplicate IP {duplicateIP}

Informational

System

All

A vNetwork Distributed Switch {dvs.name}
was created in {datacenter.name}.

Informational

System

All

vNetwork Distributed Switch {dvs.name} in
{datacenter.name} was deleted.

Informational

System

All

vNetwork Distributed Switch event

Informational

System

All

The vNetwork Distributed Switch {dvs.name}
configuration on the host was synchronized
Informational
with that of the vCenter Server.

System

All

The host {hostJoined.name} joined the
vNetwork Distributed Switch {dvs.name} in
{datacenter.name}.

System

All

DRS invocation not completed
DRS has recovered from the failure
Unable to apply DRS resource settings on host
{host.name} in {datacenter.name}.
{reason.msg}. This can significantly reduce
the effectiveness of DRS.

Critical

Informational
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The host {hostLeft.name} left the vNetwork
Distributed Switch {dvs.name} in
{datacenter.name}.

Informational

System

All

The host {hostMember.name} changed status
on the vNetwork Distributed Switch
{dvs.name} in {datacenter.name}.

Informational

System

All

The vNetwork Distributed Switch {dvs.name}
configuration on the host differed from that of
the vCenter Server.

Warning

System

All

vNetwork Distributed Switch {srcDvs.name}
was merged into {dstDvs.name} in
{datacenter.name}.

Informational

System

All

dvPort {portKey} was blocked in the
vNetwork Distributed Switch {dvs.name} in
{datacenter.name}.

Informational

System

All

The port {portKey} was connected in the
vNetwork Distributed Switch {dvs.name} in
{datacenter.name}

Informational

System

All

New ports were created in the vNetwork
Distributed Switch {dvs.name} in
{datacenter.name}.

Informational

System

All

Deleted ports in the vNetwork Distributed
Switch {dvs.name} in {datacenter.name}.

Informational

System

All

The dvPort {portKey} was disconnected in the
vNetwork Distributed Switch {dvs.name} in
Informational
{datacenter.name}.

System

All

dvPort {portKey} entered passthrough mode
in the vNetwork Distributed Switch
{dvs.name} in {datacenter.name}.

Informational

System

All

dvPort {portKey} exited passthrough mode in
the vNetwork Distributed Switch {dvs.name}
in {datacenter.name}.

Informational

System

All

dvPort {portKey} was moved into the dvPort
group {portgroupName} in
{datacenter.name}.

Informational

System

All

dvPort {portKey} was moved out of the
dvPort group {portgroupName} in
{datacenter.name}.

Informational

System

All

The port {portKey} link was down in the
vNetwork Distributed Switch {dvs.name} in
{datacenter.name}

Informational

System

All
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The port {portKey} link was up in the
vNetwork Distributed Switch {dvs.name} in
{datacenter.name}

Informational

System

All

Reconfigured ports in the vNetwork
Distributed Switch {dvs.name} in
{datacenter.name}.

Informational

System

All

dvPort {portKey} was unblocked in the
vNetwork Distributed Switch {dvs.name} in
{datacenter.name}.

Informational

System

All

The vNetwork Distributed Switch {dvs.name}
Informational
in {datacenter.name} was reconfigured.

System

All

The vNetwork Distributed Switch {oldName}
in {datacenter.name} was renamed to
{newName}.

Informational

System

All

An upgrade for the vNetwork Distributed
Switch {dvs.name} in datacenter
{datacenter.name} is available.

Informational

System

All

An upgrade for the vNetwork Distributed
Switch {dvs.name} in datacenter
{datacenter.name} is in progress.

Informational

System

All

Cannot complete an upgrade for the vNetwork
Distributed Switch {dvs.name} in datacenter
Informational
{datacenter.name}

System

All

vNetwork Distributed Switch {dvs.name} in
datacenter {datacenter.name} was upgraded.

Informational

System

All

Host {host.name} in {datacenter.name} has
entered maintenance mode

Informational

System

All

The host {host.name} is in standby mode

Informational

System

All

Host {host.name} in {datacenter.name} has
started to enter maintenance mode

Informational

System

All

The host {host.name} is entering standby
mode

Informational

System

All

Critical

System

All

Host {host.name} in {datacenter.name} has
exited maintenance mode

Informational

System

All

The host {host.name} could not exit standby
mode

Critical

System

All

The host {host.name} is no longer in standby
mode

Informational

System

All

{message}
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The host {host.name} is exiting standby mode

Informational

System

All

Sufficient resources are available to satisfy
HA failover level in cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

General event: {message}

Informational

System

All

Error detected on {host.name} in
{datacenter.name}: {message}

Critical

System

All

Issue detected on {host.name} in
{datacenter.name}: {message}

Informational

System

All

Issue detected on {host.name} in
{datacenter.name}: {message}

Warning

System

All

Informational

System

All

Error detected for {vm.name} on {host.name}
in {datacenter.name}: {message}

Critical

System

All

Issue detected for {vm.name} on {host.name}
in {datacenter.name}: {message}

Informational

System

All

Issue detected for {vm.name} on {host.name}
in {datacenter.name}: {message}

Warning

System

All

The vNetwork Distributed Switch
corresponding to the proxy switches
{switchUuid} on the host {host.name} does
Informational
not exist in vCenter Server or does not contain
this host.

System

All

A ghost proxy switch {switchUuid} on the
host {host.name} was resolved.

Informational

System

All

The message changed: {message}

Informational

System

All

{componentName} status changed from
{oldStatus} to {newStatus}

Informational

System

All

Critical

System

All

Informational

System

All

Administrator access to the host {host.name}
is disabled

Warning

System

All

Administrator access to the host {host.name}
has been restored

Warning

System

All

Cannot connect {host.name} in

Critical

System

All

User logged event: {message}

Cannot add host {hostname} to datacenter
{datacenter.name}
Added host {host.name} to datacenter
{datacenter.name}
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{datacenter.name}: cannot configure
management account
Cannot connect {host.name} in
{datacenter.name}: already managed by
{serverName}

Critical

System

All

Cannot connect host {host.name} in
{datacenter.name} : server agent is not
responding

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: incorrect user name or
password

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: incompatible version

Critical

System

All

Cannot connect host {host.name} in
{datacenter.name}. Did not install or upgrade
vCenter agent service.

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: error connecting to host

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: network error

Critical

System

All

Cannot connect host {host.name} in
{datacenter.name}: account has insufficient
privileges

Critical

System

All

Cannot connect host {host.name} in
{datacenter.name}

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: not enough CPU licenses

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: incorrect host name

Critical

System

All

Cannot connect {host.name} in
{datacenter.name}: time-out waiting for host
response

Critical

System

All

Host {host.name} checked for compliance.

Informational

System

All

Host {host.name} is in compliance with the
attached profile

Informational

System

All

Host configuration changes applied.

Informational

System

All

Connected to {host.name} in
{datacenter.name}

Informational

System

All

Critical

System

All

Host {host.name} in {datacenter.name} is not
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responding
dvPort connected to host {host.name} in
{datacenter.name} changed status

Informational

System

All

HA agent disabled on {host.name} in cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

HA is being disabled on {host.name} in
cluster {computeResource.name} in
datacenter {datacenter.name}

Informational

System

All

HA agent enabled on {host.name} in cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

Enabling HA agent on {host.name} in cluster
{computeResource.name} in
{datacenter.name}

Warning

System

All

HA agent on {host.name} in cluster
{computeResource.name} in
{datacenter.name} has an error {message}:
{reason.@enum.HostDasErrorEvent.HostDas
ErrorReason}

Critical

System

All

Informational

System

All

Disconnected from {host.name} in
{datacenter.name}. Reason:
Informational
{reason.@enum.HostDisconnectedEvent.Reas
onCode}

System

All

Cannot restore some administrator
permissions to the host {host.name}

Critical

System

All

Host {host.name} has the following extra
networks not used by other hosts for HA
communication:{ips}. Consider using HA
advanced option das.allowNetwork to control
network usage

Critical

System

All

Cannot complete command 'hostname -s' on
host {host.name} or returned incorrect name
format

Critical

System

All

Maximum ({capacity}) number of hosts
allowed for this edition of vCenter Server has
been reached

Critical

System

All

Informational

System

All

HA agent on host {host.name} in cluster
{computeResource.name} in
{datacenter.name} is configured correctly

The virtual machine inventory file on host
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{host.name} is damaged or unreadable.
IP address of the host {host.name} changed
from {oldIP} to {newIP}

Informational

System

All

Configuration of host IP address is
inconsistent on host {host.name}: address
resolved to {ipAddress} and {ipAddress2}

Critical

System

All

Cannot resolve IP address to short name on
host {host.name}

Critical

System

All

Host {host.name} could not reach isolation
address: {isolationIp}

Critical

System

All

A host license for {host.name} has expired

Critical

System

All

Host {host.name} does not have the following
networks used by other hosts for HA
communication:{ips}. Consider using HA
advanced option das.allowNetwork to control
network usage

Critical

System

All

Informational

System

All

Host {host.name} currently has no available
networks for HA Communication. The
following networks are currently used by HA:
{ips}

Critical

System

All

Host {host.name} has no port groups enabled
for HA communication.

Critical

System

All

Host {host.name} currently has no
management network redundancy

Critical

System

All

Host {host.name} is not in compliance with
the attached profile

Critical

System

All

Host {host.name} is not a cluster member in
{datacenter.name}

Critical

System

All

Insufficient capacity in host
{computeResource.name} to satisfy resource
configuration in {datacenter.name}

Critical

System

All

Primary agent {primaryAgent} was not
specified as a short name to host {host.name}

Critical

System

All

Informational

System

All

Critical

System

All

Host monitoring state in
{computeResource.name} in
{datacenter.name} changed to
{state.@enum.DasConfigInfo.ServiceState}

Profile is applied on the host {host.name}
Cannot reconnect to {host.name} in
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{datacenter.name}
Removed host {host.name} in
{datacenter.name}

Informational

System

All

Host names {shortName} and {shortName2}
both resolved to the same IP address. Check
the host's network configuration and DNS
entries

Critical

System

All

Cannot resolve short name {shortName} to IP
address on host {host.name}

Critical

System

All

Informational

System

All

Configuration status on host
{computeResource.name} changed from
{oldStatus.@enum.ManagedEntity.Status} to Informational
{newStatus.@enum.ManagedEntity.Status} in
{datacenter.name}

System

All

Cannot synchronize host {host.name}.
{reason.msg}

Critical

System

All

Cannot install or upgrade vCenter agent
service on {host.name} in {datacenter.name}

Critical

System

All

The userworld swap is not enabled on the host
{host.name}

Warning

System

All

Host {host.name} vNIC {vnic.vnic} was
reconfigured to use dvPort
{vnic.port.portKey} with port level
configuration, which might be different from
the dvPort group.

Informational

System

All

WWNs are changed for {host.name}

Warning

System

All

The WWN ({wwn}) of {host.name} conflicts
with the currently registered WWN

Critical

System

All

Host {host.name} did not provide the
information needed to acquire the correct set
of licenses

Critical

System

All

Informational

System

All

Insufficient resources to satisfy HA failover
level on cluster {computeResource.name} in
{datacenter.name}

Critical

System

All

The license edition '{feature}' is invalid

Critical

System

All

License {feature.featureName} has expired

Critical

System

All

Shut down of {host.name} in
{datacenter.name}: {reason}

{message}
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License inventory is not compliant. Licenses
are overused

Critical

System

All

Unable to acquire licenses due to a restriction
in the option file on the license server.

Critical

System

All

Informational

System

All

License server {licenseServer} is unavailable

Critical

System

All

Created local datastore {datastore.name} on
{host.name} in {datacenter.name}

Informational

System

All

The Local Tech Support Mode for the host
{host.name} has been enabled

Informational

System

All

Warning

System

All

Informational

System

All

Unable to migrate {vm.name} from
{host.name} in {datacenter.name}:
{fault.msg}

Critical

System

All

Unable to migrate {vm.name} from
{host.name} to {dstHost.name} in
{datacenter.name}: {fault.msg}

Critical

System

All

Migration of {vm.name} from {host.name} to
{dstHost.name} in {datacenter.name}:
{fault.msg}

Warning

System

All

Cannot migrate {vm.name} from {host.name}
to {dstHost.name} and resource pool
{dstPool.name} in {datacenter.name}:
{fault.msg}

Critical

System

All

Migration of {vm.name} from {host.name} to
{dstHost.name} and resource pool
{dstPool.name} in {datacenter.name}:
{fault.msg}

Warning

System

All

Migration of {vm.name} from {host.name} in
{datacenter.name}: {fault.msg}

Warning

System

All

Informational

System

All

Critical

System

All

Informational

System

All

License server {licenseServer} is available

Datastore {datastore} which is configured to
back the locker does not exist
Locker was reconfigured from {oldDatastore}
to {newDatastore} datastore

Created NAS datastore {datastore.name} on
{host.name} in {datacenter.name}
Cannot login user {userName}@{ipAddress}:
no permission
No datastores have been configured on the
host {host.name}
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A required license {feature.featureName} is
not reserved

Critical

System

All

Unable to automatically migrate {vm.name}
from {host.name}

Informational

System

All

Critical

System

All

Informational

System

All

Warning

System

All

Permission created for {principal} on
{entity.name}, role is {role.name},
propagation is
Informational
{propagate.@enum.auth.Permission.propagate
}

System

All

Permission rule removed for {principal} on
{entity.name}

Informational

System

All

Permission changed for {principal} on
{entity.name}, role is {role.name},
propagation is
Informational
{propagate.@enum.auth.Permission.propagate
}

System

All

Profile {profile.name} attached.

Informational

System

All

Profile {profile.name} was changed.

Informational

System

All

Profile is created.

Informational

System

All

Profile {profile.name} detached.

Informational

System

All

Profile {profile.name} reference host changed. Informational

System

All

Profile was removed.

Informational

System

All

Remote Tech Support Mode (SSH) for the
host {host.name} has been enabled

Informational

System

All

Created resource pool {resourcePool.name} in
compute-resource {computeResource.name}
Informational
in {datacenter.name}

System

All

Removed resource pool {resourcePool.name}
on {computeResource.name} in
{datacenter.name}

Informational

System

All

Moved resource pool {resourcePool.name}

Informational

System

All

Non-VI workload detected on datastore
{datastore.name}
Not enough resources to failover {vm.name}
in {computeResource.name} in
{datacenter.name}
The vNetwork Distributed Switch
configuration on some hosts differed from that
of the vCenter Server.
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from {oldParent.name} to {newParent.name}
on {computeResource.name} in
{datacenter.name}
Updated configuration for
{resourcePool.name} in compute-resource
{computeResource.name} in
{datacenter.name}

Informational

System

All

Critical

System

All

New role {role.name} created

Informational

System

All

Role {role.name} removed

Informational

System

All

Modifed role {role.name}

Informational

System

All

Task {scheduledTask.name} on {entity.name}
Informational
in {datacenter.name} completed successfully

System

All

Created task {scheduledTask.name} on
{entity.name} in {datacenter.name}

Informational

System

All

Task {scheduledTask.name} on {entity.name}
Informational
in {datacenter.name} sent email to {to}

System

All

Task {scheduledTask.name} on {entity.name}
in {datacenter.name} cannot send email to
{to}: {reason.msg}

Critical

System

All

Task {scheduledTask.name} on {entity.name}
in {datacenter.name} cannot be completed:
{reason.msg}

Critical

System

All

Reconfigured task {scheduledTask.name} on
{entity.name} in {datacenter.name}

Informational

System

All

Removed task {scheduledTask.name} on
{entity.name} in {datacenter.name}

Informational

System

All

Running task {scheduledTask.name} on
{entity.name} in {datacenter.name}

Informational

System

All

Critical

System

All

Informational

System

All

A session for user '{terminatedUsername}' has
Informational
stopped

System

All

Task: {info.descriptionId}

Informational

System

All

Task: {info.descriptionId} time-out

Informational

System

All

Resource usage exceeds configuration for
resource pool {resourcePool.name} in
compute-resource {computeResource.name}
in {datacenter.name}

A vCenter Server license has expired
vCenter started
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Upgrading template {legacyTemplate}

Informational

System

All

Cannot upgrade template {legacyTemplate}
due to: {reason.msg}

Informational

System

All

Template {legacyTemplate} upgrade
completed

Informational

System

All

Warning

System

All

There are {unlicensed} unlicensed virtual
machines on host {host} - there are only
{available} licenses available

Informational

System

All

{unlicensed} unlicensed virtual machines
found on host {host}

Informational

System

All

The agent on host {host.name} is updated and
will soon restart

Informational

System

All

User {userLogin} was added to group {group} Informational

System

All

User {userName}@{ipAddress} logged in

Informational

System

All

User {userName} logged out

Informational

System

All

Password was changed for account
{userLogin} on host {host.name}

Informational

System

All

User {userLogin} removed from group
{group}

Informational

System

All

{message}

Informational

System

All

Created VMFS datastore {datastore.name} on
{host.name} in {datacenter.name}

Informational

System

All

Expanded VMFS datastore {datastore.name}
on {host.name} in {datacenter.name}

Informational

System

All

Extended VMFS datastore {datastore.name}
on {host.name} in {datacenter.name}

Informational

System

All

A vMotion license for {host.name} has
expired

Critical

System

All

Cannot uninstall vCenter agent from
{host.name} in {datacenter.name}.
{reason.@enum.fault.AgentInstallFailed.Reas
on}

Critical

System

All

Informational

System

All

Critical

System

All

The operation performed on {host.name} in
{datacenter.name} timed out

vCenter agent has been uninstalled from
{host.name} in {datacenter.name}
Cannot upgrade vCenter agent on {host.name}
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in {datacenter.name}.
{reason.@enum.fault.AgentInstallFailed.Reas
on}
vCenter agent has been upgraded on
{host.name} in {datacenter.name}

Informational

System

All

VIM account password was changed on host
{host.name}

Informational

System

All

Remote console to {vm.name} on
{host.name} in {datacenter.name} has been
opened

Informational

System

All

A ticket for {vm.name} of type {ticketType}
on {host.name} in {datacenter.name} has
been acquired

Informational

System

All

Invalid name for {vm.name} on {host.name}
in {datacenter.name}. Renamed from
{oldName} to {newName}

Informational

System

All

Cloning {vm.name} on host {host.name} in
{datacenter.name} to {destName} on host
{destHost.name}

Informational

System

All

Cloning {vm.name} on host {host.name} in
{datacenter.name} to {destName} on host
{destHost.name}

Informational

System

All

Creating {vm.name} on host {host.name} in
{datacenter.name}

Informational

System

All

Deploying {vm.name} on host {host.name} in
{datacenter.name} from template
Informational
{srcTemplate.name}

System

All

Migrating {vm.name} from {host.name} to
{destHost.name} in {datacenter.name}

Informational

System

All

Relocating {vm.name} from {host.name} to
{destHost.name} in {datacenter.name}

Informational

System

All

Relocating {vm.name} in {datacenter.name}
from {host.name} to {destHost.name}

Informational

System

All

Critical

System

All

Clone of {sourceVm.name} completed

Informational

System

All

Configuration file for {vm.name} on
{host.name} in {datacenter.name} cannot be
found

Informational

System

All

Virtual machine {vm.name} is connected

Informational

System

All

Cannot clone {vm.name}: {reason.msg}
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Created virtual machine {vm.name} on
{host.name} in {datacenter.name}

Informational

System

All

dvPort connected to VM {vm.name} on
{host.name} in {datacenter.name} changed
status

Informational

System

All

{vm.name} on {host.name} in cluster
{computeResource.name} in
{datacenter.name} reset by HA. Reason:
{reason.@enum.VmDasBeingResetEvent.Rea
sonCode}

Informational

System

All

{vm.name} on {host.name} in cluster
{computeResource.name} in
{datacenter.name} reset by HA. Reason:
{reason.@enum.VmDasBeingResetEvent.Rea
sonCode}. A screenshot is saved at
{screenshotFilePath}.

Informational

System

All

Cannot reset {vm.name} on {host.name} in
cluster {computeResource.name} in
{datacenter.name}

Warning

System

All

Unable to update HA agents given the state of
{vm.name}

Critical

System

All

HA agents have been updated with the current
state of the virtual machine

Informational

System

All

Disconnecting all hosts as the date of virtual
machine {vm.name} has been rolled back

Critical

System

All

Cannot deploy template: {reason.msg}

Critical

System

All

Template {srcTemplate.name} deployed on
host {host.name}

Informational

System

All

{vm.name} on host {host.name} in
{datacenter.name} is disconnected

Informational

System

All

Discovered {vm.name} on {host.name} in
{datacenter.name}

Informational

System

All

Critical

System

All

Migrating {vm.name} off host {host.name} in
Informational
{datacenter.name}

System

All

End a recording session on {vm.name}

Informational

System

All

End a replay session on {vm.name}

Informational

System

All

Critical

System

All

Cannot create virtual disk {disk}

Cannot migrate {vm.name} from {host.name}
to {destHost.name} in {datacenter.name}
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Cannot complete relayout {vm.name} on
{host.name} in {datacenter.name}:
{reason.msg}

Critical

System

All

Cannot complete relayout for virtual machine
{vm.name} which has disks on a VMFS2
volume.

Critical

System

All

vCenter cannot start the Secondary VM
{vm.name}. Reason:
{reason.@enum.VmFailedStartingSecondaryE
vent.FailureReason}

Critical

System

All

Cannot power Off {vm.name} on {host.name}
in {datacenter.name}: {reason.msg}

Critical

System

All

Cannot power On {vm.name} on {host.name}
in {datacenter.name}. {reason.msg}

Critical

System

All

Cannot reboot the guest OS for {vm.name} on
{host.name} in {datacenter.name}.
{reason.msg}

Critical

System

All

Cannot suspend {vm.name} on {host.name}
in {datacenter.name}: {reason.msg}

Critical

System

All

{vm.name} cannot shut down the guest OS on
{host.name} in {datacenter.name}:
{reason.msg}

Critical

System

All

{vm.name} cannot standby the guest OS on
{host.name} in {datacenter.name}:
{reason.msg}

Critical

System

All

Cannot suspend {vm.name} on {host.name}
in {datacenter.name}: {reason.msg}

Critical

System

All

vCenter cannot update the Secondary VM
{vm.name} configuration

Critical

System

All

Failover unsuccessful for {vm.name} on
{host.name} in cluster
{computeResource.name} in
{datacenter.name}. Reason: {reason.msg}

Warning

System

All

Fault Tolerance state on {vm.name} changed
from
{oldState.@enum.VirtualMachine.FaultTolera
Informational
nceState} to
{newState.@enum.VirtualMachine.FaultToler
anceState}

System

All

Fault Tolerance protection has been turned off
Informational
for {vm.name}

System

All
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The Fault Tolerance VM ({vm.name}) has
been terminated.
Informational
{reason.@enum.VmFaultToleranceVmTermin
atedEvent.TerminateReason}

System

All

Guest OS reboot for {vm.name} on
{host.name} in {datacenter.name}

Informational

System

All

Guest OS shut down for {vm.name} on
{host.name} in {datacenter.name}

Informational

System

All

Guest OS standby for {vm.name} on
{host.name} in {datacenter.name}

Informational

System

All

VM monitoring state in
{computeResource.name} in
{datacenter.name} changed to
{state.@enum.DasConfigInfo.VmMonitoring
State}

Informational

System

All

Assign a new instance UUID
({instanceUuid}) to {vm.name}

Informational

System

All

The instance UUID of {vm.name} has been
changed from ({oldInstanceUuid}) to
({newInstanceUuid})

Informational

System

All

The instance UUID ({instanceUuid}) of
{vm.name} conflicts with the instance UUID
assigned to {conflictedVm.name}

Critical

System

All

Informational

System

All

Changed MAC address from {oldMac} to
{newMac} for adapter {adapter} for
{vm.name}

Warning

System

All

The MAC address ({mac}) of {vm.name}
conflicts with MAC assigned to
{conflictedVm.name}

Critical

System

All

Reached maximum Secondary VM (with FT
turned On) restart count for {vm.name} on
{host.name} in cluster
{computeResource.name} in
{datacenter.name}.

Warning

System

All

Reached maximum VM restart count for
{vm.name} on {host.name} in cluster
{computeResource.name} in
{datacenter.name}.

Warning

System

All

Error message on {vm.name} on {host.name}

Critical

System

All

New MAC address ({mac}) assigned to
adapter {adapter} for {vm.name}

392

Monitoring VMware Environments

in {datacenter.name}: {message}
Message on {vm.name} on {host.name} in
{datacenter.name}: {message}

Informational

System

All

Warning

System

All

Migration of virtual machine {vm.name} from
Informational
{sourceHost.name} to {host.name} completed

System

All

No compatible host for the Secondary VM
{vm.name}

Critical

System

All

Not all networks for {vm.name} are accessible
by {destHost.name}

Warning

System

All

{vm.name} does not exist on {host.name} in
{datacenter.name}

Warning

System

All

{vm.name} was powered Off on the isolated
host {isolatedHost.name} in cluster
{computeResource.name} in
{datacenter.name}

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is powered off

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is powered on

Informational

System

All

Virtual machine {vm.name} powered On with
vNICs connected to dvPorts that have a port
Informational
level configuration, which might be different
from the dvPort group configuration.

System

All

VM ({vm.name}) failed over to {host.name}.
{reason.@enum.VirtualMachine.NeedSecond
aryReason}

Critical

System

All

Reconfigured {vm.name} on {host.name} in
{datacenter.name}

Informational

System

All

Registered {vm.name} on {host.name} in
{datacenter.name}

Informational

System

All

Relayout of {vm.name} on {host.name} in
{datacenter.name} completed

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is in the correct format and
relayout is not necessary

Informational

System

All

{vm.name} on {host.name} reloaded from
new configuration {configPath}.

Informational

System

All

Warning message on {vm.name} on
{host.name} in {datacenter.name}: {message}
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{vm.name} on {host.name} could not be
reloaded from {configPath}.

Critical

System

All

Cannot relocate virtual machine '{vm.name}'
in {datacenter.name}

Critical

System

All

Completed the relocation of the virtual
machine

Informational

System

All

Remote console connected to {vm.name} on
host {host.name}

Informational

System

All

Remote console disconnected from
{vm.name} on host {host.name}

Informational

System

All

Removed {vm.name} on {host.name} from
{datacenter.name}

Informational

System

All

Warning

System

All

{vm.name} on {host.name} in
{datacenter.name} is reset

Informational

System

All

Moved {vm.name} from resource pool
{oldParent.name} to {newParent.name} in
{datacenter.name}

Informational

System

All

Changed resource allocation for {vm.name}

Informational

System

All

Virtual machine {vm.name} was restarted on
{host.name} since {sourceHost.name} failed

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is resumed

Informational

System

All

A Secondary VM has been added for
{vm.name}

Informational

System

All

Critical

System

All

Disabled Secondary VM for {vm.name}

Informational

System

All

Enabled Secondary VM for {vm.name}

Informational

System

All

Started Secondary VM for {vm.name}

Informational

System

All

{vm.name} was shut down on the isolated
host {isolatedHost.name} in cluster
{computeResource.name} in
Informational
{datacenter.name}:
{shutdownResult.@enum.VmShutdownOnIso
lationEvent.Operation}

System

All

Renamed {vm.name} from {oldName} to
{newName} in {datacenter.name}

vCenter disabled Fault Tolerance on VM
'{vm.name}' because the Secondary VM could
not be powered On.
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Start a recording session on {vm.name}

Informational

System

All

Start a replay session on {vm.name}

Informational

System

All

{vm.name} on host {host.name} in
{datacenter.name} is starting

Informational

System

All

Starting Secondary VM for {vm.name}

Informational

System

All

Critical

System

All

{vm.name} on {host.name} in
{datacenter.name} is stopping

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is suspended

Informational

System

All

{vm.name} on {host.name} in
{datacenter.name} is being suspended

Informational

System

All

Starting the Secondary VM {vm.name} timed
out within {timeout} ms

Critical

System

All

Unsupported guest OS {guestId} for
{vm.name} on {host.name} in
{datacenter.name}

Warning

System

All

Virtual hardware upgraded to version
{version}

Informational

System

All

Critical

System

All

Upgrading virtual hardware on {vm.name} in
{datacenter.name} to version {version}

Informational

System

All

Assigned new BIOS UUID ({uuid}) to
{vm.name} on {host.name} in
{datacenter.name}

Informational

System

All

Changed BIOS UUID from {oldUuid} to
{newUuid} for {vm.name} on {host.name} in
{datacenter.name}

Warning

System

All

BIOS ID ({uuid}) of {vm.name} conflicts
with that of {conflictedVm.name}

Critical

System

All

New WWNs assigned to {vm.name}

Informational

System

All

WWNs are changed for {vm.name}

Warning

System

All

The WWN ({wwn}) of {vm.name} conflicts
with the currently registered WWN

Critical

System

All

{message}

Warning

System

All

The static MAC address ({mac}) of
{vm.name} conflicts with MAC assigned to
{conflictedVm.name}

Cannot upgrade virtual hardware
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Booting from iSCSI failed with an error. See
the VMware Knowledge Base for information
on configuring iBFT networking.

Warning

System

All

com.vmware.license.AddLicenseEvent|
License {licenseKey} added to VirtualCenter

Informational

System

All

com.vmware.license.AssignLicenseEvent|
License {licenseKey} assigned to asset
{entityName} with id {entityId}

Informational

System

All

Warning

System

All

com.vmware.license.LicenseAssignFailedEve
nt|License assignment on the host fails.
Reasons:
Informational
{errorMessage.@enum.com.vmware.license.L
icenseAssignError}.

System

All

com.vmware.license.LicenseExpiryEvent|
Your host license will expire in
{remainingDays} days. The host will be
disconnected from VC when its license
expires.

Warning

System

All

com.vmware.license.LicenseUserThresholdEx
ceededEvent|Current license usage
({currentUsage} {costUnitText}) for
{edition} exceeded the user-defined threshold
({threshold} {costUnitText})

Warning

System

All

com.vmware.license.RemoveLicenseEvent|
License {licenseKey} removed from
VirtualCenter

Informational

System

All

com.vmware.license.UnassignLicenseEvent|
License unassigned from asset {entityName}
with id {entityId}

Informational

System

All

com.vmware.vc.HA.ClusterFailoverActionCo
mpletedEvent|HA completed a failover action
in cluster {computeResource.name} in
datacenter {datacenter.name}

Informational

System

All

com.vmware.vc.HA.ClusterFailoverActionInit
iatedEvent|HA initiated a failover action in
cluster {computeResource.name} in
datacenter {datacenter.name}

Warning

System

All

com.vmware.license.DLFDownloadFailedEve
nt|Failed to download license information
from the host {hostname} due to
{errorReason.@enum.com.vmware.license.D
LFDownloadFailedEvent.DLFDownloadFaile
dReason}
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com.vmware.vc.HA.DasAgentRunningEvent|
HA Agent on host {host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} is running

Informational

System

All

com.vmware.vc.HA.DasFailoverHostFailedEv
ent|HA failover host {host.name} in cluster
{computeResource.name} in
{datacenter.name} has failed

Critical

System

All

com.vmware.vc.HA.DasHostCompleteDatasto
reFailureEvent|All shared datastores failed on
the host {hostName} in cluster
{computeResource.name} in
{datacenter.name}

Critical

System

All

com.vmware.vc.HA.DasHostCompleteNetwor
kFailureEvent|All VM networks failed on the
host {hostName} in cluster
{computeResource.name} in
{datacenter.name}

Critical

System

All

com.vmware.vc.HA.DasHostFailedEvent|A
possible host failure has been detected by HA
on host {host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name}

Critical

System

All

com.vmware.vc.HA.DasHostMonitoringDisab
ledEvent|No virtual machine failover will
occur until Host Monitoring is enabled in
cluster {computeResource.name} in
{datacenter.name}

Warning

System

All

com.vmware.vc.HA.DasTotalClusterFailureE
vent|HA recovered from a total cluster failure
in cluster {computeResource.name} in
datacenter {datacenter.name}

Warning

System

All

com.vmware.vc.HA.HostDasAgentHealthyEv
ent|HA Agent on host {host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} is healthy

Informational

System

All

com.vmware.vc.HA.HostDasErrorEvent|HA
agent on {host.name} in cluster
{computeResource.name} in
{datacenter.name} has an error:
{reason.@enum.HostDasErrorEvent.HostDas
ErrorReason}

Critical

System

All

System

All

com.vmware.vc.VCHealthStateChangedEvent Informational
|vCenter Service overall health changed from
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'{oldState}' to '{newState}'
com.vmware.vc.cim.CIMGroupHealthStateCh
anged|Health of [data.group] changed from
Informational
[data.oldState] to [data.newState].

System

All

com.vmware.vc.datastore.UpdateVmFilesFail
edEvent|Failed to update VM files on
datastore {ds.name} using host {hostName}

Critical

System

All

com.vmware.vc.datastore.UpdatedVmFilesEv
ent|Updated VM files on datastore {ds.name}
using host {hostName}

Informational

System

All

com.vmware.vc.datastore.UpdatingVmFilesE
vent|Updating VM files on datastore
{ds.name} using host {hostName}

Informational

System

All

com.vmware.vc.ft.VmAffectedByDasDisable
dEvent|VMware HA has been disabled in
cluster {computeResource.name} of
datacenter {datacenter.name}. HA will not
restart VM {vm.name} or its Secondary VM
after a failure.

Warning

System

All

com.vmware.vc.npt.VmAdapterEnteredPassth
roughEvent|Network passthrough is active on
adapter {deviceLabel} of virtual machine
{vm.name} on host {host.name} in
{datacenter.name}

Informational

System

All

com.vmware.vc.npt.VmAdapterExitedPassthr
oughEvent|Network passthrough is inactive on
adapter {deviceLabel} of virtual machine
Informational
{vm.name} on host {host.name} in
{datacenter.name}

System

All

com.vmware.vc.vcp.FtDisabledVmTreatAsNo
nFtEvent|HA VM Component Protection
protects virtual machine {vm.name} on
{host.name} in cluster
Informational
{computeResource.name} in datacenter
{datacenter.name} as non-FT virtual machine
because the FT state is disabled

System

All

com.vmware.vc.vcp.FtFailoverEvent|FT
Primary VM {vm.name} on host {host.name}
in cluster {computeResource.name} in
datacenter {datacenter.name} is going to fail
over to Secondary VM due to component
failure

Informational

System

All

com.vmware.vc.vcp.FtFailoverFailedEvent|FT

Critical

System

All
398

Monitoring VMware Environments

virtual machine {vm.name} on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} failed to failover to
secondary
com.vmware.vc.vcp.FtSecondaryRestartEvent|
HA VM Component Protection is restarting
FT secondary virtual machine {vm.name} on
Informational
host {host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} due to component failure

System

All

com.vmware.vc.vcp.FtSecondaryRestartFailed
Event|FT Secondary VM {vm.name} on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} failed to restart

System

All

com.vmware.vc.vcp.NeedSecondaryFtVmTre
atAsNonFtEvent|HA VM Component
Protection protects virtual machine
{vm.name} on host {host.name} in cluster
Informational
{computeResource.name} in datacenter
{datacenter.name} as non-FT virtual machine
because it has been in the needSecondary state
too long

System

All

com.vmware.vc.vcp.TestEndEvent|VM
Component Protection test ends on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name}

Informational

System

All

com.vmware.vc.vcp.TestStartEvent|VM
Component Protection test starts on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name}

Informational

System

All

com.vmware.vc.vcp.VcpNoActionEvent|HA
VM Component Protection did not take action
on virtual machine {vm.name} on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} due to the feature
configuration setting

Informational

System

All

Critical

System

All

com.vmware.vc.vcp.VmDatastoreFailedEvent|
Virtual machine {vm.name} on host
{host.name} in cluster
{computeResource.name} in datacenter

Critical
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{datacenter.name} lost access to {datastore}
com.vmware.vc.vcp.VmNetworkFailedEvent|
Virtual machine {vm.name} on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} lost access to {network}

Critical

System

All

com.vmware.vc.vcp.VmPowerOffHangEvent|
HA VM Component Protection could not
power off virtual machine {vm.name} on host
{host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} successfully after trying
{numTimes} times and will keep trying

Critical

System

All

com.vmware.vc.vcp.VmRestartEvent|HA VM
Component Protection is restarting virtual
machine {vm.name} due to component failure
Informational
on host {host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name}

System

All

com.vmware.vc.vcp.VmRestartFailedEvent|
Virtual machine {vm.name} affected by
component failure on host {host.name} in
cluster {computeResource.name} in
datacenter {datacenter.name} failed to restart

Critical

System

All

com.vmware.vc.vcp.VmWaitForCandidateHo
stEvent|HA VM Component Protection could
not find a destination host for virtual machine
{vm.name} on host {host.name} in cluster
{computeResource.name} in datacenter
{datacenter.name} after waiting
{numSecWait} seconds and will keep trying

Critical

System

All

com.vmware.vc.vmam.AppMonitoringNotSup
ported|Application monitoring is not
supported on {host.name} in cluster
{computeResource.name} in
{datacenter.name}

Warning

System

All

com.vmware.vc.vmam.VmAppHealthMonitor
ingStateChangedEvent|Application heartbeat
status changed to {status} for {vm.name} on
{host.name} in cluster
{computeResource.name} in
{datacenter.name}

Warning

System

All

Warning

System

All

com.vmware.vc.vmam.VmDasAppHeartbeatF
ailedEvent|Application heartbeat failed for
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{vm.name} on {host.name} in cluster
{computeResource.name} in
{datacenter.name}
esx.clear.net.connectivity.restored|Network
connectivity restored on virtual switch {1},
portgroups: {2}. Physical NIC {3} is up.

Informational

System

All

esx.clear.net.dvport.connectivity.restored|
Network connectivity restored on DVPorts:
{1}. Physical NIC {2} is up.

Informational

System

All

esx.clear.net.dvport.redundancy.restored|
Uplink redundancy restored on DVPorts: {1}.
Physical NIC {2} is up.

Informational

System

All

esx.clear.net.redundancy.restored|Uplink
redundancy restored on virtual switch {1},
portgroups: {2}. Physical NIC {3} is up.

Informational

System

All

esx.clear.net.vmnic.linkstate.up|Physical NIC
{1} linkstate is up.

Informational

System

All

esx.clear.storage.connectivity.restored|
Connectivity to storage device {1}
(Datastores: {2}) restored. Path {3} is active
again.

Informational

System

All

esx.clear.storage.redundancy.restored|Path
redundancy to storage device {1} (Datastores:
{2}) restored. Path {3} is active again.

Informational

System

All

esx.problem.apei.bert.memory.error.corrected|
A corrected memory error occurred in last
boot. The following details were reported.
Physical Addr: {1}, Physical Addr Mask: {2},
Node: {3}, Card: {4}, Module: {5}, Bank:
{6}, Device: {7}, Row: {8}, Column: {9}
Error type: {10}

Critical

System

All

esx.problem.apei.bert.memory.error.fatal|A
fatal memory error occurred in the last boot.
The following details were reported. Physical
Addr: {1}, Physical Addr Mask: {2}, Node:
{3}, Card: {4}, Module: {5}, Bank: {6},
Device: {7}, Row: {8}, Column: {9} Error
type: {10}

Critical

System

All

Critical

System

All

esx.problem.apei.bert.memory.error.recoverab
le|A recoverable memory error occurred in last
boot. The following details were reported.
Physical Addr: {1}, Physical Addr Mask: {2},
Node: {3}, Card: {4}, Module: {5}, Bank:
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{6}, Device: {7}, Row: {8}, Column: {9}
Error type: {10}
esx.problem.apei.bert.pcie.error.corrected|A
corrected PCIe error occurred in last boot. The
following details were reported. Port Type:
{1}, Device: {2}, Bus #: {3}, Function: {4},
Slot: {5}, Device Vendor: {6}, Version: {7},
Command Register: {8}, Status Register: {9}.

Critical

System

All

esx.problem.apei.bert.pcie.error.fatal|Platform
encounterd a fatal PCIe error in last boot. The
following details were reported. Port Type:
{1}, Device: {2}, Bus #: {3}, Function: {4},
Slot: {5}, Device Vendor: {6}, Version: {7},
Command Register: {8}, Status Register: {9}.

Critical

System

All

esx.problem.apei.bert.pcie.error.recoverable|A
recoverable PCIe error occurred in last boot.
The following details were reported. Port
Type: {1}, Device: {2}, Bus #: {3}, Function:
{4}, Slot: {5}, Device Vendor: {6}, Version:
{7}, Command Register: {8}, Status Register:
{9}.

Critical

System

All

esx.problem.iorm.nonviworkload|An external
I/O activity is detected on datastore {1}, this
is an unsupported configuration. Consult the
Resource Management Guide or follow the
Ask VMware link for more information.

Informational

System

All

esx.problem.net.connectivity.lost|Lost
network connectivity on virtual switch {1}.
Physical NIC {2} is down. Affected
portgroups:{3}.

Critical

System

All

esx.problem.net.dvport.connectivity.lost|Lost
network connectivity on DVPorts: {1}.
Physical NIC {2} is down.

Critical

System

All

esx.problem.net.dvport.redundancy.degraded|
Uplink redundancy degraded on DVPorts:
{1}. Physical NIC {2} is down.

Warning

System

All

esx.problem.net.dvport.redundancy.lost|Lost
uplink redundancy on DVPorts: {1}. Physical
NIC {2} is down.

Warning

System

All

Critical

System

All

esx.problem.net.e1000.tso6.notsupported|
Guest-initiated IPv6 TCP Segmentation
Offload (TSO) packets ignored. Manually
disable TSO inside the guest operating system
in virtual machine {1}, or use a different
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virtual adapter.
esx.problem.net.migrate.bindtovmk|The ESX
advanced configuration option
/Migrate/Vmknic is set to an invalid vmknic:
{1}. /Migrate/Vmknic specifies a vmknic that
vMotion binds to for improved performance.
Update the configuration option with a valid
vmknic. Alternatively, if you do not want
vMotion to bind to a specific vmknic, remove
the invalid vmknic and leave the option blank.

Warning

System

All

esx.problem.net.proxyswitch.port.unavailable|
Virtual NIC with hardware address {1} failed
to connect to distributed virtual port {2} on
switch {3}. There are no more ports available
on the host proxy switch.

Warning

System

All

esx.problem.net.redundancy.degraded|Uplink
redundancy degraded on virtual switch {1}.
Physical NIC {2} is down. Affected
portgroups:{3}.

Warning

System

All

esx.problem.net.redundancy.lost|Lost uplink
redundancy on virtual switch {1}. Physical
NIC {2} is down. Affected portgroups:{3}.

Warning

System

All

esx.problem.net.uplink.mtu.failed|VMkernel
failed to set the MTU value {1} on the uplink
{2}.

Warning

System

All

esx.problem.net.vmknic.ip.duplicate|A
duplicate IP address was detected for {1} on
the interface {2}. The current owner is {3}.

Warning

System

All

esx.problem.net.vmnic.linkstate.down|
Physical NIC {1} linkstate is down.

Informational

System

All

esx.problem.net.vmnic.watchdog.reset|Uplink
{1} has recovered from a transient failure due
to watchdog timeout

Informational

System

All

esx.problem.scsi.device.limitreached|The
maximum number of supported devices of {1}
has been reached. A device from plugin {2}
could not be created.

Critical

System

All

esx.problem.scsi.device.thinprov.atquota|
Space utilization on thin-provisioned device
{1} exceeded configured threshold. Affected
datastores (if any): {2}.

Warning

System

All

Critical

System

All

esx.problem.scsi.scsipath.limitreached|The
maximum number of supported paths of {1}
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has been reached. Path {2} could not be
added.
esx.problem.storage.connectivity.devicepor|
Frequent PowerOn Reset Unit Attentions are
occurring on device {1}. This might indicate a
storage problem. Affected datastores: {2}

Warning

System

All

esx.problem.storage.connectivity.lost|Lost
connectivity to storage device {1}. Path {2} is
down. Affected datastores: {3}.

Critical

System

All

esx.problem.storage.connectivity.pathpor|
Frequent PowerOn Reset Unit Attentions are
occurring on path {1}. This might indicate a
storage problem. Affected device: {2}.
Affected datastores: {3}

Warning

System

All

esx.problem.storage.connectivity.pathstatecha
nges|Frequent path state changes are occurring
for path {1}. This might indicate a storage
problem. Affected device: {2}. Affected
datastores: {3}

Warning

System

All

esx.problem.storage.redundancy.degraded|
Path redundancy to storage device {1}
degraded. Path {2} is down. Affected
datastores: {3}.

Warning

System

All

esx.problem.storage.redundancy.lost|Lost path
redundancy to storage device {1}. Path {2} is
down. Affected datastores: {3}.

Warning

System

All

Informational

System

All

esx.problem.vmfs.heartbeat.timedout|Lost
access to volume {1} ({2}) due to
Informational
connectivity issues. Recovery attempt is in
progress and outcome will be reported shortly.

System

All

esx.problem.vmfs.heartbeat.unrecoverable|
Lost connectivity to volume {1} ({2}) and
subsequent recovery attempts have failed.

Critical

System

All

esx.problem.vmfs.journal.createfailed|No
space for journal on volume {1} ({2}).
Opening volume in read-only metadata mode
with limited write support.

Critical

System

All

Critical

System

All

esx.problem.vmfs.heartbeat.recovered|
Successfully restored access to volume {1}
({2}) following connectivity issues.

esx.problem.vmfs.lock.corruptondisk|At least
one corrupt on-disk lock was detected on
volume {1} ({2}). Other regions of the
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volume might be damaged too.
esx.problem.vmfs.nfs.mount.connect.failed|
Failed to mount to the server {1} mount point
{2}. {3}

Critical

System

All

esx.problem.vmfs.nfs.mount.limit.exceeded|
Failed to mount to the server {1} mount point
{2}. {3}

Critical

System

All

esx.problem.vmfs.nfs.server.disconnect|Lost
connection to server {1} mount point {2}
mounted as {3} ({4}).

Critical

System

All

esx.problem.vmfs.nfs.server.restored|Restored
connection to server {1} mount point {2}
mounted as {3} ({4}).

Informational

System

All

esx.problem.vmfs.resource.corruptondisk|At
least one corrupt resource metadata region
was detected on volume {1} ({2}). Other
regions of the volume might be damaged too.

Critical

System

All

esx.problem.vmfs.volume.locked|Volume on
device {1} locked, possibly because remote
host {2} encountered an error during a volume
operation and could not recover.

Critical

System

All

vim.event.LicenseDowngradedEvent|License
downgrade: {licenseKey} removes the
following features: {lostFeatures}

Warning

System

All

vprob.net.connectivity.lost|Lost network
connectivity on virtual switch {1}. Physical
NIC {2} is down. Affected portgroups:{3}.

Critical

System

All

vprob.net.e1000.tso6.notsupported|Guestinitiated IPv6 TCP Segmentation Offload
(TSO) packets ignored. Manually disable TSO
inside the guest operating system in virtual
machine {1}, or use a different virtual adapter.

Critical

System

All

vprob.net.migrate.bindtovmk|The ESX
advanced config option /Migrate/Vmknic is
set to an invalid vmknic: {1}.
/Migrate/Vmknic specifies a vmknic that
vMotion binds to for improved performance.
Please update the config option with a valid
vmknic or, if you do not want vMotion to bind
to a specific vmknic, remove the invalid
vmknic and leave the option blank.

Warning

System

All

Warning

System

All

vprob.net.proxyswitch.port.unavailable|Virtual
NIC with hardware address {1} failed to
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connect to distributed virtual port {2} on
switch {3}. There are no more ports available
on the host proxy switch.
vprob.net.redundancy.degraded|Uplink
redundancy degraded on virtual switch {1}.
Physical NIC {2} is down. {3} uplinks still
up. Affected portgroups:{4}.

Warning

System

All

vprob.net.redundancy.lost|Lost uplink
redundancy on virtual switch {1}. Physical
NIC {2} is down. Affected portgroups:{3}.

Warning

System

All

vprob.scsi.device.thinprov.atquota|Space
utilization on thin-provisioned device {1}
exceeded configured threshold.

Warning

System

All

vprob.storage.connectivity.lost|Lost
connectivity to storage device {1}. Path {2} is
down. Affected datastores: {3}.

Critical

System

All

vprob.storage.redundancy.degraded|Path
redundancy to storage device {1} degraded.
Path {2} is down. {3} remaining active paths.
Affected datastores: {4}.

Warning

System

All

vprob.storage.redundancy.lost|Lost path
redundancy to storage device {1}. Path {2} is
down. Affected datastores: {3}.

Warning

System

All

vprob.vmfs.heartbeat.recovered|Successfully
restored access to volume {1} ({2}) following
connectivity issues.

Informational

System

All

vprob.vmfs.heartbeat.timedout|Lost access to
volume {1} ({2}) due to connectivity issues.
Recovery attempt is in progress and outcome
will be reported shortly.

Informational

System

All

vprob.vmfs.heartbeat.unrecoverable|Lost
connectivity to volume {1} ({2}) and
subsequent recovery attempts have failed.

Critical

System

All

vprob.vmfs.journal.createfailed|No space for
journal on volume {1} ({2}). Opening volume
in read-only metadata mode with limited write
support.

Critical

System

All

vprob.vmfs.lock.corruptondisk|At least one
corrupt on-disk lock was detected on volume
{1} ({2}). Other regions of the volume may
be damaged too.

Critical

System

All

vprob.vmfs.nfs.server.disconnect|Lost

Critical

System

All
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connection to server {1} mount point {2}
mounted as {3} ({4}).
vprob.vmfs.nfs.server.restored|Restored
connection to server {1} mount point {2}
mounted as {3} ({4}).

Informational

System

All

vprob.vmfs.resource.corruptondisk|At least
one corrupt resource metadata region was
detected on volume {1} ({2}). Other regions
of the volume might be damaged too.

Critical

System

All

vprob.vmfs.volume.locked|Volume on device
{1} locked, possibly because remote host {2}
encountered an error during a volume
operation and could not recover.

Critical

System

All

15.3. Monitoring RHEV Environments
Red Hat Enterprise Virtualization (RHEV) is one of the most excessively used virtualization
technologies by companies with a Data Center based on Red Hat. Pandora FMS offers the
possibility to monitor virtual architectures based on RHEV by the RHEV Monitoring Plug in which
allows you to easily control all variables related to the RHEV virtual architecture.

15.3.1. Monitoring RHEV Architectures
You're able to monitor the entire RHEV architecture by this plug in, e.g. Data Centers, Host Clusters,
Storage Domains, Networks, Hosts and Virtual Machines, offering a global view of the virtual
environment status.
Pandora FMS utilizes the official API which is provided by the RHEV virtualization system to
accomplish this.

15.3.2. Monitoring by RHEV Monitoring Plug In
RHEV environment monitoring is based on three components:
1.An agent plug in which performs entity autodiscoveries and data collection tasks. This
agent plug in sends information to Pandora FMS.
2.A recon script which updates several parameters of entities discovered. This script is
required for extensions.
3.Several RHEV View and RHEV Manager extensions. These are extensions which provide an
added value to the plug in, allowing you to see all the monitored infrastructure and
managing virtual machines (switch on/switch off) by the Pandora FMS Console.

To be able to use any kind of Recon Script, you're required to enable the Recon Server
first.

407

Monitoring RHEV Environments

To ensure some API variables to return the correct data of any associated virtual
machine, you're required to install the RHEV Agent. You can find all information on
how to do that by taking a look into the RHEV Documentation.

To monitor an operating system installed on a virtual machine, it's recommended to use
a Pandora FMS Agent instead of the RHEV API.

15.3.2.1. How Plug Ins work
The RHEV Monitoring Plug ins extract information by the web API of RHEV virtualization
environments.
If you just want to monitor, please configure the software agent plug in which performs this task.
The agent plug in performs the device's auto discovery and creates an XML file along with modules
for each discovered device. The plugin configuration allows you to select which elements you want
to monitor and to configure the modules. The modules created by the plug in are completely
configurable. You're also able to change names and descriptions and to add 'max' and 'min' values
for the 'Warning' and 'Critical' states of the module.

The updating of values for the 'Warning' and 'Critical' states by using XML is only
available for Pandora FMS 4.0 or higher versions. For earlier versions, you're required
to perform this task by using the web console.

Once the XML files are created, the agent plug in sends the files  either by using Tentacle or by
copying them to local files, depending on the selected transfer method.
If you also intend to use the 'RHEV View' and 'RHEV Manager' extensions, you're required to use the
Recon Script to do so.
The Recon Script updates several values of each Pandora FMS Agent present in the RHEV
virtualization environment. These variables are required to visualize entities properly in the 'RHEV
View' extension and to manage virtual machines properly by the 'RHEV Manager' extension.

15.3.3. Installation Requirements
The agent plug in requires the following software:
•curl
•perlXMLSimple
•Pandora FMS Software Agent
•tentacle_client (if you want to use tentacle to send files. The 'tentacle_client' file is provided
along with the Pandora FMS Software Agent)
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15.3.3.1. Red Hat
Under Red Hatbased systems, you may install the dependencies by the following command:
yum install perl-XML-Simple curl

15.3.3.2. SLES
Under SUSEbased systems, you may install the dependencies by the following command:
zypper install perl-XML-Simple curl

15.3.3.3. Debian / Ubuntu
Under Debian or Ubuntubased systems, you may install the dependencies by the following
command:
sudo apt-get install libxml-simple-perl curl

15.3.3.4. Installing the Pandora FMS Software Agent
The Pandora FMS Software Agent Installation is explained in the section named Installing Pandora
FMS, where you're able to find all relevant information regarding the installation of Pandora FMS
Agents onto your platform.

15.3.4. Downloading the RHEV Certificate
Before you're able to execute the plug in, you're required to download the certificate to connect to
the RHEV API using HTTPS. To download the certificate, please execute the following command:
curl -o rhevm.cer http://[RHEVM-HOST]:8080/ca.crt

[RHEVMHOST] is the name of the RHEV API server, e.g.:
curl -o rhevm.cer http://rhevm.server:8080/ca.crt

Once the certificate is downloaded, you can make sure the API connection works fine with the
following command:
curl -X GET -H "Accept: application/xml" -u [USER:PASS] --cacert [CERT] https://[RHEVMHOST]:8443/api

Value explanation:
•USER: [user@domain] to connect to the API.
•PASS: Password for the user to connect to API.
•CERT: The path of the downloaded certificate.
•RHEVMHOST: The address of the host API.
A pretty good example with some real data could look like this:
curl -X GET -H "Accept: application/xml" -u [user@testdomain:12345] --cacert /home/user/ca.crt
https://rhevm.server:8443/api

If all goes fine, the command is going to return an output in the XML format, along with some
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general information about the RHEV API.

15.3.5. Considerations on RHEV Configuration
In the RHEV virtualization environment, it's possible for several entities to bear the same name. This
feature creates quite a problem for Pandora FMS, because these entities are transformed to agents 
and two agents bearing the same name are not allowed. In addition to this difficulty, it creates
problems by parsing the output of an API in XML format, which could result in an error just as this:
Warning: <data_center> element has non-unique value in 'name' key attribute: Default at ./pluginrhev.pl line 199

To solve this problem, you're required to follow a name policy for entities of the RHEV virtualization
environment which doesn't allow duplicate names.

15.3.6. Agent Plugin Installation
To install the agent plug in, please copy the files 'rhevplugin.pl' and 'rhevplugin.conf' in a folder
which is accessible by the Pandora FMS Agent and installed on the machine you want to execute the
plug in on. The plugin could be executed by an agent which is installed on the same machine the
Pandora FMS Server runs on or on another.
To execute the plug in, you're required to enter an additional line to the agent configuration file
(which is located under '/etc/pandora/pandora_agent.conf' by default):
module_plugin /root/rhev-plugin.pl /root/rhev-plugin.conf

By adding this line to the configuration file, the agent plug in is going to perform its actions on
every execution of the agent.

15.3.7. Monitoring RHEV Virtual Architecture
To see the result of the plugin execution, please click on 'Monitoring' > 'Agent Detail'.

As you can see, the plugin creates one Pandora FMS Agent for each detected entity if it discovers an
RHEV architecture:
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If you click on the agent name, you're able to see the monitoring modules created by the plug in.
You're also able to see other agentrelated data:

For each kind of entity, several modules are created automatically, which are monitoring important
information from each of them. The next picture e.g. shows several modules which were created to
monitor a virtual machine:
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If an agent is associated to a Host instead of a Virtual Machine, the monitored modules are
different. The following picture shows an example of modules for a host entity:
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The RHEV plugin also monitors the occurred events in virtual architectures. The plugin creates a
module for every event monitor in every affected agent:

The data of these eventbased modules are:
•The hour in which the event occurred
•The event description.
You can see an example of this data on the picture below:
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In addition to the agents and modules related to RHEV architecture, a module is generated on the
agent which executes the plug in. This module is called 'RHEV Plugin' by default. You're able to see
a result example for this module on the image below:

The content of this plug in is going to be the result of the plugin execution. It could be something
simple like 'OK' if it's conduct was flawless. It could also show an error string, explaining the error if
something unexpected occurs. This information is also available in a log file.

15.3.7.1. Monitoring the Status of Entities
The status modules of entities are going to return the predefined values of any RHEV architecture.
This means the values are going to be strings which have a content similar to:
•'up'
•'down'
•'error'
•'maintenance',
•'non_operational'
It all depends on the status and the monitored entity.
To assign 'warning' and 'critical' values, you're required to define a regular expression within the
module configuration. To e.g. define the module to be in a 'critical' status if the values are 'error',
'down' or 'non_operational', please add the following regular expression to the 'critical' value of the
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'Str.' field:
error|down|non_operational

It's not possible to use this option for older versions than Pandora FMS 4.0, but you're still able to
define the alert by using the same condition. To create an alert template by the previous example,
please follow the below mentioned steps:
1.Create an alert template with 'critical' priority and set the field named 'condition type' to
'regular expression'.
2.Insert the regular expression in the field value as follows: 'error|down|non_operational'. It
means, the alert is going to be fired if the module values are 'error', 'down' or
'non_operational'.
3.Please complete the next step as usual.
Once template is defined, you're able to select any action to execute in case the alert gets triggered,
e.g. creating an event, sending an email or SMS, etc.

15.3.8. Agent Modules for the RHEV Architecture
The available modules for each element of the RHEV architecture are the following:

15.3.8.1. Data Centers
•Status: The Data Center's status.

15.3.8.2. Storage Domains
•Available Space: The available space of a storage domain.
•Committed Space: The dedicated space of a storage domain.
•Used Space: The currently used space of a storage domain.
•Percent Free Space: The percentage of free space on a storage domain.

15.3.8.3. Networks
•Status: The virtual network's status.
•STP Status: The Spanning Tree Protocol's status.

15.3.8.4. Clusters
•Overcommit Percent: The overcommit percentage of the cluster.
•Transparent HugePages: The transparent HugePage status.
•High threshold: The 'high' threshold for policy planning.
•Low threshold: The 'low' threshold for policy planning.
•Threshold duration: The threshold duration for policy planning.

15.3.8.5. Hosts
•Status: The host's status.
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•Buffers size: The buffer size.
•Cache size: The cache size.
•Cached swap: The amount of memory for cached swap (in bytes).
•Free memory: The amount of free memory (in bytes).
•Percent free memory: The percentage of free memory.
•Swap cached percent: The percentage of cached swap memory.
•Swap free: The amount of free swapping space (in bytes).
•Swap free percent: The percentage of free swap memory.
•Total Memory: The amount of total memory for this Host (in bytes).
•Total Swap: The amount of swap memory (in bytes).
•Used memory: The amount of used memory (in bytes).
•Used Swap: The amount of used swap memory (in bytes).
•Nic [x] TX: The transmission rate for NIC x (in bytes per sec.). It's going to generate one
module for each interface.
•Nic [x] RX: The reception rate for NIC x (in bytes per sec.). It's going to generate one
module for each interface.
•Nic [x] erros TX: The number of transmission errors for NIC x. It's going to generate one
module for each interface.
•Nic [x] erros RX: The number of reception errors for NIC x. It's going to generate one
module for each interface.
•User CPU: The percentage of CPU used by user.
•System CPU: The used percentage of the CPU by the system.
•CPU Idle: The idle percentage of the CPU.
•CPU Load: The average CPU load for the last 5 minutes.
•KSM CPU: The percentage of the CPU which gets used by the KSM.
•Active VM: The number of active virtual machines on the host.
•Migrating VM: The number of virtual machines currently in the process of migrating on the
host.
•Total VM: The total number of virtual machines for this host.
•Fence Status: The status of host fencing.

15.3.8.6. Virtual Machines
•Status: The virtual machine's status.
•Disk [x] read: The disk read rate for disk x (in bytes / sec.). It's going to generate one
module for each disk.
•Disk [x] write: The disk write rate for disk x (in bytes / sec.). It's going to generate one
module for each disk.
•Disk [x] size: The disk size for disk x. It's going to generate one module for each disk.
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•Disk [x] status: The status of disk x. It's going to generate one module for each disk.
•Nic [x] TX: The transmission rate for NIC x (in bytes / sec.). It's going to generate one
module for each NIC.
•Nic [x] RX: The reception rate for NIC x (in bytes / sec.). It's going to generate one module
for each NIC.
•Nic [x] erros TX: The number of transmission errors for NIC x. It's going to generate one
module for each NIC.
•Nic [x] erros RX: The number of reception errors for NIC x. It's going to generate one
module for each NIC.
•Installed memory: The amount of installed memory (in bytes).
•Percent free memory: The percentage of free memory.
•Used memory: The amount of used memory (in bytes).
•Stateless: The status of the 'stateless' feature.
•HA Status: The status of the HA (High Accessibility) feature.
•Total CPU: The percentage of the total used CPU load by this virtual machine.
•Hypervisor CPU: The percentage of the hypervisor CPU load used by virtual machine.
•Guest CPU: The percentage of host CPU load used by the virtual machine.

15.3.8.7. Events
•Event [x]: The description for event x which occurred on the system. For every detected
event, one module is created within each affected agent.

15.3.9. Managing and Viewing of the RHEV Architecture
This section explains the installation and configuration of the RHEV Architecture and how the
'RHEV View' and 'RHEV Manager' extensions work.

The 'RHEV View' and 'RHEV Manager' extensions are only going to work in
conjunction with Pandora FMS 4.0.2 or higher versions.

15.3.9.1. Recon Task Installation
The following is a detailed explanation of Recon Script Installation and Recon Task Creation which
are going to update the variables used by the extensions.
Recon Script Installation

Prior to the creation of the Recon Task, you're required to register the 'Recon Script' which updates
the values which are required by the extensions. Please click on 'Manage Servers' and on 'Manage
recon script' to do so.
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Once the main screen of 'Manage recon script' has popped up, please click on the 'Add' button.

In this moment, a form to enter the details for the new Recon Script is going to appear. You're
required to fill out the fields properly as shown on the image below. In the field called 'Script
fullpath' you're required to insert the interpreter or program which executes the script ('perl' in this
case) and the full path to the script. Once the form is filled out properly, please click on 'Create'.

The moment the recon script is registered, you're going to see a screen, showing the processing was
executed properly and the script was registered, appearing on the list.
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Recon Task Creation

To ensure the variables used by the extensions are updated periodically, you're required to create a
Recon Task which is going to be executed on each defined time interval. To create a Recon Task,
please click on 'Manage Servers' and on 'Manage recontask'.

As you can see on the image below, the main view of 'Recon Task' is shown. Please click on 'Create'
to create a new one.
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After clicking on 'Create', the form on the picture below is going to appear. It's very important to
select the 'Custom Script' option in the 'Mode' field, because it's going to allow you to select a
registered script (the 'RHEV Recon' script in this case).

The field called 'script field' is reserved for recon script parameters. For this recon script, you're
required to use the following parameters:
•server: The address of the host which runs the API.
•user: The user to access the API (the syntax is 'user@domain').
•pass: The password to access the API.
•cert: The path to the API certificate.
•pandoraconf: The path to where the Pandora FMS configuration file is located.

The 'cert' parameter is going to be used by the 'Recon Task' and 'RHEV Manager'
extensions. It's very important to make sure the Pandora FMS Servers -and- Web
Servers are allowed to gain access to this location.

Please click on the 'Add' button to create a new Recon Task and to finish the process.
In this moment, the following screen is going to appear, showing the process was completed
successfully. The new Recon Task is going to appear on the list.
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In this moment, you possess one Recon Task which will be executed on each defined interval. It's
going to update all variables related to the agents which are going to monitor the RHEV virtual
architecture.

15.3.9.2. Installation of RHEV View and RHEV Manager Extensions
To install these extensions, please copy the content of the extensions folder to the extensions folder
of the Enterprise part of the Pandora FMS Console which is going to appear after the decompression
of the plug in. The command to perform these actions is shown below:
cp -R extensions/* <pandora_console_dir>/enterprise/extensions/

From now on, the RHEV monitoring extensions are available to you.

15.3.9.3. Using the RHEV View Extension
To use the RHEV View extension, please click on 'Monitoring' and 'RHEV View'.
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The extension is going to open a map, showing all components of the RHEV architecture which gets
discovered by the plug in.
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The different elements of RHEV architecture (e.g. Data Centers, Storage Domains, Clusters,
Networks, Hosts and Virtual Machines) are going to appear on the map. Each element is
represented by a different icon for each kind of element. The relationship between icons show the
relationship between the RHEV architecture elements. You're able to see the status of every element
and its relationship to each other at a glance by this view.
The extension has a menu to configure the view: Hiding or showing the entities, enlarging the text
size, zooming in and out to see a more detailed picture of the network.

On the picture below, the elements, networks, hosts and virtual machines are hidden, because we
need to see a detailed view of the relationship between clusters and storage domains with a data
center.

15.3.9.4. Using the RHEV Manager Extension
The RHEV Manager Extension is available in the agent operation view which represents RHEV
virtual machines under Pandora FMS.
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The RHEV Manager Extension utilizes the 'curl' command. The installation of this
command is required and has to be accessible to the Web Server on which the Pandora
FMS Console is installed on.

To access the extension, please click on the icon which is represented by the RedHat logo in the
agent's tab bar.

The extensions allow you to manage the virtual machine ('switch on/off' and 'suspend') without
being forced to use RHEV Management Console. The extension shows the current status of the
virtual machine by a code of colors ('green' = powered on, 'orange' = suspended and 'grey' =
powered off), and a combo containing the available states. You're able to change them by clicking
on the 'Change Status' button.

If you're clicking the 'Stop' status to stop a virtual machine, the extension is going to contact the
RHEV API and sends the command. The result is going to be a change in the virtual machine status
and the combo options, as you can see on the picture below:

The change between some states consists of several steps, e.g. changing from 'Stop' to 'Start'. In this
case, the extension is going to show the virtual machine status for each step. To change e.g. from
'Stop' to 'Start', the virtual machine crosses the states shown below:

424

Monitoring RHEV Environments

15.3.10. Agent Plugin Configuration
The agent's plugin configuration is conducted by a configuration file called 'rhevplugin.conf' by
default.
The agent's plug in selects all entities and creates all modules along with default values for name
and description by default. All these parameters can be customized by changing the configuration
file.

15.3.10.1. Configuration File
The configuration file has two different areas: The global variables and monitoring configuration
variables.
The global variables section begins on the token named 'Configuration' and carries the information
about the plugin configuration. The parameters allowed in this section are the following:
•module_name: The name of the reported module on the agent which executes the plug in.
•server: The host name which runs the RHEV API.
•user: The user to connect to the API (the syntax is 'user@domain').
•pass: The password to connect to the API.
•cert: The path to the API's certificate.
•temporal: The path to the temporal folder.
•logfile: The name of the log file.
•transfer_mode: The transfer mode (can take the values 'local' or 'tentacle').
•tentacle_ip: The tentacle server's IP to send information. Typically it's installed on the same
machine the Pandora FMS Server is installed on. This option is only available if you're using
'tentacle' under 'transfer_mode'.
•tentacle_port: The port of the Tentacle server. This option is only available if you're using
'tentacle' under 'transfer_mode'.
•tentacle_opts: These are extra options for the Tentacle server. This option is only available if
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you're using 'tentacle' under 'transfer_mode'.
The monitoring configuration section comes with several subsections. The first one contains the
token named 'Reject' and allows you to create a list which is going to contain the names of the
entities of the virtualization environment which are going to get rejected. To reject an entity, you're
required to put the name on the list as shown below:
#Dismissed entities
Reject
mv1
mv_WindowsXP
mv_WebServer1
...

To reject all entities of a kind is also supported (e.g. all hosts, all virtual machines, etc). The tokens
for each entity are the following:
•'all_dc' (data centers)
•'all_host' (hosts)
•'all_network' (networks)
•'all_storage' (storage domains)
•'all_cluster' (clusters)
•'all_vm' (virtual machines)
An example which puts these tokens to use is the following:
#Dismissed entities
Reject
all_dc
all_host
all_network
all_storage
all_cluster
all_vm

The second section is defined by the token named 'Rename' and allows you to change entity names.
This feature is very useful if you want to combine software agent and API information on the same
agent. The configuration for this section is conducted by mentioning the old name followed by the
new one and a space character between them as shown below.
#Rename entities
Rename
mv_WebServer1 WebServer1
mv_WindowsXP WindowsXP Test
...

The following subsections are related to the entity's monitoring configuration. Each entity has it's
own token named 'DataCenter', 'StorageDomain', 'Network', 'Cluster', Host and VM. For each entity,
it's e.g. possible to define whether the modules are disabled or enabled and to provide max. and
min. values for the 'Warning' and 'Critical' states:
#VM Modules
VM
status disabled
errors_total_tx name = TX Error Net [%s]; desc = Total error TX net; limits = 60 70 71 100
memory_used name = Used Mem; desc = Memory used by the virtual machine; limits = 256 1024 1025
2048
...
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Each line is associated to a monitoring module. There are two options:
•<module> disabled: The module is not going to be created.
•<module> name = <name>; desc = <description>; limits = <min_warning>
<max_warning> <min_critical> <max_critical>: The module is going to be created with a
specified name and description. It's also going to contain the thresholds for min. and max.
values and for the 'Warning' and 'Critical' states.
It's very important to pay special attention to the configuration file's line structure and syntax,
especially to the ',' character. It's located in direct vicinity to the module's name and it's description.
The command line examples which are shown below are not the same. Please take a good look at
the blanks near the ';':
errors_total_tx name = TX Error Net [%s]; desc = Total error TX net; limits = 60 70 71 100 (RIGHT)
errors_total_tx name = TX Error Net [%s]
100 (WRONG!)

; desc = Total error TX net

; limits = 60 70 71

The modules are referenced by their short names, and a name is easier to write on the command
line. A table that explains how to link full names and short names is located in the next section.
This is an example of the configuration of virtual machines:
To monitor virtual machines was defined as a list of enabled or disabled modules inside the
configuration file in the VM section. The 'status' module is disabled and the modules named
'errors_total_tx' and 'memory_used' contain custom values. The rest of the modules which are not
showing up on the list, are going to be created along with a set of default values for them. By this
configuration, the module named 'memory_used' is going to get the following values:
•Name: The used memory.
•Description: The memory used by the virtual machine.
•Min Warning: 256
•Max Warning: 1024
•Min Critical: 1025
•Max Critical: 2048
The modules are generated dynamically, e.g. modules related to disks or network interfaces, which
are going to create one module for each detected item, have a special syntax for the module's name:
errors_total_tx name = Errores TX Net [%s]; desc = Errores totales TX de red; limits = 60 70 71 100

In this case, the name has a dynamic part which allows you to use the macro '%' which will be
replaced with the dynamic part of the module's name by the plug in.
The module named 'errors_total_tx' e.g. has this default name:
Nic [nic1] errors TX

By this configuration, the name is going to be:
TX Error Net [nic1]

Where 'nic1' is the dynamic part of the module's name.
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All errors related to the configuration file are shown in the log file. They are also going
to be sent as an asynchronous module to Pandora FMS which is going to appear in the
agent which is executing the plug in.

In addition to the section related to each element, the configuration file has a common section for
the events. This section is defined by the token named 'EventCodes' and all event codes to monitor
will be listed inside it:
EventCodes
30
920
980
509
956

If you don't define this section, the event monitoring is not going to be executed.

15.3.10.2. Sharing the Monitoring Load between several Software Agents
By configuration file, it's possible to share the monitoring load of RHEV Virtualization Environments
between several Software Agents.
To do that, you're required to distribute the monitored entities between the agents. In this example,
we have the following architecture:
DC1
|
|- Cluster 1.1
|- c1.1mv1
|- c1.1mv2
|- c1.1mv3
|- Cluster 1.2
|- c1.2mv1
|- c1.2mv2
|- c1.2mv3
DC2
|
|- Cluster 2.1
|- c2.1mv1
|- c2.1mv2
|- c2.1mv3
|- Cluster 2.2
|- c2.2mv1
|- c2.2mv2
|- c2.2mv3

One possibility to share the load could be assigning one Data Center to each agent. We're going to
use the feature to reject entities named 'Reject' to do so.
The first agent only monitors the Data Center called 'DC1' and rejects the entities in Data Center 2
which is called 'DC2':
Reject
DC2
Cluster 2.1
Cluster 2.2
c2.1mv1
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c2.1mv2
c2.1mv3
c2.2mv1
c2.2mv2
c2.2mv3

The second Software Agent monitors the data center 'DC2' and rejects the data center 'DC1':
Reject
DC1
Cluster 1.1
Cluster 1.2
c1.1mv1
c1.1mv2
c1.1mv3
c1.2mv1
c1.2mv2
c1.2mv3

It's also possible to split the load based on clusters. We e.g. have four software agents and each one
is going to monitor a different cluster.
Software Agent 1 monitors cluster 1.1 and rejects the other entities:
Reject
DC1
Cluster 1.2
c1.2mv1
c1.2mv2
c1.2mv3
DC2
Cluster 2.1
Cluster 2.2
c2.1mv1
c2.1mv2
c2.1mv3
c2.2mv1
c2.2mv2
c2.2mv3

Software Agent 2 monitors cluster 1.2 and rejects the other entities:
Reject
DC1
Cluster 1.1
c1.1mv1
c1.1mv2
c1.1mv3
DC2
Cluster 2.1
Cluster 2.2
c2.1mv1
c2.1mv2
c2.1mv3
c2.2mv1
c2.2mv2
c2.2mv3

Software Agent 3 monitors cluster 2.1 and rejects the other entities:
Reject
DC1
Cluster 1.1
Cluster 1.2
c1.1mv1
c1.1mv2
c1.1mv3
c1.2mv1
c1.2mv2
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c1.2mv3
DC2
Cluster 2.2
c2.2mv1
c2.2mv2
c2.2mv3

Software Agent 4 monitors cluster 2.2 and rejects the other entities:
Reject
DC1
Cluster 1.1
Cluster 1.2
c1.1mv1
c1.1mv2
c1.1mv3
c1.2mv1
c1.2mv2
c1.2mv3
DC2
Cluster 2.1
c2.1mv1
c2.1mv2
c2.1mv3

the rejected entities configuration is very flexible, because you're able to split the load, assigning
several entities to each software agent.

15.3.10.3. Example Configuration Files
Configuration File with all Modules disabled

The lines marked by a '#' character are comments.
#Plug-in Configuration Parameters
Configuration
server rhevm.server
user user@testdomain
pass 12345
cert /home/user/rhevm.cer
temporal /tmp
logfile /tmp/plugin-rhev.log
transfer_mode local
tentacle_ip 127.0.0.1
tentacle_port 41121
tentacle_opts
#Dismissed Entities
Reject
#Data Center Modules
DataCenter
status disabled
#Storage Domain Modules
StorageDomain
available disabled
used disabled
committed disabled
free_percent disabled
#Network Modules
Network
status disabled
stp disabled
#Cluster Modules
Cluster
overcommit disabled
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hugepages disabled
threshold_low disabled
threshold_high disabled
threshold_duration disabled
#Host Modules
Host
status disabled
vm_active disabled
vm_migrating disabled
vm_total disabled
data_current_rx disabled
data_current_tx disabled
errors_total_rx disabled
errors_total_tx disabled
memory_cached disabled
memory_total disabled
swap_free_percent disabled
swap_cached_percent disabled
swap_free disabled
cpu_current_idle disabled
cpu_current_user disabled
memory_used disabled
ksm_cpu_current disabled
memory_free_percent disabled
swap_total disabled
memory_buffers disabled
cpu_current_system disabled
cpu_load_avg_5m disabled
swap_cached disabled
swap_used disabled
memory_free disabled
fence_status disabled
#VM Modules
VM
status disabled
stateless disabled
ha disabled
cpu_current_guest disabled
cpu_current_hypervisor disabled
memory_free_percent disabled
memory_installed disabled
memory_used disabled
cpu_current_total disabled
data_current_read disabled
data_current_write disabled
size disabled
disk_status disabled
data_current_rx disabled
data_current_tx disabled
errors_total_rx disabled
errors_total_tx disabled

15.3.10.4. Table linking the Module Names
Data Centers

Long name Short name
Status
status
Storage Domains

Long name
Short name
Available Space
available
Used Space
used
Committed Space committed
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Percent Free Space free_percent
Networks

Long name Short name
Status
status
STP Status stp
Clusters

Long name
Overcommit Percent
Transparent HugePages
Low Threshold
High Threshold
Threshold duration

Short name
overcommit
hugepages
threshold_low
threshold_high
threshold_duration

Hosts

Long name
Status
Active VM
Migrating VM
Total VM
Nic [x] RX
Nic [x] TX
Nic [x] errors RX
Nic [x] errors TX
Cache size
Total memory
Swap free percent
Swap cached percent
Swap free
CPU Idle
User CPU
Used memory
KSM CPU
Percent free memory
Total swap
Buffers size
System CPU
CPU Load
Cached swap
Used swap
Free memory

Short name
status
vm_active
vm_migrating
vm_total
data_current_rx
data_current_tx
errors_total_rx
errors_total_tx
memory_cached
memory_total
swap_free_percent
swap_cached_percent
swap_free
cpu_current_idle
cpu_current_user
memory_used
ksm_cpu_current
memory_free_percent
swap_total
memory_buffers
cpu_current_system
cpu_load_avg_5m
swap_cached
swap_used
memory_free
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Fence Status

fence_status

Virtual Machines

Long name
Status
Stateless
HA Status
Guest CPU
Hypervisor CPU
Percent free memory
Installed memory
Used memory
Total CPU
Disk [x] read
Disk [x] write
Disk [x] size
Disk [x] status
Nic [x] RX
Nic [x] TX
Nic [x] errors RX
Nic [x] errors TX

Short name
status
stateless
ha
cpu_current_guest
cpu_current_hypervisor
memory_free_percent
memory_installed
memory_used
cpu_current_total
data_current_read
data_current_write
size
disk_status
data_current_rx
data_current_tx
errors_total_rx
errors_total_tx
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16 MONITORING THE USER'S SURFING
BEHAVIOR
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16.1. Introduction
This is one of the Enterprise Version's features which allows you to monitor e.g. the user's surfing
behavior on a website. It's based on transactions to check the various produced steps during the
surfing process which effectively reproduces the complete browsing history in detail. It also includes
monitoring features such as authenticating or filling out a form, clicking on menu options or
verifying whether each process returns an specific text string or not. Any mistake in the moment of
processing is going to result in a failure of the surveillance. The complete transaction includes the
download of all resources (graphs, animations, etc.) of which real browsing consists of. To check
the availability and latency of websites, you're also able to obtain values from these websites to
monitor them.
'Goliath' is the name of the Pandora FMS Web Surveillance Server. Goliath has the ability to
monitor HTTP and HTTPS connections transparently if you have any OpenSSL libraries installed on
your system.

16.2. How to Create Web Surveillance Modules
To remotely monitor a web page, you're required to create the corresponding agent in order to
monitor the service first.
To do so, please click on 'Manage agents' in the Pandora FMS Console Administration section as
shown below.

On the following screen, click on 'Create agent':

Please fill out the form for your new agent and click on 'Create':
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Once you have created the agent, click on the upper flap of the modules. Please select 'Create a new
network module' and click on 'Create':

Once you have clicked on 'Create', a form is going to appear in which you're required to fill out the
fields which are necessary for being able to monitor a web page.
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This is an explanation of the form fields:
Name
The name of the check.
Type
There are various check types to choose from:
•Remote HTTP module to check latency: Obtains the total time from the first request until
the last one is checked (in a WEB test there is one or several intermediate requests which
complete the transaction. If there are several requests in the definition of the check, the
average time of each request is going to be used.
•Remote HTTP module to check server response: Obtains a value of '1' (OK) or '0'
(FAILED) as a result of checking all the transactions. If there are several attempts and all of
them happen to fail, we consider the test as a total failure.
•Remote HTTP module to retrieve numeric data: Retrieves a numeric value from an HTTP
response using a regular expression.
•Remote HTTP module to retrieve string data: Retrieves a string from an HTTP response
using a regular expression.
Web Checks
The entirety of the web checks to perform (only one by default).
The WEB check is either defined by several steps or as a simple request.
These simple petitions are required to be written in a special format in the 'Web checks' field. The
checks are started by the 'task_begin' tag and they end on 'task_end'.
It's also possible to check whether there is a string on a web page or not. The 'check_string' variable
was created for this purpose. This variable however doesn't allow you to check the HTML code
itself. A usage example of this variable could be something like e.g.: Search on the
'http://www.example.com' web page if there is the 'Section 3' string. If the string exists, the variable
has to be configured in the following way:
check_string Section 3
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There are several extra variables to check forms:
•resource ('1' or '0'): Download all the web resources (images, videos, etc).
•cookie ('1' or '0'): Keeps a cookie or an open session for later checks.
•variable_name: The name of a variable in a form.
•variable_value: The value of the previous variable on the form.
By these variables, it's possible to send data to forms and check whether they work appropriately or
not.

In some specific cases, the domain redirection is not going to work. To solve this
problem, you're required to create a module which uses the final domain address after all
redirections are completed.

16.3. String Check on a Website
The check to look up the 'Section 3' string on the 'http://www.example.com' website
would have to look like this:
task_begin
get http://www.example.com
check_string Section 3
task_end

The complete form under Pandora FMS is going to look like this:

Once the check was executed, it's going to be shown in the 'View' menu by clicking
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on the corresponding flap. The data will be shown on the bottom of that page, once
they start receive any.

The syntax for the 'check_string' parameter is not a regular string, it's a Regular
Expression ('regexp'). This is a special notation to code searches. If you are e.g. trying
to search for 'Pandora FMS (4.0)', the expression should be something like 'Pandora
FMS \(4.0\)'. This allows you to search for regular words and to conduct complex
searches, but you're required to escape from non-alphanumeric characters by the '\'
character before any attempt of execution.

16.4. Checking the Latency of a Website
If you want to check latency of a website, you're just required to select the module type named
'Remote HTTP module to check latency'.

If you e.g. want to learn the latency of the website 'http://pandorafms.com' and to
check the string named 'pandora', the code would have to look like the one shown
below.
task_begin
get http://pandorafms.com
check_string pandora
task_end

The complete form under Pandora FMS is going to look like this:
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The result of this module, showing the latency is going to look like this:

16.5. Checking of Websites by a Proxy
You're also able to conduct website checks by using a proxy. To configure the proxy, you're required
to add the proxy URL in the field 'Proxy URL' which is located under 'Advanced options':

An example of the URL could be:
http://proxy.domain.com:8080

If the proxy requires an authentication, you may utilize an URL like this:
http://my_user:my_pwd@proxy.domain.com:8080

16.6. Retrieving Google's Stock Quote
To retrieve Google's stock quote, you're required to create a 'Remote HTTP module to retrieve
numeric data' module along with the appropriate regular expression which is shown below.
task_begin
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get http://finance.google.com/finance/info?client=ig&q=NASDAQ%3aGOOG
get_content \d+\.\d+
task_end

The output is going to be something like this:

From Pandora FMS 4.1 and above, you're able to specify the part of the regular expression which is
going to be returned to retrieve data from more complex HTTP responses:
task_begin
get http://finance.yahoo.com/q?s=GOOG
get_content_advanced <span id="yfs_l10_goog">(\S+)</span>
task_end

The part of the regular expression to be returned (which is defined in
'get_content_advanced') has to be enclosed in brackets.

16.7. Form Checking on a Website
One check which is more interesting is a web site's form check, although it's more complex than the
simple text check on a website. The example check is going to use a Pandora FMS public demo
page, starts a session an checks whether it has successfully accomplished its task or not.
To be able to conduct these kinds of checks, you're required to possess the appropriate credentials
in order to start the session. It's also advisable to go to the page and obtain the HTML code to take a
look at the variable names.
The URL of the website is 'http://firefly.artica.es/pandora_demo/index.php?login=1'. Once you are
there, you could see that the variables are the following:
•nick: user name
•pass: user password
It's recommended to use the variables 'variable_name' and 'variable_value' for being able to validate
the form. The complete example is shown below.
task_begin
post http://firefly.artica.es/pandora_demo/index.php?login=1
variable_name nick
variable_value demo
variable_name pass
variable_value demo
cookie 1
resource 1
task_end

You have managed to gain access to the website and validated some values by the previous task.
Now it's recommended to check whether you're correctly registered on the page by searching for
something which would be only possible to see if you are appropriately registered:
task_begin
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get http://firefly.artica.es/pandora_demo/index.php?
sec=messages&sec2=operation/messages/message
cookie 1
resource 1
check_string Read messages
task_end

It's possible to conduct another check, which would be to end the session on the page and to exit:
task_begin
get http://firefly.artica.es/pandora_demo/index.php?bye=bye
cookie 1
resource 1
check_string Logged Out
task_end

The complete check under Pandora FMS looks like this:

Once all the checks are added, they appear on the module's list:

To see the status of the check, please go to the 'View' menu, click on the corresponding flap and and
take a look at the bottom of the page, where the data is going to be shown once the check starts to
receive any.
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You're also able to see a lot more data regarding some modules. To do so, you're just required to
click on the 'Data' flap. If you do, a list like the one shown below is going to pop up:

On this image, you're able to see both checks, their names, the interval in which each of them are
executed (which could be different from the agent interval), and the data. In the web checks, the
Data column refers to the total time the check has taken.
On the following screen, the advanced options for the website monitoring are shown (which are
partially different to the rest) :

The 'advanced features' fields are quite similar to the ones from other types of modules, but there
are some differences which are specific to website checks:
Timeout
It's the expiration time in which the petition has to be conducted. If the specified time is elapsed,
the petition check is going to be ruled out.
Agent Browser ID

It's the web browser's identifier to use, because some specific pages only accept
certain web browsers. Please see zytrax.com to obtain more information.
Requests
Pandora FMS is going to repeat the check exactly the number of times by the value this parameter
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contains. If any of the checks fail, it's going to be considered as a total failure. Depending on the
number of checks in the module, we're going to get a specific number of pages, e.g. if the module
has three checks, three pages are going to be downloaded. If we however have some fixed value in
the 'Request' field, the number of downloads is going to get multiplied by this. This is important to
know if we'd like the total time the module is going to take to complete the operations.

16.8. Simple HTTP Authentication
Some websites might require HTTP authentication. This authentication method doesn't consist of
the 'normal' user / password way to authenticate, e.g. if you're entering a site and get a popup
window which requires a user name and password for a realm or domain from you.
This way to authenticate is coded in the web task and utilizes a few new tokens like the ones shown
below.
http_auth_serverport artica.es:80
http_auth_realm Private area
http_auth_user admin
http_auth_pass xxxxxx

•http_auth_serverport  The domain and HTTP port on which to listen on.
•http_auth_realm  The realm's name.
•http_auth_user  The user.
•http_auth_pass  The password.
This is a full example:
task_begin
get http://artica.es/pandoraupdate4/ui/
cookie 1
resource 1
check_string Pandora FMS Update Manager \(4.0\)
http_auth_serverport artica.es:80
http_auth_realm Private area
http_auth_user admin
http_auth_pass xxxx
task_end

16.9. HTTPS (HTTP with SSL) Monitoring
Goliath is able to check both HTTP and HTTPS. To conduct checks on secured websites which are
utilizing HTTPS, you're only required to incorporate the protocol into its URL, e.g.:
task_begin
get https://www.google.com/accounts/ServiceLogin?
service=mail&passive=true&rm=false&continue=https%3A%2F%2Fmail.google.com%2Fmail%2F%3Fui%3Dhtml
%26zy%3Dl&bsv=zpwhtygjntrz&ss=1&scc=1&ltmpl=default&ltmplcache=2
cookie 1
resource 0
check_string Google
task_end

16.10. Monitoring of WebsiteServices
With Pandora FMS and Goliath's Web Surveillance features, you're also able to monitor web services
and APIs which are based on the REST specification, but you're unable to conduct such a
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surveillance on SOAP or XMLRPC based web services.
Let's assume for a moment that you e.g. want to check a web API by a specific call which returns a
number (from '0' to 'n') if it works properly. If not, it's not going return anything, which is going to
be considered a failure by Pandora FMS:
task_begin
get http://artica.es/integria/include/api.php?
user=slerena&pass=xxxx&op=get_stats&params=opened,,1
check_string \n[0-9]+
task_end

This is going to return a reply like this:
HTTP/1.1 200 OK
Cache-Control: no-store, no-cache, must-revalidate, post-check=0, pre-check=0
Connection: close
Date: Mon, 13 May 2013 15:39:27 GMT
Pragma: no-cache
Server: Apache
Vary: Accept-Encoding
Content-Type: text/html
Expires: Thu, 19 Nov 1981 08:52:00 GMT
Client-Date: Mon, 13 May 2013 15:39:27 GMT
Client-Peer: 64.90.57.215:80
Client-Response-Num: 1
Client-Transfer-Encoding: chunked
Set-Cookie: a81d4c5e530ad73e256b7729246d3d2c=pcasWqI6pZzT2x2AuWo602; path=/
0

This is going to produce an 'OK' (Green) module status, because my regular expression matching
('regexp') found the '0' just before a carriage return. It's important to check the entire response data
 not just the 'data' section, so you can match the HTTP headers, too. For other responses, a
different regular expression is required.

16.11. IPv6 Support
From versions 4.0.3 and above, Goliath (the library which supports the Pandora FMS Transactional
WEB Monitoring) supports IPv6. Supported IPv6 Websites are required to use FQDN (Fully
Qualified Domain Name) addresses.
There, the URL has to be a host name (e.g. 'ipv6.google.com'). IPv6 address representations (e.g.
[::1], [2404:6800:4004:803::1014] etc.) are not allowed. This limitation originates from the LWP
module called 'libwwwperl'.

16.12. Advanced Options
16.12.1. Modifying HTTP Headers (available from versions 4.0.2 and above)
By the 'header' option, you're able to modify HTTP headers or create your own. The example below
e.g. changes the 'Host' HTTP header:
task_begin
get http://192.168.1.5/index.php
header Host 192.168.1.1
task_end
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16.12.2. Debugging Web Surveillance (available from versions 4.0.2 and above)
If you want to debug a website check, please add the 'debug <log_file>' option. The files
'log_file.req' and 'log_file.res' are going to be created along with the contents of the HTTP request
and response:
task_begin
get http://192.168.1.5/index.php
debug /tmp/request.log
task_end

The website check above
'/tmp/request.log.res'.

is

going

to

generate

the

files

'/tmp/request.log.req'

and

16.12.3. Utilizing CURL instead of LWP
LWP sometimes crashes when multiple threads issue HTTPS requests simultaneously. To solve this
problem, you just have to edit the file named '/etc/pandora/pandora_server.conf' and to add the
below mentioned line to it:
web_engine curl

After you've restarted the Pandora FMS Server, the CURL binary is going to be used to perform
website checks instead of LWP.

446

Advanced Options

17 DISTRIBUTED TRANSACTIONAL WEB
MONITORING BY SELENIUM
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In addition to the features of Goliath, which is integral part of all Pandora FMS Enterprise versions,
there is another way to perform Transactional Monitoring by Pandora FMS. This method is using an
agentlike approach instead of a centralized system. It allows you to distribute the load and to use
servers in remote networks to monitor different websites or applications.
In such a case, 'Selenium' is used as the back end instead of Goliath. It supports a navigation 'by
clicks' which is much more precise than the ones offered by Goliath. The Selenium plugin agent
interacts with the Selenium Server  and this in turn with the system's browser. This method offers
the possibility to browse the web using Chrome, Firefox or the Internet Explorer. It runs on
Windows and Linux, enables latency and session checks and supports navigation with heavy
implementations of JavaScript and Java applets, Flash or any other technology, supported by
browsers today.
The Selenium plugin Documentation is very extensive and specific and can be found in the Pandora
FMS Module Library, along with the Enterprise Selenium Plug in.
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18 SERVICE MONITORING
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18.1. Introduction
18.1.1. The Concept of Service Monitoring
A service is a way to group your IT resources based on their functionalities. A service could be e.g.
your official website, your CRM system, your support application, or even your printers. Services are
logical groups which can include hosts, routers, switches, firewalls, CRMs, ERPs, websites and
numerous other services. By the following example, you're able to see more clearly what a service
is:
A chip manufacturer sells computers by its website all around the world. His company consists of
three big departments: A management, an online shop and support.

As you can see, there are three services which are offered to the customers: An online shop,
support and (indirectly) management. All services are crucial for the business, because if one fails,
the others can be affected and the company could lose a lot of money  even customers. And in the
end, as you know, happy customers could bring back even more customers to your company.
To monitor the service of a chipmanufacturing company, we're required to understand all its
services in detail.
The online shop department is responsible to ensure the shop's website to be on line, that all
product prices are appropriately for the intended market, to create the product categories, and, over
all, to ensure that all information about products, delivery and payment methods are properly
displayed on the website to render the shopping an easy task for the customers. In this example, we
intend to monitor the following parameters from their service:
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The support department has to solve all customer's problems by the computers they've purchased.
Some tasks of this department are: Helping customers to configure their computers, manage the
replacement of computer parts and manage the return of delivered products. This department in
conjunction to the online shop are the services on the client side. It's very important to get
perceived as a highquality company for them. We intend to monitor the following parameters from
their support service:

The third department is the management which consists of marketing, the production of
commercials, HHRR (Human Health Risk Resources) and other departments which are focused on
internal management. Their first and foremost job is to ensure all processes within the company are
conducted appropriately. The services of this department are crucial, because it's considered the
coordinator of all other departments. The most interesting parameters regarding management
services (which we intend to monitor in this example) are the following:
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To monitor our services, we're generating some maps by the Pandora FMS Visual Console and the
pictures we possess about the of the chipmanufacturing company's services hierarchy. These maps
are calculated in real time, because you have to be able to evaluate the status of your services at any
time. The first thing we have to do is to generate a map of each service.
The picture below shows a map of the online shop service along with each parameter's status. As
you can see, the parameter called 'Content Updated' bears a red dot. It means there is a problem
with it. The other shown parameters are appropriate because they bear green dots. Clicking on the
green arrow leads to a map which presents a more generalized view of the services, as you're going
to see in the following steps.

If you want to display detailed information about the problem, you may click on the red dot and
you're going to see a detailed view with which you're able to learn more about the problem. This
detailed (and pretty technical) view is going to display the data which were gathered by Pandora
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FMS from a lot of sources like CRM, ERP, SAP servers, databases (e.g. MySQL, Oracle, etc), even
from devices like PCs, servers and routers.

We've also generated another map for the support service which is shown on the picture below. As
you can see, all important parameters of the support service are appropriate, because all of them
bear green dots.

To finish by the services map, we've also generated a map for management services, as you can see
on the picture below. This display also shows all important parameters along with colored dots. In
this case, all the dots are green  which means the parameters of the monitored services are all
within areas which are considered to be normal.
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As you can see on the picture below, we've also generated a map with a more generalized view on
which all the services are displayed. On this map, you're able to see the chipmanufacturing
company's entire service hierarchy and the states of all monitored services. If you click on any dot,
you're going to see a detailed map of each service. By all these maps, we've created a complete
topological map of all the chipmanufacturing company's services. Each service's status is the same
as the one shown on the detailed map for each service. As you can see, the values for the
management and support services are normal, but the online shop service seems to have some kind
of a problem. As you can see, the status of the service climbs up in the hierarchy until it reaches the
top for the purpose of informing the user of important incidences.
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18.2. Services under Pandora FMS
18.2.1. How Services work under Pandora FMS
Unlike the 'specific' monitoring, where specific values are kept from specific indicators, the service
monitoring by Pandora FMS is to monitor 'groups' of elements from different kinds with certain
margins of error which is in itself based on failure accumulation.
To better understand what service monitoring consists of, we're going to show an example below.
In this example, we intend to monitor whether the service, which we're providing by the usage of a
Web Cluster, is conducted appropriately or not. This cluster consists of the following elements:
•Two routers in HA (High Availability)
•Two switches in HA.
•20 Apache Web Servers.
•Four Weblogic Appliance Servers.
•One MySQL Cluster consisting of two Storage and two SQL Processing Nodes.
It's possible to monitor each element individually. First, we're required to 'globally' activate the
service monitoring. Each element included in the service should be a 'standard' monitor of the type
which is getting monitored by Pandora FMS, which is a task that is required to be
installed PRIOR to any service monitoring.
The need of monitoring services as something 'abstract' appears if we ask ourselves the question:
"What happens when an element that is considered noncritical, initially?", such as, e.g. one of the
twenty Apache Servers. Firstly, we wouldn't be able to warn anyone. In fact, it's possible it has e.g.
frequent failures. There are also 20 nodes  it shouldn't warn us because of the failure of only one
node (let's imagine the warning of 'wake up someone who's sleeping.' here). In fact, a service which
comes with so much redundancy is installed for the purpose of giving us more peace, not more
work. It should only warn us if a critical element is down (such as a router) or if several web
servers are down, e.g. four or five of them.
In this way, if we put 'weights' to each element from our example:
•Switches and Routers: 5 points for each one if there are in a 'critical' state and 3 points if
they are in the 'warning' range.
•Web Servers: 1.2 points for each one in a 'critical' state. We omit the 'warning' state here.
•WebLogic Servers: 2 points for each one in a 'critical' state.
•MySQL Clusters: 5 points for each node, 3 points in a 'warning' state.
We're setting up a 'warning' threshold of '4' for the service and a 'critical' threshold of '6' for it. In
this way (and supposing that all entities are working appropriately) the service would give back an
'OK' if all the monitored elements are working as they're supposed to.
Now, assume the following:
•One Apache Server in a 'critical' state x 1.2 points = 1.2. '1.2' is smaller than '4' (the
'warning' threshold), so the service is still considered to be within the 'OK' range.
See what happens if e.g. a Web server and a Weblogic server are down:

455

Services under Pandora FMS

•One apache server in a 'critical' state x 1.2 points = 1.2
•One Weblogic server in a 'critical' state x 2 = 2
As you can see, the sum of '3.2' is still smaller than '4'. The service is also within the 'OK' status
range. It won't wake up the operator from his sleep.
See what happens if e.g. two Web Servers and one Weblogic Server are down:
•Two Apache Servers in a 'critical' state x 1.2 points = 2.4
•One Weblogic Server in a 'critical' state x 2 = 2
As you can see, '4.4' is of course bigger than '4' which meets the conditions for the 'warning' status.
It's possible that an urgent SMS has not been received from the operator yet, but rest assured that at
least someone certainly will receive an email. Let's continue with the example.
Let's also suppose that (in addition to the events mentioned above) one router is down:
•Two Apache Servers in a 'critical' state x 1.2 points = 2.4
•One Weblogic Server in a 'critical' state x 2 = 2
•One Router in a 'critical' state x 5 = 5
As you can see here, we've reached a value of '9.4' which is already higher than the 'critical'
threshold of '8' in this example. The service is definitely considered to be in a 'critical' state now 
and that's the moment in which our operator has no other option but to wake up.

The Service Monitoring feature is only available to the Enterprise Versions of
Pandora FMS.

18.2.2. Creating a New Service
18.2.2.1. Pandora FMS Versions 5 and above
Services are able to represent:
•Modules
•Agents
•Other Services
The service values are calculated using the Prediction Server which utilizes the default interval of
the prediction modules.
Within each service, you may add all the modules, agents or sub services which are required to
monitor the service you are creating. If you e.g. intend to monitor the online shop, you're going to
need a module for the content, a subservice that is going to monitor the communications, etc.
To create a new service, please click on 'Operation' and the 'Service' tab and click the configuration
button.
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A list of all the available services will be shown. The next screen shot shows an empty service list.

To create a new service, just click on the 'Create Service' button and fill out the form as shown
below.

457

Services under Pandora FMS

The names of the form fields and their meaning are as follows:
•Name: The name of the service.
•Description: The description of the service.
•Group: The group of the service. It's quite useful for organization purposes and to enforce
the SLA (Service Level Agreement) constraints.
•Auto Calculate: The check is enabled by default, implying the 'critical' threshold for the
service to be '1' and the 'warning' threshold to be '0.5'. It's also assumed that you'll
automatically assign weights of '0' for the 'OK' status, '0.5' for 'warning' and '1' for 'critical'
each time you're creating an element for this service.
•Critical: The weight threshold to enter the 'critical' status. This field is disabled if the auto
calculate check is enabled. The default value is '1'.
•Warning: The weight threshold to enter the 'warning' status. This field is disabled when the
autocalculate check is enabled. The default value is '0.5'.
•Agent to store Data: The agent in which the service module will be stored. The service
stores the data in special modules (called 'prediction modules'). An agent is necessary to
store those modules and the alerts of the service along with it.
•SLA Interval: The time range for performing the SLA constraint's calculation. The default
value is '1 month'.
•SLA Limit: The SLA threshold for the 'OK' status.
•Warning Service Alert: The alert template the service is going to use if it changes to the
'warning' status.
•Critical Service alert: The alert template the service is going to use if it changes to the
'critical' status.
•SLA Critical Service Alert: The service's utilized alert template for firing an alert if the SLA
constraints aren't met.
To add nodes, you're required to go to the 'Config Elements' tab.
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You're going to see a page like the one below where you can manage (modify, add new ones or
delete) service elements.

Some important items on the services configuration page are:
•Type: The module or agent. The agent's service works on all modules.
•Agent: The smartsearch input control for the agent. It's only visible if the element type is
either the 'agent' or the 'module' type.
•Module: The dropdown list along with the modules previously chosen agent under smart
search. This control is only visible when editing or creating a service element for the
'module' type.
•Service: The dropdown list of the services to create an item. It's only visible if the item is of
the 'create' or 'edit service' type. It's also important to keep in mind that the services which
are going to appear in the drop down list are not ancestors of the service. It's also necessary
to show an appropriate treestructure dependency between the services.
•Weight on Critical: The weight of the element if it's in a 'critical' state. The default value is
'1'. It's disabled if the service is in 'auto calculate' mode.
•Weight on Warning: The weight of the 'warning' state. The default value is '0.5'. It's
disabled if the service is in 'auto calculate' mode.
•Weight on "OK": The weight of the element if it's in perfect condition. The default value is
'0'. It's disabled if the service is in 'auto calculate' mode.
Once you have created the service items on this page, we're looking at a list management similar to
the one shown on the picture below:
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18.2.2.2. Under Pandora FMS 4.x
The service represents an association of agent modules in which their values are calculated in real
time. First of all, you're required to have normalized the module's values of all your devices (the
ones which provide the monitored service) to three states: 'normal', 'warning' and 'critical'. If you
like to know more about them, feel free to look up their Wiki sections Monitoring by Pandora
FMS and Monitoring by Policies.
Once you have all the devices monitored, you're able to form a group of them along with the
service. Inside each service, you may add all modules you need to monitor it. If you want to e.g.
monitor the online shop's service, you require a module which monitors the content, another one
which monitors the communication's status, etc. By the steps shown below, you're able to see how
to create a service by Pandora FMS in detail.
To create a new service, please click on 'Operation' and 'Services'.
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In this moment, a list of services is going to appear. The image below displays a list without
services, because none of them are defined yet.

To create a new service, just click on the 'Create' button. You're able to create the service by filling
out the form fields shown below.

In this moment, we've created a service without items, so we have to add items to the service now.
To add a new item, please click on the orange wrench icon on the top right of servicemanagement
tab and click on the 'Create' button. In this moment, the form which is shown below is going to
appear. In this form, you're required to select an agent's module to add. You're also required to fill
out the fields related to the weight of this module within the service for the 'normal', 'warning' and
'critical' states. The higher the value of a module, the more important it's within the service (which
we call 'weight').
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When all fields are filled out, please click on the 'Create' button. The next window you're going to
see is the one containing the success message as you can see below.

You may add any items you require to monitor your service. To provide an expressive example,
we've already added elements of this service along with the proper weights on the picture below.
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Once you have created your service, please go to the menu and click on 'Operation' and 'Services':

A list of services is going to appear in this moment. The view is calculated in realtime. The shown
parameters are as follows:
•Name: The name of the service.
•Description: The description of the service.
•Group: The group the service belongs to.
•Critical: The value limit from which the service is considered in the 'critical' state.
•Warning: The value limit from which the service is considered to be in the 'warning' state.
•Value: The value of the service. It gets calculated in real time.
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•Status: The status of the service, depending on its value and the 'critical' and 'warning'
limits.

If you click on a service name, you're going to see the specific service's view. As you know, the value
of a service is defined as the addition of weights associated to the state of each module. Services
(like modules) bear a corresponding state which depends on its value. This view displays the status
of each service item by the following parameters:
•Agent Name: The name of the agent the module belongs to.
•Module Name: The name of the module.
•Description: A freetext field, intended for a description.
•Weight Critical: The weight if the module is in 'critical' status.
•Weight Warning: The weight if the module is in 'warning' status.
•Weight OK: The weight if the module is in 'normal' status.
•Data: The value of the module.
•Status: The state of the module.
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It's also possible to create modules associated to services, along with the implicated advantages of
calculation periodicity, integration with the alert system, etc. The way to associate one module to a
service is to follow the below mentioned steps:
1.Please create the individual monitors that make up the service and make sure that they
work appropriately.
2.Fix the individual thresholds for each monitor to define 'critical' and 'warning' states.
3.Create a service with those monitors that we want, define thresholds for the service and
weights for each included monitor in the service.
4.Go to the agent in which we want to locate the serviceassociated monitor.
5.Create a new module of the 'prediction' type associated to this agent, using the module
editor of the Prediction Server in order to associate it to one of the services on the list.
6.If we intend to associate alerts to the service, we should do it on the module which is
associated to the server. The server has no possibilities of adding alerts, graphs or reports.
All these has to be done by the monitor which is linked to the service.
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After you have created all your services, you may also create visual maps to display you service's
states any time you want. If you'd like to learn more about Visual Maps, please feel free to look up
the corresponding Wiki section named Data Display and Reporting.
We've created the maps you've seen in the example which begins after the introduction by this tool.
They represent the services of the chipmanufacturing company. You can see a map of their services
on the picture below.
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If you happen to require a more technically detailed map, you may create more detailed maps by
using the Visual Map Console of Pandora FMS. You're also able to add icons, graphs, status dots,
tags and simple data there. On the picture below, you see a technical map of the Online shop
service along with all states of their devices.

18.2.3. Service Groups
Services are logically arranged groups which are part of a company's business structure. Therefore,
it may be necessary to create groups of services, because services alone sometimes don't have an
appropriate context. To create service groups, you're required to add each service to an existing
agent. In this case, a service is going to be a module of an agent. You're able to create a new logical
structure (a group of services) by these groups.
These groups can help us to create visual maps, to configure alerts and to apply monitoring policies,
etc. We're able to create alerts which trigger an alarm when the company's status is critical because
e.g. our salesmen are unable to their job properly or if one of our headquarters can't work properly
because of some technical problems with their ERP (Enterprise Resource Planning).
You can see two examples of services groups below.

18.2.3.1. Several Services within the same Company
Following the previous example, let's suppose for a moment that we also have salesmen who sell a
web
service
to
our
clients.
Those
salesmen
have
to
access
a
CRM
(Customer Relationship Management) to be able to manage their clients.
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Our CRM Service consists of the following:
•Two HA (High Accessibility) routers.
•Two Apache web servers.
•A MySQL cluster, consisting of two nodes for data and two nodes for SQL processing.
For the example, we're supposing the CRM architecture is monitored and the CRM service is already
created.
In this moment, we have two services:
1.A Web Cluster Service (for our clients)
2.A CRM Service (for our sales department)

To use the service groups, the best option is to create a new agent e.g. called 'Company' which has a
Cluster Service and a CRM Service as modules. Thus, the services will be grouped in this way.
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18.2.3.2. Different Services by several Headquarters
Another example is e.g. that we intend to monitor the different headquarters of a company where
each headquarter has its own services.
For this example, we suppose there are three headquarters bearing the following services: A CRM,
an ERP and an internal web. Services are configured according to the individual requirements of
each headquarter. At this point, we've monitored all services from each headquarter as shown on
the picture below.

We might also require another logical representation within Pandora FMS which grouped the
services of each headquarter to obtain a structure closer to your company. You're able to create an
agent for each headquarter with a module for each service. By doing so, we're obtaining the groups
you can see on the picture below.
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By this method of grouping services, we're able to create a logical structure within Pandora FMS
which is identical to the real world. We're also obtaining a full monitorization of all services in this
way.

The calculated values of the service is intended for the Prediction Server. It's values are
-not- displayed in real time. There are situations in which you're adding agents or
modules in which the service weight is outdated until the Prediction Server returns to
calculate this service again.

18.2.4. Service Visualization
18.2.4.1. Pandora FMS Versions 5 and above
From the version 5 and above, multiple ways of service visualizations are available. You may choose
to see the status of your services using a treebased view or a listbased one.
List-based View of all the Services

This is an operational list that displays all the services the user is able to see (Access Control List
implementation).
Please go to the Operation Menu and click on 'Monitorization' and 'Services'.
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Each row represents a service, and the columns represent:
•Name: The name of the service.
•Description: The service description.
•Group: The icon of the group the service belongs to.
•Critical: The threshold value for the sums of weights to put the service into 'critical' state.
•Warning: The threshold value for the sums of weights to put the service into 'warning'
state.
•Value: The current value for the sum of all weights for the service.
•Status: An icon which represents the status of the service.
Four possible states are represented:
•Red: The service is in 'critical' state, because the value exceeded the critical
threshold.
•Yellow: The service is in 'warning' state, because the value exceeded the critical
threshold.
•Green: The service is within the 'normal' range.
•Gray: The service is in 'unknown' state. This usually means the service has been
recently created and doesn't contain any modules or the Prediction Server is down.
•SLA: The current value of the SLA Service. The values can be:
•OK: the SLA is met for the the invertal defined in the SLA service.
•INCORRECT: The SLA is not meant for the interval currently defined in the SLA
Service.
•N/A: The SLA is in 'unknown' state, because there is insufficient data to perform the
calculation.
List-based view of a Service and its Elements

To obtain this view, you're required to click on the magnifying glass icon in vicinity of the service
name.
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As you can see, there are two zones here: The service containing the same columns like in the
previous view and a list of the service's elements where the columns are:
•Type: The icon which represents the type of an element. It's a Lego block for modules, some
stacked Lego blocks for an agent and a Network Diagram Icon for the services.
•Name: The text which contains the name of the module, agent or service. They're also
linked to the proper section.
•Description: A small freetext field intended for a short description.
•Weight critical: The value to sum if the element is in 'critical' state.
•Weight warning: The value to sum if the element is in 'warning' state.
•Weight normal: The value to sum if the element is in 'normal' state.
•Data: The value of the element. It's able to adopt the following modes:
•Module: The value of the module.
•Agents: The text which displays the agent's status.
•Service: The sum of all element's weights from the selected service.
•Status: The icon which represents the element's status by a color.

Keep in mind that the service-elements calculation is performed by the Prediction
Server. It's not real-time data you're looking at. There are some situations in which a
module's agent is added to the service where its weight is not going to be updated until
the calculation is performed by the Prediction Server again.

Service Map View

To access this view, you're required to click on the flap above the header in the service operation's
view, as you can see on the picture below.
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This view is going to display the service in a treestructured view as shown on the picture below.
You can see at a glance in which way the service is being impacted by the elements which compose
the view.

The possible nodes can be:
•Module Node: It's represented by the 'heartbeat' icon. This node is always final (leaf).
•Agent Node: It's represented by the 'CPU box' icon. This module is also always final (leaf).
•Service Node: It's represented by the 'crossed hammer and wrench' icon. This module is not
a final node. It's required to contain additional nodes.
The node's colors and the arrow which connects them to the service depends on the node's status.
There are the following attributes within the node:
•Title: The name of the service's / agent's or module's node.
•Value list: This list refers to the possible numeric value calculated for that instance. It
accepts any signed integer value.
•Critical:: The weight which will sum if it reaches a 'critical' state, except if it's the
rootservice node, which represents a threshold to reach the 'critical' status.
•Warning:: The weight which will sum if it reaches a 'warning' state, except if it's the
rootservice node, which represents the threshold to reach the 'warning' status.
•Normal:: The weight that will sum if it reaches a 'normal' state, except if it's the
rootservice node, in which case nothing is going to be displayed here.
•Unknown:: The 'unknown' status, except if it's the rootservice node, which
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represents a threshold to reach the 'unknown' status.
You may click on each node in the tree. The target link represents the operational view of the node
itself.
Services within the Visual Console

From Pandora FMS versions 5 and above, you may add services in the Visual Console like any other
item on the map.

To create a service on a map, the procedure is the same as it's for all other items on the Visual Map.
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It contains the following attributes:
•Label: The title which is going to be shown within the visual console's node.
•Service: The service that's going to be represented.

Keep in mind that a service node can not be linked to another Visual Map. The link is
always going to represent the service-tree view.

18.3. Pandora Server
It's mandatory the Prediction Service is running appropriately and also to have the Enterprise
Version of Pandora FMS installed.
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19 OPERATIONS BY SNMP TRAPS
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19.1. Introduction
Pandora FMS features a TRAP Reception Console which allows to display TRAPs which were sent by
monitored objects which allows to add alerts to those traps. SNMP traps are received by the
operating system's daemon which starts the SNMP Server of Pandora FMS in the moment of server
startup. This server usually stores traps in a log file under '/var/log/pandora
/pandora_snmptrap.log'.
Traps are usually received in RAW format. Regarding numerical OIDs, that means unless an
MIB (Management Information Base) is installed on the Operating System which is capable of
resolving them, the Pandora FMS Enterprise SNMP Console enables rule creation for renaming
numeric OID's to alphanumeric ones or simple descriptive text strings (e.g. 'interface is down') in
order to make working with TRAPs more intuitive. Pandora FMS allows to load trap MIB's of any
sort in order to automatically define such rules.

19.2. Access to the TRAP Reception Console
To use the trap reception console, please go to 'Operation' and 'SNMP Console', where you may take
a look at the list of TRAPs which have been received so far. There is an eyeshaped icon which
allows to display all the trap information. You're able to learn all detailed information regarding
SNMP traps here.

For each trap, the following columns are going to be displayed:
Status: A green box appears if the trap is validated. It turns red if not.
SNMP Agent: The Agent which has sent the trap. An address of the agent is obtained from the
'agentaddr' field of the PDU (Protocol Data Unit) if the sent trap is of the SNMPv1 type. If not, the
source
address
of
the
packet
is
going
to
be
used.
OID: The OID of the sent trap. If the sent trap is of the SNMPv1 type, the 'enterprise' field of the
PDU is going to be used. If not, the 'snmpTrapOID' field is going to be used.
Value: The value field of the sent trap. A trap can only send one type of data in this field. It's not
going
to
be
used
in
the
SNMPv2
trap.
Custom OID, Custom Value: The customized fields, sent within the trap. They sometimes can
consist of very complex data which bears a specific logic, depending on the which sends the trap. A
trap is able to send several types of data in this field.
Time
Stamp: The
elapsed
time
since
the
trap
reception.
Alert: A yellow box appears if any alert was launched by this trap. It's gray if no alert was launched.
Action: The field for deleting or validating the trap.
Traps also wear the following colors, depending on the type:
•Blue: Maintenance traps.
•Purple: Information traps.
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•Green: 'normal' traps.
•Yellow: 'warning' traps.
•Red: 'critical' traps.

19.2.1. TRAP Filtering
In the upper part of the trap console, the option named 'Toogle Filter' is displayed. By clicking on
that option, the trap's filtering field options appear or disappear.

Within the trap console, it's possible to filter by the following fields:
•Agent: A combo box where Pandora agents are displayed.
•OID: A combo box where OIDs are displayed.
•Alert: A combo box to select either triggered or nontriggered alerts.
•Search value: A combo box to input any descriptive text.
•Severity: A combo box where the different trap types are displayed, e.g. 'maintenance',
'information', 'severity', 'warning', 'critical', etc.
•Status: A combo box to select between 'SNMP validated alert', 'SNMP not validated alert' or
'all'.
•Free search: A search field to search for any alphanumeric field within the trap.
•Type: A type filter, intended to be used within SNMP alerts. Accepted values are: 'cold
start', 'warm start', 'link down', 'link up', 'authentication failure' or 'other'.
On top of these search fields, there is an option named 'Block size of pagination' which allows to
define the amount of displayed traps per page.

19.2.2. TRAP Validation
In order to effectively manage the traps it's possible to validate them, so the Administrator is able to
distinguish between pending traps and the ones he's already seen.
In order to validate a trap, please click on the green circle on the left of the trap.
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It's also possible to validate multiple traps by marking them all and to click on the green 'validate'
button.

19.2.3. TRAP Deletion
Furthermore, it's possible to delete traps once they have been attended to. To delete a trap, please
click on the red cross on the left of the trap.

19.3. SNMP Trap Alerts
It's possible to associate an alert to a trap, so Pandora FMS warns in case of an arrival of a specific
one. To manage alerts which are associated to traps, please click on 'SNMP' and 'SNMP Alerts'.
SNMP traps have nothing to do with the rest of the system alerts, even if both reuse the action
system.
I think you've already noticed the absence of an 'email template' here. The mechanism for
conditions and fields (which are getting passed as a parameter to the command) differs from a
normal alert. The alert fields within the SNMP alert are going to overwrite the defined fields under
'alert actions'  and there are no recovery alerts within SNMP alerts. If you e.g. receive a trap which
notifies you about a solved situation, you're required to manage it as a different trap. There is no
way to both 'connect' and to 'close' the alert.
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19.3.1. Alert Creation (Pandora FMS versions 5 and above)
To create an alert associated to a trap, please go to 'SNMP' and 'SNMP Alerts' and click on 'Create'.
The SNMP alert traps come with several fields which could be used to filter out data within the
SNMP trap. The fields (which could be used both separately and in combination) are the following:
•Description: A combo box for an alert description.
•OID: The OID of the main trap which consists of a regular expression. If a regular
expression is not used, it's going to look for the exact string. If you're looking for a piece of
the OID, a regular expression is recommended to be used, e.g. if we want to search for
'1.21.34.2.3' within a larger OID, it's recommended to use the regular expression of
.*1.21.34.2.3.*
•Custom Value / OID: This element is going to search within the trap's 'value', 'custom OID',
'custom value' and in the rest of the TRAP fields. Regular expressions are also supported
here.
•SNMP Agent: The agent's IP which has sent the trap. You're able to use a regular expression
or a substring here, too.
•Trap type: The filter by trap's type. Accepted values are 'cold start', 'warm start', 'link down',
'link up', 'authentication failure' or 'other'.
•Single value: The Filter by trap's value. In this example, it's '.666'. Please keep in mind this
refers only to the MAIN OID value, not to any additional OID's within the custom data
section.
•Custom OID / Data #120: These are regular expressions which try to match the binding
variables form '1' to '20'. If there is a match, the alert is fired. The value of the variable is
stored in the corresponding '_snmp_fx_' macro (e.g. _snmp_f1_, _snmp_f2_, etc.). Although
only twenty binding variables are able to search for matches, the _snmp_fx_ macros are set
for all of them (_snmp_f11_, _snmp_f12_, etc.).
•Field 1: The first field to set the parameters for the alert's command. This could also feature
as an event description if you select the event action.
•Field 2: The second field to set the parameters for the alert's command.
•Field 3: The third field 3 to set the parameters for the alert's command.
•Min. Number of Alerts: The field to define the min. amount of traps which have to be
received to trigger the alarm.
•Max. Number of Alerts: The field to define the max. amount of times the action will be
executed.
•Time Threshold: The field for determining the time to elapse before resetting the alarm
counter. This counter is the one which is getting used for the field named 'min. number of
alerts'.
•Priority: The combo box for establishing the alarm priority.
•Alert Action: The combo box for selecting the action which is going to execute the alert. If
you select an event, the normal event of an alert creation is not going to be created.
•Position: The alerts with a lower position are evaluated first. A single trap can only fire one
alert. It's going to be the first alert which matches the trap.
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You may utilize up to 20 variables to conduct the filtering and reuse them for macros later. It's not
required for them to follow a specific order. The position of the variable is defined in the field's
preceding value. If we e.g. intend to create an alert, seeking the values 'one' in the first variable
received by the trap, 'three' in the third variable and the same for 'five' and 'seven', the configuration
might look like the one displayed on the picture below.
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We can use the value of the variables in macros _snmp_f1_ coincidence .. so
_snmp_f7_ to define the alert, the alert action allows us to use these macros:

If an alert is configured to use an event, the result would be an event like the one shown on the
picture below.

The generated alert (an internal audit) is going to have a text like this one: "SNMP Alert of
192.168.5.2 with OID .1.3.6.1.4.1.2789.2005 Binding 1: 'one' Binding 3: 'three' Binding 5: 'five'
Binding 7: 'seven'." So if the trap has e.g. 200 variables, you can use up to 20 filter variables
(bindings) and take the value of up to 20 variables  regardless if they are in the 10th, 50th or
170th position.
Once the fields are filled out, please click on 'Create'.

19.4. TRAPStorm Protection
There are a couple of parameters on the server which are designed to protect the system against the
arrival of a Trap Storm, originating from a single location. We're going to use the following settings
in the file 'pandora_server.conf' for this:
•snmp_storm_protection: The max. number of processed SNMP traps by the same source
IP in a given interval (see below).
•snmp_storm_timeout:: The interval in seconds for protection against an SNMP Trap
Storm. During this interval, system will only going to process 'snmp_storm_protection' type
traps from the same source (IP).

19.5. Customizing SNMP Traps
In order to give the operator a better understanding of the traps sent by the monitored devices, it's
possible to either load the manufacturer's MIBs into Pandora FMS or to edit the traps to your liking.
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The functions mentioned so far are all features of the Pandora FMS Enterprise
Version.

19.5.1. Renaming and Customizing Traps
The editing of traps is a process where the operator is allowed to customize the appearance of a
trap within the console. If you take a look at the screen shot below, it might happens that all of your
traps are difficult to distinguish due to the received mess they contain as data (as shown there). If
we could rename them, we could identify them as 'blue box' instead of a huge amount of encrypted
data which is useless to the human eye.
To edit a trap, please go to 'Operation' and 'SNMP Console' and click on the OID field of the desired
trap.

In this moment, a page like the following is going to appear:
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If the SNMP Console is going to find traps by the OID of ".1.3.6.1.4.1.2789.2005", it's going to
display them as 'blue box sample', because they are going to be a lot more readable by the human
eye in this way. It's content (which is included the original OID) is not going to be changed at all.

Please keep in mind that all the older traps are not going to change their appearance.
This feature is only going to work along with new incoming traps in the system from the
moment this feature was enabled.

New traps can also be created from scratch by the 'create trap' option. To do so, you're only required
to go to the Trap Editor as shown on the screen shot below. We're also able to alter or to remove a
trap definition in there.

This is how a userredefined trap would look like:
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19.5.2. Loading the MIBs of the Manufacturer
The functions mentioned so far are all features of the Pandora FMS Enterprise
Version.

This option is only useful for uploading MIB traps and to provide more data for the Pandora FMS
Translation Database. If a trap is received, it's going to be automatically translated by its
description.
To upload the manufacturer's MIBs, please click on 'Examine', pick the file that should be with a
'.txt' extension and click on 'Upload MIB'.

Once it has been uploaded, the system is going to incorporate it to its trap library.

19.6. Associated Alerts to complex SNMP Traps
The previously described alerts are only going to be used where the trap is appropriately defined.
It's always the same and it doesn't bear any relevant data to recover.
In certain situations, we however might find a trap which exhibits the following structure:
OID: .1.3.6.1.4.1.2789.2005
Value: 666
Custom data: 1.3.6.1.4.1.2789.2005.1 = STRING: "ID-00342" .1.3.6.1.4.1.2789.2005.2 = STRING:
"Automated check"
.1.3.6.1.4.1.2789.2005.3 = STRING: "NIC Offline" .1.3.6.1.4.1.2789.2005.4 = STRING:
"4897584AH/345"

This is a 'complex' trap which contains complex data alongside an OID and a value, based on many
other OIDs and values. In its complex part, a trap can contain a completely randomized structure
which is based on OIDs or value pairs (e.g. counters, numerical, alphanumerical, dates, etc.).
Within the trap console, this trap would appear like on the picture below:
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If you carefully read the extended info (Custom data), there might be some pieces of useful data to
you. In the first field, bearing the OID ending of '2005.1' looks like an identifier. The third field,
bearing the OID ending of '2005.3' looks like an error message. Fields 2 and 4 don't look pretty
useful, since they seem to be of unknown code to us.
Let's assume for a moment we could create an event from a trap, moving specific parts from the trap
data into the text. Let's suppose we e.g. intend to build an event which contains the following
information:
Chassis Alert: <error message> in device <identifier>

The challenge is to make an alert which produces a 'match' in those fields, obtaining
the piece of data and using it to create a message in the alert later. We're able to
perform this task by using Pandora FMS by using advanced regular expressions and
selectors. You can find more info about regular expressions here.
The selectors are using brackets (), allowing us to 'copy' information by utilizing a search
expression.
We use the regular expression to obtain the identifier. The error message would be the following:
Identifier
.*.1.3.6.1.4.1.2789.2005.1 \= STRING\: \"([0-9\-\_A-Za-z]+)\"

Error message
.*.1.3.6.1.4.1.2789.2005.3 \= STRING\: \"([\sA-Za-z]+)\".*

Once we've obtained the data fields, we're required to use them in the alert. For this purpose, the
special macros '_snmp_f1_', '_snmp_f2_' and '_snmp_f3_' are used. Using these macros doesn't make
any sense outside any SNMP trap alert.
To build the message, we're going to use the following string:
Chassis Alert: _snmp_f2_ in device _snmp_f1_
The picture below shows how the complete alert is created.
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This is how it would look like from the perspective of the event viewer.

In order to successfully create this type of alert, an extensive knowledge of regular expressions is
required, since a simple blank space, a symbol or another character in the wrong location could
make it work inappropriately. Please keep in mind that SNMP alerts imply the use of regular
expressions. An easier way to establish an alert by regular expressions would be the following:
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This alert would be 'compatible' to the previous one in such a way that two different events could be
displayed for the same trap:

19.6.1. An Additional Example
This additional example uses an email alert to send information about the interface name each time
you receive an specific trap. You're going to produce an email containing a device name, IP and
interface name as received in the trap.
This is a trap, received from a switch:

This is the received mail.
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This is the trap definition.
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19.7. TRAP Association to the Rest of Pandora FMS Alerts and SNMP
Agent Trap Forwarding
The alerts defined on traps are completely independent from Pandora's Alert Engine, so correlations
of them trigger an alert if the temperature reaches 29 degrees and the trap for secondary power
supply is on. This type of alerts cannot be displayed since they're possibly not associated to any
modules of Pandora FMS. Therefore, the trap console monitoring cannot be related to elements
such as reports or maps.
Special ModuleModule SNMPTrap,with the trap sent from the SNMP
console:

In order to achieve this, we've created a method called 'Agent SNMP Trap Forwarding'. This server
wide option forwards the trap to a special agent's module named 'SNMPTrap' as a text string, but
only if the trap's originating IP address is defined as the agent's IP. Whenever this occurs, the trap
arrives as a text line to the agent within that module, which is one that's only defined on arrival of
the first trap.
Text alerts can be specified within that module, these being completely standard, just as any other
module. This enables a customization of SNMP Monitoring in order for certain traps from certain
origins to be treated as yet another type of module, which are thereby integrated into the rest of the
monitoring, including Alert Correlation.
SNMPTrap data
sample':

This is an Enterprise feature which could be activated on the main setup screen as shown below.
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Configuration option to activate the trap forward to the agents:

If this setting is changed, the Pandora FMS Server is required to get restarted to enable it.
Another solution is to mount an alert on the trap to activate an agent's module. If the trap has
written a '1' in a certain log file, there is an agent reading that file, ready to run it when it finds this
'1'. In this way, the module is going to be triggered if the desired trap arrives and the correlation
can be established, based on the arrived trap.

19.8. Trap Filtering on the Server
Some systems receive a high number of traps. We're only interested in monitoring a tiny percentage
of them. From Pandora FMS versions 3.2 and above, it's possible to filter the traps that the server
obtains in order to avoid straining the application unnecessarily.
In order to define different filters, please go to 'Administration' > 'Manage SNMP Console' and
'SNMP Filters'. One trap which is going to run in conjunction with any of them  just the ones for the
server are going to get ruled out automatically.

The filter is applied as a regular expression over the trap's corresponding entry within the SNMP log
(it's '/var/log/pandora/pandora_snmptrap.log' by default), which comes with the following format:
SNMPv1 Trap:
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%4y-%02.2m-%l[**]%02.2h:%02.2j:%02.2k[**]%a[**]%N[**]%w[**]%W[**]%q[**]%v\n

SNMPv2 Trap:
%4y-%02.2m-%l[**]%02.2h:%02.2j:%02.2k[**]%b[**]%v\n

The accepted values are the following:
•%y: The current year.
•%m: The current month (numerical).
•%l: The current month's day.
•%h: the current hour.
•%j: The current minute.
•%k: The current second.
•%a: The originating address (v1 traps only).
•%b: The originating address (source address of the packet).
•%N: The OID.
•%w: The trap's type (numerical).
•%W: The trap's description.
•%q: The trap's subtype (numerical).
•%v: T variable list in tab separated format (custom OID).
If the trap is of the SNMPv2 type, the trap OID is contained under the '%v' value as a second
parameter. The third and the following parameters are an actual part of the variable's list (custom
OID).
To e.g. filter all traps sent by the host, bearing the IP of '192.168.1.1', we could define the following
filter:

19.9. External SNMP Trap Handler
The SNMP console is made for the sole purpose of obtaining traps. It only processes TRAPs as
individual items. One trap is able to contain a lot of information. Sometimes, it happens that the
only monitoring we're able to conduct is based on traps. For doing so, we might choose to post
process the obtained information of one trap by an external script works as a plug in.
To process the data of one trap in detail, you may send all contained information to a script as an
alert result. I have used the trap shown below for the example. It's the trap view as it would be in
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Pandora's SNMP console log:
20100826 12:01:46 pandora 10.201.246.2 .1.3.6.1.4.1.1722 .1.3.6.1.4.1.1722.2.10.1.1.1 233 .
1.3.6.1.4.1.1722.2.10.1.1.3 = STRING: AIX_Software_Failure .1.3.6.1.4.1.1722.2.10.1.1.2 =
STRING: 08 25 2010 08:23:43:697685 .1.3.6.1.4.1.1722.2.10.1.1.8 = STRING: 1: A software error
PERM with label CORE_DUMP, identifier C69F5C9B occurred at Wed Aug 2 5 10:22:28 DFT 2010
on dvs02 for resource SYSPROC. Cause is SOFTWARE PROGRAM ABNORMALLY TERMINATED. .
1.3.6.1.4.1.1722.2.10.1.1.6 = STRING: 8 .1.3.6.1.4.1.1722.2.10.1.1.11 = STRING: An application
may not work properly .1.3.6.1.4.1.1722.2.10.1.1.10 = STRING: An application may not work
properly .1.3.6.1.4.1.1722.2.10.1.1.12 = INTEGER: 4 .1.3.6.1.6.3.1.1.4.3.0 = OID: .
1.3.6.1.4.1.1722

On the screen shots below, you can see how a special alert is created. It executes a script which
contains the complete content of the trap (_data_) and shows how an SNMP type of alert is created.
In such a case, it has been mapped for the specific OID (.1.3.6.1.4.1.1722.2.10.1.1.1), although it
could have been more general, e.g. (.1.3.6.1.4.1.1722) to call the script when there would be any
type of traps like these (.1.3.6.1.4.1.1722, I suppose it would be part of the AIX specific MIB).
A script which processes this data is executed. It also 'analyzes' the trap to write data directly to
Pandora FMS by creating an XML file, moves it to '/var/spool/pandora/data_in' as data, as if it
would come from an agent. A basic script for this case would be e.g. one to generate complex
information. We already possess enough information regarding this trap, which constitutes of the
following:
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•The originating IP
•The main event (cold start)
•The secondary events (descriptives): AIX_Software_Failure, 1: A software error PERM with
label CORE_DUMP, identifier C69F5C9B occurred at Wed Aug 2 5 10:22:28 DFT 2010 on
dvs02 for resource SYSPROC. Cause is SOFTWARE PROGRAM ABNORMALLY
TERMINATED, An application may not work properly
When designing a script which 'parses' each of these data, e.g. 'miscript.pl' and storing it under
'/var/spool/pandora/data_in' in the XML file along with a generic name and one random number,
e.g. 'snmp_gateway.31415.data'.
The generated XML is supposed to look like the one on the picture below.

<?xml version='1.0' encoding='ISO-8859-1'?>
<agent_data description='' group='' os_name='aix' os_version='' interval='300'
version='3.1(Build 100608)' timestamp='2010/08/26 12:20:26' agent_name='10.201.246.2'>
<module>
<name><![CDATA[Critical_Event]]></name>
<description><![CDATA[]]></description>
<type>async_proc</type>
<data><![CDATA[1]]></data>
</module>
<module>
<name><![CDATA[events]]></name>
<description><![CDATA[]]></description>
<type>generic_string</type>
<datalist>
<data><value><![CDATA[AIX_Software_Failure]]></value></data>
<data><value><![CDATA[A software error PERM with label CORE_DUMP, identifier C69F5C9B
occurred at Wed Aug 2 5 10:22:28 DFT 2010 on dvs02 for resource SYSPROC.]]></value></data>
<data><value><![CDATA[Cause is SOFTWARE PROGRAM ABNORMALLY TERMINATED, An application
may not work properly, An application may not work properly.]]></value></data>
</datalist>
</module>
</agent_data>

The application is endless, but any script should be customized and it would have a very dynamical
structure. Under a lot of systems, the information which gets received doesn't solely consist of text.
It's also numerical and therefore able to feed numerical information to the modules in order to
represent e.g. graphics, etc. Please keep in mind that all data is always of the asynchronous type.

19.9.1. Practical Example: ESX Monitoring using Traps
One of the most problematic things to monitor is the monitoring of distributed infrastructure. It gets
even harder if each version changes it's implementation to gather information (like VMware or
ESX). In this chapter, we're going to explain how to monitor ESX systems by using an external
SNMP Trap Handler.
ESX traps consist of the following data:
.1.3.6.1.4.1.6876.4.3.301 = STRING: "host" .1.3.6.1.4.1.6876.4.3.302 = STRING: "c700006
01.tsm.inet" .1.3.6.1.4.1.6876.4.3.303 = "" .1.3.6.1.4.1.6876.4.3.304 = STRING: "Green" .
1.3.6.1.4.1.6876.4.3.305 = STRING: "Yellow" .1.3.6.1.4.1.6876.4.3.306 = STRING: "Host cpu usage 
Metric Usage = 1%"
.1.3.6.1.4.1.6876.4.3.301 = STRING: "host" .1.3.6.1.4.1.6876.4.3.302 = STRING: "dl360
00.tsm.inet"
.1.3.6.1.4.1.6876.4.3.303
=
""
.1.3.6.1.4.1.6876.4.3.304
=
STRING:
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"Yellow".1.3.6.1.4.1.6876.4.3.305 = STRING: "Green" .1.3.6.1.4.1.6876.4.3.306 = STRING: "Host
memory usage  Metric Usage = 84%"
.1.3.6.1.4.1.6876.4.3.301
=
STRING:
"host"
.1.3.6.1.4.1.6876.4.3.302
=
""
.
1.3.6.1.4.1.6876.4.3.303 = "" .1.3.6.1.4.1.6876.4.3.304 = STRING: "Red" .1.3.6.1.4.1.6876.4.3.305
= STRING: "Green" .1.3.6.1.4.1.6876.4.3.306 = STRING: "Datastore usage on disk  Metric Storage
space actually used = 55%"
As you can see, traps could be used to gather information from the CPU, the hard drive or the
memory. The general idea behind the trap handler is to write a small script which is able to
'understand' the trap and to create an XML file which emulates a software agent. It's recommended
to write a trap handler for each technology. The process of doing so is pretty common and
explained in four steps:
1.Please create the handler script. You may base your work on the script which is provided
below.
2.Please create an alert command.
3.Please create an alert action using the previous command. It's allowed to add some custom
options for each 'destination' agent you want (if you possess several farms of ESX, you're
probably going to like to host the data on different agents).
4.Please create an SNMP trapalert which maps the enterprise OID (information trap
contains for all kind of this specific technology) and / or the source trap IP address.
Now we're going to show how to create the traphandler script.

19.9.1.1. Step 1  The Trap Handler Script (esx_trap_manager.pl)
#!/usr/bin/perl
# (c) Sancho Lerena 2010 <slerena@artica.es>
# Specific Pandora FMS trap collector for ESX
use POSIX qw(setsid strftime);
sub show_help {
print "\nSpecific Pandora FMS trap collector for ESX\n";
print "(c) Sancho Lerena 2010 <slerena@artica.es>\n";
print "Usage:\n\n";
print "
esx_trap_manager.pl <destination_agent_name> <TRAP DATA>\n\n";
exit;
}
sub writexml {
my ($hostname, $xmlmessage ) = @_;
my $file = "/var/spool/pandora/data_in/$hostname.".rand(1000).".data";
open (FILE, ">> $file") or die "[FATAL] Cannot write to XML '$file'";
print FILE $xmlmessage;
close (FILE);
}
if ($#ARGV == -1){
show_help();
}
$chunk = "";
# The first parameter is always the destination host for the virtual server.
$target_host = $ARGV[0];
foreach $argnum (1 .. $#ARGV) {
if ($chunk ne ""){
$chunk .= " ";
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}
$chunk .= $ARGV[$argnum];
}
my $hostname = "";
my $now = strftime ("%Y-%m-%d %H:%M:%S", localtime());
my $xmldata = "<agent_data agent_name='$target_host' timestamp='$now' version='1.0' os='Other'
os_version='ESX_Collectordime ' interval='9999999999'>";
if ($chunk =~ m/.1.3.6.1.4.1.6876.4.3.302 \= STRING\: ([A-Za-z0-9\-\.]*)\s\.1/){
$hostname = "_".$1;
}
if ($chunk =~ m/Host cpu usage \- Metric Usage \= ([0-9]*)\z/){
$value = $1;
$module_name = "CPU_OCUPADA$hostname";
}
if ($chunk =~ m/Host memory usage \- Metric Usage = ([0-9\.]*)\z/){
$value = $1;
$module_name = "MEMORIA_OCUPADA$hostname";
}
if ($chunk =~ m/Datastore usage on disk \- Metric Storage space actually used \= ([0-9\.]*)\z/)
{
$value = $1;
$module_name = "DISCO_OCUPADO$hostname";
}
$xmldata .=
"<module><name>$module_name</name><type>async_data</type><data>$value</data></module>\n";
$xmldata .= "</agent_data>\n";
writexml ($target_host, $xmldata);

19.9.1.2. Step 2  Creating the Alert Command
In this example, I've put the command script in '/tmp' to put in a safer place, and to be sure it's
executable (chmod 755):
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19.9.1.3. Step 3  Creating the Alert Action
We're going to create a specific action to send all information to specific trap agents. In this case, all
information is going to be sent to an agent named 'WINN1247VSR'. The above mentioned command
accepts the name of the agent as a parameter which is going to receive all the information (ESX
Virtual Center), and 'chunks off' " the data from the trap, which can be unlimited and also includes
all the information you're sending to the trap.

19.9.1.4. Step 4  Creating the SNMP Alert
You may set alert traps by using the action you've just created.
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In order to process all the traps the of ESX type by using the specific OID '.1.3.6.1.4.1.6876.4.3.301'
to map the ESX type traps. You also have the option of filtering by source IP for each virtual center
by filtering for the originating IP address (which is contained in the trap).

19.9.1.5. Data Visualization
This is an example on how the information is going to look like. You may manage them as standard
modules by this data.
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19.10. SNMP Trap Forwarding (Pandora FMS versions 5 and above)
With Pandora FMS, it's also possible to forward SNMP traps to an external host by enabling the
token named snmp_forward_trap within the server configuration file.

19.10.1. Configuration Example to forward Traps by SNMP v1
snmp_forward_trap 1
snmp_forward_ip 192.168.1.145
snmp_forward_version 1
snmp_forward_secName
snmp_forward_engineid
snmp_forward_authProtocol
snmp_forward_authPassword
snmp_forward_privProtocol
snmp_forward_privPassword
snmp_forward_secLevel

19.10.2. Configuration Example to forward Traps by SNMP v2c
snmp_forward_trap 1
snmp_forward_ip 192.168.1.145
snmp_forward_version 2c
snmp_forward_secName
snmp_forward_engineid
snmp_forward_authProtocol
snmp_forward_authPassword
snmp_forward_privProtocol
snmp_forward_privPassword
snmp_forward_secLevel

499

SNMP Trap Forwarding (Pandora FMS versions 5 and above)

19.10.3. Configuration example to forward Traps by SNMP v3
This example is particularly challenging because of the implicated knowledge regarding SNMP v3
traps. We are considering the remote SNMP agent to be defined under snmp_forward_ip. It contains
the following entry in its file under '/etc/snmp/snmptrapd.conf':
createUser -e 0x0102030405 myuser MD5 mypassword DES myotherpassword

The Pandora's server configuration file should look like this:
snmp_forward_trap 1
snmp_forward_ip 192.168.1.145
snmp_forward_version 3
snmp_forward_secName myuser
snmp_forward_engineid 0x0102030405
snmp_forward_authProtocol MD5
snmp_forward_authPassword mypassword
snmp_forward_privProtocol DES
snmp_forward_privPassword myotherpassword
snmp_forward_secLevel authNoPriv

If you like to learn more about it, you can find it here.
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20 LOG COLLECTION
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20.1. Introduction
Pandora FMS is a monitoring system which mainly collects events and performance information.
Sometimes, it's used to monitor the result of a certain command's output in form of a string. The
same mechanism (which is called 'command execution parsing') is used to execute expressions (as a
single, as a match or by regular expression) within a log, returning only the matched information or
the number of matches.
You may also use Pandora FMS to count the number of files in a log or single matches (by using
'grep') on a file, but that is monitoring, not logcollection.
The biggest problem regarding massive log collection is the huge sizes they can grow to. We're
talking about environments starting in 100MB's a day to others where 1GB's per hour is considered
to be normal. That means: Information of such dimensions cannot be processed, normalized and
stored in a database  it's simply impossible.
Until now, Pandora FMS doesn't have a solution to this problem yet  but with Version 5, Pandora
FMS Enterprise offers a solution to manage hundreds of MB's per day in form of log files. This
solution allows to reuse the same agents used for monitoring, to collect information from event logs
(Windows) or in form of textfile logs. It utilizes a syntax which is very similar to the one of the
current logmonitoring modules.

The logs which are going to be managed by Pandora FMS Agents (eventlog or plaintext files) are
stored in a special directory in the original RAW format on the Pandora FMS Server which was
specified in the moment of configuration.
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The Pandora FMS Data Server receives the XML file from the agent which contains the information
gained by the monitoring and log sources in its original format. It stores the log information on the
hard drive. The monitoring information is going to be processed as usual.

All log information is arranged on the hard drive, using a directory hierarchy by date, so the system
is able to quickly locate all information  no matter how large your repository might be. This system
is well known and it's also the standard for extensive data searches and storage tasks.
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20.2. Setup
First, you're required to activate this feature within the console. It's in a special section in the setup,
as you can see on the following picture under the 'Activate Log Collector' option in the 'Enterprise'
tab:
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After enabling this option within the setup, you may set up some other specific options for the log
collection in the 'log collector' tab. You're able to define the directory where the Pandora FMS Data
Server is going to store the log files. It should be BIG. Please keep in mind that logs can accrete to
several Terabytes in a few days!

Of course, you're also able to setup the max. number of days you intend to keep this data on your
hard drives. Any data above the specified limit is going to be automatically deleted from the servers.
If you activate or deactivate the log collection feature, you're required to restart the Pandora FMS
Server in order for the changes to take effect. If you want to store a huge amount of data but don't
intend to create any interference to your realtime operations under Pandora FMS, it's
recommended to setup a remote hard drive by using NFS to store all the information in that
directory (we recommend SAN disks for this task). Another complementary option is to set
up two data servers to send the most 'dense' information to the 'big one' which possesses the better
hard drives.

20.3. Search and Visualization
In a log collection tool, we tend to look for two main features:
1. The
search
for
information,
filtering
by
date
and
2. To visualize the information drawn as occurrences per defined time unit.

/

or

source.

In the example below, we've searched for any data source which was gained from October 16 to
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October 17:
Data visualization example

View of matches through time

You're also able to utilize some filters to select the information you intend to find. The most obvious
ones are the time range and others like modules or the source of information (which is defined in
the log collector within the agent) and the agent itself where the information originates from.
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The most important and useful field is definitely the 'string search' (search in the capture). As in the
above mentioned case, this ought to be a simple text string or a regular expression in form of an IP
address:
192.168.[0-9]+.[0-9]+

As seen on the picture below, the search task looks for data which looks like an IP, within the range
192.168.0.0/16 within the defined the interval date / time on any data source.

20.4. The Agent's Setup
These are two examples to capture log information under Windows and UNIX:

20.4.1. Under Windows
module_begin
module_name Eventlog_System
module_type log
module_logevent
module_source System
module_end
module_begin
module_name PandoraAgent_log
module_type log
module_regexp C:\archivos de programa\pandora_agent\pandora_agent.log
module_description This module will return all lines from the specified logfile
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module_pattern .*
module_end

In both cases, the only difference between a monitoring module and a log source definition is this
item:
module_type log

This new syntax is only going to be understood by the new Version 5 Agent. If you intend to use this
new feature, you're required to upgrade the agents to version 5.

20.4.2. Under UNIX
Under UNIX, you're going to use a new plug in that comes along with the new Agent of Pandora
FMS 5. Its syntax is quite simple:
module_plugin grep_log_module /var/log/message Syslog \.\*

Similar to the log parser plugin (grep_log), the plug in named 'grep_log_module' sends the
processed information to the log collector named 'syslog' as the source of the log file. We
recommend to use the regular expressions \. \ * (in this case 'all') as a pattern when choosing which
ship lines and which doesn't.
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21 Other Types of Monitoring
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21.1. Introduction
In addition to features like remote monitoring, agentbased monitoring or web monitoring, Pandora
FMS offers other advanced resources to improve the monitoring. By this resources, you're able to
predict the value of a module, based on historical data or create new modules, conducting
arithmetic operations by utilizing existing ones.

21.2. Monitoring by Synthetic Modules
This is a feature of the Enterprise version. A synthetic module is a module which obtains its value
from already existing data within other modules.
Here are some examples:
•A module called 'Traffic sum' which sums the values of the incoming and outcoming traffic
of a router, generating a new module by the total traffic of the interface.
•A module called 'Total users' which sums the values of ten modules called 'Connected users'
in each of the five servers where the number of connected users is monitored.
In the end, synthetic modules are built from other module's data which could reside within the
same agent or in different ones. The operations we're able to perform are arithmetics (sum,
subtraction, multiplication and division) between modules and/or by absolute values.
The first step to create a synthetic module is to go to the 'management' section in the 'module' flap
of an agent, where we're going to create a new module of the prediction type.

In our first example, we're going to create a fictitious module which is going to contain the
arithmetic average value of two modules from two different agents: 'CPUUse' (SanchoXP) and
'cpu_user' (garfio). Within each machine, this module measures the use percentage of the CPU and
they are two Windows and Linux machines respectively. The final result will be a module stored in
agent 'SanchoXP' which is going to contain the average of both values.
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In the second example, a new module called 'total accesses' by the average value extracted from the
modules 'Apache_accesses' from two different agents, called 'SanchoXP' and 'SanchoXP_2' is
created.

Another easier but more useful example is the one which has been used to create the module called
'Total accesses' in 'SanchoXP_2'. It simply 'copies' the value of a module of the same name into
'SanchoXP' to produce the value.
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In order to operate with other logical operations (multiplication, subtraction and division), we
simply have to keep the order of the operators in mind. Please feel free to play around on the
interface to see how all other arithmetic operations between different modules can be conducted.
We're also able to use a fixed value to add it to our logical operations as shown on the picture
below.
You're able to select multiple agents from the box on the left side (by using 'control'). In the central
box, all the 'common' modules from the selected agents are going to be shown. It can be pretty
useful to produce averages from common modules in a server group (e.g. CPU or disk space).

21.3. Predictive Monitoring
In order to monitor an element by a prediction module, you're required to possess a
module before you're able to add the predictions to it. A suitable module could be the 'free disk' or
'RAM quantity' in a system, because the absence of such modules could cause a bad performance in
itself. Another interesting module could be the existing latency between the Pandora FMS Server
and an internet server such as Google. Because of this, an agent will be created, and inside of it, a
prediction module which monitors the latency between the two. In order to do this, please check
the network module creation section. In order to get the prediction to make sense, it's necessary to
have a pattern in the information to predict  preferably one which gets repeated in time (daily or
weekly).
On a Prediction Server, there are two methods in our disposal:
•To predict which of them would be considered an acceptable value in a 5 to 10 minute time
range or more  but the worse the approach, the longer the time we're considering for the
future.
•To say whether there is an anomaly in the value or not which has been collected by the
analyzed source module.
Now I'm going to show how a predictive module can be defined:
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Please click on 'Manage agents' in the Pandora FMS Console Management section.

On the next screen, please click on 'Create agent':

Please fill out the data for your new agent and click on 'Create':

Once you have created the agent, please click on the module's upper flap. Please select 'create a new
network module' and click on 'Create' in it.
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In this moment, a form in which you're required to fill out the appropriate fields in order to create a
prediction module is going to be shown.

The form fields are the following:
•Name: The module's name.
•Disabled: It shows whether a module is deactivated or not.
•Type: A kind of data which the module is going to monitor. These could be of the boolean
or numerical type. Depending on the type, it's going to act as an anomalies detector
(boolean module type) or as a 'predictor' of the module's future value (which is called
'numerical datatype module').
•Module Group: The group for the module.
•Source module: The module which is going to monitor the data. This group is useful to
perform as a small 'prefilter'. It's recommended to select an agent and a module.
•Interval: The interval under 'advanced features' which is going to be shown (accepted
values range from 5 minutes to 3 years). If the interval timer, which appears in the combo,
doesn't fit your needs, you may customize picking the desired units, ranging from seconds to
years (if it's of the predicting type and no anomalies detector).
As you can see, we've selected the module named 'Host Latency' from a previously created agent
called 'Google'. This is its data:
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The data which has been obtained from the two modules in a specific moment is the following:

If you like to perform a tracking of the latency data, please click on the box named '101' below the
'Graph' column. If you do so, the received RAW data for the last day is going to be displayed.

Though we don't have much data in this case, we're able to see the media is going to range between
13 and 15 seconds. If the media gets altered by these values, the prediction module is going to
notify us about it. Nevertheless, we need at least a week of data in order to get the prediction to
work properly.
Now we're going to explain in detail how the module works:
The Pandora FMS Artificial Intelligence and Prediction Server implements a data prevision, based
on past statistical data (up to 30 days in four temporary references).
In addition to the ones of Pandora FMS, a complementary data model has been created and allows
the modules which contain prediction data to be 'fed' of real module data. Modules of the predictive
type are processed by a server that works only by data of the same type in a throughly modular
way. It's very easy to implement several cores of the information processing (even in different
languages) to make much more complete predictions, based on the neuronal bayesian networks.
By now, the prediction has two types of modules: A numerical data prediction, based on a
temporary margin (defined as an interval within the new prediction module) or a detection in the
alteration of the 'normal' performance in a temporary margin, defined as one half of the defined
interval. The wider the temporary margin, the more possibilities of errors the prediction is going to
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have and the widest possible value range is going to be considered.
These two modules are implemented along with boolean modules, which belong to the second type
of prediction (anomalies): Numerical and incremental numerics which belong to the last of the
second type of prediction.
In order to get the prediction to work properly, it should at least have the data from a week,
otherwise it's not possible to predict it. The prediction is performed by the average value calculation
of the module in an specific interval, in four points of time: 't1', 't2', 't3' and 't4' where 't1' represents
the value from a week ago, 't2' the value from two weeks ago and so on.
For the anomalies calculation, it's also possible to calculate the typical deviation for these samples
with values different from '0' and to compare the real value on the «predicted» +/ the typical
deviation.
The amount of samples are adjustable, although Pandora FMS usually doesn't keep useful values
which are older than a month.
An essential parameter in the prediction is the interval of itself, available under 'advanced options'
within the module.

The remaining fields of the advanced features are the same as in the rest of the modules.

21.3.1. Monitoring by Netflow
This is a special case of monitoring by a Prediction Server and it's also a feature of the Enterprise
Version.
Netflow modules are able to calculate the average traffic on an interval for a defined pattern on a
Netflow filter. The average is calculated in bits per second.
The first step is define the filter. To e.g. configure a module to return the web traffic average every
10 minutes, please click on 'Administration' and 'Netflow Filters'. Please create a new filter by the
following configuration:
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Please keep in mind that the fields of 'Aggregate by' and 'Output format' only affect the Netflow
graphics, not the modules.
Subsequntly we're creating a module by clicking on 'Administration' and 'Manage agents'. Please
select an agent and click on 'Modules'.

Please select 'Create a new prediction server module' and click on 'Create'.

To configure 'Netflow' as a source, please select the filter and set up an interval of 600 seconds (10
minutes).
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22 COMMON PARAMETERS WITHIN
MODULES
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22.1. Tags
Tags are like labels, associated to modules which are going to be propagated to events. Those
events will be used in conjunction with event alerts of that module.
In order to create them, please go to 'Manage interface' > 'Manage modules' and 'Manage tags':

After the tags have been created, please fill out the text fields for 'name', 'description', (optionally) a
complete URL (e.g. http://somewebpage.com), 'email' and 'phone'. This information is going to get
associated to the tag.
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It's important to note that more than one tag can be associated to a module. To do so,
you first have to create them (as shown above) before it's possible to associate them to a
module.

Within the advanced module options, two columns are displayed. On the left side you see all
available tags. On the right side, selected tags are going to be displayed. It's of course possible to
move the tags from one side to another. Please select the desired tag and click on the arrowshaped
button to do so.

23 IPAM Extension
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Using IPAM extension, we can manage, discover and get event on changes on hosts in a given
network. We can know if a given IP address (IPv4 or IPv6) change it's availability (answer to a
ping) or hostname (using dns resolution). We also can detect its OS and link a IP address to a
current Pandora FMS agent, adding the IP address to their currently assigned addresses. IPAM
extension uses the recon server and a recon script on the low level, but you don't need to configure
nothing, IPAM extension do everything for you.
IP Management works in parallel to the monitoring you currently manage with Pandora FMS
agents, you can associate a IP address managed with IPAM extension or not, it depends on you.
Managed IP addresses can optionally generate event on change.

23.1. IPs Detection
We can setup a network (using a bit mask or a prefix), and this network will be automatically
sweeped or setup to have a onrequest manual execution. This will execute a recon script task,
searching for active IP (using nmap for IPv4 and ping for IPv6). You see the progress on network
sweep in the status view and also in the recon server view.

23.2. Views
Network IP addresses administration and operation are splitted in two views: icon views and edition
view.

23.2.1. Icon view

This view reports information on the network, including stats on the percentage and number of
occupied IP addresses (only for 'managed' addresses). We can also export to Excel/CSV the filtered
list.
Addresses will be shown as icons, large or small. This icons will render the following information:

Managed
Setup

Alive host
522

Views

No assigned agent
Disabled events
With assigned agent
Disabled events
No assigned agent
Enabled events
With assigned agent
Enabled events
Not managed
Setup

Alive host

If an IP address is not managed, you can only
view if is responding or not.

Each IP address have in the bottom right position a link to edit it (with adminitration rights). In the
bottom left position, there is a small icon showing the OS detected. On disabled addresses, instead
the OS icon, you will see this icon:

When you click on the main icon, a modal window will be opened showing all the IP information,
including associated agent and OS, setup for that IP and other information, like creation date, last
user edition or last time it was checked by server. In this view you can also do a manual, realtime
check to see if that IP respond to ping.
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This ping is done by the console, instead the regular check, done by the recon
server.

23.2.2. Edit view
If you have enought permission, you will have access to setup view, where IP address are shown as
a list. You can filter to show only the IP's you are interested into, make changes and update all at
once.
Some fields, are automatically filled by the recon script, like hostname, if it have a Pandora FMS
agent and the operating system. You can mark that fields as "manual" and edit them.

Cambio entre manual y automático
Manual mode: With this symbol, the field will not be updated by the recon system and you
can edit manually. By clicking on it, you will switch to automated mode.
Automated mode: With this icon, the field will be updated automatically from the recon
script. By clicking on it, it will switch to manual mode.
Fields marked as "manual" will not be updated by the recon
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script.

Other fields you can modify are:  Activate events on an IP address. When availability on this
address change (answer or stop to answer) or the hostname change, a new event will be generated.
When an address is created, it always will generate an event.
 Mark as managed an IP Address. This address are those we will acknowledge as assigned in our
network and managed in the system. You can filter to show only managed addresses.
 Disable. Disabled IP addresses are not checked by the recon script.
 Comments. A free field to add comments on each address.

23.3. Filters
On both views you can sort by IP, Hostname and by the last update.
You can filter by a text substring, which will match in IP, hostname or comments of each IP in the
system. Enabling the checkbox near to search box, it will force an exact match by IP.
By default, not responding hosts are not shown, but you can change the filter.
You can also show only the managed IP addresses.
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23.4. Subnetwork calculator
IPAM includes a tool to calculate IPv4 and IPv6 subnetworks.
In this tool, you can, using an IP address and a netmask, obtain the information of that network:
•Red (Dirección/Bitmask)
•Máscara de red
•La máscara Wildcard
•La dirección de red
•La dirección de Broadcast
•Primera IP válida
•Última IP válida
•Número de IPs en la red

These fields are given in address format (decimal for IPv4 and hexadecimal for IPv6)
and binary format.

IPv4
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IPv6
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24 Automatic Network Discovery
by a Recon Server
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24.1. Introduction
The Pandora FMS Recon Server was introduced the first time in version 1.3. Henceforth, it had
received several updates and improvements. The Recon Server was created to explore the network
by using ICMP (Ping) by userdefined tasks in order to find new systems which are getting
identified by their IP address. Subsequently, they're added to the supervision by using the 'plugin
templates' to assign modules automatically to the new agent. In this way, a new system is absorbed
and a new set of network modules get assigned to it in order to be monitored by itself.
It's important to add that the Recon Server utilizes the IP address in order to identify which agents
are already supervised by Pandora FMS. This is the reason for why the Pandora FMS 1.3 agents
were able to hold more than one IP address.
The Recon Server also allows to detect the topology of the newly discovered systems by adding
these systems to the last known host to the new host in the path of Pandora FMS. It also identifies
all the intermediate hosts by their IPs, defining the father of the new monitored system as the last
known host before moving on to the new system.

The Recon Server sets up a system for Operating System detection by using
'Xprobe2' (if installed) along with an optional detection of open ports (via NMAP),
which allows to identify and recognize any specific system (e.g. 'Solaris with port 23
open' or 'Windows with ports 139 and 445 open').
24.2. Recon Tasks
Before defining a new Recon Task, you're required to have a Recon Server started on
the system. To be able to assign new agents to a network server automatically, you're
also required to start a Network Server before doing so.

All Recon Tasks are defined in the menu of 'Administration' > 'Manage servers' and 'Manage
recontask'.
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You may create a new task on the screen by clicking on 'Create'. You may also edit already existing
ones by clicking on their names:

If you choose to edit or create a new task of network reconnaissance, you're required to fill out the
appropriate fields so the task is getting processed properly.
Task
Name:
The Name of the discovery task. It's just a descriptive value for being able to distinguish the task in
case there are several of them, bearing different filer values or templates.
Recon
Server:
The Recon Server which is assigned to the task. If you have several Recon Servers, you're required
to select which of them you want to conduct the recon task here.
Mode:
The task mode to choose between 'network scanning' and 'custom script'. The first mode is the
conventional network recognition task, and the second is the manner in which the task is associated
to a custom script.
Network:
The network in which you want the recognition to be conducted. Please use the network format or
bit mask when conducting the recognition. The IP of '192.168.1.0/24' is a class C address which
includes all addresses from '192.168.1.0' to '192.168.1.255'.
Interval:
The repetition interval of the system's search. It's recommended not to use very short intervals,
because the Recon Server explores a network by sending one ping to each address. If you intend to
assign very large networks (for example a class A network) in combination with very short intervals
(e.g. 6 hours) to the Recon Task, the effect you're going to get is that Pandora FMS will always
flood the network with countless pings, thereby straining it and Pandora FMS unnecessarily.
Module
Template:
The plugins template to add the discovered systems. If it detects a system which fits to the
parameters for this task (e.g. OS or ports), it's going to register it and assigns all included modules
contained in the defined plugin template.
OS:
The operating system to recognize. If you select one instead of 'any', it's only going to add the
systems which use this operating system. Under some circumstances, please keep in mind that
Pandora FMS can make a mistake when detecting systems. These types of 'guesses' are conducted by
statistic patterns, which depend on certain other factors which could sometimes fail (e.g. networks
with filters, security software, modified versions of the system). To use this methods safely, it's
recommended to have 'Xprobe2' installed on your system.
Ports:
It's intended to define some specific ports or range, e.g. '22,23,21,8090,443,8080'. If you use this
field, only the detected hosts which have at least one of the mentioned ports open, are going to be
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detected and added to the system. If one host is detected without at least one of the ports opened,
it's going to be ignored. This, along with the 'filter by OS' type of filter allows you to detect the
systems that are interesting, e.g. detecting that it's a router, because the ports 23 and 57 are
opened. The system therefore recognizes it as a 'BSD' kind of operating system.
Group:
It's the group in which it's recommended to add the discovered systems. It's forced to assign the new
systems to one group. If it doesn't already have one specific group to locate the unclassified agents
assigned, it's recommended to assign it here.
Incident:
It's intended to define whether to create an incident because of discovering a new system or not. It's
going to create one incident for each task  not just one for the detected machine, but to summarize
all the newly detected systems. It's going to create it within the predefined group automatically.
SNMP Default Community:
The default SNMP community intended to be used to discover new systems.
Comments: The comments about the network discovery task.
OS Detection:
By using this option, the scan is going to detect the OS.
Name Resolution:
By using this option, the agent will be created by the name of its host computer (if a name was
assigned to it). If not, please take the IP address for the agent's name after creating it.
Parent Detection:
By enabling this option, the function is going to detect whether the detected computers are
connected to others themselves. If so, they are recognized and created as children during the
exploring process.
Parent Recursion:
It indicates the maximum number of recursions with which agents gain the ability of generating
parents and children after the completion of the scanning process.
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Once you're finished, please click on 'Update' if you intend to edit an already existing task or on
'Create' if you intend to create a new one.
The plug ins and assigned groups to the new host templates in this sweep allow you to conduct a
network reconnaissance which explores large networks in hours or just minutes. You're also able to
detect and start the monitoring of a complete network by just a few steps.
Once the Recon Task has been defined, it's recommended start it in order to obtain information
from your network systems. Do do so, please go to the 'Administration' and 'Manage Servers' menu
as shown below.

To obtain information about the state of the servers, you may also click on the head element named
'All systems' which is going to lead you to the same window.

The window shown below contains information about the state of the Pandora FMS Servers:
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Please look for Recon Server Configuration Details within the console and click on it. You're going
to see a window which contains information about the state of the Recon Tasks as shown below.

It's recommended to click on the button on the right of the console to start the Recon Tasks. Once
you've done this, the completion is going to take some time.

24.2.1. Network Topology
The Recon Server allows you not just to conduct a discovery of the host organization, but to
conduct it in such a way to detect how they are connected to each other. This means: As long as it's
well implemented, Pandora FMS is able to detect, monitor and represent its network with accuracy
 regardless the number of systems your network consists of.
This is a snapshot of the systems in one of our development servers, which monitors about a 1000
systems by Pandora FMS:
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To accomplish this successfully, you need to plan the monitoring by layers, as if it would be an
onion. We recommend to conduct this in such a way that the levels which are closer to Pandora
FMS are going to be detected first. In order to recognize them, it's going to detect the systems which
are behind them. In this way, it could associate them to the already detected modules.
To do so, you're required to create network tasks for the more immediate communication systems
and for the following ones, afterwards. Once you have detected the more basic systems, we
recommend to create more complex Recon Tasks, based on architectures and systems (by
application or by SO), and assign predefined network templates to them, well adapted to the
systems it found, e.g. creating a template for web servers which monitor the server state by an
advanced TCP checkup, verifying latency time, network response, and monitor service ports such as
SSH or FTP. If you have defined any WMI checks or suitable plug ins, you may also add them to it.
If you apply a template which contains a module that isn't applicable to a system detected by the
first scan, it's going to be considered 'not started' until it's going to be automatically deleted by the
system's daily maintenance script. The modules which have never obtained any data (or were never
started at all) are going to be deleted.

24.2.2. Examples of Use
Lets assume for a moment there would be four C type network servers and one B type, hosting
several work stations, a plugin template for any of these five networks will be defined, e.g.:
•Template Number 1 is used for a Windows Server. It could contain the following five
modules:
An
An
An
An

SNMP
module
to
learn
the
CPU
usage
on
the
SNMP module to learn the available memory on the
SNMP
module
to
learn
the
incoming
network
SNMP
module
to
learn
the
outgoing
network

Windows
Windows
interface
interface

Server.
Server.
data.
data.
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An ICMP module to monitor whether it continues working or not.
•Template Number 2 is used to check the UNIX HTTP Servers:
An
ICMP
module
to
monitor
whether
it
continues
working
or
not.
A TCP module to check whether port 80 is working and whether it responds to HTTP commands or
not.
A TCP module to check whether port 22 is working and responds to SSH.
An
SNMP
module
to
learn
about
the
CPU
usage.
An
SNMP
module
to
learn
about
the
incoming
network
interface
data.
An SNMP module to learn about the outgoing network interface data.
•Template Number 3 is used to check the UNIX Oracle Servers:
An
ICMP
module
to
check
whether
it's
working
or
not.
A TCP module to check if a specific TCP port is working and responding to Oracle commands.
A
TCP
module
to
check
whether
a
specific
port
is
open
or
not.
An
SNMP
module
to
learn
about
the
CPU
usage.
An SNMP module to learn about the available memory.
•Template Number 4 is used to check CIFS Windows Servers:
An
ICMP
module
to
check
whether
it's
working
or
not.
An
SNMP
module
to
learn
about
the
CPU
usage.
An
SNMP
module
to
learn
about
the
available
memory.
Several
TCP
modules
to
check
whether
CIFS
is
available
or
not.
An
SNMP
module
to
learn
about
the
incoming
network
interface
data.
An SNMP module to learn about the outgoing network interface data.
•Template number 5 is used to check the activity of all workstations:
An
ICMP
module
to
check
whether
it
works
or
not.
A TCP module to check whether specifically 'forbidden' ports are closed, e.g. 21,22, 80, 8080, 5900,
etc.
We recommend to create five supervision tasks: Four for each type of server in each network or
subnetwork, assigned to these types of servers. Assign each task to a different group and its network
profile to it. The last one is intended for the workstation, assigned to the all the B class devices and
other different groups. We also suggest to use a shorter analysis interval (e.g. half a day or one day)
for the workstations and a longer one for the servers (two to three days or one week).
The supervision servers use a ICMP internal analyzer to check whether the machine works or not.
When an agent gets created, it attempts to resolve the IP address to assign a host name as the name
of the agent.

24.3. Recon Scripts
24.3.1. Introduction
The new "ReconScripts" feature allows to conduct the recon in a much more flexible way than the
network monitoring and the automatic discovery of the classical Recon Server did before. The
Recon Scripts are developed individually along with completely specific targets, such as the
network's or the agent's plug ins. Each Recon Script is unique and has only one purpose.
Its basic idea is based on 'detecting' things it recognizes on the system and to automatically establish
one certain type of monitoring (network, plug in or WMI), so we're able to e.g. automatically
conduct login requests on an Oracle database, detect new virtual hosts in a VMware which is
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managed by 'VirtualCenter' or to detect new requests in a WebLogic Application Server in a
completely customized way. The Recon Server is also able to execute a script or application which
performs the desired task and to schedule its execution.
All Recon Scripts are customized, very specific and intended for only one technology. We have
developed one which is completely Open Source. We call it 'SnmpDevices'. This script can be found
in '/usr/share/pandora_server/util/plugin_reconserver/snmpdevices.pl'.
This system allows to check a predefined IP's interval and to create agents for each SNMP system
which answers to it (an SNMP community is implied here). It's also going to automatically create
some network modules (via SNMP) depending on the results that it obtains. It's going to create the
following four SNMP modules for each recognized host:
•SysUptime: The system's uptime (in seconds since the system started).
•SysName: The system's name.
•Local InReceives: The received bytes in the system per second.
•Local OutRequests: The transmitted bytes from the system per second.
And for each recognized interface (it's going to detect the interface's name automatically), three
additional SNMP modules are going to be created within the host:
•Status: The status (whether it works or not).
•Inbound Bps: The incoming bytes on the interface per second.
•Outbound Bps: The outgoing bytes on the interface per second.

24.3.2. Examples of Application
This script could be used in two different ways: By the Pandora FMS Console or by the command
line.

24.3.2.1. Application by the Command Line
Syntax:
./snmpdevices.pl
<custom_field2>

<task_id>

<group_id>

<create_incident_flag>

<custom_field1>

Example:
./snmpdevices.pl 3 8 0 192.168.100.0/24 community2010
The example above conducts a Recon Task with ID 3 to which it's going to be associated to. The
created agents are going to be assigned to the group with ID 8 (Databases). The incident creation
has been deactivated by the third parameter ('0'). It's going to check the network under
'192.168.100.0' by the mask of '24', so the IPs from '192.168.100.1' through '192.168.100.254' are
going to be checked. This example check is going to be performed by the community named
'community2010'.

24.3.2.2. Application by the Pandora FMS Console
The first step to use a Recon Script on the Pandora Console is to go to 'Manage Servers' and
'Manage Recon Scripts'. In this section, we're going to associate all the scripts we want to use by
adding the complete script paths one by one.
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Once the example script has been added, we continue by creating a Recon Task which is going to
get associated to it. If we select the 'custom script' mode in the Recon Task creating form, it's
recommended to select some common data with a 'normal' Recon Task, e.g. the associated servers,
the task execution interval, the group to which the created agents are going to belong to and the
incidents and additional comments if they are created.
Apart from this information, it's recommended to configure a series of the script's own parameters,
as the script of the previously added ones we intend to use (for us SNMP devices) and the
customized fields that we're going to pass along to the script (up to 4).
We also recommend to pass the ID of the already created task to our script automatically. Regarding
to the creation of form checks, it's the selected group and the flag which determines whether the
incident is going to be created or not. In addition to the four possible customized fields, it's going to
use the first two: The first one being the network from where it's going to track and the second one
being the device's SNMP community from which we expect the results from.
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Once the two customized fields have been filled out, and the comments you might want to add, the
Recon Task associated to the SNMP device's test script are going to be created. It's going to start the
track. The agents and the previously explained modules are also going to be created.

24.3.3. SNMP L2 Recon Script
This script relies on SNMP to perform a layer2 network scan. Routers and switches are queried via
SNMP to extract interface and layer2 information. Hosts which are still disconnected after the layer
2 scan are going to be connected via traceroute.
In order to perform an SNMP layer 2 scan, please create a new recon task, select the custom script
called 'SNMP L2 Recon' and fill out the following parameters:
•Network: A commaseparated
192.168.2.0/24).

list

of

networks

to

scan

(e.g.

192.168.1.0/24,

•Community: A commaseparated list of SNMP communities to try.
•Router (optional): The router's IP within the network. It's not mandatory, but it makes it a
lot easier to scan the network.
•Optional Parameter (optional): Please set it to 'a' in order to add all network interfaces
(by default, only interfaces which are considered up and running are added).
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In order to display the discovered network, please click on 'Operation' > 'Network View' >
'Network Map' and check the 'L2 Network Interfaces' check box.

24.3.4. WMI Recon Script
This script scans the network for hosts which respond to WMI queries and creates default modules
for them.
In order to perform a WMI network scan, please create a new recon task, select the custom script
called 'WMI Recon Script' and fill out the following parameters:
•Network: A commaseparated
192.168.2.0/24).

list

of

networks

to

scan

(e.g.

192.168.1.0/24,

•WMI Auth: A commaseparated list of WMI authentication tokens in the format 'username
%password' (e.g. 'Administrator%pass').
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25.1. Introduction
An alert is Pandora FMS's reaction to a module's value being 'out of range'. Such a reaction is
configurable and results in sending an email or an SMS to the administrator, sends an SNMP trap,
records the incident within the system's log, etc. An alert is basically any scripttriggered action,
configured in the operating system, where the Pandora FMS Server, which processes the module, is
executed. There are three alert types: Individual Alerts, Event Alerts and SNMP Trap Alerts. In this
chapter, we're going to talk about the Alert System in general and its individual alerts.

25.2. Introduction to the current Alert System
People usually complain about the complexity of defining alerts within Pandora FMS. Then (until
version 2.0), alerts were much simpler to configure. For each alert, the condition and the behavior
if the action wasn't executed, was defined for each case. It was a much more 'intuitive' thing (it also
held fields like the 'threshold alert' which caused lot of headaches for more than one customer). It
was very simple  but ... was it worth it?
One of our most helpful users in this case (he had lots of agents installed and was also able to
manage Pandora FMS very well), told us that creating an alert within 2000 modules would be very
timeconsuming, especially if you have to modify the very same things within all of them. Due to
these and quite a few other problems, we had to modify the alert system to become modular and for
being able to separate the definition of the alert's firing condition (e.g. to alter a template) from the
action to execute if it's fired (alert action) and from the command which is executed in the action
(alert command). Now, the combination of an alert template and a module triggers the alert.
If I have e.g. a 1000 systems with a module called 'Host alive' and all of them have an associated
alert template called 'Host down', an alert called 'Call the Operator' is going to be executed by
default. If I want to e.g. change the minimum number of fired alerts before notifying the operator,
I'm only required to make a change in the template's definition  I'm no longer forced to do it
separately in all of the 1000 alerts to modify their conditions.
Several of our customers only manage a few dozen machines, but there are a lot of users with
hundreds, even thousands of systems monitored by Pandora FMS, and we're making it possible to
manage any and all types of environments by it.

25.2.1. The Alert Structure
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An alert consists of the following:
•Commands
•Actions
•Templates
A command defines the operation to perform if an alert is fired. Some examples of a command
could be e.g. to write into a log, send an email or SMS, execute a script or a program, etc.
An action links a command to a template and allows you to customize the command execution by
using three generic parameters: 'Field 1', 'Field 2' and 'Field 3'. These parameters allow you to
customize the command execution because they are passed as input parameters to the executed
command.
Within the template, you're defining the alert's generic parameters like firing conditions, firing
actions and the alert recovery.
•Firing Conditions: The conditions for when the alert is going to be fired, e.g. if the data is
above a threshold or if the status is in 'critical' range, etc.
•Firing Actions: The configuration for the action which is going to be performed if the alert
is fired.
•Alert Recovery: The configuration for actions performed if the system is recovered after the
alert was fired.

25.2.2. The Alert System's Information Flow
When you're defining actions and templates, you have some generic fields called 'Field1', 'Field2'
and 'Field3' at your disposal. These are the values passed as input parameters to the executed
command. The values of these parameters are subsequently propagated from the template to the
action and to the command from there. The value propagation from the template to the action is
only going to be performed if the field defined in the action hasn't got any value  otherwise, any
resident value is going to be used.
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This is an example for how template values are overwritten by the action's values:

We can e.g. create a template that fires an alert and sends an email, containing the following fields:
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•Template:
•Field 1: myemail@domain.com
•Field 2: [Alert] The alert was fired.
•Field 3: The alert was fired!!! SOS!!!
•Action:
•Field 1: myboss@domain.com
•Field 2: <left blank>
•Field 3: <left blank>
The values which are going to be passed to the command are:
•Command:
•Field 1: myboss@domain.com
•Field 2: [Alert] The alert was fired
•Field 3: The alert was fired!!! SOS!!!

25.3. The Alert Command (Pandora Versions 5 and above only)
Pandora FMS's reaction to a value like 'out of range' can consist of the following types: A record in a
system log, the sending of an email or SMS or the execution of any processable script which is
hosted on it.
The different reactions Pandora FMS can be adopted to are configured after clicking on
'Administration' > 'Manage Alerts' and 'Command'.

545

The Alert Command (Pandora Versions 5 and above only)

In this section, you're able to modify or add your own alert commands.

25.3.1. Command Creation for an Alert
New alert commands are created by clicking on the 'Administration' > 'Manage Alerts' >
'Command menu' and 'Create' buttons.
Once you've clicked on 'Create', a window as the one shown below is going to appear.

Next, the following fields are introduced:
Name: The command's name. It's important to be descriptive but short, e.g. 'Log' or
'Communications'.
Command: The Command to be executed as reaction to a module being 'out of range'. You may use
macros to replace the preconfigured parameters within the alert definition. The available macros
are the following:
•_ﬁeld1_  _field10_: Ten fields to customize the macro.
•_agent_: The agent's complete name.
•_agentdescription_: The description of the agent who fired the alert.
•_agentgroup_: The agent's group name.
•_agentstatus_: The current status of the agent.
•_address_: The address of the agent which fired the alert.
•_timestamp_: A standard representation of date and time. It gets replaced automatically in
the moment of alert execution.
•_timezone_: The timezone's name that _timestamp_ represents (in Pandora FMS versions
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>=5.0 SP1).
•_data_: The values of the data which have triggered the alert.
•_alert_description_: The alert's description.
•_alert_threshold_: The alert's threshold.
•_alert_times_fired_: The number of times the alert has been fired.
•_module_: The module's name.
•_modulegroup_: The module's group name.
•_moduledescription_: The description of the module which fired the alert.
•_modulestatus_: The module's status.
•_moduletags_: The tags associated to the module.
•_alert_name_: The alert's name.
•_alert_priority_: The numerical value for alert priority.
•_alert_text_severity_: The text alert severity, e.g. 'maintenance', 'informational', 'normal',
'minor', 'warning', 'major' and 'critical'.
•_event_text_severity_: (Event alerts only) The severity of the text event which fires the
alert, e.g. 'maintenance', 'informational', 'normal', 'minor', 'warning', 'major' and 'critical'.
•_id_agent_: The ID of the agent. It's useful to e.g. build a direct URL to redirect to a
Pandora FMS console's web page.
•_id_alert_: The unique numerical ID of the alert which is used to correlate to a third party
software.
•_policy_: The name of the policy the module belongs to (if it applies).
•_interval_:: The execution interval of the module.
•_target_ip_ The IP address of the target's module.
•_target_port_: The port number of the target's module.
•_plugin_parameters_: The plugin parameters of the module.
•_groupcontact_: The group's contact information. It gets configured when the group is
created.
•_groupother_: All other information about the group. It gets configured when the group is
created.
•_email_tag_: The emails associated to module tags.
When it comes to creating the commands for the alerts, please keep in mind that such commands
are executed by the Pandora FMS Server which processes the module of the processed agent, e.g. a
Data or Network Server. Alerts will also be executed by the privileges of the user which is executing
the Pandora FMS Server. It's recommended to test whether the command's execution is successful
or not and if it produces the desired result (e.g. sending an email, generating an entry within the
log file, etc.) on the commandline interface in the moment of the command's definition.
Description: A thorough description of the alert command for information purposes.
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Once it's created, please click on the 'Create' button.

25.3.2. Editing an Alert Command
You may edit the newly created alert commands by clicking on 'Administration' > 'Manage Alerts'
and 'Command'.
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To edit an alert command, please click on the command's name.

Once the chosen alert has been modified, please click on the 'Update' button.

The alerts named eMail, Internal Audit and Pandora FMS Event cannot be
modified.

25.3.3. How to Delete an Alert Command
In order to delete an alert, please click on the gray trash icon (which is located on the right hand
side of the alert) as shown below.
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25.3.4. Predefined Commands
There are some predefined commands which could be adjusted if the system doesn't have the
internal commands for executing such alerts. The development team has tested these alerts by the
distributions named 'Red Hat', 'CentOs', 'Debian' and 'Ubuntu Server'.
eMail:
Sends an email from the Pandora FMS Server and uses the Perl 'sendmail' command to do so.
Pandora FMS utilizes the systemspecific tools to conduct almost all alerts. In this case, it's going to
be necessary to check whether or not the 'libmailsendmailperl' (an 'xprobe2' package) is already
installed on your system.
Internal
Audit:
This is just an 'internal' alert which generates a small entry within the internal Auditing System of
Pandora FMS. It's kept in the Pandora FMS Database and could be reviewed by the console's event
viewer.
Pandora FMS Event:
This alert creates a special event within the Pandora FMS Event Manager.
Pandora FMS Alertlog:
This is a default alert to write alerts in a standard ASCII plaintext log file located under
'/var/log/pandora/pandora_alert.log'.
SNMP Trap:
It sends an SNMP trap if an alert occurs.
Syslog:
It sends an alert to the system registry and uses the system command named 'logger' to do so.
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Sound Alert:
It plays back a sound if an alert is received.
Jabber Alert:
Sends a jabber alert to a chat room on a predefined server (please configure the file named
'.sendxmpprc' first). It uses 'field3' for the text message, 'field1' for the user's aliasforsource
message, and 'field2' for the chatroom's name.
SMS Text:
Sends an SMS to a specific cellphone. You're required to define an alert and a gateway for sending
configured and accessible SMS from Pandora FMS before being able to do so. It's also possible to
install one using 'Gnokii' to send SMS directly by using a Nokia telephone with an USB wire. Further
information on the detailed procedure is going to be described below.
Validate
It validates all events in relation to a module. The agent's and module's name will be given.

Event:

25.3.5. Examples of Commands
25.3.5.1. Integrating Alerts by the Jabber Instant Messenger
It's very easy to set up Pandora FMS to send alerts by using a Jabber Server. Jabber can be utilized
as a system to get real time alerts as well as a history log, allowing a group of people to receive
those alerts simultaneously.
Installing Jabber Services

Procedure for the Client:
1.Please install a Jabber client like Pidgin.
2.Register an account under 'Pidgin' by clicking on the 'Accounts' tab to configure the
account.
3.Login to that account.
Procedure for the Pandora FMS Server:
1.Please install the package named 'sendxmpp'. It's a dependency for the Pandora FMS
Server in order to send messages to Jabber services.
2.Create a file named '.sendxmpprc' within your '/home' folder.
3.Edit that file and insert the following text:
useraccount@jabber.org password

1.Please change the file permissions for '.sendxmpprc':
chmod 0600 .sendxmpprc

By the example below, you're now able to send private messages using the command line.
$ echo "Hello" | sendxmpp -s pandora useracount@jabber.org

To register the alert within the Pandora FMS Web Console and to add a new command and
configure its variables, you're required to do the following:
•Field_1: The Jabber address.
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•Field_2: The text you intend to send.
The alert is going to be defined as follows:
echo _field2_ | sendxmpp -s pandora _field1_

Additional Examples of Jabber Usage

To send a message to a chat room, please enter the following command:
$ echo "Dinner Time" | sendxmpp -r TheCook --chatroom test2@conference.jabber.org

To send the log entries to a Jabber destination in realtime, please enter the following command:
$ tail -f /var/log/syslog | sendxmpp -i sysadmin@myjabberserver.com

Be careful not to flood public Jabber Servers by your messages or you're very likely to
get banned by them.

25.3.5.2. Sending Emails by the 'Expect' Script
Sometimes it's necessary to use an authenticated SMTP to send emails. It's a probably easier and
more versatile method to use a simple 'expect' script instead of configuring 'sendmail' to use an
authenticated SMTP. This is an example using 'expect' to send emails by using an Exchange Server:
First, you're required to create a file called '/etc/snmp' containing the following script:
#!/usr/bin/expect -f
set arg1 [lindex $argv 0]
set arg2 [lindex $argv 1]
set arg3 [lindex $argv 2]
set timeout 1
spawn telnet myserver.com 25
expect "220"
send "ehlo mymachine.mydomain.com\r"
expect "250"
send "AUTH login\r"
expect "334"
send "2342348werhkwjernsdf78sdf3w4rwe32wer=\r"
expect "334"
send "YRejewrhneruT==\r"
expect "235"
send "MAIL FROM: myuser@domain.com\r"
expect "Sender OK"
send "RCPT TO: $arg1\r"
expect "250"
send "data\r"
expect "354"
send "Subject: $arg2\r"
send "$arg3 \r\r"
send ".\r"
expect "delivery"
send "quit"
quit

To edit the file permissions to allow the execution, please enter the following command:
chmod 700 /root/smtp
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Before trying to use it, please make sure that '/usr/bin/expect' is working appropriately.
Before being able to utilize this in conjunction with Pandora FMS, you're also required to create a
new command (or to modify an already existing email alertsending command) and to specify the
following fields within the Pandora FMS Alert Command definition in the field named 'Command'.
It's going to write the following:
/root/smtp _field1_ _field2_ _field3_

The script is allowed to be located in any place on the system.

Please keep in mind that the alert script is launched by the server which is going to
process the data. If the payload is consisted of network data, the Network Server is
going to process it. If it's an XML data file sent by an agent, it's the Data Server which
is going to launch it.

If you have several physical servers, it's possible that you're required to copy the same script to the
same location, along with the same permissions and the same owner on all the systems you have a
Pandora FMS Server running and want to execute this alert on. Please keep in mind that the
Pandora FMS Network Servers are required to be executed as 'root' (e.g. for being able to execute
ICMP latency tests). However, the Data Server isn't required to be executed as 'root'  it may be
started by any user without special privileges.
The alert is going to be executed by the user who's executing the Pandora FMS Server process.

25.3.5.3. Sending SMS by 'Gnokii'
There's also the option of using 'Gnokii'. Do do so, it's required to use a Nokia cellphone or one
compatible with Gnokii (please feel free to check the compatible hardware list on the Gnokii Project
Page. You're also required to have a USB data cable connected the cellphone and a connection to
the Pandora FMS Server you intend to send the SMS Alerts from.

Gnokii supports a large variety of Nokia cellphones and some models by other
manufacturers.

By using Gnokii, you may also send SMS directly from the command line. This is a very easy and
quick way to send any SMS directly from a Pandora FMS Server, thereby avoiding the use of
gateways sending SMS by using the internet (which is not very useful if the network is down) or
GSM hardware solutions for sending messages which are very expensive in some countries.

An alternative to the use of Gnokii is the Gammu
Project.

This is an example of sending an SMS from the command line by using Gnokii:
echo "PANDORA: Server XXXX is down at XXXXX" | gnokii --sendsms 555123123

553

The Alert Command (Pandora Versions 5 and above only)

Gnokii is unable to send an SMS which bears attached images, but it's able to send a URL via HTTP
or WAP (Wireless Application Protocol). If a message is received, it could look like the one you're
going to see if you enter the command shown below:
echo "Image capture sample" | gnokii --sendsms 555123123 -w http://artica.homelinux.com/capture.jpg

It's also able to send one image's URL or one that leads to a 'light version' of the console in order to
provide console access for the cellphone, facilitating the reception and analysis of emergency data
for the user.
The Artica Development Team has tested it. They've sent SMS alerts from a Nokia 6030 cellphone in
a moment an internet connection wasn't available. The Nokia 6030 cellphone uses the module's
6510 definition within the 'gnokiirc' file. It takes about four seconds to send an SMS.
It's also possible to install a much more versatile sending gateway by using GAMMU instead of
Gnokii.

25.3.5.4. Executing a Remote Command on another System (UNIX)
Sometimes, it's pretty interesting to execute the command on another system. Please use
the SSH command to do so. The system in which the command is going to be executed should be a
UNIX system. It's also required to have the SSH daemon installed, started and accessible.
To avoid storing the access password on the machine which executes the command within the
Pandora Console, it's recommended to copy the server's public key to where you intend to execute
the remote command on the Pandora FMS Server.
Once you have done this, please execute the following command:
ssh user@hostname [_field1_]

By using '_Field1_' as a variable, you may use any command you want.

25.4. Alert Actions (all Pandora FMS versions including 5.0)
Actions are alert components in which a command is linked to generic variables like 'Field 1', 'Field
2', ... 'Field 10', etc. (which are described in the previous section in detail). These actions are going
to be used in the alert templates which are the ones that associate a data condition to a specific
action later.

25.4.1. Creating an Action
New actions are created by clicking on 'Administration' > 'Manage Alerts' > 'Action' and 'Create'.
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Once you have clicked on 'Create', you're going to see the following window:

An explanation of the fields you're going to see is shown below:
•Name: The name of the action.
•Group: The group of the action.
•Command: The command which is going to be used in case of a fired alert. You may
choose between numerous predefined commands under Pandora FMS.
•Threshold: The action's execution threshold.
•Command Preview: The command which is going to be executed on the system is going to
appear here automatically. This field is not editable.
•Field 110: The values of the macros from '_field1_ through '_field10_' are defined here.
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They are intended to be used in conjunction with the command if necessary.
Once you have filled out the fields, please click on the 'Create' button.

To edit the newly created actions, please click on 'Administration' > 'Manage Alerts' and 'Action'.

25.4.2. Editing an Action

To edit the action, please click on the action's name.
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Once you've completed the changes, please update them by clicking on the 'Update' button.

25.4.3. Deleting an Action
To delete an action, please click on the gray trash icon which is located on the action's right side.

25.5. Alert Templates
Alert templates are alerts in which all parameters are already predefined. They only require their
assigned agent and the module that is used to activate the command or the response if a value is
'out of range'. The templates were created to render the administrator's management job a little
easier, so they could be assigned to the required agents more quickly if they're already predefined.

25.5.1. Creating an Alert Template
You may create new templates by clicking on 'Administration' > 'Manage Alerts' > 'Templates' and
the 'Create' buttons.
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Once you've clicked on the 'Create' button, a window like the one shown below is going to appear:

This is a description for the fields you're going to see there:
•Name: The name of the template.
•Description: It describes the template function. It's useful to distinguish the template from
others within the alert's general view.
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•Priority: The field which provides information about the alert. It's useful when searching
for alerts.
You may choose between the following priorities:
•'Maintenance'
•'Informational'
•'Normal'
•'Warning'
•'Critical'
•'Condition Type:' The field where the type of condition which is going to be applied on the
alert is defined. The required combos will be added according to the defined type.
Explanation for the fields:
•Regular Expression: The used regular expression. The alert is going to be fired if the
module's value performs a defined condition, expressed by using a regular expression. This
is the used firing condition for string and text data. All other conditions are intended for
states and any other types of numerical data.

By choosing the 'regular expression' condition, the possibility to select the trigger box appears if the
value is matched. If you select it, the alert is going to be fired if the value matches. If not, the alert
is going to be fired if the value doesn't match.
•Max and Min: The used maximum and a minimum values.

By choosing the 'Max and Min' condition, the possibility to select the trigger box appears if the value
is matched. If you select it, the alert is going to be fired if the value is out of range of the predefined
minimum and maximum values. If not, the alert is going to be fired if the value resides within the
predefined minimum and maximum range.
•Max: The used 'maximum' value. The alert is going to be fired if the module's value is
higher than the defined 'maximum' value.
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•Min: The used 'minimum' value. The alert is going to be fired if the module's value is lower
than the defined 'minimum' value.

•Equal to: The used 'equal' value. The alert is going to be fired if the module's value is equal
to the defined. It's intended to be used only for numerical values, e.g. '0' or '0.124'.

•Not equal to: The used 'not equal to' value. The alert is going to be fired if the module's
value is unequal to the defined. It's intended to be used only for numerical values, e.g. '0' or
'0.124'.

•Warning Status: The module's used 'warning' state. The alert is going to be fired if it's in
'warning' state.

•Critical Status: The module's used 'critical' state. The alert is going to be fired if it's in
'critical' state.

Once the appropriate fields have been filled out, please click on the 'Next' button, where you're
going to see the following window:
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These are the explanations for the fields you're going to see there:
Days of Week: The days on which the alert could be fired at all.
Use special days list: It's used to enable or disable the use of the special days list, e.g. holidays and
special working days.
Time From: The time from which the alert action is going to be executed.
Time To: The time until the alert action is going to be executed.
Time Threshold: It defines the time interval in which it's guaranteed that an alert is not going to be
fired more times than the number of times defined under 'maximum number of alerts'. If the
defined interval is exceeded, an alert is not going to recover if it reaches a specific value, except if
the 'alert recover' value is activated. It's recovered immediately after receiving a specific value
(regardless of the threshold) in this case.
Min. number of Alerts: The minimum number of times the data has to be 'out of range' to fire an
alert. It's always counting from the number defined within the 'FlipFlop' parameter of the module.
The default value is '0', which means the alert is going to be fired if the condition's first value is met.
It's intended as a filter, which is necessary to eliminate any false positives.
Max number of Alerts The maximum number of alerts which could be sent consecutively within
the same time interval (time threshold).
Field 1: It defines the value for the '_ﬁeld1_' variable. The list of macros (which are going to be
described below) could be used here.
Field 2: It defines the value for the '_ﬁeld2_' variable.
Field 3: It defines the value for the '_ﬁeld3_' variable.
Default Action: The default action the template is going to have is defined in this combo. It's the
action which is going to be automatically created if the template is assigned to the module. You may
assign one or none to it, but you're unable to assign several default actions here.
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This is a definition for the fields you're going to see there:
Alert Recovery: The Combo where you're able to define whether the alert recovery is enabled or
not.
Field 2: Defines the value for the '_ﬁeld2_' variable in the alert recovery.
Field 3: Defines the value for the '_ﬁeld3_' variable in the alert recovery.
Once all appropriate fields have been filled out, please click on the 'Finish' button.

25.5.2. Replaceable Macros within Field 1 through Field 10
It's possible to use the following macros in all cases of the fields 'Field1', 'Field2' and 'Field3' (in the
alert template, the command and the action). These are 'words' which are going to be replaced if
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executed by a value. That value is going to change by a value or agent which has fired the alert, etc.
depending on the moment.
•_field1_: The userdefined field 1.
•_field2_: The userdefined field 2.
•_field3_: The userdefined field 3.
•_field4_: The userdefined field 4.
•_field5_: The userdefined field 5.
•_field6_: The userdefined field 6.
•_field7_: The userdefined field 7.
•_field8_: The userdefined field 8.
•_field9_: The userdefined field 9.
•_field10_: The userdefined field 10.
•_agent_: The name of the agent which fired the alert.
•_agentdescription_: The description of the agent which fired the alert.
•_agentgroup_: The agent's group name.
•_address_: The address of the agent which fired the alert.
•_timestamp_: The time the alert was fired (yymmdd hh:mm:ss).
•_timezone_: The timezone's name the monitoring server resides in (>=5.0SP1).
•_data_: The module's data which caused the alert to fire.
•_alert_description_: The alert's description.
•_alert_threshold_: The alert's threshold.
•_alert_times_fired_: The number of times the alert was fired.
•_module_: The module's name.
•_modulegroup_: The module's group name.
•_moduledescription_: The description of the module which fired the alert.
•_alert_name_: The alert's name.
•_alert_priority_: The numerical alert priority.
•_id_agent_: The agent's ID. It's useful to build direct URLs to redirect them to a console
web page of Pandora FMS.
•_id_alert_: The alert's unique numerical ID. It's used to correlate on third party software.
•_policy_: The policy's name the module belongs to (if any).
•_interval_: The module's execution interval.
•_target_ip_: The module's target IP address.
•_target_port_: The module's target port number.
•_plugin_parameters_: The module's plugin parameters.
Commands for the Replacement of Macros and '_field*_' Fields
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After describing what commands, actions and templates are, you'd probably like to ask the question
about the necessity of defining the fields 'Field1', 'Field2', 'Field3' etc. and how does it all make
sense.
If an alert is fired, the 'field*' values are transferred from the action and from the template to the
command. If the '_field1_' value differs from an empty string within the action, it's going to ignore
the command which is transferred from the template, but it's not effecting anything. If the
command's '_field1_' value differs from '_field1_', it's going to ignore any action's or template's
'field1'parameter. Neither the action nor the template is going to be able to redefine it, because it
has '_field1' as a value. This means that it's ordering the command to insert whatever comes from
the action or template into this field.
Within the action, the same thing happens but in a more subtle way. If this field is empty, anything
that is transferred from the alert screen is going to be transferred to the command. If this field
differs from an empty string, it's going to use the residing values in this field. The values which
come from the template are going to be ignored.
They've been created this way to establish some 'fixed' parameters by a command or action without
the possibility of losing its flexibility.

25.5.2.1. Complete Example of an Alert containing Replacement Macros
Let's suppose for a moment you intend to create a log entry in which every line appears in the
following format:
20091224 00:12:00 pandora [CRITICAL] Agent <agent_name> Data <module_data> Module
<module_name> in CRITICAL status
To do so, you're required to change your configuration as shown below.
Command Configuration
echo _timestamp_ pandora _field2_ >> _field1_

Action Configuration
Field1 = /var/log/pandora/pandora_alert.log
Field2 = <left blank>
Field3 = <left blank>

Template Configuration
Field1 = <left blank>
Field2 = [CRITICAL] Agent _agent_ Data _data_ Module _module_ in CRITICAL status
Field3 = <left blank>

In the recovering section:
Field2 = [RECOVERED] [CRITICAL] Agent _agent_ Data _data_ Module _module_ in CRITICAL status
Field3 = <left blank>

If an alert is fired, the following line is going to be added to the log:
2009-10-13 13:37:00 pandora [CRITICAL] Agent raz0r Data 0.00 Module Host Alive in CRITICAL status

In the moment of alert recovery, the following line is going to be added:
2009-10-13 13:41:55 pandora [RECOVERED] [CRITICAL] Agent raz0r Data 1.00 Module Host Alive in
CRITICAL status
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25.5.3. Editing a Template
You may edit the newly created templates by clicking on the menus of 'Administration' > 'Manage
Alerts' and 'Templates'.

To edit a template, please click on the template's name.

25.5.4. Deleting a Template
To delete a template, please click on the gray trash icon which is located on the alert's right side.
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25.6. Assigning Alert Templates to Modules
Until now, we've defined the commands and actions as a given response from Pandora FMS for an
'out of range' value. By these templates, we're defining whether a value is 'out of range' or not and
which circumstances / responses should be shown in order for Pandora FMS to work appropriately.
In this section, we're going to describe the approach for relating the templates and actions to the
Pandora FMS Agents and its modules. This operation is the one which triggers the responses of
Pandora FMS if it encounters a value which is out of a predefined range.
You may assign the alerts in two ways: From 'Administration' > 'Manage Agents' and 'Alerts' or
under 'Administration' > 'Policy' as we're going to explain within the chapter named Monitoring By
Policies in detail.

25.6.1. Alert Management from an Alert's Sub Menu
25.6.1.1. Assigning Alerts from an Alert's Sub Menu
The alert assignment for modules is conducted by clicking on 'Administration' > 'Manage Alerts'
and 'Add Alert', subsequently filling out the appropriate fields.

This is a definition for the fields you're going to see there:
•Group: You may choose the group the agent belongs to by a combo here.
•Agent: The name of the agent to which the alert is going to be assigned to.
•Module: The module which is used for firing the alert.
•Template: You may choose the template to configure the alert by a combo here.
•Actions:: It allows to choose between all preconfigured alerts. The selected action is added
to the one defined within the template. You may choose more than one action.
•Threshold: The alert action will not be executed more than once every 'action_threshold'
seconds, regardless of the number of times the alert is fired.

25.6.1.2. Modifying Alerts from an Alert's Sub Menu
Once an alert has been created, it's only possible to modify the actions which have been added to
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the template's action.
It's also possible to delete the action that was selected in the moment you've created the alert by
clicking the gray trash icon which is located on the right side of the action, or to add new actions by
clicking on the 'Add' ('+') button.

25.6.1.3. Deactivating Alerts from an Alert's Sub Menu
Once the alert has been created, it's possible to deactivate it by clicking on the lightbulb icon which
is located on the right side of the alert's name.

The available alerts are rendered in blue while the ones which aren't are rendered in yellow.

25.6.1.4. Deleting Alerts from the Alert's Sub Menu
It's possible to delete any alert by clicking on the gray trash icon which is located on the right side of
the alert.

25.6.2. Managing Alerts from within the Agent
25.6.2.1. Alert Assignment from within the Agent
Other option to add an alert is by doing so from within the agent. Please click on 'Administration'
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> 'Manage Monitoring' and 'Manage Agents', where you're going to find all Pandora FMS Agents.

Please pick an agent and click on the 'Alerts' box.

This is a definition for the fields you're going to find there:
•Module: It's the module which is going to be used for firing the alert.
•Template: You may select the template which is going to be used to configure the alert
here.
•Actions: It allows you to choose between all preconfigured actions. The chosen action is
added to the one defined in the template. It's possible to select more than one action here.
•Threshold: The alert action is not going to be executed more than once every
'action_threshold' seconds, regardless of the number of times the alert is fired.

25.6.2.2. Modifying Alerts from within the Agent
Once an alert has been created, it's only possible to modify the actions which have been added to
the template's action.
It's also possible to delete the action which was selected in the moment you've created the alert by
clicking on the gray trash icon which is located on the right side of the action, or to add new actions
by clicking on the 'Add' button.
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25.6.2.3. Deactivating Alerts from within the Agent
Once an alert has been created, it's possible to deactivate it by clicking on the light bulb icon which
is located on the right side of the alert's name.

The available alerts are rendered in blue and the ones which aren't are rendered in yellow.

25.6.2.4. Deleting Alerts from within the Agent
It's possible to delete any alert by clicking on the gray trash icon which is located on the alert's right
side.

25.7. Defining an Alert
Let's refer to the previous case for a moment here. We're required to monitor a module which holds
numerical values. In our case, a module which measures the system's CPU, in other cases it can be a
temperature sensor which provides the value in degrees on the Celsius scale. Let's make sure that
our module obtains its data appropriately:

On this picture, we see that we have a module called 'sys_cpu' holding a current value of '7'. In our
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case, we want the alert to be fired if it exceeds the value of '20'. To do so, we're going to configure
the module to be in 'critical' state if it exceeds the value of '20'. To accomplish this, we're required to
click on the wrench icon on the left to configure the monitor's performance as shown below.

To do so, we're going to change the 'critical' value as shown below.
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In this moment, we're accepting and saving the changes. If the CPU module reaches the value of '20'
or above, its state is going to change to 'critical' and rendered in red, as shown on the picture below.

We've already talked about the system 'knowing' how to distinguish between whether something is
defined as 'OK' (green) or 'critical' (red). What we're required to do now is to get the system to send
us an email if the module's status changes. To do so, we're going to use the Alert System of Pandora
FMS.
The first thing we're required to do is to make sure there is a predefined command which exactly
performs the desired task (which is to send emails). This example is an easy one, because there
already is a predefined command to send us emails within Pandora FMS.

25.8. Configuring an Action
We have to create one action which could be described as 'Send an email to the operator'. Please
click on 'Administration' > 'Alerts' and 'Actions' and click on the button to create a new action, as
shown on the picture below.

This action utilizes the command 'Send email' and it's really easy. You're only required to fill out one
field (e.g. 'Field 1') and leave the other ones empty. This is one of the more confusing parts from the
Pandora FMS Alert System:
What's the meaning of the fields named 'Field1', 'Field2' and 'Field3' ?
These fields are used to pass along the alert template's and the command's information to the
command, so both the template and the command are able to provide different information to the
executed command. In this case, the command only sets up 'Field 1'. We're going to leave 'Field 2'
and 'Field 3' for the template, as we're going to see below.
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'Field 1' is the one that we're going to use to define the operator's email address. In this case, it's
'sancho.lerena@notexist.com'.

25.9. Configuring an Alert Template
We're required to create an alert template which is recommended to be the most generic template
possible (to be able to reuse it later). It's required to hold a message like "Alert! I have a module
that's in 'critical' state!" and to send an email containing this message to the appropriate operator by
default. To do so, please click on 'Administration' > 'Alerts' and 'Templates' and click on the button
to create a new alert template as shown below.

The field named 'Condition' is the one which defines the condition. In this case, it's the 'critical'
status. If associated to a module, this template is going to be fired if the associated module is in
'critical' state. A short time ago, we've configured the module named 'cpu_user' in a such way that it
changes to a 'critical' status if it exceeds the value of '20' or above.
The priority of 'critical' we've defined here is the alert priority. It has nothing to do with the
module's 'critical' status. The alert criticalities are designed to visualize them later by different
criticalities within other views such as the Event View.
Let's go to step 2 by clicking on the 'next' button.
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Step 2 defines all configuration values which are considered 'refinements' from the firing condition's
alert template. Some of them, like the first ones, are rather easy. They restrict the performance in
the moment of alert firing to some specified days in a predefined hour range.
The most critical parameters are the following:
•Time threshold: The default value is '1 Day'. If one module is down all the time, e.g. 'one
day' and we've defined a value of '5 minutes' here, it means that it's going to send alerts
every 5 minutes to us. If we've set it up to '24 hours', it's only going to send us the alert once
in the moment it goes down. If the module is restored and falls down again, it's going to
send us an alert again, but if it's still down from the second time, it's not going to send us
more alerts until the 24 hours have passed.
•Min. Number of Alerts: The minimum number of times the condition has to be met (in this
case, the module is on 'critical' status) before Pandora FMS executes the actions associated
to the alert template. It's a good way to avoid false positives, to get flooded by alerts or to
prevent some element's erratic behavior from firing a lot of alerts. By entering a value of '1',
the first alert is going to be ignored. If you enter a value of '0', it's going to fire the alert the
first time the module shows any predefined erratic behavior.
•Max. Number of Alerts: A value of '1' means the action will be executed once. If we e.g.
enter a value of '10' here, it's going to execute the predefined action ten times. It's intended
to be used as a way to limit the number of times an alert can be fired.
Now we're going to see the fields 'field1'  'field10' again. We can see that 'field1' is empty, which is
just the way we've defined it in the moment of configuring the action. The fields 2 and 3 are used
for the action of sending an email and to define 'subject' and 'message text' where 'field 1' is used to
define the receiver(s), separated by commas in case there are more than one. The other fields are
going to be left blank. The template defines the subject and the alert message by using some
macros. In our case, supposing that the agent where the module is located, would be named
'Farscape', we're going to receive a message like the one below:
To: sancho.lerena@notexist.com
Subject: [PANDORA] Farscape cpu_user is in CRITICAL status with value 20
email text:
This is an automated alert generated by Pandora FMS
Please contact your Pandora FMS System for more information. Please *DO NOT* reply to this
email.
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The default action is the one which we've defined before: All the alerts which use this template are
going to use the predefined action by default, except if modified.
In case 3, we're going to see that the Alert System can be configured to notify us if the alert stops.

It's almost the same as above, but 'Field1' is not defined, because it's going to be used in the same
way as defined within the action executed before (if the alert is fired). In this case, it's going to send
an email which informs us of a recovered condition in the module named 'cpu_user'.
The alert recovery is optional. Please keep in mind that if there are defined fields within the alert
recovery data ('Field2' and 'Field3'), these fields are going to ignore and overwrite the action's
fields, because they have precedence to them. The only valid field which is impossible to be
modified by them is 'Field 1'.

25.10. Associating an Alert to a Module
Now that we're already having all we need, we just have to associate the alert template to the
module. To do so, we're required go to the 'Alert' tab within the agent where the module is located:

We've created an association between the module named 'cpu_user' and the 'critical condition' alert
template. It's going to show the predefined action in this template ('Send email to XXX') by default.
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Scaling Alerts
Alert scaling consists of the possibility of performing different actions, depending on the severity of
the situation. This severity is determined by the number of times a value which is considered 'out of
range' occurs. If an alert is e.g. fired if the CPU of a system is at 90% strain, it's possible to configure
it to send an email in any case and an SMS if the value's 'out of range' condition has been met more
than five times.
This type of alert scaling is basically accomplished by configuring more than one action within the
alerts, especially by filling out the fields 'From' and 'To' extensively.

25.11. StandBy Alerts
Alerts can be defined as 'active', 'deactivated' or in 'standby'. The difference between 'deactivated'
alerts and 'standby' is that 'deactivated' alerts aren't going to be fired at all. They're also not going to
be shown in the alert's view. 'Standby' alerts will be shown in the views. They're also going to work 
but only on the visualization level. They're going to show you whether they're fired or not, but
they're neither going to perform the assigned actions nor generate events.
Standby alerts are useful to see what happens, but they're disabling the notifications and actions.

25.12. Cascade Protection
The Cascade Protection is a Pandora FMS feature which allows you to avoid a 'flooding' of alerts if a
group of agents can't be reached due to a connection failure. These kinds of things tend to happen if
an intermediate device such as a router or a switch is down and all the devices which come behind
it simply cease to be reachable by Pandora FMS. It's probable the devices are working as they're
supposed to, but if Pandora FMS can't reach them by the use of 'ping', it considers them to be
'down'.
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The cascade protection is activated from the agent's configuration menu. You may activate and
deactivate it by clicking on the check box named 'cascade protection'.

If the cascade protection is activated within an agent, the alerts with father CRITICAL state are
checked either this would be simple or correlated. In this way if any father has a critical alert fired,
the the alerts configured in the agent will not be fired. These alerts will be fired if the agent father
does not have any module in a CRITICAL state or if they are fired by the father with an state lower
than CRITICAL. It is understood that the agent will launch the alerts if the required conditions are
fullfied.
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So as the cascade protection works well, it is convenient to configure in all the fathers an alert with
a CRITICAL state that check if the device is down. Besides, in order to avoid that an alert from an
agent defined as a father and the other alerts have the CRITICAL state.

25.12.1. Examples
You're going to have the following monitoring types at your disposal:
•Router: An ICMP and SNMP check utilizing a standard OID to obtain the ATM's port status
along with a latency check, intended for your parent's or provider's router.
•Web Server: You'll also going to have several internal checks performed by the Pandora
FMS Agent, e.g. 'CPU Usage', 'MEM Usage' and 'Process Check' for your
Apache Web Server along with a 4step navigational HTTP latency check.
•Database Server: In addition you're going to have several internal checks running on the
Pandora FMS Agent at your disposal: 'CPU Usage', 'MEM Usage' and 'Process Check' for your
database along with integrity checks for it. You're also able to check the remote connectivity
to the database using a plugindefined test to login, to conduct a query and exit and a
possibility to measure the response time of the answer.
You're also able to define several alerts. We suggest to define them in the following way:
•Router:
SNMP Check / 'critical'> Action: Send mail.
•Web Server:
Process / 'critical' > Action: Send mail. HTTP Latency / 'critical' > Action: Send mail.
•Database Server:
Process / 'critical' > Action: Send mail. SQL Latency / 'critical' > Action: Send mail.
We recommend to define the router as a parent device for the Database and Web Servers and to
enable the Cascade Protection within both of their agents.
If e.g. the router connection is down, Pandora FMS receives information from the Web and
Database Servers by using that connection within which you haven't activated the Cascade
Protection, you're going to receive six alerts. Just try to imagine the effect if you e.g. have 200
Servers connected by this particular router. That's the reason for why it's sometimes called an 'Alert
Storm'. In worstcase scenarios, this problem has the potential to kill your Mail and Monitoring
Servers or your cellphone, because they're getting flooded by lots of alerts or SMS messages.
However, if you have the Cascade Protection enabled, you're only going to receive one alert, which
e.g. says that the ATM interface on your router is down. You're still going to see the Web and
Database Servers bearing a red status, but you won't receive tons of alert mails by them anymore.

25.13. Special Days List
From versions 5.0 and above, Pandora FMS has a new 'Special Days' feature. It allows to define
holidays and special working days for an alert template. The days defined within the Special Days
list are treated as the same day of the week you've selected there.

25.13.1. Creating a Special Day
The new special days are created by clicking on 'Administration' > 'Manage Alerts' > 'Special Days
List' and the 'Create' button.
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Once you've clicked on 'Create', a window as the one shown below is going to appear.

This is an explanation for the options you're going to encounter here:
•Date: The special day's date. The data format is 'YYYYMMDD'. If you want to define the
same day in every year, you may use wildcards like '*' for the 'YYYY' entry.
•Same Day of the Week: Please select a day. The above date is treated the same as the
selected day.
•Description: The Special Day's description.
Let's assume for a moment that May 3, 2012 would be a holiday. If you define the date of '201205
03' as a 'Sunday', that day is treated in the same way as a Sunday would.
Once you have filled out the appropriate fields, please click on the 'Create' button.

To enable the Special Days List, the option named 'Use Special Days List' should be
preset within the Alert Template as explained as in Step 2.

25.13.2. Editing a Special Day
You may edit the Special Days created within the 'Special Days List' option by clicking on
'Administration' and 'Manage Alerts'.
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To edit a special day, please click on its date.

Once your changes are completed, please click on the 'Update' button.

25.13.3. Deleting a Special Day
In order to delete a Special Day, please click on the gray trash icon which is located on the far right
side of the window.
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25.14. Complete Alert Examples
25.14.1. Sending SMS Alerts
In this example, we're going to see something we see very often: To send an SMS either if
something happens or it's about to happen.
To accomplish this, we're going to use a script you may download from our Pandora FMS Module
Library. This script uses a commercial Perl API to send the SMS by using a commercial HTTP
gateway (for which you're required to create an account and to pay a small fee). This is very easy to
do, because once you've set up the account and configured the script, it's ready to be put to use.
You're just required to enter your user name and password to use it.
If you've already configured your SMS account and installed the script on the Pandora FMS Server,
please enter the following command:
> sendsms
You're required to enter three parameters: <source>, <destination> and 'complete message'.
Please keep in mind to encapsulate the message in single quotes (') and to enter the
destination number
by using the international code format (e.g. 346276223 for Spanish phones).

After we've made sure the 'sendsms' command is ready to be used, the first thing we have to do is to
define the 'alert' command. We're going to define the command within the Pandora FMS
Administration Interface:

Within this command, we're going to define '346666666666' as the source of the message. We could
use an alphanumerical word here, but we're not going to do that, because some mobile phone
providers can't handle alphanumeric IDs very well. 'Field 1' and 'Field 2' are going to be used to
define the command's behavior. On the photo of the mobile phone which receives the SMS, we've
used a string identifier named 'Aeryn'. 'Field 1' is the field in which the destination phone is defined,
while 'Field 2' is going to be used for the text which is defined within the alert's action.
Now we're going to define the alert's action. It going to execute the predefined command and
replaces 'Field 1' and 'Field 2' by custom values. In this specific case, the template's alert doesn't
580

Complete Alert Examples

return any data within the SMS. All information is defined in the alert's action.

The number in 'Field 1' is my phone number (and it's a bit obfuscated, because I don't want be
called in middle of the night). The SMS text message is located in 'Field 2'. I'm going to use a few
macros here  which will be replaced within the runtime in the moment the alert is produced.
Final Step: We're going to create an Alert Template (please skip this if you already have one). I
intend to create a very simple alert template that's just going to fire if a module goes to 'critical'
status. That alert will fire max. once per day  but if it recovers, it's going to fire again each time it
recovers.

581

Complete Alert Examples

Please assign a module along with an alert template and an alert action:
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To get this alert fired, the module is required to be in 'critical' state. On the picture below, I'm going
to review the module's configuration to see if their 'critical' thresholds are properly defined. If they
weren't, the alert is never going to be fired because it's waiting for the moment to reach the 'critical'
status. In my case, I've set it to the value of '20'. If a low value gets received, the module will go to a
'critical' state and the alert is going to be fired.

All done. We may 'force' the alert in order to execute and test it. To force the alert, please go to the
agent's alert view and click on the green, roundshaped icon:

Just like on the picture below, an SMS should be appearing on my cellphone. I get an 'N/A' related
to the data, because no actual data is received by the module if you force the firing of an alert.
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25.14.2. Using Alert Commands different from Email
The internal email is defined as a nonconfigurable command to Pandora FMS, because 'Field 1',
'Field 2' and 'Field 3' are fields which are clearly intended to be used for 'addressee', 'subject' and
'message text'  but what am I supposed to do if I intend to execute a userdefined action ?
We're now going to define a new command  something completely defined by us. Let's suppose that
we intend to generate a log file entry for each alert we encounter. The format of this log file entry
should be something like this:
DATE_HOUR  NAME_AGENT NAME_MODULE VALUE PROBLEM DESCRIPTION
'Value' is going to be the module's value in this specific moment. There will be several log file
entries, depending on the action which calls the command. The alert is going to define the
description and the file to which the events are going to be added.
To accomplish this, we're required to create a command like this first:
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Subsequently, we're defining an action:

If we take a look into the created log file, we're going to see the following:
2010-05-25 18:17:10 - farscape - cpu_user - 23.00 - Custom log alert #1

The alert was fired at '18:17:10' within the agent named 'Farscape', in the module named 'cpu_sys'
containing the data of '23.00' and the description we've entered in the moment we've defined the
action.
As for the command execution, the field order and the other things we're likely not to understand
very well (e.g. how the command is executed), the easiest way to learn is to activate the Pandora
Server's
debug
traces
within
the
server's
configuration
file
located
at
'/etc/pandora/pandora_server.conf'.
Please
restart
the
server
by
entering
'/etc/init.d/pandora_server restart', look for the file named '/var/log/pandora/pandora_server.log'
and look for the exact line which contains the execution of the userdefined alert command to see
how the Pandora FMS Server is firing it in detail.
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25.14.2.1. Complete Example of an Alert by Substitution Macros
Let's suppose for a moment you intend to generate a log entry in which each line is supposed to
show its data the following format:
20091224 00:12:00 pandora [CRITICAL] Agent <agent_name> Data <module_data> Module
<module_name> in CRITICAL status
Command Configuration:
echo _timestamp_ pandora _field2_ >> _field1_

Action Configuration:
Field1 = /var/log/pandora/pandora_alert.log
Field2 = <left blank>
Field3 = <left blank>

Template Configuration
Field1 = <left blank>
Field2 = [CRITICAL] Agent _agent_ Data _data_ Module _module_ in CRITICAL status
Field3 = <left blank>

In the recovery section:
Field2 = [RECOVERED] [CRITICAL] Agent _agent_ Data _data_ Module _module_ in CRITICAL status
Field3 = <left blank>

If you execute an alert, the following line is going to be written into the log:
2009-10-13 13:37:00 pandora [CRITICAL] Agent raz0r Data 0.00 Module Host Alive in CRITICAL status

The following line is going to be written into the log if the alert is recovered:
2009-10-13 13:41:55 pandora [RECOVERED] [CRITICAL] Agent raz0r Data 1.00 Module Host Alive in
CRITICAL status
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26 EVENTS
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26.1. Introduction
Pandora FMS utilizes an Event System to inform you about any relevant incidences regarding the
monitored systems. Pandora FMS possesses an Event Visualizer in which everything is shown, e.g. if
a monitor is down, if an alert has been fired, or if Pandora FMS itself has a specific problem.
This system allows and encourages teamwork, because events can be validated and deleted by
numerous different users. In case of validating an incident, the user responsible for the validation is
going to be shown.
All events are managed by clicking on 'Operation' and 'View Events'. Within this menu, the window
shown below is going to appear:

This is an example of the Event Visualizer:

The event itself is shown within the Event Visualizer. It's a descriptive text of the problem, the
origin (agent) which generated it and the event's date. Sometimes there is some other data
associated (e.g. the agent's module which generated the event, the group, the tags associated to the
module, etc.). If we e.g. click on the eyeshaped icon, we're able to view all the event's details:
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By default, the events are shown by a specific and adaptable search window which is going to show
the filtered information, e.g. a specific agent, looking for a word, etc. To do so, we're going to select
the filter window by clicking on the filter section as shown below.

As we can see here (although it's able to be modified within the setup options), Pandora FMS is
going to show events which bear a maximum age of eight hours or less by default. It shows grouped
events to you, but only those which weren't validated yet. A user which is e.g. allowed to access
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only one group, is only going to see the events related to this group.
There's also the possibility of saving a specific search and you're able to apply filters you've created
before.
The Events are forming the core of a Monitoring System.
The operators which are going to see this screen are able to learn any information about the
monitored system's current state (active events) and all its history (seeing all the validated events),
without being forced to look at every single agent. They're also capable of browsing through global
figures, data trees, names and visual screens.
The operators should see a "clean" event console which is only going to show the active problems by
default. In this way, you won't have to create alerts. Just by looking on the screen, you're going to
see everything that's going on at all times.

26.2. The Custom Events View
Since the release of Pandora FMS 5.0, you're able to customize the Event View. To custom the event
view, please click on 'Administration' > 'Manage Events' and 'Custom Events'.
The default fields you're going to encounter there are mentioned below.
•Event name
•Agent name
•Status
•Timestamp
The only thing you're required to do is to select the fields you want to have displayed within the
'Fields available' list and to move them by means of the arrows. If you've completed this task, please
click on the 'Update' button.
If you click on the 'Default' button, you're able to see default event fields:

26.3. Creating Event Filters
In order to create Event Filters, please click on 'Administration' and 'Manage Events'. You may
create, remove and edit your filters within this window.
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If you click on the 'Create Filter' button, you're able to fill out the event fields as shown below.
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26.4. Viewing Events
To be able to view any current event, please click on 'Operation' and 'View Events'. In the moment
of viewing the events, please keep in mind that these Events hold a filter which is preconfigured in a
way to show all unresolved incidents and those from the last 8 hours.
It's going to show you a list on which all the system's past events are shown.

The list of events holds conditioned information within the following columns:
Status: The event's status. The available states are the following: 'new', 'in process', 'validated' and
'not validated'.
Event Name: The field in which the event's name is going to be shown. Clicking on its name results
in a filter which is going to show all events bearing the same name.
Agent Name: The field that shows the eventstarting agent. Clicking on this field is going to lead
you to the agent's main tab.
Timestamp: It shows the amount of time which went by since the event was received.
Actions:
allows to validate an event.

deletes the event.
shows the event's details.
Box for selecting the Event
It allows to select the event for executing the deletion or multiple validation of the events.

26.5. Filtering Events
It's possible to filter within the event list in order to look for specific events contained on the 'Event
View' page.
To filter events, please click on 'Operation' > 'View Events' and 'Event Control Filter'.
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It displays the default filter the moment you're opening the event list.

Advanced Options:

593

Filtering Events

This is an explanation for the filters and their modes you're encountering there:
•Group: The combo in which you're able to pick the agent's group which created the event.
•Event Type: The combo in which you're able to pick the event's type. There are the
following types:
•Alert ceased
•Alert fired
•Manual alert validation
•Alert recovered
•Error
•Monitor down
•Monitor up
•Recon host detected
•System
•Unknown
•Severity: The combo in which you're able to pick the event's severity. The following options
are available:
•Critical
•Informational
•Maintenance
•Normal
•Warning
•Event Status: The combo in which you're able to pick the event's state. There are the
following options:
•All events
•Only pending
•Only validated
•Free search: The field which provides a freetext search.
•Agent Search: The combo in which you're able to pick the agent's event origin.
•Max hour old: The field in which the max. age is determined.
•User Ack: The combo in which you're able to pick the users which have validated an event.
•Repeated: The combo in which you're able to decide whether to show repeatedly occurring
events or all events.
•Events with following tags: The combo in which you're able to pick events which have
tags assigned.
•Events without following tags: The combo in which you're able to choose events which
don't have an assigned tag.
There is an option named 'Block size for pagination' within the search fields in the 'Event Control'
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filter's menu in which you're able to determine the number of events displayed on each page when
paginating.
You may save the filter or load another one by clicking on the 'Load Filter' icon.

26.6. Custom Columns within the Event List
You may define the list of columns which appear on the Event View if you're a Pandora FMS
Administrator.
You can find the form by clicking on 'Events' > 'Admin' where the custom columns tab is located.
The form consists of two lists: The left list holds all available columns. You may add or remove
columns by using the arrows.

26.6.1. The Metaconsole
Within the metaconsole, you may save a distinct number of custom columns within each group.

26.7. Creating an Incident from an Event
In order to create an incident from an event, please click on 'Operation' and 'View Events'. Please
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click on the eyeshaped icon to obtain more information about the topic.

By clicking on the eyeshaped button, a window will be opened. Please click on the 'Responses' tab
as shown below.
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By selecting 'Custom Responses', you have several options at your disposal. You may create more
options or modify existing ones by clicking on 'Administration' > 'Manage Events' > 'Events Filter'
and 'Icon Event Responses'.

Creating Event Responses:

26.8. Validation / Status of one Event and Self Validation
An event is able to assume three different states: 'validated', 'not validated' and 'assigned' and is also
able to hold three different criticities: 'normal', 'critical' and 'warning'. These are related to the
monitor's different states within Pandora FMS which are mainly responsible for generating events.
As soon as an event is received by the system, it assumes the 'not validated' status by default. It's
possible that it's been generated by a monitor, e.g. 'Disk space' in the moment of moving from
'normal' to the 'critical' status.
If the same agent's monitor moves back to 'normal' status without doing anything, we're
automatically going to receive an information event about this within which we're going to have
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two events: One informing the disk was in 'critical' status and another one afterwards, informing us
about the disk returning to 'normal' status.
If something like that happens, the system automatically validates the event the moment it receives
information of this problem being solved. We call this 'Event Self Validation'. This only happens if
the newly arrived event is one of the 'normal' type. However, it finds an event of the 'warning' or
'critical' type without validation.
Furthermore, an event which contains 'Extra IDs' is going to validate any previous event along with
the same Extra ID. You may configure the 'Extra ID' whenever you're configuring an Event Action
within Pandora FMS.

26.9. Event Assignment
If we encounter an event, we also have the opportunity to validate it. Validation will cause the
system to memorize the date and the user who's validated the event. It's also possible to write a
comment, e.g. "We've revised the event and emptied some part of the hard drive on the server."

If you click on the 'Validate' button, the screen is going to be refreshed and the validated event
'disappears', because the Event View is only going to show the unvalidated or assigned events but
not the validated ones by default.
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If you refresh the event view again (thereby filtering and showing all events), you're going to see
your validated event furnished with a green check icon on the left along with information of who
has validated it at which time. It also may contain a descriptive text the validating person might
have entered in this moment.
If you're validating an event, you also have the possibility to define it as 'in process' on the
'Responses' tab instead of validating:

You're also able to have an event 'stopped' or locked in a way that it doesn't self validate, but you
still would be able to see it within the Event View as a pending event. It's going to 'group' the rest of
events of the same type, but it won't self validate (see 'event grouping' for more information). The
event is going to look similar to the one shown below.

26.10. Event Grouping
Under certain circumstances, some systems may generate a big amount of events. Pandora FMS lets
you group these events to work in conjunction with them in a much more convenient way. The
exact way in which event grouping works is going to be explained below.
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•Equal events from the same agent are shown as a single event.
•This event's status will be 'in process' if any of the grouped events assumed the 'in process'
status, 'normal' if any of the grouped events assumed the 'normal' state or 'validated' if all of
the grouped events assumed the 'validated' status.
•Events which assumed the 'in process' status are always shown  even if they're out of the
filter's predefined time range.
If you're working with grouped events, the status changes work in the following way:
•If you're 'validating' a grouped event, all of them are going to assume the 'validated' state
(including those which are out of the filter's predefined time range).
•If you're setting grouped events to the 'in process' status, only the most recent event is going
to be set to the 'in process' status (in representation of the rest).

26.11. Deleting an Event
Another way of managing events is deleting those which aren't interesting any more. Please use the
'deleting events' option to do so. If you click on 'Operation' and 'View Events', there are two ways to
delete an event from the event list:
Please click on the gray trash icon within the 'Action' column.

Please select the events you intend to delete by clicking on the last column and click on the 'Delete
selected' button.
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26.12. Other Ways of viewing Events
Beside the event's classic view which you may call up by clicking on 'Operation' and 'View Events',
you're also able to pick public news channels such as 'Sliding Marquee' (a moving list on the top of
the browser on a black screen).

26.12.1. RSS Events
Pandora FMS also has an RSS Event Provider in order for you to subscribe to it from your favorite
news reader. To see the events within a news channel or RSS, please click on 'Operation' > 'View
Events' and 'RSS' and subscribe to it from the news reader.

To provide access to event RSS feed, you're required to configure which IPs are allowed
to access it. To do so, please click on the field named 'IP list with API access' within
'Setup'.

26.12.2. Events in the Marquee
It shows the last events in a sliding textline format. This option is intended to visualize the last
events within a monitor like a text screen. You're able to easily customize the number of visualized
events or the size, color and filter of the messages by modifying the code within the file named
'operation/events/events_marquee.php'.
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26.12.3. Sound Alerts
From version 3.2 and above, Pandora FMS is going to have a new way of communicating events to
you. This new way is audible from the console. It's a lot easier to manage a system without having
to always check Pandora's console. You will be able to hear the different tunes if an event occurs
even if you are far from the computer (assumed you've attached some powerful loudspeakers). The
tune is going to be played until the sound event pauses or if you press the 'OK' button.
The list of sound events which are going to generate the playing of a sound are:
•An alert firing
•A module changes to a 'warning' state.
•A module changes to a 'critical' state.
It's also possible to filter the events by their groups.

26.12.3.1. Configuration
There are three types of events the alert sound is going to be attached to. You may configure any
appropriate sound from Pandora's Console setup for each type of event.

You're also able to hear the tune even from the setup page. Feel free to test it (if the browser is
compatible to multimedia contents) by clicking on the 'Play' button which you're going to find on
the right side of any event type.

26.12.3.2. Advanced Configuration
It's also possible to extend the list of sounds for all sound events. Please go to the Pandora Console
Server and into the directory named '/var/www/pandora_console/'. You may paste your new
sounds into the directory named 'include/sounds/'  but if you do, you're also required to consider
several things achieving the right performance:
•The file has to be in a 'WAV' format.
•It's recommended to take the smallest possible file, because this file must be sent to the
browser in order to be played within your browser's window.
There are several possibilities to achieve this:
•Please select a sound file with only a few second's length for the main alert sound,
because it's going to be played ad infinitum.
•Please convert the sound to 'mono'.
•Please change the sound's coding to '16bits signed' or less. We're going to lose
quality but we're diminishing the file's size by doing this.
•In order to create or edit sounds, we recommend to use tools as Audacity which is a multi
platform opensource tool which is also very easy to use.
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26.12.3.3. Use

The event sounds are asynchronously 'scanned' every 10 seconds. If an event is
received, the preconfigured or default sound for this event is going to be replayed and
the window is going to start flickering in red. This window is also going to be placed
in foreground of all other opened windows, depending on its browser's and operating
system's configuration.
To gain access to the sound events window, you're just required to go to the Pandora
Console's left menu and to click on 'Operation' and 'View Events' there. Within the
header's event window, please click on 'Sound Events'. It's going to show you a new
window, which is a lot smaller than the others.

This small window is going to be the one which manages all the sound events. It's recommended to
leave it open in case any event is received. We have 3 different controls within the window:
•Group: The group where we want to check the alerts. Please keep in mind that your user
should have permissions for this group.
•Type: The type of event to watch. You're able to check the events named 'fired alert',
'module changes to a critical state' and 'module changes to a warning state'. Within them,
you may enable or disable either one or several by means of the check boxes.
•Play Button: If the green arrow is shown, this button doesn't scan events (it's on pause). If
you click on it, the event's surveillance gets enabled and the button changes to an orange
one, holding a pause symbol. A normal use of this one is e.g. if you have to leave your
working place and it's inconvenient for the events to be replayed while you aren't present.
•OK Button: This red button bearing the word 'OK' is used to stop a replayed sound because
an alarm has been fired. Please keep in mind that it doesn't enable neither alerts nor
events or the event's surveillance. It's recommended to use the Pandora Console to do so. It's
only intended for the sound, and it'll continue watching.
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26.12.4. Exporting Events to a CSV
It's possible to export the event list to a CSV file in order for the events to be processed by or
incorporated into other applications.
In order to export the events to a CSV file, please click on 'Operation' > 'View Events' and 'CSV
File'.

26.12.5. Event Statistics
It's possible to gain access to the event's statistics by clicking on 'Operation' > 'View Events' and
'Statistics'.
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26.13. Event Alerts and Event Correlation
From Pandora FMS versions 4.0 and above, it's possible to define alerts on events, that allows you
to work by a completely new and much more flexible approach. This is an Enterprise feature.
In order to create new event alerts, please click on 'Administration' > 'Event Alerts' and 'Create'.

An event alert is composed of a number of different rules along with logical operators between
them, e.g. 'AND', 'OR', 'XOR', 'NAND', 'NOR' and 'NXOR'.
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In order to render the work with them a little easier, the event alert's configuration parameters are
identical to the module alerts. A detailed explanation for all of them can be found here. There are
only two specific parameters for event alerts:
•Rule Evaluation Mode: There are two options: 'Pass' and 'Drop'. 'Pass' means that if an
event is fulfilled by an alert, the alerts below are going to be evaluated. 'Drop' means that if
an event is fulfilled by an alert, the alerts below are going to be stopped from being
evaluated.
•Group by: It allows you to group the rules by agent, module, alert or group. If a rule is e.g.
configured for it, it's going to fire if we receive two critical events. If it's grouped by agent,
two critical events are required to originate from the same agent. This feature is capable of
getting switched off.
Each rule is configured to fire by a specific type of event. The alert will be fired if the condition of
the logical equation, which is defined by the rules and its operators, is met.

The rule's configuration parameters are the following:
•Name: The name of the rule.
•User comment: A freetext field intended for a comment.
•Event: The regular expression that matches the event's text.
•Window: The events which have been generated outside the defined time range are going
to be rejected.
•Count: The number of events which have to match the rule to fire the alert.
•Agent: The regular expression which matches the agent's name which has generated the
606

Event Alerts and Event Correlation

event.
•Module: The regular expression that matches to the module's name which has generated
the event.
•Module Alerts: The regular expression that matches the alert's name which has generated
the event.
•Group: The group the agent belongs to.
•Criticity: The event criticity.
•Tag: The event's associated tags.
•User: The event's associated user.
•Event Type: The event's type.
We could e.g. configure a rule which wears a tag named 'System' and matches to the events
generated by any module of any agent of the server group that is named 'cpu_load' in the moment
the module moves to a 'critical' state:

Given the high number of events the Pandora FMS Database is able to store, the server
works on an event window which is defined in the 'pandora_server.conf' configuration
file by a parameter named 'event_window'. The events which have been generated
outside the specified time range are not going to be processed by the server. Within a
rule, it doesn't make any sense to specify a time range wider than the one configured
within the Server.
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26.14. Generating Events from the Command Line by the 'pandora_revent'
Command
(Available to Pandora FMS versions 5 and above)
By using the WEB API, you may interact with Pandora FMS from remote sites, even if you don't
have a Database connection, Pandora FMS or an agent installed. You only require a special tool
which you can find under:
/usr/share/pandora_server/util/pandora_revent.pl

This tool utilizes a remote HTTP or HTTPS connection to create or validate events under Pandora
FMS. Please execute it without parameters to see it's syntax.
Pandora FMS Remote Event Tool Copyright (c) 2013 Artica ST
This program is Free Software, licensed under the terms of GPL License v2
You can download latest versions and documentation at http://www.pandorafms.org
Options to create event:
./pandora_revent.pl -p <path_to_consoleAPI> -create event <options>
Where options:
-u <credentials>
-create_event
-name <event_name>
-group <id_group>
-type <event_type>

: Free text
: Group ID (use 0 for 'all')
: unknown, alert_fired, alert_recovered, alert_ceased
alert_manual_validation, system, error, new_agent
configuration_change, going_unknown,

going_down_critical,
going_down_warning, going_up_normal
Optional parameters:
[-agent <id_agent>]
[-agent_name <agent>]
[-user <id_user>]
[-status <status>]
[-am <id_agent_module>]
[-module_name <module>]
[-alert <id_alert_am>]
[-criticity <criticity>]

: Set agent by ID
: Set agent by name (Exact match!)
: User comment (use in combination with -comment option)
: 0 New, 1 Validated, 2 In process
: ID Agent Module linked to event
: Name of the module linked to the event
: ID Alert Module linked to event
: 0 Maintance, 1 Informative, 2 Normal,
3 Warning, 4 Crit, 5 Minor, 6 Major

[-comment <user_comment>] : Free text for comment
[-tag <tags>]
: Tag (must exist in the system to be imported)
[-source <source>]
: (By default 'Pandora')
[-extra <id_extra>]
[-c_instructions <critical_instructions>]
[-w_instructions <warning_instructions>]
[-u_instructions <unknown_instructions>]
[-owner <owner_user>]
: Use the login name, not the descriptive
Credential/API syntax:
<credentials>: API credentials are separated by comma: <api_pass>,<user>,<pass>
Example of event generation:
./pandora_revent.pl -p http://192.168.70.160/pandora_console/include/api.php -u
pot12,admin,pandora
-create_event -name "Sample event executed from commandline" -group 2 -type "system"
-agent 2
-user "admin" -status 0 -am 0 -alert 9 -criticity 3 -comment "User comments" -tag
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"tags"
-source "Commandline" -extra 3 -c_instructions "Critical instructions"
-w_instructions "Warning instructions" -u_instructions "Unknown instructions" -owner
"other"
Options to validate event:
./pandora_revent.pl -p <path_to_consoleAPI> -u <credentials> -validate_event <options>
-id <id_event>
Sample of event validation:
./pandora_revent.pl -p http://localhost/pandora/include/api.php -u pot12,admin,pandora
-validate_event -id 234

You're required to enable the API access and configure it first. To do so, please follow the below
mentioned steps:
•Please enable the API access for the IP (please use '*' for all IPs).
•Please set an API password
•Please use a regular user and password or define a specific API user for conducting the
operation only.
In order to render the 'unknown', 'critical' or 'warning' instruction fields appear within the event
details, the event type is required to consist of the types named 'going_unknown',
'going_down_critical' or 'going_down_warning'.
Examples:
/pandora_revent.pl -p http://192.168.50.12/pandora_console/include/api.php -u
pandora12,admin,pandora
-create_event -name "Another nice event" -group 0 -type "system" -status 0 -criticity 4
-user "davidv" -owner "admin" -source "Commandline" -comment "Prueba de comentario"

26.15. To generate events from Command Line: The
'pandora_revent_create' Command
(Available from Pandora FMS versions 5 and above)
It comes with the same functionality as the 'pandora_revent' script with the exception of being able
to validate events.
/usr/share/pandora_server/util/pandora_revent_create.pl

This tool utilizes a remote HTTP or HTTPS connection to create or validate events under Pandora
FMS. Please execute it without parameters to learn it's syntax.
Pandora FMS Remote Event Tool Copyright (c) 2013 Artica ST
This program is Free Software, licensed under the terms of GPL License v2
You can download latest versions and documentation at http://www.pandorafms.org
Options to create the event:
./pandora_revent_create.pl -p <path_to_consoleAPI> -create event <options>
Where options:
-u <credentials>
-create_event
-name <event_name>

: Free text
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-group <id_group>
-type <event_type>

: Group ID (use 0 for 'all')
: unknown, alert_fired, alert_recovered, alert_ceased
alert_manual_validation, system, error, new_agent
configuration_change, going_unknown,

going_down_critical,
going_down_warning, going_up_normal
Optional parameters:
[-agent <id_agent>]
[-agent_name <agent>]
[-user <id_user>]
[-status <status>]
[-am <id_agent_module>]
[-module_name <module>]
[-alert <id_alert_am>]
[-criticity <criticity>]

: Set agent by ID
: Set agent by name (Exact match!)
: User comment (use in combination with -comment option)
: 0 New, 1 Validated, 2 In process
: ID Agent Module linked to event
: Name of the module linked to the event
: ID Alert Module linked to event
: 0 Maintance, 1 Informative, 2 Normal,
3 Warning, 4 Crit, 5 Minor, 6 Major

[-comment <user_comment>] : Free text for comment
[-tag <tags>]
: Tag (must exist in the system to be imported)
[-source <source>]
: (By default 'Pandora')
[-extra <id_extra>]
[-c_instructions <critical_instructions>]
[-w_instructions <warning_instructions>]
[-u_instructions <unknown_instructions>]
[-owner <owner_user>]
: Use the login name, not the descriptive
Credential/API syntax:
<credentials>: API credentials separated by comma: <api_pass>,<user>,<pass>
Example of event generation:
./pandora_revent_create.pl -p http://192.168.70.160/pandora_console/include/api.php -u
pot12,admin,pandora
-create_event -name "Sample event executed from commandline" -group 2 -type "system"
-agent 2
-user "admin" -status 0 -am 0 -alert 9 -criticity 3 -comment "User comments" -tag
"tags"
-source "Commandline" -extra 3 -c_instructions "Critical instructions"
-w_instructions "Warning instructions" -u_instructions "Unknown instructions" -owner
"other"

You're required to enable the API access and configure it first. Please follow the below mentioned
steps to do so.
•Please enable the API access for the IP (please use '*' for all IPs)
•Please set an API password
•Please use a regular user and password or define a specific API user only for conducting the
operations only.
In order to render the 'unknown', 'critical' or 'warning' instruction fields to appear within the event
details, the event type is required to be one of the types named 'going_unknown',
'going_down_critical' or 'going_down_warning'.
Examples:
/pandora_revent_create.pl -p http://192.168.50.12/pandora_console/include/api.php -u
pandora12,admin,pandora
-create_event -name "Another nice event" -group 0 -type "system" -status 0 -criticity 4
-user "davidv" -owner "admin" -source "Commandline" -comment "Prueba de comentario"
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26.16. Custom Fields within Events
Events with custom fields may be generated by the Pandora FMS CLI, e.g. an event
generated by the following command:
perl pandora_manage.pl /etc/pandora/pandora_server.conf --create_event 'Custom event' system
Firewalls 'localhost' 'module' 0 4 'admin'
'{"Location": "Office", "Priority": 42}'

Would look like the one shown below.
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27 Templates and Plug Ins
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27.1. Introduction
Pandora FMS performs all checks by utilizing modules. These modules can belong to different data
types Pandora FMS is designed to process. The complete default module list for Pandora FMS can
be viewed by clicking on 'Administration' > 'Manage Modules' and 'Module Types'.

By clicking on this menu, the available modules are going to be shown on the web console's right
side of Pandora FMS.
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As you can see, there are several module types and groups to choose from:
•async: The asynchrounous data.
•generic: The generic data.
•keep_alive: A special keepalive module, useful to control the status of the last contact to an
agent.
•icmp: The ICMP check (ping).
•snmp: The SNMP check.
•tcp: The TCP check.
•web: The network check.
Most of them are able to consist of several types of checks:
•data: The numerical data.
•proc: The boolean values. Regarding network checks, this means that if the value exists, it
returns a value of '1' and a value of '0' if not.
•string: The text string.
•inc: The incremental data, e.g. the amount of packets sent by an interface are always going
to grow.

27.1.1. What's a Component?
A component is a 'generic module' which can be repeatedly applied onto an agent, as if it were a
module's 'master copy', generating a module associated with an agent. This way, having a database
of our organization's most used components, turns out to come in handy when it comes to
monitoring, since we have our own components adapted to the technologies we're using and we
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simply have to apply these components to the new agents.
There are two types of components: Network components, which group all remote modules (wmi,
tcp, snmp, icmp, plugin, web, etc.) and local components, which are the module's definition within
the software agent's configuration as 'text snippets', ready to be cut out and pasted into the agent's
configuration.

27.1.2. What are Template Components?
A template is a set of network components which can be directly applied onto an agent, rendering
the monitoring task a little easier, since we simultaneously create various modules by means of the
components associated to a network template. The Recon Server utilizes the network templates to
automatically create a series of modules on a detected host, thereby allowing for a very fast and
automatic monitoring deployment.

27.2. Network Components
The network components are the elements that enable remote network checks. Pandora FMS has
about 40 preconfigured network checks, while the Enterprise Version comes with a disposal of over
400 of them.
The network components of Pandora FMS can be created and viewed on their management page by
clicking on 'Administration' > 'Manage Modules' and 'Network Components'.

Within it, you're able to view the already existing components (by filtering 'by groups' or by 'free
text search'), to view their configurations and details, to modify them and to create new ones.
To view any module's properties, please click on its name. The name provides a link which is going
to take you to its details page:
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As you can see on the picture above, all details of the network component named 'Host Alive' are
shown. If applied onto a module, it's going to retrieve the network component's details except the IP
address field, where it's automatically going to store the agent's main IP address the component is
applied to. All parameters may be edited later, e.g. change the user or password of the WMI
modules.
{Tip|If any template is modified, its new values are only going to apply to the modules created
from that moment on, not to the the ones already created.}
The component's values are also able to be modified. To do so, please click on the name of one
them and modify the desired values, e.g. the interval. Once you're done, please click on the 'Update'
button on the page's bottom. From that moment on, its changes are going to be stored and applied
to the agents you're adding this module to.
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27.2.1. Creating new Network Components
You may create three types of network components:
•Network components
•Plugin components (server add ons)
•WMI components
You're also unable to create web components within this version, yet.
To create a new network component, please click on 'Administration' > 'Manage Modules' and
'Network Components'. Please go to the bottom of the page, select a network component within the
pulldown menu and click on the 'Create' button.

Subsequently, a window to setup all the component's fields is going to be shown. Please fill out the
desired fields and click on the 'Create' button when ready. The WMI component creation screen is
going to be shown.

As you fill in the required fields, please keep in mind that you're going to fill out the description of a
'generic' module which is going to be applied to different agents. Some parameters such as 'snmp
community', 'user' or 'password' can be different among the module's applied agents. You're also
required to modify them manually in order to make them work. If you have a common user policy
for your systems, you may leave the modules completely configured by inputting users, passwords
and other data common to all agents here. You're also able to leave them blank.
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The same process applies to the components of the plugin type.
If you select the plug in within the interface like during the plugin modules creation, the defined
fields of the plugin macros are going to appear in this case.

27.3. Local Components
Local components are the ones which can be applied to software agents. If you have the Pandora
FMS Enterprise Version, these components are applied automatically and remotely way by policies
or manually within the agent's remote configuration editor. Please check the policy section in order
to know how to remotely apply a local component to a software agent under Pandora FMS
Enterprise.
Local components may also be used within the opensource version of Pandora FMS. They just
won't be applied automatically. It's necessary to manually copy and paste the code here. The
Pandora FMS Enterprise version has dozens of local modules to apply to the policies and to the
agents automatically, assorted by categories.
Local components work very similar to the network components. Please go to their management
page by clicking on 'Administration' > 'Manage modules' and 'Local Components' to view them.
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This screen displays the already existing local modules, which can be filtered by different
parameters (group, operating system, free text query). You're also also view, modify and create new
components here.
To view any module's properties, please click on its name. The provides a link which will lead you
to its details page which is shown below.
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As you can see, the configuration of local components is quite simple. The configuration's elements
are described below.
•Name: The component's name. This name is going to be visible within the component
selection in the moment of creating an agent's module.
•OS: The operating system the component is intended for.
•Group: The group the module is going to belong to. It quite useful to filter and assort
monitoring technologies.
•Description: The module's description. A default description which can be changed is
already in there.
•Configuration: The component's configuration like the module's configuration for software
agents. For more examples or to get complementary information, please check section
named Configuration.
•Warning Status: The interval in which the status changes to a 'warning' state. If the box
'inverse interval' is checked, the status isn't 'warning' if it's within range of this interval.
•Critical Status: Interval in which the status changes to a 'critical' state. If the box 'inverse
interval' is checked, the status isn't 'critical' if it's within range of this interval.
•Warning Instructions: The instructions for if the state moved to 'warning'.
•Critical Instructions: The instructions for if the state moved to 'critical'.
•Unknown Instructions: The instructions for if the state moved to 'unknown'.
•Category: If you're required to group or categorize differently, you may define categories
here.
•Tags: You may assign tags here.
•Macros: You may define macros within the execution module (module_exec) or plugin
parameters.

27.3.1. Creating new Local Components
To create a new local component, please click on 'Administration' > 'Manage Modules' and 'Local
components' and click on the 'Create' button which is located on the bottom right side of the page.
A page containing the form for the creation of new local components is going to be displayed:
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Please fill out the form by the information given above and click on the 'Create' button.

27.3.2. Macros
For Pandora FMS versions 5 and above, it's possible to define macros within local components.
These macros are going to be placed into the 'module_exec' parameter. They exhibit the structure of
'_field1_, _field2_ ... _fieldN_'.
In the module's edition form the macros are going to appear as normal fields which are transparent
to the user.
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Each macro is going to have three fields: 'Description', 'Default Value' and 'Help'.
•Description: It's the label near the field in the module's form.
•Default Value: A field for the desired value to be charged by default in the module's form.
•Help: A field for the desired string for additional field info. If set, it's going to appear near
the field containing this string.

If a module component contains macros, the configuration data is going to remain hidden to
simplify the view by default, but it's possible view and modify it.

27.4. Module Templates
Module templates are the ones which contain modules designed for network
checking. Once they're created, these templates can be directly applied to agents,
thereby avoiding the need to add modules individually, or be applied when
conducting one Network Recon Task of the ones described within Chapter 9.
Please click on 'Administration' > 'Manage Modules' and 'Module Templates' to manage the module
templates.

625

Module Templates

The Template Management Window is going to be displayed, which contains many default
templates:

You may click on any template to see its details or on the trash icon on the right side to delete it, or
create a new template by clicking on the 'Create' button. If you click on a template's name, its
details are going to be displayed. The snapshot below shows the template's details for the basic
network monitoring modules. In it, the template's name and description may be viewed in the first
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two fields of the form. A list of modules included in this particular template is shown below.
The final one is the form for to add modules, enabling you to filter by module group. Please select
the module and add it.

In order to delete a module, please select it within the right column and click on the 'Delete' button.
If you select the top cell of the right column, you're going to select them all.
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27.4.1. Creating New Module Templates
In order to create a new module template, please go to the main management page and click on
'Administration' > 'Manage Modules' > 'Module Templates' and click on the 'Create' button located
on the bottomright side of the page.
A page containing the creation form for new local components is going to appear in this moment:

Please enter a name and description for the new template and click on the 'Create' button.
Subsequently, a page in which you're able to add modules to the template is going to be shown.
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Please select the modules on the bottom, filter them by group if necessary and click on the 'Add'
button.
Please keep in mind that you're able to delete the unwanted modules by selecting them and clicking
on the 'Delete' button.

27.4.2. Applying a Module Template to an Agent
In order to apply one of the existing monitoring module template or a recently created one, please
click on 'Administration' and 'Manage Agents' as shown below.

Please select one of the agent's modules:
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Once you see this window, please click on the 'Templates' tab on the top of the page.

On the following picture, modules which already contain an agent and existing module templates
are displayed. Please select one and apply it to the agent.

Please select a template and click on the 'Assign' button. The modules contained in this template are
going to be added automatically. Once applied, the template can delete some of the modules by
clicking on the 'X' within the column on the right side, or you may edit them clicking on the tool
icon which is also located on the right.

The agent's applied templates are not going to be displayed, just the modules contained
in there are.

27.5. Component Groups
In order to help in component sorting and classifying, we've created component groups.
Components are associated to groups in the moment of their creation.
In order to see the existing component groups, please click on 'Administration' > 'Manage Modules'
and 'Component Groups':
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The already existing groups and their description is shown on the picture below.

You may view the details on the groups by clicking on their name, delete them by clicking on the 'X'
on the right side or create new ones by clicking on the 'Create' button on the bottom.
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If you intend to create a new components group, please click on the 'Create' button and fill out the
form fields.

You're required to provide a name for the group and determine whether it has a parent among the
existing groups or not. Please click on the 'Create' button when you're done.
Please feel free to add as many new components to your newly created component group as you
like.
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28 THE DASHBOARD
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28.1. Introduction
The Dashboard is a feature of the Enterprise Version of Pandora FMS. It was designed to allow the
users to build their own monitoring pages. It's possible to add more than a page, because you're also
able to add monitoring maps, graphs, etc.
The dashboard's configuration is carried out from the same place in which it's possible to gain
access to it. Please click on 'Operation' > 'Reporting' and 'Dashboard' on the web console's right
side to gain access to it.

If you click on the dashboard, the userconfigured pages are going to be displayed.
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28.2. Creating a Dashboard
The dashboards are all customizable. Each user configures his own dashboard and is only able to
see the ones he has configured for himself.
In order to create a dashboard, please click on 'Operation' > 'Reporting' and 'Dashboards'. All users
have a dashboard named 'default'. Please click on the 'Add Dashboard' menu option as shown below
to create a new one.

Please insert the name you'd like to see within the dashboard's tab in the window which appears in
this moment. Please click on the 'Add' button after you've assigned the visibility group.
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In the moment the new tab has been created, there are two tabs at your disposal: The default tab
and the new one. In order to add objects to the tab, please click on the 'Add Widget' menu option as
shown on the picture below.

In this moment, a new window within which all objects you're able to add to your new tab are
specified.
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28.2.1. Adding Objects to the Dashboard
You're also able to add several different objects to the dashboard. Each of them comes with its own
features.

28.2.1.1. Group Status Report
In order to add a report to the Pandora FMS group's status, please click on the icon shown below.
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By clicking on the icon, the configuration window of the object appears.

Please insert a title, select the groups which are supposed to be contained in the report and click on
the 'Update' button, shown on the picture above. If you click on it, a window like the one shown on
the picture below is going to appear.

You're able to access the corresponding group within the 'Operation' menu by clicking on the
group's name.

28.2.1.2. UserDefined Graphs
Please click on the icon shown on the picture below in order to add a userdefined graph.
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By clicking on the icon, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The title which is going to appear on the graph's top.
•Graph: The combo in which you're able to select the appropriate graph to appear. You're
able to choose among the graphs created by Pandora FMS.
•Period: The combo in which you're able to select the appropriate period for the graph.
•Stacked: The option to select whether you want the different combined graph's values to be
displayed above the other or not.
•Width: The option to select the graph's overall width.
•Height: The option to select the graph's overall height.
If you click on the 'Update' button shown on the picture above, a window like the one below is
going to appear.
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28.2.1.3. The 'Last Events' List
In order to add a list, containing the last events which took place in Pandora FMS, please click on
this icon:

If you click on the icon, the object's configuration window is going to appear.
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Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title to display on the graph's top.
•Event Type: The combo in which you're able to choose among the different existing event
types like 'OK', warning', 'critical' etc.
•Interval: The combo in which you're able to define the time interval you intend to use.
•Limit: The combo in which you're able to define the maximum number of events to appear.
•Event Status: The combo in which you're able to choose the event's state, e.g. 'validated',
'without validation' or all of them.
•Groups: The option to select the group from which the events are going to be shown.
If you click on the 'Update' button shown on the picture above, an event window like the one below
is going to appear.
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If you click on the agent's name, you're accessing the agent's configuration window.

28.2.1.4. State of the System
In order to add a report which contains the state of the Pandora FMS monitors, please click on the
icon shown on the picture below.

If you click on the above icon, the 'Global Health' window is going to appear.
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28.2.1.5. The Pandora FMS Welcome Message
In order to add the Pandora FMS welcome message, please click on the following icon:

If you click on the above shown icon, the object containing the welcome message is going to
appear.
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28.2.1.6. The Agent's Module Graph
In order to add a graph to one of the Pandora FMS agent modules, please click on this icon:

If you click on the icon, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title that's going to appear on the graph's top.
•Group: The combo to select the group the agent belongs to.
•Agent: The combo to select the agent.
•Module: The combo to select the module.
•Period: The combo to select the appropriate time period for the graph to show.
If you click on the 'Update' button, you're going to see a window like the one shown below.
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28.2.1.7. The Visual Maps Report
In order to add a report containing Pandora FMS visual maps, please click on the following icon:

If you click on the icon, the object's configuration window is going to appear as shown below.

Please insert the title, select the appropriate visual console's maps, supposed to be contained in the
report and click on 'Update'. If you do, a window like the one shown below is going to appear.
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If you click on the map's name, you're accessing the map within the visual console.

28.2.1.8. The Network Map
In order to add a Pandora FMS Network Map, please click on the icon shown below.

If you click on the icon shown above, the object's configuration window is going to appear.
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Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going appear on the map's top.
•Group: The combo to select the agent's group to appear on the map.
•Layout: The combo to select the location of the agents, depending on the map's type.
•No Overlap: If selected, the agents aren't going to be displayed in an overlapping manner.
•Simple: If selected, the agents are going to appear without any icons.
•Font Size: The combo intended to select the font's size used to display the agent's names.
If you click on the 'Update' button, a window the one shown below is going to appear.

28.2.1.9. The Visual Console's Map
Please click on the icon shown below in order to add a map from the Pandora FMS Visual Console.
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If you click on the icon above, the object's configuration window is going to appear.

Please insert an appropriate title and select the map which is supposed to appear within the object
from a combo.
If you click on the 'Update' button, a window like the one shown below is going to appear.
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Before you're able to put them to any use, all maps are required to be created by clicking
on 'Administration' -> 'Reporting' and 'Visual Console'.

28.2.1.10. Displaying URL Content
In order to display URL content under Pandora FMS, please click on the icon which is shown on the
picture below.

If you click on the icon, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the widget's top.
•URL: The combo in which you're able to select the font's size to for the agent's names.
•Height: The height of the widget in pixels. Please insert '0' for an automatic determination.
If you click on the 'Update' button, a window like the one shown below is going to appear.
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28.2.1.11. The Tactical View
In order to add a tactical view of Pandora FMS, please click on the icon shown below.

If you click on the icon, the object's configuration window is going to appear.
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Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the widget's top.
•Status and Monitor Checks: It provides general information on the modules.
•Server Performance: It provides a summary of server statistics.
•Summary:: It provides summary information about agents and modules.
If you click on the 'Update' button, a window like the one shown below is going to appear.
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28.2.1.12. Panel with a Message
In order to add a panel which contains a message under Pandora FMS, please click on the icon
shown below.
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If you click on the icon above, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the widget's top.
•Text: A freetext field containing the message itself.
If you click on the 'Update' button, a window like the one below is going to appear.

28.2.1.13. UserDefined Reports
In order to add user defined reports under Pandora FMS, please click on the icon shown below.
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If you click on the icon above, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the report's top.
•Report: The field for the report's name which is going to contain the widget.
If you click on the 'Update' button, a window like the one shown below is going to appear.

28.2.2. Putting Objects onto the Dashboard
By clicking on the dashboard's objects, it's possible to drag and drop them anywhere.

28.2.3. Editing Objects on the Dashboard
In order to edit the configuration parameters of a dashboard object, please click on the gearwheel
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shaped configuration icon on the upper right side of the object you intend to edit as shown below.

Once you have clicked on the icon, the object's configuration menu is going to appear. Please
modify it and click on the 'Update' button to save your changes.

28.2.4. Deleting Objects from the Dashboard
In order to delete an object's configuration parameters from the Dashboard, please click on the trash
icon on the upper right side of the object you intend to delete.
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28.3. Editing a Dashboard
You may edit the dashboard's name and group. In order to update an already existing dashboard,
please click on the 'Dashboard Options' and 'Update Dashboard' options.

Please click on the 'Update Dashboard' option as shown above.

28.4. Deleting a Dashboard
In order to delete a dashboard, please click on the triangleshaped icon, which is located on the tab
you intend to delete. It's also going to display the 'Update Dashboard' and 'Delete Dashboard'
options.

Please click on the 'Delete Dashboard' option.
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As you can see, there are several module types and groups to choose from:
•async: The asynchrounous data.
•generic: The generic data.
•keep_alive: A special keepalive module, useful to control the status of the last contact to an
agent.
•icmp: The ICMP check (ping).
•snmp: The SNMP check.
•tcp: The TCP check.
•web: The network check.
Most of them are able to consist of several types of checks:
•data: The numerical data.
•proc: The boolean values. Regarding network checks, this means that if the value exists, it
returns a value of '1' and a value of '0' if not.
•string: The text string.
•inc: The incremental data, e.g. the amount of packets sent by an interface are always going
to grow.

28.4.1. What's a Component?
A component is a 'generic module' which can be repeatedly applied onto an agent, as if it were a
module's 'master copy', generating a module associated with an agent. This way, having a database
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of our organization's most used components, turns out to come in handy when it comes to
monitoring, since we have our own components adapted to the technologies we're using and we
simply have to apply these components to the new agents.
There are two types of components: Network components, which group all remote modules (wmi,
tcp, snmp, icmp, plugin, web, etc.) and local components, which are the module's definition within
the software agent's configuration as 'text snippets', ready to be cut out and pasted into the agent's
configuration.

28.4.2. What are Template Components?
A template is a set of network components which can be directly applied onto an agent, rendering
the monitoring task a little easier, since we simultaneously create various modules by means of the
components associated to a network template. The Recon Server utilizes the network templates to
automatically create a series of modules on a detected host, thereby allowing for a very fast and
automatic monitoring deployment.

28.5. Network Components
The network components are the elements that enable remote network checks. Pandora FMS has
about 40 preconfigured network checks, while the Enterprise Version comes with a disposal of over
400 of them.
The network components of Pandora FMS can be created and viewed on their management page by
clicking on 'Administration' > 'Manage Modules' and 'Network Components'.

Within it, you're able to view the already existing components (by filtering 'by groups' or by 'free
text search'), to view their configurations and details, to modify them and to create new ones.
To view any module's properties, please click on its name. The name provides a link which is going
to take you to its details page:
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As you can see on the picture above, all details of the network component named 'Host Alive' are
shown. If applied onto a module, it's going to retrieve the network component's details except the IP
address field, where it's automatically going to store the agent's main IP address the component is
applied to. All parameters may be edited later, e.g. change the user or password of the WMI
modules.
{Tip|If any template is modified, its new values are only going to apply to the modules created
from that moment on, not to the the ones already created.}
The component's values are also able to be modified. To do so, please click on the name of one
them and modify the desired values, e.g. the interval. Once you're done, please click on the 'Update'
button on the page's bottom. From that moment on, its changes are going to be stored and applied
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to the agents you're adding this module to.

28.5.1. Creating new Network Components
You may create three types of network components:
•Network components
•Plugin components (server add ons)
•WMI components
You're also unable to create web components within this version, yet.
To create a new network component, please click on 'Administration' > 'Manage Modules' and
'Network Components'. Please go to the bottom of the page, select a network component within the
pulldown menu and click on the 'Create' button.

Subsequently, a window to setup all the component's fields is going to be shown. Please fill out the
desired fields and click on the 'Create' button when ready. The WMI component creation screen is
going to be shown.

As you fill in the required fields, please keep in mind that you're going to fill out the description of a
'generic' module which is going to be applied to different agents. Some parameters such as 'snmp
community', 'user' or 'password' can be different among the module's applied agents. You're also
required to modify them manually in order to make them work. If you have a common user policy
for your systems, you may leave the modules completely configured by inputting users, passwords
and other data common to all agents here. You're also able to leave them blank.
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The same process applies to the components of the plugin type.
If you select the plug in within the interface like during the plugin modules creation, the defined
fields of the plugin macros are going to appear in this case.

28.6. Local Components
Local components are the ones which can be applied to software agents. If you have the Pandora
FMS Enterprise Version, these components are applied automatically and remotely way by policies
or manually within the agent's remote configuration editor. Please check the policy section in order
to know how to remotely apply a local component to a software agent under Pandora FMS
Enterprise.
Local components may also be used within the opensource version of Pandora FMS. They just
won't be applied automatically. It's necessary to manually copy and paste the code here. The
Pandora FMS Enterprise version has dozens of local modules to apply to the policies and to the
agents automatically, assorted by categories.
Local components work very similar to the network components. Please go to their management
page by clicking on 'Administration' > 'Manage modules' and 'Local Components' to view them.
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This screen displays the already existing local modules, which can be filtered by different
parameters (group, operating system, free text query). You're also also view, modify and create new
components here.
To view any module's properties, please click on its name. The provides a link which will lead you
to its details page which is shown below.
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As you can see, the configuration of local components is quite simple. The configuration's elements
are described below.
•Name: The component's name. This name is going to be visible within the component
selection in the moment of creating an agent's module.
•OS: The operating system the component is intended for.
•Group: The group the module is going to belong to. It quite useful to filter and assort
monitoring technologies.
•Description: The module's description. A default description which can be changed is
already in there.
•Configuration: The component's configuration like the module's configuration for software
agents. For more examples or to get complementary information, please check section
named Configuration.
•Warning Status: The interval in which the status changes to a 'warning' state. If the box
'inverse interval' is checked, the status isn't 'warning' if it's within range of this interval.
•Critical Status: Interval in which the status changes to a 'critical' state. If the box 'inverse
interval' is checked, the status isn't 'critical' if it's within range of this interval.
•Warning Instructions: The instructions for if the state moved to 'warning'.
•Critical Instructions: The instructions for if the state moved to 'critical'.
•Unknown Instructions: The instructions for if the state moved to 'unknown'.
•Category: If you're required to group or categorize differently, you may define categories
here.
•Tags: You may assign tags here.
•Macros: You may define macros within the execution module (module_exec) or plugin
parameters.

28.6.1. Creating new Local Components
To create a new local component, please click on 'Administration' > 'Manage Modules' and 'Local
components' and click on the 'Create' button which is located on the bottom right side of the page.
A page containing the form for the creation of new local components is going to be displayed:
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Please fill out the form by the information given above and click on the 'Create' button.

28.6.2. Macros
For Pandora FMS versions 5 and above, it's possible to define macros within local components.
These macros are going to be placed into the 'module_exec' parameter. They exhibit the structure of
'_field1_, _field2_ ... _fieldN_'.
In the module's edition form the macros are going to appear as normal fields which are transparent
to the user.
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Each macro is going to have three fields: 'Description', 'Default Value' and 'Help'.
•Description: It's the label near the field in the module's form.
•Default Value: A field for the desired value to be charged by default in the module's form.
•Help: A field for the desired string for additional field info. If set, it's going to appear near
the field containing this string.

If a module component contains macros, the configuration data is going to remain hidden to
simplify the view by default, but it's possible view and modify it.

28.7. Module Templates
Module templates are the ones which contain modules designed for network
checking. Once they're created, these templates can be directly applied to agents,
thereby avoiding the need to add modules individually, or be applied when
conducting one Network Recon Task of the ones described within Chapter 9.
Please click on 'Administration' > 'Manage Modules' and 'Module Templates' to manage the module
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templates.

The Template Management Window is going to be displayed, which contains many default
templates:

You may click on any template to see its details or on the trash icon on the right side to delete it, or
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create a new template by clicking on the 'Create' button. If you click on a template's name, its
details are going to be displayed. The snapshot below shows the template's details for the basic
network monitoring modules. In it, the template's name and description may be viewed in the first
two fields of the form. A list of modules included in this particular template is shown below.
The final one is the form for to add modules, enabling you to filter by module group. Please select
the module and add it.

In order to delete a module, please select it within the right column and click on the 'Delete' button.
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If you select the top cell of the right column, you're going to select them all.

28.7.1. Creating New Module Templates
In order to create a new module template, please go to the main management page and click on
'Administration' > 'Manage Modules' > 'Module Templates' and click on the 'Create' button located
on the bottomright side of the page.
A page containing the creation form for new local components is going to appear in this moment:

Please enter a name and description for the new template and click on the 'Create' button.
Subsequently, a page in which you're able to add modules to the template is going to be shown.
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Please select the modules on the bottom, filter them by group if necessary and click on the 'Add'
button.
Please keep in mind that you're able to delete the unwanted modules by selecting them and clicking
on the 'Delete' button.

28.7.2. Applying a Module Template to an Agent
In order to apply one of the existing monitoring module template or a recently created one, please
click on 'Administration' and 'Manage Agents' as shown below.

Please select one of the agent's modules:
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Once you see this window, please click on the 'Templates' tab on the top of the page.

On the following picture, modules which already contain an agent and existing module templates
are displayed. Please select one and apply it to the agent.

Please select a template and click on the 'Assign' button. The modules contained in this template are
going to be added automatically. Once applied, the template can delete some of the modules by
clicking on the 'X' within the column on the right side, or you may edit them clicking on the tool
icon which is also located on the right.

The agent's applied templates are not going to be displayed, just the modules contained
in there are.

28.8. Component Groups
In order to help in component sorting and classifying, we've created component groups.
Components are associated to groups in the moment of their creation.
In order to see the existing component groups, please click on 'Administration' > 'Manage Modules'
and 'Component Groups':
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The already existing groups and their description is shown on the picture below.

You may view the details on the groups by clicking on their name, delete them by clicking on the 'X'
676

Component Groups

on the right side or create new ones by clicking on the 'Create' button on the bottom.
If you intend to create a new components group, please click on the 'Create' button and fill out the
form fields.

You're required to provide a name for the group and determine whether it has a parent among the
existing groups or not. Please click on the 'Create' button when you're done.
Please feel free to add as many new components to your newly created component group as you
like.
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29 Inventory
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29.1. Introduction
The Pandora FMS Enterprise Version allows you to generate an inventory of the devices of which
the servers monitored by Pandora FMS are composed of. By this inventory, it's possible to keep a list
which contains the CPU, expansion cards, memory, patches, software, etc. or the company's servers.
The inventory is independent from the monitoring and could be accomplished either locally (by
Pandora FMS Agents) or remotely.

29.2. Data Collection for the Inventory
The data collection for the system inventory is conducted in two different ways: Remotely by
inventory modules, by scripts integrated within Pandora FMS which perform the WMI queries or by
executable scripts which utilize SSH along with 'Expect' or similar methods.
If the data collection is conducted locally by the Pandora FMS Agent, it's going to be performed by
plug ins within the agent or a special type of module in case of Windowsbased systems.

29.2.1. Inventory Modules
The inventory modules are remote modules which execute a command against a remote machine.
These modules work in a similar way as a plug in. The same modules could be defined as 'locals' if
they obtain data by an agent.

29.2.2. Remote Inventory
29.2.2.1. Creating Remote Modules
The creation of a remote inventory module by an administrator is seen as unusual. These inventory
modules already come 'preconfigured' along with Pandora FMS Enterprise. Pandora FMS also allows
you to create your own inventory modules or modify the already existing ones by using the
Inventory Module Editor.
In order to create a remote module, please click on 'Administration' > 'Manage Modules' and
'Inventory Modules'. You're going to find all preconfigured inventory modules there.
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In order to create a new module, please click on the 'Create' button.
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Now we're going to describe the fields you'll find there.
Name: The field intended for the module's name.
Description: The field intended for the module's description.
OS: The combo in which you're able to pick the operating system the module was intended for. It's
important to pick the operating system carefully, because, by adding inventory modules to an agent,
only modules matching to the one of the agent's are going to show up in there.
Interpreter: The field intended to input the appropriate command interpreter to be used within the
module. You may also put in a shell script, use the Perl language or any other valid interpreter for
the Inventory Server which is intended for use in conjunction with a Linuxbased system in there.
Format: The field in which the fields are going to be separated by the ';' character which the
module is going to return.
Code: The module's code, It's usually Perl or a shellscript code. If you intend to use binary code
here, it's going to require a different loading procedure which is required to be introduced by
peripheral scripts.
Once the module has been created, please click on the 'Create' button.

29.2.2.2. Editing Remote Modules
In order to edit a remote module, please click on 'Administration' > 'Manage Modules' and
'Inventory Modules'. It's the location in which all the inventory modules created so far are listed.
Please click on the module you intend to edit or the wrench icon which is located on the right side
as shown below.
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In this moment, the module creation window is going to appear again.

Please edit the fields you intend to change and click on the 'Update' button.

29.2.2.3. Deleting Remote Modules
In order to delete a remote module, please click on 'Administration' > 'Manage Modules' and
'Inventory Modules'. It's the location in which all the inventory modules which have been created so
far are listed. Please click on the trash icon which is located on the right side of the module you
intend to delete.

29.2.2.4. Assigning Remote Modules
The inventory module's assignment is conducted within the agent's administration flap.
Under 'Administration' and 'Manage Agents', please click on the agent's name to which you intend to
assign inventory modules to.
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Please click on the 'Inventory' flap.

This is the menu in which you're able to add the new inventory modules.

Now we're describing the fields which you're going to encounter in the moment of adding an
inventory module.
•Module: The combo designed to pick the inventory module you intend to add. It's only
going to show the modules that match the agent's operating system.
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•Target: The IP or server name from you intend to obtain the inventory from.
•Interval: The combo to pick the time interval in which the inventory module is going to be
executed.
•Username: The user which is going to execute the inventory module.
•Password: The user's password which is going to be used to execute the inventory module.
Once the form has been filled out, please click on the 'Add' button in order to add the new module
to the other inventory modules.

29.2.2.5. Editing an assigned Inventory Module
You may also edit the inventory modules. This editing is conducted on the same page on which
they've been created before. In order to edit an inventory module, please click on the module's
name or on the key icon which is shown on the picture below.

29.2.2.6. Deleting an assigned Inventory Module
It's possible to delete inventory modules. This deletion process is conducted on the same page on
which they've been created before. In order to delete an inventory module, please click on the trash
icon which is located on the right side of the module's name.

684

Data Collection for the Inventory

29.2.2.7. Complete Example of a Remote Inventory Module
Just imagine for a moment you're required to obtain a list of physical addresses from a server  in
this case, a UNIX server. This is usually achieved by the command of 'arp a n'. If we're executing it
on a server, it's going to give us something back like this:

artica@galaga:~$ arp -a -n
?
?
?
?
?
?
?

(192.168.70.74) at 08:00:27:39:BF:6F [ether] on eth2
(192.168.70.162) at B4:74:9F:94:98:84 [ether] on eth2
(192.168.50.30) at 08:00:27:10:D1:1A [ether] on eth0
(192.168.70.90) at 98:0C:82:54:2F:DE [ether] on eth2
(192.168.50.2) at 08:00:27:EA:B2:FF [ether] on eth0
(192.168.70.135) at C8:60:00:4B:96:67 [ether] on eth2
(192.168.60.182) at FE:26:C5:91:B1:DA [ether] on tap0

What we're looking for is the IP address, the MAC address and the adapter's name.
This could be achieved by using a shell script in the below mentioned way. We're using " " to
separate the fields:
arp -a -n | sort | grep -v incomplete | awk '{ print $2,$4,$7 }'

We have almost all the necessary data to 'import' this information into the remote Pandora FMS
Inventory Server. To do so, we're going to use the 'CPU' remote inventory module as a basis and
we're also going to change it slightly. This script is connected to the destination server via SSH and
executes the command. The command's execution should return each file, separated by the ';'
character.
At this point, you're required to have some knowledge of programming to produce your own scripts.
Although they're not very complex, the remote inventory scripts require you to possess some
knowledge of Perl, shell scripts or other languages. You're also able to write them in Java or C++
and to call up their execution from the module as long as you return the values of each field
separated by the ';' character and take a new line for each line of data.

#!/usr/bin/perl
##########################################################################
# pandora_linux_arptable.pl
##########################################################################
# Copyright (c) 2012 Sancho Lerena <slerena@artica.es>
#
(c) 2012 Artica Soluciones Tecnologicas S.L
#
# This program is free software; you can redistribute it and/or
# modify it under the terms of the GNU General Public License
# as published by the Free Software Foundation; version 2.
#
# This program is distributed in the hope that it will be useful,
# but WITHOUT ANY WARRANTY; without even the implied warranty of
# MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
# GNU General Public License for more details.
# You should have received a copy of the GNU General Public License
# along with this program; if not, write to the Free Software
# Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA.
##########################################################################
use strict;
use warnings;
# Check for ssh
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my $ssh_client = "ssh";
if (system("$ssh_client -v > /dev/null 2>&1") >> 8 != 255) {
print "[error] $ssh_client not found.\n";
exit 1;
}
if ($#ARGV < 1) {
print "Usage: $0 <target ip> <username>\n";
exit 1;
}
my $target_ip = $ARGV[0];
my $username = $ARGV[1];
# Retrieve ARP table
my ($ip, $mac, $iface);
my $command = '/usr/sbin/arp -a -n | sort | grep -v incomplete | awk \'{ print \
$2,\$4,\$7 }\'';
my @info = `$ssh_client $username\@$target_ip "$command" 2> /dev/null`;
foreach my $line (@info) {
if ($line =~ /^(.+)\s(.+)\s(.+)/) {
$ip = $1;
$mac = $2;
$iface = $3;
print "$ip;$mac;$iface\n";
}
}
exit 0;

In order for the SSH connection to work automatically, you're required to copy the user's public key,
which requires 'root' privileges from the Pandora FMS Server on the destination server. Imagine this
command to be executed on '192.168.50.10'. Please follow the below mentioned steps.
1. Please create a new key on the Pandora FMS Server as 'root' by the following command:
ssh-keygen

2. Please use the command 'sshcopyid' to copy the the destination server's public key of
'192.168.50.10' along with the destination user (in this case, it's the user 'artica') by the command
below:

ssh-copy-id -i /root/.ssh/id_rsa.pub artica@192.168.50.10

You're also required to enter the user password 'artica' once on '192.168.50.10' in order to install
the public key on the destination user.
3. Now try to establish a connection. It should connect to it without asking for the password:

ssh artica@192.168.50.10

4. If the process was successful, the inventory module is going to follow the same process. Please try
to execute it from the command line and save the previous script to the disk (temporal.pl) and
execute it along with the IP and the user as parameters in the following way:
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perl temporal.pl 192.168.50.10 artica
(192.168.50.1);00:0f:ea:27:ba:f0;eth0
(192.168.50.3);08:00:27:98:f8:48;eth0

Please keep in mind that the script remotely calls to '/usr/sbin/arp'. The command should be
present within this path  if not, please change the script. As you've also certainly noticed, we call up
our script by the 'perl' command which is usually located at '/usr/bin/perl'. In the moment of
defining a module, this is exactly how it should be, as you can see below.

When applying it to an agent, please make sure the operating systems are the same. If you
encounter different operating systems, you're required to create a different module for each one of
them, because the one which was shown here is not going to work for all of them.
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Once this module has been executed, the result could look like the one shown on the picture
below.

29.2.3. Local Inventory by Software Agents
It's also possible to obtain the inventory data from a machine by using Software Agents. You're only
required to apply the appropriate inventory modules within the software agent's configuration. Like
in the remote modules, it's also necessary to add these modules as an inventory module under
'Operation' > 'Manage Modules' and 'Inventory Modules'.

29.2.3.1. Creating Local Modules
In order to create a local module, please click on 'Administration' > 'Manage Modules' and
'Inventory Modules'. This is the location in which all inventory modules created so far are listed.
You're required to create all modules which are defined within the agent.
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In order to create a new module, please click on the 'Create' button.

It's not necessary for the remote modules to complete all the fields. Now we're going to describe the
fields you're encountering there:
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•Name: The field to insert the module's name.
•Description: The field to insert the module's description.
•OS: The combo to pick the operating system the module is intended for. For the location of
modules, we recommend to use the option named 'Agent'.
•Format: The field in which to insert the fields separated by the ';' character the module is
going to return.
Once you have created the module, please click on the 'Create' button.

29.2.3.2. Inventory Module by Software Agents within Windows Systems
The Windows Software Agent Module utilizes locally predefined WMIs to collect information about
the machine's different software and hardware aspects.
The module syntax is the following:
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Now we're going to describe the fields you're required to fill out to add an inventory module within
Windowsbased machines:
module_begin: The beginning of any module of a software agent.
module_name: The field into which the module's name is inserted. In this case, it's 'Inventory'.
module_interval: The field which determines the module execution interval (in days). In this
example, we're going to take '3 days'. Be mindful of errors within certain other documentations. It's
not the module named 'module_inventory_interval', it's 'module_interval'. If the value is '0', the
information will be sent on every execution of the agent.
module_type generic_data_string The value which defines data type in Pandora FMS. The of data
for the inventory modules is 'generic_data_string'.
module_inventory CDROM Patches Software
The field where the inventory objects which we intend to collect are defined. In this example, we've
collected 'CDROM', 'Patches' and 'Software'. In this field, the different parameters where the
inventory objects which we intend to collect are defined. In order to add more objects, you're
required to insert its name into the module named 'line_inventory'. It's possible to collect the
following objects:
•CPU: It obtains information about the CPUs.
•RAM: It obtains information about the RAM modules.
•CDROM: It obtains information about the CDROMs.
•Video: It obtains information about the VGAs.
•Hds: It obtains information about the hard drives.
•Patches: It obtains information about the installed patches.
•Software: It obtains information about the installed software.
•Services: It obtains information about the services installed on the machine (no matter
whether they're running or not).
•NIC: It obtains information about network interface controllers.
module_description The field in which to insert the module's description. In this example, it's
'Inventory'.
module_end It's the end of any software agent's module. In order to activate the inventory module,
691

Data Collection for the Inventory

you're required to copy the previously described code into the software agent's file named
'pandora_agent.conf'. This activation can be achieved locally on the machine or remotely from the
agent's remote configuration.

29.2.3.3. Inventory Module within UNIX Systems by a Software Agent
The UNIX software agent module locally utilizes a plug in to obtain information about different
aspects of the machine from software and hardware.
The module's syntax is shown below.

The module consists of one line and the following parameters:
•Module activation

•The field which determines how often the module will be executed (in days). If the value is
'0', the inventory information is going to be sent on every agent execution.

•The field in which the defined inventory objects are collected.
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Just like in the Windows agent, it's possible to collect the following objects:
•CPU: It obtains information about CPUs.
•cdrom: It obtains information about CDROMs.
•video: It obtains information about VGAs.
•hd: It obtains information about hard drives.
•nic: It obtains information about network interface controllers.
•Patches: It obtains information about the installed patches.
•software: It obtains information about the installed software.
•process: The processes in execution on the server in this moment.
•ram: It obtains information about the RAM modules.
•filesystem: It obtains information about the system's partitions.
•users: It obtains information about the users.
•init_services: It obtains information about the initiated services.
You can find the plug in which collects the inventory in the directory named '/etc/pandora/plugins'.

It's also possible to set the plug in to gather all available information. In this example, the plug in is
going to obtain all daily information on the inventory:
# Plugin for an inventory on the agent (Pandora FMS Enterprise Version only)
module_plugin inventory 1

In order to activate the inventory module, you're required to copy the previously described code
within the 'pandora_agent.conf' from the software agent's file. This activation could be achieved
locally on the machine or remotely from the agent's remote configuration.
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29.2.3.4. Assigning Local Modules
It's not necessary to activate the modules in the agents defined within the console. If the modules
have been created by clicking on 'Administration' > 'Manage Modules' > 'Inventory Modules' and
configured in the software agent, they're going to appear directly within the agent in the console.
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29.2.3.5. Creation of Local Inventory Modules (which are executed from within the
Agent)
In addition to the inventory systems which come 'by default' within the agent, you may create
inventory modules for UNIX and Windowsbased systems a lot easier than the remote modules.
You're required to create a script which generates an XML file with the following structure:

<inventory>
<inventory_module>
<name>INVENTORY_MODULE_NAME</name>
<type>generic_data_string</type>
<datalist>
<data>DATA1;DATA2;DATA3....</data>
</datalist>
</inventory_module>
</inventory>

Under 'INVENTORY_MODULE_NAME' you're required to use the exact module name which is going
to be registered under Pandora FMS. Under 'DATA1;DATA2 ...' the data you intend to obtain is
going to be located.
Supposing that you intend to get an ARP table and the IPs along with their interfaces (please review
the previous example regarding the remote inventory modules). This is basically a slightly modified
exit of the command 'arp a'.
This time, we're going to develop a small script that's required under Windows. We're going to save
it within the path named 'C:\tmp\windows_arp_inventory.bat'. The script consists of the following:

@echo off
echo ^<inventory^>
echo ^<inventory_module^>
echo ^<name^>ARP_Table^</name^>
echo ^<type^>generic_data_string^</type^>
echo ^<datalist^>
arp -a | sort | grep "[0-9]" | grep -v ":" | gawk "{ print \"^<data^>\"
$1\";\"$2\";\"$3 \"^</data^>\" }"
echo ^</datalist^>
echo ^</inventory_module^>
echo ^</inventory^>

You're required to modify the 'pandora_agent.conf' and insert the following line:
module_plugin cmd.exe /C C:\tmp\windows_arp_inventory.bat

This script is going to be executed every five minutes, which represents the default
agent's interval. If it has to be executed within another interval, you're required to code
that logic into the script for yourselves.

In order to inherit the changes, please keep in mind to create an inventory module within Pandora
FMS before restarting the agent.
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Please keep in mind that it's a local module. It neither has the field named 'interpreter' nor the 'code'
fields filled out, but it already holds information about the operating system.
The results obtained here are the same as the ones we've got for the remote module's equivalent
under Linux:

There are a lot more local and remote inventory modules available for download within
the Pandora FMS Module Library. Within this library, there are also a lot of modules which have
been specifically designed for Pandora FMS, as you certainly have seen within this section.

29.3. Data Display for the Inventory
The inventory data which have been locally or remotely collected from a system can be viewed from
the agent or the console's inventory menu.

29.3.1. Inventory Data Display in the Agent
To review the agent's collected data including its inventory, please go to the agent's 'Operation'
menu and click on the 'Inventory' flap.
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It's possible to filter the information by the inventory or a freetext search. Since Pandora FMS
versions 4 and above, the searches include custom fields. It's very useful to search e.g. for a specific
version of a software:
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29.3.2. Inventory Data Display in the Inventory Menu
By clicking on 'Operation' > 'Monitoring' and 'Inventory', it's possible to view all agents inventory
data, to conduct searches and to export data to a CSV file.

The fields which could be used for searches are the following:
•Group: The combo in which you're able to pick the group of agents you intend to filter by.
•Module: The combo in which you're able to pick the inventory module you intend to filter
by.
•Agent: The field in which you're able to insert the agent's name you intend to filter by.
•Search: The field in which you're able to insert a text in order to conduct a search by using
all inventory fields.
It's also possible to see all agent's modules which have an inventory by selecting 'All' within the
search options and clicking on 'Search'.
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It's also possible to search on a specific module in all agents with inventory by selecting the module
and clicking on 'Search'.

29.3.3. Exporting the Inventory Data to CSV
By clicking on 'Operation' and 'Inventory' it's possible to export the inventory data which are the
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result of a filtering to a CSV file.
Please pick the filter. Once there is any data present, please click on 'Export to CSV'.

It has created a file which contains the inventory data, separated by a semicolon.

29.3.4. Diff view and Block mode
From version 5.1 of Pandora FMS the inventory information can be viewed in two columns so
differences can be spotted easily. This only works when you are using remote inventory modules
with "block mode" enabled. This mode is used to set the module to report all information as a single
piece of information, instead a list of small items of information, like a list of packages in the server.
Instead processing each line as a single entity, it process the whole report as a single item.
Plugin we use in this chapter can be downloaded from official module library at [1]
Inventory module Block mode is configured when you define a remote inventory module:
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To access this feature you must click on the icon that appears in the following image. All other
inventory modules WITHOUT that mode, will not allow you to have "diff view". In this screenshot,
the only moduel with diffview enabled is the third one:
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In the two column view all differences are shown between one inventory version and another. We
can even set a different date.
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Remember each time an inventory module detect a change it reports an event. In block mode, that
event will not contain the changes, because could be very extense.
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30 VISUAL MAPS
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Pandora FMS allows you to create visual maps in which each user is able to create his own
monitoring map.

The new visual console editor is much more practical, although the old visual console
editor had its advantages. Within the new visual console, we've been successful in
imitating the sensation and touch of a drawing application like GIMP. We've also
simplified the editor by dividing it into several subject-matter tabs named 'Data',
'Preview', 'Wizard', 'List of Elements' and 'Editor'.
The elements the Pandora FMS Visual Map was designed to handle are 'static image', 'percentage
bar', 'module graph' and 'simple value'.

30.1.1. Creating a Visual Map
In order to create a visual map, please click on 'Operation' > 'Reporting' and 'Visual Console'. It's
going to display a list, containing all the maps created so far. In order to create a new map, please
click on the 'Create' button.

The picture below shows a window intended to name the map. Please pick a group and select the
map you intend to use. Once you have filled out all the appropriate fields, please click on the
'Create' button.

30.1.2. Viewing a Visual Map
In order to inspect all visual maps which have been created so far, please click on 'Reporting' and
'Visual Console'. It's going to display a list which contains all maps created so far.
The visual console items come with the following characters: "_", "," , "[" and "(". For the first letter,
it's shown in the left menu within the 'Visual Console' sub menu.
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In order to see the map, please click on the map's name you intend to inspect.

Below the map, there is a combo which was designed to pick the map's appropriate refresh time.
The map can be viewed in fullscreen mode by clicking on this icon
the map's editing page by clicking on this icon

. It's also possible to go to

. It's also possible to display a public link to the
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current visual map which is accessible without having to login into the Console.

30.1.3. Deleting a Visual Map

In order to delete a visual map, please click on 'Reporting' and 'Visual Console'. It's
going to display a list in which all maps created so far are contained. In order to
delete a map, please click on the trashcan icon in the row of the visual map you
intend to delete.

30.1.4. Tabs in the Visual Map Editor
30.1.4.1. Data
Within the data tab, you may edit and create the visual console's basic data. There is only one
visible for a new map until you save it. The essential values within this particular tab are the visual
console's name, the group for the ACL management and the background image.
By creating it, the size of the visual console is determined by the background's image size. If you
change the background, the last userdefined size or the previous background will be stored.
The background images are stored within the Pandora
'var/www/pandora_console' in the '/images/backgrounds/' directory.

Console

directory

under

Example of the data tab's layout.

30.1.4.2. Preview
The visual console view is a static view, so if the state of the elements contained in there changes,
they're not going to be drawn again. Same as the visual console's view which is contained in Visual
Console's menu.
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30.1.4.3. The Wizard
In here is a small questionnaire to create several elements of the staticimage type simultaneously
within the visual console by only two clicks.
As you can see in the picture below, the form consists of the following:
•The image which will be the same for all the elements created in the batch.
•The distance between the elements, that will be one after another in a horizontal line from
position '0,0'.
•The agent's selection box to select one or several agents. Whether you select one or several
agents, the batch elements will be created for the visual console.
•The module's selection box, which is a dynamically designed control which is filled by the
agent's modules you've picked within the agent's selection box. You're able to pick the
modules for which you intend the static image elements in the visual console to be drawn in
it.
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Example of the Wizard tab.

30.1.4.4. List of Elements
This tab provides a questionnaire for the visual console which you're presently editing. It's tabulated
in files of the elements and a quick way of editing the different elements. It's also a useful tool for
users which require to adjust certain element's values.
The supported actions within this questionnaire are editing and the deletion of elements. Creating
elements and changing the element's type is not supported here. These actions are required to be
carried out under the 'Editor' and 'Create' tabs.
The first line is the background image's configuration.
The rest of the lines are going to be map elements, associated in lines of two elements each and
separated by a horizontal black line as shown on the picture below.

An example for the 'List of Elements' tab.
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30.1.4.5. The Editor
This tab contains the most of the visual console editor's functionalities, because this is the menu in
which you're able to create, edit and position the elements. It's a dynamically designed page, so
your browser is required to appropriately support the JavaScript language. As you can see on the
picture below, the window is divided into two well defined areas: The button box, the work area
(within which the visual console is going to be drawn) and the options palette (which isn't visible
on the picture).

Example of the form tab's data.

The Button Box

The buttons this particular tool is composed of are the following:
•Buttons to create different types of elements, located on the left side named 'Static Graph',
'Percentile Item' (bubble and percentile type), 'Module Graph', 'Simple Value Label', 'Icon'
and 'Service'.
If you click on them, the options palette containing the fields to fill out in order to create an
element of this type is going to appear. They can also be deactivated if you're editing or creating an
element. If it's active in the moment you're clicking on it, it's going to close the options palette.
•The 'Delete Item' button which is deactivated by default until you select an element, except
the background. By clicking on it, it's going to delete the element of this visual console for
good and also deletes it from the database.

Deletions carried out by the 'Delete Item' button cannot be
undone.

•The 'Edit Item' button, which is also deactivated by default until you select any element
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contained in the visual console. By clicking on it, it's going to display the options palette of
this element, so you're able to edit its values.
The Working Area

The working area has the size of 100% of your Pandora Console's width and a height of 500 pixels.
As you can see, it's equipped with scroll bars for the purpose of rendering the work of handling big
sized visual consoles a little easier. Please keep in mind that the visual console's size is the same as
the one of the background image. In the working area, all elements which have been created in the
default position of '0,0' (which is the upper left corner) are going to be shown.
Advanced Options

Position
By default, the position is '0x0', where the first number is the X and the second one is the Y axis.
These values are declared in pixels. Please keep in mind and that the Y axis is inverted within which
the highest value is '0', ascending downwards. The X axis is defined classically. It starts in the left
corner and increases to the right side.
You're not required to insert an exact position here, unless you're required to have a very precise
one. You may locate it by moving through the visual console the same way as with a drawing tool
after creating an element.
Parent
In order to represent a link between elements from the visual console, we've used lines that are
drawn between them. These lines are drawn in a specific color, depending on the state of the parent
element. Within the control, it's going to display a list of elements contained in this visual console
which come into consideration to be the parent elements.
Linked Map
The element can also be the connection to another visual console to obtain more usability, e.g. you
have two visual consoles: One which represents the machines inside a building, managed by you
and a second visual console which represents a world map. On this last one, the default setting is to
have an element, able to change the state (only on static images) which represents the building you
are managing and provides easy access to the other one.
This control provides you with a dropdown list which displays the already created visual console to
link it.
Label Color
You may change the text color (which is 'black' by default) for aesthetic reasons or to improve the
label's text visibility if the map's background is very dark. It's was also designed as an interactive
control. It's also possible to input a color by using the classical HTML hexadecimal format. You may
also invoke a pop up which contains the typical color palette.
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color palette screen shot in the label color.

Background

It's a special type of element which neither can be created nor destroyed. Only the following values
could be edited:
•The background image by using the choice palette.
•The size which is gained by the selected background image. Just like the static image, the
'0x0' value is a special value which means that it takes the original proportions of the
background's image file.
•It's possible to apply the original size of the background by clicking on the 'Original Size'
button.
•Also it's possible to modify heightwidth ratio of the background image. This can be
attained by clicking on the 'Proportional Width' and 'Proportional Height' buttons.
(Pandora FMS versions 5 and above only)
•Grid: You're able to display a grid, designed move elements aligned to that grid. If this
option is deactivated, the elements can be moved freely again.
•AutoSave Button: If it's disabled, you're only able to move the items because the creation
buttons are disabled.

Grid option in the palette
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An example background image with an activated grid feature.
(Pandora FMS versions 5 and above only)
•Save current Edition: You're also able to deactivate the autosave functionality within the
visual console which is activated by default and to force the saving by clicking on the
disketteshaped button. This feature really comes in handy in conjunction with slow
connections, especially if you're uncertain the auto save has been carried out appropriately.

This is the option to auto save the current visual map within the palette options.
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This is an example which displays the choice palette when editing the background.

30.1.5. The Choice Palette
It's displayed if you double click on the item you intend to edit or by clicking on the 'edit' button,
contained in the button box. The form of the option palette contains the the below mentioned
controls for all elements. Some elements contain additional controls which you're able to look up in
their corresponding sections.

30.1.5.1. Label
Labels are texts which are displayed on its corresponding element in the visual console.
Since the 5.0.1 version of Pandora FMS, it contains a featurerich editor with which you're able to
augment labels by styles.

30.1.5.2. Agent
An intelligent control with which you're able to search for an agent of your Pandora FMS
installation by its IP or the agent's name.

Example of one search within the agent's intelligent control.

30.1.5.3. Module
This control responds to the control's selection of the agent which automatically inserts the modules
the corresponding agent contains.
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Example of the intelligent control module in the moment of automatically introducing the agent's
modules.

30.1.6. Elements to use within a Visual Map
30.1.6.1. Static Image
This element displays a static image. Depending on the state of the module, agent or map, it's
always going to display one image or another. In a current Pandora FMS installation they're
available under '/var/www/pandora_console/images/console/icons'. You're also able to upload
them by the tool included within the file. The image designations are shown below.
<image_name>_<state>.png where the state could be:

An Example for the images including name and status.
•"" If the agent, module or the visual console has any state at all.
•bad: If the agent contains some failed module, the module itself fails or the visual console
(which provides the link) contains some element in a 'bad' state.
•ok: If the agent, module or the visual console is in the 'ok' state.
•warning: If the agent contains any module, the module itself or any element on the visual
console is in a 'warning' state.
Creating a Static Image
In order to create a static image, please click on the 'Static Graph' button. It's the first one on the left
side of the button box. It's going to display a palette which contains the options for a new image.
The common options could be seen on the chapter's beginning named The Choice Palette, but the
ones which are considered exclusive for the static image are mentioned in the section below.
Static Image Options
•Image: It provides a dropdown control with which you're able to pick the displayed image.
It also provides image preview under its control.
•Size: Within this control, you're able to input an appropriate size for the image. By default,
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it comes with the value of '0x0' which means that it's going to take the original image's size
as a template.
Screen Shots

Palette displaying the image preview which is going to be added to the visual console.
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A view of the choice palette of an appropriate static image view.
Tricks
•In order to create a floating text, you're only required to create a static image, but without
an actual image.
Icon
This element displays a static image which is unassociated to any module.

An icon in the visual map's editor.
In
a
normal
Pandora
FMS
installation,
the
images
are
available
under
'<pandora_home>/images/console/icons'. You're required to upload any new image by using the
'file manager' tool. As for any other element in the visual console, you may associate a label, an
initial position, a size, a parent element and a link to another visual map.
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You may perform all of these tasks in the visual map editor as shown below.

Example of an icon creation.
Icons linked to other Pages
Since the 5.0 version, you may associate a complete URL in order to link it to another web page by
using
a
label
field.
Example: In order to link an icon within the visual console to the SNMP console, you're required to
create one element of the icon type. This icon is going to contain a label which contains the
complete SNMP console's URL as shown below.
http://<pandora_home>/index.php?sec=snmpconsole&sec2=operation/snmpconsole/snmp_view

In the preview mode of the visual console, you may can click on the icon and it's going to redirect
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you to the SNMP console.

30.1.6.2. The Percentile Item Bar
Percentile items allow you to see the module's state in a descriptive way. The items can be of the
bubble or percentile (progress bar) type.

An example of the percentile bar. This example displays the result of a module which monitors the CPU.
Percentile Item Options
The percentile bar contains much less controls than the rest of the elements, but it has four controls
which we're going to explain below.
•Width: This is the percentile's bar width in pixels.
•Max Value: This is the maximum value, the represented module can assume. For this
reason it's always a good thing to examine the module to monitor just to see what's its
maximum value is going to be, e.g. in case of the screen shot, it's the CPU module which
moves from the value of '0' to '100'.
•Type: This field allows to configure whether the item type is going to be of the 'bubble' or
the 'percentile' type. It's a graphical way of representing this item.

An element of the 'percentile' type.

An element of the 'bubble' type.
•Value to Show: This field allows you to choose between the percentage of accomplishment
or the module's last value.
•Advanced Options: This element has no advanced controls which differ from the basic ones.
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An example of the choice palette for the percentile bar.

30.1.6.3. The Module Graph
Just as its name says: A graph which provides the activity information of one agent's module which
is going to be displayed within the visual console.
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This is an example of a module's graph element, within which you're looking at a CPU module's last
data from one hour ago graphically.
The Module Graph's Options It's necessary to define width and height in the graph in order for it
to change from being hidden to be shown in the advanced options.
•Period: The period or time frame that goes until the present time. Please keep in mind that
this graph is going to change as time progresses.
•Size: The width and height of the image the graph is going to be displayed in. It's not only
the graph itself, but the graph and the ciphers of all axes.
•Advanced Options: This element has no advanced controls which differ from the basic
ones.
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Example which displays the graph's choice palette of an edited module.

Since the graphs were designed to calculate themselves first and create an image
afterwards, creating graphs is not an instantaneous process. Depending on the
architecture on which you have built Pandora FMS, its completion can be either almost
instantaneous or take quite a few seconds, within which you're only going to see the
element's label on the map without the graph's actual image.

30.1.6.4. Simple Value
This element only displays a text of the '[label][module value]' type in the visual console. You're
only required to define a label (if you want), to select the agent and the module which is going to
display the intended last value within the visual console's drawing.
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This is an example in which a CPU module's simple value is shown.
Simple Value Options
The simple value choice palette doesn't have its own controls.

An example which displays the simple value's choice palette.
Since Pandora FMS versions 5.0.1 and above, you're also able to setup a style to the value by using
the rich editor within the macro (_VALUE_).

30.1.6.5. Label
This feature was designed to create labels without any associated content. The only requirement is
to fill out the 'Label' field.
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An example of label editing

30.1.6.6. Group
It's a static graph which was designed to display the group's status.
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Group item edition
30.1.7. Sharing a Visual Console
From Pandora FMS versions 4.0.2 and above, it's possible to share a visual console with anyone
within the company's network, even if they don't have a valid user account to login to Pandora FMS.
You may share the visual console with anyone, just by providing a public URL.
Please access the visual console's main view, click on the sharing tab and on the camerashaped icon
as shown on the picture below in order to do so.
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This special URL is of the static type and similar to the one shown below.
http://192.168.50.2/operation/visual_console/public_console.php?
hash=86d1d0e9b6f41c2e3e04c5a6ad37136b&id_layout=3&id_user=admin2

Please feel free to share this particular URL with anyone within your company's network and they're
instantly able to access the information published in that visual console. They of course can't access
any of the links within the console, just the information contained in it. This is a good way to
provide access to specific information under Pandora FMS.
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31 NETWORK MAP (OPENSOURCE
VERSION)
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There is also an opensource version of the network map. This functionality allows to graphically
display the nodes and relationships, agents, modules and groups available to the user. There are
three types of network maps:
•Topology Map
•Group Map
•Policy Map
In order to access the network map, please click on 'Operation' > 'Network View' and 'Network
Map'.

Creating a new network map is really easy. In order to e.g. create a topology map, please follow the
below mentioned steps:
Please click on 'Add Map'.

A window like the one shown below is going to appear.
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Please click on the green arrow. Subsequently, you're able to modify names, filter by groups, show
or hide interfaces, modify the network map's shape, to configure whether names are displayed in
overlapping mode or not, to show simple nodes (without images and names), to regenerate the map
every time the page is reloaded and to change the font size. Please click on 'update' when you're
done.
In order to finish the process, please click on the 'Save Map' button.

All other maps are also created in the same way.

31.1.1. Topology Map
The Topology Map shows the agents according to the network topology. It also shows relationships
between father and child nodes. This display mode is very useful in combination with a Recon
Script. This combination allows to graphically display the entire network topology. Each agent is
going to be colored according to its associated state.

31.1.2. Group Map
The Group Map shows agents and modules categorized by their group. The filter options pertaining
to the group map are the following:
•Filter by agents
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•Filter by module groups
•Filter by the network map's shape (e.g. radial, flat, circular)
•Filter by depth (agent or modules),
•Filter by overlapping names
•Filter by whether modules containing alerts are shown or not
•Filter by whether policy modules are hidden or not
•Filter by whether nodes are simple
•Filter by font size

31.1.3. Policy Map
The Policy Map shows agents and modules of policies. It's possible to filter by the agent's group and
module groups. It's also possible to modify the network map's shape (radial, flat, circular, etc.), the
depth (from agents or modules), whether names are overlapped, whether modules containing alerts
are shown and whether the modules are of the simple type or not. It's also possible to determine
whether it's desired to regenerate the network map each time the page is reloaded or not and to
change the font size.

31.1.4. FullScreen Mode
It's also possible to display the network map in a fullscreen mode by clicking on the button shown
on the picture below.

31.2. The Enterprise Network Console
By using Pandora FMS Enterprise, you have the opportunity of creating editable network maps
which are a lot more interactive compared to the ones of the opensource edition. You can find
them by clicking on 'Operation' > 'Network View' and 'Network Map'.
Contrary to the opensource version, the Enterprise Network Map provides you a lot more features,
such as:
•Much bigger network maps, capable of monitoring more than a 1000 agents.
•Realtime monitoring of your system's entire network topology.
•Numerous different views of its network topology, either manually defined or automatically
generated by using the agent's groups.
•The possibility to link different topology views by means of inserting fictitious points.
•The opportunity to manipulate the current topology within the view:
•The insertion of new nodes, either single or in groups.
•The function of editing the node's features.
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•The possibility to organize them within the view along with the node's position and the
relationships between them.

It's possible to gain access to the Enterprise Network Map by the menu on the left. Please click on
'Operation' and 'Network View'.

The network maps are capable of containing the following:
•Real nodes, which uniquely represent the agents added to the map. These nodes have an
icon which represents the agent's operating system and a circle by default. It's also possible
to pick another shape. The agent's states are the following:
•Green: It's the 'OK' status.
•Red: At least one module has moved to a 'critical' state.
•Yellow: At least one module has moved to a 'warning' state.
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•Orange: Some of the alarms have been fired within the agent.
•Grey: The agent is in 'unknown' state.
•Fictitious Nodes: They either represent a link to other network maps or a sole point on the
map intended for personal use. It's able to have any available shape (e.g. circle, rhombus,
square) and any text size. If it consists of link to another map, the color follows the below
mentioned rules if it can't be customized by the user.
•Green: It's used if any the nodes on the linked map are in 'OK' state.
•Red: It's used if any of the nodes on the linked map are in 'critical' state.
•Yellow: It's used if any of the nodes on the linked map is in 'warning' status and anyone in
'critical' status.
•Orange: It follows just the same rules as the other colors.
•Grey: It's used for the relationship lines between nodes.
Lines link/relationship between the nodes.
The lines link/relationship can be a relationship between the nodes or the network interfaces of this
nodes. If there are a relations across the interfaces, the line between the nodes have a arrow end
and arrow start with the circle shape, the color of the circle is the status of the network interface
and the line have a name of interface.

732

The Enterprise Network Console

31.2.1.1. Mini Map
This mini map provides you with a global view that shows all the map's extensions, but in a smaller
view. In contrast to the map's view, all the nodes are shown without their states and relationships to
each other, except the Pandora fictitious point which is shown in green. A red box is also shown in
the displayed part of the map which indicates your position.
It's in the upper left corner and can be hidden by clicking on the arrowshaped icon as shown below.

31.2.1.2. Control Panel
From the Control Panel, you may perform more complex tasks than on the Network Map.
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It's hidden on the upper right corner. Same as with the mini map, it can be shown by clicking on the
arrowshaped icon. The available options are the following:
•To change the refresh frequency of the node's state.
•To force a refresh.
•To add the agent by an intelligent control which allows you to quickly search for the agent
and add it. The new node is shown on the upper left (coordinates '0,0') on the map.
•To add several agents and filtering them by group, which is going to show the group's
agents which aren't in a list of multiple selection on the map yet.
•To produce a screen shot of the map's visible part.
•To add a fictitious point, where you can select the text as name of this point, the size
defined by the range, the point shape, color by default, and, if you want that the fictitious
point would be a link to a map.
•To search the agent by an intelligent control. Once selected, the map is automatically going
display the point on which the agent's node is located.
•To change the network map's zoom level.

31.2.1.3. Holding Area
The holding area is the place where the new nodes appears, avoid the messy networks with new
nodes in your networkmaps and of course you can see the changes and the updates in your
monitored system.
The new nodes in the holding area appears only when you choose the refresh holding area in the
context menu.
Also the new nodes are filtered by the creation options of networkmap, by example by the group, or
network mask or the new agents found by the recon task.
The nodes and the links are dashed the line or the shape.
The nodes into the holding area are in this place until that they are drag and drop out the holding
area.
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31.2.1.4. Detailed View Window
The detailed view window is a visual representation of one agent. To open this window, you're
required to right click on the node's agent displayed on the map and select 'View Details'. It's going
to be refreshed within the same period as the map which is currently open. The windows are
completely independent, so you may have several windows opened simultaneously.
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•It shows a box which rim will be of the same color as the agent's status.
•The agent's name is a link to the Pandora FMS agent page.
•Within the box, all the modules which aren't in unknown status are going to be displayed,
which depends on whether the module's status is green or red.
•It's possible to click on these modules. If you do, they're going to show a tool tip containing
the module's main data.
•Within the box rim, the modules of the 'SNMP Proc' type are displayed. They're intended for
network interfaces if a network systemsrelated agent is monitored.
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Palette of Fictitious Points

If you select 'See Details' on a fictitious point, it's going to show you a popup window, containing a
palette of options to modify the fictitious point.

The available options are the following:
•The name of the fictitious point.
•The shape of the fictitious point.
•The map which links to the fictitious point.

31.2.2. Creating a Network Map
If you intend to create a Network Map, you have two options:
•To show all the agents contained in one group.
•The creation of an empty network map.
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Now we're going to explain the available fields within the creation form:
•Name: The name of the network map.
•Group: The group for the ACL and the group's map we intend to generate, containing the
agents which are members of this group.
•Source: filter of source of the agents how is generated the networkmap or the new nodes
are searched for to add into the holding area.
•Size of the network map: It's the location intended to define the networkmap's size. The
default value is '3000 x 3000' pixels.
•Method for creation of the network map: The method of the node's distribution which is
going to generate the network map's layout.
It has a radial shape by default, but there are some additional options to choose from:
•Radial: The displaying method in which all the nodes are going to be arranged around the
fictitious node.
•Circular: The displaying method in which the nodes are going to be arranged in concentric
circles.
•Flat: The displaying method in which the nodes are going to be arranged in a treelike
shape.
•spring1, spring2: These are variations of the 'flat' arrangement method.
•Networkmap Refresh: It's the refresh cycle of the node's status contained within the
network map. The default value is '5 minutes'.
The rest of the fields (e.g. 'resizing map') are disabled, because they're unnecessary. Only active
nodes are going to be shown within the newly created map anyway.

31.2.2.1. Source of networkmap
Since the version of Pandora 5.1, the networkmap have diferent filters for to obtain the new nodes
(for the holding area) or for to generate a new map.
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The filters are:
•Group: the new nodes (in a new networkmap or into the holding area) are the agents that
are in the group or children groups of the setted group.
•Recon task: the new nodes (in a new networkmap or into the holding area) are the agents
discovered by a setted recon task, the recon task must be a recon task for the networkmap
level 2.
•Network mask: the new nodes (in a new networkmap or into the holding area) are the
agents that the main IP of these agents pass the the network mask setted.

31.2.3. Editing a Network Map

In order to edit a map, you're required to have ACL permissions of the 'IW' type. You may access the
editing form by using the wrenchshaped icon as shown in the image above.

The network map edition form is exactly the same as the one intended for creation, except for two
things:
•Generating the Network Map from: You're not going to need it, because the map is
already generated.
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•Generation Method: Because of the exact same reason stated above, you're not going to
need this one either.
However, we have some other active fields:
•Resize of the network map: It's a feature which sends an asynchronous request to the
server to analyze the network map already generated and to determine the best way to
render the map as small as possible. If there are e.g. any empty parts without nodes within a
minimum framing, it's going to reduce the map dimensions to a minimum.

31.2.4. Duplication of a Network Map
You may duplicate a network map along with all its content and configurations from the network
map's list by possessing the proper ACL 'IW' permissions. The name of the duplicated network map
is going to be 'Copy of [network map's name]' by default. If there is e.g. more than one copy, the
name of the network map is going to be 'Copy of [network map's name] [number]'.

31.2.5. Interaction with the Network Map
The network map interaction could be conducted by the following:
•The mouse, accepting actions like drag and drop, double click, left and right mouse button
and the mouse wheel.
•By using the keyboard's 'CTRL' keys it's also possible to modify multiple selections.
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31.2.5.1. Actions on the Map
Moving through the Map

•By holding down the left mouse button on an empty area of the map, it's possible to drag
the network map to a desired position.
•On the mini map, please hold down the left mouse button to drag the map to the desired
position or just click on the zone you intend to visualize.
•Once the agent is introduced, you have a search box within the dashboard. The map
automatically moves to the point on which this node's agent is located.
Forcing the Map to Refresh

By clicking on the right mouse button over an empty space, a context menu is shown. Within it,
you're able to select the 'Refresh' option which forces the map to refresh the node's status.
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Centering the Map

By clicking on an empty link by the left mouse button, a context menu is shown. If you select the
option 'Center here' it's going to fix the network map's center on the clicked point. From this
moment on, it's going to open this particular map with this point as its new center. If you e.g. don't
select any center, the center is going to be the fictitious node by default.
Editing the Nodes

31.2.5.1.1.1.

Changing the Position

It's possible to change its position by simply dragging and dropping a map's node to its desired
position.
31.2.5.1.1.2.

Linking one Node to another

By clicking on a node by the right mouse button, a context menu is going to open. Please select the
option 'Select as Child' to link one node to another.
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Please start the link operation of one node to another. In order to do this, you're required to click on
another node (it's not important whether it's fictitious or not) by the right mouse button which is
going to open a context menu which shows the two options named 'Set Parent' and 'Cancel action
set parent'.

When you're done, the node is going to be displayed as linked to the other and the node's marks are
going to disappear.
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31.2.5.1.1.3. Deleting Nodes

If you click on a node by the right mouse button, a context menu will be shown. Please pick the
option 'Delete' in order to delete a node.

31.2.5.1.1.4.

Changing the Shape of the Status Ring

If you click on a node by the right mouse button, a context menu is going to appear. Subsequently,
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you're going to see a popup list in the shape of the ring. You may pick the appropriate shape of the
ring by it.

31.2.5.1.1.5.

Deleting Relationships between Nodes

If you click on a node by the right mouse button, a context menu is going to appear. On the bottom
of it, you're going to see a relationship list. It's a list of the relationships the node could have. You
may delete them pressing on the xshaped button.
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Massive Editing of Nodes

By holding down the 'CTRL' key, a semitranslucent square is going to appear. It enables you to
select several nodes simultaneously. Once several of them have been selected, you have the
following options:
•By using the left mouse button, you may drag and drop all of them simultaneously.
•By using the right mouse button, a menu containing the following options will become
available: Linking to another node by relationship, rendering it into the foreground,
deleting, opening the detailed view and changing the way of the status ring  and if it's a
fictitious node: Changing the shape of it.

Reviewing the Node's Information

There are two ways of accessing the node's information:
•By double clicking on the node.
•By clicking on a node by the right mouse button, a context menu is going to appear. Please
select the option named 'Show details'. This feature is going to show a detailed view of the
agent within a popup window. If it's a fictitious node, it's going to open a pop up window
which displays a palette of options to edit this type of node.
Creating Agent Nodes

You may create agent nodes from the initial load if you select some from the group during map
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creation. You may add new agent nodes once the map has been created. This operation is required
to be conducted from within the control panel and there are two ways of doing so:
31.2.5.1.1.6.

Single Creation of a Node

In the control panel within the area to add agents, there is an intelligent control which filters and
displays a list of possible agents.
Once it has been selected, please click on the button 'add agent' within the panel. It's going to
display a new node of this agent in the center of the map in this moment.

31.2.5.1.1.7. Massive Creation of a Node

Within the popup list which is called 'Filter Group' in the control panel, you may select the group
from which you intend lo load the agents to add to the list shown above. In this list, the agents of
the group which aren't shown on the map are going to be displayed here.
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Once they're selected (after clicking on the button 'add') they will be shown on the coordinates '0,0'
of the map, which is the left upper corner.
Creating fictitious Nodes

It's possible to create fictitious nodes from the control panel. Within the form, it's possible to define
the shape (e.g. circle, square, rhombus), to color it, name it, to assign a size to it and even to pick a
map with which to link it within the networkmap's list.
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Modifying the Zoom Level

The mouse wheel is able change the zoom level of the map, which always starts by the maximum
zoom level by default. On maximum zoom level, the system icon which is displayed on higher levels
isn't going to be shown. There are 5 zoom levels.
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32 Pandora FMS Reports
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Pandora FMS includes a collection of fonts which could be used within graphics, maps and reports.
Among the included fonts ('code.ttf' is used by default), characters such as Latin, Arabic, hiragana,
katakana and many others are supported.
The fonts are located in the directory named '/include/fonts' in which you're able to paste new fonts
into if you need them.

32.1. Graphs
Graphs are designed to show the data collected by Pandora FMS in a temporary scale defined by the
user. Pandora FMS Graphs display data in real time. They are generated every time the operator
requires any of them and display the uptodate state. There are two types of graphs: The agent's
automated graphs and the graphs the user customizes by using one or more modules to do so.

32.1.1. Agent Graphs
Agent Graphs are the module's graphs which can be viewed from the Agent's Operation menu. In
order to access these graphs, you're required to pick an agent by clicking on 'Operation' > 'View
Agents' and 'Agents Details'.

After the filtering is completed, please click on the agent's name, e.g. 'vanessaHP630Notebook
PC', to gain access to the agent's operations menu.
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This view is going to display a list which contains all the agent's modules. One of the columns of
this list is called 'Graph'. It provides a link to access the graph within each module.

If you click on the 'Graph' icon, you're going to gain access to a new window in which the module
graph is contained. You're also able to personalize the graph shown there.
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The graphs are displayed in Flash or in a PNG format (if Flash has been deactivated). The Flash
graphics are interactive, so hovering the mouse over any point of the graph's back side leads to a
display of this point's specific data. The graphs come with a configuration menu which allows you to
reconfigure the graph by hovering the mouse over the flap on the left of the graph's window. For
each series, some statistical data are displayed within the legend (e.g. 'last value', 'average',
'minimum' and 'maximum').

Now we're going explain the fields you're encountering there:
•Refresh Time: The field in which the graph's refresh time is defined.
•Avg. Only: If you select it, it's going to show the medium data without minimum and
maximum only (This feature is not available for boolean modules).
•Begin Date: By a calendar, it's possible to define the moment from which the data is going
to be shown.
•Zoom Factor: You may enlarge or reduce the graph by this combo.
•Time Range: You may choose the graph's time frame by this combo.
•Show Events: If you click on it, it's going to show the module's events.
•Show Alerts: If you click on it, it's going to show the module's alerts.
•Show Event Graph: If you click on it, it's going to show a bar graph along with received
events within the graph's interval below it (Pandora FMS versions 5 and above only).
•Time Compare (Overlapped): If you click on it, it's going to show a second overlapping
graph along with the module's data within the previous interval, e.g. if the module
represents one week, the previous week is also going to be shown. This option is available
for the numerical and boolean modules only (Pandora FMS versions 5 and above only).
•Time Compare (Separated): The same as the overlapped version but with separated
graphs.
Once you have changed the values, please click on 'GO' to apply the changes.
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It's also possible to change the graph's resolution to display a more detailed view, as you can see on
the next picture. The values for the resolution are between '1' (lower) and '5' (higher).

If you intend to edit or review the configuration parameters related to graphs, please click on
'Administration' > 'Setup' and 'Visual Configuration'.

32.1.2. Combined Graphs
Combined graphs allow the user to augment graphs with a variable size which hold values of
different modules which themselves own one or more agents. You may visually compare
information which originates from several sources in this way.

32.1.2.1. Creating Combined Graphs
In order to add a combined graph, please click on 'Operation' > 'Reporting' and 'Custom Graphs'.
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Now we're going to describe the fields you're going to encounter there:
Width: The field intended for the graph's 'width' value.
Render Now: A combo which determines whether the graph is rerendered or not.
Height: The field intended for the graph's 'height' value.
Period: It's the combo by which you're able to define the temporary period used to create the graph.
View Events: By this combo, you may select whether the events which have taken place on the
module are going to be shown or not.
Stacked: By this combo, you may select the type of graph. You're able to choose between 'Area',
'Line', 'Stacked Area' and 'Stacked Line'.
Factor: Please click on 'Preview' to display a preview of the graph.
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This is the graph. You may change the parameters and click on 'Update'.

In order to add new modules, please click on the 'Graph Editor' button. It's going to open a form
which allows you to add new modules from any agent.
The defined graph is shown below, along with one menu and the options to add more modules and
to store the newly created graph.

The 'factor' option allows you to select the value of the data standardization factor in case you
intend to use it. The standardization was designed to compare graphs of different levels and to
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multiply the data by the defined factor. If we e.g. intend to insert the CPU graph along with values
between '0' and '100' and the number of connections between '1000' and '10000' into the same
graph, it's recommended to multiply the CPU value by '10'.
There is no limit in the number of elements to visualize  but from five values and above, the shown
quantity of information makes it pretty difficult to interpret, unless you use bigsized graphs, e.g.
'800x600' and above.
Due to the simplicity the combined graph creation possesses, the graphs can't be edited, except in
the moment you're creating them. In the moment of their creation, the only thing you can do is to
delete the inserted module and to reinsert it once again along with other properties.
Once the graph has been created, it's important to store it for being able to review it later or to
utilize it within a report. Before storing the graph, we strongly recommend to name it, to write a
small but detailed description, to determine whether it's considered to be of a private nature or not
and to click on the 'Store' button when you're done.
On the picture below you can see a combined graph, consisting of two modules: 'cpu_user' of the
'farscape' agent and 'cpu_user' from 'ARTK_galaga'. In our example, the graph has been saved as
'Example cpu_user'.

32.1.2.2. Displaying Stored Combined Graphs
In order to see a stored combined graph, please click on 'Operation' > 'Reporting' and 'Custom
Graph'. It's the location in which all the graphs are stored. Please click on the graph's name to
review it.
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On the picture below, you can see a graph which is recalculated by means of the available values in
this moment.

On this page, it's possible to modify any display parameters such as the time frame, the graph's type,
e.g. 'line', 'area', 'stacked line' and 'stacked area' and the zoom factor, e.g. 'defined by graph', 'zoom
x1', 'zoom x2' and 'zoom x3'.
Now we're going to provide an example along with the different types of graphs. The area type was
shown on the previous image.
•Line Type:
Shown as a static graph (PNG).

•Stack area Type:
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In this case, the graph type gets shown in Flash (interactive):

•Stack line Type:
Shown as a static graph (PNG).

32.1.2.3. Deleting Stored Combined Graphs
To delete a stored combined graph, please click on 'Operation' > 'Reporting' and 'Custom Graph'.
It's the location in which all stored graphs are listed. Please click on the trash icon on the graph's
right side to delete it.
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32.2. Agents / Modules View
By clicking on 'Monitoring' and 'Agent/Module View', a matrix containing modules, agents and the
state of every single module is displayed.
In order to invoke the extensions, please click on 'Operation' > 'Extensions' and the
'Agents/Modules' view.

32.3. Module Groups
This section allows to have a precise overview in a module table by its state, regarding the module's
group and the module itself. In order to access the extensions, please click on 'Operation' >
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'Monitoring' and 'Module Groups'.

As you can see on the image above, there is a matrix containing the module's number, assorted by
agent group along with different colors, depending on whether there are modules in 'critical',
'warning' or 'OK' states or not.

32.4. The Tree View
The tree view allows to visualize the agent's monitors in a treeshaped structure. Please click on
'Operation' > 'Monitoring' and 'Tree View' to invoke it.
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It's also possible to classify the agents by modules, policies, module group, group and operating
system. They're assorted by group by default. Within this level, the number of agents in 'ok' (green),
'critical' (red), 'warning' (yellow) and 'unknown' (gray) states is displayed. Information about it is
going to be displayed by clicking on the agent's name, address, operating system, event and access
graph. They can be filtered by the module's states ('normal', 'critical', 'warning' or 'unknown'). A
search by agent's name is also supported here.

32.5. The Mobile Console
Pandora FMS comes with a new mobile console. This console a reduced version of the default
console and allows any user with a mobile device with at least 600x280 pixels of screen resolution
to browse all information provided by Pandora FMS like agents, monitor view, alerts, agent detail
(graphs included), group view and last events.
The mobile interface is located at '/mobile' [url], so if your regular console is located at
'http://firefly.artica.es/pandora_demo/' your
mobile
console
is
located
at
'http://firefly.artica.es/pandora_demo/mobile'.
This URL is compatible to any device which is able to access native websites. It has been thoroughly
tested with iPhone and androidbased cellphones and tablets and adapts automatically to the width
of your device's screen.
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The login screen within the mobile web interface.
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The tactical view of the mobile web interface.
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The detailed event view.
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The detailed module graph.
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The general options menu.
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The agent's detailed view.
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The module's detailed view.

32.6. Custom reports
Pandora FMS was designed to create customized reports containing information about agents such
as calculus, derived from them or even to import data or tables intended for other places by
using URL import or similar methods. It's possible to select different modules from different agents.
The data is visualized in different ways, depending on the type of report element which we intend
to add.

32.6.1. Creating a Report
In order to add a report, please click on 'Administration' > 'Manage Reports' and 'Report Builder'.
It's going to show you a list which contains all the reports. In order to create a report, please click
on 'Create Report'.
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There is one window within which the name of the report, the group it belongs to, whether it's
private or not and the description is defined and contained. Once the fields have been filled out,
please click on 'Create Report'.

32.6.2. Editing a Report
In order to edit a report, please click on 'Administration' > 'Manage Reports' and 'Report Builder'. It
contains a list in which all the reports so far are listed. In order to edit a report, please click on the
report's name.

770

Custom reports

32.6.3. Deleting a Report
In order to delete a report, please click on 'Administration' > 'Manage Reports' and 'Report Builder'.
It contains a list in which all the reports so far are listed. In order to delete a report, please click on
the trash icon which is located on the right side of the report's name.

32.6.4. Tabs
32.6.4.1. Main Tab
The main tab is the only one available within a new report, so this one defines the report's basic
data (name, access group and description). After storing it properly, you're able to access the rest of
the tabs.
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The fields pertaining to this particular tab are the following:
•Name: Intended to define the name of the form.
•Group: Intended to define the access group that is visualized within the report.
•Description: Intended for providing more report information to the users (which is also
going to be shown within the report's list). It's also going to be shown within the
visualization of the report as XML and PDF.

32.6.4.2. The 'List Items' Tab
By this tab, you're going to obtain a global visualization of all items the report is composed of. The
items contained in the list will be displayed in the same order they're going to have within the
report later. Within this tab, you have the following options:
•To modify the item (by clicking on the adjustable spanner).
•To modify the order within the header cells automatically by using the white arrows,
classifying them alphabetically, by element type or by the agent's name.
•To modify the order manually by the green arrows on the left.
•To delete the item by clicking on the red xshaped icon.
If it's a big report which contains several items, it has a form on the top in order to filter the items
by different criteria.
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The columns pertaining to this particular tab are the following:
•P.: The items appear exactly in this column's order within the report.
•Type: The column in which the item's type is displayed.
•Agent: The column in which the agent's name is mentioned. It's also allowed to leave it
blank for item types like SLAs, custom graphs, import texts from URLs, SQL queries, simple
graphs and texts.
•Module: The column in which the module's name will be extracted from the data in order
to generate the report. It's also allowed to leave it blank for item types like detailed agent
view, alert report agent, custom graph, event report agent, import text from URL, SLA, SQL
queries and text.
•Period: The time period that it's going to receive in the specific moment the report is
generated.
•Description: The column which displays the description you've given the item in order to
render the work with it a little easier.
•Options: The column which displays the buttons and icons to edit or to delete it.

32.6.4.3. The 'Item Editor' Tab
The Item Editor tab is more complex than the others, because you'll be able to create the form items
or to edit them by it. The form is dynamically designed, depending on the type of item you intend
to create. In the editing process, all fields except the type are editable. If you e.g. need to change
the type, the way to do it is to delete the current and to generate a new one along with a similar
configuration.
The common fields for all types are the following:
•Type: The popup list containing the types of items intended for the report which
determines the appropriate fields to configure this type of item by selecting the type.
The available types pertaining to this particular tab are the following:
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•Agents
•Modules
•Agent Detailed View
•Alert Report Agent
•Alert Report Module
•Avg. Value
•Custom Graph
•Event Report Agent
•Event Report Module
•Import text from URL
•MTBF
•MTTR
•Max. Value
•Min. Value
•Monitor Report
•SLA
•SQL query
•Serialized Data
•Simple Graph
•Summary
•TTO
•TTRT
•Text
•Description: The text box intended for a description of the reported item.
Types of Items

32.6.4.3.1.1.

Agents / Modules

It displays a matrix of agents and modules of a specific module group along with its associated
states.
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32.6.4.3.1.2.

The Alert Report Agent

It displays a list containing the agent's fired alerts of a specified report group within a predefined
period.

The fields within this form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
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Within the HTML version of the report, an item of this type is generated as you can see below.

32.6.4.3.1.3.

The Alert Report Module

It displays a list containing the module's fired alerts within a predefined period intended for the
report.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: The intelligent control to select the appropriate agent for this item.
•Module: A list which is dynamically loaded by the agent's modules selected in the control
above.
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32.6.4.3.1.4.

Avg. Value

It's the average value for a module within a predefined period. This period is calculated in the
moment of visualizing the report. Within the configuration menu, the fields for the source agent are
added, where the agent and modules are selected. Subsequently, the module's average value is
shown.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: The intelligent control to select the appropriate agent for this item.
•Module: A list which is dynamically loaded by the agent's modules selected in the control
above.
Within the HTML version of the report, an item of this type is generated as you can see below.

32.6.4.3.1.5.

The Custom Graph

It's a userdefined combined graph. A field is added with a combo to select the graph we intend to
add.
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The fields within this form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Custom Graph: A deployable list containing the userdefined graphs. In order to create
theses
graphs,
please
click
on
'Administration'
>
'Manage
Reports'
and 'Graph Builder'.
Within the HTML version of the report, an item of this type is generated as you can see below.
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32.6.4.3.1.6.

The Event Report Agent

It displays a list containing the events which occurred within the agents in the predefined time
frame.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: The intelligent control to select the appropriate agent for this item.
Within the HTML version of the report, an item of this type is generated as you can see below.

32.6.4.3.1.7.

The Event Report Group

It displays a list containing the events which occurred in the report group's agents within a
predefined time frame.
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The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Group: A combo intended to select the group.
Within the HTML version of the report, an item of this type is generated as you can see below.
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32.6.4.3.1.8.

The Event Report Module

It displays a list containing the events occurred within an agent's module in the report of a
predefined time frame.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control to select the appropriate agent for this item.
•Module: A deployable list that is dynamically loaded with the agent's modules selected in
the control above.
32.6.4.3.1.9.

Exceptions

The picture below shows values of several modules which meet the conditions of a logical operator
(e.g. 'greater than', 'less', 'OK' or 'Not OK'). They're able to be arranged in an ascending or
descending way or by the agent's name within a predefined time frame.

32.6.4.3.1.10.

General

It displays the values of several modules, arranged in an ascending or descending way, by the
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agent's name and / or grouped by agent.

Please keep in mind that if a module extends its range over its lifetime, the accounts
might display an incorrect sum.

32.6.4.3.1.11.

The Group Report

It displays a table containing the below mentioned information of a predefined group:
•Agents
•The total number of agents
•The number of agents holding an 'unknown' status
•Modules
•The total number of modules
•The number of modules holding a 'normal' status
•The number of modules holding a 'critical' status
•The number of modules holding a 'warning' status
•The number of modules holding an 'unknown' status
•The number of modules holding a 'not initiated' status
•Alerts
•The number of defined alerts
•The number of fired alerts
•Events
•The number of this group's events within the last 8 hours.
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The fields pertaining to this particular form are the following:
•Group: A combo intended to select the group.
Within the HTML version of the report, an item of this type is generated as you can see below.

32.6.4.3.1.12.

Importing Text from an URL

This item shows the text extracted from an external server to which the Pandora FMS Console has
access to. In the HTML report format, it's important to keep in mind that it's going to display the
text like it really is, but in the PDF version of the report, it's only going to show the text in a plain
text format.
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The fields pertaining to this particular form are the following:
•URL: The text field intended to insert the external server address in order to extract the
text.
32.6.4.3.1.13.

Inventory

This item is contained in the Enterprise version of Pandora FMS. It displays the selected inventory
of one or various hosts pertaining to a specific date or its last known data.

The fields pertaining to this particular form are the following:
•Description: A text field intended for the item's description.
•Group: A combo which filters the agents appearing within the next field. It doesn't appear
in the report, it's only a form tool.
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•Agents: The agents of the hosts in which the inventory will be gathered. Only the agents
which contain inventory modules are going to appear in this field.
•Modules: The common inventory modules of the selected agents.
•Date: The date of the displayed data. If the youngest date is selected here, only the latest
inventory data of the selected modules will be gathered.
32.6.4.3.1.14.

Inventory Changes

This item displays the changes of the inventory registered in one of various hosts within a
predefined time frame.

The fields pertaining to this particular form are the following:
•Description: A text field intended for the item's description.
•Period: A field to determine the interval for registering the changes.
•Group: A combo which filters the agents which appear within the next field. It doesn't
appear in the report, it's only a form tool.
•Agents: The agents of the hosts in which the inventory will be gathered. Only the agents
containing inventory modules are going to appear within this field.
•Modules: The common inventory modules of the selected agents.

The data for this item is solely provided by inventory changing events. If they have a too
large number of them, you may delete some of those events manually to reduce them.
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32.6.4.3.1.15.

MTBF

MTBF = Mean Time Between Failures
•It's calculated in the following way: MTBF = TTO / #F
• where:
TTO = The total time for operation within the period
#F = The total number of failures
•It provides the average time of regular operation between failures.
•It's reliability indicator.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A deployable list which is dynamically loaded by the agent's modules selected in
the control above.
32.6.4.3.1.16.

MTTR

MTTR is the mean time to restore the performance of one system, machine, line or process after a
functional failure.
•It includes time to analyze and diagnose the failure, the time to get refurbished, the time
for planning, etc.
•It's a measuring of a system's performance.
•It's the time interval divided by the total time of reparations and the total number of
failures within a system.
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The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module:A deployable list which is dynamically loaded by the agent's modules selected in
the control above.
32.6.4.3.1.17.

Max. Value

It's the maximum value of a module within a predefined period. This period is calculated in the
moment of the report's viewing.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
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is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A deployable list which is dynamically loaded by the agent's modules selected in
the control above.
Within the HTML version of the report, an item of this type is generated as you can see below.

32.6.4.3.1.18.

Min. Value

It's the minimum value of a module within a predefined period. This period is calculated in the
moment of the report's viewing.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A deployable list which is dynamically loaded by the agent's modules selected in
the control above.
Within the HTML version of the report, an item of this type is generated as you can see below.
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32.6.4.3.1.19.

Monitor Report

It shows the percentage of time a module has been right or wrong within a predefined period.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A deployable list which is dynamically loaded by the agent's modules selected in
the control above.
Within the HTML version of the report, an item of this type is generated as you can see below.

789

Custom reports

32.6.4.3.1.20.

SLA

It allows you to measure the SLA (Service Level Agreement) of any monitor of Pandora FMS.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
This form is more complex than others, and alongside the common fields of other items, it features
a list of the module's sub items to calculate the SLA by the following columns:
•Agent: A combo box intended to select the agent to use in the SLA.
•Module: A combo box intended to select the module to use in the SLA.
•SLA min (value): A field intended to determine the SLA's minimum value. The minimum
values are going to trigger the SLA.
•SLA max (value): A field intended to determine the SLA's maximum value. The maximum
values are also going to trigger the SLA.
•SLA Limit (%): A field intended to set the time percentage which is going to trigger the
SLA. If the module has been within the minimum and maximum limit values during this
particular time percentage, the SLA will be shown as right and as wrong if not.
It's also possible to add new modules to the SLA to create combined moduleSLAs from the same or
different systems.

In case of combined SLAs, the SLA performance is going to depend heavily on the
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performance of all the SLAs configured so far.

32.6.4.3.1.21.

Monthly SLA

This feature is only available to Enterprise Versions of Pandora FMS. It's a variation of
the SLA feature. Instead of measuring the service level periodically, it's going to conduct it on every
day of the months contained in this period.
Examples:
•In a report of the May 5, it's going to calculate the SLA of every day in May.
•In a report between February 13 and April 4, it's going to calculate the SLA of every day in
February, March and April.
Each module on each month is going to contain the same data of a standard SLA, except that its
compliance won't be the month's level. It will be the percentage of days that accomplish it. There is
also a bar that's going to display all days of the month by the following color code:
•Green: The SLA was accomplished.
•Red: The SLA wasn't accomplished.
•Gray: Unknown. There is insufficient data on this day.

The unknown days aren't going to be taken into account for the percentage of days
which accomplished the SLA.

If there are days which don't accomplish the SLA they will be put in a summary table.
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On the picture above, we observe a monthly SLA for two modules. The first one passes 100% of the
days with data, and the second one doesn't in 3 out of 22 days. That gives us an accomplishment of
86.36%. For day 23 there is no data, because it's the current date. These days are not going to affect
the calculations.
32.6.4.3.1.22.

SQL Query

This item displays the report's data from the Pandora FMS Database in form of tables. It's a
customized data report, containing data extracted directly from the DB.
There are two ways of describing the SQL query:
•One handwritten within the text box:
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•The other selected by the Custom SQL template drop down, which can only be easily edited
by the Enterprise Version of Pandora FMS.

The fields pertaining to this particular form are the following:
•Query SQL: A text box intended to insert the SQL query to extract the data from the
Pandora FMS Database.
•Serialized Header: A text field intended to define the table headers which are going to be
shown in the report, separated by the '|' (pipe) character. Each column is going to be shown
as a result within the SQL query.
•Custom SQL Template: A dropdown list which contains the SQL templates of stored
queries for its management. These could be managed by clicking on 'Administration' >
'Custom SQL' and 'Manage Reports'.
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Due to certain security restrictions, you're not allowed to use the following words and
tokens: '*', 'delete', 'drop', 'alter', 'modify', 'union', 'password', 'pass', 'insert' and 'update'.

32.6.4.3.1.23.

SQL Graphs

This type of reporting allows you to define your own graphs to be used in reports. That graphs will
be created by using your own SQL code. This code should always return a variable called 'label' and
another one called 'value'. This is an SQL example used to create graphs:
SELECT tagente.nombre AS label, datos AS value FROM tagente, tagente_estado, tagente_modulo
WHERE tagente_estado.id_agente_modulo = tagente_modulo.id_agente_modulo AND
tagente_modulo.nombre = "module_1" AND
tagente_modulo.id_agente = tagente.id_agente

This is a sample on how to define the graph. It's pretty similar to the SQL query report but it doesn't
use headers and requires the SQL code only.

These are a few samples of the three different graphs you're able to draw by Pandora FMS: Pie
charts, vertical bars and horizontal bars. They're utilizing different UTF encodings within their
description (e.g. western Latin, Japanese and Arabic) just to demonstrate the powerful true multi
language UTF support of Pandora FMS (which is also used for creating the PDF reports).
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Due to certain security restrictions, you're not allowed to use the following words and
tokens: '*', 'delete', 'drop', 'alter', 'modify', 'union', 'password', 'pass', 'insert' and 'update'.
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These types of items are required to be used with caution because they have the
potential to overload Pandora FMS.

32.6.4.3.1.24.

Simple Baseline Graph

By this type of graph, you're able to display future estimation values for the selected module. Let's
assume for a moment you e.g. select a period of a week and today would be Tuesday, this particular
graph provides real data from Monday through Tuesday and estimation values for all other days
within the selected week.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A dropdown list which is dynamically loaded by the agent's modules selected in
the control above.
Within the HTML version of the report, an item of this type is generated as you can see below.
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This type of graph has the potential to overload Pandora FMS if you're utilizing too
much data to generate future estimations.

32.6.4.3.1.25.

Serializing Data

It displays an item in the table format report from the data stored within the table named
'tagente_datos_stringin' the Pandora FMS Database. For it, the agent should serialize the data
separating them with a lineseparating character and another which separates the fields. All lines
should contain all fields. This type of item is e.g. used for the agent which is designed to extract
management data from the SAP Platform.

The fields pertaining to this particular form are the following:
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•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A dropdown list which is dynamically loaded by the agent's modules selected in
the control above.
•Serialized Header: A text field intended to define the table headers which are going to be
shown in the report, separated by the '|' (pipe) character. Each column is going to be shown
as a result within the SQL query.
•Field Separator: A separator intended for different fields within the serialized text chain.
•Line Separator: A separator intended for different lines (composed by fields) of the
serialized text chain.
32.6.4.3.1.26.

Simple Graph

It displays one simple module graph.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A dropdown list which is dynamically loaded by the agent's modules selected in
the control above.
Within the HTML version of the report, an item of this type is generated as you can see below.
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32.6.4.3.1.27.

Summatory

It displays a summation of a single module's values within a specific time frame.

•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A dropdown list which is dynamically loaded by the agent's modules selected in
the control above.
Within the HTML version of the report, an item of this type is generated as you can see below.
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32.6.4.3.1.28.

TTO

It's the Total Time of Operation, which is defined as the overall time in which the monitor has been
within the 'OK' range.

The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A dropdown list which is dynamically loaded by the agent's modules selected in
the control above.
32.6.4.3.1.29.

TTRT

Is the the overall time in which the monitor has not been within the 'OK' range.
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The fields pertaining to this particular form are the following:
•Period: The time frame it takes to get back to the temporary point within which the report
is generated.
•Agent: An intelligent control for selecting the appropriate agent for this item.
•Module: A dropdown list which is dynamically loaded by the agent's modules selected in
the control above.
32.6.4.3.1.30.

Text

This item displays a formatted text within the reports to add e.g. more information of the company
to the report.
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The field pertaining to this particular form is the following:
•Text: A text box intended to format the text and to add links and images from a remote
server.
An example of the window in which the link is added is shown below.

An example of the window in which the image is added is shown below.
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32.6.4.3.1.31.

Top N

It displays N values discriminated by maximum, minimum or the average of the selected modules,
ordered ascending, descending or by the agent's name.

32.6.4.3.1.32.

Projection Graph

This type of graph is going to project a future estimation of the module's data. This estimation is
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based on Linear Regression and is implemented by means of the Least Squares Method.

In order to configure this graph, you're required to provide the following information:

•Period: The relevant time frame for the estimation.
•Projection Period: The relevant time frame in the future for which the module data is
going to be used to create the projection.
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32.6.4.3.1.33.

Prediction Date

This type of item returns a date in the future in which a module reaches its interval. It utilizes
the Least Squares Method like the projection graph.

In order to configure this item, you're required to provide the information shown below.
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•Period: The relevant time frame for estimation creation.
•Data Range: The interval the module requires to return the associated date.
Example: Just assume for a moment you would have taken the module named 'FreeDisk_SpoolDir',
picked '15 days' as a time frame and searched for the date on which the module would reach its
interval [32000]. The result would have been '03 Nov 2013 19:07:18'. Please take a look on the
picture below to get a graphical explanation.

32.6.4.4. The Wizard Tab
This tab is a feature of the Enterprise Version of Pandora FMS. It allows you to automatically
combine several items containing common configurations all at once and by a few clicks which are
getting applied to several agents and modules for a report.
Once the type, the period, the agents and the modules have been selected, all you need to do is to
click on the 'Add' button and it's going to generate as many items as agents or modules have been
selected for the report.
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The fields pertaining to this particular form are the following:
•Type: A deployable list in which you're able to select the type of item that's going to be
massively generated. Not all item types are contained in here, because there are certain item
types which require a more detailed configuration.
The available item types within this form are the following:
•Alert Report Agent
•Alert Report Module
•AVG Module
•Event Report Agent
•Event Report Module
•Monitor Report
•Simple Graph
•Period: An intelligent control to provide the time period or datatime segment to represent
the report item from the moment it's generated. If the time frame is e.g. 'one month' and
you're generating the report in the current moment, the items are going to provide data from
today to one month in the past.
•Agents: The list of agents you're allowed to access according your permission group. On
this list, you may select one or several agents. The modules which are defined as common
for the selected agents are shown within the module control for each selection.
•Modules: This common module list of the selected agents is available for one or several
agents.
•Filter Group: A field intended to filter the agents by group.
•Elements to apply: The list intended for the selected modules to add.
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32.6.4.5. The SLA Wizard Tab
This tab is a feature of the Pandora FMS Enterprise Version and was designed to create an SLA
report by a wizard. It's possible to add modules from different agents easily by it.

32.6.4.6. The Global Tab
This tab is a feature of the Enterprise Version of Pandora FMS and allows us to create 'Exception',
'General' or 'Top N' reports easily by a wizard. You're also able to easily add different modules from
different agents by it.
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32.6.4.7. The Advanced Options Tab
This tab is a feature of the Enterprise Version of Pandora FMS. This tab was designed to make the
reports much more customizable. Among other things, you're now able to select the font the PDF
report is going to be generated with, to select the logo which will be shown in the PDF header, to
edit the header and the PDF footer and the report's front page.
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The fields pertaining to this particular form are the following:
•Font Family: It's a deployable list, containing all the fonts you've installed within your
Pandora Console in the directory '<pandoraconsole>/enterprise/include//mpdf50b/ttfonts'.
The default font is 'Times New Roman'. If you want to make the font range bigger, it's
important to consider that it's required to have read access to the apache group and the fonts
are required to be in TTF format.

If you intend to use Arabic, Chinese, Japanese or another UTF8 text within your PDF,
you're required to utilize a supported TTF font for doing so. We're providing the 'code'
font which actually contains all language characters.

•Custom Logo: It's a deployable list containing all possible logs which could be shown in the
header
of
each
PDF
page.
The
logo
images
are
stored
under
'<pandora_console>/images/custom_logo/'. The default image is 'pandora_logo.jpg'. You're
able to see a preview in conjunction with your form by clicking on it.
•Header: It's a complete editor within which you're able to copy and paste the formatted
text of an application into or to edit it by the 'box' button. This text is going to be the one
shown in the header.
•First Page: Like the header field, this is another complete text editor, intended to create
and to edit the PDF's front cover page.
•Footer: It's the same like the two other fields, but for editing and creating each PDF page's
810

Custom reports

footers.
32.6.4.7.1.1.

Macros

It's also possible to use macros within the first page, the header and footer. The available
implemented macros are the following:
•(_DATETIME_): In the data format configured within the Pandora Console options, this
value is replaced by the date in the moment the report is generated.
•(_REPORT_NAME_): This value is going to be replaced by the report's name.

32.6.4.8. The Preview Tab
This tab displays the report as if it's generated in HTML format to be able to easily review the
results. It's going to display the report exactly as the one you're going to see if you click on
'Operation' and 'View Report' within the menu.

32.6.5. Visualizing a Report
In order to visualize an already created report, please click on 'Operation' > 'Reporting' and
'Custom Reporting'.

Reports can be visualized in HTML, XML, CSV or PDF formats.
In order to see a report in the HTML format, please click on the
icon. Once the report is
opened in HTML, it's possible to select the date and hour it was generated.
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In order to see a report in the XML format, please click on the

In order to see a report in the PDF format, please click on the

icon.

icon.
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32.6.6. Automatic Report Sending by Email
In the Pandora FMS Enterprise Version, this is the extension which allows you to send the reports
generated by email in a scheduled way. The reports are going to be sent in PDF format.
In order to gain access to the extension, please click on 'Operation' > 'Extensions' and 'Cron Jobs'.
In order to add the task of report sending by email, you're required to fill out he following fields:
•Task: Intended to select the option of 'send custom report by email'.
•Scheduled: Intended to select how often the report is going to be sent.
•First Execution: Intended to select the date and hour of the first execution.
•Report Build: Intended to select the report you intend to send.
•Send to Mail: Intended to insert the mail address to send the report to.
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Once you have filled out the appropriate data, please click on 'Create' and the task is going to be
shown within the scheduled tasks.

Once you have created the scheduled task, it's also possible to force its execution by clicking on the
green circle on the right side of the task or to delete it by clicking on the red 'x' on the left.

32.6.6.1. Configuration
This functionality requires an appropriate configuration before it can be put to use. The
configuration is located in the file named '/enterprise/extensions/cron/email_config.php' in the
Pandora console's host and it's empty by default.
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<?php
//Please setup your config to send emails in cron job
$cron_email_from = array('pandora@pandorafms.org' => 'Pandora FMS');
$cron_email_smtpServer = 'mail.artica.es';
$cron_email_smtpPort = 25;
$cron_email_username = 'info@artica.es';
$cron_email_password = ;
?>

The fields pertaining to this particular form are the following:
•From: Intended for the contact's email account. You may mention the name between the
quotes of 'acount.contacto'.
•SMTP Server: It's the field intended to insert the SMTP server's URL.
•Username: It's the filed intended for the connection's user name.
•Password: It's the field intended for the connection's password.
This is an example configuration file:
<?php
//Please setup your config to send emails in cron job
$cron_email_from = array('bot_report@company.cat' => 'Bot report');
$cron_email_smtpServer = 'mail.company.cat';
$cron_email_smtpPort = 25;
$cron_email_username = 'bot_report@company.cat';
$cron_email_password = 'opensesamo';
?>

Please keep in mind that anybody who has access to a host with a Pandora FMS Console
on it is able to view this file's content. It's recommended not to mention your personal
email account, but to create an additional one, intended for use in conjunction with this
task instead.

32.7. Report Templates
(Available to all Pandora FMS Enterprise Version 5 and above.)
Report templates are components which allow you to parametrize the report's creation. It also
allows you to apply them onto a set of agents and to easily create a lot of reports.

32.7.1. Introduction
The report templates are components which allow you to parametrize the report creation that could
be applied onto a group of agents and to quickly and easily create a big number of reports. Each
element of the templates is going to match to an agent or module by a regular expression or
substring, rendering this system very flexible.
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As you can see on the previous image, a report template will be created, containing elements or
items. Each one of them is going to generate one or more report items. If they're applied, they fit to
some agents or modules of the ones selected within that application.
The type of template items will be almost all the ones that are available within the reports, e.g.
'average value', 'SLA', 'agent events', etc.
Now we're going to describe three examples of template items.

32.7.2. Examples
In order to access the template's administration menu, please click on 'Operation' > 'Reporting' >
'Custom Reporting' and click on the 'list templates' button:

This template examples are containing three template items mentioned below:
•An automated combined graph which allows you to create graphs on the modules which
coincide within the application.
•A 'Top N' report.
•An agent event report.
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32.7.3. Example 1: The Automated Combined Graph
This element is going to generate graphs to display the incoming network traffic of the selected
agents. In order to do this, it's going to create combined graphs for each agent which holds a
module name like "Network Traffic (Incoming)" and "Network Traffic (Outgoing)". Besides creating
combined graphs, it's going to add them to the generated report.

Within this example, we've decided to select a form to control the target modules. It's also possible
to select the modules by using a regular expression, filling out the field 'Modules to match (Free
text)'. For example, the regular expression .*cpu.* would be applied on modules like e.g. 'cpu_user',
'total_cpu_usage', 'cpu', etc.
Another important control for this type of template item is 'Create a graph for each agent' which
allows the creation of a combined graph for each agent or to create a combined graph for all the
agents an modules that coincide once it has been selected.
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32.7.4. Example 2: Top N
This item is going to generate a report of the 'Top N' type, showing the most demanded 5 CPUs of
the last day. This item applies to all agents with modules which contain the literal "CPU User"
element.

As you can see on the image, the modules are not going to be searched literally, but a regular
expression is used here. This performance is selected by clicking on the box next to the agent's name
('exact match'). If you leave it blank, the agent's name is going to match on all agents selected
during the application.

32.7.5. Example 3: Agent Events
This element is going to generate a report of the events generated on the last day for all selected
agents.
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As you can see in the 'Agent' field, the regular expression '.*' has been used. It symbolizes any
alphanumeric string, so it will be applied on any selected agent.

32.7.6. Application
Once the different elements of one template have been created, they should be applied to generate
the report(s) within the 'Template Wizard' tab.

During the application, the report can be selected from the box named 'Create report per agent' in
order to create one report for each agent selected in the application or in case a report containing
all the results would be selected:
•In case one report by agent is generated, the report's title is going to look like this:
[template title]  [agent name] ([agent name])
•In case one report by agent is generated, the title is going to look like this: [report title] 
agents ([number of agents])  [date]
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Once it has been applied on the agents you can see on the image, this template is going generate
the report by the following title: 'Sample template report  agents (3)  October 14, 2013, 04:21
pm'. This report is shown on the picture below.

For the automated combined graph, one item of the 'custom_graph' type was created. This graph
contains two elements for the modules named 'Cache mem free' and 'proctotal'.
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By editing the customized graph, you can see that it contains the two following modules:

For the 'Top N' report, one item is created, containing two sub items (because one of the agents
didn't have a module to select).

By reviewing the render report, you're able to see the top 5 CPUs which carry the biggest load:
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For the agent's event report, three elements are going to be created (please keep in mind that all
elements were selected by the regular expression of '.*'):

32.7.7. Editing the Template
Within the templates you're able to modify the general parameters of the template as shown on the
picture below.
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32.7.8. List of Templates
In order to access the template's list, please click on 'Administration' > 'Manage Reports' > 'Report
Builder' and on the 'List Templates' button:

In this section, you may create new templates, edit existing ones, copy and delete them.

32.7.9. The Items List
In this section, you're able to review, edit, assort and delete items within a report template.
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32.7.10. The Item Editor
This editor was designed to create new items. The item types are the same as in the report section,
but with two differences: The agent's name is a regular expression, e.g. 'oracle_agent[.]*'. It's going
to match to the agent's names 'oracle_agent_1', 'oracle_agent_2', etc. If you leave it blank, this item
is going to be applied onto all selected agents within the The Template Wizard.
The module's name can be filled out by activating the check box named 'Module exact match' or by
a regular expression without activating this particular check box.

32.7.11. Advanced Options
You may edit visual aspects for the results report like fonts, logos, headers, the first page or the
report footer within this section.
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32.7.12. The Template Wizard
In order to apply templates, you're required to pick a template, pick the target agents (by clicking in
the 'tick' icon, you may select all of them), to click on the arrow pointing to the left and clicking on
the 'Apply Template' button. The default approach is to create one report which contains all the
template's items. If you click on the 'Create report per agent' check box, the template application is
going to create one report for any selected agent.
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If an item already contains an agent's name (a regular expression in this case), the template is only
going to be applied over agents whose names match to this regular expression, e.g. if an item has
been filled with the agent's name of 'Contador 1[.]*' the template is only going to be applied onto
the agents 'Contador 1' and 'Contador 10' but not onto the 'Contador 2' agent.

The results can be seen in the list of reports as shown below.

In order to delete all reports created by previous template applications, you may select a template
and click on the broomshaped button as shown below.
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33 THE DASHBOARD
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33.1. Introduction
The Dashboard is a feature of the Enterprise Version of Pandora FMS. It was designed to allow the
users to build their own monitoring pages. It's possible to add more than a page, because you're also
able to add monitoring maps, graphs, etc.
The dashboard's configuration is carried out from the same place in which it's possible to gain
access to it. Please click on 'Operation' > 'Reporting' and 'Dashboard' on the web console's right
side to gain access to it.

If you click on the dashboard, the userconfigured pages are going to be displayed.
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33.2. Creating a Dashboard
The dashboards are all customizable. Each user configures his own dashboard and is only able to
see the ones he has configured for himself.
In order to create a dashboard, please click on 'Operation' > 'Reporting' and 'Dashboards'. All users
have a dashboard named 'default'. Please click on the 'Add Dashboard' menu option as shown below
to create a new one.

Please insert the name you'd like to see within the dashboard's tab in the window which appears in
this moment. Please click on the 'Add' button after you've assigned the visibility group.
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In the moment the new tab has been created, there are two tabs at your disposal: The default tab
and the new one. In order to add objects to the tab, please click on the 'Add Widget' menu option as
shown on the picture below.

In this moment, a new window within which all objects you're able to add to your new tab are
specified.
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33.2.1. Adding Objects to the Dashboard
You're also able to add several different objects to the dashboard. Each of them comes with its own
features.

33.2.1.1. Group Status Report
In order to add a report to the Pandora FMS group's status, please click on the icon shown below.
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By clicking on the icon, the configuration window of the object appears.

Please insert a title, select the groups which are supposed to be contained in the report and click on
the 'Update' button, shown on the picture above. If you click on it, a window like the one shown on
the picture below is going to appear.

You're able to access the corresponding group within the 'Operation' menu by clicking on the
group's name.

33.2.1.2. UserDefined Graphs
Please click on the icon shown on the picture below in order to add a userdefined graph.
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By clicking on the icon, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The title which is going to appear on the graph's top.
•Graph: The combo in which you're able to select the appropriate graph to appear. You're
able to choose among the graphs created by Pandora FMS.
•Period: The combo in which you're able to select the appropriate period for the graph.
•Stacked: The option to select whether you want the different combined graph's values to be
displayed above the other or not.
•Width: The option to select the graph's overall width.
•Height: The option to select the graph's overall height.
If you click on the 'Update' button shown on the picture above, a window like the one below is
going to appear.
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33.2.1.3. The 'Last Events' List
In order to add a list, containing the last events which took place in Pandora FMS, please click on
this icon:

If you click on the icon, the object's configuration window is going to appear.
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Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title to display on the graph's top.
•Event Type: The combo in which you're able to choose among the different existing event
types like 'OK', warning', 'critical' etc.
•Interval: The combo in which you're able to define the time interval you intend to use.
•Limit: The combo in which you're able to define the maximum number of events to appear.
•Event Status: The combo in which you're able to choose the event's state, e.g. 'validated',
'without validation' or all of them.
•Groups: The option to select the group from which the events are going to be shown.
If you click on the 'Update' button shown on the picture above, an event window like the one below
is going to appear.
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If you click on the agent's name, you're accessing the agent's configuration window.

33.2.1.4. State of the System
In order to add a report which contains the state of the Pandora FMS monitors, please click on the
icon shown on the picture below.

If you click on the above icon, the 'Global Health' window is going to appear.
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33.2.1.5. The Pandora FMS Welcome Message
In order to add the Pandora FMS welcome message, please click on the following icon:

If you click on the above shown icon, the object containing the welcome message is going to
appear.
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33.2.1.6. The Agent's Module Graph
In order to add a graph to one of the Pandora FMS agent modules, please click on this icon:

If you click on the icon, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title that's going to appear on the graph's top.
•Group: The combo to select the group the agent belongs to.
•Agent: The combo to select the agent.
•Module: The combo to select the module.
•Period: The combo to select the appropriate time period for the graph to show.
If you click on the 'Update' button, you're going to see a window like the one shown below.
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33.2.1.7. The Visual Maps Report
In order to add a report containing Pandora FMS visual maps, please click on the following icon:

If you click on the icon, the object's configuration window is going to appear as shown below.

Please insert the title, select the appropriate visual console's maps, supposed to be contained in the
report and click on 'Update'. If you do, a window like the one shown below is going to appear.
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If you click on the map's name, you're accessing the map within the visual console.

33.2.1.8. The Network Map
In order to add a Pandora FMS Network Map, please click on the icon shown below.

If you click on the icon shown above, the object's configuration window is going to appear.
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Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going appear on the map's top.
•Group: The combo to select the agent's group to appear on the map.
•Layout: The combo to select the location of the agents, depending on the map's type.
•No Overlap: If selected, the agents aren't going to be displayed in an overlapping manner.
•Simple: If selected, the agents are going to appear without any icons.
•Font Size: The combo intended to select the font's size used to display the agent's names.
If you click on the 'Update' button, a window the one shown below is going to appear.

33.2.1.9. The Visual Console's Map
Please click on the icon shown below in order to add a map from the Pandora FMS Visual Console.
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If you click on the icon above, the object's configuration window is going to appear.

Please insert an appropriate title and select the map which is supposed to appear within the object
from a combo.
If you click on the 'Update' button, a window like the one shown below is going to appear.
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Before you're able to put them to any use, all maps are required to be created by clicking
on 'Administration' -> 'Reporting' and 'Visual Console'.

33.2.1.10. Displaying URL Content
In order to display URL content under Pandora FMS, please click on the icon which is shown on the
picture below.

If you click on the icon, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the widget's top.
•URL: The combo in which you're able to select the font's size to for the agent's names.
•Height: The height of the widget in pixels. Please insert '0' for an automatic determination.
If you click on the 'Update' button, a window like the one shown below is going to appear.
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33.2.1.11. The Tactical View
In order to add a tactical view of Pandora FMS, please click on the icon shown below.

If you click on the icon, the object's configuration window is going to appear.
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Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the widget's top.
•Status and Monitor Checks: It provides general information on the modules.
•Server Performance: It provides a summary of server statistics.
•Summary:: It provides summary information about agents and modules.
If you click on the 'Update' button, a window like the one shown below is going to appear.
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33.2.1.12. Panel with a Message
In order to add a panel which contains a message under Pandora FMS, please click on the icon
shown below.
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If you click on the icon above, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the widget's top.
•Text: A freetext field containing the message itself.
If you click on the 'Update' button, a window like the one below is going to appear.

33.2.1.13. UserDefined Reports
In order to add user defined reports under Pandora FMS, please click on the icon shown below.
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If you click on the icon above, the object's configuration window is going to appear.

Within the configuration window, you have the following configurable parameters at your disposal:
•Title: The option to determine the title which is going to appear on the report's top.
•Report: The field for the report's name which is going to contain the widget.
If you click on the 'Update' button, a window like the one shown below is going to appear.

33.2.2. Putting Objects onto the Dashboard
By clicking on the dashboard's objects, it's possible to drag and drop them anywhere.

33.2.3. Editing Objects on the Dashboard
In order to edit the configuration parameters of a dashboard object, please click on the gearwheel
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shaped configuration icon on the upper right side of the object you intend to edit as shown below.

Once you have clicked on the icon, the object's configuration menu is going to appear. Please
modify it and click on the 'Update' button to save your changes.

33.2.4. Deleting Objects from the Dashboard
In order to delete an object's configuration parameters from the Dashboard, please click on the trash
icon on the upper right side of the object you intend to delete.
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33.3. Editing a Dashboard
You may edit the dashboard's name and group. In order to update an already existing dashboard,
please click on the 'Dashboard Options' and 'Update Dashboard' options.

Please click on the 'Update Dashboard' option as shown above.

33.4. Deleting a Dashboard
In order to delete a dashboard, please click on the triangleshaped icon, which is located on the tab
you intend to delete. It's also going to display the 'Update Dashboard' and 'Delete Dashboard'
options.

Please click on the 'Delete Dashboard' option.
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34 THE PANDORA GIS

854

The Pandora GIS

From Pandora FMS versions 3.1 and above, Pandora FMS supports the processing of positional
information and interactive maps to display the agent's positions. This is a feature of the open
source version and intended for UNIX Agents only.

34.1. Setup
34.1.1. The Agent's Configuration
The agent now accepts new parameters to send the positional data. In the 'agent.conf', there some
new parameters for longitude, latitude, altitude and position description now. Other parameters for
an alternative way to obtain the coordinates are located in the file named 'gis_exec' now. This
parameter has a script path which is going to return a string, containing the coordinates in the
format of '[latitude],[longitude],[altitude]'.
This is an example:
# Agent position parameters
# Those parameters define the agent's geographical position.
# gis_exec: Calls a script that returns a string with '[latitude],[longitude],[altitude]'
# i.e.: 41.377,-5.105,2.365
#gis_exec /tmp/gis.sh
# latitude
latitude 42.70456
# longitude
longitude -3.897187
# altitude
altitude 600
# Position description
position_description Madrid, centro

34.1.2. The Server's Configuration
The GIS features are also required to be enabled on the server. There is a new flag called
'activate_gis' for this. If this flag is set to '1', the server is going to process all GIS information it
receives from the agents.
There is also the new feature of storing agent positions on Pandora FMS by positional data now.
This data is coming from a source without high accuracy. It's possible to store a lot of different
points very close to each other without an important difference on the position. To avoid this
circumstance, the 'location_error' parameter determines the distance which is considered to be the
same location. This is an error threshold on the position and all data received from an agent having
a position within the distance (in meters) defined within this parameter will be stored as new data
received on the same point, until the received position moves out of the defined error distance
which triggers the setting of a new location.
Recon Server and positional Information:
By using a reverse geolocation algorithm and a database, containing the relation of IPs and
positional information, the Recon Server is now able to 'guess' the position of the discovered agents.
It's able to use a file inMaxMind GeoIP GeoLiteCity format or a couple of tables on the database
containing this particular information.
There is also an entire tree of new parameters which define this particular behavior of the Recon
Server, called the 'recon_reverse_geolocation_mode' (accepted modes are 'disabled', 'file' or 'sql').
The 'recon_reverse_geolocation_file' is only used to point to the file which contains the reverse
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geolocation information by using the 'MaxMind GPL GeoLiteCity.dat' format if the mode is set to
'file'. The last parameter is called 'recon_location_scatter_radius' which is used to place the
discovered agents randomly around the point defined by the reverse geolocation algorithm and
within the range (in meters) defined by the 'recon_location_scatter_radius' parameter.
You're also able to use the reverse geolocation provided by the Google API and OpenStreetMaps.
You may activate Google's reverse geolocation by setting the parameter named
'google_maps_description' to '1'. You may activate OpenStreetMaps reverse geolocation by setting
the parameter 'openstreetmaps_description' to '1'.
Be careful in using this feature, because it considerably decreases the Pandora FMS server's
performance. Please keep in mind that you're required to have a direct connection to the internet to
use Google's API and Openstreet Maps. It also depends heavily on service provider's availability.
Configuration Example:
# Flag to activate GIS (positional information for agents and maps). It's deactivated by default.
activate_gis 1
# Radius of the Error in meters to consider two GIS locations as the same location.
location_error 10
# Recon reverse geolocation mode (available modes are 'disabled', 'sql', 'file')
#
* disabled: The recon task doesn't try to geolocate the discovered IP.
#
* sql: The recon task tries to query the SQL database to geolocate the discovered IP.
#
* file: The recon task tries to find the geolocation information of the discovered IP
in
#
the file indicated in the 'recon_reverse_geolocation_file' parameter.
recon_reverse_geolocation_mode file
# Recon reverse geolocation file (databases containing the reverse geolocation information
using
# the 'MaxMind GPL GeoLiteCity.dat' format).
recon_reverse_geolocation_file /usr/local/share/GeoIP/GeoLiteCity.dat
# Radius (in meters) of the circle in which the agents will be place randomly when found by a
recon task.
# The center of the cycle is guessed by geolocating the IP.
recon_location_scatter_radius 1000
# This enables real time reverse geocoding using the Google Maps public API.
# This requires internet access and could have performance penalties because of having to
process GIS
# information due the connection required to resolve all GIS input.
google_maps_description 1
# This enables real time reverse geocoding using OpenStreetMaps public API.
# This requires internet access and could have performance penalties because of having to
process GIS
# information due the connection required to resolve all GIS input.
# You may alter the code to use a local or your own OpenStreetMaps server.
openstreetmaps_description 1

34.1.3. The Console's Configuration
Within the Console, the configuration must be activated in the main setup in order to utilize the GIS
features.
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Because of the activation, the following new sections of the user interface are available now:

34.1.3.1. GIS Connections
Within the admin setup, the first step is to define the connections which can be used to connect to
the map servers in order to provide maps for the GIS features.

The connection comes with several basic parameters:
•A name for the configuration, so it can be recognized when selecting a connection on the
map definition screen.
•The group that owns the connection. This is going to be used to filter the connections
available on the map builder, depending on the ACLs.
•The number of zoom levels defined on the map.
•The default zoom level, recommended for the map (this can be redefined on the map) and
it's the zoom level used when the map is open.
Once the basic parameters are set, the administrator is required to select a connection type.
Depending on the type there will be different options, and so are the types of connections and their
options.
Open Street Maps

The default installation of Pandora FMS comes with a predefined connection
with OpenStreetMaps so the users are able to directly see and test the GIS features. Usually the
Pandora FMS server's location is a place without direct access to the Internet or the user would
prefer to use it's own map server to have more flexibility, to be faster or to define it's own kind of
tiles. Please check the topic namedPandora:Current_development:Pandora_GIS_Backend for a
possible way to achieve this.
In order to use an Open Street Maps type of map, the only parameter required is the URL of the tile
server as shown on the image below.
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This can be something like:
http://tiles.example.com/${z}/${x}/${y}.png

Google Maps

Pandora FMS also supports the connection to Google Maps. A valid key for the Pandora FMS
Console Server must be obtained from Google (see Google Maps API Policy) and placed in the
corresponding field of the connection definition.

By this key, it's possible to define several connections by using different types of base maps, e.g.
'hybrid', 'physical' or 'satellite'.
Static Image

Another type of supported connection is to utilize a static image as a map. In order to use this type
of map, the image is required to be on a EPSG:4326 projection.
In this case, the parameters required for the map's definition are the URL of the image, the image's
height and width and the positional limits ('longitude' and 'latitude') of the image's sides ('right',
'left', 'top' and 'bottom').

The Map's Center and Default Position
The last thing to define for a map connection is the map's center and the default position for agents
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without any positional data. In order to define them, it's possible to preview the map and click on
the map to set this parameters, depending on which parameter is selected by the 'Change in the
Map' selector.
Within this preview map, it's possible to move the map around by using the green arrows on the top
left, to change the zoom level with the '+' and '' icons or to use the 'magnifier' to use the full zoom.
It's also possible to set the position by inserting the values into the corresponding input boxes.

Once all connection parameters are set, it's possible to save the connection in order to use it on the
map builder by clicking on the 'Save' button.

34.1.3.2. The GIS Map Builder
Once the connections are defined, they may be used to define the maps within the 'GIS Maps
Builder'.
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The menu takes the user to a screen which contains the defined maps. In there it's possible to edit a
map by clicking on its name, to view the map by clicking on the 'View' icon, to determine the
default map by the radio buttons or to delete maps by using the 'Delete' icon. There is also a button
to create new maps.

The Administrator is required to establish a default map which is going to be used for
the agent's view in order to display the agent's position.

Creating a GIS Map

Once on the map's creation page, the first thing to do is to allocate a map name and to add a map
connection from the available ones. It's possible to add more than one, which are going to be
available later on as base layers. This means that only one can be active at a time. When the
connection is selected or if the default connection for the map is changed, the Pandora FMS Console
asks if you intend to use the default data from the connection for the map. If the answer is 'Accept',
the console is going to insert or update all positional data ('center longitude', 'center latitude',
'center altitude', 'default longitude', 'default latitude' and 'default altitude') from the ones defined
within the connection. The user is only required to set the default zoom level. If the answer is e.g.
'Cancel', no changes will be made within those fields and merely the connection is added.
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The Layer's Definition

Once the basic map parameters are set, it's time to define the map's layers used to select which
elements are shown on the map, except if it's the default map  on which you have no need to
define any layer, because it's going to be used to display the agent's position in the agent view.
Each map has one or more layers to display the agents. Each layer was designed to display the
agents of a group and a list of agents. In this way, it's easy to define the agents shown on each layer.
The layers can be defined as 'visible' or 'hidden'. Please select the group by the selector or add
agents by the box. Once the layer is defined, it will be moved to the left column of defined layers, in
which it's possible to arrange, delete or edit them again. The layer is not going to be entirely saved
until the whole map is.
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Once the definition of the layers of the map is completed, it may be saved by clicking on the 'Save
Map' button. The 'Update Map' button is only going to be displayed in case of editing any map.

34.2. Operation
Once there is at least one map defined, it's possible to start the operation containing the GIS
features.

34.2.1. The GIS Maps
The GIS Maps menu is going to display all defined maps. Each link leads to one of the maps which
will be opened by using the parameters defined within the 'GIS Maps Builder'.
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34.2.1.1. Moving around on the Map
The controls for the map include four green arrows on the top left corner which allow to move
around on the map. The '+' and '' icons are intended to increase and decrease the zoom level.
There is also a 'zoom bar', designed to directly select the favored zoom level.
It's also possible to move around by dragging the map to its favored position.
The agents shown on the map are able to be clicked on in order to display more information about
the agent. Once the bubble containing the extra info is displayed, the agent's name consists of a link
to the agent's view. If you intend to close the bubble, please click on the red box with a cross.
There is also a special systemdefined layer called 'Hierarchy of Agents'. If this layer is visible, it's
going to display some red dashed lines, connecting an agent to its parent element if both of them
are visible.

34.2.1.2. Hide, Show and Select Layers
The white '+' icon on the green background on the right is going to open the layer's controls. If you
click on it, it's going to display a green box in which it's possible to select the base layer (it's the
connection to the map's server, if more than one are defined for the map) and to determine which
layers are visible.

34.2.1.3. Filters
There are the following five buttons to filter the agents shown by their state on the map's top:
•The green button is going to display all agents in 'OK' state.
•The gray button is going to display all agents in 'unknown' state.
•The yellow button is going to display all agents in 'warning' state.
•The red button is going to display all agents in 'critical' state.
•The All button is going to display all agents, defined by their layers without taking their
states into account.

34.2.1.4. Map Refresh
Next to the filter buttons, there is a combo box named 'Refresh' to select the update rate for the
map. The map utilizes [AJAX Calls] to refresh the agents on the map by using the defined period.

34.2.1.5. Map Edit and Full Screen
The last three buttons on the map's top right is a link to the Public Visual Console, a GIS Map
Builder link, intended for editing the map and a fullscreen button to see the map in fullscreen
mode.
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34.2.2. The Agent View
The Pandora FMS console's agent view also comes with new GIS features.
The main view now displays the longitude, latitude and altitude values of the agent.

34.2.2.1. The Historical GIS View
There is a new button on the top bar in order to display the agent's GIS view (if GIS is activated).
This view displays the agent's current position on the default map. It contains a table which displays
the history of the agent's previous positions and a path of them on the map.
Each position on the map is represented by a dot, except the current one which is represented by
the agent's or group's icon if the agent doesn't have one. It's possible to click on any of these dots in
order to obtain positionrelated information. It's also possible to click on the agent's icon in order to
display the agent's current information. For Android devices, the path reported by the Pandora FMS
agent is shown on the picture below.
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You're also able to display a table which contains all the agent's reported information, including a
reverse geolocation system which was designed to display the agent's address including the street,
city and country in which the Pandora FMS agent is located.
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34.2.3. The Agent's GIS Setup
Among the agent's administration tabs, there is a new tag to manually set the agent's position. The
'agent manage' tab also has some parameters which are going to affect the GIS features.

34.2.3.1. Ignoring GIS Data
On the 'agent manage' tab, there is a new switch called 'Ignore GIS data'. If this switch is activated,
the server is going to ignore all positional information received from the agent and uses the last
valid values for it. This is useful in case an agent is reporting a wrong position or it's desired to
place it on a fixed place.
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34.2.3.2. Manual Position of the Agent
The 'GIS Data' view displays the default map on which it's possible to click on the agent in order to
determine the agent's new position. It's also possible to determine the position by using the input
boxes below the map.

Defining the agent's position is going to activate the 'Ignore GIS Data' switch in order
to avoid the agent's next positional information data package to reset the agent's position
again. If this is not the desired behavior, we recommend to deactivate the 'Ignore GIS
Data' switch before clicking on the 'Update' button.

34.3. Useful Links
This is a collection of interesting links which are quite useful if you intend to implement your own
tile server and expand the current code's features.

34.3.1. OpenLayers
•Wikipedia page about OpenLayers
•Openlayer documentation made by using Natural Docs Openlayers Documentation
•More information about Openlayers Official documentation about styles
•Help with OpenLayer styles: OpenLayers Styles
•Debugging by Firebug OpenLayers Debug
Mapnik
•Mapnik setup by OpenStreetMap
•Rendering by Mapnik
•Ubuntu Installation
OpenStreetMap
•Some examples of OpenLayers
•Make your first map OpenStreetMap + osm2pgsql + PostGIS + Mapnik
•Using OpenStreetMap
•Tiles download OSM
•Osm2qgsql
OS Geo
•The Open Source Geospatial Foundation
Geo Server
•Main website geoserver.org
•Stable version
PostgreSQL
•Documentation for GIS extensions for PostgreSQL 8.1
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35 The Management of Pandora
FMS
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35.1. Introduction
Several topics regarding the daily management of Pandora FMS such as group administration, user
creation, etc. are discussed in this chapter.

35.2. Profiles, Users, Groups and ACLs
Pandora FMS is a networkmanagement tool which allows multiple users to work with different
permissions in multiple defined agent groups. Before adding new users, groups and profiles (as well
as the data visibility we intend for each user) are required to be well defined.

35.2.1. Profiles in Pandora FMS
The permissions a user can have are defined within profiles. You're able to manage any profile by
clicking on 'Administration' > 'Manage Users' and 'Manage Profiles'.

The following list defines what ACL control allows in each feature on the console:

Feature

ACL Control

View the agent's data (all tabs)

AR

Tactical View

AR

Network-map view

AR

Group View

AR

Visual console editing

RW

Creating reports

RW

Creating user-defined graphs

RW

Viewing reports, visual maps and custom graphs

RR
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Applying report templates

RR

Creating report templates

RM

Creating incidents

IW

Reading incidents

IR

Deleting incidents

IW

Becoming the owner of another user's incidents

IM

Deleting another user's incidents

IM

Viewing events

ER

Validating and commenting events

EW

Deleting events

EM

Executing responses

EW

Creating incidents from events (response)

EW&IW

Managing responses

PM

Managing filters

EW

Customizing event columns

PM

Changing owners / reopen event

EM

Viewing users

AR

SNMP Console viewing

AR

Validating traps

IW

Messages

IW

Cron jobs

PM

Tree view

AR

Update Manager (operation and administration)

PM

Extension Module Group

AR

Agent Management

AW

Remote Agent Configuration Management

AW

Assigning alerts to agents

LW

Defining, altering and deleting alert templates, actions and
commands

LM

Group Management

PM

Creating inventory modules

PM

Module Management (includes all suboptions)

PM

Massive Management Operations

AW

Creating agents

AW

Duplicating remote configurations

AW
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Downtime Management

AW

Alert Management

LW

User Management

UM

SNMP Console Management (alerts and MIB loading)

PM

Profile Management

PM

Server Management

PM

System Audit

PM

Setup

PM

Database Maintenance

DM

Administrator Extension Menu

PM

Search Bar

AR

Policy Management

AW

Disabling agents / modules / alerts

AD

35.2.1.1. Adding a Profile
In order to add a profile, please click on 'Administration' > 'Manage Users' > 'Manage Profiles' and
click on the 'Create' button.

In order to create a profile, please assign a name to it, pick the permissions it's supposed to have
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and click on the 'Create' button.

35.2.1.2. Editing a Profile
In order to edit a profile, please click on 'Administration' > 'Manage Users' > 'Manage Profiles' and
click on the profile's name you intend to edit.

35.2.1.3. Deleting a Profile
In order to delete a profile, please click on 'Administration' > 'Manage Profiles' and click on the
trash icon on the right side of the profile's name you intend to delete.

35.2.2. Pandora FMS Groups
The accesses are related to the groups which are used to group agents. An user could have different
permissions in each of the groups to which it has access. The agents are only allowed to belong to
one group.

The group 'All' is a special group that cannot be deleted. All the groups are defined as
subgroups of the group 'All'. Any element (e.g. reports, graphs or events) which is
associated to the group 'All' can be viewed and managed by a user which has
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permissions for any group.

In order to define any group, please click on 'Administration' > 'Monitoring' and 'Manage Groups'.

35.2.2.1. Adding a Group
In order to add a group, please click on 'Administration' > 'Monitoring' > 'Manage Groups' and
click on 'Create Group'.
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The fields pertaining to this particular form are the following:
•Name: The group's name
•Icon: The combo box to pick the icon the group is going to have.
•Parent: The combo box to assign another group as parent of the group under creation.
•Alerts: If enabled, the agents belonging to the group will be able to send alerts. If not, they
won't be able to do so.
•Propagate ACL: If enabled, the child groups are going to have the same ACL as this group.
•Custom ID: The groups have an ID in the database. In this field, you're able to input
another customized ID to be used by an external program in an integration, e.g. CMDBs.
•Description: A freetext field for a description.
•Contact: A field intended
'_groupcontact_' macro.

for contact

information

which is accessible by

the

•Other: A field for other information, accessible by the '_group_other_' macro.
•Skin: A field in which you're able to assign a skin for the group.
Once the fields have been filled out, please click on the 'Create' button.

35.2.2.2. Editing a Group
In order to edit a group, please click on 'Administration' > 'Monitoring' > 'Manage Groups' and
click on the group's name you intend to edit or on the keyshaped icon.

874

Profiles, Users, Groups and ACLs

35.2.2.3. Deleting a Group
In order to delete a group, please click on 'Administration' > 'Monitoring' > 'Manage Groups' and
click on the trash icon on the right side of the group's name you intend to delete.

35.2.3. Tags under Pandora FMS (>=5.0)
From Pandora FMS versions 5 and above, the access to modules can be configured by a tags system.
Tags are configured on the system and be assigned to the chosen modules. The user's access can be
limited to modules with certain tags in this way.

The access tags are not meant to replace the group access, they're just meant to
complement it.

In order to manage the tags, please click on 'Administration' > 'Manage Modules' > 'Manage Tags'.
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35.2.3.1. Adding a Tag
In order to add a tag, please click on 'Administration' > 'Manage Modules' > 'Manage Tags' and
click on the 'Create Tag' button.

The fields pertaining to this particular form are the following:
•Name: The tag's name.
•Description: The tag's description.
•URL: The field intended to insert an external link in order to add extra information to the
tag.
•Email: The field intended to insert an email address to be used in case of alerts associated
to the tag.
•Phone:The field intended for a phone number used in alerts associated to the tag.
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Once the form is filled out properly, please click on the 'Create' button.

35.2.3.2. Editing Tag
In order to edit a tag, please click on 'Administration' > 'Manage Modules' > 'Manage Tags' and
click on the tag's name to edit or on the editing icon in the actions column.

35.2.3.3. Deleting a Tag
In order to delete a tag, please click on 'Administration' > 'Manage Modules' > 'Manage Tags' and
click on the trash icon in the actions column.

35.2.4. Users in Pandora FMS
Once the profiles and groups in Pandora FMS have been defined, we suggest to define the users.
In order to manage the users, please click on 'Administration' and 'Manage Users', in which the list
of the defined users is displayed.
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35.2.4.1. Adding a User
In order to add a user, please click on 'Administration' > 'Manage Users' and click on the 'Create
User' button.

The fields pertaining to this particular tab are the following:
•User ID: The ID Identifier the user is going to utilize for login.
•Full Display Name: The field to store the full name.
•First Name: The field to store the person's name.
•Last Name: The field to store the family name.
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•Password: The field to insert the password.
•Password Confirmation: The field to insert the password again for confirmation.
•Global Profile: The field to choose between 'Administrator' or 'Standard User'. An
administrator is going to have absolute permissions for the assigned groups within the
application. A standard user is going to have the permissions defined in its assigned profile.
•Email: The field to store the user's email.
•Phone Number: The field to store the user's phone number.
•Comments: The field to store comments on the user.
•Skin: The field to pick a skin.
•Interactive Charts: The field intended to decide whether to use JavaScript or static PNG
graphs.
•Block size for pagination: The field to determine the block size for pagination.
•Not login: The user for which the 'not login' flag is set is only allowed to access the API.
If the form has been filled out appropriately, please click on the 'Create' button. The newly created
user, an applicable profile and a new section appears in order to define the groups the user is
supposed to have access to.

A user can be granted access to as much groups as you want. Please select a profile and a group and
click on the green '+' symbol.
From Pandora FMS versions 5 and above, it's possible add tags to each userprofilegroup
association in order to limit access to the modules containing these tags. If no tags are assigned at
all, the user is going to have access to all modules of these group's agents.
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In case you intend to remove access to a group, please click on the trash icon on the right side of the
access window to remove it.

35.2.4.2. Editing your own User Settings
If the user has administrator permissions, it's able to modify certain parameters of its configuration
by clicking on 'Operation' > 'Workspace' and 'Edit my User'.
If the user creation form is displayed, everything is editable, except group permissions.
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35.2.4.3. User Editing by the Administrator
In order to completely edit a user (including the permissions and groups part), please click on
'Administration' > 'Manage Users' and click on the user's name or on the keyshaped icon.

35.2.4.4. Removing a User
In order to completely remove a user, please click on 'Administration' and 'Manage Users' and click
on the trash icon on the right side of the user's name.
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35.3. The 'All' Group
Pandora FMS has a system of groups that are entities in which the agents will be categorized and
used to disperse privileges. It provides some permissions for the users, framed into one or several
groups in that way. They possess the capability of seeing and interacting with agents and other
objects from their environment.
To render the assignation and filtering of the groups a little easier, we've designed a tool named the
'All' group. The 'All' group means: All groups or any of them, depending on the context. It's just
about the same in version 3.1, but its implementation has changed.
Within version 3, the 'All' group is a special group which is contained in the database with identifier
'1'. This one was attached to this group in this way, so the group with ID '1' was managed as an
exception throughout the console's code, along with the necessity of the subsequent control if the
groups were listed, and where it was necessary to sometimes omit this group.
In version 3.1, the 'All' group has disappeared entirely from the database. The identifier '1' has been
released for use to any normal group. Now, the identifier reserved for the "All" group is '0', bearing
the difference that it's completely controlled by code. Now it's controlled in such a way that the
objects associated with the '0' group are going to be associated to all groups, without the need to
define whether a group, taken out from the database is special or not.
If we take out agents from a group or vice versa, there isn't any problem, because an agent belongs
to only one group. If we're e.g. extracting the groups to which a user belongs to (or the users which
belong to one particular group) it's important to keep in mind that we should display the ones
which are members of all groups (group '0') if we're going to list the users which belong to one
group. If we're displaying the groups of a user, it's recommended to display all of them in case this
user belongs to the 'All' group ('0').

35.4. The Enterprise ACL System
The Open Source ACL model is based on a 'unix style' type of role/action/group/user procedure.
The Enterprise ACL system (which was implemented in version 3.1) allows to define to which pages
the user has access to for any profile (defined individually or by groups). This feature e.g. only
allows to let a user see the 'Group' and 'Detailed Agent' views, but skipping over pages like the 'Alert'
or 'Monitor' views. Those are already grouped within the classic ACL system of Pandora FMS as
'ARs' (the agent's read privileges).
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This feature even allows you to restrict the administration for each page. This is also very useful to
allow specific lowlevel operations.
Both models are implemented side by side and compatible, but the enhanced ACL system is an
Enterprise feature only. The regular ACL system will continue to exist, because it provides a very
easy to handle ACL system for Pandora FMS.
An activation is required within the setup in order to use the new enhanced ACL system. The option
to activate it is only visible if you're running the Enterprise Version of Pandora FMS.

In order to utilize the Enterprise ACL system, please click on the specific option for Enterprise ACL
on 'Administration' and 'Setup'. Within this window, you're also able to add new items to the ACL
System and see the items defined by its profile. You're also able to delete items from the Enterprise
ACL system there.

If activated, the Enterprise ACL system restricts all pages to all groups (even administrators) to
defined (allowed) pages in the Enterprise ACL system. If a user with an 'Administrator' profile has
no defined pages within the Enterprise ACL system, it can't see anything.
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Please exercise extreme caution in handling this feature, because you're running the
risk of entirely losing your console's access if you're accidentally setting up incorrect
Enterprise ACL configuration values for your user account.

In order to disable the Enterprise version's ACL System from the command line, please execute the
following command:
/usr/share/pandora_server/util/pandora_manage.pl /etc/pandora_server.conf --disable_eacl

You're also able to define the rules page by page', by whole sections, to setup a 'any' rule or to add
'custom pages' which aren't going to be accessible from the menu.
There are two methods to add pages to a profile: By the wizard (default setting) or by custom
edition. There is a button on top of the 'Add Rules' button to change this mode.

35.4.1. The Wizard
The default method is to pick the sections and pages for a combo control by the wizard.

The pages of these combos are exactly the ones accessible from the menu. In order to
grant access to pages which are accessible in other ways (e.g. the main view of the
agents), you're required to use the Custom Editor to do so.

In order to include a particular Pandora FMS page into the 'allowed pages list', you're required to
select the profile to which the ACL is going to apply to and to pick the allowed section by the
'Section' control. In this moment, you're also able to select any desired section of the page by the
'Page' control.

Another available option is to select a section and to assign the 'All' value for 'Page'. This is going to
allow the selected profile to see 'everything', just as it would be without the Enterprise version's ACL
system related to that profile. If you e.g. select 'All' within both controls, this profile could see all
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sections in their entirety, as if it would be without the Enterprise version's ACL system within these
sections.

In order to render a section visible within the menu, the user is required to have been
granted access to this particular section's first page. In order to e.g. display the
'Monitoring' section, the user is required to have been granted access to the 'Tactical
View' page prior to that.

35.4.2. Custom Editing
In order to add single pages which aren't accessible from the menu, you're also able to introduce
their 'sec2' parameter manually. To do so, you're just accessing the page you intend to add and copy
the 'sec2' parameter.
If we e.g. intend to add the agent's main view, we're just going to any agent's main view in which
the URL looks like the one shown below:
http://localhost/pandora/index.php?
sec=estado&sec2=operation/agentes/ver_agente&id_agente=7702
Now we're going to insert the 'sec2' parameter ('operation/agentes/ver_agente') into the text box as
shown below.

35.4.3. Security
Any page which is defined as 'not allowed' is not going to be displayed within the menu. Those
pages are also not allowed to be used, even if the user e.g. inserts their URLs manually in order to
gain access to them. Any page defined as 'not allowed' by the regular Pandora FMS ACL System is
not going to be allowed by the Enterprise ACL, because these pages are still handled by the regular
ACL.
This is an example which contains several filters:
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There is also a control which was designed to check whether a page belongs to a section or not,
thereby improving the security against manually conducted URL modifications. This check can be
avoided by pages added by the custom editor, providing this particular user has been granted access
to all pages of a section e.g. in order to optimize their performances prior to that.

35.5. The Workspace
35.5.1. Chat
This tool was designed to interact with other Pandora FMS users connected to the console in real
time. This tool might come in handy if you e.g. intend to share comments or issues about the service
with other operators or administrators.

35.5.2. Connected Users
This extension displays other users which are connected to the Pandora FMS console, different from
our own. This functionality is quite important, because the Pandora FMS Console allows
connections from different users.
In order to display the connected users, please click on 'Operation' > 'Workspace' and 'Users
Connected'.

35.5.3. Messages
Pandora FMS has a tool which allows the users to send messages to each other. Pending messages
have a blinking icon within the header.
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35.5.3.1. Viewing Messages
If a user receives a message, an envelopeshaped icon is going to appear on the console's top right.

In order to view the user's messages, please click on 'Operation' > 'Workspace' and 'Messages'.

You may read the message on top of the messages list by clicking on the envelopeshaped icon and
answer it by clicking on the black 'Reply' button you see below.
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Once your answer is complete, please click on 'Send Message'.
Sending Messages

In order to send a message, please click on 'Operation' > 'Workspace' > 'Messages' and 'New
Message'.

Once your message is complete, please send it by clicking on the 'Send Message' button.
Deleting Messages

In order to delete user related messages, please click on 'Operation' > 'Workspace' > 'Messages'
and click on the trash icon on the message's right side.
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35.6. Incidents
Besides receiving and processing data to monitor systems or applications, you're also required to
monitor possible incidents which might take place on these systems within the system monitoring
process.
For it, the Pandora FMS team has designed an incident manager within which any user is able to
open incidents, explaining what's happened on the network and to update them with comments and
files any time in case there is a need to do so.
This system allows the users to work as a team, along with different roles and workflow systems
which allows an incident to be moved from one group to another, and that members from different
groups and different people could work on the same incident, sharing information and files.

35.6.1. Viewing all Incidents
Please click on 'Operation' and 'Manage Incidents' in order to view all incidents created so far.

There is a list containing all incidents, arranged by update order.
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Within the list of incidents, each incident comes with detailed information, distributed in the
following columns:
ID: The incident's identifier.
State: The incident's state, containing the icons shown below.

Incident Name: The incident's name.
Priority Displays the priority the incident has assigned by the priority icons.

Group: It defines the group the incident has been assigned to. An incident can only belong to one
group.
Updated: The last time an incident update was received.
Origin: The tab which is applied to assign the incident's origin. It could be selected from a list that
is stored on the database. It's fixed and predefined by the origin list and could be modified by the
database's administrator.
Owner: The user which has presently been assigned to the incident. Please don't confuse it with the
incident's creator  the incident's owner could have been changed, because the owner can always
assign it to another user. Any other user is also able to do the same thing, as long as it has incident
management privileges within the group the incident belongs to.

35.6.2. Incident Tracking
In order to see a specific incident, please click on the incident's ID or on its name.

The incident is displayed within a window which is split into three sections:
•Incident Data
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The incident's basic data is going to be displayed in this section.
You may update the fields named 'incident', 'owner', 'state', 'origin', 'group', 'priority' and the
description.
Once they have been properly updated, please click on the 'Update Manager' button.
•Notes created by users

This section contains the notes from different users which have participated in the incident.
In order to add notes to the incident, please click on the 'Insert Note' button. It's going to display a
page which contains a text area. Please create your note and click on the 'Add' button.
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Any user that has been granted permission for reading an incident is able to add a note, but only
the incident's or the note's owners are able to delete them.
•Attached Files

The attached files of the different users who have taken part in the incident, are contained in this
field.
Please click on the 'Add file' button to add a file.

Two insertion fields are going to be displayed here. Please take a look for the file on the local
system and feel free to create a description. Once you've completed your search, please click on the
'Upload' button to start uploading the file onto the server.
In order to see the file, please click on the file's name.
Any user that has been granted permission for reading an incident is able to add a file, but only the
incident's or the file's owners are able to delete them.

35.6.3. Searching for Incidents
There are some fields designed to ease the search for incidents which are able to be combined.

892

Incidents

It's possible to filter the information by using the following fields:
•Filter by incident state.
The field in which you're able to filter by the incident's state by using the following values:
•All incidents
•Active incidents
•Closed incidents
•Rejected incidents
•Expired incidents
•Filter by priority.
The field in which you're able to filter by incident priority by using the following values:
•By all Priority
•By informative priority
•By low priority
•By medium priority
•By serious priority
•By very serious priority
•By maintenance
•Filter by user: It's possible to filter by the user of the incident.
•Free text: The field in which it's possible to filter by a matching text.
•Filter by groups: The field in which it's possible to filter by incidents, associated to each of
the existing groups.

35.6.4. Opening a New Incident
In order to open a new incident, please click on 'Operation' > 'Manage Incidents' and click on
'Create Incident' button.
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This is the page to create it.

35.6.5. Changing the Owner of an Incident
In order to change the owner of an incident, please click on 'Operation' > 'Workspace' >
'Incidents', select the proper incident in the last column and click on the 'Become Owner' button.

In this way, the user which conducts the operation is going to become the incident's owner.

35.6.6. Deleting an Incident
In order to delete an incident, please click on 'Operation' and 'Manage Incidents'. Please select the
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proper incident in the last column and click on the 'Delete Incident' button.

35.6.7. Incident Statistics
By clicking on 'Operation' > 'Manage Incidents' and 'Statistics', you're able to access the following
five types of incident statistical graphs:
•Incidents state
•Priorities assigned to the incidents.
•Users that have an incident opened.
•Incidents by groups.
•Incidents Origin.

35.6.8. Selfgenerated Incidents (Recon Server)
By the integration of the Recon Server we've also added the selfgenerated incidents from the events
processed by the recon server, such as the detection of new systems within the network we're
working in. These incidents are exactly the same as the rest. They're also listed in the 'Operation' >
'Managing Incidents' section.

35.7. Managing Incidents (Integria IMS Integration into Pandora FMS)
The integration of Integria IMS into Pandora FMS allows to share all information these applications
possess and to work with them in a syncronized way.

First, it's necessary to enable the integration of Integria IMS into Pandora FMS. In
order to obtain information about its configuration and parameters, please click
on SetupIntegria URL, API password and Integria IMS Inventory).
In order to call up Integria IMS incidents, please click on 'Operation' and 'Manage Incidents'.

The incidents search under Integria IMS is quite similar to the way Pandora FMS searches for
incidents. As you can see below, you're also able to review all incidents related to Pandora FMS
under Integria IMS.
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You're also able to see details about values like 'group', 'severity', 'source', 'resolution', 'state',
'description', etc.

Furthermore, you're also able to add work units which were designed to sustain communication
between the incident's source and the person who solved it. You're also able to see the time it took
to create the incident, whether it's public or not and if it has generated any cost.
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You're also able to upload files which are associated to the incidents.

Additionally, you're able to keep track of all interactions between users for each incident.
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35.8. The Servers
The server's detailed view is considered common knowledge, besides the Pandora FMS server's
general state, its load level and its delay. Below, we're going to show one picture which contains the
server's state. Please click on 'Operation' and 'Pandora Servers' in order to obtain it.

We're looking at several important pieces of data within this window:
•The server's name.
Usually it's the system's hostname.
•The server's state
('green' = right, 'red' = not fired, stopped or down).
•The server's type
data servers, network servers, etc.
•The progress bar
It's going to display the load percentage of all modules, pertaining to this type of server. In this
example, all servers are at a 100% strain, except the Recon Server which has no tasks to perform, so
its strain is at 0%.
•The number of modules
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Displays the number of modules of this type executed by the server in relation to the total number
of modules of this type.
•Server Lag:
The highest amount of time the oldest module has been waiting for data and the number of
modules which have exceeded their life time. In this example, there are nearly 3,000 modules
considered out of their life time, bearing a lag time of 10 minutes and 13 seconds. This indicator is
quite useful in case we have a lot of modules to execute and like to know whether the server is on
the limit of its load capacity or not, as it is in this case. It's not an excessive delay (10 minutes and
13 seconds) for modules that have a lower average life time, being only 19 modules with a lag (of
10 minutes) from a total of almost 1,500 modules.
•The total number of modules in queue waiting to be attended to.
These parameters display a state of excessive load. Modules aren't supposed to be held in queue at
all. Such a state always indicates the server's disability to process data fast enough.
•Number of seconds since the server has updated its data.
Each server contains a 'Keep alive' that updates its state in order to make sure that it's active. It's
also updating its statistics.

35.9. The Backup
An extension which was designed to conduct database backups and to restore them. Please click on
'Administration' > 'Extensions' and 'Backup'. to call it up. In order to complete the procedure, we
suggest to create a distinct backup description and click on the 'Create' button as shown below.

After the backup is completed, it's going to appear in the backup list, bearing the
running icon under 'Status'.
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Once the Backup has been created, it's possible to:
•Download it clicking on the image icon shown below.

•Conduct a rollback by clicking on the image icon shown below.

The rollback feature applies to any backups which have been created before. This will destroy all
existing data in the console and will apply data that already exist in the backup where the rollback
is done.
•Delete it by clicking on the image icon shown below.

35.10. Cron Jobs
This is a feature of the Enterprise Versions of Pandora FMS.
It's an extension which allows to schedule the completion of tasks assigned to Pandora FMS Servers.
Please click on 'Operation' > 'Extensions' and 'Cron Jobs' to execute this feature.

In order to add a task, you're required to fill out the following fields:
•Task: The combo to pick the task that is going to be performed, e.g.:
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•Sending a custom report by email.
•Executing a custom script.
•Conducting a Pandora database backup.
•Saving a custom report to the disk.
•Scheduled: The field to determine how often the task is going to be executed.
•Not Scheduled: These tasks are only going to be executed once and at a specified
time, e.g.:
•Hourly
•Daily
•Weekly
•Monthly
•Yearly
•First Execution: The field to choose the date and hour for the task's first execution. It's
going to be executed periodically by utilizing taking the predefined date and hour as
reference.
•Parameter: The field which allows to introduce parameters into the task to perform. It's
options diversify and depend on the task which are going to be conducted.
•Backup Pandora database: The field intended to provide a database description.
•Send custom report by email: The report to send and the destination email
address.
•Execute custom script: The custom script to execute.
•Save custom report to disk: The report to save and the destination folder.
Once you have inserted all data, please click on the 'Create' button and the task is going to be
displayed within the scheduled tasks list.

Once you have created the scheduled task, it's possible to force its execution by clicking on the
green circle located on the task's right or deleting it by clicking on the red 'X' on the left (It's only
visible if the task is active. It replaces the green circleshaped icon).

35.11. Planned Downtime
Pandora FMS contains a scheduled downtime management system. This system was designed to
deactivate the alerts in the intervals whenever there is down time by deactivating the agent. If an
agent is deactivated, it doesn't collect information. In a down time, the downtime intervals aren't
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taken into account for most of the metrics or types of reports, because the agents don't contain any
data within those intervals.
In order to create a downtime, please click on 'Administration' > 'Manage Monitoring' >
'Scheduled Downtime' and click on the 'Add' button as shown below.

The configurable parameters pertaining to this particular form are the following:
•Name: The name of the scheduled downtime.
•Group: The group we intend it to belong to.
•Description: A field for a description.
•Type: The downtime type. We're able to configure the following types of downtimes:
•Quiet: A field to disable the modules we describe below.
•Disable Agents: It disables the selected agents.
•Disable Alerts: It disables the alerts for the selected agents.
•Execution: It allows us to determine whether we intend it to run it once or periodically.
•Configure the time: A field to define date and time within which it's going to start and
stop, the planned end, either once or periodically, depending on what has been defined
under the 'Running' option before.
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Now we're going to specify the agents we intend to include into this downtime.

If a scheduled service stop is defined as 'active', it usually cannot be modified or deleted. From
Pandora FMS versions 5 and above, there is a new option with which we're able to stop the
execution of the scheduled shutdown. It's called 'Stop Downtime' and reenables all agents, modules
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and alarms the planned stop is temporarily disabling. This option is not compatible to the regular
scheduled downtimes.

In the moment the scheduled downtime ends, you're able to edit or delete it.

35.11.1. Alternatives to the Service Downtime Management in the Console
There are often some reemerging situations we're required to keep in mind in which the service
downtime management method is too specific. We e.g. quickly and precisely intend to deactivate all
agents or to schedule a general downtime each week within a specific hour range. For these types of
operations, there are the following commandline ways to accomplish that:
There are two faster ways of putting all agents into service mode:
1. By using the Pandora management tool named 'pandora_manage.pl' on the command line by
executing the following command:
./pandora_manage.pl /etc/pandora/pandora_server.conf --enable_group 1
Pandora FMS Manage tool 3.1 PS100519 Copyright (c) 2010 Artica ST
This program is Free Software, licensed under the terms of GPL License v2
You can download latest versions and documentation at http://www.pandorafms.org
[*] Pandora FMS Enterprise module loaded.
[INFO] Enabling group 1

This command activates all agents. In order to deactivate 'Group 1', please execute the following
command:
./pandora_manage.pl /etc/pandora/pandora_server.conf --disable_group 1

2. You're also able to achieve this by using the MYSQL interface by modifying the data directly:
echo "UPDATE tagente SET disabled = 1" | mysql -u pandora -ppassword pandora

Within the 'password' passage of the above mentioned command, you're obviously required to enter
the access password for the database. You also have the option of conducting a more granular
operation by using the SQL method, e.g. to specify it by the agent's name:
echo "UPDATE tagente SET disabled = 1 WHERE nombre LIKE '%_XXXX%'" | mysql -u pandora -ppassword
pandora

904

The Audit Log

35.12. The Audit Log
Pandora FMS generates a log, containing all important changes and actions which have taken place
within the Pandora FMS console. This log can be invoked by clicking on 'Administration' and
'System Audit Log'.

35.12.1. Reviewing the System Logs
You're able to invoke the system logs by clicking on 'Administration' and 'System Audit Log'.
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35.13. Managing the Database from the Console
The core of Pandora FMS is its Database. All data collected from the monitored systems, the agents
configuration, the alarms, the events, the audit data, the different users and their data are stored
within it. It's all considered system data.
The efficiency and reliability of this module is vital to the correct functionality of Pandora FMS. An
appropriate maintenance of the Pandora FMS Database is of course crucial for its proper operation.
In order to perform a regular maintenance of the database, the administrators are able to either use
MySQL standard commands from the command line or to manage the database from the console
without having to be an expert on MySQL.
The database management is carried out by clicking on 'Administration' and 'DB Maintenance'. The
options pertaining to this particular feature are shown on the picture below.

35.13.1. Obtaining Information from the Database
In order to manage the database correctly, it's essential to exactly know the data contained in it and
the amount of time this data has been in the database. It's possible to obtain information of
different types from the database:

35.13.1.1. Obtaining General Information
You're able to open a page which contains general data of the database by clicking on
'Administration' and 'DB Maintenance'. This page displays the time the system requires to compact
the data and the time the information was stored within the system.
Packing is defined in reducing the amount of stored data without losing important information. As
time progresses, not all data will be stored, but statistic interpolations which allow to generate
graphs by the processed data.

906

Managing the Database from the Console

35.13.1.2. Obtaining Information about Agents and Modules
In order to obtain information about the number of modules and the data from each Pandora FMS
agent, please click on 'Administration' > 'DB Maintenance' and 'DB Information'.
This window is going to display two bar charts: One which displays the modules sorted by agent
and another one which displays the packets sorted by agent as shown below.
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Any general information is going to be displayed within the graphs. If you like to learn more specific
information in text mode, please click on 'Press here to get database information as text' like on the
picture above.
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You're going to obtain the information by text along with the agent's name, the number of assigned
modules and this agent's amount of data. The list is assorted by agent data and contains a list of all
agents installed under Pandora FMS.

35.13.1.3. Obtaining Information about Data by Date
By clicking on 'Administration' > 'DB Maintenance' and 'Database Purge' you're able to obtain the
number of packets from the past three months, one month, two weeks, one week, three days or one
day.
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You're able to obtain data from all or one specific agent.
In order to obtain data from a specific agent, please pick the agent you intend to show up in the
combo and you're going to obtain the agent's data automatically.

35.13.1.4. Obtaining Data from the Audit Log
By clicking on 'Administration' > 'DB Maintenance' and 'Database Audit', you're able to learn the
total number of audit logs and the data from the first and last log.
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35.13.1.5. Obtaining Data about Events
By clicking on 'Administration' > 'DB Maintenance' and 'Database Event', you're able to obtain the
total number of events and the first log and last log data.

35.13.2. Purging the Database
Pandora FMS also provides advanced tools for data purging. It's generally conducted by the data's
dates, if a system's insufficient speed is getting detected or specifically, if inappropriate data is
detected and you intend to delete it from a module.

35.13.2.1. Agent Data Purge by Date
Please click on 'Administration' > 'DB Maintenance' and 'Database Purge' in order to purge the
agent's data by date in the database. Please select the data you intend to delete within the combo
and click on the 'Do it !' button.

It's also possible to purge the data from more than three months, one month, two weeks, one week,
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three days or one day. The time the system requires for purging the selected data will depend
heavily on its amount.

35.13.2.2. Purging Specific Data from a Module
If you're e.g. discovering modules which contain inappropriate data, it's possible to standardize their
content by clicking on 'Administration' > 'DB Maintenance' and 'Database Debug'.
Please select the agent and the module, define the maximum and minimum limits and click on the
'Delete' button on the bottom left.

All data that is outside the defined minimum and maximum intervals are going to be deleted.

35.13.2.3. Purging Audit Data
In order to purge any audit data within the Database, please click on 'Administration' > 'DB
Maintenance' and 'Database Audit'. Please select the data you intend to delete in the combo and
click on the 'Do it !' button as shown on the picture below.

It's also possible to purge the data from more than ninety days, thirty days, fourteen days, seven
days, three days or all data. The time the system requires for purging the selected data will depend
heavily on its amount.

35.13.2.4. Purging Event Data
In order to purge any event data within the Database, please click on 'Administration' > 'DB
Maintenance' and 'Database Event'.
Please select the data you intend to delete in the combo and click on the 'Do it !' button as shown on
the picture below.
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It's also possible to purge data of more than ninety days, thirty days, fourteen days, seven days,
three days or all data. The time the system requires for purging the selected data will depend
heavily on its amount.

35.13.3. Database Maintenance
The Pandora FMS infrastructure doesn't require external maintenance, but it's very important to
purge the old data, to keep the database in a compacted shape and to delete modules which have
never been started. These modules are located in the agents and have never received any data. In
order to accomplish proper database maintenance, we recommend to execute an internal Pandora
FMS script which conducts the database's regular (daily) maintenance. Please read the chapter
named Server Management in order to obtain more information.
Nevertheless, you're able to perform some of the tasks, this script accomplishes from the console, as
we're going to see in the following subsection.

Please click on 'Administration' > 'DB Maintenance' and 'Database Sanity' in order to execute these
tasks.

35.13.3.1. Sanitizing Modules and Structures
This tool was designed to 'sanitize' the modules (e.g. by a pending deletion) and to delete some
unfinished or badly applied structures which could lead Pandora FMS to perform more slowly than
usual in some cases.
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35.13.3.2. Purging NonInitialized Modules
Again and again, modules are created and assigned to agents which have never been initialized, due
to the fact they've never received any data. It's recommended to delete the noninitialized modules
every now and then.
Please click on 'Administration' > 'DB Maintenance' > 'Database Sanity' and 'Delete noninitialized
modules now' in order to execute this task from the console.

Please keep in mind that these two operations are conducted automatically by the Pandora FMS
Database Maintenance Tool which is thoroughly described in the Server Management and
Administration chapter.

35.13.4. The Database Interface
It's an extension which was designed to execute commands in the database and to observe the
results. It's a very advanced tool that is recommended only to be used by people who have
a serious knowledge of the SQL language and the Pandora FMS Database Structure in detail.

If this tool gets used in any inappropriate way, it's very likely to result in a permanent
destruction of Pandora FMS, its database or its data !

Please click on 'Administration' > 'DB Maintenance' and 'DB Interface' in order to invoke the
database's interface.
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Please click on 'Administration' > 'DB Maintenance' and 'DB interface', insert your SQL command
into the text field and click on the 'Execute SQL' button.

35.14. The PlugIn Registration
The plugin registration was designed to render the logging of server plug ins an easy task. Please
click on 'Administration' > 'Manage Servers' > 'Register Plug In' in order to invoke this plug in.

In order to log a plug in, please pick the file by clicking on 'Examine' and click on the 'Upload'
button.
You may obtain more information about the '.pspz' server plug ins in the Server PlugIn
Development Section.

35.15. Inserting Data
This extension was designed to import data by means of a commaseparated file (CSV) to an agent's
module. Please click on 'Administration' > 'Manage Monitoring' and 'Insert Data' in order to invoke
this extension.

915

Inserting Data

The syntax in the CSV file format is required to be 'date;value' in each and every line. The date's
syntax format is required to be 'Y/m/d H:i:s', e.g.:
2011/08/06 12:20:00;77.0
2011/08/06 12:20:50;66.8

35.16. CSV Import
This is a feature of the Pandora FMS Enterprise Version.
This extension was designed to import a file, separated by any divider on the Pandora FMS server.
Please click on 'Administration' > 'Extensions' and 'CSV Import' in order to invoke this extension.
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Please pick the field to import by clicking on the 'Examine' button, choose the server on which the
export is supposed to be conducted on and select the divider from a combo. Once the before
mentioned combos are served appropriately, please click on the 'Go' button.
The CSV file is required to contain the following fields in the below mentioned sequence:
•The agent's name
•IP address
•The operating system's ID
•The interval and group ID the agent belongs to.

35.17. Resources Registration
This extension was designed to import '.prt' files which contain the definition of local, network,
SNMP and WMI components. Except for the local components, you're allowed to add these
components to a template.
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35.17.1. File Definition for the PRT Format
This is an appropriate definition for '.prt' files.
<?xml version="1.0"?>
<pandora_export version="1.0" date="yyyy-mm-dd" time="hh:mm">
<component>
<name></name>
<description></description>
<module_source></module_source>
<id_os></id_os>
<os_version></os_version>
<data></data>
<type></type>
<max></max>
<min></min>
<max_cri></max_cri>
<min_cri></min_cri>
<max_war></max_war>
<min_war></min_war>
<historical_data></historical_data>
<ff_treshold></ff_treshold>
<module_interval></module_interval>
<id_module_group></id_module_group>
<group></group>
<tcp_port></tcp_port>
<tcp_send></tcp_send>
<tcp_rcv_text></tcp_rcv_text>
<snmp_community></snmp_community>
<snmp_oid></snmp_oid>
<snmp_version></snmp_version>
<auth_user></auth_user>
<auth_password></auth_password>
<privacy_method></privacy_method>
<privacy_pass></privacy_pass>
<auth_method></auth_method>
<security_level></security_level>
<plugin></plugin>
<plugin_username></plugin_username>
<plugin_password></plugin_password>
<plugin_parameters></plugin_parameters>
<wmi_query></wmi_query>
<key_string></key_string>
<field_number></field_number>
<namespace></namespace>
<wmi_user></wmi_user>
<wmi_password></wmi_password>
<max_timeout></max_timeout>
<post_process></post_process>
</component>
<component>...</component>
<component>...</component>
<template>
<name></name>
<description></description>
</template>
</pandora_export>

35.18. Translation of Strings
This extension can be found in the godmode menu under 'Administration' > 'Setup' and 'Translate
String' and was designed to translate strings on the Pandora FMS interface for the purpose of
personalizing it.
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The fields pertaining to this particular extension are the following:
•Language: It allows to filter the strings by language.
•Free text for search: The field to insert the string content you intend to personalize.
Three columns are going to be displayed in this window: The first one is going to display the
original string, the second one displays the current translated string and the third one contains the
custom translation you intend to add.
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36 Setup by the Console
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36.1. Introduction
The console configuration allows you to change and fine tune configuration parameters of the
Pandora FMS Console. However, some general parameters are common for the whole application,
including the Pandora FMS Servers and could affect the application's main performance.
By clicking on 'Administration' and 'Setup', you're able to configure several options of Pandora FMS,
which are going to be explained below.

36.2. Setup
By clicking on 'Administration' and 'Setup', you're able to invoke the configuration of the console's
general parameters page.
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In this moment, the window shown below appears on the screen.
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36.2.1. General Parameters
Language Code for Pandora:
It's the combo in which you're able to select the console's main language.
Remote Config Directory:
It's the field intended to identify the directory in which the remote configuration of the agents is
stored. It's '/var/spool/pandora/data_in' by default. This feature is only available to Enterprise
Versions of Pandora FMS.
AutoLogin (hash) Password:
It defines a static and symmetrical password which is used to create a hash value in order to render
the automatic validation by URL possible. It's used to incorporate Pandora FMS into other web
applications, provides a user name as a parameter, generated by the user's name by using a hash.
This password allows an automated validation within Pandora FMS without the need of having to
introduce a password. In order to see an example of this integration, please take a look into the file
named '/extras/sample_login.php' from the Pandora FMS console.
Time Source:
The combo in which you're able to select the origin of the date and hour between the database and
the system. The first one is used if the database is located on a system different from the console's.
Automatic Check for Updates:
The field in which the automatically conducted update check for the Open Update Manager is
configured. This function causes the console to contact the Pandora FMS Update Server at Artica ST
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each time you start the session and sends anonymous information about your Pandora FMS usage
(just your number of agents).
Enforce HTTPS:
The field which allows you to force a readdressing to HTTPS. If you enable it, you're required to
activate the use of Pandora FMS in conjunction with HTTPS within your web server. If you've
enabled it and you haven't properly configured your Apache to use HTTPS before, you're unable to
access the web console again. In this situation, you'll have to disable the HTTPS option again by
going straight to the database, using MySQL and the following SQL syntax:
update tconfig

set `value` = 0 WHERE `token` = 'https';

Attachment Storing:
The attachment directory is used as a temporary folder for Pandora FMS. All attached incident data
are also stored in this folder. It's located under '/var/www/pandora_console/attachment' by default.
You're required to have writing rights for the web server. The map's images and other temporary
files are stored there, too.
List of IPs with access to the API:
This is a list of IP addresses (not FQN and one per line) which are going to have access to the
Pandora FMS webservices API and other minor functions like the RSS event feed or the marquee
view. You may use '*' as a wild card in order to define 'any' IP address and e.g. '125.56.24.*' in
order to grant access to all hosts within the '125.56.24.*' subnet.
API Password:
It's the authentication method used to access the Pandora FMS API from the outside. Please read the
section named Pandora FMS External API. in order to obtain more information about this topic.
Enable GIS features in Pandora Console:
The field intended to enable or disable GIS features within the Pandora FMS Console. Please read
the section named GIS Console in order to obtain more information about this topic.
Enable Integria incidents in Pandora Console:
The field intended to change the Incident System in order to synchronize it to Integria IMS. After
enabling it, three new fields for the Integria IMS credentials are going to be displayed within this
view.

•Integria
URL: The
URL
of
'http://exampledomain.com/integria'.

the

Integria

IMS

installation,

e.g.

•Integria API Password: The API's access password which was set up during the Integria
IMS setup.
•Integria Inventory: The inventory objects of Integria IMS which are going to be associated
to incidents, created by Pandora FMS. It's going to remain empty until a connection is
established.
Enable Netflow:
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The field intended to enable or disable the Netflow feature.
Timezone Setup:
It defines the timezone in the moment the Pandora FMS Console is located. It's also the combo in
which it's possible to pick the zone and timezone.
Sound for Alert fired:
It's the combo which was designed to pick the sound for fired alerts.
Sound for Monitor critical:
The combo which was designed to pick the sounds in case a module is in 'critical' state.
Sound for Monitor warning:
The combo which was designed to pick the sounds in case a module is in 'warning' state.
Public URL:
Please define this value if your Pandora FMS works across an inverse proxy or is e.g. configured by
Apache's 'mod_proxy' option.
Referrer Security:
For security reasons, it's going to be verified whether the user has started from a Pandora FMS URL
or not and the old link isn't an external or malicious link if activated. It's disabled by default. The
locations which are considered highsecurity areas are the following:
•Database Manager Extensions
•User Configurations
•Recon Script Configurations

Event Storm Protection:
If set to 'yes', none of the events or alerts are going to be generated, but the agents continue to
receive data.
Command Snapshot:
The string modules which contain several lines are going to be shown as a command output.
ServerLogs Directory:
It's the directory in which the server logs are going to be stored.

36.2.2. Features of the Enterprise Version
Now we're going to describe some fields which are exclusive to the Enterprise version of Pandora
FMS.
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Forward SNMP traps to Agent (if exist):
It's the option which allows for transforming a trap into a Pandora FMS Module, associated to the
agent with the same IP as the trap's originating IP, any time a trap is received.
Use Enterprise ACL System:
This option is going to activate the Enterprise version's ACL System which is much more flexible
than the default one. Please read the section named Enterprise ACL System if you like to obtain
more information about this topic.
Collection
Size:
This field defines the maximum size of the collections. Please read the section named Monitoring by
Policies if you like to obtain more information about this topic.
Event Replication:
If the event replication is activated, the received events are going to be copied into the meta
console's remote database.
Inventory Changes Blacklist:
The inventory modules included into the changes blacklist are not going to generate any events if a
change occurs.

36.2.3. Password Policy
36.2.3.1. Introduction
You're able to utilize the password policies from Pandora FMS Enterprise versions 5 and above. It's
a group of rules which apply in the moment you're defining the Pandora FMS user passwords. This
policy was designed to be applied to standard and administration users, as we're going to see below.

36.2.3.2. Configuration
You're required to have administrator permissions in order to enable the password policy. It's
configured by clicking on 'Administration' and 'Setup' in a section called 'Enterprise Password
Policy'.
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The configuration parameters pertaining to this particular feature are the following:
Enable Password Policy:
It's intended to enable or disable the password policy activation. It's disabled by default.
Min. size Password:
It's the password's minimum size. The default value is '4 characters'.
Password must have Numbers:
The password is required to have numbers. It's disabled by default.
Password must have Symbols:
The password is required to have symbols. It's disabled by default.
Password Expiration:
The password's expiration period. The default value is '0', which means that it never expires. Force
change password on first login: It forces a login by password in the moment of first login after the
user's creation. It's disabled by default.
User blocked if login fails:
It's the feature intended to determine time the user is blocked if it exhausts the maximum number
of failed login attempts. The default value is '5 minutes'.
Number of failed login Attempts:
It's the number of allowed failed login attempts in the moment of logging. The default value is '5
attempts'. Apply password policy to admin users: It's the feature to include the password policy
also to administrator users. It's disabled by default.
Enable password history:
It's used to enable or disable the password history. It's disabled by default.
Compare previous Password:
It's the number of previous passwords which are considered inappropriate for a password change,
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because they've been used before. The default value is '3'.

36.2.4. The Log Collector
If you select this option, a window like the one shown on the picture below is going to appear.

The configurable fields pertaining to this particular feature are the following:
Log Storage Directory:
The directory in which the log data is going to be stored.
Log max. Lifetime:
The log's maximum lifetime.

36.2.5. The History Database
This feature allows you to enable the Pandora FMS Database History options in order to save old
data within an auxiliary database. This system accelerates all queries and accesses to the data.

The options pertaining to this particular feature are the following:
•Enable history database: It's intended to enable or disable the database's history feature.
•Host: The host name of the history database.
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•Port:: The port of the history database.
•Database Name: The name for the history database.
•Database User: The user allowed to access the history database.
•Database Password: The password to access the history database.
•Days: The number of days for the data to be transferred to the history database.
•Step: The buffer size for the data transfer (in number of items). The lower the value, the
slower the data transfer, but it also lowers the performance reduction within the main
database. An appropriate default value is '1000'.
•Delay: The delay time (in seconds) for the data block transfer between main and history
databases. An appropriate value is '2'.

36.2.6. Authentication
There are several options for authentication:
•Active Directory
•LDAP
•Local Pandora FMS
•Remote Babel Enterprise
•Remote Integria IMS
•Remote Pandora FMS

Due to certain security reasons, the users with administrator privileges are always
required to use the local authentication of Pandora FMS.

36.2.6.1. Active Directory
If you click on this option, the window shown on the picture below is going to appear.

The configuration parameters pertaining to this particular feature are the following:
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Fallback to Local Authentication: Please enable this option if you want to fall back to a local
authentication if the Active Directory remote authentication happens to fail.
Active Directory Server: The address of the Active Directory server.
Active Directory Port: The port of the Active Directory server.
Start TLS: The parameter intended to switch the Transport Layer Security protocol (TLS) for
communications between client and server on or off.
Domain: The Active Directory domain to be used.

36.2.6.2. LDAP
If you select this option, a window like the one shown on the picture below is going to appear.

The options pertaining to this particular feature are the following:
Fallback to local Authentication:
Please enable this option if you intend to fall back to a local authentication if the LDAP remote
authentication happens to fail.
AutoCreate Remote Users:
It enables and disables the remote user creation automatically. This option allows Pandora FMS to
create the users automatically, once logged in by using LDAP. If enabled, the three below
mentioned fields are going to be available. If not, the fields are blocked.
AutoCreate Profile:
If the automatic remote user creation is enabled, this feature was designed to assign a profile to the
automatically created users. There are the following available default profiles:
•Chief Operator
•Group Coordinator
•Operator (Read)
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•Operator (Write)
•Pandora Administrator
You're also able to review all available profiles by clicking on 'Administration' > 'Manage Users' and
'Manage Profiles'.
AutoCreate Profile Group:
If the automatic remote user creation is enabled, this field allows you to assign groups to
automatically created users. There are the following available default groups:
•Servers
•Firewalls
•Databases
•Network
•Unknown
•Workstations
•Applications
•Web
You're also able to create new groups or to list all available groups by clicking on 'Administration'
> 'Manage Agents' and 'Manage Groups'.
AutoCreate Blacklist:
A comma separated user list of names which are not allowed to be created automatically.
LDAP Server:
The LDAP server's address.
LDAP Port:
The LDAP server's port.
LDAP Version:
The LDAP server's version.
Start
It's
intended
to
switch
the
Transport
([http://en.wikipedia.org/wiki/Transport_Layer_Security TLS) protocol
between client and server on or off.

TLS:
Layer
Security
for communications

Base DN:
The Distinguished Name (DN) used by the LDAP server, e.g.
'ou=People,dc=edu,dc=example,dc=org'.
Login Attributes:
The login attributes used by the LDAP server during the authentication process, e.g. the UID.

36.2.6.3. Local Pandora FMS
If you select this option, the configurable fields are going to disappear. This option conducts the
authentication by using the internal database of Pandora FMS.

36.2.6.4. Remote Babel Enterprise
If you select this option, a window like the one shown on the picture below is going to appear.
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The parameters pertaining to this particular feature are the following:
Fallback to local Authentication:
Enable this option if you intend to fall back to a local authentication if the remote Babel Enterprise
authentication happens to fail.
Babel Enterprise Host:
The Babel Enterprise server address.
MySQL Port:
The MySQL port of the Babel Enterprise database.
Database Name:
The Babel Enterprise database name.
User:
The user allowed to access the Babel Enterprise database.
Password:
The password to access the Babel Enterprise database.

36.2.6.5. Remote Integria IMS
If you select this option, a window like the one shown on the picture below is going to appear.

932

Setup

The parameters pertaining to this particular feature are the following:
Fallback to local Authentication:
Please enable this option if you intend to fall back to a local authentication if the Integria
IMS remote authentication happens to fail.
Integria Host:
The Integria IMS server's address.
MySQL Port:
The MySQL port of the Integria IMS database.
Database Name:
The Integria IMS database's name.
User:
The user allowed to access the Integria IMS Database.
Password:
The password to access the Integria IMS Database.

36.2.6.6. Remote Pandora FMS
If you select this option, a window like the one shown on the picture below is going to appear.
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The parameters pertaining to this particular feature are the following:
Fallback to local Authentication:
Please enable this option if you intend to fall back to a local authentication in case the Pandora FMS
remote authentication happens to fail.
Pandora FMS Host:
The Pandora FMS server's address.
MySQL Port:
The MySQL port of the Pandora FMS database.
Database Name:
The name of the Pandora FMS database.
User:
The user allowed to access the Pandora FMS Database.
Password:
The password to access the Pandora FMS Database.

36.2.7. Database Performance
If you select this option, a window like the one shown on the picture below is going to appear.
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The parameters pertaining to this particular feature are the following:
Max. days before delete Events:
The maximum number of days before the events are going to be deleted.
Max. days before delete Traps:
The maximum number of days before the traps are going to be deleted.
Max. days before delete Audit Events:
The maximum number of days before the audit events are going to be deleted.
Max. days before delete String Data:
The maximum number of days before the string data are going to be deleted.
Max. days before delete GIS Data:
The maximum number of days before the GIS data are going to be deleted.
Max. days before Purge:
The maximum number of days before purging the database. This parameter is also used to specify
the maximum number of days before deleting the inventory data.
Max. days before compact Data:
The maximum number of days before compacting the data.
Compact interpolation in hours ('1' = ok '20' = bad)
This is the length of the compacting interval in hours, e.g. a module with an interval of 5 minutes
generates 288 values per day. If this interval is set to '2', the data is going to be grouped in 2 hour
intervals and averaged, resulting in 12 values per day instead of 288. The higher this value, the less
the resolution. A value close to '1' is recommended.
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SLA Period (in seconds):
The default time to calculate the SLA within the agent's SLA tab in seconds. It calculates the SLA
within the modules within an agent automatically. It's based on the defined 'critical' or 'normal'
values.
Default hours for Event View:
It's default number of hours for event filtering. If the value is '24 hours', the event views are only
going to display the events which occurred in the last 24 hours.
Use realtime Statistics:
It enables or disables the realtime statistics.
Batch statistics Period (secs):
If realtime statistics are disabled, this is the parameter to define the refresh time for the batch
statistics.
Use agent Access Graph:
The agent's access graph renders the number of agent contacts per hour in a graph on a scale of 24
hours. This feature is intended to learn the contact frequency for each agent. Under some
circumstances, it could take quite a long time to process the data, so if you have slow hardware
resources, it's recommended to disable it.
Max. days before delete unknown Modules:
It's the maximum number of days before the deletion of unknown modules.
Max. recommended number of files in attachment directory:
It's the maximum number of stored files in the attachment directory.

36.2.8. Visual Styles
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The parameters pertaining to this particular feature are the following:
Date Format String:
The date's format. You're going to find all available options within the console's help.
Timestamp or Time Comparison:
It defines which date and hour is used. There are two available options: The 'Timestamp in rollover'
system timestamp or the 'comparison in rollover' database timestamp. It's very useful in cases the
database belongs to different system other than the console.
Graph Color (min):
It's the color for the minimum value in module graphs.
Graph Color (avg):
It's the color for the average value in module graphs.
Graph Color (max):
It's the color for the maximum value in module graphs.
Graphic Resolution:
It defines the graphical resolution.('1' = low, '5' = high)
Style Template:
It defines the Pandora FMS console's web style. You're able to add new skins or templates by
including CSS files in the folder called 'include/styles'.
Block Size for Pagination:
The block size for pagination.
Use round Corners:
It's intended to switch the round corners of the progress bar and other Pandora FMS graphics on or
off.
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Status Icon Set:
This combo was designed to select the icons used to visualize the module's states. By default the
colors red, yellow and green are used. You may replace the colors by other conceptual icons which
allow you to differentiate the module's status if you're e.g. required to adapt the system to users
with color blindness.
Font Path:
It's the main font's selector combo. This TrueType font is used in Pandora FMS graphs.
Font Size:
Font size of Pandora FMS graphics font.
Custom Logo:
This feature is only available in the opensource version and allows you to display your logo in the
Pandora FMS console header. You may use any PNG picture. The default size for a picture is
60x139 pixels. You may upload your logo to the directory called '/images/custom_logo' by using the
file manager.
Global default Interval for Refresh:
This parameter determines the global refresh interval. The defined value is going to affect all pages,
except the visual console.
Default interval for refresh on Visual Console:
This parameter determines the refresh interval for visual console pages.
Graph color #4 > Graph color #10:
These colors are used in Pandora FMS graphs.
Interval Values:
This parameter determines the interval values.
Interactive Charts:
This option determines whether to use JavaScript or static PNG graphs.
Login Background:
You can place your custom images to the folder called 'images/background'.
Agent Size Text:
If the agent's name consists of a lot of characters, it's required to truncate it into N characters in
some sections within the Pandora FMS console.
Module Size Text:
If the module's name consists of a lot of characters, it's required to truncate it into N characters in
some sections within the Pandora FMS console.
Description Size Text:
If the description consists of a lot of characters, it's required to truncate it into N characters in some
sections within the Pandora FMS console.
Item Title Size Text:
If the item's title consists of a lot of characters, it's required to truncate it into N characters in some
sections within the Pandora FMS Console.
GIS Labels:
Please enable this option if you intend to obtain a label which contains the agent's name in GIS
maps. However, if your maps contain a lot of agent names, they're very likely to be unreadable.
Default Icon in GIS:
The agent's icon to be used on the GIS maps. If you set it to 'none', the group's icon is going to be
used.
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AutoHidden Menu:
This option minimizes the side menu.
Custom Report's Front Page:
The custom report's front page is going to be applied to all reports and templates by default.
Paginate Module View:
It activates the pagination within the module list.

Show QR Code Icon in the Header:
It's intended to display QR Code within the header.

Custom Graphviz Directory:

It's the custom directory in which the Graphviz binaries are stored in.

36.2.9. Netflow
If you select this option, a window like the one shown on the picture below is going to appear.

The configurable fields pertaining to this particular feature are the following:
Data Storage Path:
The directory in which the Netflow data is stored.
Daemon Interval:
The time interval in seconds to update the Netflow data.
Daemon Binary Path:
The nfcapd path.
Nfdump Binary Path:
The nfdump path.
Nfexpire Binary Path:
The binary path for nfexpire.
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Maximum Chart Resolution:
The maximum graph and chart resolution.
Disable custom live view filters:
The option to disable the custom liveview filters.
Netflow max. Lifetime:
The maximum lifetime of the Netflow data.
Name Resolution for the IP Address:
The feature intended to resolve IP addresses in order to obtain their host names.

36.3. The File Manager
The File Manager was designed to upload files to Pandora FMS. You're able to access the file
manager's page by clicking on 'Administration' > 'Setup' and 'File Manager'.

If you invoke the above mentioned feature, a window like the one shown on the picture below is
going to appear.
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The content of the 'images' folder within your Pandora FMS installation is displayed in this section.
In it, you're able to browse directories, create files and folders and upload and download files from
your local hard disk.
You're required to use the buttons shown on the picture below in order to do that.

The buttons are the following: 'create folder', 'create text file' and 'upload file'.

36.3.1. Creating Folders

After clicking on the 'create folder' button, the field shown on the picture above is going to appear.
Just enter the name of the folder and click on the 'Create' button. If you click on the 'Close' button,
the dialog is going to close.
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36.3.2. Creating Text Files

After clicking on the 'create file' button, the field above is going to appear.
Just enter the name of the file and click on the 'Create' button. If you click on the 'Close' button, the
dialog is going to close.

36.3.3. Uploading Files

After clicking on the 'update file' button, the field on the picture above is going to appear.
Just click on the 'Browse' button, browse your local disk and select the file you want to upload.
It's also possible to upload several files at once by selecting a zipped file and selecting the
'Decompress' option. The file will be unzipped and all your compressed files inside is going to
appear within the folder.

36.4. GIS Map Connection
Under Pandora FMS it's possible to obtain the agent's location by using interactive maps. You're able
to configure all parameters related to the connection of the GIS map provider, e.g. OpenLayers of
Google Maps within this section.
You're able to obtain further information about GIS in the section called GIS Console.

36.5. Links
By clicking on 'Administration' > 'Setup' and 'Links', you're able to access the linkmanaging page of
the Pandora FMS Console.
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If you invoke the above mentioned feature, a window like the one shown on the picture below is
going to appear.

The process of creating or updating a link is very similar. Please click on the 'Add' button in order to
create a new link. Please click on 'update a link' and click on the link's name. Both methods are
displaying the same screen. In the first case, the screen is empty and in the second the screen
displays the data of the link to be modified.
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The configurable options pertaining to this particular feature are the following:
Link Name:
The link's name.
Link:
The link's address.
Please click on the 'Create' or 'Update' button in order to create or modify the link, once all fields
have been filled out appropriately.
In order to delete a link, please click on the red cross which is located in the same row as the link
you intend to delete.

36.6. Site News
By clicking on 'Administration' > 'Setup' and 'Site News' it's possible to add news which are going
to appear in console's home page.

Please click on the 'Add' button in order to create news. Subsequently, the window shown on the
picture below is going to appear.
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Please insert an appropriate title and text and click on the 'Update' button. It's possible to delete a
news by clicking on the red cross on its right or editing it by clicking on its name.

36.7. Edit OS
This feature was designed to edit or create new operating systems.
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The feature shown on the picture below was designed to create or edit new operating systems.

The configurable fields pertaining to this particular feature are the following:
Name:
The operating system's name.
Description:
The description for the newly created operating system.
Icon:
Please select an appropriate icon for the OS here.

36.8. The Enterprise ACL Setup
This feature is explained in the section called Enterprise ACL System.

36.9. The Metaconsole
This feature is explained in the section called Metaconsole.

36.10. Skins
This feature was designed to customize the look of the Pandora FMS Console Interface. This feature
was made by changing the CSS style files and the associated icons. In order to create a new skin
you're required to replicate the folder structure of the console.
The folders pertaining to this particular feature are the following:
Images:
This
directory
Include/styles:

is

intended

to

contain

the

skin's

icons

and

images.

This folder is intended to contain the skin's CSS files.
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The skin called 'Example' contains the following directory structure:
Example/
|
|_______images/
|
|_______include/
|
|_________styles/

This structure can be found in '<pandora_root>/images/skin'. All file structures and the content
are required to be compressed in a zip file. A skin could be applied to two levels:
User:
The field for the user's name.
Group:
The skin is going to be applied to all users which belong to the group mentioned here.
If a user has a skin for itself and the group it belongs to has another one, the user's skin has a higher
priority. The window intended to access the available skins is shown on the picture below.

You're required to use the window shown on the picture below in order to create or to configure
any skin.
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The configurable fields pertaining to this particular feature are the following:
Name:
The skin's name.
Relative
Path:
During the creation process, this field is going to ask you to upload the zip file. During any
modification process, this field contains the name of the uploaded zip file.
Description:
The skin's description.
Group/s:
The groups assigned to this skin.
Disabled:
A field intended to disable skins which aren't applied to any user.

36.11. The Pandora FMS Diagnostic Tool
This tool was designed to detect an installation profile of Pandora FMS. It's going to display
information e.g. like the Pandora FMS version, the PHP version and database volumetric
information.

36.12. Update Manager Settings
This feature is thoroughly explained in the section called Update Manager.
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36.13. System Info
This tool is basically an extension which was designed to review the log files by using the Pandora
FMS Console. You're able to obtain information about the Pandora Diagnostic Tool, the system and
the logs by it. It's also possible to execute it by using the command line. You're required to have
administrative rights to do so.
This is an example command for executing the System Info tool by the command line:
sudo php /var/www/pandora_console/extensions/system_info.php -d -s -c

36.14. Translating Strings
This extension is thoroughly explained in the section called Translation of Strings.
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37 UPDATING LANGUAGES
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In order to update any language of the Pandora FMS console, you're required to invoke
the Launchpad Translation Download Page, select the languages you intend to update (they're in
*.mo file format), to click on the 'Request Download' button and to wait for an email which contains
indicators and a location to download the files. Once the download is completed, please copy them
into the folder called '/include/languages/' of the Pandora FMS console and your languages are
updated instantly.

You're required to create an account under Launchpad in order to be able to download
the translation files.
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38 REMOTE SYSTEMS MANAGEMENT BY
PANDORA FMS
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38.1. Introduction
Pandora FMS is a monitoring tool and it doesn't use agents in order to establish a connection to the
systems. It isn't useful to control the monitored systems remotely in this way. Some systems, such as
routers and switches could be managed by using Telnet or SSH. In order to have access to them
you're only required to fire the appropriate command.
Pandora FMS includes a Java plug in by default to be able to establish a connection from the web
console via VNC to the remote servers by using the IP configured within them. This could be easy if
we're in the same local network segment and have a direct connection. It's more complicated in
some other cases.
We're distinguishing between complex and simple environments. These would be e.g. the
characteristics of a simple environment:
•The server's IP doesn't change.
•The access (paths and firewalls) from the operator's PC to the servers has open ports and it
knows how to connect by using normal TCP/IP.
•We're able to install a remote control software within the server's host system or it already
has one.
The characteristics we consider to be the ones of a complex environment are the following:
•The server's IP changes (it's dynamic).
•There is no direct access from the operator's PC to the server we intend to monitor.
•We're unable to install any remote control software on the remote system.
There are also intermediate cases, e.g. the machines have a fixed IP, but we don't have direct
remote access from the operator's PC to the server via TCP/IP. In any case, there are three possible
ways to acquire remote access to these systems:
1. Directly:
It's possible to install e.g. an SSH server, to activate the remote desktop or to install a VNC server on
the host system. From the perspective of the operator's PC, it's completely sufficient if we're
inserting the remote system's IP into the client program which is running on it and it's ready. For
the 'simple' environments, this is the appropriate way to go. We strongly recommend to
use UltraVNC if you decide to use this method.
2. By using an inverse System:
We're referring to remote control systems which connect by using a server on the internet which
allows to connect both computers so they can 'talk' if the operator's PC communicates with the same
server on the internet, instead of just waiting to connect with an open TCP port. The internal
network wouldn't communicate with them in this way at all. This system, although useful in
complex environments, has many disadvantages such as the speed or the fact that if the server we're
required to control doesn't have access to the internet. In this case, we wouldn't be able to
communicate with it. We strongly recommend to useTeamViewer here.
3. By using a Direct Connection System:
UltraVNC allows to configure one proxy, so it's going to be the one which connects to the remote
server. We're going to connect with the intermediate server (proxy) and connect this one to the end
server. This is called 'Ultra VNC Repeater'. You can find more information about this method on
the UVNC Repeater page.
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On the picture below, you're looking at a basic working sketch of this system.

The UltraVNC tool itself allows you to conduct the setup graphically:

The connection to the VNC server utilizes the proxy to connect to the destination server, as we can
see on the picture below.
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38.2. Using Integrated VNC under Pandora FMS
By the Pandora FMS 'VNC' extension it's possible to have access from the web console itself, without
having to install additional software or doing besides that.
The only requirements are the following:
•Having a VNC server that includes the Java applet installed which listens on port 5800 of
each server we intend to manage remotely.
•Having the Java plug in installed on its browser.
•Having direct connection from the PC on which the operator is connected to the Pandora
FMS console and to the monitored server we intend to manage remotely. The connection is
required to grant access via port 5800 TCP.
If we fulfill these requirements, we only have to click on the flap with the 'VNC' extension within the
'Operation' view of an agent. We're going to see the following there:

Appearance of the VNC flap (first one on the left)
When the communication is reestablished, it's required to introduce a password which is configured
in the moment the VNC server is installed on the machine.
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Once we have introduced the password, we have access to the server "as if we were on site".

We recommend the use of UltraVNC. Besides being very strong, supporting connection coding and
allowing file transfer from one machine to another, it's a GPLv2 licensed free software.
However, the limitations of this system are mainly the following:
•It requires a connection between your PC and the machine you intend to monitor remotely.
If it's behind a firewall, a router or in the internet, it won't be able to connect.
•It requires to know the IP. With Pandora FMS, it could tell the agent which notifies the
current IP to it, which is going to know the appropriate IP, but sometimes it doesn't work
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very well. If it has several network adapters, if it doesn't update the IP by default or due to
other possible causes.
•It requires the installation of the UltraVNC software, which you're might not allowed to
install due to certain security policies in your location.
In cases in which the first mentioned point is the problem, we recommend to use the direct
connection method by using a proxy. If the methods shown here aren't working, you're required to
download a client program and execute it manually from your PC in order to connect to your
remote system.

38.3. Using TeamViewer under Pandora FMS
TeamViewer is one of the best remote management systems available. TeamViewer is able to use
intermediate servers on the internet to connect to its equipment, regardless of changes in the IP,
firewalls or other problems we've previously mentioned.
You only require three things:
•An internet connection on both ends (the server you intend to monitor and the operator's
PC).
•To take a note of the machine's ID and to remember the password.
•To install the TeamViewer software on the remote server.
Once it has been installed, you're required to assign an ID to the machine. You're also able to
configure a password for permanent access. The TeamViewer IDs have the format "XXX XXX XXX"
(nine digits). This is the required ID to connect to the server. We use the Enterprise feature called
'Customized Fields' to create this field within all agents and to insert the ID of each machine for this.
Please click on 'Configuration' > 'Agents' and 'Manage customized Fields' in order to create a
custom field. Once the creation process is finished, please click on 'Create' button.

Once the field is created, you're able to store the machine's ID there. It's '623 596 886' in this case.
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In this moment, you're required to go to the TeamViewer page, insert my ID and login to the system
as shown on the picture below.
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38.3.1. Technical Details about TeamViewer
TeamViewer is quite powerful. It allows to transfer files from one system to another.
These tools are connected to remote servers. The security could be a problem in cases we're very
demanding related to these concepts, e.g. legal questions and privacy of data. If you're using the
commercial version, there are some advantages regarding the above mentioned security issues.
This is a list of fixed connections within the remotely managed server in the moment of using a
fixed TeamViewer connection:
TCP
TCP
TCP
TCP

desktop:1379
desktop:1380
desktop:1381
desktop:1382

server530.teamviewer.com:http

ESTABLISHED

master4.teamviewer.com:http ESTABLISHED
server311.teamviewer.com:http ESTABLISHED
server311.teamviewer.com:http ESTABLISHED

TeamViewer also supports direct connections between client and server.
We strongly recommend to buy a license of TeamViewer to manage their servers to all Pandora FMS
Enterprise users. VNC is quite nice, but TeamViewer has a very efficient on the fly compression, and
you will experience an incredible remote access level when managing remote hosts with it.

38.4. Connecting remote systems using SSH/Telnet from Pandora FMS
Since the 4.0.2 version, Pandora FMS comes with a new extension which was designed to directly
connect to their devices by telnet or SSH. This feature is conducted by the 'Remote Gateway'
extension. You're required to conduct a special setup for this component, because it's not going to
be installed by default. This is an opensource feature, based on the 'anytermd' software, published
under GPL2 license.
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Pandora FMS uses a tool called 'anytermd' to create a 'proxy' between the user's browser and its
remote destination. This tool launches as a daemon which listens on a port. It executes a command
which forwards all output to the user's browser. That means all the connections are
conducted by the Pandora FMS Server and it has to be installed onto the telnet and SSH client.
You're looking at the the architecture's basic schema on the picture below.
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38.4.1. Setup and Installation
All sources are contained in the directory called 'extras/anytermd'.
Please make sure you have the gnu c++ compiler ('gccc++'), 'make', 'boostdevel' and 'zlibdevel'
installed.
Please execute:
make

Then install the binary to the directory called '/usr/bin' manually by executing the following
command:
cp anytermd /usr/bin

In order to run the server daemons, you're required to start them manually, since the Pandora FMS
Server or the console don't start up automatically. The Pandora FMS SSH / telnet extension is going
to look for a different instance of 'anytermd', running on port 8023 for telnet and port 8022 for SSH
connections.
You also have a start and stop daemon in the directory called 'contrib/anytermd'. Please copy it to
'/etc/init.d/anytermd' and execute it in the following way:
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/etc/init.d/anytermd start

It's going to use the 'pandora' user for execution by default. If you intend to change it, please alter
the script file for any other HTTPDbased user your system may have.

This script is going to use the ports 8023 and 8022. Please make sure these ports are
'open and clear' from the user browser to the console's web-server system.

You're now free to use the extension and connect to remote servers by telnet or SSH.
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39 Massive Operations
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39.1. Introduction
The Massive Operations feature allows you to conduct actions related to agents, modules, users,
alerts and policies in a massive way. In recent years, the importance of massive operations have
grown in largevolume environments. This functionality has been designed to facilitate the
administrators work in situations in which they have to deal with systems which contain a very
large amount of components.
You're able to access the massive operations features by clicking on 'Administration' and 'Massive
Operations' as shown below.

A piece of advice:
The PHP language requires an appropriate configuration of the timeout parameters. In order to do
this, please open the configuration file called 'php.ini' by entering the following command:
sudo vi /etc/php5/apache2/php.ini;

Please modify the timeout parameters as shown below.
max_execution_time = 0
max_input_time = -1

39.2. Massive Operations  Agents
It's possible to edit or delete agents by using the 'massive operations edition' feature.
Within the 'massive agents edition' subsection, it's possible to filter by 'destination', 'agents' and
'group' and to change general parameters like 'parent agent', 'group', 'execution interval' or
'operating system'.
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Within the 'massive agents deletion' subsection, it's possible to filter by group.

39.3. Massive Operations - Modules
There are three massive operations for the modules:
•Deletion
•Copying one module from one agent to another
•Edition
The 'massive modules deletion' feature allows you to select the modules to edit in the two following
modes:
•Modules Selection:
If you've picked 'selection by module', you're going to be able to filter by the type of module, to
select modules of this type and select the agents associated to these modules at the end.
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•Agents Selection:
If you've picked 'selection by agent', you're going to be able to filter by groups, to select the agents
of this group and to select the modules of the selected agents at the end.

The 'massive modules edition' feature allows the editing by module or by agent. If you've conducted
a search by module, it's possible to filter by the module's type or by modules and agents.
Subsequently, it's possible to edit the module's general parameters like 'warning value', 'execution
interval', 'post processing', etc.
The 'massive modules edition' feature allows you to select the modules to edit in the two following
modes:
•Modules Selection:
If you've picked 'selection by module', you're going to be able to filter by the type of module, to
select modules of this type and select the agents associated to these modules at the end.
•Agents Selection:
If you've picked 'selection by agent', you're going to be able to filter by group, to select agents of this
group and to select the modules of the selected agents at the end.
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Subsequently, you're going to be able to edit the general parameters as well as the 'warning' and
'critical' values, the execution interval, post processing, etc.
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The 'massive modules copy' feature allows you to copy one module's information to another agent's
modules. In order to do this, it's required to pick a group and a source agent. Subsequently, you're
able to pick the modules and the destination agent by using the 'filtering by group' feature.

39.4. Massive Operations  Users
It's also possible to add or to delete profiles which are associated to users. This feature can render
the user's management a lot easier, because they can be managed massively.
In order to add new profiles, you're able to pick profiles, groups and users.
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In order to delete profiles, you're required to fill out the profile, group and user information.

39.5. Massive Operations  Alerts
Within this section it's possible to add, delete or add actions, enable and disable alerts or put them
into standby mode. All these operations can be performed massively.
In order to add new alerts, it's possible to filter by group. To do so, it's required to select an agent,
module and the template to add.
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In order to delete alerts, it's possible to filter by group. To do so, it's also required to select a
template, group, agent and modules.

In order to add actions to alerts, it's possible to filter by group and to select agents, templates and to
select the action you intend to add.
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In order to delete alert actions, it's possible to filter by group and to select agents, templates and the
actions you intend to delete.

971

Massive Operations  Alerts

In order to enable or disable alerts, it's possible to filter by group. To do so, it's required to fill out
the information about agents, templates and two columns about enabling and disabling the alert
options.
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In order to assign a standby state to an alert, it's possible to filter by group. In order to do so, you're
required to fill out the information about the agents, templates and the alerts you're intending to
put into a standby state.
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39.6. Massive Operations  Policies
In this section, it's possible to perform two actions: Adding and deleting alerts within policies.
In order to add alerts, you're required to fill out the destination policy, the template to add, to
provide a regular expression to match the agents and modules of the policy.
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In order to delete policy alerts, it's required to fill out the destiny policy, the template to delete, to
provide a regular expression to match the policy agents and its corresponding modules.
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40 POLICIES
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40.1. Introduction
Pandora FMS is able to manage thousands of devices, containing thousands of modules and alerts.
We've developed the policy functionality with the purpose of rendering the administrators work a
lot easier as the systems which are the target of the monitoring could be composed of a very high
number of components.
The policy appliance allows you to propagate modules, alerts, external alerts and collections to the
agents in a centralized and homogeneous way by modifying its configuration files by the remote
edition feature called Agent Configuration.
The available operations pertaining to policies in general are the following:
•To create, delete and duplicate one policy
•To add and delete one or several existing agents
•To create, edit and delete one module
•To create, edit and delete one alert
•To create, edit and delete an external alert
•To add and delete an already existing collection
•To add and delete an already existing inventory module
•To link the policy to one or several adopted modules
The operations conducted within a policy are not going to be effective until the policy is applied.
The application of the different policies is managed by one queue, in which they could be
introduced in order to apply to an agent or to all of the policy. It's also possible to introduce the
application of one policy from the database, if the changes don't affect the remote configuration.
You may invoke the policy management by clicking on 'Administration' and 'Manage Policies' on the
left side of the Pandora FMS web console as shown below.

40.2. Adding a Policy
If you click on the 'Administration' and 'Manage Policies' menus, all available policies are going to
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be shown.

Please click on the 'Create' button to create a new policy. You have a policy creation screen here, in
which we're required to insert the name, the group to which it's going to belong to, and an optional
description.

40.3. Deleting a Policy
If you intend to delete any policy, please make sure that it doesn't have any agent associated to it.
If one policy contains agents, the delete button is disabled and a button to delete all its agents is
shown next to it. This button is going to introduce the deletion process into the queue. Once it has
been processed, the policy deletion button is going to be in an active state again.
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40.4. Duplicating a Policy
There is also a button to duplicate a policy. It's located in the middle of the policy operation
buttons.

The copy of the policy which will be created here is going to be shown as 'not applied', regardless of
the original policy's state.

40.5. Configuring a Policy
In order to configure the policy, please click on the policy's name under 'Administration' and
'Manage Policies' or access it directly by hovering the mouse over it and clicking on the policy you
intend to configure.

The policy configuration contains options for the following elements:
•Agents
•Modules
•Inventory Modules
•Alerts
•External Alerts
•Collections
•Linking
•Queue
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•Agent Plug Ins
The different executable actions aren't going to be applied until the policy is applied. If you're
adding an agent to the policy, you're e.g. able to create several modules and alerts, but they're not
going to come into effect until you're applying the policy.
If we e.g. have one policy applied and we're modifying or deleting elements, the changes aren't
going to come into effect until its next execution.
All changes are displayed shown within the 'Queue' window. You're able to introduce the policy into
the process queue there, in which it's going to wait for its turn to be applied.

40.5.1. Policy Propagation
Policy propagation means the activation of the modules, alerts and collections which are configured
within the defined agents. This means that these modules and alerts are going to be added to the
agents.
A policy can be propagated to a specific agent or a complete policy.
In order to propagate it to an agent, you're required to go to the 'Agents' section and choose to
which agent you intend to apply it to. If you intend to apply an entire policy, you're required to
open the 'Queue' section to do so.

40.5.2. Policy Queues Management

The policy operations queue contains a summary of the elements which have been changed since
their last application:
This list contains the elements which are required to be updated and the ones pending to delete:
•Pending to update
•Agents
•Adopted modules pending to link
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•Adopted modules pending to unlink
•Pending to delete
•Agents
•Modules
•Inventory Modules
•Alerts
•External Alerts
•Collections
This summary is going to show you whether you should apply the policy or not. Sometimes, a
button will be shown to apply them next to the icon of agents pending to apply.
If the pending changes only affect the database, e.g. changes in alerts, this button is going to
conduct the changes on this level only, so the application will be quicker.

If the configuration which affects the configuration files has been changed, e.g. if collections or local
modules have been modified, the application is complete.

Under summary, there is a button called 'Apply All', regardless of the pending modifications.

If we select to apply we're going to add the policy agents to the application queue. The Pandora
FMS Server will be in charge of applying the pending policies to the queue. If we refresh the screen,
we're able to see the application's progress. In the moment it's completed, it's going to be mentioned
in the queue as completed, along with the time which passed since it has finished the process.
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40.5.3. Agents
This window was designed to add or to delete agents from the policy.

40.5.3.1. Massive Actions
The upper part is intended to massively add or to delete agents.

You're able to filter them by group and with a substring. It's possible to conduct a multiple selection
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to add them to the policy by clicking on the arrow which points to the right. These agents are going
to be moved to the box on the right and associated to the policy in a 'pending to apply' mode.
The policy's agents could be deleted by multiple selection with the help of a filter in order to move
them into the box on the left with the arrow which points to the left. If you select one or several
agents to delete from the policy in this way, they will be shown as crossed out in the box on the
right. They can be re associated to the policy if you select them again in the left box and link them
as if they weren't.

40.5.3.2. Unit Actions
In the window shown below, there is a list, containing all the agents associated to the policy,
including the ones which are in a 'pending to delete' mode.

The agent's list was designed to filter by group, substring or an application state:
It displays:
•The agent's name
•The remote configuration
•The agent's state within the policy
•The number of unlinked modules in the agent
•The button to introduce this agent into the queue in order to apply it
•The date and hour of the last application
•The button of delete, undo and remove
If an agent is removed, it's going to be displayed with its name crossed out. In the place of the
deleted button, a new button (intended to undo the deletion and to link the agent to the policy
again) appears.

40.5.4. Modules
The modules menu allows to configure the modules which are going to be added to the policy.
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In order to add modules, you're required to pick the type of module in the dropdown menu, to
select one module, e.g. 'data server', 'network', 'red', 'plug in', 'WMI', 'prediction' and 'web' and to
click on the 'Create' button.

40.5.4.1. Creating a Data Server Module
The Data Server Modules are the modules which are going to be added to the software agents. In
order to work with these modules, it's necessary for the agents to have the remote configuration
enabled.
Please select the option 'Create a new data server module' and click on the 'Create' button in order
to create a new data server module.

Subsequently, a screen intended to configure all the module fields is going to be displayed. The field
called 'Data Configuration' is the one which allows you to introduce the module's code which is
going to be applied to the agents subscribed to this policy. This change will be contained in this
particular agent's 'pandora_agent.conf' file.
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You're able to gain access to the advanced options by clicking on the 'Advanced Options' button.
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It's possible to review the description of these particular features in the Templates and
Components section. There are two options: To fill out the fields or to have a previously defined
local component ready to invoke here.

40.5.4.2. Creating a Network Server Module
The network server modules are modules which are managed by the Network Server.
Please select the option called 'Create a new Network Server Module' and click on the 'Create'
button in order to create a new network server module.

Subsequently, a window intended to configure all the module fields is going to be displayed.
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Please click on the 'Advanced Options' button to gain access to the advanced options.

It's possible to review the description of these particular features and options in the Templates and
Components section. Please click on 'Create' button once all fields have been filled out.
Please keep in mind that the modules are quite similar most of the time. Instead of filling out the
fields any time one module is added, the best option is to preliminarily define it as a component and
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to use it as such. In order to use a component, please fill out the combo which is located under
'Using module component' in which it's possible to choose between the different component groups.

Once the group has been selected, another combo pops up in which you're able to choose the
component you intend to use.

In this example, we've selected the component called 'Catalyst CPU Usage' of the Cisco MIBs Group.
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Once the component is selected, it's possible to modify any of the fields. Please click on the 'Create'
button once all the fields have been filled out appropriately.

40.5.4.3. Creating a Module for the Complement Server
The modules of the complement servers are the modules which are getting managed by it.
In order to create a module for the complement server, please click on 'Create a new PlugIn Server
Module' and click on the 'Create' button.

In this moment, a window intended to configure all the module's fields is going to appear.
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You may gain access to the advanced options by clicking on the 'Advanced Options' button as shown
on the bottom left on the picture above.

You're also able to review the description of the above mentioned features and options within
the Templates and Components section again.
Once you have filled out all the fields appropriately, please click on the 'Create' button.
Please keep in mind that the modules are quite similar most of the time. Instead of always filling
out the fields any time a module is added, the best option is to preliminarily define it as a
component and to use it as such. The use of components is thoroughly explained in the section
called Creating a Network Server Module.

40.5.4.4. Creating a Module for the WMI Server
The modules of the WMI Server are the ones which are getting managed by it.
In order to create a module of the Network Server, please click on 'Create a new WMI Server
Module' and click on the 'Create' button as shown below.
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In this moment, a window intended configure all the module's fields is going to appear.

You may gain access to the advanced options by clicking on the 'Advanced Options' button as shown
on the bottom left on the picture above.
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It's also possible to review the description of these features and options in the Templates and
Components section.
Once all the fields have been filled out appropriately, please click on the 'Create' button.
Please keep in mind that the modules are quite similar most of the time. Instead of always filling
out the fields any time a module is added, the best option is to preliminarily define it as a
component and to use it as such.

40.5.4.5. Creating a Module for the Prediction Server
The modules of the prediction server are the ones which are getting managed by it.
In order to create a module for the prediction server, please select the option called 'Create a new
Prediction Server Module' and click on the 'Create' button.

Subsequently, a window intended to configure all the module's fields is going to appear.
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You may gain access to the advanced options by clicking on the 'Advanced Options' button.

Please feel free to review these features and options in the Templates and Components section.
Once all the fields have been filled out appropriately, please click on the 'Create' button.
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In this particular context, the modules of the prediction server are not considered
components.

40.5.4.6. Creating a Module for the Web Server
The modules of the web server are the modules which are getting managed by it.
In order to create a module for the web server, please select the option called 'Create a new Web
Server Module' and click on the 'Create' button.

Subsequently it's going to display a window intended to configure all the module's fields.

You may gain access to the advanced options by clicking on the 'Advanced Options' button.
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Please feel free to review these features and options in the Templates and Components section.
Once all the fields have been filled out appropriately, please click on the 'Create' button.

In this particular context, the modules of the web server are not considered
components.

40.5.4.7. Modifying a previously created Module
It's possible to modify all modules created in a preliminarily generated policy.
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In order to do so, please click on the module's name so the module configuration options are
shown.
Once they have been modified appropriately, please click on the 'Update' button.

If the policy module is renamed, the name is going to be renamed like any other field in
the moment the policy is applied.

If a module with the new name already exists in one of the agents in the moment the
policy module is renamed, this module is going to be adopted while the old module's
name is deleted.
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40.5.4.8. Deleting an already created Module
In order to delete the module from the policy and remove it from the agents that have it installed,
please click on the xshaped button on the right of the module's name. Once you've done that, the
module is still going to be shown but crossed out. Subsequently, the 'Delete' button will be replaced
by the 'Undo' button.

40.5.4.9. Using Plug Ins within the Policies
The format used is quite simple. You're only required to 'outwit' the system, declaring one module
for each type of module that the plug in returns. In order to do this, you're required to foreknow
how many modules the plug in would return. If you're not completely sure, you're able to choose to
register the plug in once and that the modules, which are going to be created, are going to work
from outside of the policy. The data will arrive, but we can't parametrize them by the policies,
because they are modules which are going to arrive without being associated to the policy.
All the data linked to one policy has to be previously defined. The policies don't specifically contain
'nondefined' information.
Supposing that we're going to execute this plug in which dynamically returns the free space in bytes
which all the units of the system have.
In this example, the plugin exit returns several unities (C:, D: and Z:)
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If you intend to manage them as policy modules, it's recommended to define several modules and
the real call of the plug in within only one of them. Please leave the field called 'module_plugin'
empty in any other cases.
module_begin
module_name C:
module_type generic_data
module_plugin cscript //B "%ProgramFiles%\pandora_agent\util\df.vbs"
module_end
module_begin
module_name D:
module_type generic_data
module_plugin
module_end
module_begin
module_name Z:
module_type generic_data
module_plugin
module_end

40.5.5. Inventory Modules
It's also possible to create inventory modules within a policy by picking one from the list of the
available ones in the system, thereby picking an interval and the credentials for it.
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Like the rest of the policy's elements, if we remove an inventory module, it's going to be shown as
crossed out. The 'Undo' button is going to be displayed instead in case you intend to undo the
action.

40.5.6. Alerts
The Alert menu allows you to configure the alerts which are going to be added to the policy.

40.5.6.1. Adding Alerts
In order to add an alert, you just have to link it to one of the predefined templates or to one module
which belongs to the policy and to click on the 'Add' button.

999

Configuring a Policy

40.5.6.2. Modifying Alerts
It's possible to add actions to alerts, to put them in a standby mode or to deactivate them.
If you intend to change any module or template, it's recommended to delete it and to create a new
one.

40.5.6.3. Deleting Alerts
In order to delete an alert from the policy and remove it from the agents that have it installed,
please click on the xshaped button on the right of the module's name. Once you've done that, the
alert is still going to be shown but crossed out. Subsequently, the 'Delete' button will be replaced by
an 'Undo' button.

40.5.7. External Alerts
The external alerts are very similar to the regular alerts. The difference is that this type allows you
to link alerts to agent modules which aren't contained in the policy module's main list. It's
sometimes very useful to only assign alerts to some agent modules but not to all of them.

40.5.7.1. Adding External Alerts
In order to create an external alert, you're required to fill out the form shown on the picture below.
The first field is intended to select the agent's modules. Only the ones which aren't contained in the
policies are mentioned here. The second field is intended to select the appropriate alert template.
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40.5.7.2. Modifying External Alerts
Considering how easy it is to create new external alerts along with their few variables, the
possibility of modifying external alerts doesn't exist. In order to modify an external alert, it's
recommended to just delete it and to create a new one.

40.5.7.3. Deleting External Alerts
In order to delete an external alert from the policy and remove it from the agents that have it
installed, please click on the xshaped button on the right of the module's name.

The deletion system is the same as the one of the regular alerts. The deletion isn't going to come
into effect until the policy is applied. The 'Delete' button is going to be replaced by an 'Undo' button
in order to undo an e.g. accidental deletion.

40.5.8. Agent Plug Ins
Since Pandora FMS 5.0 it's possible propagate the agent's plug ins easily by the plug ins editor
within the policies.
It's possible to add agent plug ins to be created in each local agent within a policy in the moment of
applying it.

40.5.9. Types of Modules
If a policy is applied, it's possible to review the different modules within the agent's view. If you
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click on 'Manage Agents' and 'Modules' menu, there are three different types of modules:

40.5.9.1. Adopted Modules
These modules were created in the policy with the same name of an already existing module within
the agent. When applying the policy, Pandora FMS is going to use the existing module's data
instead of creating a new one.

If you delete a policy, the adopted modules aren't going to be deleted from the agents. They're only
going to be defined as 'nonadopted' modules. The data column for these modules is going to look
like the one shown on the picture below.

40.5.9.2. Linked Modules
These modules are created in the policy. If you're applying the policy, they're also being created
within the agent. These are the average modules created in the policies.

You're able to link and unlink modules by clicking on 'Manage Agents' and 'Modules'. Please select
the appropriate module and click the button on the picture below in order to unlink the module ...
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... and this button to link it.

If you delete a policy, the linked and unlinked modules are deleted from the agents.

40.5.9.3. Unlinked Modules
If a module is unlinked, the future changes conducted in the policy aren't going to be applied onto
them. The unlinked modules are useful, because they allow to define 'individual exceptions' to
modules which belong to a certain policy. You're able to 'customize' an agent in a policy without
removing it from the policy and only for a specific module in this way.

The changes in the policies are only going to be applied if the module is linked again.

40.5.10. File Collections
A file collection is not just an option to policies  it's usually utilized in them. A file collection is a
group of files (e.g. scripts or executables) which are automatically copied to a specific directory of
the agent (under Windows or UNIX). The file collections allow to be propagated along with the
policies in order to be used by a group of agents, using a 'package' of scripts and modules which use
them.
First we learn how to use the file collections in the agent's view, how to conduct it manually, agent
by agent, without using collections, and how to do the same thing by using policies.
Our first task is to arrange a compilation of files. In order to do this, please go to the agent's
administrator. Subsequently, we're going to see a 'sub option' called 'Collections'. Please click on it
in order to create a new collection as we can see on the picture below.

Once you've created the file collection, please feel free to upload any appropriate file to it. These
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files can be binaries, scripts or data files. All files are moved to the same base directory.
It's extremely important that each file collection has its own base directory. In the console, file
collections are stored under a directory called '/pandora_console/attachment/collection', bearing a
name like 'fc_XXX', where 'XXX' is the collection's numerical ID. The file collections are also able to
contain subdirectories. The file collections are transferred as ZIP files to the agent.
File collections are only supported if you use the Tentacle transference mode.
On the second picture below, you can see how the example collection we've created
(fc_1383033439) has received two files:

If we go back to the mail collection screen, we can see both collections as a triangular icon, which
indicates a problem. This happens because the collections aren't synchronized. It's recommended to
synchronize them by clicking on the triangular icon shown below.

When a file collection is synchronized, a green arrowshaped icon is displayed as shown on the
picture below.

Once we've synchronized the collection, it's going to be applied onto the agent  this time without
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using any policies. Please go to the agent's administrator mode and look for the collection's
tabulator (it's a diskshaped icon). The available collections are going to be displayed there in order
to pick one of them and apply it to the agent, as you can see in the windows utilities example on the
picture below.

Now it has been applied. Next time the agent contacts the server, we're going to receive the file and
a little modification in the '.conf' file, which is going to look like this:
file_collection fc_1383033439

40.5.10.1. File Collections and Policies
This works in a similar way as the single agent collections. Instead of applying a collection on a
specific agent it's applied to one policy, as we can see below.
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It's very easy to use a module which works with a file included in the collection: Only refer to the
directory which contains the collection by using its fixed ID. This is an example which uses a plugin
module:

40.5.10.2. Location of File Collections within Agents
Each file collection has a 'short name'. In this example, it's called 'fc_1383033439', which means the
utilities, scripts or executables contained in the collection are located in '%Archivos de programa
%\pandora_agent\collections\fc_1383033439'. It's important to keep in mind that the collection is
sent in a compressed format to the agent, so this file collection should contain the unzip tool to be
able to unpack the file. Since the agent's version 3.2, this utility is installed under '%Archivos de
programa%\pandora_agent\utils'.
This information is important in order to use modules which work by using these files and to be
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able to specify the complete 'real' path.
This is another example:
If the collection's short name is 'fc_18', the location will be '%ProgramFiles
%\pandora_agent\collections\fc_18' in case the English language is used on this particular
computer.
Each file collection is stored in a different location in order to avoid the file collections to overwrite
each other or to create conflicts among them.
Any locally modified file (on the same system on which the agent is executed) will be overwritten
by the agent in the moment it establishes contact to the server. This is done in order to avoid local
modifications and to ensure the collections are identical in all the systems in which they've been
shown on. This mechanism utilizes the same method the remote configurations management does.
It's based on MD5 hashes.
This is an example of one plug in which uses the 'df_percent.vbs' file, contained in one collection
called 'fc_1383033439' for a windowsbased agent:
module_plugin cscript //B "%ProgramFiles%\pandora_agent\collections\fc_1383033439\df_percent.vbs"
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41.1. Introduction
The Pandora FMS Enterprise Version implements a data scaling device which allows you to conduct
a virtually distributed implementation, able to monitor an unlimited number of information by
utilizing an export server as long as you design it properly and break it up into different information
profiles.
The main idea consists of creating a hierarchical structure which distributes the information from
down to top, the top point being the more global one, which only collects an extract of basic
information of Pandora FMS installations on the lowest level, instead of collecting a bigger number
of information. This method allows to have a 'filtered' view and more information density for the
highest Pandora FMS installation.

The server which exports the data is hierarchically below the server which receives this information.
You're able to use this technology to conduct a reply of all data reported by a server in a different
sketch of the filtered view, although it could seriously affect the server's performance.
Each independent installation of Pandora FMS was designed to export those data to one or several
servers which can be selected by the administrator.
It's also possible to export data that originates from modules, so a hierarchically higher Pandora
FMS installation is able to receive important data.
The processing of events, its viewing, reports, users and permissions will be different for each
Pandora FMS installation. There will be installations totally different at all purposes. The higher
request could not be executed in realtime data refresh petitions, so these data is passively obtained.
There is no access to the monitored elements of lower petitions. The access security, the
information partition and access to privileged information is guaranteed by the architectural design.
The server which receives the data receives it by an XML file, similar to the ones agents would
generate, in a way that they only require to have a data server available. The higher server (the one
which receives the data) only receives data. It doesn't receive events and can't reuse the alerts
defined on the server which receives the data first. It should define its own alerts and reports,
customized graphs, etc.
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41.2. Adding a Target Server
In order to export module data, the first step is to define a scaling server, containing different
configuration options which would allow to export a link between a server (or client) which exports
and a server which imports.
Please click on 'Administration' > 'Manage Servers' > 'Export Targets' and on the 'Create' button in
order to create a Target Server.

Once you've clicked on the 'Create' button, a window like the one shown on the picture below is
going to appear.

The configurable fields pertaining to this particular feature are the following:
Name:
The Pandora FMS server's name.
Export Server:
The combo intended to pick the export server's petition which is going to be used to export the data.
Prefix:
The prefix used to add to the agent's name which sends the data, e.g. if the data of an agent named
'Farscape' is resent and its prefix in the export server is 'EU01', the resent agent's data is going to
show up with an agent name 'EUO1Farscape' on the destination server. This allows you to learn the
data's origin in case of a server we receive different sources of information from, coming from
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different Pandora FMS servers, with which we would force a name duplicity. The server will always
add the '_' character after the prefix, so it would be empty. The '_' character is always going to be
put in front of the agent's name on the destination server.
Interval:
It defines the time interval and how often (in seconds) you intend to send the data which are
considered unresolved. The data is always going to be collected from the original source. If an agent
collects data every 300 seconds and there are a 1000 seconds configured here, means that the
server is going to send what has been collected until this moment. In this case, this would mean to
receive three packages by this agent with an interval of '300'.
Target Directory:
It's the remote target directory in which it's going to deposit the data. It's used for SSH or FTP only.
Address:
The dataserver address which is going to receive the data.
Transfer Mode:
The file transfer mode. You're able to pick the following modes:
•Local: The datareceiving server is on the same machine as the export server.
•SSH: The transfer address if the transference is conducted by SSH. In this case it's necessary
to copy the certificate of the server which exports the data to the server which receives it.
•FTP: The transfer is conducted by using the FTP protocol.
•Tentacle: The transfer is conducted by using the Tentacle protocol (recommended).
User:
The user for FTP.
Password:
The user's password for FTP.
Port:
The port used in the file transfers. The default port for the Tentacle protocol is '41121'.
Extra Options:
The field for additional options like the ones Tentacle requires to work with certificates.
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There is an example on the image below. In order to create the server, please click on the 'Add'
button once all fields have been filled out appropriately.

41.3. Editing a Target Server
In order to edit a target server, please click on the target server's name or on the wrenchshaped
icon as shown on the picture below.

41.4. Deleting a Target Server
Please click on the trash icon which is located on the right side of the target server's name in order
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to delete it.

41.5. Linking a Target Server to a Module
In order to scale the information, you're required to select the modules one by one which are able to
send the information to a higher instance. In order to do this, the Pandora FMS console's module
editor implements an option which allows you to assign one export server for each type of data.
In order to edit a module within an agent, you're required to pick one by clicking on
'Administration' > 'Manage Monitoring' and 'Manage Agents'.
When the filtering is completed, please click on the module's direct access which is located below
the agent's name (this particular type of direct access is displayed by hovering the mouse over the
agent's name).

In order to edit a module, please click on the module's name. In this example, the module called
'cpu_user' is selected.
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If you click on the module's name, its configuration window is going to appear. In order to export
the data, you're required to invoke the advanced options for the module. Please click on the
'Advanced Options' button to do so.

Once you have opened the advanced options, please pick the server within the combo you intend to
export the data to, which is located in the 'Export Target' option. It's the one in which the 'none'
option is defined as the default value.

Please click on the 'Update' button so that Pandora FMS is able to begin the dataexporting process
to the afore selected server.
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42 NETFLOW
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42.1. Introduction
The Pandora FMS versions 5 and above are designed to monitor the IP traffic by using the NetFlow
protocol. This protocol allows to you review the traffic's most useful patterns and general data.
'NetFlow' is a network protocol, developed by Cisco Systems to collect IP traffic information. It has
become an industrial standard for network traffic monitoring and is currently supported by several
platforms besides Cisco's IOS and NXOS like Juniper devices, Enterasys Switches and operating
systems like Linux, FreeBSD, NetBSD and OpenBSD.

42.1.1. NetFlow
NetFlowcapable devices (NetFlow probes) are generating NetFlow records, which consist of small
chunks of information which are sent to a central device or NetFlow Server (or NetFlow collector),
which stores and processes that information.
Data is transmitted using the NetFlow protocol via UDP or SCTP protocols. A NetFlow record is a
small packet which only contains statistical information about a connection, not the whole raw data
or the payload.
There are several NetFlow implementations that may differ from the original specification and
include additional information, but most of them provide at least the following:
•The source's IP address.
•The target's IP address.
•The source's UDP or TCP port.
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•The target's UDP or TCP port.
•The IP protocol.
•An interface (SNMP ifIndex)
•The type of service.
With time, some manufacturers have designed similar protocols with different names but for the
same purpose:
•'Jflow' or 'cflowd' from Juniper Networks
•'NetStream' from 3Com/H3C/HP
•'NetStream' from Huawei
•'Cflowd' from Alcatel Lucent
•'Rflow' from Ericsson
•'AppFlow'
•'sFlow'

42.1.2. The NetFlow Collector
A NetFlow collector is a device (a PC or a Server), placed in a network to gather all the NetFlow
information which is sent by routers and switches.
A NetFlow Server is required to receive and store that information. Pandora FMS uses 'nfcapd' for
this purpose, and it's required to be installed before Pandora FMS is able to process any NetFlow
related data. Pandora FMS starts and stops this server automatically in the moment the need arises.

42.1.3. The NetFlow Probe
Probes are usually NetFlowcapable routers, configured to send NetFlow data to its collector  in our
case, a Pandora FMS server with 'nfcapd' running.
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42.2. Installation and Requirements
Pandora FMS uses an opensource tool called 'nfcapd' to process all NetFlow traffic. This daemon is
automatically started by the Pandora FMS Server. This system stores the data in binary files at a
specific location. You're required to install 'nfcapd' on your system before working with NetFlow.
'nfcapd' listens on port 9995 UDP by default. Please keep in mind to open port 9995 UDP in case
you have firewalls in place.

42.2.1. Installation of 'nfcapd'
You're required to install 'nfcapd' manually, because Pandora FMS is not going to install it by
default.
For
more
information
on
how
to
install
it,
please
visit
the
Official NFCAPD Project Page.
Pandora FMS uses the directory '/var/spool/pandora/data_in/netflow' by default to store all
NetFlow data. The 'nfcapd' daemon is going to point to this directory when it's getting started by the
Pandora FMS Server. Do not change it unless you know exactly what you're doing.
Pandora FMS requires the nfdump version 1.6.8p1 in order to process any NetFlow data properly.
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In order to test your 'nfcapd' installation manually, please execute the command below.
nfcapd -l /var/spool/pandora/data_in/netflow -D

Please keep in mind that the Pandora FMS Console (and more specifically the web server which
hosts it) requires access to the directory of '/var/spool/pandora/data_in/netflow' in order to read
any NetFlowrelated data files.

42.2.2. The NetFlow Probe Installation
If a NetFlow capable router is not available, but you use a Linux server to route your traffic, you
may install a NetFlow software probe which sends all NetFlowrelated information to its server.
In Linux there is a program called 'fprobe' which obtains the traffic and sends it to a NetFlow
Server. By this program you're able to generate NetFlow traffic which goes through its interfaces,
e.g.:
/usr/sbin/fprobe -ieth0 -fip 192.168.70.185:9995

Once the traffic has been generated, you're able to review the traffic's statistics by entering the
following command:
nfdump -R /home/netflow_data/

The above mentioned command displays information similar to the one shown below.

Aggregated flows 1286
Top 10 flows ordered by packets:
Date flow start
Duration
Packets
Bytes Flows
2011-12-22 20:41:35.697
901.035
2105
167388
4
2011-12-22 20:41:35.702
900.874
1275
202984
4
2011-12-22 20:48:15.057
1.347
496
737160
1
2011-12-22 20:48:14.742
1.790
409
607356
1
2011-12-22 20:46:02.791
76.616
370
477945
1
2011-12-22 20:48:15.015
1.389
363
22496
1
2011-12-22 20:46:02.791
76.616
303
24309
1
2011-12-22 20:48:14.689
1.843
255
13083
1
2011-12-22 20:48:14.665
1.249
227
335812
1
2011-12-22 20:48:21.350
0.713
224
330191
1
Top 10 flows ordered by bytes:
Date flow start
Duration
Packets
Bytes Flows
2011-12-22 20:48:15.057
1.347
496
737160
1
2011-12-22 20:48:14.742
1.790
409
607356
1
2011-12-22 20:46:02.791
76.616
370
477945
1
2011-12-22 20:48:14.665
1.249
227
335812
1
2011-12-22 20:48:21.350
0.713
224
330191
1
2011-12-22 20:48:15.313
1.603

Proto
TCP

Src IP Addr:Port

Dst IP Addr:Port

192.168.60.181:50935 ->

192.168.50.2:22

TCP

192.168.50.2:22

->

192.168.60.181:50935

TCP

157.88.36.34:80

->

192.168.50.15:40044

TCP

91.121.124.139:80

->

192.168.50.15:60101

TCP

192.168.50.15:80

->

192.168.60.181:40500

TCP

192.168.50.15:40044 ->

157.88.36.34:80

TCP

192.168.60.181:40500 ->

192.168.50.15:80

TCP

192.168.50.15:60101 ->

91.121.124.139:80

TCP

178.32.239.141:80

->

192.168.50.15:38476

TCP

137.205.124.72:80

->

192.168.50.15:47551

Proto

Src IP Addr:Port

Dst IP Addr:Port

TCP

157.88.36.34:80

->

192.168.50.15:40044

TCP

91.121.124.139:80

->

192.168.50.15:60101

TCP

192.168.50.15:80

->

192.168.60.181:40500

TCP

178.32.239.141:80

->

192.168.50.15:38476

TCP

137.205.124.72:80

->

192.168.50.15:47551

TCP

89.102.0.150:80

->

192.168.50.15:52019
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212
313432
1
2011-12-22 20:48:14.996
191
281104
1
2011-12-22 20:51:12.325
201
245118
1
2011-12-22 20:52:05.935
167
211608
1
2011-12-22 20:41:35.702
1275
202984
4

1.433 TCP

212.219.56.138:80

->

192.168.50.15:36940

46.928 TCP

192.168.50.15:80

->

192.168.60.181:40512

34.781 TCP

192.168.50.15:80

->

192.168.60.181:40524

900.874 TCP

192.168.50.2:22

->

192.168.60.181:50935

Summary: total flows: 1458, total bytes: 5.9 M, total packets: 15421, avg bps: 49574, avg pps:
15, avg bpp: 399
Time window: 2011-12-22 20:40:46 - 2011-12-22 20:57:21
Total flows processed: 1458, Records skipped: 0, Bytes read: 75864
Sys: 0.006s flows/second: 208345.2
Wall: 0.006s flows/second: 221177.2

If your system works properly, the following chapter is intended to configure Pandora FMS in order
to use this particular configuration appropriately.

42.3. Working with NetFlow under Pandora FMS
Pandora FMS doesn't store NetFlow data in its database. The information is processed on demand in
order to render reports.
Pandora FMS works with NetFlow data by using filters, which are sets of rules that match certain
traffic patterns. A rule can be as simple as 'all the traffic from the 192.168.70.0/24 subnet' or a
complex 'pcap' filter expression.
Once the filters are created, we're required to define reports that determine how the information
matched by those filters is going to be displayed (e.g. charts and tables) and the time frame. The
NetFlow reports can be accessed on demand like any other Pandora FMS reports.
There is also a live NetFlow Viewer to analyze the traffic, modify and create rules on the spot. It can
be very useful to investigate problems or temporarily display a chart that we don't intend to save for
a later usage.

42.3.1. Enterprise Version: Analysis under Pandora FMS
The enterprise version of Pandora FMS allows you to store average traffic values for any filters as
Pandora FMS modules. This feature allows you to configure alerts, generate combined charts or
work with it as with any other Pandora FMS module. In order to obtain more information, please
visit
the
section
called
NetFlow Monitoring by a Prediction Server.

42.3.2. Configuration
First of all, you're required to authorize NetFlow in order to become accessible from the 'Operation'
and 'Administration' menus.
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You can find the NetFlow option in the 'Configuration' chapter of the 'Administration' menu in
which we specify the path in which the files of the Netflow traffic are captured, e.g. '/tmp/netflow'.
It's also very important to determine whether the path to the 'nfcapd' daemon is appropriately
specified or not.

The configurable fields pertaining to this particular feature are the following:
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Data Storage Path:
The directory in which the NetFlow data files are stored. IMPORTANT: The disk's access speed on
which the NetFlow data is stored is usually the limiting performance factor.
Daemon Interval:
The time interval in seconds for the data rotation. The recommended value is '3600'. A bigger
interval means potentially bigger files, which means less I/O overhead, but it also renders accessing
the data for a specific time interval slower.
Daemon Binary Path:
The path to the 'nfcapd' binary.
Nfdump Binary Path:
The path to the 'nfdump' binary.
Nfexpire Binary Path:
The path to the 'nfexpire' binary. This program was designed to delete old NetFlow data.
Maximum Chart Resolution:
The maximum number of points which a NetFlow Area Chart is going to display. The higher the
resolution the lower the performance. Values between '50' and '100' are recommended here.
Disable Live View Custom Filters:
If enabled, only Netflow filters previously created by an administrator can be used in the Netflow
live view.
Netflow max. Lifetime:
The NetFlow data which are older than the specified number of days are going to be deleted.
Once the NetFlow configuration is enabled, the Pandora FMS Server is required to be restarted in
order to be able to start the 'nfcapd' server. This server must be properly installed and accessible
from the system path. Please check the server logs if you're unsure on that. This server is not going
to appear in the Pandora FMS server view mode, because it isn't considered a Pandora FMS Server.

42.4. Filters
You may access the creation and edition of filters by clicking on 'Administration' and 'NetFlow
Filters'. This section contains a list of already created filters which can be of course altered or
deleted.
The configurable NetFlow filters pertaining to this particular feature are the following:
•

Name: It's recommended for the filter's name to be as descriptive and clear as necessary.

•

Group: A user is only able to create a filter or edit the group's filters it has access to.

•

Filter: There are two types of filters: Basic and advanced. Advanced filters allow the usage
of advanced expressions in the same format as 'nfdump'. Basic filters can filter traffic by
source and destination IP and source or destination port. Lists of commaseparated IPs or
ports are also accepted here.

•

Aggregate by: All traffic data can be grouped by one of the following fields:

•

IP
Origin: It
displays
the
traffic
of
different
origin
for
each
IP.
IP Destination: It displays the traffic of different destinations for each IP.
Origin Port: It displays the traffic for each port of different origins.
Destiny Port: It displays the traffic for different destinations for each port.
Protocol: It
displays
the
traffic
for
each
protocol.
Any: The total data is going to be displayed by this one.
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•

Output Format: The data is going to be displayed in the selected unit:
Kilobytes.
Kilobytes per second.
Megabytes.
Megabytes per second.
Basic web traffic filter example:

Advanced intranet traffic filter example:
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Here are other examples of advanced filters:
•Capture traffic to or from 192.168.0.1:
host 192.168.0.1

•Capture traffic to 192.168.0.1:
dst host 192.168.0.1

•Capture traffic from 192.168.0.0/24:
src net 192.168.0.0/24

•Capture HTTP and HTTPS traffic:
(port 80) or (port 443)

•Capture all traffic except DNS:
port not 53

•Capture SSH traffic to 192.168.0.1:
(port 22) and (dst host 192.168.0.1)

42.5. Reports
Netflow reports are integrated with Pandora FMS reports (see Reports for more information).
To create a report item, choose one of the available netflow report items.
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And configure it. The following options are available:

•Type: Item types will be explained below.
•Filter: Netflow filter to use.
•Description: Item description.
•Period: Length of the interval of data to display.
•Resolution: Data will be retrieved in blocks of size equal to the resolution. If Period /
Resolution is bigger than the configure maximum chart resolution the resolution will be
dynamically readjusted. For example, for a period of 1 day and a resolution of 1 hour 24
points will be drawn in the chart.
•Max. values: Maximum number of elements for aggregates. For example, if a chart of
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HTTP traffic is drawn aggregated by source IP address and Max. values is set to 5, only 5 IP
addresses will be shown.
There are five types of netflow report items:
•Area chart: An area chart, either aggregated or unaggregated.

•Pie chart: An aggregated pie chart.

•Data table: A text representation of the area chart.
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•Statistics table: A text representation of the pie chart.

•Summary table: Traffic summary for the given period.

42.6. Netflow live view
Filters can be visualized live from "Operation / Netflow Live View". This tool allows you to preview
changes made to a filter and save it when the desired result is achieved. It is also possible to load
and modify already existing filters.
See Reports and Filters to learn how to configure live view options.
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To modify an existing filter load if from the Load filter selector, make the desired changes and click
on Update current filter.

To create a new filter, configure it, click on Save as new filter, enter a name and optionally select a
group and click on Save as new filter again.
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43 SATELLITE SERVER
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43.1. Introduction
The Satellite Server is used for network and remote systems monitoring and discovery. It can
discover network elements (routers, switches, etc) using SNMP or ICMP, or Windows (using WMI)
or Linux (using SNMP) servers. This is no ordinary server, it can be considered to be a broker agent
with extended functions. It is an exclusive component for the Enterprise version. It is especially
useful to monitor inaccessible, by the Pandora Server, remote networks, where a software agent just
isn't and option.

This server doesn't require a connection with the pandora database. It sends all information in XML
format using the tentacle protocol like and agent.
The satellite server can be used in Windows and Linux alike although the installation process in
both cases is a little different.
This server has some characteristics witch make it unique and more than recommended on many
occasions:
•It can execute network tests (ICMP, Latency and SNMP v1 and v2) at an extremely high
pace (500 checks per second).
•It only sends information to the server after some period of time (300 seconds by default),
but it can execute the latency, ICMP and SNMP tests within a smaller interval (30 seconds
for example). This way it can notify the Pandora Server almost instantly when a change in
the status is detected. This status changes must be previosly defined if the module type isn't
a generic_proc type (network interfaces or general network connectivity for example)
•It doesn't require connection to the database. It sends all files in XML format the same way
as an independent server, similar in many ways to a broker agent or an export server.
•It has an autodiscovey mechanism for SNMP and WMI. Once an agent is detected (by IP
address), it detects the dynamic elements (network interfaces, storage) and monitors them
automatically.
•In Windows systems it can detect the discdrive, CPU, and memory.
•In systems with SNMP it can detect the status of the interfaces, inbound and outbound
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traffic for each interface and the name of the system.
•The autogenarated modules can be modified, like every other module, administrating the
agent from the console like any other agent in the massive operations menu and for these
modules from the Satellite section.
•Agents can be created directly by the creation o an agent configuration file in the satellite
server directory for agent configuration files.

43.2. Installation
The Satellite Server is distributed in binary format this way no additional library is required. In both
Windows and Linux versions the functionality of this server is the same. In Windows systems it is
installed as a service and in Linux systems it is installed as a daemon. The configuration file and
specifications in both cases are the same.

43.3. Satellite Server Installation in Linux Systems
Once downloaded the binary witch contains the satellite server we must go to the download
directory with root privileges and extract the files from the binary:

The a satellite_server will be created. We must enter that folder typing:
cd satellite_server/
Before proceeding with installation it is necessary to clarify that nmap, wmic and braa are
absolutely necessary for the Satellite Server:
The Satellite Server only functions with the following nmap versions: 5.511; 6.00; 6.01; 6.25; 6.40
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The 6.46 version of nmap isn't compatible with the Satellite Server.

In the installer the Braa and Wmic packages are included. NMAP must be installed
independently. To download NMAP you can visit the oficial NMAP
website: http://nmap.org/
To install the Satellite Server we can just follow the instructions in the following image:

Once finished we need to edit the satellite_server.conf file, located in /etc/pandora/ To start the
Satellite Server we need to type the following:
sudo /etc/init.d/satellite_serverd start
In case of an error take a look at the satellite_server.log file, located in /var/log/

43.4. Windows Installation
The Satellite Server can be installed following these simple steps:
We start by chosing the installation language:
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Then we click on Next

Then we choose where to install the Satellite Server:
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Installation of WinPCap is required. The WinPCap installation window would appear at this step of
the installation process:
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Then we must configure WinPCap to start on when system starts.
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Once finished the installation of WinPCap we would see the following window:
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The the license number must be introduced:
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Then the parameters of the recon task must be configured:
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At the end a restart of the system is required for all changes to take place.
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Once finished the Satellite Server can be started from the start menu.
43.5. Configuration
All parameters that require a timeout or some time are specified in seconds, for example 300 = 5
minutes.
It is important to keep in mind that the latency and snmp intervals are specific for the status
change. In case of Boolean checks (port or machine status) the threshold witch defines the change
of state is automatic. For the numerical values (latency, network traffic in an interface, disk space,
CPU, etc) it is based in a threshold that must be defined in each module.

43.5.1. agent_interval xxx
300 seconds by default (5 minutes), it creates agents with an interval of 5 minutes. Information ins't
send to the server till this time has passed. Independently that the checks done by the network
server have a lower interval.

43.5.2. xxxxxx_interval xxx
Executes all checks (latency, snmp, etc) with some interval. If the current information is different
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compared with the previous one it sends it instantly. If it is the same it will send it when the agent
interval has passed. It is useful to do intesive checks and notify only in case of a status change.

43.5.3. xxxxx_retries xxx
Number of retries in checks (latency, snmp, ping...)

43.5.4. xxxxx_timeout xxx
Timeout in seconds for the SNMP, Latency and Ping checks.

43.5.5. xxxxx_block xxx
Forces the server to execute the checks in blocks of XXX checks. The higher the number (500 tops)
the more capacity it would have, but with an increased latency. In some cases it mind be
recommended to lower this number (latency, ping and snmp)

43.5.6. xxxxx_threads n
Number of assigned threads to every type of check. It depends on the capacity (CPY and Memory)
of the machine. The higher the threads more pressure would be put on the machine but the
processing speed would be higher for the satellite server.

43.5.7. log_file /dev/null
Satellite server logfile. It can grow quickly, so it is recommended, if not going to be used, to be
redirected to /dev/null/. It is usefull at the beginning to try and discover possible errors and later
on comment it.

43.5.8. recon_task xxxxx[,yyyy]
IP Address and network addresses for autodiscovery for example:
192.168.50.0/24,10.0.1.0/22,192.168.70.64/26

43.5.9. server_ip <ip>
Pandora FMS Server ip address where the information is send using the tentacle protocol (port
41121/tcp)

43.5.10. recon_mode [icmp,snmp,wmi]
Autodiscovery mode. The system would use the following protocols to in recon checks:
•ICMP: It would just check if the host is alive and the latency time.
•SNMP: If capable it would look for all the interfaces and get it's trafic, general status etc..
It can only use v1 and 2 of SNMP.
•WMI: Similar to the previous but in this case it would show: CPU Usage, Memory and
Diskdrives
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43.5.11. recon_community aaa,bbb,ccc...
States a list of SNMP communities to be used in autodiscovery mode.

43.5.12. wmi_auth Administrator%password
Specifies a list of groups of User%Password, f.e: admin%1234,super%qwerty. This list is used in
autodiscovery mode.

43.5.13. agent_conf_dir <path to agente conf dir>
In this directory the config files are automatically of each agent discovered by the satellite server is
stored.

43.5.14. group <grupo>
Specifies the default group for the agents created by the Satellite Server.

43.5.15. daemon 1|0
When set to 1 starts the daemon in the background (by default).

43.5.16. hostfile <file>
It is an alternative method for network scanning. A file is provided with an adress in each line. It
can include the hostname as well.

43.5.17. pandora_license xxxxxxx
Here you must input the license number of your Pandora FMS server the same way it appears in the
Setup>Licency section. The total number of agents is verified in the pandora console.

43.5.18. remote_config 1|0
Specifies if the autodiscovery agents have enabled remote config to edit them from the console.

43.6. Specific Configurations (per agent)
In addition to autodiscovered modules, all kinds of TCP, SNMP or WMI tests can be added, using a
similar syntax to the local modules in software agents.
Status of the Interface (SNMP). The Satellite Server detects automatically each interface.
module_begin
module_name if eth1 OperStatus
module_description IP address N/A. Description: The current operational state of the interface.
The testing(3) state indicates that no operational packets can be passed.
module_type remote_snmp_string
module_snmp 192.168.70.225
module_oid .1.3.6.1.2.1.2.2.1.8.3
module_community artica06
module_end

Conectivity to a machine (using PING)
module_begin
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module_name ping
module_type generic_data
module_ping 192.168.70.225
module_end

General SNMP check. In this case the server extracts automatically the traffic for each interface with
it's descriptive name.
module_name if eth0 OutOctets
module_description The total number of octets transmitted out of the interface, including
framing characters.
module_type remote_snmp_inc
module_snmp 192.168.70.225
module_oid .1.3.6.1.2.1.2.2.1.16.2
module_community artica06
module_end

CPU WMI usage check(percentage).
module_begin
module_name CPU
module_type generic_data
module_wmicpu 192.168.30.3
module_wmiauth admin%none
module_end

Memory free wmi check(percentage).
module_begin
module_name FreeMemory
module_type generic_data
module_wmimem 192.168.30.3
module_wmiauth admin%none
module_end

General WMI Querry
module_begin
module_name GenericWMI
module_type generic_data
module_wmiquery 192.168.30.3
module_wmiauth admin%none
module_end

To introduce a threshold we must do it in the text definition of the module and the definition in the
console for each module (module_min_warning, module_min_critical):
module_begin
module_name latency
module_type generic_data
module_latency 192.168.70.225
module_min_warning 80
module_min_critical 120
module_end

Manually we can create execution modules. The scripts or commands that the satellite server
executes must be previously established and available for the server to use. The use of module_exec
can make the performance speed of the satellite server to shrink.
module_begin
module_name Sample_Remote_Exec
module_type generic_data
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module_exec /usr/share/test/test.sh 192.168.50.20
module_min_warning 90
module_min_critical 95
module_end

43.7. General view of all agents in the console
If the configuration of the satellite server is correct we should be able to see the following in Agent
Detail:

Generally in all machines ICMP (Ping and Latency) modules would be created but in some
machines SNMP and WMI modules can be created.
In machines witch have enabled WMI the following modules can generate.
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In machines with enabled SNMP the following modules will generate:

In the massive operations menu of the pandora console there is a specific section for the satellite
server where different edition, deletion actions can be performed on agents and modules massively.
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44 HIGH AVAILABILITY
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44.1. Introduction
Pandora FMS is a very stable application (thanks to the test and improvements included in each
version and to the hundred of fails opened by users and that have been solved.In spite of this, in
critical environments and/or with much load, it is possible that it would be necessary to distribute
the load in several machines, being sure that if any component of Pandora FMS fails, the system will
not be down. Pandora FMS has been designed to it would be very modular. Any of its modules
could work in an independent way. But it has also been designed to work with other components
and for being able to take the load from those components that have been down.
The Pandora FMS standar design could be this one:

Obviously, the agents are not redundants. If an agent is down,it makes no sense to execute another
one, so the only cause for than an agent downs is that data could not be obtained because the
execution of any module is failing, and this could not be solved with another agent running in
parallel, or because the system is isolated or fails. The best solution is to make redundancy of the
critical systems regardless if they have Pandora FMS agents or not and so to make redundancy or
these systems monitoring.
It is possible to use HA in several scenaries:
•Data Server Balancing and HA.
•Network Servers,WMI, Plugin, Web and Prediction Balancing and HA
•DDBB Load Balancing.
•Recon Servers Balancing and HA.
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•Pandora FMS Console Balancing and HA.

44.1.1. Data Server Balancing and HA
This is the more complex setting, so in the level of Pandora FMS it is not necessary to have specific
knowledges about the server installation.You should use another tool to implement HA and the load
balancing instead: commercial hardware tools that implements HA and balancing or through
OpenSource solutions such as vrrpd, LVS or Keepalive.
For the Pandora FMS dataserver you will need to install two machines with one configured Pandora
FMS dataserver (and differents hostname and server name). You should also configure a Tentacle
server in each of them and, if it would be necessary, an SSH/FTP server.Consider that you need to
copy the keys of each machine in the server (SSH). It is easier through Tentacle, so you only need to
reply the configuration. Each machine will have a different IP, and the balancer will give (sa,e as
with MySQL cluster) only one IP address to which the agents will connect with to send data.The
balancer will send the data to the corresponding server.
If one fails, the HA device «promote» one of the active servers that are availables and the Pandora
FMS agents will connect with the same address that they used before, without noticing the change,
but in this case, the load balancer will not send the data to the server has failed, but to another
active server.You do not need to change anything in Pandora FMS dataserver.Even each server
could keep its own name, useful to know if any of them has down in the server state view.Pandora
FMS data modules could be processed by any server and a preassignation is not necessary. It is
designed this way so it would be possible to implement HA in an easier way.
Another way to implement the HA is though the sending from the agents, to two different servers,
one of them for reserve (HA Active/Passive) just in case that the main one fails, or two different
ones at the same time, replying data in two different and independent instances of Pandora FMS.
This is described next as "Balancing in the Software Agents"
At the end of the chapter is described the mechanism to implement HA and Load balancing with
LVS and Keepalive on a TCP service that could be the Tentacle port (41121) or the SSH port, FTP or
another one.The same procedure could be used to cluster two or more systems. In this case the
Pandora FMS Web will be useful through an Apache.
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44.1.1.1. Balancing in the Software Agents
From the software agents it is possible to do a balancing of Data servers so it is possible to configure
a Data server master and another one for backup.
In the agent configuration file pandora_agent.conf, you should configure and uncomment the
following part of the agent configuration file:
# Secondary server configuration
# ==============================
# If secondary_mode is set to on_error, data files are copied to the secondary
# server only if the primary server fails. If set to always, data files are
# always copied to the secondary server
secondary_mode on_error
secondary_server_ip localhost
secondary_server_path /var/spool/pandora/data_in
secondary_server_port 41121
secondary_transfer_mode tentacle
secondary_server_pwd mypassword
secondary_server_ssl no
secondary_server_opts

There are the following options (for more information, go to the Agents Configuration chapter.
•secondary_mode: Mode in which the secondary server should be. It could have two values:
•on_error: Send data to the secondary server only if it could not send them to the
main server.
•always: Always sends data to the secondary server not regarding if it could or not
connect with the main server.
•secondary_server_ip: Secondary server IP
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•secondary_server_path: Path where the XML are copied in the secondary server,usually
/var/spoo//pandora/data_in
•secondary_server_port: Port through the XML will be copy to the secondary server in
tentacle 41121, in ssh 22 are in ftp 21.
•secondary_transfer_mode: transfer mode that will be used to copy the XML to the
sercondary server, tentacle, ssh, ttp etc
•secondary_server_pwd: Password option for the transfer through FTP
•secondary_server_ssl: Yes or not should be put depending if you want to use ssl to transfer
data through Tentacle or not.
•secondary_server_opts: This field is for other options that are necessaries for the transfer.

44.1.2. Balancing and HA of the Network Servers, WMI, Plugin, Web and Prediction
This is easier. You need to install several servers, network,WMI, Plugin, Web or Prediction, in
several machines of the network (all with the same visibility for the systems that you want
monitor). All these machines should be in the same segment (so as the network latency data
whould be coherents)
The servers could be selected as primaries.These servers will automatically collect the data form all
the modules assigned to a server that is selected as «down».Pandora FMS own servers implement a
mechanism to detect that one of them has down thorugh a verification of its last date of contact
(server threshold x 2).It will be enough if only one Pandora FMS server would be active for that it
could detect the collapse of the other ones. If all Pandora FMS are down, there is no way to detect
or to implement HA.
The obvious way to implement HA and a load balancing in a system of two nodes is to asign the
50% of the modules to each server and select both servers as masters (Master. In case that there
would be more than two master servers and a third server down with modules expecting to be
executed, the first of the master server that would execute the module will "selfassign" the module
of the down server. In case of the recovering of one of the down servers, the modules that have
been assigned to the primary server would automatically be assigned again.
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The load balancing between the different servers is done in the Agent Administration section in the
"setup" menu.

In the field "server" there is a combo where you can choose the server that will do the checking.

44.1.2.1. Configuration at Servers
In Servers there are two modes of work:
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•Master Mode.
•NonMaster Mode.
The differences between them, and the importance that they have to work in HA mode, consist on
that when there are several servers from the same kind( e.g: Network Servers).When a server falls,
the first master server that could, will be in charge of the network modules of the down server that
are waiting to be executed. The nonmaster servers does not do this.
This option is configured in the file /etc/pandora/pandora_server.conf through the master 1 token.
Being the value 1 to active it and 0 to deactivate it.

44.1.3. Load Balancing in the DDBB
It is possible to configure a database cluster to implement at the same time HA and the load
balancing. The database is the more critical component of all architecture, so a cluster would be the
best option. You only need to convert the DB sketch in tables compatibles with a MySQL cluster.
This setting has been tested and it works well, but it is necessary to have an advanced knowledge in
cluster administration with MySQL5 and that the modules would have lot of RAM memory. A
minimum of 2GiB in a setting of two nodes for a maximum of 5000 modules (in total).
In this case it would not be necessary an special configuration of Pandora FMS.

You have several proposals to implement the MySQL HA, see more about this in out annexes
(MySQL Cluster, MySQL HA Binary Replication and DRBD).

44.1.4. Balancing and HA of the Recon Servers
In the Recon Server the redundancy is very easy to apply. You only need to install two recon servers
with alternate tasks.So is one of them is down, the other one will continue executing the same task.

44.1.5. Balancing and HA of Pandora FMS console
In this case, you do not neither need an special configuration of Pandora FMS. It is very easy,you
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will only need to install another console.Any of them could be used at the same time from different
locations by different users. Using a Web balancer in front of the consoles, you could have access to
them without knowing exactly to which one are you having access into, so the performaces system
is managed throughcookies and this will be kept in the browser. The balancing procedure
implementing LVS and the HA using KeepAlived is described after.

44.2. Annex 1: HA implementation and Load Balancing with LVS and
Keepalived
For the load balancing we advise to use Linux Virtual Server (LVS). To manage the High Availability
(HA) between the services, we advise to use Keepalived.
LVS
At present, the main function of the LVS project is to develop an advanced IP system of load
balancing through software (IPVS), load balancing through software at application level and
components for the management of a services cluster.
IPVS
Advanced IP system of load balancing through software implemented in the Linux own kernel and
that has been already included in versions 2.4 and 2.6.
Keepalived
It is used to manage the LVS. Keepalived is being used in the cluster to make sure that the SSH
servers, both Nodo 1 and Nodo2 are alive, if any of them falls, Keepalive show to the LVS that one
of the two nodes is down and it should to readdress the petitions to the node that is alive.
We have chosen Keepalived as HA service so it allows to keep a persistence of session between the
servers. This is, if any of the modules falls, the users that are working on this node will be conduced
to the other module that is alive, but these will be exactly in the same place that they were before,
doing that the fall will be fully transparent to its work and sessions ( in the case of SSH it will not
work due to the SSH encrypting logic, but in simple TCP sessions, such as Tentacle without SSL or
FTP, they will work without problem).With Tentacle/SSH the communication should be try again
and this way the information of the data packet will not be lost.
The configuration file and the orders for use of KeepAlived are in the Annex 2.
Load Balancing Algorithm Algorithm
The two more used algorithms nowadays are:«Round Robin» and «Weight Round Robin». They are
very similar and they are based on an assignment of work by turns.
In the case of the «Round Robin»,it is one of the process planning algorithms more simple in an
Operative System that assigns to each proccess an equitable and ordered time share, considering all
processes with the same priority.
On the other hand, the «Weight Round Robin» algorithm allows to assign load to the machines
inside the cluster so as a number of specific petitions will go to one or other node, depending on its
weight inside the cluster.
This has no sense in the topology that we consider here, so both machines have exactly the same
hardware features. For all these we have decided to use «Round Robin» as load balancing
algorithm.
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44.2.1. Action when a node is down
Keepalived will detect is one of the services is down. So, if it happens it will eliminated the module
that have failed from the LVS active modules to the node that has failed, so all the petitions to the
node that have failed will be readdressed to the active node.
Once the possible problem will be solved with the service that has fallen, you should restart
keeoalived:
/etc/init.d/keepalived restart

With this restart of the service, the nodes will be inserted again in the LVS available nodes list.
If one of the nodes falls, it would be not necessary to do a manual insertion of the nodes
using ipvsadm, so Keepalived will do it once it would restart and check that the services that are
supposed to do an HA service are running and are accessibles by its «HealthCheckers».

44.3. Annex 2. LVS Balancer Configuration
Use of ipvsadm:
Installing of the manager Linux with ipvsadm:
ipvsadm -A -t ip_cluster:22 -s rr

The options are:
•A Add service
•t TCP service with Ip format
•s Sheduler, in this case you should use the "rr" parameter (round robin)
Install the nodes (real servers) to which the petitions to the 22 port will be readdress.
ipvsadm-a -t ip_cluster:22 -r 192.168.1.10:22 -m ipvsadm -a -t ip_cluster:22 -r 192.168.1.11:22 -m

The ipvsadm situation without active connections is the following:
Prot LocalAddress:Port Scheduler Flags
->
TCP
->
->

RemoteAddress:Port
cluster:www rr
nodo-2:ssh
nodo-1:ssh

Forward Weight ActiveConn InActConn
Masq
Masq

1
1

0
0

0
0

Using the «Round Robin» algorithm, both machines have the same weight in the cluster. So the
connexions will be shared. Here you can see an example of LVS balancing connexions against the
cluster:
Prot LocalAddress:Port Scheduler Flags
-> RemoteAddress:Port
TCP cluster:ssh rr
-> nodo-2:ssh
-> nodo-1:ssh

Forward Weight ActiveConn InActConn

Masq
Masq

1
1

12
11

161
162
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44.4. Annex 3. KeepAlived Configuration
Keepalived is the one that verifies that the files selected in its configuration file
(/etc/keepalived/keepalived.conf)are empty, and keep the different host in the balancing cluster. If
any of these services falls, get out the host of the balancing cluster.
To start Keepalived:
/etc/init.d/keepalived start

To stop Keepalived:
/etc/init.d/keepalived stop

The configuration file used for the cluster is the following one:
# Configuration File for keepalived
global_defs {
notification_email {
email@valido.com
}
notification_email_from keepalived@domain
smtp_server 127.0.0.1
smtp_connect_timeout 30
lvs_id LVS_MAIN
}
virtual_server 192.168.1.1 22 {
delay_loop 30
lb_algo rr
lb_kind NAT
protocol TCP
real_server 192.168.1.10 22 {
weight 1
TCP_CHECK {
connect_port 22
connect_timeout 3
nb_get_retry 3
delay_before_retry 1
}
}
real_server 192.168.1.11 22 {
weight 1
TCP_CHECK {
connect_port 22
connect_timeout 3
nb_get_retry 3
delay_before_retry 1
}
}
}
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45.1. Database management
Pandora FMS infrastructure does not need external maintenance, but it is very important to purge
old data, and maintain the database compacted. There is an essential tool for the proper functioning
of Pandora FMS. This tool must be launched only once by night. If you have multiple physical
servers, start it from one of them. This tool must be launched from a system where there is a
Pandora FMS server, if you have two systems and one has the server and another one the console,
run it from the server where server is the Pandora FMS. This tool is at:
/usr/share/pandora_server/util/pandora_db.pl

This tool, hereinafter pandora_db.pl is included in the package Pandora FMS server.
This tool performs all maintenance database automatically and is essential for the proper
functioning of Pandora FMS so be sure it works properly. Its functions are:
•Delete old data.
•Compact existing data, interpolated at various intervals, so that graphics are the same but
the space needed for storage is much lower (this is one reason why Pandora FMS is capable
of processing such information).
•Check the consistency of the database for nonexisting modules, or modules which are not
used because they can not be initiated (these modules appear in print as uninitialized
modules ).
•Eliminates the daily information contact the agent. Pandora FMS does not need more than
historical 24hr contact agent, and if it builds up, slows down in the access to the database.
•The enterprise version, moving all the old data to the standby database as historic.
This task should be performed every night, and it is very important to do it, taking time to
understand and fixing the cron task. The installation should have been programmed correctly, but
you should check that this has been done. This chapter explains how program it manually, so you
can verify whether the installation on your system is working properly.
To install this tool on standard Linux systems, we recommend the following procedure:
•Create a new file called /etc/cron.daily/pandora_db that contains following lines:
#!/bin/bash
/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

•Alter permissions of file:
chmod 750 /etc/cron.daily/pandora_db

•Change ownership
chmod root:root /etc/cron.daily/pandora_db

•Reload cron configuration
/etc/init.d/cron reload

From now on, every night it will run the maintenance tool database Pandora FMS, ensuring that the
database is always in optimum condition.
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Finally, to ensure that you have left everything up correctly, or to ensure that the system, after
installing the tool has been programmed correctly, manually run it once:
/etc/cron.daily/pandora_db

It should show a message like this (perhaps with less information, depending on their level of
verbosity in the configuration file of Pandora FMS):
Pandora FMS DB Tool 3.0-dev PS090930 Copyright (c) 2004-2008 Artica ST
This program is Free Software, licensed under the terms of GPL License v2
You can download latest versions and documentation at http://www.pandorafms.org
Pandora DB now initialized and running (PURGE=60 days, COMPACT=15 days, STEP=1) ...
Starting at 2009/10/10 02:02:18
[PURGE] Deleting old event data (More than 60 days)...
[PURGE] Deleting old data...
[PURGE] Delete old data (string) ...
[PURGE] Delete pending deleted modules (data table)...
[PURGE] Delete pending deleted modules (data string table)...
[PURGE] Delete pending deleted modules (data inc table)...
[PURGE] Delete pending deleted modules (status, module table)...
[PURGE] Delete old session data
[PURGE] Delete old data from SNMP Traps
[PURGE] Deleting old access data (More than 24hr)
[CHECKDB] Deleting non-init data...
[CHECKDB] Checking database consistency (Missing status)...
[CHECKDB] Checking database consistency (Missing module)...
[CHECKDB] Deleting non-existing module 1189 in state table
[CHECKDB] Deleting non-existing module 1190 in state table
[COMPACT] Compacting data until 2009092502:02:18
Ending at 2009/10/10 02:02:31

45.2. Manual Execution of Maintenance Tool
It is possible to execute manually the maintenance tool once the script has been created. Its use is
very easy. From a shell console, execute:

In installed systems this could take hours. It is recommended to leave the process in
second level

/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

To execute manually the maintenance tool and leave it in second level, execute:
nohup /usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

The process will take some time until it load throughly in second level. After, you could close
the shell console window without problems, while the process will continue executing.

In some installations the tool directory could change. The most common one
is:
/usr/share/pandora_server/util/
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In Pandora FMS previous versions, it could be find at:
/usr/share/pandora/util/

It is very important that you make sure to use the current version of the tool, and not the one from
a previous version. If you execute the program without arguments, it will show the tool version at
the head of the message.

45.3. Database Backup
A simple command mysqldump, will do a dump of the database contents.To restore data it will be
necessary an empty database with the same name that the original one (usually Pandora).
Doing the Backup
mysqldump -u root -p pandora > /backup/pandoradb_backup.sql

Restore the Backup
mysql -u root -p
create database pandora;
use pandora;
source /backup/pandoradb_backup.sql

Probably, it will be also necessary to create new permissions to the console user:
grant all privileges on pandora.* to pandora@localhost identified by 'mypassword';

If you want to do a complete backup of the system, do not forget to do a backup of the whole
directory /etc/pandora, to keep the information of the configuration of the local agents and the
servers.
It is important to emphasize that this ONLY do a backup/restoration of the database files.

45.4. Backup and Complete Recovery of Pandora FMS
There is an script in the Pandora FMS server distribution that is useful to do a backup and a
complete restoration of all Pandora FMS.This script is though to do copies and restoration in
systems where the server and the console are located in the same machine. If in your environment
there are several components, then you should use the tool with the most adequate parameters for
its use or modify them so they could be adapted to their circumstances.
In order it could do its tasks, this script needs to be executed as root.
This script is located at:
/usr/share/pandora_server/util/pandora_backup.sh

If we execute it without parameters, it will give us some help:
Pandora FMS Command line backup tool. http://www.pandorafms.org
(c) 2009 Sancho Lerena <slerena@gmail.com>, Artica Soluciones Tecnologicas
Syntax:
-c Path to Pandora FMS console, p.e: /srv/www/htdocs/pandora_console
-d Destination path for backup file. p.e: /tmp
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-s
-f
-q
-b

Source filename for backup restore. p.e: /tmp/pandorafms
Restore also files
Quiet. No output message (used for scripts/cron)
No database backup/restore

Please BE SURE TO USE RESTORE (-s) option. This will OVERWRITE ALL your
PandoraFMS install, including files, configuration and data. Please backup first!

This script is designed to do security copies and restoration of the following components:
•Server Configuration File(s).
•Files waiting for execution, and also agent remote configuration files.
•Complete DB.
•Complete WEB Console.
Origin and Destination Options of the Copy
This script obtains the credentials to have access to the DB directly from the WEB console
configuration. Is because of this that you should go, with the cparameter the complete path to the
WEB console. This same parameter is used also to show it where it will find the WEB console to do
its backup.
The backup destination is specified with the d parameter. In this path, it will leave the backup file
compressed, with a name similar to pandorafms_backup_xxxxxxx.tar.gz.
The source origin of the restoration is the complete name and path of the backup generated file by
this same tool.
File Restoration, not only Data Restoration
The f option also allows to restore the files (overwriting the current ones) of a security copy, not
restoring the data from the database. As overwriting the current configuration files could have
serious consequences, it is necessary to use f if we want to do a backup recovery and we want to it
restore all the Pandora files (Console and Server).
File Restoration, without Data
Same as with the previous option, we could restore only the files, without dumping the data. To do
it, use the boption.
Data Restoration, without Files
It is the default option. For doing this, you will not have to use neither the b option nor the f
option.

45.4.1. Examples of Use
Create backup
Execute as root:
/usr/share/pandora_server/util/pandora_backup.sh -c /var/www/pandora3 -d /tmp/

It will return something similar to this:
Backup completed and placed in /tmp//pandorafms_backup_2009-10-10-01-35-31.tar.gz

This means that the backup is at /tmp//pandorafms_backup_20091010013531.tar.gz
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Restoring Backup
To restore the backup in an automatic way, you are supposed to have a console with the
authentication credentials on the DDBB correctly defined.
Execute as root:
/usr/share/pandora_server/util/pandora_backup.sh -c /var/www/pandora3_broken/ -s
/tmp/pandorafms_backup_2009-10-10-01-35-31.tar.gz

It will give back something similar to:
Detected Pandora FMS backup at /tmp/pandorafms_backup_2009-10-10-01-35-31.tar.gz, please wait...
Dropping current database
Restoring backup database
Restoring files and configuration
Done. Backup in /tmp/pandorafms_backup_2009-10-10-01-35-31.tar.gz restored

Restoring Backup in case of disaster
If you have lost the Pandora FMS console but you have a backup generated by this tool,then, first
you will have to restore the console directory. For it, decompress manually its backup:
cd /tmp
tar xvzf pandorafms_backup_2009-10-10-0

This will unpack your WEB console complete directory in /tmp. In the case of the generated backup
of the previous example, it creates a directory named:
/tmp/var/www/pandora3/

Copy the content of all this directory to to your web publication directory, that could change
depending on the distribution you use:
cp -R var/www/pandora3 /var/www

Then restore the backup as usual.

45.5. Manual startup/shutdown for Pandora FMS servers
To start and / or stop the server manually Pandora FMS is running the following in a console shell':
Stop daemon:
/etc/init.d/pandora_server stop

Start daemon:
/etc/init.d/pandora_server start

Restart daemon:
/etc/init.d/pandora_server restart

45.6. Watchdog implementation for Pandora FMS
In the repository there is a small script that is used as a "watchdog" (Watchdog). This script
performs a monitoring Pandora (who monitors who monitored?). Thus we can perform a recovery
1061

Watchdog implementation for Pandora FMS

operation (trying to lift Pandora), and if that fails, we can tell the event.

45.6.1. pandora_watchdog.sh
#!/bin/bash
#
#
#
#
#
#
#
#
#

Copyright (c) 2005-2012 Artica ST
Author: Sancho Lerena <slerena@artica.es> 2009
Licence: GPL2
daemon_watchdog
Generic watchdog to detect if a daemon is running. If cannot restart, execute
a custom-user defined command to notify daemon is down and continues in
standby (without notifying / checking) until daemon is alive again.

# Default configuration is for Pandora FMS Server daemon
# =====================================================================
# Configuration begins here. Please use "" if data contain blank spaces
export DAEMON_WATCHDOG=pandora_watchdog.sh
# DAEMON_WATCHDOG: Name of this script. Used to check if its running already
export DAEMON_CHECK="/usr/bin/pandora_server /etc/pandora/pandora_server.conf"
# DAEMON_CHECK: Daemon monitored, please use full path and parameters like
#
are shown doing a ps aux of ps -Alf
export DAEMON_RESTART="/etc/init.d/pandora_server restart"
# DAEMON_RESTART: Command to try to restart the daemon
export DAEMON_DEADWAIT=90
# DAEMON_DEADWAIT: Time this script checks after detect that
#
daemon is down before to consider is really down.
export DAEMON_ALERT="/usr/bin/pandora_alert"
# DAEMON_ALERT: Command/Script executed if after detecting daemon is down,
#
and waiting DAEMON_DEADWAIT, and daemon continues down.
export DAEMON_LOOP=7
# DAEMON_LOOP: Interval within daemon_wathdog checks if daemon is alive.
#
DO NOT use values under 3-5 seconds or could be CPU consuming.
#
NEVER NEVER NEVER use 0 value or gets 100% CPU!.
# Configuration stop here
# =====================================================================
# Check if another instance of this script
RUNNING_CHECK=`ps aux | grep "$DAEMON_WATCHDOG" | grep -v grep |wc -l`
if [ $RUNNING_CHECK -gt 2 ]
then
echo "Aborting, seems that there are more '$DAEMON_WATCHDOG' running in this system"
logger $DAEMON_WATCHDOG aborted execution because another watchdog seems to be running
exit -1
fi

# This value always must be 0 at start. Do not alter
export DAEMON_STANDBY=0
# This function replace pidof, not working in the same way in different linux distros
function pidof_daemon () (
# This sets COLUMNS to XXX chars, because if command is run
# in a "strech" term, ps aux don't report more than COLUMNS
# characters and this will not work.
COLUMNS=300
DAEMON_PID=`ps aux | grep "$DAEMON_CHECK" | grep -v grep | tail -1 | awk '{ print
$2 }'`
echo $DAEMON_PID
)
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# Main script
if [ ! -f `echo $DAEMON_CHECK | awk '{ print $1 }'` ]
then
echo "Daemon you want to check is not present in the system. Aborting watchdog"
exit
fi
while [ 1 ]
do
DAEMON_PID=`pidof_daemon`
if [ -z "$DAEMON_PID" ]
then
echo "Checkpoint #1 $DAEMON_PID "
if [ $DAEMON_STANDBY == 0 ]
then
# Daemon down, first detection
# Restart it !
logger $DAEMON_WATCHDOG restarting $DAEMON_CHECK
$DAEMON_RESTART 2> /dev/null > /dev/null
# Just WAIT another DAEMON_DEADWAIT before consider it DEAD
echo "Going to DAEMON_DEADEWAIT"
sleep $DAEMON_DEADWAIT
DAEMON_PID=`pidof_daemon`
if [ -z "$DAEMON_PID" ]
then
# Is dead and can't be restarted properly. Execute alert
echo "I cannot startup again the process"
logger $DAEMON_WATCHDOG $DAEMON_CHECK is dead, alerting !
$DAEMON_ALERT 2> /dev/null > /dev/null
# Watchdog process puts in STANDBY mode until process get
alive again
logger $DAEMON_WATCHDOG "Entering in Stabdby mode"
DAEMON_STANDBY=1
fi
fi
else
echo "Checkpoint #1B $DAEMON_PID "
DAEMON_STANDBY=0
fi
sleep $DAEMON_LOOP
done

45.6.2. /usr/bin/pandora_alert
This is the script that acts when the watchdog process cannot start the process that monitors
(pandora). In our case, besides alert by SMS, it disables Tentacle.
There will be given rights with chmod 750 / usr / bin / pandora_alert
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#!/bin/bash
sendsms +34458474843 "Pandora FMS Server stopped and can't be started"
/etc/init.d/tentacle_serverd stop

45.6.3. Watchdog Startup
If you have copied pandora_watchdog.sh to /usr/bin, the manual way to start the wathdog will be:
nohup /usr/bin/pandora_watchdog.sh &

45.6.4. Remarks
Having a watchdog running on the system can cause unpleasant consequences if we do not consider
that there is a watchdog. If for example, we want to make a Pandora to disconnect maintenance,
the watchdog will automatically rise again, so we will go "crazy" if we do not stop watchdog first.

45.7. History database
A history database is a database where old module data is moved to make the main Pandora FMS
database more responsive for everyday operations. That data will still be available seamlessly to the
Pandora FMS console when viewing reports, module charts etc.

45.7.1. Setting up a history database
To configure a history database follow these simple steps:
•Create the new history database.
•Create the necessary tables in the new database. You can use the pandoradb.sql script
provided with the Pandora FMS console:
cat pandoradb.sql | mysql -u user -p -D history_db

•In your Pandora FMS console navigate to Setup>History database and enter the host, port,
database name, user and password of the new database.
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Data older than Days days will be moved to the history database in blocks of Step rows,
waiting Delay seconds between one block and the next to avoid overload.

This is an Enterprise feature

45.7.2. Setting up history database purge and compactation
History database is supposed to contains "all history data", but if you want to delete old data, or
compact them, you will need to execute pandora_db script with a "fake" configuration data, to let it
think is the "normal" behaviour. To do this, you need to enter some data in your History Database.
First, you need to "recreate" a functional table values in tconfig, with useful values to be used by
pandora_db tool. Use this SQL queries ON YOUR history database to create a minimal configuration
for the behaviour of the pandora_db running against history database. You fist, need to connect
your database, using mysql CLI tool.
This is an example, replace values as you needed (but let history_db_enabled to zero):
INSERT INTO `tconfig` VALUES (1,'days_purge','180');
INSERT INTO `tconfig` VALUES (2,'history_db_enabled','0');
INSERT INTO `tconfig` VALUES (3,'days_compact','120');
INSERT INTO `tconfig` VALUES (4,'step_compact','1');

This means data in history is stored for 6 months (starting from NOW), and compacted from 4th
month. If you have 1 month of data in your "main" database, you will have a total of 6 months of
data, because the last month is coming from the main database, and the other five from the history
database. You can put any value here, there is no limit of data storage in history database. Just
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remember, history database MUST BE IN A DIFFERENT PHYSICAL SERVER, not in the same
host/system where is the main database and/or running Pandora FMS server or console.
Second, you need to create an aditional pandora_server.conf file, use this "small version" to create
your
own
(replace
the
values
for
your
history
database
values),
name
it/etc/pandora/pandora_server_history_db.conf :
dbengine mysql
dbname pandora4_history
dbuser pandora4_history
dbpass 1234
dbhost 192.168.50.23
log_file /var/log/pandora/pandora_db_history.log

Now you can execute pandora_db tool against the "fake" configuration:
/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server_history_db.conf

This process SHOULD NOT affect your main operation because is running against a different
database in a different server. The only possible delay should be if someone is trying to render a big
ammount of data from history, that will take more time than usual.
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46 Optimization and problem
solving of Pandora FMS
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46.1. Introduction
Pandora FMS server can monitor about 2000 devices.To do that,it is necessary to refine the
configuration of the database.
In this section are also explained some techniques to detect and solve problems of your Pandora
FMS installation.

46.2. Optimizing Pandora FMS
46.2.1. MySQL Optimization for enterprise grade systems
46.2.1.1. General Advises
The first thing you should do if you really want to have a HUGE system with tables bigger than
2GiB and that MySQL recommends, is to use a system of 64Bit.Also, we suggest this: the more RAM
memory and more CPU is used, the better performance.
According with out experience, the RAM memory is more important than the CPU. If you are
thinking about using 1GiB or a lower memory quantity for your SQL system, please think it again.
The minimum for an enterprise system should be 2GiB. One good option for a big system is 4GiB.
Remmember that bigger RAM memory could speed up the key updates through the maintenance of
the key pages more used in the RAM.
Other advise, if you are using transfer tables that are not sure or you have hard disks very big and
you want to avoid long file checking, would be to use a UPS. In this case, it is a good idea to be able
to remove the system in case of failure. For systems where the database is in an specific server, you
should have a look to 1G Ethernet.The latency is as important as the performance.
The disk optimization is very important for databases that are very big: you should cut the
databases and the tables in different disks. In MySQL is possible to use symbolic links for this. Use
different discs for the system and the database and, very important:try to use a hard disk of low
capture, so the application would be compromised by the disk capture velocity, that increases in N
log N when it gets more data.
Under GNU/Linux use hdparmm16 d1 in the disks when starting to prepare the reading and
writing of several sector in an specific time, and also DMA. This could increase the answer time in
550%.Other excellent idea would be to set the disks with async(in a predetermined way)
and noatime, this group does not update the time access to the files in each reading/writting. For
any specific application, it would be a good idea to have a RAM disc for some very specific tables. It
would be an option lightly risky if it is switched off without storing it in a non volatile disk. Please,
consider it carefully.
Use skiplocking (activate in a predetermined way in some systems) if it is possible.This will put
out the external blockade and will give a better performance.
If you start the client and the MySQL in the same machine,use sockets instead of TCP/IP connexions
when connecting with MySQL (this could result in an improvement of the 7.5%). You could do this
without specifying the host name or the localhost when connecting with the MySQL: disauthorize
the star of the binary session an the replicationif it only fires one MySQL host server.
As a general advice for a better performance, check this two items:
•Don't use binary replication logs if you will not use replication.
•Don't use slowquery or debug logs.
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•Check your MySQL configuration files, default values are *SLOW*.
About MySQL Versions

Some people which uses high loaded Pandora FMS servers are using Percona modified MySQL
versions which offers better performance.
MySQL performance is also better in last versions (5.5) and you can get an improvement on
performance about 20% respect 5.0 version.

46.2.1.2. Tools for MySQL configuration check
There are many tools to "optimize" the setup of your MySQL server. Some of them could be very
useful, just to keep a look and be sure you don't pass any important parameter.
MySQL Tuning Primer, from Mattew Montgomery, is a tool (command line) to check your MySQL
performance, and give you a few tips and suggestions to improve it. Check it
at https://bugs.launchpad.net/mysqltuningprimer

46.2.1.3. Disable binary replication
It is enabled by default on most Linux distros. To disable it, edit the my.cnf file, usually
in /etc/my.cnf and comment the following lines:
# log-bin=mysql-bin
# binlog_format=mixed

Comment both lines, and then restart the MySQL Server.

46.2.1.4. Avoiding Disk Flush in Every Transaction
By default, MySQL fix autocommit=1 for each connection. This is not so bad for MyISAM, so what
one person writes is not guaranteed in the disk, but for InnoDB it means that any insert / update /
delete in an InnoDB table will be result in a register on the disk.
So, why would it be bad that it writes on the disk? Nothing at all. It assures that when there's any
commitment, it will be for sure that the data will be there when the database will be restarted after
an accident. The problem is that the DDBB performance is limited by the physical velocity of the
disk. Given that the disk has to write the data in a disk before the writing has been confirmed, this
will take some time.
Even when we consider a searching average time of 9ms for the disk writing, we are being limited
to approximately 67 commits/ sec1, this is very slow. And while the disk is busy trying that the
sector would be written, it's not reading. InnoDB can avoid some of this limitation through the
association of some writing together, but, even with this, the restriction exists.
We can avoid that it writes at the end of each transaction, doing that it uses an "automatic" system
of writing, that writes approximately every second. In case of failure, we could lose the data from
the last second, something more bearable considering that we are trying to gain efficiency. For
doing this, we need to use the following configuration token:

innodb_flush_log_at_trx_commit = 0

Reference: http://tag1consulting.com/InnoDB_Performance_Tuning
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46.2.1.5. Bigger Size for the KeyBuffer
Depending on the system total RAM, it's a very important global parameter, thats speeds up
DELETES and INSERT.
key_buffer = 400M

46.2.1.6. Other important buffers
There are some buffers not configured by default in some MySQL/Linux distributions. Modify these
default parameters (or add it if there are not present) could be very important for the final
performance. It's very important to check if they are present in the my.cnf file, if not, add it, and of
course, change some values (raise a bit if you have lots of RAM).
query_cache_size = 64M
query_cache_limit = 2M
join_buffer_size = 16M

46.2.1.7. Improving InnoDB Concurrency
There is a parameter that can affect Pandora MySQL server performance pretty much. This
parameter is innodb_thread_concurrency. This parameter is used to specify how many "concurrent
threads" can run MySQL. Misconfiguration of this parameter can make it go slower than the default,
so it is especially important to pay attention to several parameters:
•MySQL version. In different versions of MySQL this parameter behaves VERY differently.
•Real number of physical processors.
Here you can read the official MySQL documentation [1].
The recommended value is the number of CPUs (Physical) multiplied by 2 plus the number of disks
where is located InnoDB. In later versions of MySQL (> 5.0.21) the default is 8. A value of 0 would
mean that "opens up so many threads as possible."
Different people [2] [3] have done tests and have found problems with performance on servers with
multiple physical CPUs when using a very high number, with relatively old versions of MySQL
(we're talking 2008).

46.2.1.8. Using a table space for each table
( From the MySQL
tablespaces.html)

manual

at http://dev.mysql.com/doc/refman/5.0/en/innodbmultiple

In MySQL 5.0, it's possible to store each InnoDB table and its index in its own file. This feature is
called "multiple tablespaces" because each table has its own table space.
The use of multiple space tables can be useful for users that want to move specific tables to
separated physical disks or the ones who wanta restore table back ups without interrupt the use of
the rest of the InnoDB tables.
It's possible to activate multiple table espaces adding this line to the my.cnf Mysqld section
[mysqld]
innodb_file_per_table

After restarting the server, InnoDB will store each new created table in its own file name_tabla.ibd
in the database directory to which the table belongs to. This is similar to the MyISAM store motor
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does, but MyISAM divides the table in a tbl_name.MYD data file and the tbl_name.MYI. index file.
For InnoDB data and index are kept together in the .ibd file. The tbl_name.frm file should be
created as usual.
If we take off the innodb_file_per_table line form my.cnf and we restart the server, then InnoDB
will create again the tables in the shared table space files
innodb_file_per_table affect only to the table creation. If you start the server with this option, then
the new tables will be created using.ibd files, but you could still have access to the existing tables in
the shared table space. If you remove the option, then the new tables will be created in the shared
space, but it will be still possible to have access to the tables created in multiple table spaces

46.2.1.9. MySQL Fragmentation
Like the filesystems, databases also will fragment theirselves, doing the whole system slower. In a
high performance system like Pandora, you need a fast al reliable database. In overloaded systems,
database could "die" and force the monitoring system to stop.
An easy way to check how "fragmented" is your database, is use this SQL query: (you can use the
SQL manager at Administration > Database > SQL Manager in Pandora console)
select table_schema, table_name, data_free, engine from information_schema.tables where
table_schema not in ('information_schema', 'mysql') and data_free > 0;

This will show you some fragmented tables of "pandora" database, like these ones:
pandora taddress
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora
pandora

15911092224

InnoDB

taddress_agent 15911092224
InnoDB
tagent_access
15911092224
InnoDB
tagent_custom_data
15911092224
tagent_custom_fields
15911092224
tagent_module_inventory 15911092224
tagente 15911092224
InnoDB
tagente_datos
15911092224
InnoDB
tagente_datos_inc
15911092224
tagente_datos_inventory 15911092224
tagente_datos_log4x
15911092224
tagente_datos_string
15911092224
tagente_estado 15911092224
InnoDB
tagente_modulo 15911092224
InnoDB
talert_actions 15911092224
InnoDB

InnoDB
InnoDB
InnoDB
InnoDB
InnoDB
InnoDB
InnoDB

In this case, there are lots of tables fragmented. To optimize one of them, you can use this
command:
OPTIMIZE table tagente;

You should not optimize big tables, because you can lock the system. MySQL locks the whole table
on optimize in order to rewrite it. In small tables, it takes just a seconds, but in huge tables, like
tagente_datos or tagente_datos_string could take hours... without service.
We recommend to optimize following tables:
OPTIMIZE table tagente;
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE

table
table
table
table
table

tagente_estado;
tagente_modulo;
taddress;
tserver;
tsesion;
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46.2.1.10. Using MySQL Table Partitioning
To use MySQL table partitioning, you should also use "multipletablespace" described above.
MySQL 5.1 supports table partitioning, which allows you to split large table into multiple small
logical subtables. (See MySQL manual for more
details: http://dev.mysql.com/doc/refman/5.1/en/partitioningoverview.html)
If you have large amounts of data in your Pandora FMS database and feel many console operations
which refer to these data (e.g. drawing graph) are quite slow, you will improve their performance
by using table partitioning.
For example, if you want to split tagente_datos table (which typically grow too large) into 100
logical partitions based on module id automatically, run the following query:
ALTER TABLE tagente_datos PARTITION BY HASH(id_agente_modulo) PARTITIONS 100;

This operation may take a long time depending on table size. As an example, it took about one and
half hours to split table which has about 7500 modules' data for 100 days (more than 50,000,000
rows):
mysql> ALTER TABLE tagente_datos
-> PARTITION
-> PARTITIONS
Query OK, 53391880
Records: 53391880

BY HASH(id_agente_modulo)
100;
rows affected (1 hour 35 min 3.41 sec)
Duplicates: 0 Warnings: 0

In the case of this table, it took about one seconds to execute following query to partitioned table,
though it took more then 8 minutes for nonpartitinoed one.
SELECT datos,utimestamp FROM tagente_datos WHERE `id_agente_modulo` = '6332' AND utimestamp >
1322838000 AND utimestamp < 1338390000 ORDER BY utimestamp ASC

46.2.1.11. DDBB Rebuilding
Partial Rebuilding

The MySQL database management system, same as other SQL engines, such as Oracle (tm) is
degraded with the time due to causes as the data fragmentation produced by the deleting and
continuous insertion in large tables. In large environments with a lot traffic volume, there is a very
easy way to improve the performance and avoid that the performance would be degraded, this is, to
rebuild the DDBB in a periodic way
To do this, you should schedule a service stop, that could last approximately 1 hr.
In this service stop, you should stop the Pandora FMS WEB console and also the server (be careful,
leave the Tentacle server to it could receive data still and these will be processed as soon as the
server would be working again).
Once they have been stopped we do a DDBB dump (Export)
mysqldump -u root -p pandora3 > /tmp/pandora3.sql
Enter password:

We delete the DDBB:
> mysql -u root -p
Enter password:
Welcome to the MySQL monitor.

Commands end with ; or \g.
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Your MySQL connection id is 3279346
Server version: 5.0.67-Max SUSE MySQL RPM
Type 'help;' or '\h' for help. Type '\c' to clear the buffer.
mysql> drop database pandora3;
Query OK, 87 rows affected (1 min 34.37 sec)

We create the DDBB and do an import of the previous export:
mysql> create database pandora3;
Query OK, 1 row affected (0.01 sec)
mysql> use pandora3;
mysql> source /tmp/pandora3.sql

This could last approximately 1030 minutes, a little more if the system is large and the hardware is
not very powerful. For one system with 1500 agents and approximately 100.000 modules. It's
possible to automatize this process, but, because it's very delicate, the best option is to do this
manually every month or month a a half.
Total Rebuilding

This section affects only to Innodb databases. Pandora FMS is built on Innodb databases.
Unfortunately MySQL is degraded a lot with time, and this affects to the global performance of the
system.There is no other solution that doesn't involve to rebuild all the database schemes from 0,
rebuilding the data binary file that MySQL uses to store all the information and the files used to
rebuild the transactions.
If you take a look to the /var/lib/mysql directory, you can see that there are three files, that have
always the same name, and that are, depending on the severity of the case, hugh. In my case of
example:
-rw-rw----

1 mysql mysql 4.8G 2012-01-12 14:00 ibdata1

-rw-rw----rw-rw----

1 mysql mysql 5.0M 2012-01-12 14:00 ib_logfile0
1 mysql mysql 5.0M 2012-01-12 14:00 ib_logfile1

The ibdata1 is the one that store all the system Innobd data. In a very fragmented system, that has
been a lot of time without "rebuilding" or without "installing", these system will be big a little
efficient. The innodb_file_per_table parameter, that we have mentioned before, regulates part of
this performance.
Same way, each database has in the /var/lib/mysql directory, one directory to define its structure.
You should delete them also.
The process is very easy:
1.Dump (via mysqldump) all the schemes to disk:
mysqldump -u root -p -A > all.sql

1.Stop MySQL.
2.Delete ibdata1, ib_logfile0, ib_logfile1 and the InnoDB database directories
3.Restart MySQL.
4.Create pandora database again (create database pandora;)
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5.Import the backup file (all.sql)
mysql -u root -p
mysql> source all.sql;

The system should go much faster now.

46.2.1.12. Optional Indexes
There are some situations when you can optimize the MySQL performance, but sacrificing other
system resources.
This index optimizes speed on graph rendering (a lot), but it uses more disk storage space, and
could have a slightly decrease on INSERT/DELETE operation, due the Index overhead:
ALTER TABLE `pandora`.`tagente_datos`
( `id_agente_modulo` , `utimestamp`

ADD
);

INDEX

`id_agente_modulo_utimestamp`

46.2.1.13. Slow queries study
In some systems, depending on the type of information we have, we can find some "slow queries"
that make the system worse off than normal. We can enable logging of this type of queries over a
short period of time (and that hurts the system performance) in order to consider trying to optimize
queries to tables with indexes. To enable this setings, do the following:
Edit my.cnf and add the following lines:
slow_query_log = 1
long_query_time = 2
slow_query_log_file = / var / log / mysql_slow.log

In the OS:
touch / var / log / mysql_slow.log
chmod 777 / var / log / mysql_slow.log

Restart mysql.

46.2.1.14. Optimizing Specific tables
Other less "drastic" solution to solve the problem with fragmentation is the use of the MYSQL
OPTIMIZE tool to optimize certain tables of Pandora FMS. For it, directly from MySQL, execute:
OPTIMIZE table tagente_datos;
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE

table
table
table
table
table

tagente;
tagente_datos_string;
tagent_access;
tagente_modulo;
tagente_estado;

This will improve the performance, and it shouldn't be necessary to fire it more than once per week.
It could be done "IN THE HEAT OF THE MOMENT" while the system is working. In very big
environments the OPTIMIZE could be "blocked" not being an option. In this case the best option is
to rebuild the DDBB.
After doing these operations, you should execute:
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FLUSH TABLES;

From the MySQL manual:
For InnoDB tables, OPTIMIZE TABLE is mapped to ALTER TABLE, which rebuilds the table to
update index statistics and free unused space in the clustered index.

46.2.1.15. Mysql special tokens
There are some tokens very "special" in MySQL: they can help or degrade the performance, there is
no "fixed" rule and you will need to check it by yourself, BUT, they usually help more than make the
system go worse.
# Set to 0 in mysql 5.1.12 or higher
innodb_thread_concurrency

= 20

This parameter, innodb_thread_concurrency, in versions 5.1.12 or higher, on 0 value, means there is
no limit on concurrency, BUT in previous versions, the same meaning is achieved with value 20.
innodb_flush_method = O_DIRECT

This important parameter affects on how is information written on disk, in most cases, helps to set
to O_DIRECT.
innodb_thread_sleep_delay = 1000
innodb_concurrency_tickets = 250

This affects on systems with huge load, and helps to get quicker queue management and locking
innodb_lock_wait_timeout = 180

This helps when your database is "stuck" in a lock due a long transaction (mysql has gone away
messages). If you get more than 180 lock, you have a real problem

46.2.1.16. Configuration Sample #1
This example of configuration uses an example system with 4CPU, 4GiB RAM, and InnoDB tables
for the installation of two databases, both of them with a powerful usage. Consider that the total
sum of obsolete memory, in reserve for each variable, should not be higher than the 80% of the
system total memory. Try to adjust the values for its installation, and have look to the MySQL
registers in the demon that starts.
As a general aspect for evaluating the performance, consider that the following things affect
seriously to the performance:
•DO NOT use binary logs if you are not going to use a MySQL configuration with replication.
•DO Not use logs of queries traceability or slow query logs.
# Sample configuration for a MySQL with ~3GB RAM dedicated to MySQL Process
[mysqld]
datadir=/var/lib/mysql
socket=/var/lib/mysql/mysql.sock
user=mysql
# ------------------------# Innodb specific tokens
# -------------------------
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# You need to create the tables AFTER using this parameters
innodb_file_per_table
# Beware, you cannot change this two following parameters
# in an already running system or the database will be corrupted!
#innodb_log_files_in_group
= 2
#innodb_log_file_size
= 200M
# This parameter gives about a 150% more performance, but in case of
# power failure, you will loss about 1-2 secs of data.
innodb_flush_log_at_trx_commit
= 0
innodb_buffer_pool_size
innodb_additional_mem_pool_size

= 2G
= 4M

innodb_flush_method
innodb_open_files
innodb_thread_sleep_delay
innodb_concurrency_tickets

=
=
=
=

O_DIRECT
700
1000
250

# This will avoid some "MySQL gone away" shutdowns on long locking
innodb_lock_wait_timeout
= 180
# Set to 0 in mysql 5.1.12 or higher
innodb_thread_concurrency
= 20
# ------------------------# Performance Parameters
# ------------------------key_buffer
max_allowed_packet
max_connections
max_heap_table_size
read_buffer_size
read_rnd_buffer_size
join_buffer
record_buffer
table_cache
sort_buffer_size
query_cache_min_res_unit
query_cache_limit
query_cache_size
thread_stack
thread_cache_size
skip-external-locking
max_delayed_threads

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

512M
64M
500
512M
16M
32M
2M
1M
128
4M
1K
2M
100M
128K
8

= 25

# ------------------------# Other parameters
# ------------------------max_connections
= 500
# OS Buffer to let connections waiting for Mysql thread.
back_log
= 100
# Print warnings to the error log file.
log_warnings
[mysqld_safe]
log-error=/var/log/mysqld.log
pid-file=/var/run/mysqld/mysqld.pid
################# /etc/my.cnf ###################

46.2.1.17. External references
References:
•http://dev.mysql.com/techresources/presentations/presentationoscon2000
20000719/index.html
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•http://jeremy.zawodny.com/mysql/mysqloptimization.html

46.2.2. MySQL Percona XTraDB
Percona is a "high performance" version of MySQL, improving a lot the scalability and using all
CPU's of the system, speeding also the disk transactions.
Percona installation is like a custom "mySQL" instalacion, very similar to a standard MySQL. We
strongly suggest you download the binary packages from percona.com and do a manual install
based on binary package, using following procedure:
shell> groupadd mysql
shell>
shell>
shell>
shell>
shell>
shell>
shell>
shell>
shell>
shell>
shell>
shell>

useradd -r -g mysql mysql
cd /usr/local
tar zxvf /path/to/mysql-VERSION-OS.tar.gz
ln -s full-path-to-mysql-VERSION-OS mysql
cd mysql
chown -R mysql .
chgrp -R mysql .
scripts/mysql_install_db --user=mysql
chown -R root .
chown -R mysql data
cp support-files/mysql.server /etc/init.d/mysql.server
/etc/init.d/mysql.server start

To configure your percona server, you can use their excelent online configuration
wizard, which will generate the file /etc/my.cnf: Percona Wizard Configurator
This is a sample of a Percona XtradB MySQL Server with 10GB RAM, 10KrpmHardrive, Xeon
Quadcore.
[mysql]
# CLIENT #
port
socket

= 3306
= /var/lib/mysql/data/mysql.sock

[mysqld]
# GENERAL #
user
default_storage_engine
socket
pid_file

=
=
=
=

# MyISAM #
key_buffer_size
myisam_recover

= 32M
= FORCE,BACKUP

# SAFETY #
max_allowed_packet
max_connect_errors
skip_name_resolve
sysdate_is_now
innodb

mysql
InnoDB
/var/lib/mysql/data/mysql.sock
/var/lib/mysql/data/mysql.pid

= 16M
= 1000000
= 1
= FORCE

# DATA STORAGE #
datadir

= /var/lib/mysql/data/

# CACHES AND LIMITS #
tmp_table_size
max_heap_table_size
query_cache_size
max_connections
thread_cache_size
open_files_limit
table_definition_cache
table_open_cache

=
=
=
=
=
=
=
=

32M
32M
32M
500
50
65535
1024
2048

1077

Optimizing Pandora FMS

sort_buffer_size = 1M
join_buffer_size = 8M
read_rnd_buffer_size = 16M
# INNODB #
innodb_flush_method
innodb_log_files_in_group
innodb_log_file_size
innodb_flush_log_at_trx_commit
innodb_file_per_table
innodb_buffer_pool_size
innodb_locks_unsafe_for_binlog
innodb_lock_wait_timeout = 30
innodb_stats_on_metadata = 0
innodb_read_io_threads = 4
innodb_write_io_threads = 4
innodb_old_blocks_time = 1000
# LOGGING #
log_error
log_queries_not_using_indexes
slow_query_log
slow_query_log_file

=
=
=
=
=
=
=

O_DIRECT
2
64M
0
1
6G
1

=
=
=
=

/var/lib/mysql/data/mysql-error.log
0
0
/var/lib/mysql/data/mysql-slow.log

46.2.3. Measuring Pandora FMS for High Capacity
This section describes different methods in order to configure Pandora FMS in a high capacity
environment. It also describes different tools for doing load tests, useful to fix the environment to
the highest level of process.
Pandora FMS has been configured to bear a load of 2000 agents in systems where database, console
and server are in the same machine. The recommended number is around 1200/1500 agents by
system, but this number changes a lot depending on if they are XML agents, remote modules, with
high or low intervals, with systems of high capacity or low memory. All these things changes a lot
the nº of agents that one system is able to manage in an efficient way.

46.2.4. Use of RAM (tmpfs) disks for the incoming directory
In some environments of high capacity for the XML processing coming from agents, the directory
directorio /var/spool/pandora/data_ has a high traffic and to have this file system available in a
memory storage can improve the XML processing performance in a 25%.
To create a partition in /var/spool/pandora/data_in_RAM, it will be enough with the command:
mount -t tmpfs -o size=100M,nr_inodes=10k,mode=770 tmpfs /var/spool/pandora/data_in_RAM

It is possible to program in /etc/inittab so as this partition would be created when starting. The end
directory should be exist and be empty.
tmpfs /var/spool/pandora/data_in_RAM tmpfs size=100M,nr_inodes=10k,mode=770 0 0

Of course, as it is limited to 100MB, if the system is filled it will stop working properly. If you are
working with policies or remote configurations the directories that usually hang from /data_in (file
collections, md5, conf and others) should be located as links to their real paths in the disk, with an
structure based in the following commands:
mv /var/spool/pandora/data_in /var/spool/pandora/data_in_old
ln
ln
ln
ln

-s
-s
-s
-s

/var/spool/pandora/data_in /var/spool/pandora/data_in_RAM
/var/spool/pandora/data_in_old/md5 /var/spool/pandora/data_in_RAM/md5
/var/spool/pandora/data_in_old/conf /var/spool/pandora/data_in_RAM/conf
/var/spool/pandora/data_in_old/collections /var/spool/pandora/data_in_RAM/collections
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46.2.5. Many Request in the Same System
An special case to implement a bigger processing power in servers with several processors (of two
or more physical cores) consist of implementing several instances of Pandora Specific servers in the
same machine, some that has nothing to do with increasing the nº of threads of the server, so due to
the design of the Linux Kernel and of the Perl virtual machine, it is possible to take the most of the
cores with several processes than with more threads in the same process
You can use this technique when Pandora FMS is not able of processing all the information without
delaying to much. This options means that you should have to install another Pandora FMS server
with otherincoming entry directory. Of course it will have its own pandora_server.conf and a
different server name. You should also do some changes in the server firing script and other smaller
customizations in the system.
Example of High Capacity Servers Configuration
For example, for one machine with 16GB of RAM and 4 CPUs that we wanted to optimize for the
Data server maximum processing capacity (XML)

46.2.5.1. my.cnf
(Only the most important parameters are shown)
key_buffer

= 1G

innodb_flush_log_at_trx_commit = 0
innodb_file_per_table
skip-locking
innodb_thread_concurrency = 16
max_allowed_packet
= 160M
query_cache_limit
= 50M
query_cache_size
= 360M
innodb_buffer_pool_size=9000M
innodb_additional_mem_pool_size=800M
innodb_log_file_size=2500M
innodb_log_buffer_size=80M
innodb_lock_wait_timeout=50

46.2.5.2. pandora_server.conf
(Only the most important parameters are shown)
verbose 1
server_threshold 15
dataserver_threads 5
max_queue_files 1000

You should consider these things:
•A very high nº of threads(+5) only benefits to the processes with large E/S queues, like the
network or the plugin server, just in case that the dataserver, which is always a processing
one, could even penalize the performance. This is the reason why we use 5 here. In systems
with an slow DB, we should use even less threads. Test different combinations between 1
and 10. In case of optimizing the system for the networkserver, the nº would be higher,
between 10 and 30.
•A high threshold server(15) does that the DB suffer less, and the increase in the maximum
nº of files processed makes that any time that the server "looks for files" it fill the buffers.
These two elements of the configuration are linked. In the case of optimizing the network
server, it would be advisable to low the server threshold to 5 or 10.
•Some parameters of the configuration could affect a lot to Pandora FMS performance, such
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as the parameter agent_access (configurable from the console).

46.2.6. Capacity analysis Tools(Capacity)
Pandora FMS has several tools that can help you to measure properly its hardware and software for
the data amount that it expects to obtain.One of them is useful to "attack" directly the database with
fictitious data (dbstress) and the other generates fictitious XML files(xml_stress)

46.2.6.1. Pandora FMS XML Stress
This is an small script that generates XML data files like the ones sent by Pandora FMS agents. It's
placed on /usr/share/pandora_server/util/pandora_xml_stress.pl
The scripts reads agent names from a text file and generates XML data files for each agent according
to a configuration file, where modules are defined as templates.
Modules are filled with random data. An initial value and the probability of the module data
changing may be specified.
Run the script like this:
./pandora_xml_stress.pl <configuration file>

Sample configuration file:
# Maximum number of threads, by default 10.
max_threads 10
# File containing a list of agent names (one per line).
agent_file agent_names.txt
# Directory where XML data files will be placed, by default /tmp.
temporal /var/spool/pandora/data_in
# Pandora FMS XML Stress log file, logs to stdout by default.
log_file pandora_xml_stress.log
# XML version, by default 1.0.
xml_version 1.0
# XML encoding, by default ISO-8859-1.
encoding ISO-8859-1
# Operating system (shared by all agents), by default Linux.
os_name Linux
# Operating system version (shared by all agents), by default 2.6.
os_version 2.6
# Agent interval, by default 300.
agent_interval 300
# Data file generation start date, by default now.
time_from 2009-06-01 00:00:00
# Data file generation end date, by default now.
time_to 2009-06-05 00:00:00
# Delay after generating the first data file for each agent to avoid
# race conditions when auto-creating the agent, by default 2.
startup_delay 2
# Address of the Tentacle server where XML files will be sent (optional).
# server_ip 192.168.50.1
# Port of the Tentacle server, by default 41121.
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# server_port 41121
# Module definitions. Similar to pandora_agent.conf.
module_begin
module_name Module 1
module_type generic_data
module_description A long description.
module_max 100
module_min 10
module_exec type=RANDOM;variation=60;min=20;max=80
module_end
module_begin
module_name Module 2
module_type generic_data
module_description A long description.
module_max 80
module_min 20
module_exec type=SCATTER;prob=1;avg=40;min=0;max=80
module_end
module_begin
module_name Module 3
module_type generic_data
module_description A long description.
module_max 80
module_min 20
module_exec type=CURVE;min=20;max=80;time_wave_length=3600;time_offset=0
module_end

module_begin
module_name Module 4
module_type generic_data_string
module_description A long description.
module_max 100
module_min 10
module_exec type=RANDOM;variation=60;min=20;max=80
module_end
module_begin
module_name Module_3
module_type generic_proc
module_descripcion Module 3 description.
# Initial data.
module_data 1
module_end

Send and Receive the Agent Local Configuration

If you start in your "pandora_xml_stress.conf" the configuration value "get_and_send_agent_conf" to
1, you can do that the test load agents will act as normal agents, so they send their configuration
file and also the md5. And from Pandora Console Enterprise you can change the remote
configuration in orther that in next executions of the pandora_xml_stress it uses the customized
configuration from the Pandora Console Enterprise instead of doing it through the
"pandora_xml_stress.conf" definition.
Besides this, you can configure where to store in a local way the configuration of your testing agents
with the "directory_confs" configuration token in the file "pandora_xml_stress.conf".
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Configuration File

•max_threads Number of threads where the script will be executed.This improves the E/S.
•agent_file Path of the name list file path, separated by new line
•temporal Path of the directory where the fictitious XML data files are generated.
•log_file Path of the log where it will inform about its execution script.
•xml_version Version of the XML data file (by default 1.0)
•encoding XML data files encoding (by default ISO88591).
•os_name Name of the fictitious agent Operative System (by default Linux).
•os_version Version of the fictitious agents Operative System (by default 2.6)
•agent_interval Interval of the fictitious agents in seconds (by default 300).
•time_from Time from which fictitious XML data files are generated, in format" YEAR
MONTHDAY HOUR:MIN:SEC"
•time_to Time until which fictitious XML data files are generated, in format YEARMONTH
DAY HOUR:MIN:SEC"
•get_and_send_agent_conf Boolean value 0 or 1. When it is active the fictitious agents will
try to download by remote configuration a more updated version of the standard
configuration file of an agent. And from the Pandora FMS Enterprise console you can edit
them.
•startup_delay Time numeric value in seconds before each agent starts to generate the files.
It is used to avoid race conditions.
•timezone_offset Numeric value of the time zone offset
•timezone_offset_range Numeric value that is useful to generate the timezone in this range
in a random way.
•latitude_base Numeric value. It's the latitude where the fictitious agents will be shown.
•longitude_base Numeric value. It's the longitude where the fictitious agents will be shown.
•altitude_base Numeric value. It's the altitude where the fictitious agents will be shown.
•position_radius Numeric value. It's the range around. The circumference with this radius
where the fictitious agent is shown in a random way.
Module Definition

The definition of one module in the script configuration file and if you have activated the remote
configuration will also be the same. It is:

module_begin
module_name <name of the module>
module_type <type, p.e: generic_data>
module_description <description>
module_exec type=<type>;<other options separated by ; >
module_unit <units>
module_min_critical <value>
module_max_critical <value>
module_min_warning <value>
module_max_warning <value>
module_end
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And you can configure each of them as:
•<type of exec>:Can have the values RANDOM,SCATTER,CURVE.
•module_attenuation <value>: The generated module value is multiplied by the specified
value, usually between 0.1 and 0.9.
•module_attenuation_wdays <value> <value> ... <value>: The module value is only
attenuated the given days, ranging from Sunday (0) to Saturday (6). For example, the
following module simulates a 50% drop in network traffic on Saturdays and Sundays:
module_begin
module_name Network Traffic
module_type generic_data
module_description Incoming network traffic (Kbit/s)
module_exec type=RANDOM;variation=50;min=0;max=1000000
module_unit Kbit/s
module_min_critical 900000
module_attenuation 0.5
module_attenuation_wdays 0 6
module_end

•module_incremental <value>: If set to one, the module's previous value is alway added
to a new value, resulting in an increasing function.
•Others: See below what options are available, depending on the execution type.
Note that min/max_critical and min/max_warning are only available in 5.0 or higher version.
46.2.6.1.1.1.

RANDOM

These have the following options:
•variation probability in % that it would change regarding the previous value.
•min Minimum value that the the value could have.
•max Maximum value that the the value could have.
Numeric
Generates random numeric values between the ranges value min and the value max
Booleans
Generates values between 0 and 1.
String
Generates a string of length between values min and max. The characters are random between A
and Z and includes capital and lower case letters and also numeric ciphers.
46.2.6.1.1.2.

External data source (SOURCE)

Allows you to use a plain text file as a data source. Options:
•src: source data file.
The file contains one data per line, there is no limit for lines. For example:
4
5
6
10
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There are two possibilities for data (numeric and strings). These kind of modules will use data from
file to generate module data in Pandora, data will be get secuentially. For example data above will
be shown as follows:
4 5 6 10 4 5 6 10 4 5 6 10 4 5 6 10 4 5 6 10 4 5 6 10

46.2.6.1.1.3.

SCATTER

It is only useful for numeric data, and the generated graphics are similar to the ones of a heartbeat,
that is, a normal value, and from time to time a "beat".
It has the following options:
•min Minimum value that the value could have.
•max Maximum value that the value could have.
•prob Probability in % that it generates a "beat".
•avg Average value that it should show by default if there isn't any "beat".
46.2.6.1.1.4.

CURVE

Generates module data following a trigonometric curve. They have the following options:
•min Minimum value that the value could have
•max Maximum value that the value could have
•time_wave_length Numeric value in seconds of the duration of the "crest" of the wave
•time_offset Numeric value in seconds from the starting of the wave from time zero with
module value zero (similar to the sine graph)

Notes of Interest

Please, consider that the amount of generated files is the link between the starting time
1084

Optimizing Pandora FMS

(time_from)and the final date (time_to) and the interval setted in the agent (agent_interval),so is
there are long periods of time or small intervals, the script will generate lot of XML data files.
How to measure the Data server Processing Capacity
There is an small script called "pandora_count.sh" that is in the util/directory in the Pandora FMS
server directory. This script is used to measure the processing rate of XML files by the data server,
and it uses as reference all the files pending of processing at /var/spool/pandora/data_in so to can
use it you need thousand of packages pending of being processed (or to generate them with the tool
mentioned before). This script takes into account only the packages that are now, and it take them
away from the packages that were 10 seconds ago, then divide the result by 10, and these will be
the files that have been processed in the last 10 seconds, showing the rate per second. It's a
rudimentary solution but it serves to fix the server configuration.

46.2.6.2. Pandora FMS DB Stress
This is an small tool to test you database performance.It could also be used to «pregenerate »
periodical or random data (using trigonometric functions) and fill in fictitious modules.
you should create an agent and to assign it modules for automatic data injection with this tool. The
names should be these ones:
•random: to generate random data
•curve: to generate a coincidence curve using trigonometric functions. useful to use the
interpolating work with different intervals, etc.
•boolean: To generate random boolean data
This way it's possible to use any name that contains the words «random», «curve» and/or «boolean».
For example:
•random_1
•curve_other
You will only could choose the «data_server» module kind
Pandora FMS DB Stress Fine Adjustment

This tool is preconfigured in order to search, in all agents, the modules
name «random», «curve» o «boolean»,that use one interval between 300 seconds and 30 days.
If you want to modify this performance, you should edit the pandora_dbstress script and change
some variables at the start of the file:
# Configure here target (AGENT_ID for Stress)
my
my
my
my

$target_module = -1; # -1 for all modules of that agent
$target_agent = -1;
$target_interval = 300;
$target_days = 30;

The first line of variable corresponding withtarget_module, should be fix for a fix module or 1 to
process all the objectives that match. The second line of variable match with target_agent, for an
specific agent. The third line match with target_interval,defined in seconds and that represent the
module predefined periodical interval. The fourth line is target_daysand represent the number of
days in the past since the date , in the current timestamp.
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46.3. Problem Solving and Diagnostic tools in Pandora FMS
Sometimes, the user have problems and Pandora Developers can't help without more information
about the user systems. In 3.0 version we have created two small tools to help solving user
problems:

46.3.1. pandora_diag.php
This is a web diagnostic tool. You need to have an active session in order to use this resource. It
gives information about Pandora FMS database usage, and some setup values and version. This tool
is accessible from your console using the following URL:
http://localhost/pandora_console/extras/pandora_diag.php
If you have your PandoraFMS console in other URL just add /extras/pandora_diag.php to your home
url.
Sample of output
Pandora FMS Build

PC090512

Pandora FMS Version
v3.0-dev
Homedir /var/www/pandora_console
HomeUrl /pandora_console
tagente 2385
tagent_access
20049
tagente_datos
4342323
tusuario
19
Update Key
PANDORA-FREE
Updating code path
/var/www/pandora_console
Keygen path
/usr/share/pandora/util/keygen
Current Update #
0

This tool can be launched also from command line, and you need to pass the full path to your
Pandora FMS console homedir, for example:
php /var/www/pandora_console/extras/pandora_diag.php /var/www/pandora_console

And the output of this script will be printed on the standard console output.

46.3.2. pandora_diagnostic.sh
Is a tool placed on /usr/share/pandora_server/util and it gives a lot of information about the system:
•CPU information
•Uptime and CPU avgload
•Memory information
•Kernel/Release information.
•A fully mysql config file dump.
•A fully PandoraFMS Server config file dump (filtering passwords).
•Pandora FMS logs information (but not the full log!).
•Disk information
•Pandora FMS processes information
•A fully kernel log information (dmesg).
All information is generated in a .txt file so users can sent this information to anyone who wants to
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help them, for example in Pandora FMS user forums or in the Pandora FMS public mailing lists.
This information should not have any kind of confidential information. Note that you probably want
to run with root privileges if you want to get pandora_server.conf and my.cnf files parsed.
This is an example of execution:
$ ./pandora_diagnostic.sh
Pandora FMS Diagnostic Script v1.0 (c) ArticaST 2009
http://pandorafms.org. This script is licensed under GPL2 terms
Please wait while this script is collecting data
Output file with all information is in '/tmp/pandora_diag.20090601_164511.data'

And here there are some parts of file output
Information gathered at 20090601_164511
Linux raz0r 2.6.28-12-generic #43-Ubuntu SMP Fri May 1 19:27:06 UTC 2009 i686 GNU/Linux
=========================================================================
----------------------------------------------------------------CPUINFO
----------------------------------------------------------------processor
: 0
vendor_id
: GenuineIntel
cpu family
: 6
.
.
----------------------------------------------------------------Other System Parameters
----------------------------------------------------------------Uptime: 16:45:11 up 5:27, 2 users, load average: 0.11, 0.12, 0.09
----------------------------------------------------------------PROC INFO (Pandora)
----------------------------------------------------------------slerena 11875 0.9 2.1 114436 44336 pts/0
Sl
13:14
1:56 gedit pandora_diagnostic.sh
slerena 24357 0.0 0.0
4452 1524 pts/0
S+
16:45
0:00 /bin/bash
./pandora_diagnostic.sh
----------------------------------------------------------------MySQL Configuration file
----------------------------------------------------------------#
# The MySQL database server configuration file.
#
# You can copy this to one of:
# - "/etc/mysql/my.cnf" to set global options,
.
.
.
----------------------------------------------------------------Pandora FMS Logfiles information
----------------------------------------------------------------total 3032
drwxr-xrwx 2 root
root
4096 2009-04-30 20:00 .
drwxr-xr-x 17 root
root
4096 2009-06-01 11:24 ..
-rw-r----- 1 root
sys
377322 2009-04-06 00:12 pandora_agent.log
-rw-r--r-- 1 root
root
0 2009-04-06 00:15 pandora_agent.log.err
-rw-r--r-- 1 root
root
13945 2009-04-02 21:47 pandora_alert.log
-rw-r--r-- 1 slerena slerena 2595426 2009-04-30 20:02 pandora_server.error
-rw-rw-rw- 1 root
root
9898 2009-04-30 20:02 pandora_server.log
-rw-rw-rw- 1 root
root
65542 2009-04-30 20:00 pandora_server.log.old
-rw-r--r-- 1 root
root
94 2009-04-06 00:19 pandora_snmptrap.log
-rw-rw-rw- 1 root
root
4 2009-04-03 14:16 pandora_snmptrap.log.index
----------------------------------------------------------------System disk
----------------------------------------------------------------S.ficheros
Tamaño Usado Disp Uso% Montado en
/dev/sda6
91G
49G
37G 58% /
tmpfs
1003M
0 1003M
0% /lib/init/rw
varrun
1003M 260K 1002M
1% /var/run
varlock
1003M
0 1003M
0% /var/lock
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udev
1003M 184K 1002M
1% /dev
tmpfs
1003M 480K 1002M
1% /dev/shm
lrm
1003M 2,4M 1000M
1% /lib/modules/2.6.28-12-generic/volatile
----------------------------------------------------------------Vmstat (5 execs)
----------------------------------------------------------------procs -----------memory---------- ---swap-- -----io---- -system-- ----cpu---r b
swpd
free
buff cache
si
so
bi
bo
in
cs us sy id wa
2 0
0 684840 119888 619624
0
0
15
10 258 474 3 1 95 0
0 0
0 684768 119888 619640
0
0
0
0 265 391 0 0 100 0
0 0
0 684768 119892 619636
0
0
0
56 249 325 1 1 99 0
0 0
0 684768 119892 619640
0
0
0
0 329 580 0 0 100 0
0 0
0 684776 119892 619640
0
0
0
0 385 1382 1 0 99 0
----------------------------------------------------------------System dmesg
----------------------------------------------------------------[
0.000000] BIOS EBDA/lowmem at: 0009f000/0009f000
[
0.000000] Initializing cgroup subsys cpuset
[
0.000000] Initializing cgroup subsys cpu
[
0.000000] Linux version 2.6.28-12-generic (buildd@rothera) (gcc version 4.3.3 (Ubuntu
4.3.3-5ubuntu4) )
#43-Ubuntu SMP Fri May 1
19:27:06 UTC 2009 (Ubuntu 2.6.28-12.43-generic)
.
.
----------------------------------------------------------------END OF FILE
----------------------------------------------------------------560e8fa02818916d4abb59bb50d91f6a /tmp/pandora_diag.20090601_164511.data
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47 Pandora FMS Engineering
Details
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In this annex we are going to explain some of the Pandora FMS special features and design
principles.

47.1. Pandora FMS Database Design
Pandora FMS first versions, from the 0.83 to the 1.1, were based in a very simple idea: one data,
one insertion in the database. This was very easy to develop and allowed the program to do very
simple searches, insertions and other operations.
These had a lot of advantages and a big problem: scalability. This system has an specific limit in
maximum number of modules that could support, not having to implement difficult mechanisms
of clustering that would allow more load, and even with this, with certain number of data,the
functioning was not so quick (> 5 millions of elements).
The solutions based in MySQL cluster are not easy, and always add some minor problems.Neither
they offer even a long term solution.
Pandora FMS versions 1.3 and higher, implement a data compression in real time for each insertion.
They also allow to do a data compression based on interpolation. They also implement &mdasdh, as
in previous versions, and an automatic deleting of data from an specific date.
The new data processing system keeps only «new» data. If a duplicated value enter in the system, it
will not be kept in the database.It is very useful to keep the database reduced. This works for all
Pandora FMS modules:numeric, incremental, boolean,and chain. In the boolean data kind, the
compressing index is very high, so they are data that rarely change.Nevertheless, the «index»
elements are kept every 24 hours, so there is minimum information that is useful as a reference
when compacting the information.
This solves part of the scalability problem reducing the database usage in a 40%70%. There is also
another solution for scalability problems: the total breaking up of components in Pandora FMS, that
allows to balance the data files processing load and the network modules execution in different
servers. Now it it possible to have several Pandora FMS servers(network servers, data or SNMP),
like Pandora FMS Web consoles, and also a database or a high performance cluster (with MySQL5).
The adjustments imply big changes when reading or interpreting data. We have redesign and
implement from zero the graphic motor to could represent data in a quick way with the new data
storage model. With the new version, if an agent could not communicate with Pandora FMS, and
the Pandora FMS server does not receive data from the agent, then this absence of data could not
have a graphic representation. And regarding the module graph, it will be no changes.
You will get a graph with a perfect horizontal line.Pandora FMS, if does not get new values, will
think that there are not, and all things will appear exactly as they were in the last
notification.Similar to the MRTG performance, for example.
To see a graphic example, this image shows the changes for each data, received every 180 seconds.
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This would be the equivalent graphic for the same data, expect a connection failure, from 05:55 to
15:29 approximately.

In Pandora FMS 1.3 a new general graphic for the agent is introduced. It shows its connectivity, and
it shows the access rate from the module agents. This graphic complements the other graphs that
are shown when the agent has activity and is receiving data. This is an example of an agent that is
regularly connected with the server:

If you have peaks (lows) in this graphic, you could have problems or slow connections in the
Pandora FMS agent connectivity with the Pandora FMS server. It is also possible that you could
have connectivity problems from the network server.

1091

Pandora FMS Database Design

47.1.1. Improvements in Index and Other Technical Aspects in the DDBB
We have implemented small improvements in the relational model of the Pandora FMS database.
One of the changes that we have introduced is the indexation by module kinds.In this way, the
access to the information is quicker, so the Pandora FMS logic agent, that is useful to "upload" all
the information about monitoring. It is distributed in small pieces of information that could came
form very different sources. In the new version of Pandora FMS we have planned until four kinds of
new specific servers that will offer a wider variety of information kinds to process.

We also have added factors such as the numerical representation of time marks (in UNIX format, or
number of seconds from the 1 January 1970), speeds the searches of date ranks, comparisons of
these ones, etc. This work has allowed a considerable improvement in the search times an in the
insertions.

47.1.2. Database Main Tables
Next is shown an ER diagram and also a detailed description of the main tables of Pandora FMS
database.The rest of the tables are also commented briefly.
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•taddress: Contains agent additional addresses.
•taddress_agent: Addresses asociated to an agent(rel. taddress/tagente).
•tagente: Contains the information of Pandora FMS agents.
•id_agente: Agent unique identifier.
•nombre: Name of the agent (case sensitive).
•direccion: Agent address. It is possible to assign additional addresses through
taddress.
•comentarios: Free text.
•id_grupo: Identifier of the group the agent belongs to (ref. tgrupo).
•ultimo_contacto: last date of agent contact, either through a software agent or
through a remote module.
•modo:Way in which the agent runs, 0 normal, 1 training.
•intervalo: agent execution interval. Depending on this interval, the agent will be
showed as out of limits.
•id_os: Agent SO identifier (ref. tconfig_os).
•os_version: SO version (free text).
•agent_version: Agent version (free text). Updated by the software agents.
•`ultimo_contacto_remoto: Last date of contact received by the agent. In case of
software agents, and unlike the last contact, the date is sent by the agent itself.
•disabled: Agent state, enabled (0) or disabled (1).
•id_parent: Identifier of the agent parent (ref. tagente).
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•custom_id: Agent customized identifier. Useful to interact with other tools.
•server_name: Name of the server the agent is assigned to.
•cascade_protection: Cascade protection. Disabled at 0. When is at 1 it avoid that he
alerts that are associated to the agent would be fired if a critical alert of the parent of
the agent has been fired.
http://www.openideas.infowiki/index /wiki/index.php?
title=Pandora_3.0:Documentation_es:Alertas#Protecci.C3.B3n_en_cascada
•tagente_datos: Data received from each module. If for the same module the last received
data is the same as the immediate previous one it will be not added (but tagente_estado is
updated). The incremental and string type data are kept in different tables.
•tagente_datos_inc: Incremental data type.
•tagente_datos_string: String kind data.
•tagente_estado: Information of the current status of each module.
•id_agente_estado: Identifier.
•id_agente_modulo: Module identifier.(ref. tagente_modulo).
•datos: Value of the last received data.
•timestamp: Data of the last data received (could come from the agent).
•estado: Module status: 0 NORMAL, 1 CRITICAL, 2 WARNING, 3 UNKNOWN.
•id_agente: Agent identifier associated to the module (ref. tagente).
•last_try: Data of the module last successful execution.
•utimestamp:Data of the module last execution in UNIX format.
•current_interval:Module execution intervale in seconds.
•running_by: Name of the server that executed the module.
•last_execution_try: Date of the module execution last try.The execution could have
failed.
•status_changes: Number of status changes that have been occurred. It is used to
avoid continuous status changes. http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:Operacion#FF_Threshold
•last_status: Module previous status.
•tagente_modulo: Module configuration.
•id_agente_modulo: Module unique identifier.
•id_agente: Agent identifier associated to the module(ref. tagente).
•id_tipo_modulo: Kind of module (ref. ttipo_modulo).
•descripcion: Free text.
•nombre: Module name.
•max: Module maximum value. Higher data than this value will be consider invalid.
•min: Module minimum value. Lower data than this value will be consider invalid.
•module_interval: Module execution interval in seconds.
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•tcp_port: Destination TCP port in network modules and plugin. Name of the column
to read in WMI modules.
•tcp_send:Data to send in network modules. Namespace in WMI modules.
•tcp_rcv: Expected answer in network modules.
•snmp_community:SNMP community in network modules. Filter in WMI modules.
•snmp_oid: OID in network modules. WQL Query in WMI modules.
•ip_target: Destination address in network modules, plugin and WMI.
•id_module_group:Identifier
tmodule_group).

of

the

group

the

module

belongs

to

(ref.

•flag: Flag of forced execution. If is at 1 the module will be executed though it would
be not entitled by interval.
•id_modulo: Identifier for modules that could not been recognized by its
id_tipo_módulo. 6 for WMI modules, 7 for WEB modules.
•disabled: Module status, 0 enabled, 1 disabled.
•id_export: Identifier of the export server associated to the module (ref. tserver).
•plugin_user: User name in plugin and WMI modules, useragent in Web modules.
•plugin_pass: Passwork in plugin modules and WMI, number of reattempts in Web
modules.
•plugin_parameter: Additional parameters in plugin modules, configuration of Goliat
task in Web modules.
•id_plugin: Identifier of the plugin associate to the module in plugin modules (ref.
tplugin).
•post_process: Value with the module data will be multiplied by before being kept.
•prediction_module: 1 if it is a prediction module, 0 in any other case.
•max_timeout: time to wait in seconds in plugin modules.
•custom_id: Module customized identifier. Useful to interact with other tools.
•history_data: If it is at 0 module data will not be kept at tagente_datos*, only
tagente_estado will be updated.
•min_warning: Minimum value that activates the WARNING status.
•max_warning: Maximum value that activates the WARNING status.
•min_critical: Minimum value that activates the CRITICAL status.
•max_critical: Maximum status that activates the CRITICAL status.
•min_ff_event: Number of times that should be a condition of status change before
this change take place. It is is related with
tagente_estado.status_changes. http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:Operacion#FF_Threshold
•delete_pending: If it is at 1 it will be deleted by the maintenance script of
pandora_db.pl database.
•custom_integer_1: When prediction_module = 1 this field is the module id that is
1095

Pandora FMS Database Design

used to predict. When prediction_module = 2 this field is the service id assigned to
the module
•custom_integer_2:
•custom_string_1:
•custom_string_2:
•custom_string_3:
•tagent_access: A new entry will be inserted each time that it is received data from an agent
to any of the servers, but never more than one by minute to avoid overload the database. It
could be deactivated setting the agentaccess to 0 in the pandora_server.conf configuration
file.
•talert_snmp: Configuration of SNMP alerts.
•talert_commands: Commands that could be executed from actions associated to an alert
(eg. send mail).
•talert_actions: Command instance associated to one alert (eg. send mail to administrator).
•talert_templates: Alert templates.
•id: Template unique identifier.
•name: Template name.
•description: Description.
•id_alert_action: Identifier of the default action associated to the template.
•field1: Customized field 1(free text).
•field2: Customized field 2(free text).
•field3: Customized field 3 (free text).
•type: kind of alert depending on the shot condition ('regex', 'max_min', 'max', 'min',
'equal', 'not_equal', 'warning', 'critical').
•value: Value for alerts kind regex (free text).
•matches_value: To 1 it inverts the logic of the shot condition.
•max_value: Maximum value for max_min and max alerts.
•min_value: Minimum value for max_min and min alerts.
•time_threshold: Alert interval.
•max_alerts: Maximum number of times that an alert will be fired during an interval.
•min_alerts: Minimum number of times that the shot condition should be shown
during an interval to the alert will be fired.
•time_from: Time from which the alert will be active.
•time_to: Time to which the alert will be active.
•monday: To 1 the alert is active on Mondays.
•tuesday: To 1 the alert will be active on Tuesdays.
•wednesday: To 1 the alert will be active on Wednesdays.
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•thursday: To 1 the alert will be active on Thursdays.
•friday: To 1 the alert will be active on Fridays.
•saturday: To 1 the alert will be active on Saturdays.
•sunday: To 1 the alert will be active on Sundays.
•recovery_notify:
To
1
activate
the
recovery. http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:Alertas#Plantilla_de_alerta

alert

•field2_recovery: Customized field 2 for alert recovery (free text).
•field3_recovery: Customized field 3 for alert recovery (free text).
•priority: Alert criticity: 0 Maintenance, 1 Informational, 2 Normal, 3 Warning, 4
Critical.
•id_group: Identifier of the group the template belongs to (ref. tgrupo).
•talert_template_modules: Instance of an alert template associated to a module.
•id: Alert unique identifier.
•id_agent_module:
tagente_modulo).

Identifier

of

the

module

associated

to

the

alert

(ref.

•id_alert_template: Identifier of the templated associated to the alert (ref.
talert_templates).
•internal_counter: Number of times that the alert shot condition has occurred.
•last_fired: Last time the alert was fired (Unix time)
•last_reference: Start of the current interval (Unix time).
•times_fired: number of times the alert was fired (could be different from
internal_counter)
•disabled: At 1 the alert is deactivated.
•priority: Alert criticity : 0 Maintenance, 1 Informational, 2 Normal, 3 Warning, 4
Critical.
•force_execution: At 1 the action of the alert will be executed thought it has not been
fired. It is used for the alert manual execution.
•talert_template_module_actions: Instance of an action associated to one alert (ref.
talert_template_modules).
•talert_compound: Compound alerts, the columns are similar to the talert_templates.
•talert_compound_elements: Simple alerts associated to a compound alert, each one with
its correspondent logic operation (ref. talert_template_modules).
•talert_compound_actions:
talert_compound).

Actions

associated

with

a

compound

alert

(ref.

•tattachment: Attachments associated to one incident.
•tconfig: Console configuration.
•tconfig_os: Valid Operative systems in Pandora FMS.
•tevento: Event entries. The criticity values are the same ones than for the alerts.
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•tgrupo: Defined groups in Pandora FMS.
•tincidencia: Incident entries
•tlanguage: Available languages in Pandora FMS.
•tlink: Links showed at the console menu lower side.
•tnetwork_component: Network components. They are modules associated to a network
profile used by the Recon Server. After they result in an entry at tagente_modulo, so the
columns of both tables are similar.
•tnetwork_component_group: Groups to classify the network components.
•tnetwork_profile: Network profile. Network components group that will be assigned to
recognition tasks of the Recon Server. The network components associated to the profile will
result in modules in the created agents.
•tnetwork_profile_component: Componentes de red asociados a un perfil de red (rel.
tnetwork_component/tnetwork_profile).
•tnota: Notes associated to an incident.
•torigen: Possible origins of an incident.
•tperfil: User profiles defined at the console.
•trecon_task: Recon Server Recon tasks. http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:ReconServer
•tserver: Registered servers.
•tsesion: information on actions that toke place during an user session for administration
and statistical logs.
•ttipo_modulo: Kinds of modules depending on their origin and kind of data.
•ttrap: SNMP traps received by the SNMP console.
•tusuario: Registered users at the console.
•tusuario_perfil: Profiles asociated to an user (rel. tusuario/tperfil).
•tnews: News showed at the console.
•tgraph: Customized graphs created in the console.
•tgraph_source: Modules associated to a graph (rel. tgraph/tagente_modulo).
•treport: Customized reports created at the console.
•treport_content: Elements associated to one report.
•treport_content_sla_combined: Components of an SLA element associated to one report.
•tlayout: Customized maps created at the console.
•tlayout_data: Elements associated to a map.
•tplugin: Plugin definitions for the Plugin Server.
•tmodule: Kinds of modules (Network, Plugin, WMI...).
•tserver_export:
Configured
destinations
Server. http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:ExportServer

for

the

Export
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•tserver_export_data: Data to export, associated to a destination.
•tplanned_downtime: Programmed stops.
•tplanned_downtime_agents:
tplanned_downtime/tagente).

Agents

associated

to

a

programmed

stop

(rel.

47.1.3. Data Compression in Real Time
To avoid overload the database, the server does a simple compression in time of insertion.One data
won't be stored at the database unless it would be different to the previous one or it would be a
difference of 24 hours between both of them.
For
example,
supposing
an
interval
of
approximately
1
hour,
then
the
sequence 0,1,0,0,0,0,0,0,1,1,0,0 is kept in the database as 0,1,0,1,0. It won't kept other
consecutive 0 unless 24 h. have passed.
The graph that is shown next has been drawn from the data of the previous example. Only the data
in red has been inserted in the database.

The compression affects to the algorithms of data processing. Either to the metrics as to the graphs,
and it's important to consider that you should fill in the blanks that are caused by the compression.
Considering all the previous things, in order to calculate with the data of a given module the
interval and the starting data, you should follow these steps:
•Search for the previous data out of the interval and date given. If it exists, you have to put it
at the beginning of the range. If it doesn't exist, then previously there was no data.
•Search the following data out of the range and data given until a maximum equal to the
module interval. If it exists, then you have to put it at the end of the interval. If not, you
have to extend the last available value until the end of the interval.
•All data should be check, considering that one data is valid until we get another data.

47.1.4. Data compaction
Pandora FMS has included a system to "compact" database information. This system is focus on
small / midsize deployments (250500 agents, < 100,000 modules) which want to have a long
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history information but "loosing" some resolution.
Pandora FMS database maintance, which is executed each day do a scan of old data subject to be
compacted. This compactation is done using a simple linear interpolation, that means, if you have
10,000 points of information in a day, you will get a result of a process of interpolation, which
replace that 10,000 points for 1000 points.
This, obviously "loose" information, because is an interpolation, BUT also saves database storage
and on long term graphs (monthly, yearly) the graphs are mostly the same. In big databases this
behaviour coult be "costly" in terms on database performance, and should be disabled and you
should use the history database model instead.
Sample of non compact data

Same graph after a compactation

47.1.5. History database
This is an Enterprise feature, and is used to store the information from a given point in time, for
example, data with more than one month in a different database. This database must be in a
different physical server (no virtualize here, please!). Automatically, when you request a data graph
for 1 year, Pandora FMS will look the first XX days in the "realtime/main" database and the other
information in the history database. In this way you can avoid to have performance penalties when
you store a huge ammount of information in your system.
To configure this, you need to setup manually in another server, a history database (importing the
Pandora FMS DB Schema into it, without data), and setup permissions to allow access to it from the
main Pandora FMS server.
Go to Setup > History database and configure there the settings to access the history database.
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Some settings interesting which need to be explained:
•Days: max days information is stored in main database. After that date, data will be moved
to history db. 30 days is a good default.
•Step: This acts like a buffer, database maintance script, will take XX registers from
database, will insert it in the history database and will delete it from main database. This is
timeconsuming, and size depends on your setup, 1000 is a good default
•Delay: After a block of step modules, script will wait for delay seconds. Useful if your
database performance is poor, to avoid locks. Use values only between 15.
A good way to test this is to run the database maintance script manually:
/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

You should not get any errors there.

47.2. States of The Modules in Pandora FMS
In Pandora FMS the modules can have different states:Unkown, Normal, Warning, Critical or with
Fired Alerts.

47.2.1. When is Each State Fixed?
Each module has the Warning and Critical thresholds fixed in its configuration. These thresholds
define its data values for which these states will be activate. If the module gives data out of these
thresholds, then it will be considered that it's on Normal state.
Each module has also a time interval that will fix the frequency with which it will get the data. This
interval will be taken into account by the console to collect data. If the module has the double of its
interval without collecting data, then, it'll be considered that this module is in Unknown State.
Finally, if the module has configured alerts and any of them have been fired and have not been
validated, then the module will have the corresponding Fired Alert state.
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47.2.2. Spreading and Priority
In Pandora's organization, some elements depend on others, as for example the modules of one
agent or the agents of one group.These can also be applied to the case of the Pandora's FMS
Enterprise policies, which have associated some agents and some modules that are considered
associated to each agent.
This structure is specially useful in order to evaluate easily the states of the modules. This is
obtained spreading up the states in this organization, giving state to the agents, groups and policies
this way.

47.2.2.1. Which State will have an Agent?
An agent will have the worst of its modules's states. Recursively, a group will have the worst of the
agent's states that belong to it, and the same for the policies, that will have the worst state of its
assigned agents.
This way, by seeing one group with a critical state, for example, we'll known that at least one of its
agents has the same state. When we locate it, we could get down another level to get to the module
or modules that have caused the spreading of the critical state to the upper level.

47.2.2.2. Which should be the Priority of the States?
When we say that the worst of the states is spread, we should be sure which states are the most
important ones. This way, there is a priority list, being the first state in it the one that has highest
priority over the others and the last one the one that has the lowest. This one will be shown only
with all elements have it.
1. Fired Alerts
2. Critical State
3. Warning State
4. Unknown State
5. Normal State
We can see that when a module has fired alerts, its state has priority over the rest, and the agent to
which it belongs will have this state and also the group to which this agent belongs to.
On the other hand, in order to one group, for example, has a normal state, all its agents should have
this state; which implies that all the modules of these groups will have normal state.

47.2.3. Color Code
Each one of the commented states has a color assigned, in order to could view in the network maps,
with a quick view, when something isn't working properly.
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Fired alerts State
Critical State
Warning State
Unknown State
Normal State
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